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Welcome to Axiom Budgeting and
Performance Reporting

Axiom Budgeting and Performance Reporting contains all the necessary tools to model the finances of
any facility-based operation (for example, hospitals, long-term care facilities, rehab, or psychiatric
facilities), and generate comprehensive projections and what-if scenarios to support multi-year financial
planning.

Using the software, you can evaluate proposed capital investments, establish short- and long-term
profitability targets, and/or quantify the impacts of operational or market strategies.

Axiom Budgeting and Performance Reporting primarily focuses on:

l Development of annual department/group-level budgets
l Monthly/biweekly tracking of variances
l Management reporting based on budget data and key performance indicators

While Axiom Budgeting and Performance Reporting is flexible and powerful enough to support any
approach to budgeting, the real value of the software comes from Kaufman Hall's library of healthcare-
specific templates, reports, and utilities. Based on our 25+ years of experience as trusted advisors to
healthcare institutions, these tools can help your organization establish and maintain the solid financial
foundation necessary to fulfill its mission.

Axiom Budgeting and Performance Reporting is supported by a team of specialists who together have
helped hundreds of healthcare organizations apply our solutions to meet their strategic and financial
goals. During implementation, a Kaufman Hall Implementation Consultant will help you configure the
application to match your organization's structure and preferences. If you encounter any difficulties or
unanticipated situations while using the software, contact Kaufman Hall Support.

The individuals who often interact with this product include:

l Department Managers/Directors – Develop and update budgets to meet targets based on the
long-term financial plan. Provide explanations for any significant variances.

l Vice Presidents/Executives – Review reports and analyses of budget data to help inform strategic
decision-making.

1
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What is covered in this document
This manual is written for an Axiom Budgeting and Performance Reporting Administrator. This is an
individual at your organization tasked with configuring, maintaining, and controlling other users' access
to Axiom Budgeting and Performance Reporting 2020.3-related features and data.

As an Administrator, you have access to features and menus that are unavailable to regular end users
such as department managers, non-finance executives, and other stakeholders. In some cases, the same
screen or workbook might display slightly differently in your interface than it would for an end user.

TIP: Online help offers all the topics in this guide and multiple training videos related to how to use
the Axiom Budgeting and Performance Reporting. You can access online help by navigating to the
Help ribbon tab, click Online Help, and then click Budgeting and Performance Reporting.

What's new
Welcome to Version 2020.3.1 of Axiom Budgeting and Performance Reporting!

New 2022 budgeting and management reporting tables

The following tables have been added to the Table Library for 2021 budgeting and planning purposes:

l \Axiom\Table Library\Budgeting\Flex Budget\FLX2022
l \Axiom\Table Library\Management Reporting\Actuals\CY Forecast\CYF2022

NOTE: Risk point with COVID-19 changes

l \Axiom\Table Library\Management Reporting\Actuals\Financial\ACT2022
l \Axiom\Table Library\Management Reporting\Actuals\Payroll\ACT_PAY12_2022
l \Axiom\Table Library\Management Reporting\Actuals\Payroll\ACT_PAY27_2022
l \Axiom\Table Library\Management Reporting\Actuals\Payroll\EMPLOYEE_ROSTER_2022
l \Axiom\Table Library\Management Reporting\Actuals\Physician\ACT_PROV_2022
l \Axiom\Table Library\Management Reporting\Actuals\Rev Usage\ACT_RU_2022
l \Axiom\Table Library\Management Reporting\Actuals\Transactions\GLTRANSACTIONS_2022
l \Axiom\Table Library\Management Reporting\Actuals\Health Plan\ACT_HP_2022

IMPORTANT: Some of the new features listed above have been included in the latest Prototype file
group. You must create a new file group or update an existing file group to utilize the updated
contents from the 2020.3.1 release. To create a new file group for a new budgeting year, follow the
instructions in the section Rolling forward to a new budget year.
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New 2022 budgeting and management reporting tables

� Why use this feature
The following tables have been added to the Table Library for 2021 budgeting and planning purposes:

l \Axiom\Table Library\Budgeting\Flex Budget\FLX2022
l \Axiom\Table Library\Management Reporting\Actuals\Financial\ACT2022
l \Axiom\Table Library\Management Reporting\Actuals\Payroll\ACT_PAY12_2022
l \Axiom\Table Library\Management Reporting\Actuals\Payroll\ACT_PAY27_2022
l \Axiom\Table Library\Management Reporting\Actuals\Payroll\EMPLOYEE_ROSTER_2022
l \Axiom\Table Library\Management Reporting\Actuals\Physician\ACT_PROV_2022
l \Axiom\Table Library\Management Reporting\Actuals\Rev Usage\ACT_RU_2022
l \Axiom\Table Library\Management Reporting\Actuals\Transactions\GLTRANSACTIONS_2022
l \Axiom\Table Library\Management Reporting\Actuals\Health Plan\ACT_HP_2022
l \Axiom\Table Library\Management Reporting\Actuals\CY Forecast\CYF2022

NOTE: The CYF2022 tables does not include the edits made for the revised CYF utility made for
the COVID-19 response. Those updates, if made, were to facilitate a rapid response to the
current table and are not included as a standard product change at this time.

� How this feature works
What: New2021 tables are now accessible in the Axiom Table Library.

Where: In the Admin ribbon tab of the AxiomWindows or Excel Client, click System Browser. In the
Libraries section, click the Table Library folder.

Who: Users must be assigned the Bud Admin role.

How: Open and use the table, as needed.
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Getting Started
This section provides information on the basics of using Axiom Budgeting and Performance Reporting,
such as:

l General system navigation and user interface
l Using spreadsheet plan files and report files from an end user perspective
l Using general Axiom spreadsheet file features such as views, snapshots, and printing
l Viewing data using web-friendly reporting tools such as Web Reports and Data Explorer

This section is intended for all users who are getting started with Axiom Budgeting and Performance
Reporting. For end users, this section provides an ongoing reference for file-related tasks.

Home page
All users have a home page that opens automatically when you log into the AxiomWeb Client.
Depending on your system, this home pagemay be one of the following:

l A product-specific home page for an installed Axiom Budgeting and Performance Reporting
product

l A custom home page created specifically for your organization
l The default Axiom Budgeting and Performance Reporting home page

If you have any questions about your home page, please contact your system administrator.

If you navigate away from the home page, you can return to it by using the Area menu in the Global
Navigation Bar:

2
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If you are in a system with installed products, this menu may contain product names instead of the
Home item. In that case, you can select a product name to return to the home page for that product.

NOTE: If you are an administrator looking for more information on how the home page is
determined, see Assigning alternate home pages (in Desktop Client Help).

� Default home page
If a user does not have an available web-enabled home page, then the default home page is used. The
default home page displays notifications, favorites, and quick links.

This page can also be accessed (by any user) by going to the following URL:

Example On-
Premise URL

http://ServerName/Axiom/Home/Launchpage
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Where ServerName is the name of the Axiom Application Server, and Axiom is the
default name of the virtual directory.

Example Cloud
System URL

https://CustomerName.axiom.cloud/Home/Launchpage

Where CustomerName is the name of your cloud service system.

This page has the following features:
l Notifications: You can read and delete notifications using the same features available in the

Notifications panel.

l Quick Links: You can use a set of global quick links that are displayed here for easy access. These
links are built-in to the page and cannot be customized. However, the link to the Excel Client may
not be present if your system has been configured to hide it.

l Favorites: You can open and delete web favorites.

Launching Axiom Budgeting and Performance Reporting
applications

You can launch various Axiom Budgeting and Performance Reporting applications from theWeb Client
Quick Launch menu, including the Axiom Excel Client and AxiomWindows Client.

The Quick Launch menu serves the following purposes:
l Users can install applications from this area as needed. Afterward, they can continue to launch

installed applications from this location, or they can use other options (such as a shortcut on their
desktop).

l For systems using SAML or OpenID authentication, this is the only option for users to launch
installed applications. SAML and OpenID authentication require users to be authenticated using
theWeb Client before they can launch a desktop application.

l Users can install and launch add-ins such as the add-ins for Microsoft Office applications.

To open the Quick Launch menu, click the Quick Launch icon in the Global Navigation Bar.
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Quick Launch menu

� Launching the Axiom Desktop Client
Using the Quick Launch menu, you can launch the Axiom Desktop Client. Click on one of the following
icons:

Item Description

Windows Client Launches the AxiomWindows Client on your desktop.

Excel Client Launches the Axiom Excel Client on your desktop. Requires Microsoft Excel.

NOTE: This option may not display in themenu, in which case you should use
theWindows Client as your desktop client.

If the client is not already installed on the current workstation, clicking the icon will initiate the install and
then launch the client. If the client is already installed, clicking the link will launch the client. You must be
using Microsoft Edge or Internet Explorer 11 (or higher) to perform these actions. Other browsers may be
able to install and launch the client if a ClickOnce extension is applied to the browser.

The appropriate client to use depends on your organization's preferences and on your user role. Your
organization will provide instruction as to which client you should use.
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For more information on installing theWindows Client and Excel Client, including prerequisites and
configuration details, see the Installation Guide (on-premise systems) or the Axiom Cloud Technical Guide
(Axiom Cloud systems). Some software prerequisites can be downloaded and installed from theWeb
Client. You can access the prerequisites download page from the Axiom Budgeting and Performance
Reporting About box.

NOTE: The default home page also contains links to launch theWindows Client or the Excel Client.

� Launching add-ins
Using the Quick Launch menu, you can launch Axiom Budgeting and Performance Reporting add-ins.
Click on one of the following icons:

Item Description

MSWord Add-In Launches the Axiom Budgeting and Performance Reporting Add-In for Microsoft
Word.

MS PowerPoint
Add-In

Launches the Axiom Budgeting and Performance Reporting Add-In for Microsoft
PowerPoint.

NOTE: One or both add-ins may not display in themenu, depending on your organization's
preferences.

TheWord and PowerPoint Add-ins are optional applications to support document integration between
Axiom Budgeting and Performance Reporting and Word or PowerPoint.

Navigation panel
Using the Navigation panel, you can navigate to your documents and to various areas of theWeb Client.

To open the Navigation panel, click themenu icon in the left side of the Task Bar. To navigate to an
area or document listed in the panel, click on the item.
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Example Navigation panel

The Navigation panel updates dynamically to show the available navigation links for the currently active
area of theWeb Client. The following areas are available:

Area Description

Default Axiom Budgeting and Performance Reporting provides a set of standard
navigation links that show by default when you are in theWeb Client. The
previous screenshot shows the standard navigation links. These links provide
access to your favorites, recent places, web-enabled reports and forms, and the
Report Designer.

The standard navigation links can be customized, so each client's system may
look different. Navigation links can only be customized by administrators using
the Desktop Client.

System
Administration

The system administration links showwhen you are in the System
Administration area, and provide access to features such as the TableManager,
Audit Manager, and software updates.

Product-Specific Systems with installed products may have product-specific web navigation links.

When you select a product name from the Area menu in the Global
Navigation Bar., the product-specific links display in the Navigation panel. For
more information, see the product-specific documentation.
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Additionally, when you open a report or other browser-based document, that document may be
associated with a set of document-specific navigation links. These links are added to the Navigation panel
while you are in that document.

Viewing system information
Use the Axiom Budgeting and Performance Reporting About box to see information about your current
system, such as:

l Axiom Budgeting and Performance Reporting version number
l Product version numbers
l System name
l Application server URL

The About box also contains a link to download software prerequisites, if necessary for installation of the
Desktop Client.

To open the About box:

1. Click themenu icon in the Global Navigation Bar.

2. At the bottom of the Area menu, click About Axiom Software.

About Axiom Software at bottom of Area menu
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Getting to know the interface
All Axiom Software products share a common interface and make use ofmany of the same features.

NOTE: The interface elements referenced in this section can vary depending on if or how your
organization customizes them. This means that topics may reference features that do not display in
your task panes, which means they may not be available for you to use. Contact your Axiom
administrator for more information.

The interface includes several sections, including:

� Display area
Themain display area displays the open files. By default, it shows the Kaufman Hall Home dashboard,
which displays announcements, assigned tasks, links to dashboards, and contact information for
administrators. Your Axiom Software product administrator configures the information that displays on
this screen.

� Task panes
A task pane provides access to commands, utilities, reports, plan files, and so on for Axiom Budgeting
and Performance Reporting, and displays on the left side of themain display area. To switch between
task panes, click the tabs on the left side of the interface. To expand or collapse the task panes, click the
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arrow in the left-hand corner above the tabs.

� Ribbon tabs
Ribbon tabs provide access to commonly used features and shortcuts to frequently accessed files. They
display above the task pane and main display areas. The role assigned to you determines the ribbon tabs
that display. For example, the Admin ribbon tab only displays to those users assigned the Administrator
role profile.

� Main
Includes commands for accomplishing most tasks in Axiom:

l Opening, closing, and saving files
l Accessing online help for products and advanced (Axiom platform) help
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l Viewing data in spreadsheets
l Printing or emailing files
l Accessing shortcuts to frequently accessed reports

� Admin
Includes commands for managing and configuring security, Scheduler jobs, processes, and data as well
as other system-related tools used by administrators. This ribbon tab only displays to users with
administrator privileges. Access to online help for products and advanced topics (Axiom platform) is also
available.

� Home
Includes standard spreadsheet commands.

Some options on the ribbon tabs display grayed out unless certain types of files such as reports or plan
files are currently open or if you do not have the necessary security permissions to use the feature.

The Excel Client displays all of the same ribbon tabs included in a normal Excel file. TheWindows Client
only includes a subset of the same ribbon tabs located in the Home ribbon tab.

TIP: When creating reports, we recommend that you use the Excel Client.
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Opening task panes
To open the Axiom Budgeting and Management Reporting task panes:

l For administrators, in the Admin ribbon tab, click Admin Task Panes, and select Budget Admin or
Management Reporting Admin.
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l For end users, in theMain ribbon tab, click Open App Menus, and select Budgeting or
Management Reporting.

Opening the Explorer task pane
Axiom Budgeting and Performance Reporting provides a built-in Explorer task pane so that you can
quickly access your favorites, recent items, and all the files that you have rights to access.

TIP: You can also access Favorites, Recent, and My Documents from theMy Files and Tasks task
pane.

By default, all users are given access to this task pane. If desired, administrators can disable use of this
task pane entirely, or restrict access to certain sets of users.
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To access the Explorer task pane:
l In theMain ribbon tab, click Navigation, and select Explorer.

Using the Workflow task pane
Axiom Budgeting and Performance Reporting provides a built-in Workflow task pane that allows you to
easily see and access your workflow tasks. By default, the task pane is configured to open automatically
for any user who has current tasks in an active workflow. If desired, you can change the conditions that
make the task pane visible, or disable it entirely. 

Commenting on documents using the Message Stream
task pane

When viewing a spreadsheet Axiom file within the Desktop Client, you can view comments that other
users havemade about the document and also make comments about the document. New comments
are stored in themessage stream for that document, so that all other users who access the document
can see the comment. Additionally, you can "tag" other users in the comment, so that the tagged users
are notified about the comment.

You can view comments and add comments using theMessage Stream task pane. This is a system-
controlled task pane that automatically opens for eligible documents.

NOTES:
l Themessage stream is only available for documents where it has been enabled.

l Themessage stream is also available for Axiom forms that are open within the Desktop Client,
using theMessage Stream panel. This panel is accessible from the task bar displayed across
the top of the form.
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� Viewing the message stream
To view themessage stream for the current document, click theMessage Stream tab to display the task
pane in the Axiom Assistant sidebar. This task pane shows all comments that have been made about the
document.

Example message stream

Comments are displayed in the order they weremade, with themost recent comment shown at the top
of the panel. Each comment shows when the comment was made and the user who made it.

To view the full text and details of a comment, hover your cursor over the comment so that the > symbol
displays on the right-hand side of the comment. Click the symbol to open a separate Comment Details
dialog with the full comment text.

Once themessage stream has been loaded for the current document, it is only updated automatically
after you add a new comment. If necessary, you can manually refresh the task pane to see if any other
users havemade comments during the current file session.

Comments are stored for the life of the document, and cannot be deleted.

� Adding a comment
To add a comment, click Add Comment at the top of theMessage Stream task pane. In the Add
Comment dialog, you can define an optional title for the comment, and then define the comment text.
Basic text formatting of bold, italic, and underline can be used.
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If desired, you can "tag" one or more users in the comment, so that those users are notified about the
comment. Any user tagged in the comment will receive an email that contains the content of the
comment and a link to the document. To tag a user, use the Tag user box to find a user and insert the
tag. You can type into the box to find a specific user, or select a user from the drop-down list. When you
click on a user name in the list, a tag will be inserted at the current cursor point in the comment text. The
tag displays as @FirstName LastName.

When you click Post, the comment is saved to themessage stream, and any tagged users will be notified.

NOTES:
l All users with access to the document can see comments posted to themessage stream. Any

comments made should be appropriate for the entire document audience. Do not post any
sensitive information to themessage stream.

l Adding a comment automatically subscribes you to the document's message stream, and
tagging a user automatically subscribes that user to the document's message stream.

� Ongoing notifications (subscriptions)
If you havemade a comment in a document's message stream, or if you have been tagged in a
comment, you are now subscribed to that document's message stream. Whenever a new comment is
made to that document's message stream, you will receive a notification in the Notifications task pane.
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The notification details the user who made the comment and when it was made, the text of the
comment, and a link to open the file.

Currently it is not possible to unsubscribe from a document's message stream once you have been
subscribed.

Managing favorites
You can save files and other items as favorites for quick access to commonly used items. Your favorites
list is available in the following locations:

l The Explorer task pane in the Axiom Assistant area
l The Axiom Explorer dialog (if you have permission to access this dialog)

NOTE: Your organization may choose not to use the Explorer task pane or to restrict it to certain
users. In this case, you can access your favorites from theMy Files and Tasks task pane.

When an item is saved to favorites, you can open the item by double-clicking it, or you can right-click it to
access any other commands available on the item in its native area. For example, if you have rights to the
Table Library and you save a table as a favorite, you can right-click the table favorite and perform actions
such as editing the table structure.

If an item that a favorite points to is deleted, then the favorite becomes invalid and a red arrow icon
displays next to it.

If you attempt to open an invalid favorite, a message box informs you that the item has been deleted,
and asks whether you want to delete the favorite. If a file is moved or renamed within the Axiom file
system but it retains the same document ID, then the shortcut is not broken.

� Saving favorites
l In the Explorer task pane and the Axiom Explorer dialog, by right clicking an item and selecting

Add to Favorites.
l By right clicking the file tab of an opened file and selecting Add to Favorites.

TIP: If you open a table using Open Table in Spreadsheet, and save the open table as a
favorite (using the file tabs), the settings you used are automatically saved as part of the
favorite in the shortcut properties. You may want to rename the favorite to indicate the
particular settings.

� Organizing favorites
You can create sub-folders in the Favorites area to organize favorites by folder. To create a new folder,
right-click Favorites, and select New Folder.
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By default, favorites display in the order that they were added. New favorites are added to the bottom of
the list. You can drag and drop individual favorites to change the order. You cannot reorder sub-
folders—they always display in alphabetical order.

To rename a favorite, right-click the item, and select Rename. The name becomes editable, and you can
type a new name.

� Shortcut properties
You can edit the shortcut properties for a favorite. Right-click the favorite, and select Shortcut
Properties. In this dialog, you can edit the shortcut name, change the shortcut target, and define certain
shortcut properties.

The available shortcut properties vary by file type. For example, you can configure a report favorite to
always open as read-only, or to automatically apply a Quick Filter when opening.

� Deleting favorites
To delete a favorite, right-click the item, and select Delete.

Opening recent files
Axiom Budgeting and Performance Reporting maintains a list of your recently opened files in theMy
Files and Tasks task pane. You can use this list for quick access to recent files.

The recent file list is located in theMy Files section. Double-click the files to open them, or right-click to
access the context menu for the file type.
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The list displays the last 15 files that you recently opened. Note the following:
l To clear the list, right-click Recent, and select Clear History.
l To continue to have quick access to a recent file, you can add it to your favorites. Right-click the

file, and select Add to favorites.
l If the icon next to a file name is a red arrow, this means that the file has been moved or deleted

since you accessed it, so you can no longer open it from the recent file list.

NOTE: In theWindows Client only, you can only access recent files from the Filemenu. In the Excel
Client, although your recent files are tracked in File > Recent, those links point to the temporary
versions of the file stored on your local drive, not the source versions of the files stored in the Axiom
database. Therefore, you cannot use Excel's recent file list to open Axiom files.

Running file processing on an Axiom file
If a file is set up to use file processing, you can process the file to automatically create various file
outputs, such as:

l Save snapshot copies of the file and automatically email them to various recipients
l Print one or more sheets in the file using one or more print views
l Export data in the file to a CSV or TXT file
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l Collect multiple output files into a single report package
l Process multiple reports in batch

File processing can be used in all spreadsheet Axiom files except file group templates, however, report
files are themost common use case.

NOTE: The file processing menu command and the associated task pane are only available to
administrators and to users with the Allow File Processing permission for the file.

To process a file using file processing:
1. Open the file. If you want to see what the file is configured to do during file processing before

executing it, you can check the settings in the File Processing task pane.

2. In the File Processing task pane, in the Actions section, click one of the following options to start
processing:

l Process File: The file is processed once "as is." The file is refreshed and the file processing
action is performed. No multipass filter or settings are applied.

l Process File Multipass: The file is processed multiple times, with a unique filter applied for
each pass. For example, if the file is set up to process by DEPT, then the file is processed
once for each department. The data queries in the file are automatically filtered to return
data for the current pass department only.

TIP: You can also process the file using the File Processingmenu on the Axiom tab. (In
systems with installed products, this featuremay be located on theMain tab.)

Once file processing is initiated, the following occurs:
l The file is refreshed. If you are performing multipass processing, the file is refreshed using a data

filter for the current pass item.
l The file processing action is performed. If you are performing multipass processing, the action

may be performed after each pass, or it may be performed once all passes are complete,
depending on the file processing settings.

A status bar displays the progress of the file processing. When the processing is complete, a confirmation
box displays information about the process, such as howmany passes were performed, howmany files
were created, etc.

Note that the file itself is not saved as part of file processing. You can process a file even if you have read-
only rights to the file. However, if the file processing is set up to save to the database, you must have
rights to save data for that file.
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Viewing alert notifications
When a new alert is added to the database as a result of an alert processing, a notification is delivered to
all designated alert recipients using email and/or the Notifications task pane.

� Email notification
If the alert notification is delivered using email, the subject of the email is "Axiom Budgeting and
Performance Reporting alert: <Alert Title>". The alert message displays within the body text. The email
also contains a hyperlink to the supporting file if one is specified in the alert definition.

� Notification task pane
Alert notifications display in the Notifications task pane in the order they are received, with themost
recent alerts at the top.

By default, notifications are collapsed so that only the severity icon and the alert title display. You can
expand the notification to read the alert message and to navigate to the supporting document for the
alert, if defined.

If you receive a new alert notification during the current session or if unread alerts are present when you
log in, the Notifications tab flashes orange and remains orange until the tab is clicked. New notifications
display in bold text until they are read.

Using the right-click menu, you can mark notifications as read or unread and can delete notifications
from the task pane. If you have rights to access the source file for an alert, you can also navigate to the
alert definition in that file.

Notifications do not have an expiration date. A notification continues to display in your Notifications task
pane until you delete it or until the notification record is purged from the database using the System
Data Purge task in Scheduler.

NOTE: If you delete a notification, this simply removes the notification from the task pane. It does
not delete the notification record from the database.

The Notifications task pane is system-controlled. You cannot manually open and close it, and it is not
available for customization. The task pane behaves as follows:

l The task pane displays on startup if you have an active notification (read or unread). If the task
pane contains unread notifications, the task pane is active, and the tab flashes. The task pane
continues to display for the duration of the current session, even if you delete all active
notifications from the task pane.

l The task pane does not display on startup if you have no active notifications. If you receive a new
notification mid-session, the task pane automatically opens, becomes active, and the tab flashes.
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Changing your Axiom Budgeting and Performance
Reporting password

If your authentication method is Axiom Prompt, you can change your password as needed. This feature
does not apply if you use any other authentication method, such as Windows User Authentication,
because those passwords are controlled externally from Axiom Budgeting and Performance Reporting.

To change your Axiom Budgeting and Performance Reporting password:
1. On theMain ribbon tab, in theHelp group, click Help > Change Password.

NOTE: This command is only available to Axiom Prompt users.

2. In the Set Password dialog, type your current password, then type and confirm your new
password.

If password rules are being enforced, your password must meet the rules. A validation message
informs you of the rules, if necessary. Alternatively, you can click Generate Password to auto-
generate a password that meets the rules. If you do this, make sure to note the generated
password because you will not have another opportunity to see it. If you do not note the
password and cannot log in later, an administrator will need to reset your password.

3. Click OK.

Your password is now changed. You need to use this new password the next time you log in.

Exiting Axiom Budgeting and Performance Reporting
To exit Axiom Budgeting and Performance Reporting, in theMain ribbon tab, click the Close Axiom
Software button in the Exit group.

You can also simply close the application by clicking the X button in the top right corner of the window.
Axiom Budgeting and Performance Reporting prompts you to save any changes to unsaved files.
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Understanding File Groups and
Budget Plan File Setup

Before setting up budget plan files, we recommend that you first familiarize yourself with file groups and
how they work.

Axiom Budgeting and Performance Reporting groups related files for a single year's annual budget into a
file group. You maintain a single, designated file group for the active budget. This section covers file
groups in detail.

Accessing file groups
You access file groups from the File Groups section of the Explorer task pane. Your access rights to each
plan file (read-only or read/write) within a file group are determined by a combination of your security
settings and workflow or process settings (if applicable).

To access a file group:
In the Explorertask pane, in the File Groups section, expand a file group to do the following:

3
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Option Description

Open Plan Files Select the plan files to open by double-clicking a budget file group's plan
file.

Create Plan Files Create and save empty plan files, per the configuration settings in
dimension tables and the file group's driver files.

Process Plan Files Load historical data into each budget plan file, then run calculations based
on calc methods in the dimension tables.

Copy Plan Files Copy plan files from one file group to another.

Drivers DriversDrivers store configuration settings and key statistics used
throughout the file group. Driver files control plan-wide settings, such as
the current planning period, and contain assumptions such as payroll-
related rates and percentages, production or utilization statistics, and
conversion rates that the plan files use to calculate and spread data.

Utilities If your organization has purchased certain add-on modules, you might
find additional utilities in this folder.

Process Definitions Lists processes defined for the files group. Budget plan files include the
Budget Approval Process definition, by default.

Scenarios This section is not used in Axiom Budgeting and Performance Reporting
2020.3.

NOTE: By default, only Administrators can see the file group administration options for a group.
Users without Administrator privileges can only open specific plan files for the file groups to which
they have access.

Working with file group aliases
Because you need to manage current and future plan files simultaneously, the task panes recognize the
fiscal year the administrator wants to point them to.

Additionally, using file group aliases allows you to determine when an annual update is made active in
your environment. You can obtain updates at any time an update is made available, without affecting
current operation settings.

In the ExplorerExplorer task pane, the File Group Aliases folder is located in themain File Group section.
There are three aliases available and are currently defaulted with values. BP_CurrentYear, BP_NextYear,
and BP_PriorYear.
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This means that when using task panes to open plan files, the file group aliases determine which plan file
set opens. For example, in the Budgeting task pane, there are two sets of budgets, Open Next Year
Budgets and Open Current Year Budgets.

When opening the Next Year Budgets, the dialog confirms that the plan files are for the next budget year.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 34



Updating file group aliases
File group aliases are reference pointers that are used throughout the system to determine which file
group corresponds to which budgeting year.

IMPORTANT: The aliases must be set before copying driver security so that themost recent year is
used. For example, if a 2020 file group was created and the intent is to copy the file group security
from 2019, then BP_CurrentYear must point to 2019 File Group.

To update file group aliases:
1. In the Admin ribbon tab, click System Browser.

2. In the Axiom Explorer window, click File Group Aliases, and double-click the BP_CurrentYear or
BP_PriorYear aliases to assign their respective file group year relative to the new file group year.
For example, if creating a new 2020 file group, set the BP_CurrentYear to 2019 and BP_PriorYear to
2018.

3. In the Edit File Group Alias dialog, click the folder icon.

4. In the Choose File Group dialog, select the file group, and click OK.

5. Click OK.

6. Click Close.
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Setting the fiscal year for file group aliases
IMPORTANT: File group aliases also affect scheduled jobs. A scheduled job can only contain one
fiscal year setting. By changing the file group aliases, you may be changing a data set the job will run.
To confirm which file group aliases a scheduled job points to, open the job, and click Process Plan
Files from the task pane. The Select File Group box on theOptions tab displays the alias.

To set the fiscal year for file group aliases:
1. In the ExplorerExplorer task pane, in the File Groups section, right-click BP_CurentYear, and click

Edit.

2. In the File Group field, click the folder icon.

3. Select the file group to use for the current year budget plan files.

4. Click OK.

5. Repeat Steps 2-4 for BP_NextYear and BP_PriorYear.

Deleting a file group
Deleting a file group deletes all of the files stored in the associated file group folder, including templates,
plan files, drivers, calc method libraries, and workflows. Additionally, any document reference tables
linked to the file group are also deleted.
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IMPORTANT: You cannot undo this action, and the deleted files cannot be recovered using normal
Axiom Budgeting and Performance Reporting functionality. Be sure that you no longer need the file
group before you delete it. You may want to back up the Kaufman Hall Axiom database before
deleting the file group.

To delete a file group:
1. In the ExplorerExplorer task pane, in the File Groups section, right-click the file group to delete.

2. Click Delete.

3. At the confirmation prompt, click Yes.

The system deletes the file group and all of its associated files.

Updating file group aliases
File group aliases are reference pointers that are used throughout the system to determine which file
group corresponds to which budgeting year.

IMPORTANT: The aliases must be set before copying driver security so that themost recent year is
used. For example, if a 2020 file group was created and the intent is to copy the file group security
from 2019, then BP_CurrentYear must point to 2019 File Group.

To update file group aliases:
1. In the Admin ribbon tab, click System Browser.
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2. In the Axiom Explorer window, click File Group Aliases, and double-click the BP_CurrentYear or
BP_PriorYear aliases to assign their respective file group year relative to the new file group year.
For example, if creating a new 2020 file group, set the BP_CurrentYear to 2019 and BP_PriorYear to
2018.

3. In the Edit File Group Alias dialog, click the folder icon.

4. In the Choose File Group dialog, select the file group, and click OK.

5. Click OK.

6. Click Close.

Adding a new department
The NewDepartment Utility allows you to easily set up new departments using a copy of accounts from
an existing department as well as add additional accounts to your new department. As a result, you can
configure all necessary accounts for Statistics, Revenues, Deductions, Expenses, and Hours in a single
step. In addition, you can also set up the job codes necessary to populate your labor method.

� Configure the PAYTYPE dimension
In the PAYTYPE dimension, you need to set up the NewDeptStdLine column. By default, this column
populates with NA until you configure it, but will have similar entries as Paytype.KHAStdLine. This column
is used to select the appropriate calculation method to use for the labor method selected for use in the
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new department.

� Manage labor rates when using the New Department utility
When the plan file is built for the new department, it is ready for user input. One of the inputs you need
to configure is the FTE value for each job code. In the following example, two FTEs have been added to
job code J00090 in the FY 2019 Budget column, but notice that the Current, Start, and End Rate columns
are zero.

In the Department - Jobcode Exceptions section, add each department and job code combination. In the
Regular Rate Source column, select Global, and enter the wage rate desired. Save the driver file and then
refresh (F9) the plan file.
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Note that the system nowdisplays the wage rate and calculates the dollars. The word “Global” also
displays next to the Regular row, indicating that this wage rate is controlled from the 27 Budget Labor
Override driver.
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� Alternate configuration
The instructions above present a configuration that enables administrators to allow for FTE input only by
their end users, while administrators control the wage rate. However, if administrators prefer to use the
Add New Jobcode calculation method, then simply exclude the job code(s) when processing the New
Department Utility. Administrators can then add the job codes by using the existing Add New Jobcode
calculation method individually, which then allows for end user input of both wage rate and FTE.

To add a new department:
1. Using the Dimension Maintenance utility, add the new department in theDEPT dimension.

NOTE: Before you can use the NewDepartment utility, the new department must exist as a
valid department with all required columns completed.
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The calculation method available is “Jobcode” and that method assumes historical activity to
populate a rate. To configure for a rate, we will use one of the driver files known as 27 Budget
Labor Override to allow for rates to be applied.

2. In the Explorer task pane, navigate to File Groups > budget file group > Utilities, and double-
click New Department Utility.
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3. In the Refresh Variables dialog, complete the following:

Option Description

Select Existing
Department

Select an existing department to copy from. The existing department will be
used as the profile of accounts and job codes for the new department.

Select New
Department

Select the new department to copy to.

4. Review the rows assigned to the new department, and exclude any that you do not want as part
of the new department profile.

In the following example, the first three rows are part of the actual data of the donor department,
but wemay not want these for budgeting purposes so wewill set these rows to No in the Include
column.
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5. To add additional rows, use the Add Additional Rows section. In the Account column, double-
click the blue input cell to select from a validated list of accounts. Click the blue cell in the Include
Account column and click Yes from the drop-down to confirm the addition of the account.

6. Refresh the utility again to see the final results of the new department’s profile that will be used in
the plan file.

7. The NewDepartment Utility displays the results in the Results of added department section. Use
the drop-down in the Retain or Remove column to remove any accounts within the results that
you want to remove. Retain is selected by default.
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8. After updating the new department’s profile, in theMain ribbon tab, click Save.

NOTE: The system posts the values to the Act[YEAR] table, and uses the database field
NYBKHA as the value to post to so no changes to actual imported data are affected.

9. Using the Dimension Maintenance Utility, update the calc methods for each account in the
NewDeptStdLine column in the ACCT dimension, and click Save.

As of the 2018.4 release, we added a new column to the ACCT dimension for the calculation
methods that would work best in a department that contains no history. For example, when using
patient revenue accounts, typically a per-unit type calculation method would be used. However,
in a new department with no history, Fixed Even or Input Monthly would likely be a better option.
The Acct.NewDeptStdLine column is used to assign the calcutation methods so plan files build with
the relevant methods.
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10. In theDEPT dimension, update the KHACMDimGrp colum as you would any department, but use
NewDeptStdLine and click Save.

11. Click the Jobcode tab at the lower-left of theNew Department Utility.

In the following example, there are only two job codes in the department:

12. To add additional rows, use the Add Additional Rows section. In the Jobcode.BGTCodecolumn,
double-click the blue input cell to select from a validated job code list. Click the blue cell in the
Include Jobcode column, and click Yes from the drop-down to confirm the addition of the
account.
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13. In theMain ribbon tab, click Refresh Data.

14. The NewDepartment Utility displays the results in the Results of added department section. Use
the drop-down in the Retain or Remove column to remove any job codes you do not want to
retain. Retain is selected by default.

15. After updating the new department’s job codes, in theMain ribbon tab, click Save.

Restoring archived plan files
NOTE: For instructions on archiving, see Archiving current year plan files.

You can reverse the archive process by restoring the previous versions of plan files using the restore
point created by the Archive Current Year Plan Files command. However, the previous versions of the
plan files are only available until they are deleted by the system Scheduler job Purge System Data, which
by default runs nightly and deletes old items based on a configured time frame. The restore point is only
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intended as a safeguard for a situation where the command is run accidentally, so that the plan files can
be restored immediately. It is not intended to be used to convert the plan files back to "live" plan files at
a later date. The archive process is permanent except for this short-term safeguard.

This feature is limited to administrators and to users with one of the following security permissions:
Administer File Groups (for all file groups) or Modify File Group (for specific file groups). Users with the
Administer File Groups permission can restore all plan files for all file groups, even if the user does not
otherwise have access to those files. Users with theModify File Group permission can only restore plan
files for which the user has read/write access.

NOTE: If a plan file is deleted, it cannot be restored using restore points. Restore points can only
restore earlier versions of existing plan files.

When restoring plan files, you first select a restore point and then you select the plan files to restore.

To restore archived plan files:
1. In the Explorer task pane, in the File Groups section, right-click the budget for the file to restore,

and click Restore Plan Files.

2. On the first screen of the Restore Plan Files dialog, select the restore point to use, and then click
Next. Restore points are identified by date/time and description.

3. On the second screen of the dialog, select the plan files to restore, and then click Finish.

This screen only lists the plan files that have been changed since the date/time of the selected restore
point. You can select individual plan files or you can select the check box in the header to restore all of
the plan files. You can use Axiom grid features to sort and filter the list.

If no plan files have been changed since the selected restore point, a message displays to inform you of
this.

The restore process creates a new plan file version that is a copy of the version from the selected restore
point, and that new version becomes the active version. For example, imagine that the current plan file
version is version 10, and you want to restore version 9. The system creates version 11 of the plan file,
which is a copy of version 9. Both version 9 and 10 still exist as independent versions in the document
history for the plan file.

Managing restore points
You can create custom restore points and you can delete existing restore points that are no longer
needed. For example, you may be preparing to open the file group for end user input, and you want to
manually create a restore point before users start editing plan files.

To manage restore points:
1. In the Explorer task pane, in the File Groups section, right-click the budget to manage the restore
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points for, and clickManage Restore Points.

2. Do any of the following:
l To create a new restore point, click New. Enter a description for the new restore point, and

then click OK. The date/time for the new restore point will be the current date/time.

l To delete a restore point, select the restore point, and then click Delete. This action simply
deletes the restore point so that it is no longer available for selection; it does not delete the
associated plan file versions from the database audit history.

NOTE: Restore points are automatically deleted when the plan file versions associated
with the restore points are no longer available in the database audit history.

The availability of restore points and the associated plan files depend on your system purge settings, as
defined in the Scheduler system job System.SystemDataPurge.

The setting Audit History: Number of days to keep system history determines how long old plan file
versions are stored in the database. For example, if this option is set to 15 days (the default setting), then
you can only restore plan files from the last 15 days; anything older than that has been purged from the
database. Therefore, Axiom Software also uses this setting to automatically delete old restore points
from the same time frame, since those restore points no longer have any plan files available to restore.

For more information, see Configuring plan file purging.

Configuring plan file purging
When setting the number of days to purge, we recommend keeping the number of days to a minimum
because it can affect the system performance as a result of storing plan file copies for an extended period
of time.

To configure plan file purging:
1. In the Admin ribbon tab, click Scheduler.

2. In the Schedule Jobs tab, double-click System.SystemDataPurge.
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3. On the left side of the screen, click Tasks > SystemDataPurgeTask.

4. In theNumber of days to keep result history field, type the number of days to keep the archived
file, and click Save.
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Setting Up Budget Plan Files
The numbered list below include the required and optional steps you need to complete to configure,
test, and release the budget plan files in your organization for the next budgeting season. The system
can also walk you through these same steps by running the Budget Checklist process.

TIP: The steps below link to the corresponding help topics, where applicable.

1. Change year and period.

2. Prepare data for budget go-live.

3. Reconcile data.

4. Create one plan file for each Labor tab template.

5. Process one plan for each Labor tab template.

6. Create plan files using the scheduled job.

NOTE: Run the Build & Process Budget Files job in Scheduler, and use a filter to run the job.
Review the log for errors once the scheduled job completes to confirm that no errors have
occurred.

7. Open a plan file, and save it to confirm there are no errors on save.

8. Review the Budget Configuration driver.

9. Review all the tabs of a plan file for reasonableness.

TIP: Specifically focus on the Stat_Rev, Expense, and Payroll tabs

10. General plan file tab review

a. Ensure navigation under Go To jumps as expected for all tabs.

b. Row/Col headers should be turned off for all tabs.

c. Confirm all print definitions look as expected.

d. Test each View option to ensure it displays/hides parts as expected.

4
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e. Verify print settings for all worksheets.

f. Save the plan file to the database without any errors.

g. Repeat steps below for different departments types (Nursing, Fixed, Admin).

11. Instructions tab review.

a. Review the due dates.

b. Review the budget questions.

c. Review the budget assumptions.

12. Summary tab review.

a. Do initiatives display as they should? Are initiatives set to be displayed in Budget
Configuration driver?

b. Review labels for proper year setting.

TIP: Projected Year settings are highlighted in blue in the Budget Configuration driver
and can be budget group specific.

c. Confirm columns hidden in the Budget Configuration driver are hidden in the plan file.

TIP: Set the Hide Column option in Budget Configuration driver.

d. Confirm "Display Contribution Margin on Summary Tab" is set properly.

TIP: Set the Display Contribution Margin on Summary Tab? option in Budget
Configuration driver.

e. Review dollar and % variances for NYB to ensure reasonableness.

13. Stat_Rev tab review.

a. Verify that History and YTD numbers are accurate.

b. Verify that Projected numbers appear reasonable.

c. Verify that all expected accounts interfaced.

d. Verify that accounts appear under the correct section.

e. Verify that accounts use the expected calc method.

f. Test changing a calc method type used in a plan file.

g. Confirm statistics coming from the Budget Statistics driver do not contain blue input cells.

h. Confirm correct Budget Method selection.
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i. Verify that sections without data are hidden, as expected.

j. Verify that the Global Drivers are reflected at the top from the Budget Driver driver for the
corresponding Budget Group.

k. Verify that all the expected drivers display.

l. Verify that key statistics, identified in Dimensions, are listed.

m. For revenue accounts, verify that the global adjustments display from the Budget Revenue
Adjustments driver.

n. Check review projections in CYP.

o. Test that the summary section for revenue ties with the detail sections.

p. Confirm that the columns hidden in the Budget Configuration driver are hidden in the plan
file.

q. Test to confirm red flag warnings disappear when all comments with red flags include
comments.

14. Expense tab review.

a. Verify that History and YTD numbers are accurate.

b. Confirm column labels are accurate from the Budget Configuration driver.

c. Verify that all expected accounts interface.

d. Verify that accounts display under the correct sections.

e. Verify that accounts use the expected calc method.

f. Test changing a calc method type used in a plan file.

g. Confirm that expense adjustments interface from expense-related drivers (Budget
GlobalExp, Budget GlobalData, etc.) for all calc methods (Budget Group specific).

h. Test resolving "Salaries do not match" warning.

NOTE: Test with provider and non-provider plan files.

i. Test using ePTO with and without ePTO (Gross and Net).

NOTE: See the Earned Paid Time Off setting in the Budget Labor Configuration driver to
configure this feature.

j. Test resolving "Hours do not match" warning.

NOTE: Test with provider and non-provider plan files.
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k. Ensure that the Budget Method is correct for Detail Method.

l. Review the Statistics spread total for Key Stat accounts.

m. Confirm that the projected numbers appear reasonable.

n. Confirm that the columns hidden in Budget Configuration tab are hidden in the plan file.

o. Confirm that KHABgtMap works as expected.

NOTE: The DEPT column for calc methods that use KHABgtMap will be highlighted in a
different background color. The DEPT column is visible ONLY if KHABgtMap is in used.
Otherwise, the column is hidden.

p. Test the drilling feature by drilling historical GL Transactions.

NOTE: See the Expense Transaction Drilling setting in the Budget Configuration driver to
enable this feature.

q. Confirm that the Use Preliminary Estimate on Detail Calc Method option in the Budget
Configuration driver works as expected.

15. Labor tab review.

a. Verify that the plan files interface with the expected labor type.

NOTE: ACCT.KHAStdLine (or other StdLine columns) Calc Method selection (Labor,
ProviderLabor, etc.)

b. Verify that the expected job codes are interfaced.

NOTE: All job codes that work in the Dept YTD will be interfaced into the Dept.

c. Review the Uniform Merit Increase Date.

d. Review the FTE Comparison to YTD.

e. Test with Projected FTE Starting Point.

f. Test with Forecast FTEs from Projection.

g. Change the titles for Program Additions Title and Position Changes Title, and confirm it
displays up in the plan file.

h. On the Staffing and Jobcode tabs, test % of Staffing Change with Volume.

NOTE: The default is set to 60% for Variable job codes.

i. Ensure that the FICA limits apply, regardless of the fiscal year (it should taper down in the

Administrator's Guide Axiom Budgeting and Performance Reporting │ 55



months of Oct – Nov, regardless of the fiscal year).

j. Ensure that the total dollars match the dollars on the Expense tab.

k. Confirm that the YTD Hours and YTD Dollars are accurate.

l. Confirm that the GL mapping is accurate.

TIP: Select the Audit view in the Labor tab to confirm the account coding.

m. Test the Dept_BasePay calc methods.

n. Review the allocation rates in the JobCode block for reasonableness.

o. Confirm that the PayTypeMapping Analysis report includes no variances.

p. Confirm that only the PayTypes mapped on the Budget Labor Configuration driver interface
into the Jobcode block.

q. Confirm that the Contract labor (Agency) is set up and interfaces appropriately.

r. Confirm ePTO GLAcct maps correctly when set to Yes.

NOTE: Review the Earned PTO Hours Conversion Factor (by default, the system sets
this to 80 hours) and PTO per FTE (by default, the system sets this to 176).

s. If using Lump Sum, confirm that the Budget Labor Limits is set up for max rates.

NOTE: The default is 100% for full payout ofmerit abovemax rate.

t. Test by adding a new PayType to the Dollars section of JobCode block.

u. Review the Fixed/Variable coding for each job code and test variability.

NOTE: For JobCode and Staffing labor tabs only; Comes from Dimension setting
JobCode.Variable.

v. Test the overrides from the driver, if Budget Group specific.

NOTE: Cross check with the Budget Labor Override driver.

w. Update/change the days staffed and shift hours (impacts variable spread)

NOTE: For the Staffing and JobCodeADC labor tabs only.

x. Employee labor tab only:

l Confirm that the Empl_List tab is unavailable.
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l Review the Employee labor tab for a complete list of the employees.

y. ADC labor tab only:

l On the ADCConfig tab, add a block for Global Budget Group and Dept Exceptions.
Ensure that the ADCConfig tab options came through as expected.

l Confirm that the Jobcode and ADC tabs are equal to each other for FTEs.
l Review FTEs and Hours calculations for reasonableness.

16. Empl_List tab review.
a. Verify all of the interfaced data (comes from EmployeeMaster import).

b. Check that all employees or job codes display under their home department.

c. Check that increases are populated.

d. Test the Lump Sum options.

17. Initiatives tab review (if applicable).
a. If enabled in New Initiatives tab of drivers, all the approved initiatives display on the

Summary tab, and save to the database.

b. The list of initiatives that displays in the New Initiatives tab of Drivers is available for
selection.

c. Test by adding new calc methods.

18. Dept_History tab review.
a. Validate data by ensuring that the historical data ties to department P&Ls.

b. Check that the Dept column for calc methods that use KHABgtMap are highlighted in a
different background color.

NOTE: The Dept column is visible ONLY if KHABgtMap is used. Otherwise, the column is
hidden.

19. Provider and Provider Comp tab review.
a. Verify that History and YTD numbers are accurate.

b. Verify that projected numbers appear reasonable.

c. Verify that all the providers that meet the threshold setup display, if applicable.

d. Verify the summary section totals the detail sections.

e. Verify that all stats and revenue flow to the Stat_Rev tab, as expected.

f. For Provider Detail methodology:
l Verify the FTE is pulling from the ProviderComp tab.
l Review the overall driver for the department, and compare the production days

Administrator's Guide Axiom Budgeting and Performance Reporting │ 57



based on provider FTE.
l Verify that seasonality appears reasonable, if provider has at least one year of

history.
l Review the various data breakout, if using the detail method, to make sure the data

is grouped appropriately.
l Review the Gross Charges section, and verify that the charges calculate either on

Encounter, WRVU, Procedure, or RVU.

g. Provider Summary methodology:
l Verify that the system appropriately pulls FTE and driver stats from the Simple Dept

Config driver.
l Verify that the system pulls the spread from the Simple Dept Config driver.

h. Verify that the expected job codes relating to providers interface with the ProviderComp
tab.

NOTE: The system will interface all job codes that have worked in the department YTD
into the department when the KHAInt on the Jobcode dimension is set to Provider.

i. Verify that the YTD Hours and YTD Dollars are accurate.

j. Verify that RVUs flow from the Provider tab.

k. Verify that the Comp Models pull properly from the Provider List driver.

l. Complete a few calculations manually to verify that the expected salary calculates.

m. Review the compensation spread for reasonableness.

n. Verify any additional pay/benefits either calculate properly in the provider block and/or pull
appropriately from the Provider List driver.

o. Ensure that the FICA limits are applicable, regardless of the fiscal year.

NOTE: It should taper down in themonths of Oct – Nov, regardless of the fiscal year.

p. Verify that the GLMapping is accurate and flowing to the Expense tab.

20. Reconcile the budget.
a. Schedule nightly recalculation for all budgets to transfer results to the database.

b. Correct any errors encountered during the recalculation process.

c. Review the Budget Income Summary report for reasonableness.

21. Run and review optional calculator reports.
a. NewDepartment utility
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TIP: This utility is located in the Utility section of the file group year you will use for the
planning cycle.

b. Deductions Calculator by Payor utility

TIP: Do not create a plan file for the Budget Deduction Department when using this
utility.

c. Deductions Calculator using FSDetail utility

d. Deductions Calculator using FSPayor utility

e. Budget Balance Sheet and Cash Flow utility

22. Run and review Budget Reconciliation reports.
a. Budget Department Audit report

b. Budget Process Management report

c. Budget Workbook Reconciliation report

d. Global Depreciation Reconciliation report

e. Global Expense Reconciliation report

f. Global Revenue Reconciliation report

g. Labor Non-Matched report

h. Payroll12 Hours Reconciliation report

i. Payroll12 Negative Hours report

j. PayTypeMapping Analysis report

k. Reconcile NYBDetail to Financial report

l. Reconcile Payroll12 to Financial-Dollars report

m. Reconcile Payroll12 to Financial-FICA report

n. Reconcile Payroll12 to Financial-Hours report

o. Salaries Do Not Match report

23. Delete test plan files.

24. Clear test data from the budget data table.

25. Build budget plan files.

26. Process budget plan files.

27. Verify plan file creation and interface.
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28. Advance the plan files using Process Management to Owner stage.

Running the Budget Checklist process
Use this process to walk you through the steps needed to create plan files for the next budgeting season.
The Budget Checklist process displays all of the steps to complete on the left side of the window. Those
steps that include sub-steps are indicated with an arrow icon, which you can click to expand or contract
the list.

To run the Budget Checklist process:
1. In the Bud Admintask pane, in the Prepare Budget Plan Files section, double-click Budget

Checklist.

2. In the Process Owner field of the Process Properties tab, do one of the following:
l To assign a specific user as process owner, click Select User.
l To assign users with specific roles as process owners, click Select Role.

NOTE: You must assign a user or role before you can run this process.

3. Click Start Process in the upper right corner of the dialog.
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4. At the Start process 'Budget Checklist' prompt, click OK.

5. As you complete each step, click Complete step in the upper right corner of the screen.

TIP: An arrow icon displays next to steps that contain sub-steps. Click the icon to expand or
contract the list of sub-steps.

NOTE: You can skip steps that do not apply to your organization.

6. In the Process Action dialog, you can enter any details about the step you performed, and click
OK.

TIP: The dialog also displays the next step in the process.
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7. If you need to stop the process as you work on the different steps, click Stop process in the upper
left corner above the list of steps. This places the process in an inactive status until you are ready
to start the process again.

TIP: To view a report of the process history, click Process history in the upper left corner above
the list of steps.

8. At the Are you sure that you want to stop this process? prompt, click OK.

Setting year and period
Use this table to configure the following for your organization:

l Set the fiscal year and the first month of the fiscal year
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l Define the number of work days in the current year, last year, and next year
l Select the standard Full Time Equivalent (FTE) hours worked by employees in a year.

NOTE: The standard FTE hours you select in this worksheet displays as the default FTE Hours in the
Budget Labor Configuration

The FTE Hours you select are reflected on the following tabs in the plan file:

l Expense
l Jobcode
l Staffing
l Employee
l ProviderComp
l altEmployee
l HHLabor

To set year and period:
1. In theMgmt Admin task pane, in theData Maintenance section, double-click Update Year and

Period Tables.
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2. In the Primary Inputs section, complete the following options:

Option Description

Fiscal Year Select the fiscal year.

Fiscal Start Month Select themonth in which the fiscal year starts.

FTE Hours Select one of the following:

l To use the standard of the number of days worked multiplied by a
40-hour work week divided by 7, select 2086.

l To use the standard 40 hour work-week multiplied by 52weeks,
select 2080.

3. In theWorking Days Inputs area, enter the number of working days for the current year, last
year, and next year for each fiscal month.

TIP: To hide the year and/or period tables, click the corresponding check boxes under the
Working Days Inputs section.

4. After making your changes, click Save.

Preparing data for budget go-live
Importing and loading data is an important part of keeping your budget up-to-date and correct. We
recommend that you perform these actions on a biweekly and monthly bases.

The following topics provide instructions on running the required and optional data imports reports.
These are the same imports you will run to create your monthly reports.

IMPORTANT: You must load and reconcile data before you start building and processing plan files.

Run these imports and utilities in the following order to load your data into the system:

1. Import General Ledger data - The Load 12Month import brings in 12months of General Ledger
data from your source system. This will include values for revenues, deductions, expenses, etc. -
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including values for balance sheet (if provided).

2. Import Monthly Statistics data - The Load Monthly Stats import brings in departmental-level
statistics, including key and non-key statistics. This can also include facility-level statistics. If payroll
hours are not imported through the Payroll Transfer utility, then they will commonly be imported
using this import.

3. Import Biweekly Payroll data - Imports biweekly payroll data, which includes identifying
department, job code, pay type, and employee ID values.

4. Load EmployeeMaster - Imports the employee level detail information, including base rate,
full/part time status, anniversary date, PTO balance, etc. The employees are listed by job code.
The employeemaster is used in the interfacing and plan files to apply merit and market
adjustments.

5. Loading Revenue and Usage data - Imports your Charge Description Master (CDM)monthly data,
including department, CDMCODE, revenue and volume type (i.e. inpatient, outpatient).

NOTE: This import only applies if your organization is licensed for the CDM template.

6. Load Provider Data - Imports the transactional-level records for a provider, including ID,
department, and key database fields such as CPT, location, FinClass, and other related records.
This information is used for reporting and budgeting purposes. Once loaded, you can configure
whether to use the Provider Summary or Provider Detail options, and adjust your dimension
accordingly. This is the core transactional data from your provider billing database.

NOTE: This import only applies if your organization is licensed for the Provider feature.

� Other imports
These imports can be run in any order, as needed, with the exception of the Biweekly to Monthly Payroll
Accrual utility. While these imports are not required to create budgets, they do provide enhanced
reporting and plan file analysis without having to leave the Axiom application.

l Running the Biweekly to Monthly Payroll Accrual utility - Run this utility to accrue for hours,
dollars, and statistics from your biweekly payroll import(Payroll26) into themonthly data tables
(Payroll12).

IMPORTANT: This utility is a prerequisite to using theMonthly to GL Accrual utility.
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l Running theMonthly to GL Accrual utility - If payroll hours are not coming through your GL
Import, you can move your hours from the Payroll12 data tables created from the previous
process to your Financial tables by running theMonthly to GL accrual utility.

IMPORTANT: Only run this utility if you are not loading hours from your GL using the GL12
Month or Monthly Statistics imports (step 1 or 2 above).

l Loading AP Detail data - Imports your Accounts Payable sub-ledger detail, including amount,
check date, check number, invoice date, invoice number, etc.

l Loading GL Detail data - Imports your general Journal Entry detail, including department, account,
and other identifying information.

l Loading MM Detail data - Imports your Materials Management sub-ledger detail, including
amount, item number, item description, location, quantity, unit price, and vendor information.

l Loading Accrued Receipts data - Imports your Accounts Receipts sub-ledger detail, including item
number, description, invoice date, vendor name and number, and other vendor identifier
information.

l Summarizing CDM statistics to financial - To use your Charge Description Master (CDMCODE) to
create your statistics, we offer a save-to-database utility that summarizes the inpatient and
outpatient volumes in the RevUsage database (ACT_RU_20XX) into statistic accounts that can be
stored in the Financial database (ACT20XX).

NOTE: For this utility to work, your Kaufman Hall implementation consultant will help you
design your CDMCODE table during the implementation.

� Resolving import errors
If any of the imports experience validation errors, you can view them in two places in the system: a
separate CSV file and the Execution log area of the Execute Import dialog, as shown in Step 8 of Loading
GL12Month data.

For more information, see Resolving import validation errors.

� Generating and publishing monthly reports
After the report data is imported and any import errors are resolved, you can run the Department
Monthly Package report to pull together the different monthly reports with the imported data and
distribute them to the appropriate personnel. For more information, see the following:

l Understanding the Department Monthly Package
l Configuring the Department Monthly Package report
l Processing and distributing the Department Monthly Package report
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Loading GL12 Month data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a GL_ prefix.

To load GL12 Month data:
1. To change the current period, in the Admin ribbon tab, in theDatabase group, click Imports &

Utilities > System Period/Year.

2. In the System Current Period dialog, in theNew Value field, type the newmonth value, and click
OK.

IMPORTANT: Do not change the System Current Year field unless changing over a new fiscal
year. Setting the system period and year could affect other Axiom Healthcare Suite products.

3. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports,
Management Reporting> 01-Load GL 12 Months, and click Execute.
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4. Click Execute.

5. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

6. In the Choose the import source file dialog, select the source file to load.-

If the import encounters validation errors, see Resolving import validation errors.

7. After you load the data, run the Income Statement Summary report in Explorer in Reports Library
> Management Reporting > Income Statement > Income Statement Summary to reconcile to
your GL income statement.

Loading Monthly Statistic data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a ST_prefix.

To load Monthly Statistic data:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 02-Load Monthly Stats, and click Execute.
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2. Click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a ST_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. If you are not loading your statistics through an import set up by your Kaufman Hall
Implementation Consultant, then you can also load statistics using a Save to Database report.
There are standard reports delivered with your system for this, which you can find in Explorer in
Management Reporting Utilities > Data Input > Input Monthly Statistics.

6. Use the top section of the report, labeled Add New Stats, when entering a newDept-Acct
combination into the database.
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If needed, you can copy additional rows by copying the entire row, and then using the Insert
Entire Row option in Excel. If you Refresh the report, it will bring in all existing statistic
combinations from the database, and you can then update any monthly value in the blue cells in
the Change Existing Stats section.

7. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.

Loading Biweekly Payroll data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
The file should be saved as LD_MMDDYY_PP. For example, LD_100418_1

To load Biweekly Payroll data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Table Current Periods.
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2. Filter using the Table Type, and select Payroll.

3. Change the period for all of the payroll tables where theUses System checkbox is not selected.
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4. In the Table Current Periods dialog, double-click the current period for the table, and type the
new period.

5. When you have finished all the tables, click OK.
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6. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 03-
Load Biweekly Payroll > Execute.

7. In the Execute Import: 03-Load Biweekly Payroll dialog, click Execute.

8. In the Variables dialog, do the following, and click OK:

Field Steps

Year Selection: Input
Year (YYYY)

Type the year to load.

PayPeriod: Input
Period (1 – 27)

In the drop-down, select the pay period to load to.
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9. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

10. If there are any import exceptions, follow the import exceptions remediation from .

Loading Employee Master
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a LM_prefix.

To load Employee Master:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 10-Load Employee Master, and click Execute.
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2. Click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

Yr: Input Year (YYYY) Type the year to load.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a LM_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.

Loading Revenue and Usage data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a RU_prefix.
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To load Revenue and Usage data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 09-

Load RevUsage > Execute.

2. In the Execute Import: 09-Load RevUsage dialog, click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

YR: Input Year (YYYY) Type the year to load.

Month: Select
Current Month

In the drop-down, select themonth to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Loading GL12
Month data.

Loading Provider Detail data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a PB_prefix.

To load Employee Master:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 4-Load Provider Detail, and click Execute.
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2. Click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

Yr: Input Year (YYYY) Type the year to load.

Month: Select
Current Month

Select themonth to interface the data into the system from the drop-
down.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a PB_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.
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Loading AP Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an AP_prefix.

To load AP Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

06-Load AP Detail > Execute.

2. In the Execute Import: 06-Load AP Data dialog, click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading GL Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a JE_prefix.

To load GL Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

05-Load GL Detail > Execute.
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2. In the Execute Import: 05-Load GL Data dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading MM Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an MM_prefix.

To load MM Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

07-Load Materials Issues> Execute.
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2. In the Execute Import: 07-Load Materials Issues dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading Accrued Receipts data
Make sure the import file is created and saved to a directory accessible by the Axiom Application server.
We recommend naming the file with an AR_prefix.

To load Accrued Receipts data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 08-

Load Accrued Receipts > Execute.
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2. In the Execute Import: 08-Load Accrued Receipts dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Summarizing CDM statistics to financial
To use your ChargeMaster (CDMCODE) to create your statistics, we offer a save-to-database utility that
summarizes the Inpatient and Outpatient volumes in the RevUsage database (ACT_RU_20XX) into
statistic accounts that can be stored in the Financial database (ACT20XX). For this utility to work, your
Kaufman Hall consultant will help you design your CDMCODE table during the implementation.

To summarize CDM statistics to financial:
1. To run this Save to Database utility, navigate to In the ExplorerExplorer task pane, in the Libraries

section, click the Reports Library > Management Reporting Utilities > RevUsage folder, and
double-click Summarize CDM Statistics.

2. In the drop down box in cell M19, select whether you are running the process for Current Year or
Last Year.
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3. Refresh the data by doing one of the following:

l In theMain ribbon tab, click Refresh Data.

l Press F9.

4. In the File Processing task pane, click Process file.
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NOTE: You do not need to run this utility using Multipass unless you are a large health system and
are noting performance issues when previously running.

Resolving import validation errors
If the import experiences import validation errors, you can view them in two places in the system: a
separate CSV file and the Execution log area of the Execute Import dialog, as shown in Step 8 of Loading
GL12Month data.

The CSV file is located in Explorer in the Imports Library > Management Reporting > Import Errors
folder.
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The CSV file shows you which rows of data were invalid within the context of the import data. This error
file includes the following:

l Look up validation errors from Kaufman Hall's Software's built-in validation against lookup
columns.

l Validation errors from any Custom Data Validation steps in the transforms.

l Key validation errors such as blank keys or duplicate keys.

You can also open the file from the Execute Import dialog by clicking the link the Status area. The status
displays either "failed" or "warning," followed by "click here to open errors in a spreadsheet." The status
type depends on whether the option to Ignore lookup and key errors is selected.
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Each execution of an import that results in a lookup error generates a unique error file (differentiated by
a date/time stamp). These error files are not automatically deleted; you must manually delete them
when you finish investigating the error.

The CSV file contains the import data, followed by one or more validation columns. Validation columns
are labeled as follows:

l LookupColumnName Lookup Error column – Contains lookup and key validation messages. For
example, Acct Lookup Error"\ when looking up against the ACCT column.

l AXTRANSFORM_StepNumber column – Contains Custom Data Validation messages where
StepNumber is the number of the associated transformation step. For example, AXTRANSFORM_5
when the associated transform is step 5 in the list.

If there are errors (most commonly new codes in Dimensions), add those codes to dimensions, and re-
run the import.
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Reconciling data
After importing and loading the data, you need to reconcile it to make sure it enters the system correctly
before starting the budget process. We recommend that you perform these actions on a biweekly and
monthly bases.

The following topics provide instructions on running the required reconciliation reports. These are the
same reports you will run to create and reconcile your monthly reports.

IMPORTANT: You must load and reconcile data before you start building and processing plan files.

Run these imports and utilities in the following order to load your data into the system:

1. Reconcile Income Statement - Use this report to review the Income Statement totals by FSDetail
category for the current period and year-to-date compared to budget and prior year.

2. Reconcile GL to GL Transactions - If you load sub-ledger detail, such as Accounts Payable (AP),
Accrued Receipts (AR), Materials Management (MM), and Journal Entries (JE), we have a
reconciliation utility that ties the sub-ledger data back to the General Ledger data (ACT20XX). This
report confirms that the data loaded to the GL matches the data loaded to the Journal Entry (JE)
detail. It also compares the JE detail to AP, MM, and AR transactions to make sure the data
balances.

3. Reconcile GL to RevUsage - Use this report to reconcile GL revenue data in the Financial tables to
the Revenue and Usage data imported into the database on a monthly and year-to-date basis.
The desired result for this report is to show a zero variance.

4. Monthly RevUsage Reconciliations (For CDM template licensed users only) - After all revenue and
usage data is loaded, run theMonthly RevUsage Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for each month.

5. Biweekly Payroll Reconciliation - Run this report after loading the biweekly payroll data to validate
totals for the dollars, hours, and statistics from the import file.

Working with Dimensions
Dimensions are the key index fields for the tables in the Axiom Budgeting and Performance Reporting
2020.3 database. All data in the system will be associated with one or more dimensions.

A few examples of dimensions used in Axiom Budgeting and Performance Reporting 2020.3 include:

Each dimension has multiple fields. The fields within dimensions tables are typically referred to as
columns. Field/column names are expressed as tablename.fieldname.
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When Axiom Budgeting and Performance Reporting 2020.3 is first implemented, your Kaufman Hall
Implementation Consultant helps you configure the dimension tables to reflect the structure of your
organization (departments, entities, accounts, and so on). Subsequently, you may need to edit
dimensions in order to add new departments, accounts, positions, pay types or other items to the
database.

Working with the Dimension Maintenance Utility
Your organization may usemultiple distinct Entity Management branches within your structure to help
manage your Axiom products. It might be the responsibility of each local product administrator to
maintain their own elements within dimensions for each Axiom product that your organization is
licensed for. Additionally, and ideally, each administrator should not be able to modify elements outside
of their area, otherwise, reports and processes could be negatively impacted.

The Dimension Maintenance Utility allows the administrator for a local branch to manage only grouping
columns within a dimension and limits this dimension to only the elements that the administrator has
access to.

IMPORTANT: Version 2017.1 and higher includes a variety of security changes to enable this tool. The
dimension tables have been restricted to read-only access until the system administrator configures
a user for dimension maintenance security. For more information, see Editing the security rights for a
user.

The Dimension Maintenance Utility allows administrators to:

l Havemulti-user and filtered access to key universal dimensions.

l Restrict dimension grouping column maintenance to specified product grouping columns.

l Create dimension grouping columns, and assign them to products.

l Add new records and update all validated grouping columns, even when they are outside of that
product range.

l Create dimension grouping columns that automatically display in an organized manner.

To enable the Dimension Maintenance functionality described above, the following features were
created:

l In the Edit Data Structuremode, administrators can manage grouping columns using datasets.
l In the Dimension Maintenance Utility, depending on their roles, users can select the products and

dimensions to maintain.
l Using the security feature in the Dimension Maintenance Utility, for each product, administrators

can quickly assign write filters to those users who have an administrator role assigned to them.
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The following table represents which dimensions are part of each product. A check mark means users can
access the dimension using the Dimension Maintenance Utility, but the records each user can edit
depends on the security filter applied to each.

The following dimension tables are not affected by this update and are not part of the Dimension
Maintenance Utility. Each of these dimensions retain:

l Full edit rights, per authorized user.
l Ability for direct table edit.
l Leverage existing edit tools as you have used in the past.
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IMPORTANT: Because Axiom Budgeting and Performance Reporting uses CDMCODE, GLPERIOD, and
INITIATIVEID dimension tables, which are not included as part of the Dimension Maintenance Utility,
you will need to access these dimensions in the Budget System Maintenance > View Dimension
Tables area of the Bud Admin task pane or from the Explorer task pane.

Configuring the Dimension Maintenance Utility

To configure the Dimension Maintenance Utility, do the following:

1. Configure the utility to assign any custom dimension grouping column to their respective
products. For more information, see Assigning an existing grouping column to a dataset (product).

2. Configure the security for each administrator user in the utility. You must apply a dimension filter
to any member that you want to have edit rights. IfNotConfigured displays, then the user does
have edit ability. A filter grants users edit abilities for those records within the assigned filter. For
more information, see Editing the security rights for a user.

3. Review and test the Dimension Maintenance Utility.

Editing the security rights for a user

You can only access the security management feature of the Dimension Maintenance Utility if you are
assigned the security administrator role.

With Dimension Maintenance - Security, you can set in bulk the security rights for all users assigned a
product administrator role for all dimensions for a specific dataset (product).
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NOTE: If a user is assigned as an administrator for a product and as a user for another product, the
user can only access the tables for the product they are administrator of. For example, if a user is a
product administrator for Axiom Cost Accounting and a user for Axiom Budgeting and Performance
Reporting, the user would only be able to edit the dimensions for Axiom Cost Accounting.

IMPORTANT: For a user (with a product administrator role) to edit a dimension, you must first assign
them security rights using this utility.

To edit the security rights for a user:
1. From the Explorer task pane, in the Reports Library section, select System Files > Dimension

Maintenance, and double-click Dimension Maintenance - Security.

2. In the Select a Product drop-down, select the product to display the respective product
administrators, and click OK.

3. Select a user, and do one of the following:

IMPORTANT: IfNotConfigured displays in the cell, then the user does not have edit rights. For
full edit access on numeric dimensions, enter >= 0, for example Acct > 0.
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To... Then...

Use the filter
wizard to specify
the security
rights

a. Right-click the cell to edit.

b. Select Axiom Wizards > Filter Wizards.

c. Use the Filter Wizard to select and specify
the security rights for a product
administrator. For more information on
using the Filter Wizard, do the following:

i. On theMain ribbon tab, click Help.

ii. In the left navigation pane, click
Reference > Filters > Filter
Wizard.

Enter the
security rights
manually

Click in a cell, and type the rights.

In the following example, Angela is not authorized to edit the ACCT dimension. She can, however,
edit the DEPT dimension records for departments that belong to Entity 2.

4. In theMaintenance - Security table, at the top of the utility, On indicates saving will post changes
to the database.
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NOTE: The ability to save is initially enabled (On). Clicking Save on theMain ribbon tab posts
any changes to the database.

5. In theMain ribbon tab, click Save.

Assigning an existing grouping column to a dataset (product)

You can associate each grouping column you create with multiple licensed products. The assignment
determines which product each column gets displayed under within the Data Maintenance utility.

NOTE: You can only perform assignments for custom columns that your organization has added. We
recommend that you do not change the assignments of any standard columns included with the
product.

IMPORTANT: Make sure to define a default value entry for the column. To do this, complete steps 1-
8 of Creating a grouping column.

To assign an existing dimension grouping column to a dataset (product):
1. From the Explorer task pane, in the Libraries section, click Table Library > !Dimensions.

2. Right-click a dimension, and select Edit table structure.
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3. In the Edit Table dialog, click the Columns tab.

4. In the list of columns, select a column to assign, and click the Assign Column to Data Sets button.

5. In the Data Set Assignment dialog, in the list of data sets (products) that have predefined for you,
select the checkbox next to the products to assign this grouping column to, and click OK.

NOTE: The list that displays will vary depending on the Axiom Healthcare Suite products you
are licensed to use.
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Product Product Node

Budget Planning BP

Financial Planning FP

Rolling Forecast RF

Cost Accounting Cost

Cost Management CM

Capital Planning CP

Decision Support DSS

Capital Tracking CT

Performance Reporting PR

Available to all related products General
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After you select the products, they display in the Edit Table dialog in the Product Data Sets field.

6. In the Edit Table dialog, click OK.

Managing dimensions
After you configure the Dimension Maintenance Utility and set the security rights for the appropriate
users, they can access the utility from the Administrator task pane to manage and configure dimensions.
The products and dimensions a user can access will vary depending on their role. As an administrator,
you can select all of the Axiom products.

For more information, see the following:

l Launching the Dimension Maintenance Utility
l Editing a dimension
l Adding a dimension record
l Creating a grouping column

Creating a grouping column

Some dimension tables include grouping columns that allow data associated with those records to share
common settings or be rolled up into larger groups for calculation or reporting purposes.

NOTE: If you created a custom grouping column in Axiom Budgeting and Performance Reporting
version 2016.4 or earlier, you need to assign it to a data set (product). For instructions, see Assigning
an existing grouping column to a dataset (product).

Here are a few guidelines for naming your columns:

l Keep the descriptions of grouping columns short and simple.
l Avoid using common English words in your grouping column names, such as Interface or Union.

Instead, combine words to come up with column titles such as IntGroup.
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l It is good practice to fill out each grouping column for every element (table row).
l Spaces are not allowed. Use the underscore to separate upper/lower case words.
l Grouping columns cannot start with a number, but they may include a number.

To create a grouping column:
1. In the Explorer task pane, in the Libraries section, click Table Library > !Dimensions.

2. Right-click the dimension table to add the grouping column to, and select Edit table structure.

3. In the Edit Table dialog, click the Columns tab.

4. Above the list of column names on the left side of the tab, click the + button.

5. In the Column Name field, type a name for the new column.

IMPORTANT: Use only alphanumeric characters in group column labels.

6. In the Data Type field, click the drop-down button, and select String.

7. In theDefault Value field, type a default value that displays to the user.

8. Click Apply.

9. In the list of columns, select the column you just added.

10. Above the list of columns, click the Assign Columns to Data Sets button.

11. In theData Set Assignment dialog, select the checkbox for any Axiom Healthcare Suite products
to add to the column to, and click OK.

12. In the Edit Table dialog, click OK.

13. To view the new column, in theMain ribbon tab, click Refresh Data.

The new grouping column nowdisplays in the dimension.

Editing a dimension

The Dimension Maintenance Utility allows you to edit the grouping columns for one or more products,
but the product options available to you depend on the role assigned to you. Axiom Financial Planning
administrators have rights to Financial Planning dimensions, Axiom Capital Planning and Capital Tracking
administrators have rights to Capital dimensions, and so on.

TIP: You never edit database tables directly in the database. Instead, data is pulled into
spreadsheets, where you can edit the data and then subsequently save it back to the database.

The columns that display depend on what products each column is assigned to using the Data Set
Assignment.

When editing dimensions, keep in mind the following:
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l The products you select determine the columns you can view.
l The dimension you select determines the table you can edit.
l Your role determines the records you can edit.

Some dimensions are not included in the Dimension Maintenance Utility. You can continue to access and
modify these dimensions from the Axiom product's Admin task pane, as usual. If the dimension you
open displays as read-only, this means that you need to use the Dimension Maintenance Utility to
modify it. For example, in Axiom Budgeting, when you open the DEPT dimension from Bud Admin task
pane > Budget System Maintenance > View Dimension Tables, the tab displays DEPT R/O. Though you
can view the dimension, you need to use the Dimension Maintenance Utility to edit it. On the other
hand, if you open the INITIATIVEID dimension, the tab does not display R/O. This means that you can
modify the dimension as usual. This is because the INITIATIVEID table is not included in the list of tables
that aremaintained via the Dimension Maintenance Utility. For a list of dimensions not included in the
Dimension Maintenance Utility, see the Overview section.

IMPORTANT: Edit dimension data with extreme care, as any errors introduced could cause problems
throughout the system. Do not modify fields not described in Axiom documentation.

After you select the product(s) and dimension to edit, the Dimension Maintenance Utility refreshes itself
and displays the different products and the columns that belong to them for the dimension. As seen in
the following example, the columns display in groups.

TIP: It is not always necessary to populate every field. Enter as much information in the dimension
table as you have available.
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In the blue cells, you can do the following:

l Choose from a list of validated values by double-clicking the folder in the column next to the
grouping column.

l Enter free-form values, though we recommend that you take into consideration any existing
values or rules for that column.

Grouping columns tagged as General display first, as shown in the previous example. General columns
are typical reference fields leveraged by multiple products. Each subsequent grouping displays based on
the products you selected. Records display depending on the security assigned to you. For example, if a
no write filter is assigned for that member, the dimension will return no records. For more information,
see Editing the security rights for a user.

IMPORTANT: If you are not sure whether to edit a cell, contact your system administrator.

Some columns in dimensions tables are validated, allowing only certain predefined values. If you enter
an invalid value, an error will occur when you save, specifying the cell so you may make a correction and
save again.

The following are examples of validated columns:

l RFCODE.RFStdLine – Used during the reporting process to identify the standard financial
statement categories to use for each RFCode category. (Same as Acct.FSDetail in Axiom
Management Reporting.)
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l RFCODE.RFType – Used during the forecast workbook interface process to define the categories
within each model that an account or account group will be categorized into. (Similar to
BudgetType in the traditional budget workbooks.)

For more information, see Adding validations.

To edit a dimension:
1. Launch the Dimension Maintenance Utility.

2. In the RF Admin task pane, in theDimension Update section, double-click Dimension
Maintenance.

3. In the Cap Plan Admin task pane, in the Administration section, double-click Dimension
Maintenance.

4. In the Cap Track Admin task pane, in the Administration section, double-click Dimension
Maintenance.

5. In the Cost Accounting Admin task pane, in the Costing Structure Maintenance section, double-
click Dimension Maintenance.
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6. In the Bud Admin task pane, in the Budget System Maintenance section, double-click Dimension
Maintenance.

7. In the Refresh Variables dialog, do the following, and click OK:

a. In the Select The Product To Edit drop-down, select the product.

NOTE: The list of products that display is determined by the Axiom product licenses
that your organization owns.

b. In the Select a Dimension to Edit drop-down, select the dimension.

c. In theOptional Data Filter field, do one of the following:
l Type a filter syntax.
l To select an existing filter or create a filter that you can save for later use, click Select

Filter.

8. To retrieve a smaller subset of data, you can use theQuick Filter in theWorkbook Options of the
Main ribbon tab.

For detailed instructions on how to use the feature, see Applying a Quick Filter to a report.

9. Enter the dimension member attribute information in the appropriate cells. You can type a value
in the cell free-form or select from a list of existing validated values. These are represented with a
folder icon next to the grouping column. You can do one of the following to enter validated values:
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l Next to the column, double-click the folder icon. In the Choose Value dialog, select the
value, and click OK.

l If you have a large number of entries to make, instead of opening each folder, you can copy
and paste the validated value to other cells in the same column.

IMPORTANT: Do not change the format of cells in dimensions (e.g., number, date,
percentage, and so on).

10. After you finish making your changes, in theMain ribbon tab, click Save.

NOTE: If a column is missing, then it is assigned to a different dimension or not assigned. For more
information, see Assigning an existing grouping column to a dataset (product).

Adding a dimension record

When you save the new dimension record, it displays in the existing table on the next utility refresh.

To add a dimension record:
1. Launch the Dimension Maintenance Utility.

2. In the RF Admin task pane, in theDimension Update section, double-click Dimension
Maintenance.
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3. In the Cost Accounting Admin task pane, in the Costing Structure Maintenance section, double-
click Dimension Maintenance.

4. In the Bud Admin task pane, in the Budget System Maintenance section, double-click Dimension
Maintenance.

5. To select the product to add the new dimension record, do the following:

a. Press F9 or in theMain ribbon tab, in theWorkbook Option group, click Refresh Data.

b. In the Refresh Variables dialog, from the Select The Product To Edit drop-down, select the
Axiom Healthcare Product.

c. From the Select a Dimension to Edit drop-down, select the dimension.

d. Click OK.

6. At the bottom of the workbook, click the Add_New_Dimension tab.

7. You can type a value in the cell free-form or select from a list of existing validated values. These are
represented with a folder icon next to the grouping column. You can do one of the following to
enter validated values:
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l Next to the column, double-click the folder icon. In the Choose Value dialog, select the
value, and click OK.

l If you have a large number of entries to make, instead of opening each folder, you can copy
and paste the validated value to other cells in the same column.

8. For each record to create, in the Save? cell, click the drop-down box, and select Yes.

If you do not select Yes, the Save ? cell for the new dimension displays No with a red background
as a reminder that you need to save your changes. If you do not save your changes, the default
values you enter will not display. If you leave the values unpopulated, the system will populate
the defaults using those defined in the column properties in the dimension table.

9. In theMain ribbon tab, click Save.

Upon Save, the new record posts to the database and the utility refreshes, moving the newly saved
record to theDimension Maintenance tab.
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IMPORTANT: When adding new records, the field used as that user’s security filter must be
completed and within their filter before it will save successfully. If it is not, the system displays a
message that you cannot post this record to the database because it is outside of your write filter.
For example, if a security administrator using the Dimension Maintenance Security provides a filter
for Angela to grant her edit rights to the Department dimension for Entity =2, then Angela must enter
2 in the Entity column before saving. For more information about setting up security for the
Dimension Maintenance Utility, see Editing the security rights for a user.

Working with dimensions
Dimensions are key fields in each data table. Each dimension has its own table that includes a series of
attributes (columns) for each element that further defines the dimension. These columns are leveraged
throughout various Axiom Healthcare Suite products in reports, planning processes, and plan file
configurations. Many dimensions, such as DEPT, are shared between various products.

When Axiom Healthcare Suite products are first implemented, a Syntellis Implementation Consultant
helps you configure the dimension tables to reflect the organizational structure such as departments,
entities, accounts, and so on. Subsequently, editing dimensions to add new departments, accounts,
positions, pay types, or other items to the database is part of your routine system maintenance.

IMPORTANT: Becausemany dimensions are shared across multiple Axiom Healthcare Suite
products, do not delete a grouping column or modify entries in the dimension tables without
consulting the administrators for the other applications.

Some columns in dimension tables are validated. This means they only allow certain predefined values
that are contained in validation system table. If you enter an invalid value, an error occurs when you
save, specifying the cell so you can correct it and save again using a corrected entry.

Examples of validated columns include:

l ACCT.Credit – Identifies which accounts should have their signs reversed during an import.
l PAYTYPE.CM_PayCategory – Defines which summary pay category to use for each Cost

Management plan file during a sequential interface. May also be used in reporting for grouping
PayTypes.

l JOBCODE.CM_PlanCode – Used for combining job codes during reporting and Cost Management
plan file creation. If there are historical values for two job codes that you want to report as one
combined job code, list the surviving job code on both lines.

Dimensions aremanaged and maintained using the Dimension Maintenance utility. This utility allows
users assigned the Product Administrator role to only manage grouping columns within specified
dimensions. It also limits these dimensions to only the elements that the Product Administrator role can
access.
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ACCT

The ACCT dimension table contains records for each account in the GL of your organization. This includes
accounts that can be found on the balance sheet, income statement, hours, and statistics.

Refer to the Axiom EPM Dimensions Setup files (AcctCoding sheet) for codes to use in \Axiom\Reports
Library\System Files\Documents\Admin\Management Reporting\KHA EPM Dimensions Coding.xls.

The following table lists all of the options available in this dimension table:

Column Description

ACCT The Axiom Software account number. This can be the combination of the
prime account and sub account, if that is how your GL system is set up.

Description The account description from the GL. Do not enter a description in all
capital letters. To remove the all-caps format in the spreadsheet, use the
Proper formula =Proper().

Credit Used during the interface process to reverse the signs so values are stored
in a positive condition in the database. Select one of the following valid
entries:

l dr
l C
l NA

Normally, Revenue and Liabilities are C, and all others are dr.

RptMap Used to group accounts. Valid entries include any account numbers in the
ACCT column. The system automatically copies the information in the
ACCT column to this column during installation.
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Column Description

Statement Used to identify the Financial Statement category. Select one of the
following valid entries:

l BS (Balance Sheet)
l CM
l HoursJC (Jobcode Hours)
l Hours
l IS (Income Statement)
l KeyStat
l NA
l NI (New Initiatives)
l Statistic
l VCC (Variance Comments Collection)

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.
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Column Description

Type Used to identify themajor Financial Statement category. Select one of the
following valid entries:

l Allocation
l Asset
l Bmark (Benchmark)
l Capital
l Comments
l Deduction
l Equity
l Expense
l FTEs
l GenStat
l HoursJC (Job Code Hours)
l Hours
l KeyStat
l Liability
l NA
l NetAsset
l Plan
l Revenue
l Scenario
l Statistic
l Target (Hours codes that are not reported as FTEs should be coded as

Statistic.)
l VCC (Variance Comments Collection)

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

FSSummary Used to identify summary-level Financial Statement categories. For the
naming convention, use the first letter of the type category with an
underscore and then the category name. For example, R_PatientRev or E_
Salaries.

NOTE: This is an Axiom standard column and categories cannot be added
or edited. Default value is NA.
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Column Description

FSDetail Used to identify line-item Financial Statement categories. For the naming
convention, use the first letter of the type category with an underscore
and then the category name. For example, R_IPRev, R_OPRev. For a list of
the available options, see Options for Acct.FSDetail.

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

FSPayor A variation of FSDetail used if GL accounts have payor categories; used for
Budgeting Deductions models. If this is not used, match to FSDetail.
Categories can be added or edited. The default value is a blank.

FPCode Used to identify the name of the Financial Planning category to use for
summarization during the integration process with Axiom Financial
Planning. If Axiom Financial Planning is not used, the default is NA.

FSProvider Used to identify line-item Financial Statement categories. For the naming
convention, use the first letter of the type category with an underscore
and then the category name. For example, R_IPRev, R_OPRev.

NOTE: This is only used if licensed for the Provider Budget Module. The
default value is NA.

FPCategory Used to identify the name of the Financial Planning category to use for
transferring the financial plan targets during the integration process with
Axiom Financial Planning. If Axiom Financial Planning is not used, the
default is NA.

BPCode Used to identify the payors from the Budget Deductions report. During
installation, the system automatically copies the information from the
FPCode column to this column.

FlexStat Identifies the primary statistic used for Flexible Budgeting. Themost
common set up is KeyTot for all stat, hours, and expenses. Revenue uses
KeyIP for IP, KeyOP for OP, and KeyOth for other patient revenue. The
default is NA.

COSTCAT Represents the cost category mapping of accounts, which is used to assign
cost categories to incoming data when the GL data is imported into a CGL
format table.

FlexPercent Identifies default variable percentage (0-100%) to use for Flexible
Budgeting. Values should be entered as decimals, 0.75 = 75%. The default
value is 0 (zero).

CostMethod Identifies the Cost Calculation Offset Accounts used for writing offsets to
the GL-oriented tables and matches them to themethod that they
represent.
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Column Description

FlexGroup Used to group accounts together for Flexible Budgeting. For example,
Medical Supplies or Other Expenses. The default is NA.

CostVarPct The Percent Variable for Axiom Cost Accounting; 0 = Fixed, which is used in
the costing processes to determine the dollar weighted variability for
calculation results.

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file creation process. Valid entries include the following:

l Stat_Rev – Type this to assign to all statistics, revenue, and deduction
accounts that will be budgeted in the budget plan files.

l Expense – Type this to assign to all expense and hours accounts that
will be budgeted in the budget plan files.

l NA – Type this to exclude an account from all budget plan files.

KHAStdLine Identifies default budget methodology used in budget plan files during
budget plan file creation. Refer to calc methods for Stat_Rev sheet and
Expense sheet in the Axiom Budgeting and Performance Reporting
Administrator's Guide (Budget Plan Files chapter) for valid entries and
definitions. The default value is NA.

CostDSSSummary An FSSummary clone owned by Axiom Cost Accounting and Axiom
Decision Support so that cost accounts can be categorized differently to
facilitate costing and DSS needs without impacting Axiom Financial
Reporting.

KHABgtCode Used for combining accounts together during budget plan file creation. If
there are historical values for two accounts that you want to budget as
one combined account, list the surviving account number on both lines. If
not combining accounts, this value should match value in the Account
column. The default value is 0 (zero).

CostProvider Used by the Axiom Cost Accounting system when performing the Provider
RVU costing method. This identifies the cost information at the account
level that is associated to the Provider, which is then allocated to his or her
patients’ cost item or chargeable activities.
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Column Description

BudgetType Used to identify which category an account should be interfaced to during
the budget plan file interface process.

If KHAInt = Stat_Rev, valid entries are:

l IPRev
l OPRev
l OthPtRev
l OtherRev
l Allowance
l BadDebt
l KeyIP
l KeyOP
l KeyOth
l OthStat

If KHAInt = Expense, valid entries are:

l Salaries
l Benefits
l Supplies
l OtherExp
l PaidHours

The default value is NA.

DropDown Identifies the drop-down pick list when adding new accounts on Stat_Rev
or Expense sheets in the budget plan file. It should be the same as the
value in the BudgetType column.

CDMStdLine Used to identify default budget methodology for CDM budget plan files
(departments that have CDMStdLine in KHACMDimGrp column of DEPT
Dimension) during budget plan file creation. It is used similarly to
KHAStdLine in Budget Planning workbooks.

Valid entries are:

l Statistical accounts = CDMStatistic
l IP Revenue accounts = CDMIPRevenue
l OP Revenue accounts = CDMOPRevenue

Copy the remaining account assignments from KHAStdLine column.
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Column Description

KHASum Used to summarize information from the Stat_Rev and Expense sheets to
the Summary sheet within the budget plan files.

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

CYPMethod Identifies themethodology used for projecting the remainder of the
current fiscal year. Valid entries are dependent upon values in the
KHAStdLine column:

l Input Monthly, Detail, or any of the Fixed Options:
o Rolling12 – Use historical values from previous year's samemonths
o Annual –- Annualize YTD value
o RemBud – Use remaining budget
o CapBud – Use Total Budget less YTD actual
o PctBud – Use percentage of CY Actual over Budget

l Variable – Use Variable
l Labor – Use Labor
l FICA – Use FICA
l Hours – Use Hours
l GlobalExpense – Use GlobalExpense
l Depreciation – Use Depreciation
l IP_Per_Unit – Use IP_Per_Unit
l OP_Per_Unit – Use OP_Per-Unit
l Oth_Per_Unit – Use Oth_Per_Unit

PhyStdLine Identifies default budget methodology used in the Provider budget plan
files (departments which have PhyStdLine in KHACMDimGrp column of the
DEPT dimension table) during budget plan file creation. Refer to Provider
Version Only: Calc Methods - Stat_Rev Sheet and Expense Sheet in the
Axiom Budgeting and Performance Reporting Administrator's Guide
(Budget Plan Files chapter) for valid entries and definitions.

The default value is NA.
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Column Description

CYFMethod Used to identify themethodology used for projecting the remainder of the
current fiscal year in the current year forecast utility. This utility is available
in Axiom Budgeting and Performance Reporting in the Bud Admin task
pane in Financial Reporting > Financial Utilities > Current Year Forecast.

Statistics:

l Key Dept Statistics – See Forecast Methods below, normally use Trend
l Other Dept Statistics – See Forecast Methods below

Revenue:

l IP Revenue – IP_Per_Unit
l OP Revenue – OP_Per_Unit
l Other Patient Revenue – Oth_Per_Unit
l Other Operating Revenue – See Forecast Methods below

Salaries:

l Hours – See Forecast Methods below
l Salaries – Labor

All Other Accounts: See Forecast Methods below

Forecast Methods:

l IP_Per_Unit: YTD IP_Per_Unit * Forecasted Volume
l OP_Per_Unit: YTD OP_Per_Unit * Forecasted Volume
l Oth_Per_unit: YTD Oth_Per_Unit * Forecasted Volume
l Labor: Actual Hourly Rate * Forecast Hours * Budget Rate Change
l RemBud: Remaining Budget from CYB
l Annual: YTD / Calendar Days * Remainng Calendar Days
l Rolling12: YTD Actual / YTD Budget * Remainder of LYA
l PctBud: YTD Actual / YTD Budget * Remainder of CYB
l Variable: Actual Rate per Unit * Forecast Volume
l Trend
l CapBud: Remaining Budget not to exceed the annual budget

You can also add additional CYFMethod columns. Create a new
CYFMethod column and use this in conjunction with the CYFDimGrp
column in the DEPT dimension if you need to use a different CYP method
for different departments.

ReclassType Defines the type reclass that was used to calculate the values in the
account. This information is important for post-reclass reporting.
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AllocType Defines the type of account for indirect allocations in Axiom Cost
Accounting.

BudStat Identifies Budget Statistic accounts used in Budget Statistics Driver.
Standard entries are:

l Admits
l PatientDays
l Discharges
l AdjDischarges
l Encounters
l ERVisits
l ClinicVisits

You can also create custom stats to use in the Budget Statistics Driver and
identify accounts appropriately. The default value is a blank.

CostAdjustmentID Used in Axiom Cost Accounting to tie allocation and Reclass StepIDs to
account numbers for easier referencing in downstream reports. This
number represents the ReclassID (reclasses) or the StepID (overhead
allocations) accounts that are not reclass or allocation accounts that have
a value of zero in this column.

CMStdLine Used to identify the StdLine for Axiom Cost Management.

KHAStandardClass The KHA standard classification for accounts to be used in reports to
standardize across the organization. Double click to select the appropriate
classification.

BPCategory Used to identify the Budget Planning category.

NewDeptStdLine Used to set or update the calc method for each department.
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InitStdLine Used to make accounts available for initiatives in the Axiom Budgeting
budget workbook.

In the Choose Value dialog for the InitStdLine, there are five validated
values to select from. The following table lists the Initiative Standard Lines
that we recommend you assign to each account type:

l Statistics accounts to use Detail Line
l Patient Revenue accounts to use Patient Revenue
l Other Revenue accounts to use Detail Line
l Deduction accounts to use Detail Line
l Labor accounts to use Detail Line
l Benefit accounts to use Detail Benefits w Percent
l All other expense accounts to use Detail Line
l Hours accounts to use Hours Line
l For accounts not configured, NAwill be the default value

RFCode Identifies the RFCode for account. Only used with Axiom Rolling
Forecasting. The default value is Z_Exclude.

CM_Group Used to summarize account types at a higher level for Axiom Cost
Management analysis and reporting needs.
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InitType Used by the system to select the sections so that when the user refreshes
the plan file, the accounts will insert into the appropriate section of the
Initiative block in the Axiom Budgeting budget workbook.

In the Choose Value dialog for the InitType, you can configure up to
seventeen possible values. The section types available are noted in the
following list. NA is the default value until configured or for any account
not configured.

l Benefits
l ContractLabor
l Deduction
l Depreciation
l Drugs
l Hours
l Interest
l IPRev
l NA
l OPRev
l OtherExp
l OtherRev
l ProFees
l PurchSvcs
l Salaries
l Statistic
l Supplies

CM_NonLabor Used to classify non-labor accounts in Axiom Cost Management according
to FSDetail. Valid entries include the following:

l Drugs
l KeyStats
l OtherExp
l PurchSvcs
l Supplies

These classifications are used in reporting and plan creation.

CM_Map Used to map accounts together in Axiom Cost Management. You can use
this column to map closed accounts with another existing account or to
group like accounts.
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CM_TargetBgt Used to create team workbooks in Axiom Cost Management at the
account level.

DEPT

The DEPT dimension contains records for each department within an organization. For example,
radiology, emergency, finance, and so on.

The following table lists all of the options available in this dimension table:

Column Description

DEPT The Axiom Software department number, which is formed by combining
the entity and cost center.

Description The department description. The naming convention is entity abbreviation
with department description. For example, MHS Operating Room.

NOTE: For closed departments, add three asterisks to the beginning of the
description. For example, MHS *** Operating Room. Descriptions should
not be in all capital letters.

Entity The Axiom Software entity code. The description lookup table is in the
ENTITY dimension table. This should be the Business Unit, and match the
first three to four characters of the department number.

CostCenter The cost center portion of the department number. You can use this for
comparative reporting across entities, such as comparing the cost per unit
of all operating rooms across your health system.

RptMap Used to consolidate departments for reporting.

BudgetGroup A collection of departments used primarily for plan file purposes. This is
commonly setup by a KHA consultant during implementation but can
easily be updated by clients. For example, departments 16010 and 16020
may be assigned to EMC budget group.

NOTE: BudgetGroup is a validated dimension so additions and deletions
need to first be added/deleted in the associated validation table.

ProdMap Used to consolidate departments for productivity reporting.

VP The Vice President responsible for the department. Use the naming
convention of FirstName LastName. This information is primarily used for
rollup reporting.

Director The director responsible for the department. Use the naming convention
of FirstName LastName. This information is primarily used for rollup
reporting.
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Manager Themanager responsible for the department. Use the naming convention
of FirstName LastName. This information is primarily used for rollup
reporting.

Division The division for rollup reporting, which is defined by your organization.
You can use this information to consolidate types of departments together
for reporting. For example, you can use the word Radiology to combine all
radiology departments across all entities.

ActivityGroup Default Activity Group. Used as a way to group categories (configurable by
user).

KHABgtCode Used to identify departments to combine during plan-file creation.

Owner Used to identify the network ID of the person responsible for initial input
of the plan file (i.e. Manager). It should be the same as their Axiom login ID.
Naming convention would be first initial, full last name (or whatever your
network ID naming convention is).

If your organization does not use this role for plan file approval, type [skip]
in the cell.

IMPORTANT: Do not leave this cell blank.

KHABgtTemplate Used to identify the template to use for plan file creation. Valid options
include the following:

l Master
l NA
l NoBudget
l RollingForecast

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

Reviewer The network ID of the person responsible for reviewing the cost
management plan, for example, Director. This information should be the
same as the user's Axiom Software login ID. The naming convention is first
initial, full last name or whatever your network ID naming convention is.

If your organization does not use this role for plan file approval, type [skip]
in the cell.

IMPORTANT: Do not leave this cell blank.
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Approver The network ID of the person responsible for approving the cost
management plan, for example, VP. This information should be the same
as their Axiom Software login ID. The naming convention is first initial, full
last name or whatever your network ID naming convention is.

If your organization does not use this role for plan file approval, type [skip]
in the cell.

IMPORTANT: Do not leave this cell blank.

TplOptions Used to identify the template option based on licensed products. Valid
options include the following:

l Master (common for all clients)
l MasterCDM (used for clients licensed for CDM option)
l MasterProvider
l NoBudget
l RFProvider

CM_Template Used to assign a specific Axiom Cost Management plan template.

LaborType Used to identify the labor method to use for plan file creation. Valid
options are:

l altEmployee
l Employee
l HHLabor
l JobCode
l JobCodeADC
l NA
l NoBudget
l Staffing

NOTE: This is an Axiom standard column and categories cannot be added
or edited. The default value is NA.

CM_Map Similar to RptMap, used to consolidate departments for reporting.

FinContact Used to assign the finance contact for a department during the cost
management process.

KeyStatDesc Used to identify the description of the primary statistic for each
department.
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KHACMDimGrp Used to identify the Standard Line selected from the ACCT dimension for
use in budget planning specifically for the budget values. Valid options are
the options used on the ACCT dimension. For example the common ones
uses include: KHAStdLine, PHYStdLine.

Campus Used as part of Axiom Cost Accounting.

CM_TeamMap Used to create team-planning workbooks. You can create teams by
combining like departments or like accounts for team Axiom Cost
Management planning.

CostMap Allows departments to processed as a group in the unit cost processing
phase of cost accounting. All costs for the group are combined and
allocated to all of the Cost Items within the group. In most cases, the first
or largest department of the groups becomes the target CostMap
definition to which the other members aremapped.

DeptType Determines the Direct or Indirect department category. Direct
departments are those that generally provide patient care services and
generate revenue, while Indirect departments are involved in support
services and do not generate patient care related revenue.

JobcodeDimGrp Used to designate which labor type distribution set applies to the
associated department. KHAInt is the standard set of job code labor types.
PhyInt is themodified set of job code labor types.

MarkupName The specified markup table to use when processing unit costs using the
ReverseMarkup method.

NOTE: Currently only one table is available per department.

ProjDimGrp Used to identify the Standard Line selected from the ACCT dimension for
use in budget planning specifically for the projection values. Valid options
are the options used on the ACCT dimension. For example the common
ones uses include CYPMethod.

ShowOnList_
Budgeting

Used to identify if a department displays to be selected during the plan file
creation process. Valid entries include the following:

l TRUE
l FALSE

CM_Team Create teams by combining like departments for team Axiom Cost
Management planning.

KHABgtMap Used for combining departments during plan-file creation. This column is
also used when more than one department is needed in one plan file.
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CM_Division Used to group similar departments for Axiom Cost Management reporting
and analytics.

CYFDimGrp Used to identify which CYFMethod column each department uses to
forecast accounts. Valid options are:

l CYFMethod - Uses themethod specified in ACCT.CYFMethod
l NA - Not Applicable
l [Other Column Name] - Uses themethod specified in the corresponding

column on the ACCT dimension table

KHAStandardClass Used for reporting.

FPNode Used to group the department to the appropriate FPNode in Axiom
Financial Planning.

CM_BMarkStatus Used to define which departments to include in Axiom Cost Management
benchmarking reports and analytics. Valid entries include the following:

l Yes – Type to include the department.
l No – Type to exclude the department.

FPType Used to group the department to the appropriate FPTYPE in Axiom
Financial Planning.

FPNodeBS Balance Sheet node for Axiom Financial Planning.

CM_DeptStandard Used for mapping departments to external benchmark data. This mapping
matches the department to the ExternalBMark information in the Axiom
Cost Management file groups.

CM_PdHrsMetricID The paid hours metric ID from external benchmark. Elements are validated
to theMetricID table. Used to link a department with specific metrics in the
CM_Benchmarks_yyyy tables. Used only in Axiom Cost Management.

CM_WkdHrsMetricID Themetric ID for worked hours from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

CM_
NonLabor1MetricID

Themetric ID for NonLabor 1 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.
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CM_
NonLabor2MetricID

Themetric ID for NonLabor 2 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

BudLocalAdmin1 Used to select the local administrator for Axiom Budgeting.

CM_CombineStat Used to determine if key statistics should be combined when grouping
departments together with CM_Map grouping column for Axiom Cost
Management. Valid entries include the following:

l Y – Type if the key statistics of the rolled up departments are to be
cumulative.

l N – Type to use only the key statistics from the surviving department.

CM_
NonLabor3MetricID

Themetric ID for NonLabor 3 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

CM_
NonLabor4MetricID

Themetric ID for NonLabor 4 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

CM_
NonLabor5MetricID

Themetric ID for NonLabor 5 from external benchmark. Elements are
validated to theMetricID table. Used to link a department with specific
metrics in the CM_Benchmarks_yyyy tables. Used only in Axiom Cost
Management.

BudLocalAdmin2 Used to select the local administrator for Axiom Budgeting.

BudLocalAdmin3 Used to select the local administrator for Axiom Budgeting.

FlexGroup Used for grouping departments together for the flexible budget utility. (For
example, Imaging).

FlexDept Used for defining each department as fixed or variable during the flexible
budget utility. Valid entries include the following:

l Yes
l No
l NA
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RFGroup Used to define your forecast groups. Consider:

l Management structure and cultural impact
l Team concept versus individual department managers
l The availability of a statistic that can be collected

CM_ShowOnList Used to define which departments to build Axiom Cost Management plan
files. Valid entries include the following:

l TRUE – Type this to build a plan file.
l FALSE – Type this to exclude from plan file lists and build.

CM_PlanGroup Used to group departments together for applying assumptions and
configurations in Axiom Cost Management driver files.

CM_
ExtBenchmarkSource

The source name of the external benchmark to use for this department in
Axiom Cost Management. Used to link a department with the CM_
Benchmarks_yyyy tables.

ShowOnList_Capital Used to define which departments to build Axiom Capital Planning plan
files. Valid entries include the following:

l TRUE
l FALSE

PM_IT The IT reviewer assigned for Process Management in Axiom Capital
Planning and Capital Tracking.

PM_Facilities The Facilities reviewer assigned for Process Management in Axiom Capital
Planning and Capital Tracking.

PM_Clinical The Clinical Engineering reviewer assigned for Process Management in the
Axiom Capital Planning and Capital Tracking systems.

PM_Voting The owner of the prioritization process assigned for Process Management
in Axiom Capital Planning and Capital Tracking.

ProviderType Select, by dept, whether to use the Detail or Summary options for provider
plan files.

CDMCODE

The CDMCODE dimension table includes all the charge codes within an organization. The charge codes
are used to track gross revenue and statistics at an inpatient (IP) and outpatient (OP) level.

The following table lists all of the options available in this dimension table:
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Column Description

CDMCode Used in Axiom Budgeting. This must be an alpha numeric field so that
during the import process, a C is appended to all CDMCodes to ensure
they are alpha numeric.

Description Identifies the CDMCode description. Try to be as explicit as possible, avoid
abbreviations, and use layman’s terms. Descriptions should not be in all
capital letters. To remove the all-caps format in the spreadsheet, use the
Proper formula =Proper().

KeyStat Identifies which CDMCodes to use for key stat calculation. Valid entries
include the following:

l To count the code, select Yes.
l To exclude the code, select No.

To summarize all of the Yes codes as monthly key stats, use the
Summarize CDMCode utility. This utility is available in Axiom Budgeting
and Performance Reporting in the Bud Admin task pane, Financial
Reporting > Financial Utilities > RevUsag.

RVU Identifies an RVU value for each CDMCode. This RVU value is used to
weight each CDMCode for monthly reporting. To summarize all of the Yes
codes as monthly key stats, use the Summarize CDMCode utility.

This utility is available in Axiom Budgeting and Performance Reporting in
the Bud Admin task pane, Financial Reporting > Financial Utilities >
RevUsage. This RVUmay also be used as a source for RVU information in
the costing process.

IPStatAcct To summarize all of the Yes codes as monthly key stats, use the
Summarize CDMCode utility. This utility is available in Axiom Budgeting
and Performance Reporting in the Bud Admin task pane, Financial
Reporting > Financial Utilities > RevUsage.

If you use this report, list a valid account number from the IP Statistic ACCT
dimension to use to post to when running this utility each month.

OPStatAcct To summarize all of the Yes codes as monthly key stats, use the
Summarize CDMCode utility. This utility is available in Axiom Budgeting
and Performance Reporting in the Bud Admin task pane, Financial
Reporting > Financial Utilities > RevUsage.

If you are using this report, list a valid account number from the OP
Statistic ACCT dimension to use to post to when running this utility each
month.
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IPRevAcct Used for mapping if your organization is licensed for the CDMRevenue
template. This maps CDMCodes to IP revenue accounts in the budget
process.

OPRevAcct Used for mapping if your organization is licensed for the CDMRevenue
template. This maps CDMCodes to OP revenue accounts in the budget
process.

KHABgtCode Used for combining CDMCodes during budget plan file creation. If there
are historical values for two CDMCodes that you want to budget as one
combined CDMCode, list the surviving CDMCode on both lines. If you do
not want to combine codes, then the code for this column should be the
same as the CDMCode in the CDMCode column.

KHAStdLine Used during the budget creation process. Valid entries include the
following:

l To budget that CDMCode, select CDM.
l To not budget that CDMCode, select NA.

KHAINT Valid entries include the following:

l If RVU > 0, IPStatAcc > 0, KeyStat=Yes, select Include.
l If RVU<0, IPStatAcc < 0, KeyStat=No, select Exclude.

UBRev The Universal Billing Code associated with each charge code from your
chargemaster. If there is no code available, then enter NA. This column is
used for reporting purposes.

HCPCS_CPT The Health Care Procedure Coding System/Current Procedural
Terminology codes associated with each charge code from the
chargemaster. If there is no code available, then enter NA. This column is
used for reporting purposes.

DATATYPE

The DATATYPE dimension is used to load provider-level to the data tables. Each record is tagged with a
DataType when loaded. Examples of DataTypes include Revenue, Visit, WRVU, and so on.

The following table lists all of the options available in this dimension table:

Column Description

DATATYPE The DATATYPE used in Axiom Budgeting and Performance Reporting. This
must be an alpha code.

Description Identifies the description to be use for budgeting and reporting.
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BudgetType Used during interface to determine which section each data type should
interface to. Valid codes Include the following:

l Encounter
l Revenue
l RVU
l WRVU
l Volume
l NA

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file creation process. Valid entries include the following:

l Driver
l Statistic
l Financial

INITIATIVEID

Use the INITIATIVEID dimension when budgeting for initiatives, which may or may not be approved. It
allows for tracking the impact of proposed initiatives while keeping that data separate from the baseline
budget.

The following table lists all of the options available in this dimension table:

Column Description

INITIATIVEID The INITIATIVEID used in Axiom Budgeting. This is used during the budget
process to store new initiatives. InitiativeID 1 is used for baseline
operations. All other initiative numbering is determined by the system
administrator and must be numeric.

Description Identifies the INITIATIVEID description to use for budgeting and reporting.

InitType Groups initiatives together for reporting and categorization. Valid entries
include the following:

l Baseline (INITIATIVE 1 only)
l System - Initiatives that affect multiple departments
l Dept - Initiatives for a single department
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Approve The coding for Approve/Exclude for new initiatives. Valid entries include
the following:

l Baseline (applies only to INITIATIVEID 1)
l Approve – Initiatives that have been approved
l Exclude – Initiatives that are declined or deleted
l Integration – Used when integrating Capital Planning to an initiative

project

SaveCustom Used to save from the Axiom Budgeting plan file to this dimension table.

IMPORTANT: Do not alter or recode.

SaveTagDocID Used to save from the Axiom Budgeting plan file to this dimension table.

IMPORTANT: Do not alter or recode.

Profile The profile type to apply to the initiative.

To not use a profile, typeNA.

For more information on setting up initiative profiles, see "Setting up
initiatives" in the Axiom Budgeting online help.

BudCM For internal use.

DefaultFlag_
Description

For internal use.

DefaultFlag_Approve For internal use.

INSCODE

The INSCODE dimension stores information for the insurance/health products offered by your
organization. This information is used to manage and configure the insurance/health plans included in
your budgets. Similar to other dimension tables like ACCT, there are column structures to control what
insurance plans will be allowed to interface to the HealthPlan tab and at what level of rollup, if any.

The following table lists all of the options available in this dimension table:

Column Description

INSCODE The short name or code your organization uses to represent the
insurance/health plan product.

Description The long description of the insurance/health plan.

InsCode_BgtCode The code used to group the insurance/health plan products together. For
example, grouping all commercial or FFS plans.
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Column Description

KHAInt Specify whether to include the product in the list of available plans to
include in your budgets. Select one of the following:

l HealthPlan – Select this option to include the product in the list of
available plans.

l NA – Select this option to remove the product from the list of available
plans.
NOTE: The system will retain historical information for plans removed
from the list.

JOBCODE

The JOBCODE dimension table includes records for all of the JobCodes within your organization. Each
JobCode represents a job position or role within the organization.

The following table lists all of the dimension options available in the JOBCODE dimension table:

Column Description

JOBCODE The Axiom Software job code. This entry must be an alpha-numeric field so
that during the import process a J is prepended to all job codes to ensure
they are alpha numeric.

Description The job code description from the payroll system. Do not type
descriptions using all capital letters. To remove the all-caps format in the
spreadsheet, use the Proper formula =Proper().

GLAcct The GL account where regular dollars are posted on the GL. If your payroll
data maps to the GL based upon pay type, type 0 (zero).

HrAcct The GL account where regular hours are posted on the GL. If your payroll
hours map to the GL based upon pay type, type 0 (zero).

FICAAcct The FICA account code to use for each job code. You can use this to
allocate FICA expense to different accounts by job code.
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JobClass Themajor job classes of individual job codes. You can use this to apply
salary increases for specific groups. Commonly used entries include the
following:

l Management
l Physician
l Professional
l Technical
l RN
l LPN
l Assistant
l Support
l Other
l Clerical
l Contract

GLClass Used to identify the GL Class each job code is assigned to for budget and
reporting salary-mapping purposes. The exception-mapping table is
located in the GLPayrollMapping table. If mapping payroll by job code or
pay type is not an option, this mapping table allows for special exceptions
for payroll mapping.

Variable Used to identify JobCodes, which are sensitive to volume changes. Valid
entries include Fixed and Variable.

KHABgtCode Used for combining accounts together during budget plan file creation. If
there are historical values for two accounts that you want to budget as
one combined account, list the surviving account number on both lines. If
not combining accounts, this value should match value in the Account
column. The default value is 0 (zero).

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file create process. Valid entries include the following:

l JOBCODE
l PROVIDER
l To exclude an account from all budget plan files, typeNA.

CostHr The Prod Hours Account Definitions for Costing
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PhyInt Used to create an alternative to the KHAInt classification for the associated
job code.
Valid entries include the following:

l JOBCODE
l PROVIDER
l NA – Indicates the value will default to the value currently in the KHAInt

column.

ResourceJobClass Used in the RVU developer process by themapping of job codes to a
Resource Job Class, which determines the level of detailed RVU
development for labor resources. This attribute is also used in the
mapping of payroll hour and dollar into an average wage rate in the
resource table that then drives the calculation of the RVU.

CostCat The cost category for the job code.

KHAStandardClass The KHA standard classification for jobcode to be used in reports to
standardize across the organization. Double click to select the appropriate
classification.

StdHours Used to identify the standard FTE hours worked in a year. Options include
Default, which is 2086 hours, and 2080. For more information, see
"Working with FTE standard working hours" in the online help.

CostGL The Prod Dollars Account Definitions for Costing

Retirement Identifies the jobcodes to be used for retirement calculation. Used in
Jobcode and ProviderComp (available on Labor tabs). Valid entries are:

l NA
l Qualified

CostClass An alternative grouping column used in the costing process that is invoked
during the loading of payroll information into the CGL as statistics to
support a payroll related reclassification of GL dollars or hours.

RFCODEGL In Axiom Rolling Forecast, this may be used to allocate salaries to specific
salary related RFCodes.

CostVariable Not used at this time.

RFCODEHR In Axiom Rolling Forecast, this may be used to allocate hours to specific
hours related RFCodes.
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FPCategory Used to identify the name of the Financial Planning category to be used for
transferring the financial plan targets during the integration process with
Axiom Financial Planning. If Axiom Financial Planning is not used, the
default is NA.

CM_PlanCode Used for combining job codes during reporting and plan file creation in
Axiom Cost Management. If there are historical values for two job codes
that you want to report as one combined job code, list the surviving job
code on both lines.

PAYTYPE

The PAYTYPE dimension table includes records for all of the possible categories of compensation that an
employeemight receive. For example, regular pay, paid time off, sick pay, incentive pay, and so on.

For more information on how to set up the PAYTYPE dimension for reporting, budgeting, and GL
mapping, seeMapping the PAYTYPE dimension.

The following table lists all of the options available in this dimension table:

Column Description

PAYTYPE The Axiom Software pay type. This must be an alpha-numeric field, so that
during the import process, a P is prepended to all pay types to ensure they
are alpha numeric.

Description Identifies the pay type description from the payroll system. Be as explicit
as possible, avoid abbreviations, and use layman’s terms. Do not enter a
description using all capital letters. To remove the all-caps format in the
spreadsheet, use the Proper formula =Proper().

PaySummary Used in reporting to identify major pay categories. Select one of the valid
entries:

l Prod
l NonProd
l Other
l Stat
l NA
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PayDetail Used in reporting to identify detail pay categories. Select one of the valid
entries:

l Contract
l NA
l NonProd
l Other
l Overtime
l Regular
l Stat

LaborDist The variation of PayDetail used in Labor Distribution reporting. Valid
entries include the following:

l Regular
l Education
l PTO
l Overtime
l OnCall
l Other
l Contract
l Stat
l NA

FTE Indicates whether to include hours in FTE calculations. Select one of the
valid entries:

l To assign to pay types to count for FTE calculations such as Regular,
Overtime, Education, PTO, Jury Duty, Bereavement, Sick, and so on,
select Yes.

l To assign to pay types to not count for FTE calculations such as
Differentials, Call Pay (not callback), Bonus, Benefits, and so on, select
No.

l To assign to your productivity stat pay types, select Stat.
l If none of the above scenarios apply, select NA.

Empl_Detail Used to identify pay types that are FTE related for employee-level
budgeting. Select one of the valid entries:

l If it is FTE-related, select Z_Employee.
l If it is not FTE-related, select NA.
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Column Description

KHAInt Used to identify pay types to include in plan file processing. Select one of
the valid entries:

l To assign pay types to include in the JobCode block (generally FTE=Yes),
select JobCode.

l To assign pay types to include in the JobCode block as additional
dollars (generally FTE=No; examples include call pay, differentials,
bonus, etc.), select Dollars.

l To assign pay types to budget at the department (not job code) level,
select Dept.

l To assign pay types to exclude from the budget workbooks such as
PTO sellback, reimbursement\adoption reimbursement, car allowance,
benefit expenses, and so on, select NA.

GLAcct Used to identify the account number to use for dollars on the GL. Do one
of the following:

l If your payroll data maps to the GL-based upon job code, type 0 (zero).
l If your payroll data does not map to the GL-based on job code, type

the GL salary account from the ACCT dimension table.

HrAcct Used to identify the account number to use for hours on the GL. Do one of
the following:

l If your payroll hours map to the GL-based upon job code, type 0 (zero).
l If your payroll hours do not map to the GL-based on job code, type the

GL hours account from the ACCT dimension table.

JobCode The pay type summary groupings used for plan-file processing when using
the Jobcode labor method. The code used must be a valid pay type.

Staffing The pay type summary groupings used for plan-file processing when using
the Staffing labor method. The code used must be a valid pay type.

Employee The pay type summary groupings used for plan-file processing when using
the Employee labor method. The code used must be a valid pay type.

Provider The pay type summary groupings used for plan-file processing when using
the ProviderComp labor method. The code used must be a valid pay type.

KHAStdLine Used to identify default budget methodology used in budget plan files
during budget plan file creation. Refer to the calc methods for the Stat_Rev
sheet and Expense sheet in the Axiom Budgeting and Performance
Reporting Administrator's Guide (Budget Plan Files chapter) for valid
entries and definitions. The default value is NA.
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Column Description

RF_Pay26_Include_
Exclude

Select whether to include or exclude option from monthly payroll to GL.

ResourceCalculation Determines the calculation behavior for the hours or dollars within the
PAYTYPE when using the payroll information within the RVU development
process. When labor rates are calculated for the Resource Table, the
designation here determines if the Hours, Dollars, or Both are to be used in
the numerator and denominator in the average.

PHYStdLine Identifies the default budget methodology used in budget plan files during
budget plan file creation. Options include:

l CM_Jobcode
l Dept_AvgPerProdHr
l Dept_InputMonthly
l Input_Monthly
l JobCode
l NA

CDMStdLine Used to identify default budget methodology for CDM budget plan files
(departments which have CDMStdLine in KHACMDimGrp column of DEPT
Dimension) during budget plan file creation. It is used similarly to
KHAStdLine in Budget Planning workbooks.

Valid entries include the following:

l Statistical accounts = CDMStatistic
l IP Revenue accounts = CDMIPRevenue
l OP Revenue accounts = CDMOPRevenue

Copy the remaining account assignments from KHAStdLine column.

Accrue Used to identify paytypes to be included when using the payroll accrual
utility. Valid entries include the following:

• To accrue during monthly payroll accrual process, type Yes.

• To not accrue during monthly payroll accrual process, typeNo orNA.

RFPAYCLASS Not used at this time.

Cost Variable Not used at this time.

CM_PlanCode Used for combining pay types during Axiom Cost Management reporting
and plan-file creation. If there are historical values for two pay types that
you want to report as one combined pay type, list the surviving pay type
on both lines.
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Column Description

KHAStandardClass Grouping column that can be used to report on paytype usage across your
organization.

NewDeptStdLine New department standard CM Line.

CM_PayCategory Used in Axiom Cost Management to group individual pay types into
summary categories for planning purposes. Examples include the
following: Regular, Overtime, Education, PTO, Contract, Other, Stat.

CM_Paid Used to identify the pay type to include in the Paid Hours calculations in
Axiom Cost Management. Valid entries include the following:

l For paytypes that will be included in paid hours, select Yes.
l For paytypes that will not be included in paid hours, select No.

CM_Worked Used to identify the pay type to include in theWorked Hours calculations
in Axiom Cost Management.

l For Pay Types that will be included in worked hours, select Yes.
l For Pay Types that will not be included in worked hours, select No.

CM_PaidDLLRS Used to identify the pay type to include in the Paid Dollars calculations in
Axiom Cost Management.

l For Pay Types that will be included in paid dollars, select Yes.
l For Pay Types that will not be included in paid dollars, select No.

CM_WorkedDLLRS Used to identify the pay type to include in theWorked Dollars calculations
in Axiom Cost Management.

l For Pay Types that will be included in worked dollars, select Yes.
l For Pay Types that will not be included in worked dollars, select No.

CMStdLine Used during the interface process to assign the standard planning method
to use for each pay type. In other words, this identifies the desired formula
to use to calculate Axiom Cost Management initiatives. It is used similarly
to KHAStdLine in Budget Planning workbooks.

Options for Acct.FSDetail

l A_AccumDepr
l A_AR
l A_ARAllow
l A_BoardInvest
l A_BondAmort
l A_BondCost
l A_Cash
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l A_CashInvest
l A_CIP
l A_CurLtdAsset
l A_CurOtherAsset
l A_CurReceivable
l A_Inventory
l A_Land
l A_LTNotesRec
l A_LTOtherAsset
l A_PPE
l A_Prepaid
l A_RelatedParty
l A_ThirdPartyRec
l A_Trusteed
l C_Comments
l D_BadDebt
l D_Charity
l D_Contractual
l D_Discounts
l E_BadDebt
l E_Benefits
l E_Depreciation
l E_Drugs
l E_Insurance
l E_Interest
l E_MaintRepairs
l E_MedSupplies
l E_OtherExp
l E_OthSupplies
l E_ProFees
l E_PurchSvcs
l E_RentLease
l E_Salaries
l E_SalariesContract
l E_SalariesMid
l E_SalariesPhy
l E_Utilities
l F_ContractFTEs
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l F_NonProdFTEs
l F_OvertimeFTEs
l F_ProdFTEs
l H_Contract
l H_JCHours
l H_Midlevel
l H_NonProd
l H_Overtime
l H_Physician
l H_Prod
l L_AccExpense
l L_AccPayroll
l L_AP
l L_CurLTDebt
l L_CurOthLiab
l L_LTDebt
l L_LTOther1
l L_LTOther2
l L_ThirdPartyPay
l M_BmarkAdjD
l M_BmarkNOR
l M_DEPUOS
l M_NonLabor
l M_ONLPUOS
l M_PSPUOS
l M_SEPUOS
l M_TContPct
l M_TEducPct
l M_TEPUOS
l M_TFTERate
l M_TOTPct
l M_TPHUOS
l M_TUOSRate
l M_TWHPUOS
l N_NetAsset
l N_NetAssetPerm
l N_NetAssetTemp
l NA
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l Q_Restricted
l Q_RestrictedPerm
l Q_RestrictedTemp
l Q_Unrestricted
l R_IPRev
l R_NonOpContrib
l R_NonOpExtraord
l R_NonOpGainLoss
l R_NonOpInterest
l R_NonOpInvest
l R_NonOpOther
l R_NonOpRev
l R_OPRev
l R_OtherRev
l R_OthPtRev
l S_Admits
l S_Deliveries
l S_Discharges
l S_Encounters
l S_ER Visits
l S_GenStat
l S_Global
l S_KeyIP
l S_KeyOP
l S_KeyOth
l S_Newborn
l S_OthStat
l S_PatientDays
l S_PayorDays
l S_PayorDisch
l S_PayorVisits
l S_StatOth
l Z_Exclude

Working with Drivers
Driver files contain rates, statistics, and other drivers that your budget plan files reference to help
calculate data. Driver files can also contain global values such as calendar information.
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The data in driver files is ultimately saved to the database into one or more driver tables. These driver
tables can then be referenced by templates/plan files to calculate planning data or determine other
global settings for the file group.

In Axiom Budgeting and Performance Reporting 2020.3, the file group for each year's budget contains a
set of driver files that display configuration settings and Budget Assumptions (key statistics) referenced
by all of the other files within the file group.

The configuration settings in the driver files can impact the structure of budget plan files in the following
ways:

l Show or hide sections of sheets, columns, and rows.
l Set default values and parameters within budget plan files, including:

o Pay types
o Number of pay periods
o Thresholds for flagging variances
o Column headings

Budget Assumptions are used in calculations throughout the entire budgeting process.

Examples of Budget Assumptions include:

l Inflation rates
l Labor merit increases and benefits percentages
l Revenue rates
l Any other statistics that impact multiple budgets

NOTE: Whenever you create a new budget, review the assumptions and settings in the driver files to
make sure they still apply to the current year.

Cells in driver files are color-coded as follows:

l White shading – Cells cannot bemodified.
l Blue shading – Input or modify data in the cell.
l Green shading – Choose from a drop-down selection of entries.

Depending on a user's security profile settings, certain parts of a driver file may be protected.

IMPORTANT: Any changemade to the configuration settings and assumptions in the driver files can
impact the structure and contents of any number of related budget plan files.

The Budget Driver is referred to as a rebuildable driver. This means that the driver stores and controls
information using data tables, which provides the ability to control who can edit driver data and what
driver data each can edit. A rebuildable driver also provide other benefits:
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l Secure access to default driver settings – You determine who can edit the default sections in each
driver table.

l Secure access to budget group exceptions – You determine which Budget Groups each product
admin member can view and edit.

l Filtered data access –When editing the driver, filtered data access provides improved
performance.

l Multi-user driver file access – You can havemultiple members responsible for separate budget
groups access the same driver at the same time.

l Updatability and enhancements – By removing the persistent file requirement, Kaufman Hall can
provide you enhanced driver templates without any risk to current parameters and construct.

l Calc methods included – You can add additional sections/rows with double-clicks instead of
manually. You can save or delete each section using the drop-down next to each budget group
section.

NOTE: Axiom Budgeting and Performance Reporting driver files may reference dimension tables
shared with other applications.

Throughout the driver files, you define default settings and assumptions for use throughout the file
group. In some cases, however, you might want to make exceptions for certain groups of departments,
accounts, and so on. These groupings of exceptions (particularly departments) are referred to as Budget
Groups. Many of the driver files include fields where you can indicate how budget groups are defined
within the dimension tables.

After the driver data is stored in data tables, you must establish security by doing the following:

l Allowmultiple users to access the driver files at the same time.
l Configure a user to only have access to the correct budget group sections or all sections of each

driver file.

Opening budget driver files
There aremany drivers available in Axiom Budgeting and Performance Reporting. You can access most of
them from the Bud Admin task pane.

To open budget driver files:
1. In the Bud Admin task pane, in the Budget Assumptions section, do one of the following:

l To open next year's budget drivers, click Access NY Budget Assumptions.
l To open this year's budget drivers, click Access CY Budget Assumptions.

2. Double-click the driver.
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3. Refresh the variables by doing the following:

NOTE: Not all drivers include the ability to select variables, depending on the purpose of the
driver.

a. In theMain ribbon tab, click Refresh Data, or press F9.

b. In the Refresh Variables dialog, for each variable option, click Choose Value.

c. In the Choose Value dialog, select one or more variables, and click OK.

TIP: If the dialog displays a large number of variables, you can use the Select All or
Clear All to select or deselect all the selections in the check boxes. If you do not select
check boxes for any variables, the system automatically includes all of the variables in
the driver. If you click Cancel, no variables are included in the driver, and it displays
blank.

4. After you make your changes, in theMain ribbon tab, click Save.

Order to set up drivers
Set up the drivers in the following order:

1. Budget Configuration

2. Budget Labor Configuration

3. Budget Statistics

4. Budget Driver

5. Budget Depreciation
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6. Budget Global Data Configuration

7. Budget Global Data 1

8. Budget Global Data 2

9. Budget Global Data 3

10. Budget Global Data 4

11. Budget Global Expense

12. Budget Revenue GlobalRev

13. Budget Expense Adjustments

14. Budget Labor Rates

15. Budget Assumptions

16. Budget CDM Config

17. Budget CDM Overrides

18. Budget Expense Admin Adjustments Setup

19. Budget Expense Adjustments

20. Budget Global Sum

21. Budget Labor Accounts

22. Budget Labor ADC Config

23. Budget Labor Alt FTE Factors

24. Budget Labor Benchmark driver

25. Budget Labor JobCode Dropdown

26. Budget Labor Limits

27. Budget Labor Override

28. Budget Labor Target

29. Budget Provider Configuration

30. Budget Provider

31. Budget Provider Global Provider

32. Budget Provider GlobalVolChg

33. Budget Provider List

34. Budget Provider Simple Config

35. Budget Provider Simple Dept Config Basic
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36. Budget Provider Simple Dept Rate

37. Budget Provider Vol

38. Budget Revenue Adjustments

39. Budget Revenue Deductions

40. Budget Revenue Payor Adjustments

41. Budget StatAcct

42. Budget Statistics Supplement

43. Membership Enrollment Trend

NOTE: This driver only displays if your organization has the Budgeting Health Plan license.

44. Membership PMPM

NOTE: This driver only displays if your organization has the Budgeting Health Plan license.

Summary of commonly used drivers and use of global assumptions
Driver Global BudgetGroup Comments

Budget
Assumptions

Budget Driver

Plan files will default to
Global if BudgetGroup
block is not built out

Exceptions

Budget
Configuration

Budget Labor
Configuration

Plan files will default to
Global if BudgetGroup
block is not built out

Exceptions BudgetGroups built
out in both drivers
must match

Budget
Depreciation

Budget
GlobalData (1-4)

Budget GlobalExp

Budget
GlobalSum

Budget Revenue
GlobalRev

NA BudgetGroup/DEPT/ACCT
specific

Budget method must
be identified in
ACCT.KHAStdLine
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Driver Global BudgetGroup Comments

Budget Expense
Adjustments

FSDetail level only

Plan files will default to
Global if BudgetGroup
block is not built out

FSDetail or ACCT level.

Budget Labor
Benchmark

NA NA DEPT specific,
regardless of
BudgetGroup

Budget Labor
Limits

NA NA JOBCODE specific,
regardless of
BudgetGroup

Budget Labor
Override

NA BudgetGroup, DEPT, or
DEPT/JOBCODE specific

Budget Labor
Rates

Global, Jobclass, or
Jobcode specific

Plan files will default to
Global if BudgetGroup
block is not built out

Global, Jobclass, or
Jobcode specific

Budget Labor
Target

NA NA DEPT/JOBCODE
specific, regardless of
BudgetGroup

Budget Revenue
Adjustments

Global IP, OP, Other
Patient, Other Revenue

Global or ACCT specific IP,
OP, Other Patient, Other
Revenue

Budget Statistics Includes high level stats
only - Calendar &
Worked Days, Paid
Hours, Consolidated
Stats (Admissions,
Discharges, Patient
Days, Outpatient Visits,
ER Visits)

Consolidated Stats
summarize
BudgetGroups

Includes Admissions,
Patient Days, Discharges,
Adjusted Discharges,
Calendar Days, Worked
Days

Budget Assumption and Configuration drivers
The following table includes a description of each type of assumption and configuration driver:
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Driver Description

Budget Configuration Use to configure a variety of general settings that affect themajority of
budget plan files.

TIP: Usually the first driver you edit prior to creating a budget.

Budget Driver Use to assign a driver statistic either to the facility or to an individual
department, and assign a default statistic to be used if a department does
not currently have a database statistic.

Budget Assumptions Use to control the contents of the Instructions and Planning sheets in
budget plan files.

Budget Depreciation Use to designate an alternative location for entering depreciation for
specific expense accounts shared across departments without having to
divide the depreciation between multiple budget plan files.

Current payroll period
driver

Use to change the current period for the Payroll 27 tables.

Service Line data
tables

Use to configure the import into tables that store your Decision Support
data (DSS).

Driver Description

Budget Configuration Use to configure a variety of general settings that affect themajority of
budget plan files.

TIP: Usually the first driver you edit prior to creating a budget.

Budget Driver Use to assign a driver statistic either to the facility or to an individual
department, and assign a default statistic to be used if a department does
not currently have a database statistic.

Budget Assumptions Use to control the contents of the Instructions and Planning sheets in
budget plan files.

Budget Depreciation Use to designate an alternative location for entering depreciation for
specific expense accounts shared across departments without having to
divide the depreciation between multiple budget plan files.

Current payroll period
driver

Use to change the current period for the Payroll 27 tables.

Service Line data
tables

Use to configure the import into tables that store your Decision Support
data (DSS).
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Budget Configuration

� Overview
This driver contains a variety of general configuration settings that affect themajority of budget plan
files. This is typically the first driver file you edit prior to creating a budget.

The Budget Configuration driver is divided into a Global Setup section with settings that apply system-
wide and a section with default settings, followed by separate sections for each defined budget group.
Each section contains the following:

� Global Setup
Open the driver, and then configure the Global Setup parameters to apply to all the budget plan files.

Settings in this section include:
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Option Definition

Dept Dimension
Grouping Code to be
used for Global
Assignments

Define the groupings by which the system will build and assemble the plan
files.

Use KHACMDimGrp? Define from the ACCT dimension which Stdline to use for the department.
For example, if the budget plan file is a typical basic operating plan file used
in a hospital, then you would use Account KHAStdline. For a physician
department, you would likely select Physician KHAStdline.

Activate Red Flag
Popup?

For certain values, you can set variance thresholds which, if exceeded,
cause a red flag icon ( ) to display. Select one of the following options to
determine whether or not the user needs to address the threshold by
entering a comment:

l Yes -When the threshold is met, require the user to enter a comment
in the Comment field before they can save the plan file.

l No - Allow the user to save the plan file without entering comments.

Expense Transaction
Drilling, On or Off?

Select one of the following:

l On - To allow users to drill down to a subsidiary General Ledger in the
Expense tab.

l Off - To not allow users to drill down in the Expense tab.

Dept Column Width? By default, the department column width is 15 pt. Use this field to enter
different column width size.

NOTE: If you enter a size larger than 15 pt, large numbers will display in
scientific notation (i.e. #######).

Acct Column Width? By default, the account column width is 15 pt. Use this field to enter
different column width size.

NOTE: If you enter a size larger than 15 pt, large numbers will display in
scientific notation (i.e. #######).

� Budget Setup section
The Budget Setup section for each budget group defines basic parameters such as pay periods and start
and end months for the fiscal year.

Settings in this section include:
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Option Definition

Payroll27 - YTD
Biweekly Pay Periods

Indicates howmany pay periods have elapsed in the current fiscal year, in
case you need to create a budget for a fiscal year already in progress.

Financial - Current
Fiscal Year Period

Indicates the current fiscal year period, in case you need to create a budget
for a fiscal year already in progress. When you build a new budget, the
Current Period entered heremust equal the Current Period of your data
sources.

IMPORTANT: Be sure to enter a specific number. Do not use the
KHAPeriod formula (which returns the current period) in this cell, as it will
cause your data to become out of sync as the value of KHAPeriod changes.
Changing the value recalculates the YTD calendar days, impacting
calculations throughout the system. For example, if this field is mistakenly
set to seven months but the budgets were built using 8months of data,
most values will be overstated.

Year of Fiscal Year End The calendar year in which the budget's fiscal year ends.

Fiscal Year Beginning
and End Month

Themonth in which the fiscal year begins and ends for each budget plan
file.

Current Year
Beginning and YTD
Date

The date when the current year budget began and the date when YTD data
was imported.

� Budget Tab Settings section
This section configures the sheet headings for time period columns in budget plan files.

Settings in this section include:

Option Definition

Month End Determines the end date for all monthly spread sections in budgeting
driver and plan files.

NOTE: This must be updated for the current year end at the beginning of
each new budget cycle.
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Option Definition

Months in Period Designates the number ofmonths in each period, typically 12 for past year
actual data, but may vary for the YTD period versus projected period for
the current year.

Days in Period The total number of business days in the period.

NOTE: Must be updated for each budget year.

Identify columns to
hide in budget
workbooksplan files

Enter the names of any columns you wish to hide on the Stat_Rev and
Expense sheets in budget plan files.

Print Suppressor to
hideWB columns

Designates which columns have been suppressed per the previous row.

Identify columns to
hide in Summary Tab

Allows you to control which columns to display on the Summary sheet of
the budget plan files. Set to Yes to hide, No to display in the budget plan
files.

Print Suppressor to
hide Summary
columns

Designates which columns have been suppressed per the previous row.

� Red Flag Parameters section
This section determines if and when users will be required to enter comments for variances in budget
plan files (for more information, see the chapter on Variance Reporting).

Settings in this section include:

Option Definition

Percent Increase
Threshold

Sets the percentage variance above budget for which users will be required
to enter an explanation.

Percent Decrease
Threshold

Sets the percentage variance below budget for which users will be required
to enter an explanation.

Dollar Threshold (+/-) Sets a strict dollar amount above or below budget for which users will be
required to enter an explanation

� Other Tab Parameters section
This section addresses additional configuration options for budget plan files:
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Settings in this section include:

Option Definition

Use Preliminary
Estimate on Detail
Calc Method?

If set to Yes, the preliminary estimate displays on the detail sheet in
budget plan files. If set to No, the system will hide the preliminary estimate
row.

Display Contribution
Margin on Summary
Tab?

If set to Yes, the contribution margin row displays on the Summary sheet
in the budget plan files. If set to No, the system will hide the contribution
margin row. To display themargin, choose a custom name for that row on
the Summary sheet.

Use Forecast for
Current Year
Projection?

Select Yes orNo.

Show Initiatives Tab? Select to Show or Hide the Initiatives tab.

Show Plan Tab? Select to Show or Hide the Plan tab.

Show Empl_List tab
with JobCode and
Staffing Tabs?

Select to Show or Hide the Empl_List tab with the JobCode and Staffing
tabs.

Show Empl_List tab
with Employee Tab?

Select to Show or Hide the Empl_List tab with the Employee tab.

ShowNet Revenue
section on Stat_Rev
tab (Requires Global
Sum Setup)?

Select to Show or Hide the Net Revenue section on the Stat_Rev tab.

Budget Driver

� Overview
This driver is used for two major purposes:

1. Assign a driver statistic either to the facility or to an individual department.

l These drivers must exist in the Statistics sheet.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 158



l The code requested is the same code that is in column A of the Statistic worksheet which is
a combination of columns B & C in the Statistic worksheet.

l A red flag will indicate if an incorrect code has been input (refer to screen shot example).
2. Assign a default statistic to be used if a department does not currently have a database statistic.

l Departmental Exceptions from the facility assignment can be entered in the lower half of
this sheet (refer to screen shot below).

The Driver sheet contains the following columns for each entity:

l BudgetGroup Code
l Department Description
l IP Driver
l OP Driver
l Default Statistic

Drivers must be defined in column A on the Statistics sheet in order to be used.

� Settings
Open the driver, and complete the driver settings, as needed.
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Budget Assumptions

� Overview
Use this driver to control the contents of the Instructions and Planning sheets in budget plan files. It is
probably best to revisit this section after you have gone through the process of creating a budget and
viewed these sheets in the context of a budget plan file.

� Settings
Open the driver, and define different sets of instructions and planning questions for each Budget Group.

Each section has three columns:

l Budget Instruction Process Steps –Modify the description of each step.
l Due – Enter the due date for step.
l Use – Enter or modify the link.

Open the Budget Assumptions driver, and then use the following table to complete the settings in this
driver, as needed:
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Option Definition

Budget Contact Type the contact information for the Budget Administrator in case end
users have any questions.

Budget Assumptions Input key budget assumptions in this section to display for the user's
reference. Again, this is strictly for reference. These are not the cells that
the system refers to for assumptions data when performing actual
calculations.

Budget Planning
Account

Type the account used to store plan tab answers.

Planning Questions Type the questions to display on the Planning sheet in budget plan files.

Budget Depreciation

� Overview
This driver provides an alternative location for entering depreciation for specific expense accounts shared
across departments without having to divide the depreciation between multiple budget plan files.

To use this driver, set the budget method (KHAStdLine) in the ACCT dimension table to Depreciation.

To add a new department to the driver, double-clicking theDouble click to Insert New Department cell.

� Settings
Open the driver, and complete the driver settings, as needed.

Configuring the current payroll period

Use the Change Payroll 27 Tables-Current Period utility to change the Payroll 27 tables current period.

NOTE: You must have the Administrator role profile to access this utility.
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To configure the current payroll period:
1. In the Bud Admin orManagement Reporting Admin task pane, in the Budget System

Maintenance section, double-click Change Payroll 27 Tables-Current Period.

NOTE: The utility opens in a separate browser window.

2. From theNew Pay Period drop-down, select the current pay period.

3. Click Submit.

4. At the This may take around a minute to save prompt, click OK.

5. At the confirmation prompt, click OK.

Configuring the Service Line data tables

Service Line data tables allow you to house your Decision Support data (DSS). The tables are assigned to
the Performance Reporting license such as many other tables that house data for Actuals.

The data tables are located in the Service Line folder in the Table Library accessed through the Explorer
task pane.
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Open Tables In Spread Sheet (OTIS) is available for the following Kaufman Hall standard roles for direct
table access, if needed:

l Management Reporting Admin
l Management Reporting Analyst

You will need Management Reporting Admin role to use the import.

One standard import is available in the Imports > Management Reportingmenu. You will need
Management Reporting Admin role to use the import. File specs will be provided in the related file spec
document and initial setup may be needed. Please contact Kaufman Hall customer support for
assistance.

The Service Line data tables contain four key fields, twelvemonthly periods columns, and calculated
summary fields. The Key fields are defined as follows:
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l Group Service Line – Service Line category name. This is client defined and no Kaufman Hall
standards are required. This same field is used to define the Service Line namewhen configuring
the Service Line Supplement Driver.

l Primary Payor Plan Code – Used to summarize payor categories. This is client defined and no
Kaufman Hall standards are required. This is used for reporting only and is not used as a key field
in the Service Line Supplement driver.

l Entity Code – Level of summarization similar to Budget Group. This is NOT a validated dimension
to the Entity validation table at this time, but we recommend that the Entity Codematches
validated codes.

l Data Type – Statistic category desired to be used in the data table. These are client defined and no
Kaufman Hall standards are required.

Budget Global drivers
The following table includes a description of each type of Budget Global driver:

Driver Description

Budget Global Data
Configuration

Use to configure settings related to the GlobalData calc method.

Budget Global Data 1-
4

Use to configure next-year budget values by month for individual expense
items.

Budget Global
Expense

Use as an alternative location for budgeting dollars to specific expense
accounts shared across departments without having to divide the dollars
between multiple budget plan files.

Budget Global Sum Use to calculate the value of an account on the Stat_Rev or Expense sheet
based on the value of one or more other accounts on the Stat_Rev sheet.
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Driver Description

Budget Global Data
Configuration

Use to configure settings related to the GlobalData calc method.

Budget Global Data 1-
4

Use to configure next-year budget values by month for individual expense
items.

Budget Global
Expense

Use as an alternative location for budgeting dollars to specific expense
accounts shared across departments without having to divide the dollars
between multiple budget plan files.

Budget Global Sum Use to calculate the value of an account on the Stat_Rev or Expense sheet
based on the value of one or more other accounts on the Stat_Rev sheet.

Budget Global Data Configuration

� Overview
This driver contains settings related to the GlobalData calc method. The GlobalData calc method allows
you to create configurable budget relationships for calculating NYB amounts for the Expense tab only.
The GlobalData calc method is similar to GlobalExpense but allows you to use up to four configurable
tabs in GlobalData Assumptions.

This calc method works much like Global Expense, Global Revenue, and Depreciation, which look to the
StatData tab to get the budget values.

This driver file allows plan files to look up historical and projected values for expense items. To reference
a department/account combination to the Global Data Assumptions, you must specify the GlobalData
calc method in the appropriate grouping column on the ACCT dimension table. These accounts will then
look to one of the four GlobalData sheets for historical and projected data.

To use GlobalData, you must first specify a default GlobalData sheet for accounts using the GlobalData
calc method, along with any departmental or budget group exceptions. There are four sheets set up in
the Global Data Configuration to use when creating alternate data sets. If you need more than four
sheets or need to modify any of the default queries on the sheets, please contact your Kaufman Hall
Consultant.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Budget Global Data 1-4

� Overview
Each of the four GlobalData drivers allows you to adjust current year projections and next-year budget
values by month for individual expense items. The initial values are populated from source data using
predefined queries. The filter capability helps narrow down the available departments and/or accounts
to specify in this driver.

Note the following:

l In the DEPT and ACCT filter fields, make sure to only use DEPT or ACCT filters.
l Under the ACCT filter field, the driver lists the current filter and the last saved filter.
l When inserting a new department or account row, the system only offers a selection of

departments or accounts that meet the filter criteria. You cannot enter the department or
account number by typing it in the field.
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l The system will not allow you to save duplicate records.

� Settings
1. Open the driver.

2. In theDEPT Filter and/or ACCT Filter field, right-click the cell, and select Axiom Wizards > Filter
Wizard.

NOTE: Only users assigned the GlobalDriverMgmt role can make edits to this driver.

3. Create or select an existing filter to use. For instructions, see Using the Filter Wizard.

4. Refresh the variables by doing one of the following:
l In theMain ribbon tab, click Refresh Data.

l Press F9.

5. To add a new row, double-click Double Click to Insert New Dept/Acct row.

6. From theDepartment and/or Account column, select the appropriate department or account.

NOTE: Only the departments or accounts that meet the filter criteria will display in the list of
options.

7. To delete a record, in the far left column, select Delete from the drop-down.

8. After making your changes, in theMain ribbon, click Save.
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Budget Global Expense

� Overview
This driver provides an alternative location for budgeting dollars to specific expense accounts shared
across departments without having to divide the dollars between multiple budget plan files. Some
common uses are for Building Rent and Inter-company Allocations.

Use this sheet for any department and account combination to budget globally instead of by entering
values into individual budget plan files.

For an account to reference the values on this sheet, the budget method (KHAStdLine) in the ACCT
dimension table must be set to GlobalExpense.

You can add additional rows by copying the formulas from the ones already set up.

� Settings
Open the driver, and then complete the driver settings, as needed.
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Budget Global Sum

� Overview
This driver allows you to calculate the value of an account on the Stat_Rev or Expense sheet based on the
value of one or more other accounts on the Stat_Rev sheet.

Use this sheet for any department and account combination to budget as a percentage of the total of
specific accounts on the Stat_Rev sheet.

To reference this sheet, enter GlobalSum as the budget method in the ACCT dimension table
(KHAStdLine).

You can add additional rows by copying the formulas from the ones already set up.

IMPORTANT: Do not change the codes on Row1 or delete a column without consulting with
Kaufman Hall first.

� Settings
Open the driver, and complete the following sections in the GlobalSum sheet:

� Revenue Accounts to be Summed section
Use this section to list the accounts on the Stat_Rev sheet to sum together.

Accounts to sum together and have the same adjustment factor applied should have the same Account
Summary Group.

Summary groups can be text or numeric. Do not use the word Unused to avoid inadvertent summations.

The only methodologies that can be summed are the following:

l Allowance
l BadDebt
l CDMIPRevenue
l CDMOPRevenue
l IP_Payor
l IP_Per_Unit
l OP_Payor
l OP_Per_Unit
l Oth_Payor
l Oth_Per_Unit
l ProviderRev

You can add additional rows by copying the formulas from the ones already set up.
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IMPORTANT: Do not change the codes on Row1 or delete a column without consulting with
Kaufman Hall first.

Displayed fields and settings in the Revenue Accounts to be Summed section include:

Option Description

Budget Group l Acct – Add or modify the account number.
l AcctSumGroup1-4 – There are four account summary groups available.

Add or modify these values.

Dept\Acct Exceptions l Dept – Add or modify the department.
l Acct – Add or modify the account number.
l AcctSumGroup1-4 – There are four account summary groups available.

Enter or modify these values.

Acct Exceptions l Acct – Add or modify the account number.
l AcctSumGroup1-4 – There are four account summary groups available.

Enter or modify these values.

� Accounts to use GlobalSum Methodology section
Fields and settings in the Accounts to use GlobalSum Methodology section include:
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Option Description

Dept\Acct Exceptions l Dept – Add or modify the department.
l Acct – Add or modify the account number.
l Summary Group Column – From the drop-down, select one of the

following:
o AcctSumGroup1
o AcctSumGroup2
o AcctSumGroup2
o AcctSumGroup4

l Adjustment Factor Summary Group 1
l Adjustment Factor Summary Group 1
l Summary Group 1
l Summary Group 2

Acct Exceptions l Acct – Add or modify the account number.
l Summary Group Column – From the drop-down, select one of the

following
o AcctSumGroup1
o AcctSumGroup2
o AcctSumGroup3
o AcctSumGroup4

l Adjustment Factor Summary Group 1
l Adjustment Factor Summary Group 2
l Summary Group 1
l Summary Group 2

Budget Expenses drivers
The following table includes a description of each type of Budget Expense driver:
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Driver Description

Budget Expense
Adjustment

Use to control expense rate increases by facility, broken out by income
statement category.

Budget Expense
Admin Adjustments
Setup

Use to make incremental adjustments to manager inputs on budget plan
files.

Driver Description

Budget Expense
Adjustment

Use to control expense rate increases by facility, broken out by income
statement category.

Budget Expense
Admin Adjustments
Setup

Use to make incremental adjustments to manager inputs on budget plan
files.

Budget Expense Adjustments

� Overview
This driver contains the following fields for controlling expense rate increases by facility, broken out by
income statement category (as defined in the FSDetail column of the ACCT dimension table).

� Settings
Open the driver, and then use the following table to complete the settings in this driver, as needed :
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Option Definition

FY Year Projection
Adjustment

Use to modify expense values for current year projection.

FY YearBudget
Adjustment

The default expense adjustment for all budget plan files (exceptions can be
made for any defined Budget Groups in the sections below)

Budget Groups Defines exceptions to the global expense adjustments for any defined
Budget Groups. Exceptions can bemade by FSDetail category and/or
Account.

NOTE: Axiom Budgeting and Performance Reporting overrides default
exceptions with the FSDetail exceptions and overrides any FSDetail-level
exceptions with the ACCT exceptions. This applies for both current year
and next year’s budget.

FYYear Fixed % Used if using the PctofSalaries_FixedPct methodology. This will set a fixed
percentage to be used for all departments in that budget group rather
than the historical percentage which would be different for all
departments.

FYYear Rate/FTE Used if using the RatePerFTE_Fixed methodology. This will set a fixed rate
per FTE to be used for all departments in that budget group rather than
the historical rate which would be different for all departments.

Budget Expense Admin Adjustments Setup

� Overview
Use these drivers to make incremental adjustments to manager inputs on Budget plan files. To use these
drivers, you must first set up the accounts in the Budget Expense Adjustments driver.

� Settings
When you open the driver, double-click where indicated to insert a row.
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Use the drop-down menu to select whether to enter exceptions for that DEPT/ACCT combination by
Amount or Percent.

Repeat for as many DEPT/ACCT combinations as you need to enter exceptions. When you are finished,
save the file.

Next, open the Budget Expense Admin Adjustments driver from the Budget Admin task pane. When you
open the driver file, your DEPT/ACCT combinations display. Finally, save the Budget Expense Admin
Adjustments driver.

NOTE: This driver only links to calc methods for Detail, Fixed, Rate Per FTE, and Variable. It is not
designed to work for FTE or salary adjustments.

Budget CDM drivers
The following table includes a description of each type of Budget CDM driver:
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Driver Description

Budget CDM
Configuration

Use to set configuration options for the CDMRevenue tab in budget plan
files, including the inpatient and outpatient volume settings.

Budget CDM
Overrides

Use to override the charge per unit rate for specific CDM codes, either
globally or by budget group/department.

Driver Description

Budget CDM
Configuration

Use to set configuration options for the CDMRevenue tab in budget plan
files, including the inpatient and outpatient volume settings.

Budget CDM
Overrides

Use to override the charge per unit rate for specific CDM codes, either
globally or by budget group/department.

Budget CDM Config

� Overview
Use this driver to configure the CDMRevenue tab in Budget plan files, including the inpatient and
outpatient volume settings.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Description

Budget Option -
Activate KHABgtMap?

Select one of the following:

l To activate KHABgtMap, select Yes.
l To not activate KHABgtMap, select No.

Stat_Rev Integration
Option

l From the Allocate CDM Revenue to GL Accounts drop-down, do the
following:
o To calculate the total revenue on the CDMRevenue sheet to be

allocated to the GLAccounts interfaced on the Stat_Rev sheet, select
Yes. The allocation uses YTD history as its allocation method.

o If you select No, the Use CDM GLAcct to integrate with Stat_Rev
automatically will turn to Yes, and it will use themapping from the
RevUsage dimension table on the IPRevAcct and OPRevAcct
columns.

l From theUse CDMCode.GLAcct to integrate with Stat_Rev drop-
down, select Yes orNo.

Optional CDM
Revenue Column
Display

l Select whether to Show or Hide the Last Year Actual, Current Year
Budget, and Preliminary Budget columns on the CDMRevenue sheet in
the budget plan files.

l From the IP Revenue Spread and OP Revenue Spread drop-downs,
choose the default spread in the budget plan files. Choices include the
Driver, Calendar Days, Work Days, Even, or History. You can override
this setting in each budget plan file.

Budget CDM Overrides

� Overview
Use this driver to override the charge per unit rate for specific CDM codes, either globally or by budget
group/department.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 176



� Settings
Open the driver, and then complete the driver settings, as needed.

Option Description

CDM Code Type the charge code to override.
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Option Description

Description Displays a description of the charge code you entered in the CDM Code
column.

IP Inpatient

OP Outpatient

Health Plan drivers
The following table includes a description of each type of Budget Health Plan driver:

Driver Description

Membership
Enrollment Trend

Allows you to enrollment percentages for insurance/health plans offered
by your organization to determine themembership trend of each plan.
The trend percentages are then used in theMembership Per Member Per
Month (PMPM) driver to adjust themembership statistics.

Membership PMPM Provides the basis for several important planning activities needed for
your organization to budget insurance/health plans in your plan files
including calculating historical PMPM values based on available history
and calculating the projection and monthly budget for revenues and
expenses.

Membership Enrollment Trend driver

� Overview
Use this driver to enter enrollment percentages for each health plan or insurance product offered by
your organization. The purpose of this driver is to determine themembership trend of each insurance
product. The trend percentages are then used in theMembership Per Member Per Month (PMPM)
driver to adjust themembership statistics.

TIP: If themembership percentages are provided by the health plan company’s actuaries, you can
enter those values in this driver.

� About this driver
Note the following before configuring this driver:

l This driver is only accessible if your organization has the Axiom Budgeting Health Plan license.
l You must first add/edit insurance or health plan products in the INSCODE dimension table. The

system automatically populates the driver with the information from this dimension. The system
does not allow you to manually enter plans directly into the driver.
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l You must first complete this driver setup before configuring theMembership PMPM driver.
l Only users assigned the GlobalDriverMgmt role profile can access and update this driver.

Access to the data table that stores the health plan records is controlled using the Budget Security
Update utility. In the HealthPlan column, you can configure the filter for the health plan data. This
column only displays if your organization has an Axiom Budgeting Health Plan license.

� Understanding the interface
The driver displays the list of insurance plans by clearly grouping them together by entity. By default, the

list of insurance plans is expanded, but you can double-click to expand or double-click to contract
it. After you save your changes, the system remembers this setting the next time you open the driver.
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To remove an entity from the driver, click the Save drop-down, and select Delete. After you save your
changes, the system will remove the entity from the driver.

NOTE: This action does not delete the entity from the system. It simply removes the entity from the
driver list. To add the entity again, in theMain ribbon tab, click Refresh Data. You can also press F9
on your keyboard.

You can view specific parts of the driver from theMain ribbon tab by clicking Change View, and selecting
one of the following:

l Default - Displays both the actuals and budget columns for each period as well as the Projected
Actuals.

l Hide Actuals - Hides the actuals columns for each period. The projected actuals column remains
available.

l Hide Budget - Hides the budget columns for each period.

� Settings
Complete the following steps to configure this driver:

1. In the Bud AdminBud Admin task pane, in the Budget Assumptions section, do one of the
following:

l To open next year's budget drivers, click Access NY Budget Assumptions.
l To open this year's budget drivers, click Access CY Budget Assumptions.
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2. Double-click 45 Budget HealthPlan Enrollment Trend.

3. In the Refresh Variables dialog, type the entity number(s) in the field or click Choose Value to
select the entities, and then click OK.

4. To display the plans to budget for the entities, in the first column click the Select Option cell, and
select Save.

NOTE: The list that displays populates from the INSCODE dimension table. If you add a plan to
the table, the new plan is automatically added to this driver. Removing a plan causes an
unmatched records message on the screen. For more information, see Unmatched records
below.

5. In the actuals columns for each period, enter the actual percentage of growth or reduction of
membership that the plan experienced or expect to experience.

6. By default, and upon initial use, all Projected Actuals and Budget columns display 100% for all
plans. The configured growth or reduction ofmembership percentages provides the basis for
budgeting plan membership for the next budget year. You can change this number, if needed.

7. In the Comments column, enter any additional information related to the Actual or Projected
Actuals columns.

8. In the budget columns for each period, enter the percentage of growth or reduction of
membership that you expect the plan to experience.

9. After making your changes, click Save.

� Managing unmatched records (orphan data)
If a plan is removed from the INSCODE dimension table (i.e., a plan is retired or discontinued), an
Unmatched Records area displays at the bottom of the driver page. This is often referred to as orphan
data. The list of unmatched records means there are plans in the driver table that are no longer valid
because of the changes in the dimension table. The system lists the unmatched records and will remove
them from the driver table the next time you save.

TIP: The Unmatched Records area displays at the bottom of the driver page, so you may need to
scroll to see this information. You can also jump to this section from theMain ribbon tab by clicking
Go To >Unmatched Records. This option only displays when unmatched records exist. The driver
screen will also display a warning message.
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NOTE: More unmatched records may occur for other entities in the database, however the system
will only delete the plans for those entities you selected in the Refresh Variables dialog.

Membership Per Member Per Month (PMPM) driver

� Overview
This driver provides the basis for several important planning activities needed for your organization to
budget health plans and insurance products. The system uses the information in this driver to populate
the HealthPlan Operation utility.

l Depending on the level of detailed records loaded by your organization in the ACT_HP_20XX data
table, the driver can bring in actual data for members, revenues, and expenses by entity,
department, insurance code, location, and data type. The driver calculation methods then
calculate historical PMPM values based on available history.

l The historical PMPM rates carry forward to any non-actual period. For example, if six months of
actual is used, then month seven of the current year in the driver refers to themonth six PMPM
rate. The rates in all non-actual months can be edited.

l The PMPM rates in the projection and monthly budget columns are then used to calculate the
projection and monthly budget for revenues and expenses in the HealthPlan Operations utility.
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This driver provides a central location to reviewmember lives, revenue PMPM, and expense PMPM for
each health plan and specifically within each entity (or department). The enrollment percentages from
theMembership Enrollment Trend driver updates the planned member lives, which also flows to the
HealthPlan Operation utility.

� About this driver
Note the following before configuring this driver:

l This driver is only accessible if your organization is licensed for the Axiom Budgeting Health Plan
product. Only users assigned the GlobalDriverMgmt role profile have access to this driver.

l You must complete the following before configuring this driver:
o Add or edit insurance or health plan products in the INSCODE dimension. The system does

not allow you to manually enter plans directly in this driver because the system
automatically populates it with the plans listed in the INSCODE dimension.

o Add or edit the health plan budget data types in the DATATYPE dimension.
o Add or edit department locations in the LOCATION dimension.

For instructions on updating these dimensions, see Updating dimensions for health plan
budgeting.

o Configure theMembership Enrollment Trend driver before configuring this driver. If the
Membership Enrollment Trend driver is not configured, theMembership PMPM driver will
default to 100%.

l The system auto populates the driver with data that is stored in the ACT_HP_20XX data table. You
can enter the data manually in this table or as part of an import. Your Kaufman Hall
Implementation Consultant will help you set up the table for your organization, but you will need
to maintain this table as new plans are added.

NOTE: There is no pre-defined import available to import health plan data at this time, but
you can work with your Kaufman Hall Implementation Consultant to create a custom import.

l To remove or retire a plan, you cannot delete it from the driver. For instructions, see Removing or
retiring plans.

� Understanding the interface
The driver makes it easy to view and manage plans by displaying entities and department using a tiered
structure that follows this format:
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n Entity
n Department

n Insurance/Health Plan
n Location

n Data Type

When you first open the driver, the list of locations is expanded, but you can double-click to expand or

to contract it. After you save your changes, the system remembers this setting the next time you
open the driver.

The columns to the right of the listed data types are the actuals columns that display the data stored in
the Act_HP_20XX data table. The blue cells allow you to edit remaining projected by month and
budgeted values, if needed. By default, the values for themembership row are calculated using the
Membership Enrollment Trend driver. The system calculates these values by multiplying the previous
month's enrollment numbers by the percentage for the period in theMembership Enrollment Trend
driver.

Let's say an organization expects a 10% growth in their membership for period 7. Themembership
number for period 6was 88,798. The system multiplies this number by 1.10 for a projected actual of
97,678members. This calculation continues throughout the blue cells for both actuals and budgeted in
themembership row. You can edit this value two ways:

l Adjust the percentage in theMembership Enrollment Trend driver
l Edit the value directly in the actual or budget blue cell in theMembership PMPM driver
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NOTE: You can usually get the plan percentages from an actuary at the insurance or health plan
company.

The values in the data types from both the actual and budget columns are derived by dividing the data
type period value (located in the ACT_HP_20XX data table) by the number ofmembers in the same
period. In the following example, the value for hospital medical expenses for this departments plan in
period 6 is $11,099,749. The system divides this amount by the number ofmembers, in this case 88,798
and calculates the expense as $125 per member. TheMembership Enrollment Trend driver provides a
starting point for budgeting your health plan costs for the remainder of the year.
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When entering remaining projected and budget values, you can either use the values that are
automatically calculated by the system using theMembership Trend Enrollment driver, or you can enter
your own custom values. The option you choose is indicated by the Spread Tag column. When entering
and saving custom values, the Spread Tag column automatically changes from Default to Previous
Input. The Previous Input option means that the system stores and retrieves the values from the
Membership PMPM driver table versus using the default calculations. Even if you use custom values,
you can return to using the driver-calculated values at any time by selecting Default from the Spread Tag
column.

� Changing views
You can view specific parts of the driver from theMain ribbon tab by clicking Change View, and selecting
one of the following:

l Default - Displays both the actuals and budget columns for each period as well as the projected
actuals.

l Hide Actuals - Hides the actuals columns for each period. The projected actuals column remains
available.

l Hide Budget - Hides the budget columns for each period.

� Settings
Complete the following steps to configure this driver:
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1. In the Bud AdminBud Admin task pane, in the Budget Assumptions section, do one of the
following:

l To open next year's budget drivers, click Access NY Budget Assumptions.
l To open this year's budget drivers, click Access CY Budget Assumptions.

2. Double-click 46 Budget HealthPlan Membership PMPM.

3. In the Refresh Variables dialog, do the following to filter the entities or departments that display
in the driver:

a. In the Filter by Entity field, type the entity number(s) or click Choose Value to select the
entities, and then click OK.

b. Optionally, in the Filter by DEPT.KHABgtMap field, type the department number(s) or click
Choose Value to select the departments, and then click OK.

4. In the actuals and budget columns, do one of the following:
l To use the default values derived from theMembership Trend Enrollment driver, select

Default in the Spread Tag column (if it is not already selected).
l To use custom values, type the values in the columns. When you save your changes, the

Spread Tag column changes from Default to Previous Input.

TIP: Even if you enter custom values, you can go back to using the default values by
selecting Default from the Spread Tag column. The system will automatically use the
values calculated using theMembership Enrollment Trend driver. After you save your
change, the system will change the spread tag from Previous Input back to Default to
indicate that these are driver-calculated values.

For more information on how the spread tags work, see Understanding the interface in the
section above.

5. After making your changes, click Save.

� Adding data types
To add a data type:

1. In the list of data types, double-click Double click to Add New Datatype.
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NOTE: The purpose of this option is to allow you to add a revenue or expense category that
contains no actual history. For example, if the AARP health plan does not contain drug
expense historically, but nowwewish to include it for planning, this option will accommodate
that expense category.

2. In the Select Datatype field, type the name of the data type or click Choose Value to select the
data types.

3. Click OK.

Because you can only add one instance of a data type, the list of available data types diminishes as they
are added to the driver for a particular location. If all the data types have been used, then themessage
No additional Datatypes available for insertion replaces Double click to Add New Datatype at the
bottom of the list.

� Deleting data types
After you select the data types to delete, the system does not remove them until after you save the
driver.
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To delete a data type:
1. Next to the name for each data type to delete, click the Save cell drop-down, and select Delete.

2. In theMain ribbon tab, click Save.

� What if there are no members in a plan?
Newplans will likely have no members or historical information in the system, but you can still use this
driver to manually enter membership numbers and begin the health plan budget process. In this
situation, themembership row displaysMembers Not Found and the system displays zeroes in the
white cells of the actual period columns. However, in the blue cells, you can manually enter member
numbers and revenue/expense stream values, as needed.

TIP: Instead of entering the new plan information in this driver, another option is to simply enter this
same data in the ACT_HP_20XX table. The system will then pull in the data from the table as the
starting point for the new plan.

Budget Labor drivers
The following table includes a description of each type of Budget Labor driver:

Driver Description

Budget Labor
Configuration

Use to configure default settings for tracking and calculating labor-related
expenses.
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Driver Description

Budget Labor Rates Use to control the wage rate increases globally for your entire organization
as well as for specific budget group and department categories.

Budget Labor
Accounts

Use to configure certain salary or benefit accounts to use total salaries or a
subset of salary accounts to use in the calculation.

Budget Labor ADC
Configuration

Use to configure the job classes and staffing ratios for each job class.

Budget Labor Alt FTE
Factors

Use to configure Alt FTE factors.

Budget Labor
Benchmark driver

Use to define a benchmark target of FTEs or Worked Hours per Unit of
Service (WHPUOS) by department.

Budget Labor
JobCode Dropdown

Use for any department where a filter applied to a JobCode drop-down
provides a streamlines list for the user.

Budget Labor Limits Use to top-out rates when needed.

Budget Labor
Override

Use to make overrides to the various labor-related sheets, such as Empl_
List, in budget plan files.

Budget Labor Target Use to define a target ofWorked Hours per Unit of Service (WHPUOS) by
department and job code.

Driver Description

Budget Labor
Configuration

Use to configure default settings for tracking and calculating labor-related
expenses.

Budget Labor Rates Use to control the wage rate increases globally for your entire organization
as well as for specific budget group and department categories.

Budget Labor
Accounts

Use to configure certain salary or benefit accounts to use total salaries or a
subset of salary accounts to use in the calculation.

Budget Labor ADC
Configuration

Use to configure the job classes and staffing ratios for each job class.

Budget Labor Alt FTE
Factors

Use to configure Alt FTE factors.

Budget Labor
Benchmark driver

Use to define a benchmark target of FTEs or Worked Hours per Unit of
Service (WHPUOS) by department.

Budget Labor
JobCode Dropdown

Use for any department where a filter applied to a JobCode drop-down
provides a streamlines list for the user.
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Driver Description

Budget Labor Limits Use to top-out rates when needed.

Budget Labor
Override

Use to make overrides to the various labor-related sheets, such as Empl_
List, in budget plan files.

Budget Labor Target Use to define a target ofWorked Hours per Unit of Service (WHPUOS) by
department and job code.

Budget Labor Configuration

� Overview
This driver contains default settings for how labor-related expenses are tracked and calculated. You can
set exceptions for specific budget groups by adding another calc method and entering data for the
specific budget group.

� Settings
Open the driver. The top of the sheet begins the settings for the global configuration, including the
following calc method blocks:

l Labor Configuration
l Standard Budget PayTypes
l Earned Paid Time Off Setup

After configuring the global labor drivers, you can do the same for each budget group.
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� Global Setup and Default Budget Workbook Configuration Settings section

Settings in this section include:

Option Definition

Activate Dept Based Pay? Enable or disable department-based pay and designate a
default JobCode (the default is initially set to JDept).

Global or BudgetGroup name Hours
per FTE Convention

Do one of the following for each BudgetGroup:

l To use the default standard work hours specified by
your organization, select Default.
NOTE: The default selected by your organization is
configured in the YearPeriod table.

l To use the non-default standard work hours, select it
from the list. For example, if the default is 2086, then it
displays as Default. The other option that would display
is 2080.

For more information, see Setting year and period.

Global or BudgetGroup name
Calendar Days

The calendar days for the YTD, remainder of the current
year, and upcoming budget years.

Global or BudgetGroup nameWork
Days in Period

The work days in each period.

Global or BudgetGroup name Hours
in Period

The hours in each period, calculated by work days.

Global or BudgetGroup name
Number of Holidays

The number of holidays in each period.

� Labor Configuration section
In this section, enter basic assumptions and key statistics related to payroll.
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Settings in this sheet include:

Option Definition

%of Staffing Change with Volume The ratio of staffing increases to volume increases.

Medicare Tax TheMedicare tax rate for staff.

Current FICA Rate The FICA rate for staff.

Current FICA Limit The FICA limit for staff for the calendar year.

Retirement Below FICA limit The retirement benefit rate to apply before the employee's
salary passes the amount in the Current FICA limit cell.

In the following example, the current FICA limit is $113,700.
As a result, the retirement benefit is calculated at 12%.

Retirement Above FICA limit The retirement benefit rate to apply when the employee's
salary exceeds the amount in the Current FICA limit cell
but does not exceed the amount in the Retirement Max
Limit cell.

For example, an employee's salary increases to $125,000.
As a result, the retirement benefit rate increases from 12%
to 18%.

Retirement Max Limit The amount at which the retirement benefit rate stops.

Uniform Merit Increase Date? Click Yes and designate a date when themerit increases go
into effect; otherwise, click No.
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Option Definition

FTE Comparison to YTD Can use Scheduled FTEs (from Labor Master import) or
CYB FTE – Current year budget FTEs from Payroll26.

Projected FTE Starting Point Use this option to set the starting point for projected FTE
counts.

l To use YTD_FTEs as the projected starting point, select
YTD_FTE.

l To set the starting point as schedule and budget, select
Sched/Budget.

NOTE: To use CYB_FTE, you must run theMonthly to
Biweekly report under Reports Library >Management
Reporting Utilities > Payroll to transfer your budgeted FTEs
from themonthly payroll tables to the biweekly payroll
tables. Default setting is Sched_FTE, which feeds from the
Empl_List in the budget plan files.

Forecast FTEs from Projection To set the default budget FTEs to zero in all labor sheets
(JobCode, Staffing and Employee), select No. The default
setting is Yes.

Hours per PayPeriod Defines the number of hours in a pay period. The default is
80.

Hours per Monthly This should not be edited.

Reimbursed Salaries Account This should not be edited.

KHASum Code for Agency Summary code for Agency labor.

KHASum Code for Physician Summary code for Physician labor.

Use Self-Balancing to Target on
JobCode tab?

When active, this feature forces the department budget to
a selected target on the Benchmark sheet.

JobCode to use for Self-Balancing
JobCode Adjustment

Input valid job code for variable and fixed.

PayType to use for Self-Balancing
JobCode Adjustment

Input valid pay type for variable and fixed. The default is
the Regular pay type specified in the Standard Budget
PayTypes Productive Categories section below.

Account to use for Self-Balancing
JobCode Adjustment

Input valid account for variable and fixed. Default is the
"Regular" account specified in the Standard Budget
PayTypes Productive Categories section below.
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Option Definition

Projection FTEs - Use YTD Actual or
NYB Adjusted

You can base the Projected FTE allocation off of YTD or
NYB. This means that if there are adjustments in the yellow
allocation rows from the base YTD calculation, you can
elect to make that same assumption for the Projected FTE.

For example, assume that the YTD% for overtimewas 4%
YTD. The projection would also be 4% and would calculate
the overtime FTE accordingly. But, assume an adjustment
to overtime allocation of 8% is made. This would normally
apply to just NYB, but now that 8% adjustment can apply
to the Projection FTE too.

Program Additions Allows for custom naming of the Program Additions row.
To change the name, type the desired name in the cell to
the left of the label.

Position Changes Allows for custom naming of the Position Changes row. To
change the name, type the desired name in the cell to the
left of the label.

� Standard Budget PayTypes section

This section defines the pay categories for Productive, NonProductive, and Contract labor that you can
assign to the JobCode, Staffing, and Employee columns in the PAYTYPE dimension table. This determines
how different paytypes are spread out over themonths of a year. The initial configuration is set up by
your Syntellis Implementation Consultant during implementation.

Settings in this section include:
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Option Definition

Productive Categories Includes regular, overtime, education, and so on.

NonProductive
Categories

Includes time off and other non-productive hours.

Contract Labor
Categories

Define up to seven categories of contract labor in the labor models

Productivity Statistic Defines the PayType used to store productivity statistics, usually PStat.

� Earned Paid Time Off Setup section
Use this section to determine how PTO is computed based on labor hours.

Settings in this sheet include:

Option Definition

Earned Paid Time Off
Setup

Set whether to use calculated PTO. To use historical taken PTO as the
budgeted PTO, select No. If you select Yes, you can select the gross or net
method for earned PTO.

Earned PTO Hrs
Conversion Factor

The rate at which hours accrue based on which account.

Default Earned PTO
Hours Per FTE

The default annual per-FTE PTO hours earned.

Working with FTE standard working hours

The FTE Hours standard specified from the YearPeriod table is included in the Budget Labor Configuration
tab. This allows you to not only define standard working time globally across your organization, but you
can also define it for each budget group.
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In the Budget Labor Configuration driver, the Default values are set up in the YearPeriod table where you
can set the standard working hours by job code.

You do this in the StdHours column in the JOBCODE dimension table. This is a validated field so the two
options are Default and 2080 Hours.

The FTE Hours standard specification is especially helpful if your organization has a mix of employees
using the Jobcode or ProviderComp labor methods but are using alternate FTE standard working hours.
For example, highly compensated employees are perhaps using a 2080 FTE scale while others are using a
2086 FTE scale, yet they are on the same Jobcode labor type.

NOTE: As an administrators, you only need to update this column if you need the alternate scale.
The column automatically displays Default, so no additional configuration is required.
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NOTE: Standard reports do not recognize FTE calculations based on the two scales. We recommend
that you modify or create your reports to represent the FTE values, if needed. For example, if an FTE
using 2080 hours is calculated with a denominator of 2086, then the FTE displays as .9971, unlesss
rounded to two decimals.

After setting up and applying the FTE Standard, within the plan file, a row is added. If the 2080 Hours
option is selected, the hours will be based on the FTE factors on this row.

In themonthly hours row of the applicable Labor calc method, the formula looks for 2080 Hour, and if
present, then the hours are based on the 2080 row, as seen i the calculation highlighted in the following
example.

The following example shows the option selected from the JOBCODE dimension.
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The following example shows the option selected from the JOBCODE dimension.

Budget Labor Rates

� Overview
The Budget Labor Rates driver allows you to control the wage rate increases globally for your entire
organization as well as for specific budget group and department categories. For each category, you can
also set rate increases by job code (determined by the JobClass grouping column in the JOBCODE
dimension table), job class, and step.

There are two types of wage rate increases you can configure:

l Annual Merit – The effective date from the labor master file is used in the budget plan file. If there
is no match to the Empl_List, theMerit Month is used by default.

l Market Adjustments – TheMarket month listed in Budget Assumptions is themonth in which the
increase is applied. You can define up to two Market Adjustment merit increases.
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� Settings
Open the driver. When configuring the Labor Rate driver, you begin by specifying global rate and merit
increases that apply to the broadest set of job codes. Next, you specify the rate and merit increases by
specific budget group. Finally, you can finish your configuration at themost specific category—by
department.

NOTE: Budget groups are normally used for entities within your organization, but you can use them
any way you wish.

Within each Labor Rate category, you can specify rate and merit increases by job code, job class, and
step. The following is a list of the different configuration combinations you can set up, in order of
broadest to most specific.

l Global | Global (Broadest)
l Global | JobClass
l Global | JobClass | Step
l Global | JobCode
l Global | JobCode | Step

l BudgetGroup | Global
l BudgetGroup | JobClass
l BudgetGroup | JobClass | Step
l BudgetGroup | JobCode
l BudgetGroup | JobCode | Step

l Dept| Global
l Dept | JobClass
l Dept | JobClass | Step
l Dept | JobCode
l Dept | JobCode | Step (Most specific)

When it comes to actually applying the rate and merit adjustments, Axiom Budgeting and Performance
Reporting evaluates each job code and applies themost specific Labor Rate driver configuration first. If a
configuration does not apply to the specific job code, the system evaluates the next least-specific
configuration to see if it applies. If it does not, the system continues to evaluate the job code until it
meets the requirements of a configuration.

In the following example, rates have been specified for Global |JobClass and Global | JobClass | Step for
a job class defined as Other. Employees who meet the step criteria will receive a 30% increase while those
in the same job class that do not meet the step criteria will only receive a 20% increase.
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In the following example, note the configuration of Global-J00200.

In this next example, note that Global-J00200 is recognized in the Empl_List tab.

When configuring the Labor Rate driver, remember the following:
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l Themost specific labor rate you configure will be the one that controls the labor rate adjustments.
For example, if you configure the rates for Dept | Global, but you do not specify the rates for Dept
| JobClass, then the rates apply to everyone in the department—regardless of job class, job code,
or step.

l To minimize the number of configurations you need to set up and maintain, we recommend using
the global configurations to institute your rate and merit increases for most job codes. You should
only use themore specific labor rate categories and configurations as exceptions.

The configurations you make in the Labor Rate driver affects the following tabs in the plan file:

l JobCode
l Staffing
l Employee
l Provider
l HHLabor
l AltFTE

The same exception principle that is applied in expense adjustment is applied here as well. After Axiom
Budgeting and Performance Reporting determines that it is an exception, all other related increases will
not apply.

You can make exceptions to budget groups by adding another calc method block and entering the code
for the budget group.
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� Configuring labor-rate details
1. To make global rate changes for the Global, BudgetGroup, and/or Department categories, in the

Global Change row, type rate increase percentages in theMerit,Market-1, andMarket-2
columns.

2. To add a job class or job code to an existing labor-rate category, click >> next to <= Click here to
enter JobClass or <= Click here to enter JobCode.

3. To add a step to a job class or job code, in the Step field, type the step code or description.
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4. To make rate changes for job classes and job codes for a labor-rate category, type rate increase
percentages in theMerit,Market-1, andMarket-2 columns.

5. To add another job class or jobcode and step, double-click Double Click to Insert New Jobclass
and Step or Double Click to Insert New Jobcode or Step.

6. To add a new budget group and/or department, do the following:
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a. In the Enter New BudgetGroup Code section or the Enter New Department Code section,
in the BudgetGroup column, type the budget group or department group in the blue cell.

b. To add another new budget group or department, double-click Double Click to Insert New
Budget Group or Double Click to Insert New Department Group.

c. To add job classes, job codes, or steps to the new category, complete Steps 2-5.

7. When you are donemaking changes, in theMain ribbon tab, click Save.

NOTE: After you click Save, any new budget groups and departments that you added move
up to the list of existing budget groups and departments. The system then reorganizes the list
in alphabetical order.

8. At the confirmation prompt, click OK.

Budget Labor Accounts

� Overview
Use this driver to configure certain salary or benefit accounts to use total salaries or a subset of salary
accounts to use in the calculation. You can set the configuration for all or configure it for a specific budget
group.
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� Settings
Open the driver, and then complete the driver settings, as needed.

Budget Labor ADC Config

� Overview
In the Budget Labor ADCConfig driver, configure the job classes and staffing ratios for each job class. The
staffing ratios are used to build out the nursing grid in the budget plan files. You must also determine if
each class is considered:

l Fixed - Position is fixed but is not replaced for PTO calculation.
l Fixed With Replacement - Position is fixed but is replaced for PTO calculation.
l Variable - Position is replaced for PTO calculation and fluctuates with volume changes.

For each defined job class, you must input a staffing ratio to determine the flexing point of each Average
Daily Census level.

There are sections to do this globally for all departments, make exceptions by BudgetGroup, or make
exceptions by department. For each defined job class, you must input a staffing ratio.

Fields and settings in the ADC Configuration driver include:

l Global – Used to set a global staff-per-patient ratio for each category.
l BudgetGroup – Designate exceptions by budget group.
l Dept – Designate staff per-patient-ratios by department. This is themost commonly used section.

NOTE: To activate the ADC sheet for a department, enter JobcodeADC in LaborType in the DEPT
dimension table.
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� Settings
Open the driver, and then complete the driver settings for Global, BudgetGroup, and Dept, as needed,
for each shift.

Budget Labor Alt FTE Factors

This driver allows you to enter different bi-weekly hours for some job codes due to union labor contracts.
For example, you might need to enter 75 hours for some job codes instead of 80.

� Overview
Use this driver to configure the Alternate FTE factors.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Description

JobCode Type the job code.

FTE Factor Type the FTE factor.

Budget Labor Benchmark driver

� Overview
Use this driver to define a benchmark target of FTEs or Worked Hours per Unit of Service (WHPUOS) by
department. You can define a target for the current year (CY Target) as well as next year (NY Target). The
Target Type column contains drop-downs to select the type of target to use for each department.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Description

Dept Displays the department code.

Department Name Displays the name of the department.

Target Type Select the target number of paid FTEs for the department.

Total FTEs Type the target number of FTEs for the department.

WHPUOS Type the number ofWorked Hours per Unit of Service.

PHPUOS Type the number of Paid Hours per Unit of Service.

Budget Labor JobCode Dropdown

� Overview
Use the Budget Labor JobCode Dropdown driver for any department where a filter applied to a JobCode
dropdown provides a streamlined list for the user.

NOTE: This methodology only works with the Add New JobCodemethodologies on the JobCode tab.
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� Settings
Open the driver, and then complete the driver settings, as needed.

Budget Labor Limits

� Overview
Use the Budget Labor Limits driver to top-out rates when needed.

� Settings
Open the driver, and then complete the driver settings.

l Enter any applicable Job Code and its corresponding rate limit. If a Job Code has a rate limit of
$20.00 per hour and the 5% increase will exceed that, then the rate is capped at $20.00 per hour.

l TheMaxRate is used to determine if a lump sum payout should be calculated when a salary
increase is applied to employee rates. If you do not want to calculate lump sum payouts, set the
MaxRate to $1000. You can also set the Lump Sum Payout Multiplier on the Configuration sheet
to 0%.

l TheMid Rate (MidPoint) is used when a new Job Code is added to a departmental budget. The
Budgeted Rate defaults to the rate listed here, if available.

l TheMid and Max Rate values should reflect the rates that will be used in the new budget year. In
most cases, they should be adjusted by Human Resources to include the range updates related to
merit and market assumptions.
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Budget Labor Override

� Overview
Use this driver to make overrides to the various labor-related sheets, such as Empl_List, in budget plan
files. You can configure labor overrides at the following levels:

l Global
l Budget Groups
l Department Exceptions
l Department - Jobcode Exceptions
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The plan file calc methods process the overrides by first evaluating for exceptions at the job code level,
then department exceptions, budget group exceptions, and then finally applies the default settings at
the global level.

Labor Overrides allow you to modify how the Jobcode, Staffing, and Employee tabs calculate salaries and
related statistics and expenses.

You can adjust the following items:

l The source for Regular and PTO pay
l The source for PTO and EPTO FTEs
l The spread of pay across pay types

� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Definition

Department The department in which to apply the labor override.

Jobcode The job code for the specified department to apply the labor override.

NOTE: This column is only editable in theDepartment - Jobcode
Exceptions section.

Regular Rate Source Select the Regular Rate Source to use for the beginning budget rate for
each job code.

l History – Uses the historic rate based on themost recent current
period actual.

l Base – Uses the base rate from the EmployeeMaster sheet.
l Global – Uses the rate of pay entered on this tab in the Rate Override

Amount column.

Rate Override
Amount

Enter the override amount.

NOTE: This column is only editable in theDepartment - Jobcode
Exceptions section.

PTO Rate Source Select the beginning PTO budget rate for each job code.

l Base – Uses the rate listed on the EmployeeMaster sheet.
l Regular – Uses the Regular pay rate for PTO.
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Option Definition

PTO FTE Source Select the source of FTE for PTO Calculation.

l YTD – Uses actual Year-to-Date FTE.
l Rolling12 – Uses 12-month actual (full year) FTE.
l EPTO – Uses the EPTO rate based on scheduled. This may not match

the actual EPTO rate.

EPTO%Override Enter one of the following to override the calculated EPTO% from the
Empl_List:

l A percentage to override the standard PTO calculation.
l History orNA - If you do not want to adjust the EPTO%, enter NA, and

the default lookup to Emp_List logic applies.

IMPORTANT: Do not enter zero (0), because zero is a valid adjustment
percentage.

Adjustment to
Calculated PTO%

Modify the EPTO%used on the PTO row. This is a data validation entry
field, with a range from 0%-200%. For example, if the EPTO% for a selected
job code is 8%, and you enter 100% as the default in this column, the value
remains at 8% (i.e. 8% x 100% = 8%). If you enter the adjustments to
calculated EPTO% as 80%. then 6.4%would display as the value on the
PTO row.

EPTO FTE Source Select the source of the FTE for Earned PTO Calculation, if that option is
enabled on the Configuration sheet.

l YTD – The YTD FTE.
l Scheduled – The scheduled FTEs from the EmployeeMaster sheet.

Paytype Distribution
Overrides

Enter the Override FTE Allocation percentages by category. For each
category, do one of the following:

l Enter a percentage.
l To use the historical percentage by category by job code, select

History.

NOTE: History is the default. You can enter or modify this value. There are
several columns available, for both Prod and NonProd entries.

� Adding a new row to a section
To add a new row to a section, click theDouble Click to Insert New Budget Group/Dept
Exception/Jobcode Exception row.
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� Displaying the legend
The Labor Override Legend provides descriptions that corresponds to specified columns. The letter next
to the description corresponds to the letter that displays above the column, as seen in the following
screen shot.

By default, the legend is hidden. To display it, in theMain ribbon tab, click Change View > Legend.

To hide the legend, in theMain ribbon tab, click Change View > Default.

NOTE: When you close and reopen the driver, the system automatically hides the legend.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 214



Budget Labor Target

� Overview
Use this driver to define a target ofWorked Hours per Unit of Service (WHPUOS) by department and job
code.

� Settings
Open the driver, and complete the following:

l A target can only be defined for next year (NY Target).
l You can only enter a variable target based on worked hours per unit of service or a fixed paid FTE

target.
l The variable FTE calculation in the budget plan file will be forced to match the target.
l This method does not work on the Employee sheet since there is no variable logic.

Budget Revenue drivers
The following table includes a description of each type of Budget Revenue driver:

Driver Description

Budget Revenue
GlobalRev

Use to budget all dollars for specific revenue accounts centrally without
touching each individual budget plan file.

Budget Revenue
Adjustments

Use to control the revenue rate increases by BudgetGroup broken out by
Inpatient, Outpatient, and Other Revenue.
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Driver Description

Budget Revenue
Deductions

Use to control the rest-of-year projection as well as monthly budget
assumptions for those deduction accounts that are budgeted at the
department level.

Budget Revenue
Payor Adjustments

Use to configure percentage shifts in payor mix.

Driver Description

Budget Revenue
GlobalRev

Use to budget all dollars for specific revenue accounts centrally without
touching each individual budget plan file.

Budget Revenue
Adjustments

Use to control the revenue rate increases by BudgetGroup broken out by
Inpatient, Outpatient, and Other Revenue.

Budget Revenue
Deductions

Use to control the rest-of-year projection as well as monthly budget
assumptions for those deduction accounts that are budgeted at the
department level.

Budget Revenue
Payor Adjustments

Use to configure percentage shifts in payor mix.

Budget Revenue GlobalRev

� Overview
Use this driver to budget all dollars for specific revenue accounts centrally without touching each
individual budget plan file. Common uses are for Other Operating revenue and Inter-company
allocations.

� Settings
To reference this sheet, the budget method (KHAStdLine) in the ACCT dimension table must be
GlobalRevenue.
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Budget Revenue Adjustments

� Overview
This driver allows you to control the revenue rate increases by BudgetGroup broken out by Inpatient,
Outpatient, and Other Revenue.

� Settings
You can make department and account exceptions.

l EffectiveMonth is based on Fiscal month (If FYE is June, January is effectivemonth 7.)
l Departmental Exceptions are allowed at the bottom of each section.
l Common exceptions are if nursing inpatient increases will occur at a different rate than other

inpatient services, you need to enter each nursing department as an exception. You can also use
this to reflect the results of a price optimization study.

IMPORTANT: After you enter a department or account as an exception, any global facility
parameter will not be applicable.

Budget Revenue Deductions

� Overview
Percentage of Gross Revenue for Estimated Deductions

The Deductions driver controls the rest-of-year projection as well as monthly budget assumptions for
those deduction accounts that are budgeted at the department level.

The assumptions can be defined by:

l BudgetGroup and Account
l Department and Account

Administrator's Guide Axiom Budgeting and Performance Reporting │ 217



The same exception principle that is applied in expense adjustment is applied here as well. After Axiom
Budgeting and Performance Reporting determines that it is an exception, all other related increases will
not apply.

� Settings
Open the driver, and complete the following settings:

l BudgetGroup – Enter or modify this value.
l Acct – You can enter, modify this value.
l [Monthly budget amounts] – 12months of budget amounts, which you enter or modify.

Budget Revenue Payor Adjustments

� Setting up payor adjustments
If your organization uses a general ledger structure that is set up with detailed revenue accounts by
payor, you can use the Budget Revenue Payor Adjustments driver to budget for percentage shifts in
payor mix. Payor adjustments are used for revenue accounts in the general ledger system and set up by
payor. In the ACCT dimension table, you need to configure the FSPayor column to use this sheet. List a
valid code in the FSPayor column and list percentage changes in the inpatient, outpatient, and other
patient columns. The payor shifts displays in the Stat_Rev sheet in budget plan files. The system
calculates and displays budget revenue shifts in the budget plan files in hidden columns AU-AW.

� Settings
Complete the following steps to configure this driver:

1. In the ACCT dimension, configure the following columns for each payor specific account:
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Column Description

ACCT.FSPayor Type R_IP (inpatient payors), R_OP
(outpatient payors), or R_Oth (other
payors) followed by the payor name.
For example, R_IPMedicare, R_
OPBlueCross, R_OthOther.

ACCT.KHAStdline Type one of the following:

l R_IP – Inpatient payors
l R_OP – Outpatient payors
l R_Oth – Other payors

2. Open the 41 Budget Revenue Payor Adjustments driver.

3. Enter the payor name in the FSPayor column without the prefix used in the ACCT.FSPayor column.
For example, if ACCT.FSPayor = R_IPMedicare, then column Q in the driver will read Medicare.
Then enter the percentage shifts for the budget year in the Inpatient, Outpatient, and Other
Patient columns.
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Budget Statistics drivers
The following table includes a description of each type of Budget Statistics driver:

Driver Description

Budget Statistics Use to ensure that your historical data for budget is the same as the data
in the database.

Budget StatAcct Use to set up with the Revenue_Stat (on Stat_Rev) and Variable_Stat (on
Expense) calc methods.

Budget Statistics
Supplement

Use to create custom statistics to pull into the Budget Statistics Driver.

Budget Statistics

� Overview
The Budget Statistics driver ensures that your historical data for budget is the same as the data in the
database. It is referenced by the Statistics, GlobalRev, GlobalExp and Depreciation worksheets for LYA,
CYB and CYA_YTD information. Also, the Rolling12 spreads on the Statistics worksheet are pulled from
the StatData tab.
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If you are using staggered start periods for your budget groups, the GlobalStatUpdate report has logic
that will pull the appropriate values to correspond to the correct period.

NOTE: Click Refresh Data to refresh your statistics with the latest information available.

� Settings
Open driver. For each entity, this driver contains the following information:

l BudgetGroup – Enter or modify this value.
l Stat Name – Enter or modify this value.
l DEPT – Enter or modify this value.
l ACCT – Enter or modify this value.
l Spread Tag (Facility Statistics only) – Select the default calc method to use for the budget group.

The Global Statistics sheet contains the following additional columns:

l FY 20XX Actual – Actual, year before last.
l FY 20XX Actual – Actual, last year.
l FY 20XX Budget – This year's budget.
l FY 20XX Dec YTD Actual – This year's December YTD actual.
l FY 20XX Jan-Jun Projected – This year's January - June, projected.
l FY 20XX Projected – This year, projected.
l Actual Percentage of Total – Percentage change from previous year.
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l Change – Percentage change.
l Budget Percent of Total - Budget percent of total.
l FY 20XX Budget – Next year's budget total.
l Bud-Proj Amt – Variance amount, budget vs. projection.
l Variance % – Variance percentage.

The Service Line information at the bottom of the worksheet is pulled from the Budget Service Line
Supplement driver. Before you make any changes to these line items, make sure to select Previous Input
from the Spread Tag column. This will ensure your edits are retrieved from the Statistics driver table
versus using the default calculations.

Budget StatAcct

� Overview
Use this driver for set up with the Revenue_Stat (on Stat_Rev) and Variable_Stat (on Expense) calc
methods.

� Settings
Open the driver, and enter the department and account combination on the left, then the driven by
department and account on the right. These calc methods will then pick up the set up to be used for the
calculation in budgets.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 222



Budget Statistics Supplement

� Overview
The Budget Statistics Supplement driver allows you to create custom statistics to pull into the Budget
Statistics Driver.

Setting up andmanaging health plan budgeting
With the Health Plan product for Axiom Budgeting, your organization can budget health plan and
insurance costs by calculating revenues and expenses based on Membership Per Member Per Month
(PMPM) calculations. You can then use this information to determine the profitability of each health plan
and/or insurance product.

Complete the following steps to configure and budget health plans and insurance products in your
organization:

NOTE: As you add or retire plans each year, you will need to complete these steps.

1. Update the LOCATION, INSCODE, and DATATYPE dimension tables.

2. Configure user access and the data filter in theHealthPlan column of the Budget Security Update
utility.

3. Add or edit plans and the corresponding actual account data into the ACT_HP_20XX table.

4. Configure theMembership Enrollment Trend driver.

5. Configure theMembership Per Member Per Month (PMPM) driver.

6. Open the HealthPlan Operations utility.

Updating dimensions for health plan budgeting
To implement health plan budgeting in your organization, start by making the following changes to the
following dimensions:

� LOCATION
The LOCATION dimension contains all of the physical locations that have been billed within the
organization and is used for monthly reporting and provider-level budgeting. This information is also
used for the Axiom Budgeting Health Plan product.

The following table lists all of the options available in this dimension table:
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Column Description

LOCATION The LOCATION used in Axiom Budgeting. This must be an alpha code (i.e.
WestClinic). Default should be used as the Location code if this dimension
is not being used.

Description Identifies the LOCATION description to be used for budgeting and
reporting.

KHABgtCode Used for combining accounts together during budget plan file creation. If
there are historical values for two accounts that you want to budget as
one combined account, list the surviving account number on both lines. If
not combining accounts, this value should match value in the LOCATION
column. The default value is NA.

KHAInt Currently no needed for health plan budgeting so the default is NA.

� INSCODE
The INSCODE dimension stores information for the insurance/health product plans offered by your
organization. This information is used to manage and configure the plans included in related driver tables
and in the Health Plan Operations utility. Similar to other dimension tables like ACCT, there are column
structures to control what insurance plans will be allowed to interface to the HealthPlan tab and at what
level of rollup, if any.

IMPORTANT: Use caution when using multi-layer mapping of the plan codes.

The following table lists all of the options available in this dimension table:

Column Description

INSCODE The short name or code your organization uses to represent the
insurance/health plan product.

Description The long description of the insurance/health plan.

InsCode.BgtCode The code used to group the insurance/health plan products together. For
example, grouping all commercial or FFS plans.
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Column Description

KHAInt Specify whether to include the insurance product in the list of available
plans in the Health Plan Operations utility. Enter one of the following:

NOTE: The system will allow you to enter any text into this field, however,
it only recognizes HealthPlan as the way to add the plan to the interface

l HealthPlan - Enter this option to include the product in the list of
available plans.

l NA - Enter this option to remove the product from the list of available
plans.
NOTE: The system will retain historical information for plans removed
from the list.

� DATATYPE
The DATATYPE dimension for health plan budgeting purposes is used to load configurable categories for
revenues and expenses. Use the Axiom provided default for members. Data imported or entered into the
data tables will need to include a valid data type from this table.

NOTE: Version 1 DATATYPE dimension permits DATATYPE.DataType='HP_Members' and
DATATYPE.BudgetType IN ('HP_Expense','HP_Revenue') - supplied by default data (i.e. one HP_
Members DataType and multiple versions of Revenue and Expense).

The following table lists all of the options available in this dimension table:

Column Description

DATATYPE The DATATYPE used in Axiom Budgeting and Performance Reporting. This
must be an alpha code.

l HP_Members - This is a required default for members data.
l HP_Revenue - This is a recommended default for revenue, but you may

use other codes. For example, other types of revenuemay be desired
to load and recognized as a separate revenue line item. (i.e. HP_
Revenue1, HP_Revenue2).

l HP_Revenue - This is a recommended default for revenue, but you may
use other codes. For example, other types of revenuemay be desired
to load and recognized as a separate revenue line item. (i.e. HP_
Revenue1, HP_Revenue2).

Description Identifies the description to be use for budgeting and reporting.
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Column Description

BudgetType Used in related driver tables and in the Health Plan Operations utility. Valid
codes will typically be what was used in the Datatype column, however
these can be used as a mapping code similar to how KHABgtCode is used in
other dimensions. For example, if there are codes used in DataType for
Revenue1, Revenue2, and so on but the desired configuration is to map
Revenue2 to Revenue1, this column would be used for themapping.

l HP_Members - This is a required default for members data.
l HP_Revenue - This is a recommended default for revenue, but you may

use other codes. For example, other types of revenuemay be desired
to load and recognized as a separate revenue line item. (i.e. HP_
Revenue1, HP_Revenue2).

l HP_DrugME - This is a recommended default for Drug Medical Expense,
but you may use other codes.

l HP_HospME - This is a recommended default for Hospital Medical
Expense, but you may use other codes.

l HP_OutPTME - This is a recommended default for OutPatient Medical
Expense, but you may use other codes.

KHAInt Used to identify which Datatype categories to use in the related driver
tables and in the Health Plan Operations utility. Valid entries include the
following:

l HealthPlan - Use this code to include the data type.
l NA - Use this code to exclude the data type.

NOTE: You may have data you want to record in the actual tables but
not necessarily include them for planning purposes.

Managing the ACT_HP_20XX data table

� Overview
The ACT_HP_20XX table stores the actual data used by the HealthPlan Operations utility to budget for
your organization's health and insurance plans across entities and departments. This information is used
primarily by theMembership Per Member Per Month (PMPM) driver to calculate actual and budget
amounts by period by the number ofmembers in a particular period. The table includes the following
information for each plan (INSCODE column):

l Department (DEPT)
l Location (LOCATION)
l Data type (DATATYPE) (includes membership numbers and revenue/expense streams)
l Values for periods 1-12 (P1-P12)
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NOTE: The following columns are reserved for future use at this time: GROUP, ACCT, NYBKHA,
SaveCustom, and SaveTagDocID

You can enter the data in this table manually or as part of an import. Your Kaufman Hall Implementation
Consultant will help you set up the table for your organization. There is no pre-defined import available
to import health plan data at this time, but you can work with your Kaufman Hall Implementation
Consultant to create a custom import.

IMPORTANT: Your organization cannot enter any health plan data containing patient identifying
information into the system. Please do not send any transmission of data in any form to Kaufman
Hall related to this feature containing any patient identifying information.

NOTE: The Health Plan product relies on data identified in this table for refresh variables and blocks
of data. Without the data, refresh variable picklist(s) will display blank. You will need to maintain this
table as plans, revenue streams, and expense streams are added or changed. If you need to remove
a plan, do not delete it from this table. For instructions, see Removing or retiring plans.

� About this table
Note the following before configuring this table:

l This table is only accessible if your organization is licensed for the Axiom Budgeting Health Plan
product. Only users assigned the Budget Administrator role profile can access this table.

l Before configuring this table, you will need to do the following:
o  Add or edit insurance or health plan products in the INSCODE dimension.
o Add or edit the health plan budget data types in the DATATYPE dimension.
o Add or edit department locations in the LOCATION dimension.

For instructions, see Updating dimensions for health plan budgeting.
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� Adding or editing plans
To add or edit a plan:

1. In the Admin ribbon tab, click System Browser.

2. In the Libraries section, click Table Library > Management Reporting > Actuals > Health Plan.

3. Double-click the file for the planning year. For example, if you are planning for 2021, double-click
ACT_HP_2021.

4. Add or edit the following columns for each plan:

Column Description

INSCODE Double-click to select the plan name.

DEPT Double-click to select the department.

LOCATION Double-click to select the department location.

DATATYPE Double-click to select the data type.

GROUP Reserved for future use.

ACCT Reserved for future use.

P1-P12 Enter the actual or budgeted amount for the period.
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Column Description

NYBKHA Reserved for future use.

SaveCustom Reserved for future use.

SaveTagDocID Reserved for future use.

5. After making your changes, in the Admin ribbon tab, click Save.

Removing or retiring plans
As new plans are added for your employees or for your service area, you may need to retire old plans
from the system. We do not recommend deleting plans from the ACT_HP_20XX data table. Instead,
open the INSCODE dimension table, and in the KHAInt column, typeNA. After you save the dimension,
the system will remove the plan from the Health Plan drivers as well as the budget plan files while still
retaining the plan history.

Setting variance thresholds
The threshold level determines howmuch an account can vary from budget before department
managers are required to enter comments explaining the variance.

To configure the threshold level, navigate to one of the following:
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l In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities > System
Setup, and double-click VCC_Threshold.

l In theMgmt Admin task pane, in theDimension & Reference Maintenance section, click System
Setup, and double-click VCC_Threshold.

NOTE: In the ACCT dimension table, you need to create or include Variance Comments accounts for
the Summary selection where ACCT.Type=’Comments’.

� General settings

In the top section of the sheet, you may select the following options:

1. To only view thresholds for particular departments, type criteria in the Custom Filter for Alert
Processing cell (e.g., "(Dept.Manager='Chris Sparks' or Dept=101010)").

IMPORTANT: Do not remove the "Acct.Statement <>'NI'" criteria, otherwise new, approved
initiatives will be included.

IMPORTANT: Custom filters will not be applied to the optional Variance Comments Collection
tab in theMonth End Reporting dashboard.

2. In the Comparison Time Series cell, select one of the following options in which to base the
variance in the reports:

l For regular current year budget variances, select CYB.
l For flexible budget variances, select FLX.
l For three-month average variances, select 3MthAvg.
l For prior month variances, select LastMth.
l For the samemonth last year variances, select SameMthLY.

3. In the Revenue & Usage Comparison field, do one of the following:

l To enable drilling in the statistic section down to CDMCode, select Budget.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 230



l If unsure which option to select, select Budget.

4. In the Flag Max Positive Variance as Required cell, do one of the following:
l To be alerted to variances in a favorable direction as well as variances in an unfavorable

direction, select Yes.
l To not be alerted to variances, select No.

5. If your organization uses H_JCHours for Paid Hours, do the following:
l In theUse H_JCHours for Paid Hours filter (Default is H_Hours) cell, select Yes.
l If you are not sure, select No.

6. In the Activate Variance Comments Collection tab on Month End Review Dashboard drop-
down, select one of the following options:

l To create a Variance Comment Collections in theMonth End Review dashboard where you
will manage variance comments, select Yes.

l To manage variance comments in the Excel Client, especially if you already have customized
filters, select No.

� Comment level settings
In the Summary portion of the General Threshold Levels section of the page, you may decide whether to
collect comments at a summary level or account detail level.

IMPORTANT: Valid account codes are needed if reporting at the Summary level.

This setting is reflected in the Comment Input reports. If you select Summary, a single comment input
field displays at the summary level. If you select Detail, individual comment input fields display for each
account.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 231



If using the summary level, you need to create a dummy account to accept comment input. You need to
add the dummy accounts to the ACCT dimension table, and then indicated in the Summary Account
column on the ThresholdLevel sheet.

IMPORTANT: Do not assign any new account to an existing FSSummary category, otherwise the next
month that account will show up in detail. Use Summary instead.

You can define exceptions for summary level (and all other Threshold settings by Entity) in the sections
further down the worksheet.
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� Flag alert settings
For each account, you may define ranges at which various flags are set:

For each summary and/or detail account, you may set thresholds that will trigger flags with different
color coding in the variance reports.

Color Description

Green Displays on the report if the variance is below the value in the Min Yellow
column.

Yellow Displays on the report if the variance exceed the Min Yellow amount but remains
below the Red Threshold.
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Color Description

Red Displays on the report if the variance is greater thanMax Red but comments are
not required.

Red w/Yellow Box Displays in the yellow cell if variance is greater thanMax Red and comments are
required.

Building and processing budget plan files
A budget contains budget plan files for each department, organized into file groups, which typically each
contain a single year's budget.

IMPORTANT: Before you build and process plan files, you must first load and reconcile data. For
more information, see Preparing data for budget go-live

To initially create plan files for a new year, you will need to:

1. Build plan files - Creates the budget plan file.

2. Process plan files – Populates the budget plan file with data from the Axiom database that you
preloaded.

Budget file groups contain plan files with budget data for each department in the organization. However,
you do not copy individual plan files when cloning a file group. Instead, you use the Build & Process
Budget Files job in the Axiom Scheduler to generate a new set of plan files for the new budget year.

Budget plan files are generated from templates. Which templates are used for a particular department
and how those templates are configured is based on settings in our Budget Configuration and
Assumptions driver files.

NOTE: The Build & Process Budget Files job creates and saves the plan files per the configuration
settings in the dimension tables and the file group's driver files—it does not populate the files with
data. Populating the plan files with data is an additional step that wewill discuss later.

Within the job, creating and processing are broken out to two different tasks to allow each to be run
independent of each other.

� Building budget plan files
To build budget plan files:

1. In the Bud Admin task pane, in the Prepare Budget Plan Files section, double-click Build &
Process Budget Plan Files.
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2. In the box on the left side of the Scheduler dialog, click Create Plan Files.

3. Click the folder icon.
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4. In the Choose File Group dialog, select the file group, and click OK.
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5. To create specific plan files, you can apply filters, as needed. For example, to only run for a
selected Entity or Dept. To apply filters, in the Task Details section, click the Plan Files tab. Select
theUse filter radio button to access filtering options.

6. After you select the options you want, in the Job ribbon, click Run Once.

7. After creating the plan files, you need to process them. For more information, see Process plan
files.

� Refreshing data
Most of the data in Axiom Software is stored in a database. Plan files are typically generated as needed
by populating a template file with the relevant data from the database. The template used for a
particular plan file often depends on the configuration settings selected in the driver file for that file
group. Most plan files automatically refresh/recalculate data on open. If you need to update an open
workbook to reflect changes to the database or driver files, however, you can use the Refresh feature.

In plan files, this feature is only available to product administrators and to users with the Run AQs in Plan
Files security permission. This control prevents users from inadvertently overwriting plan data when the
template is not designed to accommodate data updates.

An Axiom query is a method of querying data from the database and updating a specific range in a sheet
with the data. If an Axiom query is configured to refresh when the file is opened, however, that refresh
occurs for all users, regardless of their security settings. Therefore, you may see data updates in the file
when it is first opened, regardless of whether the Refresh feature is available to use.
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For administrators, typically the only time you may refresh individual plan files is during plan file testing.
To test changes made to a template, you build a plan file from the template, and then refresh the plan
file to bring in data. After testing has been completed and the final plan files are built out, use the Process
Plan Files utility to refresh plan files in a batch process rather than refreshing individual files.

After the plan files have been rolled out to end users, you only refresh the plan files if the templates are
designed to accommodate ongoing data updates. For example, when performing rolling forecasting,
your templates are designed to accommodate bringing in a new period of actuals data each month or
each quarter. On the other hand, if you are performing traditional annual budgeting, then your
templates are designed so that actual data is brought in once at the start of the process. After that initial
baseline is set, typically no further data updates are brought into the plan files.

To refresh a plan file:
l On theMain tab, in the File Options group, click Refresh.

NOTE: You may be prompted to define values before the refresh occurs. If so, these values are
applied to the plan file to impact the data refresh.

� Viewing budget plan file templates
Templates define the default file structure for budget plan files. Each template contains one or more
sheets that are copied into a budget plan file at the time it is initially created. Individual cells in templates
may contain formulas (tags) that define how data flows from the database into the corresponding
budget plan file cells and/or how data input or modified in the plan should be written back to the
database.

In all Axiom Software products, templates are generally standardized for each application and not
editable by users. However, you may still view the contents of templates to help trace formulas back to
the source data and understand how data in plan files flows to and from the central database.

Which templates (or sheets within templates) are used to create a particular plan file depends on settings
within the related driver files and dimension table(s). You may or may not be able to configure these
associations, depending on the application and particular category of plan file.

NOTE: After plan files have been created from templates, subsequent changes to the template do
not impact the plan files unless the plan files are re-created.
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To view templates:
1. In the Explorer task pane, in the File Groups section, click the file group for the templates to view.

2. Click Templates.

3. Double-click the template to view.

� Processing budget plan files
To process budget plan files:

1. In the Bud Admin task pane, in the Prepare Budget Plan Files section, double-click Build &
Process Budget Plan Files.

2. In the box on the left side of the Axiom Scheduler dialog, click Process Plan Files.
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3. To process specific plan files, you can apply filters, as needed. For example, to only run for a
selected Entity or Dept. To apply filters, in the Task Details section, click the Plan Files tab. Select
theUse filter radio button to access filtering options.

4. To process the plan files, in the Job ribbon, click Run Once.
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Building plan files using a Scheduler job
Use a filter in Scheduler to run the Build & Process Budget Files job. To confirm that no errors occurred,
review the log for errors after the scheduled job completes.

To build plan files using a Scheduler job:
1. From the Admin ribbon tab, click Scheduler.

2. In the Job ribbon tab, click Open.

3. Double-click the Budgeting folder.

4. Double-click Build & Process Budget Files.

NOTE: By default, the job is already set up to run, but you can complete steps 5-9 if you want
to filter the plan files to build and process. Otherwise, skip to step 10.

5. In the left-hand navigation, click Tasks > Create Plan Files (if it's not already selected).
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6. In theGeneral tab, click the folder icon.

7. Select the file group in which to select the plan file to create.
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8. Click the Plan Files tab, and click Use filter.

9. From the list, select the plan files to create by clicking the check box next to the left of theDEPT
column.

10. In the Job tab, click Run Once.
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Configure budget security
This section provides the security settings for the Kaufman Hall Axiom Product roles - per the design of
the Axiom Budgeting product. It is intended not only to provide additional education towards security
settings but to also serve as an audit tool to validate your current Axiom EPM roles.

For more details regarding general set up and maintenance of Axiom security, see Security Overview.

For more details regarding general set up and maintenance of Axiom Security, see "About security" in the
Axiom Budgeting online help.

� Design
Security is pre-configured according to each product. Each product provides five primary roles: System
Admin, Product Admin, Local Admin, Product Analyst, and Product User. Each role includes pre-
configured security to access specific locations, files, and features. You apply data filters to control each
user’s reach into the data.

There are two main elements to setting up security in Axiom products:

l Role - Allows access to features and files, but not data. Roles define what a user can do, which are
defined and explained in the Roles section.

l Filter - Allows access to data and plan files with standard filters built into each role. The filters are
directly referenced from the dimension tables, which provides the ability to maintain data access
through the dimensions for additional disseminated control. These are explained in the Filters
section.

� Filters
The Product User, Analyst, and Local Admin roles come pre-configured with a flexible, dynamic filter. Each
member requires a unique filter. For example, the ICUmanager needs a unique filter to restrict access to
only ICU information, as true with every member of the suite. We accomplish this by using a variable to
drive each user’s data filter from a reference table you would commonly maintain. Themost common
table is the DEPT dimension. This table is shared by many planning process and data tables, and provides
an excellent means to protect your data. Other products may have an alternative key table that drives
security filters. Wewill use the DEPT dimension in our examples.

Each product includes nine columns in the DEPT dimension, which you assign to user’s login IDs based
on who is the owner of that role for each department listed. Those security columns with login IDs are
referenced by the corresponding role as for unique data and plan file filters. In the following table,
CSparks is assigned a Budget User role. The role gives him access to specific features, functions, and
tools. The role also includes a dynamic data filter for all budget data tables of “If BPOwner or BPReviewer
or BPApprover = login name”. So, when CSparks logs in, his role filter will apply his login name to his
budget role filter, resulting in if BPOwner or BPReviewer or BPApprover = CSparks. This gives him access
to the budget planning data tables for ICU and ER.
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Managing member’s data and plan file filters aremanaged by assigning each members login ID to the
respective departments in the DEPT dimension without the need to access security. This allows you to
minimize number ofmembers with security access since Local Admin members can manage security
filters through dimension ownership assignments.

� Adding additional users
If you need additional users than the fields provide, you may create and use pseudo roles as an
assignment vs. a single login name. Every member of that role will inherit permissions to that
department. For example, let's say you have six local admins that need rights to all departments and
only there are only three slots available in the dimensions. You would do the following:

1. Open Security Manager.

2. Create a new role.

3. Assign the six members to the new role.

4. Open the Dimension Maintenance Utility.

5. In the DEPT dimension, assign the role name to each of the departments in the BPAdmin column,
and save the changes.

1. Open Security Manager.

2. Create a new role.

3. Assign the six members to the new role.

4. Open the Dimension Maintenance Utility.

5. In the DEPT dimension, assign the role name to each of the departments in the BPAdmin column,
and save the changes.

For instructions related to managing security and managing dimensions, see the following topics in the
online help:

TIP: To find the exact topic listed below, type the name of the topic with quotations.

l "The Security Management dialog"
l "Managing roles"
l "Managing users and roles"
l "Launching the Dimension Maintenance Utility"
l "Editing a dimension"

All of themembers with that role will now have proper permissions.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 245



If you need to assign broader filters, such as “Region=’IOWA’, you can apply a custom filter directly to
the user. A user-level filter and a role filter combine as an OR statement “User Filter OR Role Filter”. The
user filter is applied in multiple locations.

� Security basics
Security is configured by four sections.

Type Description

Product permissions General administrative functions. Many of these permissions span all
products. You can grant many of the permissions in the other sections.
This permission level is suite-wide.

Product file groups Determines access to what file groups, plan file filters, access, and abilities.

Data table types Determines access to data tables. Tables are categorized by type. For
example, the Financial type contains all the GL financial tables.

Files Determines access to select Axiom EPM files.

� Tools

Name Description

Security Manager Allows you to maintain the complete security options for all users and
roles. We recommend this tool for adjusting security at the individual
level.

Security Spreadsheet Provides a spreadsheet view of file group and table options for all users
and roles.

IMPORTANT: Use caution when using this tool. If two or more security
members save this file with overlapping filters at the same time, the
system will overwrite one over the other.

Product Security
Setup Utilities

Allow you to bulk assign roles and data filters. Each product has a
configured set in the Product Utilities > Security Setup folder. You must be
a member of Security Admin to post changes. We recommended using this
tool for initial product and role assignment.

Dimension Security
Utility

Allow you to assign permissions for Admin members to maintain
dimensions. You must be a member of Security Admin to post changes.

Product Driver
Security Utility

Allows you to assign permissions for Admin or Analyst members to
maintain dimensions. You must be a member of Security Admin to post
changes.

Active Directory
Import

Using the Active Directory Import, you can map directory groups to EPM
roles to automate enabling newmembers.
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� Roles
Each EPM license/product comes with the following role types:

� Budget planning provider roles
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� Product permissions
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� Product file groups
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� Data table types

Administrator's Guide Axiom Budgeting and Performance Reporting │ 250



� Files

� Specialty roles

Running processmanagement

� Running the Budget Approval Process
To use the Budget Approval Process:

1. In the Explorer task pane, in the File Groups section, click Budget-20XX > Process Definitions.

2. Double-click Budget Approval Process.

3. To view the steps in the process, click the Process Steps tab.
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The steps for running the Budget Planning Process include:

Step Name Description

1 Budget
Configuration

Notifies the Budgeting Admin to configure the new year's budgeting file
group.

2 Driver
Configuration
Updates

Notifies the Budgeting Admin to make any necessary updates to the
Driver files.

3 Volume
Assumptions

Notifies the Budgeting Admin to adjust volume assumptions for the
new year.
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Step Name Description

4 Budget Approval
Stages

This subprocess containing multiple steps:

l Base Budget Build – Prompts the Budgeting Admin to build plan files
for the file group.

l Budget Owner Input – Prompts department managers to edit their
respective budget plan files.

l Budget Review – Submits plan files to their designated reviewers for
approval.

l Executive Approval – Submits approved plan files to their
designated executive for approval.

l Finance Team Approval – Submits approved plan files to their
designated financial department contact for approval.

� Copying the Recalculate Budget Files job
In Axiom Budgeting, you can copy the Recalculate Budget Files job to recalculate the budget files for one
or more specified entities.

To copy the Recalculate Budget Files job:
1. In the ExplorerExplorer task pane, in the Libraries section, click Scheduler Jobs Library >

Budgeting, and double-click Recalculate Budget Files.

2. In Tasks list in the left window pane, click Process Plan Files.

3. Right-click any of the tabs, and click Save As.
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4. Name and save the new scheduler job file.

5. Click the Plan Files tab.

6. At the Specify plan files to process option, select Use filter.

7. Create a filter to specify an entity by entering the filter syntax in the Plan File Filter box or click the
Filter Wizard button.

8. Click the Axiom Queries tab.

9. In the Refresh On Open column heading, click the gray drop-down, and in the Value field, type
True. This filters the list for all the AQs that should contain the check mark.
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10. Click any blank check boxes, and then click Save.

Releasing budget plan files
After you start building plan files, they become available to your end users - unless you restrict them - so
you want to make sure you are ready before releasing them to your end users.

Ensure that Security and Process Management is set up and ready to go.

Under certain circumstances, you may want to wait to make them available for a few days. For example,
waiting until after the weekend or a major holiday.

TIP: We recommend that you review reconciliation reports on a daily basis until the budget is
complete. This allows you to find and troubleshoot any issues quickly because you are starting each
day with "clean" data. If you wait too long to reconcile your budget, it can take longer to find where
the problems are located and resolve them. It also puts your organization or department in a
constant state of readiness so that you can report information at a moment's notice
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Managing Setup Table Data
The following setup tables are used to enter your organization's information into the system. These
tables include the following:

Table Description

FP Payor Add and manage the payors in the system

Payroll_Dates Manage your organization's pay period dates

VCC_Payroll_Mapping Identify JobCode/PayType combinations for each salary GL
Account number

VCC_Threshold Configure howmuch an account can vary from budget
before department managers are required to enter
comments explaining the variance

YearPeriod Configure the following:

l Fiscal year and the first month of the fiscal year
l Number of work days in the current year, last year, and

next year
l The standard Full Time Equivalent (FTE) hours worked

by employees in a year

Managing payors
The FP Payor table allows you to add and manage the payors in the system.

To manage payors:
1. In theMgmt Admin task pane, in theData Maintenance section, double-click FP Payor.

5
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2. In theDescription column, type the full name used for the payor. For example, Blue Cross/Blue
Shield.

3. In the Payor column, type the payor code to use in the system. For example, BCBS.

IMPORTANT: By default, Payor1will always beMedicare. This means that if you currently use
Payor1 for another payor, it will revert to Medicare when you open and save this utility.

If you have a large number of payors that you can copy from an Excel spreadsheet, you can use
the Edit in Spreadsheet link in the upper left corner of the page to open a spreadsheet version of
the table to edit.
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4. After you finish making your changes, in the upper right corner of the page, click Save.

Setting payroll dates
Use this table to manage your organization's pay period dates. This table is used in many of the
productivity and pay period reports.

IMPORTANT: If your organization uses more than two cycles, it will not display in this table.

To set payroll dates:
1. In theMgmt Admin task pane, in theData Maintenance section, double-click Update Payroll

Dates Table.
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2. For Cycle 1 and Cycle 2, from the Select the initial period pay date drop-down, select the date for
Pay Period 1.

TIP: You can hide or show Cycle 1 and 2 using the toggle under the Save button.

3. From the Select the number of days the Pay Date is after the Pay Period End Date drop-down,
select the number of days.

4. After you make changes, click Save in the upper right corner of the page.

Setting VCC Payroll mapping
Variance Comments and other payroll utilities use specific rules to map GL accounts to job codes and pay
types.
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Use the VCC Payroll Mapping table to identify JobCode/PayType combinations for each salary GL
account number.

Any unmapped accounts display in theUnmapped Accounts section under theMapped Accounts
section. Click the Unmapped Accounts header to expand or contract the list. When you map any
unmapped accounts, the system automatically moves it to the list ofmapped accounts.

To map VCC Payroll:
1. In theMgmt Admin task pane, in theData Maintenance section, and double-click Update

VCC Payroll Mapping Table.

2. In the VCC Payroll Mapping utility, find the Salary GL Account to map to, and from theGLAcct
Dimension column drop-down, select JobCode or PayType for each salary account. To disable
drilling, select NA.
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TIP: Previously mapped accounts display at the top of the list.

3. To remove any mapped accounts, click the check box in Delete column (the first column indicated
with a trash can icon). When you click Save, the account is removed.

4. After you finish making changes, click Save in the upper right corner of the page.

The filter column computes the required filter based on the GLAcct mapping in the GLAcct grouping
column in the respective JobCode or PayType dimension.

Setting variance thresholds
The threshold level determines howmuch an account can vary from budget before department
managers are required to enter comments explaining the variance.

To configure the threshold level, navigate to one of the following:

l In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities > System
Setup, and double-click VCC_Threshold.

l In theMgmt Admin task pane, in theDimension & Reference Maintenance section, click System
Setup, and double-click VCC_Threshold.

NOTE: In the ACCT dimension table, you need to create or include Variance Comments accounts for
the Summary selection where ACCT.Type=’Comments’.
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� General settings

In the top section of the sheet, you may select the following options:

1. To only view thresholds for particular departments, type criteria in the Custom Filter for Alert
Processing cell (e.g., "(Dept.Manager='Chris Sparks' or Dept=101010)").

IMPORTANT: Do not remove the "Acct.Statement <>'NI'" criteria, otherwise new, approved
initiatives will be included.

IMPORTANT: Custom filters will not be applied to the optional Variance Comments Collection
tab in theMonth End Reporting dashboard.

2. In the Comparison Time Series cell, select one of the following options in which to base the
variance in the reports:

l For regular current year budget variances, select CYB.
l For flexible budget variances, select FLX.
l For three-month average variances, select 3MthAvg.
l For prior month variances, select LastMth.
l For the samemonth last year variances, select SameMthLY.

3. In the Revenue & Usage Comparison field, do one of the following:

l To enable drilling in the statistic section down to CDMCode, select Budget.
l If unsure which option to select, select Budget.

4. In the Flag Max Positive Variance as Required cell, do one of the following:
l To be alerted to variances in a favorable direction as well as variances in an unfavorable

direction, select Yes.
l To not be alerted to variances, select No.

5. If your organization uses H_JCHours for Paid Hours, do the following:
l In theUse H_JCHours for Paid Hours filter (Default is H_Hours) cell, select Yes.
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l If you are not sure, select No.

6. In the Activate Variance Comments Collection tab on Month End Review Dashboard drop-
down, select one of the following options:

l To create a Variance Comment Collections in theMonth End Review dashboard where you
will manage variance comments, select Yes.

l To manage variance comments in the Excel Client, especially if you already have customized
filters, select No.

� Comment level settings
In the Summary portion of the General Threshold Levels section of the page, you may decide whether to
collect comments at a summary level or account detail level.

IMPORTANT: Valid account codes are needed if reporting at the Summary level.

This setting is reflected in the Comment Input reports. If you select Summary, a single comment input
field displays at the summary level. If you select Detail, individual comment input fields display for each
account.
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If using the summary level, you need to create a dummy account to accept comment input. You need to
add the dummy accounts to the ACCT dimension table, and then indicated in the Summary Account
column on the ThresholdLevel sheet.

IMPORTANT: Do not assign any new account to an existing FSSummary category, otherwise the next
month that account will show up in detail. Use Summary instead.

You can define exceptions for summary level (and all other Threshold settings by Entity) in the sections
further down the worksheet.

� Flag alert settings
For each account, you may define ranges at which various flags are set:
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For each summary and/or detail account, you may set thresholds that will trigger flags with different
color coding in the variance reports.

Color Description

Green Displays on the report if the variance is below the value in the Min Yellow
column.

Yellow Displays on the report if the variance exceed the Min Yellow amount but remains
below the Red Threshold.

Red Displays on the report if the variance is greater thanMax Red but comments are
not required.

Red w/Yellow Box Displays in the yellow cell if variance is greater thanMax Red and comments are
required.

Setting year and period
Use this table to configure the following for your organization:

l Set the fiscal year and the first month of the fiscal year
l Define the number of work days in the current year, last year, and next year
l Select the standard Full Time Equivalent (FTE) hours worked by employees in a year.

NOTE: The standard FTE hours you select in this worksheet displays as the default FTE Hours in the
Budget Labor Configuration
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The FTE Hours you select are reflected on the following tabs in the plan file:

l Expense
l Jobcode
l Staffing
l Employee
l ProviderComp
l altEmployee
l HHLabor

To set year and period:
1. In theMgmt Admin task pane, in theData Maintenance section, double-click Update Year and

Period Tables.

2. In the Primary Inputs section, complete the following options:
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Option Description

Fiscal Year Select the fiscal year.

Fiscal Start Month Select themonth in which the fiscal year starts.

FTE Hours Select one of the following:

l To use the standard of the number of days worked multiplied by a
40-hour work week divided by 7, select 2086.

l To use the standard 40 hour work-week multiplied by 52weeks,
select 2080.

3. In theWorking Days Inputs area, enter the number of working days for the current year, last
year, and next year for each fiscal month.

TIP: To hide the year and/or period tables, click the corresponding check boxes under the
Working Days Inputs section.

4. After making your changes, click Save.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 267



Working with Budget Plan Files
All of the files, utilities, process definitions, and other materials for a budget year are all grouped together
into a single file group. The file group includes all of the budget plan files for each department. Budget
plan files are the primary means by which users pull data from and write data back to the central
database. Your organization creates a budget plan file for each department that needs a budget.

A budget plan file includes the following sheets:

l Instructions – Provides a guide to completing budget plan files, plus support contact information.

6
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l Budget - Includes all of the sheets associated with entering and reviewing the budget values.
o Summary - Provides a high-level summary of the department budget, based on

information from the plan file.
o Statistics and Revenue -Most of the sheet is pre-populated, but may require your input for

projections for next year's budget.
o Labor - Provides several different sheets for tracking payroll, depending on themethod

used by your organization and/or department.
o Expense - Summary and Detail of non-payroll expenses. Most of the sheet is pre-populated,

but may require your input for projections and next year budget.

l Provider or ProviderComp – Overview of encounters, procedures, gross charges, and RVUs for
each provider.

NOTE: Available only to organizations with the Provider module license.

l New Initiatives – Allows users to enter values into both approved and excluded (unapproved)
initiatives. Only approved initiatives are included in plan file totals. Totals incorporating excluded
initiatives are tracked in a separate column on the Summary sheet.

l Operating Plan – Questionnaire covering strategic budget concerns. A useful tool to help keep
real-world priorities in mind while you are working on budgets.

l Department History – Used to calculatemonthly spreads on the Expense tab. Contains a history of
budget updates going back 18months.

The budget plan file also allows you to include supporting files that you can attach to the budget.

Creating or modifying a budget plan file

Using budget plan files
Each budget plan file contains multiple sheets. Within a sheet, you can view data and/or input or modify
the values in blue or green cells.

� Opening budget plan files
Your access rights to each budget plan file (read-only or read/write) within a file group are determined by
a combination of your security settings and workflow or process settings, if applicable.

The Open Plan Files dialog lists all budget plan files available to you based on your role profile and
security settings. Use the filter box at the top of the dialog to quickly find a plan file based on the plan
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code or description. You can also sort and filter the list to narrow down the list. If you have previously
opened a budget plan file within this session, the system highlights that plan file by default when you
open the dialog.

Depending on your Axiom role profile, you can open budgets from either the Budgeting or Bud Admin
task panes.

� From the Budgeting task pane
1. From theMain ribbon tab, click Open App Menus, and select Budgeting.
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2. In the Budgets section, double-click Open Next Year Budgets orOpen Current Year Budgets.

3. In theOpen Plan Files dialog, select the budget plan file or files to open, and click OK.

4. If you have read/write permissions to a file but you want to open it as read-only to prevent locking
the file from other users, right-click your selection, and select Open Read Only.

� From the Bud Admin task pane
1. From the Adminribbon tab, click Admin Task Panes, and select Budget Admin.
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2. In the Budget Files Administrationsection, double-click Open Next Year Budgets orOpen
Current Year Budgets.

3. In theOpen Plan Files dialog, select the budget plan file or files to open, and click OK.

4. If you have read/write permissions to a file but you want to open it as read-only to prevent locking
the file from other users, right-click your selection, and select Open Read Only.

The selected budget plan files open. If a file was opened read-only, then the text (R/O) displays in the file
tab. You cannot save read-only budget plan files.

If the dialog is empty, then either you do not have access to any budget plan files in the file group or the
budget plan files have not yet been created for the plan codes that you have rights to.
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If another user has the budget plan file open with read/write permissions, then the file is opened as read-
only—regardless of your security permissions.

� Navigating budget plan files
When you first open a budget plan file, the system displays two main areas: the Navigation panel and the
sheet display area. By default, the Summary sheet and its associated budget sheets display when the
plan file is first opened.

The Navigation panel is the primary way in which to open the different sheets that make up the budget
plan file. To open a specific sheet, double-click the tab name.

NOTE: If your organization is licensed to use the Provider module, the Navigation panel will include
links to those sheets as well.

Each sheet you open displays as a separate tab in the plan file. The exception to this are the budget tabs,
which are grouped and open together as a unit to help facilitate the process of adding and entering
values. To move from one tab to another, you can use the Navigation panel or click the tab at the top of
the display area.

In the grouped budget sheets, you can also click the tab names at the bottom of the display area.
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You can easily move around to different sections within sheets by using theGoTo function onMain
ribbon tab. This opens a drop-down menu that lists links to specific sections of the budget. This is
typically a faster and more convenient way of reaching the section you need when working with tabs that
contain a large amount of data.

The system allows you to open multiple budget plan files simultaneously so that you can work on them
from one screen. To do this, click the Budgeting or Bud Admin tab, and open another budget plan file.
The system assigns color codes the tabs specific to each plan file. In the following example, the blue tabs
belong to the plan files for department 19100 and the orange tabs belong to the budget for department
27200.
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To close a sheet, click the X next to the tab name. If you have unsaved data, the system will prompt you
to save before closing.

NOTE: If there is only one sheet open for the plan file and you close it, the entire plan file will close.

� Changing sheet views
On theMain ribbon tab, click the Change View drop-down to select how to display data on certain
budget tabs.

For example, the Statistics and Revenue tab drop-down menus allows you to choose whether a section
of a sheet displays data for annual, monthly, and projection intervals.

� Understanding cell formatting and input types
The cells in the budget plan file are color coded as follows:

Administrator's Guide Axiom Budgeting and Performance Reporting │ 275



l White cells: Displays information only. The values are either hard-coded, pre-populated from the
database, or calculated from other fields, and cannot be changed.

l Blue cells: These fields can be edited. Blue-shaded cells might be empty or pre-populated with a
value or formula that you can change.

l Green cells:. From these cells, you can select from one of several predefined options.

While different budget plan files call for different types of user input, some common cases where the user
is called upon to enter values include:

l Adjustments – Some calculations depend on historical account balances and can only be affected
by changing the budgeted increase over the previous year.

l Spreads – Some calculations automatically spread the budget value over the year, others allow
direct entry to adjust themonthly spread.

l Monthly input – There are sections on some tabs that allow you to enter values, while others
have formulas which pre-populate values directly into each of the twelvemonths.

l Variance comments / Red flags – For certain values, the Budget Administrator may set variance
thresholds which, if exceeded, cause a red flag icon ( ) to display. The system may display a
warning message if you attempt to save the budget. When this happens, enter a comment in the
Comment field explaining the reason(s) for the variance. Entering a comment allows you to save
the budget normally.

� Understanding source data
Themajority of a budget is pre-populated with data. Sources for this data include:

l Dimension tables –When you open a plan file, Axiom Budgeting and Performance Reporting
typically runs a query against one or more dimension tables and returns data for the specified
department, account, and so on.

l Data tables – These tables contain data associated with one or more dimensions. Budgeting-
related examples include Financial and Payroll data tables.

l Driver files – Some cells in plan files contain formulas that reference assumptions (key statistics)
contained in the plan file's driver files.

l File group variables – Axiom Budgeting and Performance Reporting can associate certain
variables with a file group. The variable most often used in Axiom Budgeting and Performance
Reporting 2020.3 is the file group year, which is set by Kaufman Hall when initially creating the file
group.

l Other cells / other sheets – Some values are calculated based on the contents of other cells or
sheets within the plan file.

� Understanding calculation methods
Calculation methods (calc methods) are pre-formatted groups of rows with pre-defined cell contents that
can be inserted into plan files or reports. For instance, a budget plan file might use calc methods to insert
multi-line records for each account associated with a given department.
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The cells in a calc method may include formulas. These formulas might incorporate variables that
reference the year of an associated file group or an assumption or configuration setting in a driver file.
Some calc methods also incorporate user-defined variables.

Reading instructions

� Overview
The Instructions sheet provides information related to the following areas:

l Timeline and Deadlines for Submitting Budgets - Dates and other deadline information for
submitting your budget.

l Your Contact for Budgeting Questions Is - The name and contact information for the person in
your organization to contact if you have questions about managing the budget plan file.

l Budget Assumptions - Overall, high-level assumptions that may be important when creating your
budget.

l Instructions for Budgeting - Instructions related to navigating and entering information in the
budget.

NOTE: The information on this tab, including the section names, are determined and set up by your
organization. If you have Administrator privileges, you can add or edit the contents of this tab in the
Budget Assumptions driverBudget Assumptions driver.
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Reviewing budget summary

� Overview
The Summary sheet provides an overview of the entire budget. Beforemaking revisions, review the
Summary tab to get a sense of where the budget currently stands. After completing revisions, return to
the Summary sheet to see how the figures have changed. This sheet is also useful when submitting a
budget plan file for leadership review.

This sheet includes data from two sources:

l Base Budget – Summary of inputs on Stat_Rev and Expense tabs based on KHASum (set in column
U in the ACCT dimension table).

l New Initiatives – Incremental volumes, revenue, FTEs, and expenses for approved new initiatives.
It does not include data from unapproved initiatives.

This tab includes the following sections:

The Financial Summary section displays totals from the other tabs, along with the contribution margin.
The Analysis sections consist of Statistical Analysis and Hours Analysis, and features calculated metrics to
help gauge the reasonableness of a submitted budget.
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Statistics and Revenue sheet

� Overview
Use this sheet to review and adjust current year projection amounts and next year’s budget for
statistics, revenues, and deductions. The sheet is segmented into two main areas: statistics and revenue.

NOTE: Provide comments in any red comment cells.

� Statistics section
The following table describes the sections in this sheet:
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Section Description

Global Drivers Summarizes the Budget Assumptions used to drive initial projections
for the department.

Key Department Statistics Includes department-specific statistics that drive the variable gross
revenue, variable costs, and variable labor calculations in the
workbook. Global drivers are used to apply the overall organization
growth assumptions to the department statistic.

You can make adjustments in theMar-Jun change for CY as well as %
Adjust and Amt Adjust columns for NY Budget. Key statistics, such as
patient days by Nursing unit, are defined in the Budget Statistics
driverBudget Statistics driver.

NOTE: If a statistic Dept/Acct combination is listed in the Budget
Assumptions driverBudget Assumptions driver, no adjustments may
bemade in the budget plan file.

Other Non-Key Statistic Displays other statistics captured for the department, but do not
drive any other calculations in the workbook.

� Revenue section
The following table describes the sections in this sheet:
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Section Description

Patient Revenue Summarizes all revenue. Displays projections based on historical
revenue per unit plus price increase (revenue adjustments) times
volume.

Patient Revenue Detail Displays detailed patient revenue, both inpatient and outpatient, by
specific account.

Other Revenue Models the projection and budget for other operating revenue
accounts, typically using a Fixed Revenue calc method, which uses
the projected value as the starting point for budget. You can make
adjustments in theMar-Jun change, % Adjust, and Amt Adjust
columns.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 282



� Inserting a new statistic or revenue line item
You can add statistic or revenue line items to individual sections, including:

l Key and non-key statistics
l Deductions
l Net and other revenue
l Inpatient, outpatient, and other patient revenue

The system adds the line by inserting the appropriate calc method into the sheet. The following table lists
the available calc methods used by the corresponding section in the sheet:

Calc Method Description Sheet Section

Add NewDetail Zero-based expense calculations when
adding a new account. Inputs are done on
the Detail tab in the budget plan file.

l Other Patient
Revenue

l Other Revenue

Add New Fixed Revenue Use this new revenue calc method to add a
new Fixed Revenue account.

l Inpatient Revenue
l Outpatient Revenue
l Other Patient

Revenue
l Other Revenue

Add New Input Monthly Use this new revenue or statistic calc
method to add a new account.

l Deductions from
Revenue

l Inpatient Revenue
l Outpatient Revenue
l Other Patient

Revenue
l Other Revenue

Add New Statistic Use this new statistic calc method to add a
new key statistic account.

Key Department
Statistics

Add New Statistic_Oth Use this new statistic calc method to add a
newOther Statistic account.

Other Non-Key Statistics

GlobalSum This SPM allows you to budget for an
account at a percentage of the total of
specific other account(s) within the same
workbook.

Net Revenue
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Calc Method Description Sheet Section

ProviderRev Transfers Revenue calculations from the
Provider Summary/Provider Detail tab to
the Stat_Rev tab to save to the Financial
Data tables.

NOTE: Only available to organizations with
the Provider module license.

l Inpatient Revenue
l Outpatient Revenue
l Other Patient

Revenue

ProviderStat Transfers Statistic calculations from the
Provider Summary/Provider Detail tab to
the Stat_Rev tab to save to the Financial
Data tables.

l Key Department
Statistics

l Other Non-Key
Statistics

To insert a new statistic or revenue line item:
1. Navigate to the section to add the new line item.

2. Double-click theDouble Click to Insert... cell.

3. In the Insert Calc Method(s) in sheet Stat_Rev dialog, select the calc method to insert, and click
OK.

NOTE: If the line only uses or your organization is only licensed for one type of calc method,
this dialog will not display. The system will open the Calc Methods Variable dialog instead.

4. In the Calc Methods Variable dialog, enter or select the account and department number, and
click OK.

5. Enter the appropriate values in the blue cells, as needed.

6. After making your changes, in theMain ribbon tab, click Save.

Reviewing employee master

� Overview
Use the Employee Listing sheet as reference to calculate when salary adjustments occur throughout the
planning cycle. This sheet lists all employees by job code and includes details regarding each employee's
current and next year's rate as well as their merit and market increasemonth and percentage.
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To make the budget plan file as accurate as it can be when calculating salaries, the system takes into
account any potential current year rate increases set to take place - depending on when the budget plan
file is built. For example, let's say the following budget plan file is built in month 8. All the radiology
technicians except Michael and Jeff have likely received their rate increases already because 0% displays
in the CY Inc % column and their anniversary dates have already passed. However, Michael is set to
receive his increase in month 9 and Jeff in month 10. The system anticipates this increase by showing
that their beginning rate as 3% higher than their current rate and uses this rate for the budget.

The system does the same for scheduled budget market and merit increases as well. In this example,
everyone will receive a 3%merit increase but no market increases. The system allows you to include up
to two market increases, which simply provides a way to apply additional percentages beyond themerit
increase. For example, a contract may stipulate that nurses receive two market increases per year.

The system then layers together all of the rate adjustments as well as themerit and market increases to
provide you with values related to the amount that salaries will increasemonth-over-month over the
year. In the following example, July starts with an increase of 0.70% but begins to increasemonth to
month as more employees receive their salary adjustments. These values are used in the Jobcode tab to
calculate salaries.
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The last month of the fiscal year becomes the "fully burdened" month because by this point all of the
increases have occurred. The effective rate for the fiscal year is located in the Total FTEs column. Knowing
the effective rate helps you determine the effect of adding merit or market adjustments. In the example
below, the user now knows that adding a 3%merit increase will result in a 1.67 effective rate.

The remaining section of the sheet is devoted to the scheduled hours for scheduled FTE employees. The
system projects scheduled hours based on when the employee was hired and whether they are working
full or part time.

Keep in mind the following when using this sheet:

l Employees are only listed in their home department. The Jobcode sheet may showmore
employees than what are listed for the job code in the Employee Listing sheet. This means that
employees have been borrowed from other departments.

l The Employee Listing sheet only displays current active employees.
l To add an employee, you must do so through the labor method itself. For example, if you use the

employee budgeting methodology, you must add a new employee in the Employee sheet.
l Merit and market increase factors are defined in the LaborRates sheet of the Budget Labor

Assumptions driverBudget Labor Assumptions driver.
l This sheet incorporates max rate logic to calculate the lump sum payout if an employee is

currently above their max limit or defined increases will put them above the limit.
l Max limits are defined in the Budget Labor Limits driverBudget Labor Limits driver.

Use this sheet to calculate PTO accrual hours if activated in the Budget Configuration driverBudget
Configuration driver.
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Labor sheets

� Overview
Different departments may use different methodologies to track their labor expenses (FTEs and salary
dollars). To facilitate this, the budget plan file template includes several different labor sheets for tracking
payroll. When a department's budget plan file is first created, the system copies the payroll sheet
specified for that department in the LaborType field of the DEPT dimension table.

There are four Labor sheets used to cover thesemethodologies:

l JobCode – Use for departments needing the ability to adjust FTEs on a monthly basis or based on
volume.

l Employee – Use to allow departments to budget at the employee level. No volume adjustments
are included in the salary calculations.

l Staffing – Use for 24/7 departments to prepare the budget by shift/day of the week.
l ADC Configuration – Use for nursing departments to prepare the budget Average Daily Census

(ADC) and Nursing Staffing grid levels by job class.

NOTE: This tab only works with the JobCode tab.

JobCode sheet

� Overview
The JobCode sheet is used for departments that need to adjust FTEs on a monthly basis or based on
volume.
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This sheet is comprised of threemain areas:

Summary and Target
This area displays at the top of the sheet and provides an overview of the productive hours, target hours
per unit, FTEs from target, paid hours per unit, and the productive percentage. This area automatically
updates as detail is added to each job code block. Targets are defined by department on the Budget
Labor Benchmark driverBudget Labor Benchmark driver.

The Summary and Target area provides a quick and easy way to ensure that your numbers are on track
without having to dive into the details.

Jobcode Statistics
This section displays all of the statistic values related to the job codes in the department, including the
following:

l Departmental totals
l Total program additions
l Total position changes
l Total productive FTEs
l Total non-productive FTEs
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Jobcode
Most of the sheet is comprised of the individual job code values. By default, the sheet displays only a
summary view of the job code that includes the total productive, non-productive FTEs as well as the total
FTEs for the job code.

To view the job code details, double-click theDouble click to show details cell. From this expanded
section, you can view specific details about the job code.
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� Sheet columns
The following table provides descriptions for the columns in this sheet:

Column Name Column
Letter

Description

Job Code A The job code identification number (using
Jobcode.KHABgtCode).

Current Rate G The hourly rate as of the start of the budget process.

Start Rate H The hourly rate as of the start of the new budget year.
This includes any salary increases expected to occur in
the remainder of the current year.

End Rate I The hourly rate as of the end of the budget process. This
includes all salary increases through the end of the
budget year. This is calculated using the last month of the
budget as this would contain the effective rate of all merit
& market adjustments.

Alloc Rate J Calculated based upon YTD actual % of total FTE. You can
make adjustments to allocate NYB FTEs for salary
calculations.

Sched K Scheduled FTEs from the labor master file or CYB FTEs
depending on the configuration option chosen in the
Budget Configuration Assumptions driver file.

YTD Actual L Year-to-date FTEs from the Payroll26 database.

Month-Month Projected
(FTEs)

M Projected FTEs for the remaining months of the current
fiscal year. Initial FTE allocation is the same as YTD.
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Column Name Column
Letter

Description

FY20XX Budget (FTEs) N Starting point matches projected FTEs. You can make
monthly adjustments to theMonth FTEs columns
(columns S-AD).

Month-Month Projected
(Dollars)

O Projected dollars for the remaining months of the current
fiscal year.

FY20XX Budget (Dollars) P Projected dollars for the budget year.

Notes Q Enter comments for the line item, as needed.

Spread Method R Select a spread method for the pay type, as needed.

Month FTEs S-AD Enter a percentage of each FTE factor to the total factor.
For example, let's say that the FTE factor for month one is
177 divided by the FTE factor for the year of 2080 or 2086.
It usually ranges around 8% or so per month.

NOTE: Not all pay types allow you to update the spread
amount.

Month-Year Hours AG-AS Hours spread across months, including total budgeted
hours.

Month-Year Dollars AT-BF Dollars spread across months, including total budgeted
dollars.

Month-Year FICA BH-BT FICA spread across months, including total budged FICA.

Projected FICA BW Total projected FICA amount.

Month-Month Hours BX Total budgeted hours for the remaining months of the
fiscal year.

The following sections include instructions on performing specific actions in this sheet.

� Updating the staffing ratio for a job code
Use these instructions if you want to change the default staffing ratio type.

To update staffing ratio type for a job code:
1. Navigate to the job code, and double-click Double click to show details.
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2. In the job code title row, from the drop-down, select one of the following:
l Variable - Input is the worked FTEs per a normal work week. Non-productive hours are

added to productive based upon allocation percentage. This setting is a default from the
JOBCODE dimension. When Variable, the values in the job code will fluctuate based on
changes in the departments volume.

l Fixed - Input is the total paid FTEs per a normal work week. Non-productive hours are
allocated based upon allocation percentage. This setting is a default from the JOBCODE
dimension. When FIXED, the values in the job code will not fluctuate based on changes in
the departments volume.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

TIP: You can also click the Save button in theMain ribbon tab.

� Updating start rate and projected FTEs for program additions and position changes
To update start rate and projected FTEs for program additions and position changes:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Program Additions field (column H), type the start rate amount.
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3. In the Position Changes field (column H), type the start rate amount.

4. In theMonth-Month Projected column (column M) for the program additions and position
changes line items, as needed.

5. In theNotes column (column Q), enter comments, as needed.

6. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the allocation rate for a job code pay type
To update the allocation rate for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Alloc Rate column (column J), enter a percentage for each line item, as needed.
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3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the spread method for a job code pay type
To update the spread method for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. From the Spread Method column (column R), select the spread method to use.
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3. In theMonth-Year FTEs columns (columns S-AD), make adjustments, as needed.

NOTE: The spread methods available are configured by your organization.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding contract labor
To add contract labor:

1. Navigate to the contract labor job code.

2. In the Current Rate column (column G), enter the hourly rate for the contract labor.

3. In the Start Rate column (column H), enter the starting rate.

4. In theMonth-Month Projected (FTEs) column (column M), enter the projected FTE value.

5. In theMonth-Year FTEs columns (columns S-AD), enter the FTE spread across months.

6. After making your changes, in the budget file Navigation panel, click Save Budget.
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� Adding a new pay type for a job code
To add a new pay type for a job code:

1. In the job code in which to add the new employee, double-click Double click to show details.

2. Double-click Double Click to Insert New Pay Type.

3. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

NOTE: The dialog includes fields that are not enabled at this time.

l Add New AvgPer Paid Hr PayType - Calculates other non-FTE related pay based on the
relationship to paid hours in the job code block. Monthly spread will be based on the
spread of paid hours.

l Add New AvgPer Prod Hr PayType - Calculates other non-FTE related pay based on the
relationship to productive hours in the job code block. Monthly spread will be based on the
spread of productive hours.

l Add New Input Monthly PayType - Calculates other non-FTE related pay by typing in the
monthly totals.

4. Do the following based on the calc method you selected in step 3:

Administrator's Guide Axiom Budgeting and Performance Reporting │ 296



Calc Method Steps

Add NewAvgPer
Paid Hr PayType

Add NewAvgPer
Prod Hr PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Start Rate column (column H), enter the hourly start
rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Add New Input
Monthly PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In themonthly budget (columns AT-BE), enter values for the
applicable months.

d. In theNotes column (column Q), enter comments, as needed.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

� Adding a new job code to a department

NOTE: If you accidentally add a duplicate job code, see the Removing duplicate job codes section
below for instructions on how to remove it.

To add a new job code to a department:
1. Navigate to the end of the job code listing, and double-click Double Click to Insert New Job Code.
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2. In the Calc Method Variables dialog, do the following, and then click OK:
a. In the Select a JobCode field, enter a job code or click Choose Value to select a job code.

b. In the Select a Dept field, enter a department or click Choose Value to select a department.

3. To enter adjustments to allocate NYB FTEs for salary calculations, click Double Click to Show
Details.

4. From the details section, do any of the following:
l Updating start rate and projected FTEs for program additions and position changes
l Updating the allocation rate for a job code pay type
l Updating the spread method for a job code pay type

5. When you finish making changes, in the budget file Navigation panel, click Save Budget.

� Removing duplicate job codes
If you add a duplicate job code and save the JobCode sheet, the system will display the duplicate in the
sheet. The duplicate does not save to the database, but to remove it from the sheet you will need to do
one of the following:

l Rebuild the plan file.
l Manually delete the job code from the sheet, and save your changes.

� Adding a new department pay type
To add a new department pay type:

1. Navigate to the bottom of the sheet, and double-click Double Click to Insert New Dept Pay Type.
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2. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

NOTE: The dialog includes fields that are not enabled at this time.

l Dept_AvgPerProdHr - Calculates other Non-FTE related pay based on the relationship to
productive hours in the department. Monthly spread will be based on the spread of
productive hours.

l Dept_InputMonthly - Calculates other Non-FTE related pay by inputting monthly amounts
for the department.

l Dept_InputTotal - Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month.

3. Do the following based on the calc method you selected in step 2:

Calc Method Steps

Dept_AvgPerProdHr a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Budget column (column H), enter the hourly start rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.
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Calc Method Steps

Dept_InputMonthly a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In theNotes column (column Q), enter comments, as needed.

d. In themonthly budget (columns AT-BE), enter values for the
applicable months.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Dept_InputTotal a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In the FY 20XX Budget (Dollars) column (column P), enter the
projected budgeted dollars.

d. In theNotes column (column Q), enter comments, as needed.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Employee sheet

� Overview
The Employee sheet is for departments to budget at the employee level, and operates similarly to the
JobCode sheet. No volume adjustments are included in the salary calculations. This sheet combines the
data from the Employee Listing and Employee sheets.
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This sheet is comprised of threemain areas:

Summary
This area displays at the top of the sheet and provides an overview of the FTE totals, target, and FTEs
from the budget target. It also shows you the paid hours and the productive percentage. This provides a
quick and easy way to ensure that your numbers are on track without having to dive into the details.
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Jobcode Statistics
This section displays all of the statistic values related to the job codes in the department, including the
following:

l Departmental paid totals
l Total float staff
l Total program additions
l Total position changes
l Total productive FTEs
l Total non-productive FTEs

Jobcode summary and details
Most of the sheet is comprised of the individual job code values. By default, the sheet displays only a
summary view that includes the total productive, non-productive FTEs as well as the total FTEs for the
job code.
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To view the job code details, double-click theDouble click to show details cell. From this expanded
section you can view specific details about the job code as well as a list of all the employees assigned the
job code.

Keep in mind the following:

l Non-FTE-related pay categories are added during the interface process within the job code block
and use a dollars-per-productive-hour or input monthly methodology.

l You can makemonthly adjustments to FTEs to model staging of staffing changes.
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l For contract labor, you must enter requests for contract labor FTEs. No default to YTD is made.

IMPORTANT: If you add a new calc method to a labor method sheet (such as adding new job code
pay type) and you do not include any calculated hours and dollars, then the calc method will not be
included the next time the budget plan file is rebuilt.

� Sheet columns
The following table provides descriptions for the columns in this sheet:

Column Name Column
Letter

Description

Job Code A The job code identification number number (using
Jobcode.KHABgtCode).

Employee ID F The identification number of the employee.

Current Rate G The hourly rate as of the start of the budget process.

Start Rate H The hourly rate as of the start of the new budget year.
This includes any salary increases expected to occur in
the remainder of the current year.

End Rate I The hourly rate as of the end of the budget process. This
includes all salary increases through the end of the
budget year. This is calculated using the last month of the
budget as this would contain the effective rate of all merit
& market adjustments.

Alloc Rate J Calculated based upon YTD actual % of total FTE. You can
make adjustments to allocate NYB FTEs for salary
calculations.

Sched K Scheduled FTEs from the labor master file or CYB FTEs
depending on the configuration option chosen in the
Budget Configuration Assumptions driver file.

YTD Actual L Year-to-date FTEs from the Payroll26 database.

Month-Month Projected
(FTEs)

M Projected FTEs for the remaining months of the current
fiscal year. Initial FTE allocation is the same as YTD.

FY20XX Budget (FTEs) N Starting point matches projected FTEs. You can make
monthly adjustments theMonth-Year FTEs columns
(columns S-AD).

Month-Month Projected
(Dollars)

O Projected dollars for the remaining months of the current
fiscal year.
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Column Name Column
Letter

Description

FY20XX Budget (Dollars) P Projected dollars for the budget year.

Notes Q Enter comments for the line item, as needed.

Spread Method R Select a spread method for the pay type, as needed.

Month-Year FTEs S-AD Enter a percentage of each FTE factor to the total factor.
For example, let's say that the FTE factor for month one is
177 divided by the FTE factor for the year of 2080 or 2086.
It usually ranges around 8% or so per month.

NOTE: Not all pay types allow you to update the spread
amount.

Month-Year Hours AG-AS Hours spread across months, including total budgeted
hours.

Month-Year Dollars AT-BF Dollars spread across months, including total budgeted
dollars.

Month-Year FICA BH-BT FICA spread across months, including total budged FICA.

Projected FICA BW Total projected FICA amount.

Month-Month Hours BX Total budgeted hours for the remaining months of the
fiscal year.

Month-Month Dollars BY Total budgeted dollars for the remaining months of the
fiscal year.

The following sections include instructions on performing specific actions in this sheet.

� Updating projected and budgeted FTE for an employee
To update projected and budgeted FTE for an employee:

1. Navigate to the job code assigned to the employee, and double-click Double click to show
details.
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2. In theMonth-Month Projected (column M) and FY 20XX Budget (column n) columns, update the
FTE values for the employee, as needed.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating projected FTEs for float staff/inactive employees, program additions, and
position changes
To update projected FTEs for float staff/inactive employees, program additions, and position
changes:

1. Navigate to the job code, and double-click Double click to show details.

2. In theMonth-Month Projected column (column M) for the Float Staff/Inactive Employees,
Program Additions, and Position Changes line items, as needed.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.
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� Updating the allocation rate for a job code pay type
To update the allocation rate for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Alloc Rate column (column J), enter a percentage for each line item, as needed.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the spread method for a job code pay type
To update the spread method for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. From the Spread Method column (column R), select the spread method to use.
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3. In theMonth-Year FTEs columns (columns S-AD), make adjustments, as needed.

NOTE: The spread methods available are configured by your organization.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding a new employee
To add a new employee:

1. Navigate to the job code to add the new employee, double-click Double click to show details.

2. Double-click Double Click to Insert New Employee.
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3. Enter information in the following columns, as needed:
l Employee Name (column E)
l Employee ID (column F)
l Current Rate (column G)
l Start Rate (column H)
l Month-Month Projected (FTE) (column M)
l Notes (column Q)
l Month-Month FTE columns (columns S-AD)

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding contract labor
To add contract labor:

1. Navigate to the contract labor job code.

2. In the Current Rate column (column G), enter the hourly rate for the contract labor.

3. In the Start Rate column (column H), enter the starting rate.

4. In theMonth-Month Projected (FTEs) column (column M), enter the projected FTE value.

5. In theMonth-Year FTEs columns (columns S-AD), enter the FTE spread across months.
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6. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding a new pay type for a job code
To add a new pay type for a job code:

1. In the job code in which to add the new employee, double-click Double click to show details.

2. Double-click Double Click to Insert New Pay Type.

3. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

l Add New AvgPer Paid Hr PayType - Calculates other non-FTE related pay based on the
relationship to paid hours in the job code block. Monthly spread will be based on the
spread of paid hours.

l Add New AvgPer Prod Hr PayType - Calculates other non-FTE related pay based on the
relationship to productive hours in the job code block. Monthly spread will be based on the
spread of productive hours.

l Add New Input Monthly PayType - Calculates other non-FTE related pay by typing in the
monthly totals.

4. Do the following based on the calc method you selected in step 3:
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Calc Method Steps

Add NewAvgPer
Paid Hr PayType

Add NewAvgPer
Prod Hr PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Start Rate column (column H), enter the hourly start
rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Add New Input
Monthly PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In theNotes column (column Q), enter comments, as needed.

d. In themonthly budget (columns AT-BE), enter values for the
applicable months.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

� Adding a new job code to a department
To add a new job code to a department:

1. Navigate to the end of the job code listing, and double-click Double Click to Insert New Job Code.

2. In the Calc Method Variables dialog, enter a job code or click Choose Value to select a job code,
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and then click OK.

3. To enter adjustments to allocate NYB FTEs for salary calculations, click Double Click to Show
Details.

4. From the details section, do any of the following:
l Add a new pay type for a job code
l Update the spread method for a job code pay type
l Update the allocation rate for a job code pay type
l Update projected FTEs for float staff/inactive employees, program additions, and position

change
l Add a new employee
l Update projected and budgeted FTE for an employee

5. When you finish making changes, in the budget file Navigation panel, click Save Budget.

� Adding a new department pay type
To add a new department pay type:

1. Navigate to the bottom of the sheet, and double-click Double Click to Insert New Dept Pay Type.

2. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:
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NOTE: The dialog includes fields that are not enabled at this time.

l Dept_AvgPerProdHr - Calculates other Non-FTE related pay based on the relationship to
productive hours in the department. Monthly spread will be based on the spread of
productive hours.

l Dept_InputMonthly - Calculates other Non-FTE related pay by inputting monthly amounts
for the department.

l Dept_InputTotal - Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month.

3. Do the following based on the calc method you selected in step 2:

Calc Method Steps

Dept_AvgPerProdHr a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Budget column (column H), enter the hourly start rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Dept_InputMonthly a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In theNotes column (column Q), enter comments, as needed.

d. In themonthly budget (columns AT-BE), enter values for the
applicable months.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.
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Calc Method Steps

Dept_InputTotal a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In the FY 20XX Budget (Dollars) column (column P), enter the
projected budgeted dollars.

d. In theNotes column (column Q), enter comments, as needed.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Staffing sheet

� Overview
This sheet allows 24/7 departments to prepare the budget by shift/day of the week, such as a nursing
department, cafeteria, lab, or security. This sheet is comprised of threemain areas:

Staffing Summary
This area displays at the top of the sheet and provides an overview of the total hours for productive and
target, the FTEs from target, the paid hours per unit, and the productive percentage. It also shows the
trending of FTEs over timewith LYA, YTD, and budgeted. This provides a quick and easy way to ensure
that your numbers are on track without having to dive into the details.
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Department Statistics
The first line item in the sheet displays the primary department statistics, which include LYA, YTD, and
budgeted hours as well as the total department hours and dollars over months.

Jobcode summary and details
Most of the sheet is comprised of the individual job code values. By default, the sheet displays only a
summary view that includes the shift FTE values, budgeted hours, pay type information, and the
breakdown of hours and dollars by month. To view the job code details, double-click theDouble click to
show details cell.

Instead of calculating values monthly, the Staffing sheet allows you to budget hours on a weekly basis
using the shift grid. This forms the core component of the calculations performed on this sheet. The
totals weekly hours are then translated into monthly values in terms of hours. As you move to the right,
you can view the spread of the hours and dollars.
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While the Employee and Jobcode labor methods allow you to change FTEs on a monthly basis, you do
not have this ability using the Staffing labor method, though a lot of the logic is still the same in that you
still use budget to YTD or a target.

� Sheet columns
The following table provides descriptions for the columns in this sheet:

Column Name Column
Letter

Description

LYA N Values from Last Year Actuals

YTD O Values for Year To Date

Month-Month P Values for themonths for Remaining Projection

NYB Q Values for the annual New Years Budget

Job Code AA The identification number associated with the job code
(using Jobcode.KHABgtCode)

Pay Type AB The pay type associated with the job code (using
Paytype.Staffing)

Pay Type Description AC A description of the pay type

Current Rate AD The current pay rate for the pay type

Begin Rate AE The beginning pay rate for the pay type

Year End Rate AF The pay rate for the pay type at the end of the year

Month-Year Hours AG-AR Total hours for each month of the year

Total Hours AS The sum of the total hours

Month-Year Dollars AT-BE Total dollars for each month of the year

Total Dollars BF The sum of the total dollars

� Updating the number of days to staff in a week
To update the number of days to staff in a week:

1. In theDays Staffed/Week field, type the number of days to staff in a week.

l Selecting 7will allocate FTEs in the grid to all seven days of the week.

l Selecting 5will allocate FTEs in the grid to only Mon-Fri columns.
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2. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the shift FTE hours for a job code
The shift grid provides a visual representation of a full 24-hour clock. You can enter all your FTEs in a
specific row or you can split them up by time of day. While most organizations simply enter all their
hours in the Day part of the grid, you may want to enter hours in another part of the day if there is a
premium pay rate for those FTEs in the budget.

To update the shift FTE values for a job code:
1. Navigate to the job code, and double-click Double click to show details.

2. In the job code title row, from the drop-down, select the shift to assign to the job code.

3. Next to the shift drop-down, from the Fixed/Variable drop-down, select one of the following:

NOTE: In most cases, you will not need to change this unless an exception needs to bemade
to this job code.
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l Fixed - The input is the Total Paid FTEs per a normal work week. Non-productive hours are
allocated based on the allocation percentage.

l Variable - The input is theWorked FTEs per a normal work week. Non-productive hours are
added based upon grossing up to total hours then subtracting productive hours.

l Fixed w/ Replacement - Similar to fixed, the input is the Total Paid FTEs per a normal work
week. Non-productive hours are added based upon grossing up to total hours then
subtracting productive hours.

4. In the shift grid, enter the FTE hours for each day of the work week.

5. After you make your changes, in the budget file Navigation panel, click Save Budget.

� Updating the allocation rate for a job code pay type
To update the allocation rate for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Allocation % column (column R), enter the allocation percentage for each pay type, as
needed.

3. After you finish making your changes, in the budget file Navigation panel, click Save Budget.
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� Updating the pay type values for a job code
To update the pay type values for a job code:

1. Navigate to the job code, and double-click Double click to show details.

2. In theMonth-Month column (column P) and NYB column (column Q), enter dollar amounts in the
blue fields for each applicable pay type.

3. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the monthly spread
To update the monthly spread:

1. Navigate to the job code, and double-click Double click to show details.

2. In theMonthly Spread column (column V), select one of the following:
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NOTE: The choices in the drop-down depend on the pay type.

l FTEAlloc - Percentage of each FTE factor to the total factor. For example, let's say that the
FTE factor for month one is 177 divided by the FTE factor for the year of 2080 or 2086. It
usually ranges around 8% or so per month.

l Global - Define your own percentage. For example, you may want to use this for a special
project where you know there will be a higher use of overtime over the next threemonths
for this project. You can use this option to reflect this in your budget.

l History - Percentage determined over a rolling 12months (i.e. Percentage ofmonth one to
total, month two to total, etc.)

l Prod Hours - Percentage based on productive hours per month to total.
l Paid Hours - Percentage based on the paid hours per month to total.
l Even - Spread evenly across each month.

3. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Adding contract labor
To add contract labor:

1. Navigate to the contract labor job code.

2. In theMonth-Month column (column O), type the total hours for themonths.

3. In theNYB column (column P), type the total hours for the next year's budget.

4. In theHrly Rate cells (column Y and Z), type the hourly rate for current year and for next year's
budget.

5. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Adding a new job code
To add a new job code:

1. Navigate to the bottom of the job code list, and double-click Double Click to Insert New Job
Code.
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2. In the Select Job Code field, type a job code or click Choose Value to select one, and click OK.

3. Do the following:
l Update the shift values
l Update the allocation rate
l Update the pay type values for non FTE, if needed
l Wage rate for Regular pay for the new job code can be pre-populated if the “Mid” wage rate

from the Labor Rates driver is filled out. Otherwise, a rate can bemanually entered in the
“Current Rate” column (note blue cell for Regular in the image below).

l You can also enter the starting month of the added FTE (if parital year) in the “Start” and
“End” section (note blue cells below for “Start” and “End”).

4. After you finish making changes, in the budget file Navigation panel, click Save Budget.

� Adding a new department pay type
To add a new department pay type:

1. Navigate to the bottom of the job code list, and double-click Double Click to Insert New Dept Pay
Type.

2. In the Insert Calc Method(s) in sheet Staffing dialog, click OK.

3. In the Select Pay Type field, type a pay type or click Choose Value to select one, and click OK.

4. In theMonth-Month Dollars column (column P), enter the dollars for the pay type.

5. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 321



Labor Standard by ADC Setup sheet

� Overview
This sheet is designed for nursing departments to prepare an Average Daily Census (ADC) budget and
staffing levels by job class. The ADC worksheet models nursing staffing ratios by ADC level by job class
level.

IMPORTANT: All positions have to be budgeted in this sheet if you are going to use this labor
method.

The sheet is comprised of threemain areas:

ADC Table
The ADC Table allows you to set the staffing ratio for a job class. You can configure up to 15 job classes.
The staffing ratio determines the number of staff needed per patient. For example, if the RN staffing ratio
is 5:1, then for census levels 1-5, one nurse would be required. At census levels 6-10, two nurses would be
required.

NOTE: The Fixed/Variable settings and the ratio values may be configured for the department using
the Budget Labor ADC Config driverBudget Labor ADC Config driver. The system applies the setup
from this driver to the ADC sheet (starting in column W) in the plan file. The ADC staffing grid builds
out based on the staffing ratios entered for each job class set up in the Budget Assumptions
driverBudget Assumptions driver.

Calculated Staffing Grid
The staffing grid is used to calculate job class specific budget FTEs. There is a section for each job class
that displays the results of these calculations (starting in column F). All calculations are then transferred
to the JobCode tab and allocated to each job code based on relative historical FTEs within each job class.
There is a row for non-productive time for each job class, which defaults to values based off of the history
for each job class, but you can change them, if desired. The productive and non-productive hours are
transferred to the JobCode sheet and distributed to each job code using the YTD historical distribution.
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Summary
The Summary section at the top of the ADC sheet that shows the following:

l The Patient Days for projection and for each budget month. Average Daily Cencus (ADC) values are
also presented.

l FTE information for the department by productive and non-productive.
l FTE differences between the JobCode tab and ADC tab for the department.
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NOTE: You can only use this feature with the JobCode tab. It is not configured to work with the
Staffing or Employee tabs. If the historical hours are zero for the defined JobClass, then JobClass will
not populate a section or the section title will remain unused.

The following sections include instructions on performing specific actions in this sheet.

� Setting the staffing ratio/paid FTEs for a job class
Setting the staffing ratio/paid FTEs for a job class:

1. Navigate to the ADC Table section of the sheet (starting at column W).

NOTE: If your organization has already added these values from the Budget Assumptions
driver, then you may not need to modify. Your system administrator will provide direction, as
needed.

2. In the Fixed/Variable row, select one of the following from the drop-downs:
l Fixed - The input is the Total Paid FTEs. Non-productive hours are allocated based on the

allocation percentage. This means that no matter howmany Average Daily Census days are
calculated in the Summary section, the number of employees will always remain fixed to
the number you enter in the Jobclass row (step 3 below).

l Variable - The input is the Staffing Ratio. Non-productive hours are added to productive
based upon the allocation percentage. This means that the number of people in this job
class will fluctuate based on the Average Daily Census days, so themore ADC days themore
employees are required.

l Fixed w/ Replacement - Similar to fixed, the input is the Total Paid FTEs. Non-productive
hours are added to the total based on the allocation percentage. The difference is that the
number of employees can be split across job codes in a job class.

3. In the Jobclass row, complete the following, depending on the staffing ratio type you selected in
step 2:

l Fixed - Type the true number of FTEs required. In the following example, four LPN FTEs are
required - regardless of patient census.
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l Variable - Type the number of patients the FTE can care for. In the following example, one
RN FTE can care for up to six patients. If more than one RN job code exists on the Jobcode
tab, the FTE value will be allocated to each occurrence of an RN job code

l Fixed w/ Replacement - Type the true number of FTEs required - regardless of patient
census. In the following example, only one clerical job class is required for each patient, but
those hours can be split among multiple job codes in the clerical job class.

4. To update the budgeted non-productive percentage for a job class, navigate to a job class, and in
the Budget Non Prod % row, enter the percentage value for each month, as needed.

NOTE: Using Jobcode ADC will require that you use the payroll utility that accrues biweekly to
monthly so that the historical productive and non productive hours can be used in the plan
file for JobcodeADC.

5. After making your changes, in the budget file Navigation panel, click Save Budget.
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6. Review the Jobclass data on the ADC grid. This will present several data points such as productive
and non productive FTE and hours that will be transferred to the Jobcode tab.

In the following example for the RN jobclass, 20.36 total budget FTEs were calculated from the ADC
staffing grid. The FTEs may vary month to month as shown below. Each month’s FTEs will be
transferred to the Jobcode tab.
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ProviderComp sheet
NOTE: This sheet displays only if your organization has purchased the Provider module.

The ProviderComp sheet displays the selected calc methods for provider compensation, which you can
change in the Budget Provider Assumptions driver (if you have Administrator role privileges).

NOTE: Provider Volume data carries over from the Provider Summary or Provider Detail sheet.

You can automatically change compensation models at a set point during the budget year. To
accomplish this, designate the Primary and Secondary Comp Models for each provider in the Budget
Provider Assumptions plan file, along with the Comp Model Changemonth. To keep the same Comp
Model throughout the year, select the same Comp Model for both the primary and secondary options.
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IMPORTANT: Any changes made to the provider's FTE value on this tab will affect the values for that
provider in the Provider Detail tab. For instructions, see Updating detail provider values from the
Stat_Rev tab.

Expense sheet

� Overview
The Expense sheet is where you review and adjust the current year projection and next year’s budget for
Expenses and Paid Hours. The Expense tab also captures data calculated on other budget tabs for paid
hours, salaries, and detail accounts.

The categories include:

l Salaries – All salary and contract labor accounts (Acct.BudgetType=’Salaries’). Most salary
calculations are done on the Labor tabs – JobCode, Staffing, or Employee. The Labor Calc Method
is used to summarize the salary dollars from the defined labor tab (JobCode, Staffing, Employee,
JobCode ADC).

l Benefits – All benefit accounts, if accounted for at the department level
(Acct.BudgetType=’Benefits’). FICA is calculated at the JobCode level on the Labor tabs.
If FICA is not budgeted at the department level, there is the option to use theMonthly FICA by
Dept report to summarize total FICA and add it to the Benefits department budget plan file.
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l Supplies – All medical and other supply expense accounts (Acct.BudgetType=’Supplies’). Usually
budgeted on a rate-per-unit basis using the Variable calc method.

l Other Expenses – All other expenses, excluding Bad Debt (Acct.BudgetType=’OtherExp’). Calc
methods are usually Fixed, Detail, Depreciation, or GlobalExpense.

l Paid Hours – All labor and contract labor hours accounts (Acct.BudgetType=’PaidHours’). Inputs
for hours are done on the Labor tabs – JobCode, Staffing or Employee. The Hours calc method is
used to summarize the paid hours.

NOTE: Be sure to provide comments in any comment field flagged red.

� Drilling to detail
You can drill from an account on the Expense tab (this tab only) to GL Transactions detail. To activate this
feature, open the Budget Configuration driverBudget Configuration driver. In the Expense Transaction
Drilling, On or Off row, select Yes or No to turn on the drill. This is not budget group-specific so the
election is for all plan files.

From the Expense tab, select the account desired, and drill on it from the year-to-date column. There are
three ways to drill on the account:
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l On theMain ribbon tab, select Drill > JE Detail.
l From value on the Expense tab, right-click the year-to-date value, and select Drill > JE Drill.
l Double-click the selected row.

To close the drill to detail report, double-click Return to Report or close the drill report tab.

� Adjusting supply percentage and amount for Next Year Budget
To adjust supply percentage and amount:

1. Navigate to the Supply section of the sheet.

2. In the supply line item, do any of the following to adjust for NYB:
l In the% Adjust column (column O), type the percentage amount.
l In the Amt Adjust column (column O), type the dollar amount.

3. After you finish making your changes, in theMain ribbon tab, click Save.

� Inserting a new expense line item
You can add new expense line items to individual sections, including:

l Salaries
l Benefits
l Supplies
l Other expenses
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l Paid hours

The system adds the line by inserting the appropriate calc method into the sheet. The following table lists
the available calc methods used by the corresponding section in the sheet:

Calc Method Description Sheet Section

Add Detail - Input
Monthly

Use this to insert a row to populate an
individual month.

Other Expenses

Add Detail - Input Total Use this to insert a row to enter an annual
amount, and then decide how to spread it.

Other Expenses

Add NewDetail Zero-based expense calculations. Inputs are
done on the Detail sheet in the budget plan
file.

l Benefits
l Supplies
l Other Expenses

Add NewHours Use this new labor calc method to add a new
hours account to the Expense sheet.

Paid Hours

Add New Input
Monthly

Month-by-month input. Use this calc method
only when adding a new account.

l Salaries
l Benefits
l Supplies
l Other Expenses
l Paid Hours

Add New Labor Use this new labor calc method to add a new
labor account to the Expense sheet.

Salaries

Add NewVariable Calculates based on the relationship to key
statistics. As there is no history when
inserting as new, use the Amt Adjust (column
P) to enter a value. If a projection value is
desired, enter a value in Manager Input
(Column J).

l Salaries
l Benefits
l Supplies
l Other Expenses
l Paid Hours

Fixed Use this fixed methodology and select how
you want to spread.

l Salaries
l Benefits
l Supplies
l Other Expenses
l Paid Hours

PctOfSalaries_FixedPct Calculates a designated fixed percent from
Budget Expense Adjustment Driver file,
Budget Expense Assumptions, based on the
relationship to salaries. Monthly spread will
be based on the spread of salaries.

Benefits
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Calc Method Description Sheet Section

RatePerFTE_Fixed Allows you to define the fixed dollar amount
per FTE in Budget Expense Adjustment Driver
file to apply globally to benefit accounts.

Benefits

To insert a new expense line item:
1. Navigate to the section to add the new line item.

2. Double-click theDouble Click to Insert... cell.

3. In the Insert Calc Method(s) in sheet Expense dialog, select the calc method to insert, and click
OK.

NOTE: If the line only uses or your organization is only licensed for one type of calc method,
this dialog will not display. The system will open the Calc Methods Variable dialog instead.

4. In the Calc Methods Variable dialog, enter or select the account and department number, and
click OK.

5. Enter the appropriate values in the blue cells, as needed.

6. After making your changes, in theMain ribbon tab, click Save.

Provider Detail and Provider Summary sheets
NOTE: This tab only displays if your organization purchased the Provider module license.

There are two sheets available that include provider level information: Provider Summary and Provider
Detail.

Provider statistics are computed using historical relationships. Provider volumes are computed using
today’s Encounters per Production Day and adjusted for next year’s Available Production Days.
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IMPORTANT: Because the tab is rebuildable, any changes made in the Provider data tables after the
plan file is built will be automatically updated in the plan file. These changes are commonly referred
to as prior period adjustments, which will be reflected in the YTD columns in the tab.

To view a list of Provider calc methods, click one of the following:

l Expense sheet calc methods
l Provider sheet calc methods
l Stat_Rev sheet calc methods

� Provider Summary sheets
This sheet provides a summary of the totals at the department and individual provider level.

� Provider Detail sheet
This sheet shows summary subtotal information for each provider, but you can also access the details for
each provider by using the Click-to-Expand feature.
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The Click-to-Expand feature expands the rows and inserts the calc method that includes the provider
detail information such as WRVUs, gross charges, RVUs, encounters, and so on. You can simply scan and
review the summary information for each provider without having to sort through multiple lines of
details to view the information you need, and if necessary, expand the details and manage only those
providers that need it.

TIP: When you save the file, the system will remember which providers you have expanded the detail
rows for that day. Let's say you expanded the detail rows for five providers and saved your changes,
when you open the file later, the detail lines will still display for those five providers. When the plan
file processes that evening, however, the system will collapse all of the detail rows so that the tab
opens faster.
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IMPORTANT: The Summary Department Totals section at the top of the tab will not update values
until you save changes to the workbook.

� Updating detail provider values from the Stat_Rev tab
Any changes made to the provider's FTE value on the ProviderComp sheet will affect the values for that
provider in the Provider Detail sheet. To see that result within your session, double-click theDouble click
to collapse/refresh Provider summaries cell to refresh the data; otherwise, the nightly recalculation
process will update it automatically.
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New Initiatives sheet

� Overview
This sheet allows you to budget for new projects that are outside of your organization or department's
normal operations. The budgets for each new initiative save to unique Initiative IDs so that you can
analyze the new initiative budget separately from the ongoing operating budget. For each project to
budget, use the Initiatives tab to enter the project's monthly budget values. There is also a comments
section.

To create an initiative, double-click Double Click to Insert New Initiative. The Insert Calc-Method(s) in
sheet Initiatives dialog displays.

You can create one of two types of initiatives: department or system.

� Adding a department initiative
A department initiative is a project that applies only to a single department.

To add a department initiative:
1. Double-click Add Department Initiative to create an outline for adding detailed information for

department-wide initiatives.
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2. In the Insert Description Here cell, enter information to describe your initiative.

3. At the top of the screen, from the drop-down, select one of the following:
l To include the initiative for the next year budget amounts in the database, select Approve.
l To exclude the initiative from the next year budget amounts in the database, select Exclude

4. Update the blue cells with the budget data for the initiative, as needed. You can also add rows for
new items related to the initiative by double-clicking the appropriate row.

5. After you finish making changes, in theMain ribbon tab, click Save.

� Adding a system initiative
A system initiative is a project that applies to multiple departments in your organization.

To add a system initiative:
1. Double-click Add Project Initiative for a single project.
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2. In the Calc Method Variables dialog, click Choose Value.

3. In the Choose Value dialog, select the project, and click OK.

4. In the Calc Method Variables dialog, click OK.

5. The project list is created by you. Each project is pre-defined to Approve or Exclude.
l Approve saves data related to an initiative to the Financial data source for each department

with a budget for the initiative. Approved initiatives would subsequently be included in any
Budget Income Statement reports.

l Exclude saves the data from New Initiatives to the NYBDetail data source. Excluded
initiatives will not be included in any Budget Income Statement reports, but separate New
Initiatives reports can be run to summarize the totals for each initiative.

6. In theMain ribbon tab, click Refresh Data to populate the initiative with data.

NOTE: This assumes that your Axiom Budgeting administrator has instituted the New
Initiatives utility.

7. Update the blue cells with the budget data for the initiative, as needed. You can also add rows for
new items related to the initiative by double-clicking the appropriate row.

8. After you finish making changes, in theMain ribbon tab, click Save.
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Operating Plan sheet

� Overview
This sheet helps you clarify strategic budget objectives beforemaking updates to a budget. It presents a
questionnaire that lists the department's objectives and describe how any changes to the budget will
support each objective. For example, you can use this for a SWAT analysis approach or whatever is most
meaningful to your organization. The purpose of the planning questions is to capture higher level, salient
points within the plan file to facilitate a discussion with the budget stakeholders such as department
directors or vice presidents. You can review the questions with others by opening the plan file directly or
running the Budget Plan Questions reportBudget Plan Questions report.

NOTE: The questions that display are determined and set up by your organization. If you have
Administrator privileges, you can add or edit them in the Budget Assumptions driverBudget
Assumptions driver, as needed.
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� Completing plan questions
To complete plan questions:

1. In this tab, do any of the following:
l Answer the questions by entering content in as many rows as needed.

NOTE: The content in the rows do not wrap, meaning that once you get to the end of
the row, you need to continue entering content in the next row.

l To add a line, double-click Double Click to Insert New Planning Lines.

2. After you finish making changes, in theMain ribbon tab, click Save.

Department History sheet

� Overview
This sheet is a report that allows you to reference the historical spending trends for up to the last 18
months. This report is useful to keep open as you work on your budget. The reports is segmented into
the following areas for statistics, revenue, expenses, and hours:

l Last Year Actual - Includes values posted for over the last year.
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l Current Year Actual - Includes values posted for YTD.
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l Department History used for Monthly Spreads - Includes a combination of YTD values plus the
actuals from the previous year to form a full 12months of data. In the following example, the
actuals are posted through February 2019. In theMonthly Spreads section, the actuals are copied
from July through February. But, for themissing months that have no actuals yet, the system
copies the data from Last Year Actual and enters them for themissing months. In this example,
theMarch through June actuals are copied from the samemonths in the Last Year Actual section.

TIP: Before you begin entering budget values, look for anomalies or holes in the Last Year
Actual and Current Year Actual values that do not make sense or cannot be explained -
especially if you intend to use this section. Make sure to resolve any data issues before you
start creating a new budget for the next budget year or select an alternate spread option.

The system uses this combination of actuals and historical values to determine how to spread
budgeted expenses across an account. So, if a department spends moremoney at the beginning
of a fiscal year and adds a $10,000 expense to the budget, the system will automatically apply
more of that expense to the beginning of the year than at the end.

TIP: The same historical information is also available in the Expense sheet at the expense line
level. For more information, see Viewing historical values for expenses.
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Viewing andmanaging file attachments for a plan file

� Overview
In a budget plan file, you can attach supporting files to help support your budgeting process. For
example, you may want to attach various supporting information about the spending requests or capital
projects, and have that information easily reviewable along with the plan file itself.

If you have read/write access to a plan file, then you can add and delete attachments as well as view
attachments. If you have read-only access to a plan file, then you can only view existing attachments.

� Managing file attachments
Using theManage Attachments dialog, you can add, delete, and view attachments for a plan file.

l Adding a file attachment: Click Upload Attachment, and then navigate to the file that you want
to add as an attachment. The file will be imported into the Axiom Budgeting and Performance
Reporting database and associated with the plan file.

l Deleting a file attachment: Select the file, and then click Delete. The file is deleted from the Axiom
Budgeting and Performance Reporting database and will no longer be available as an attachment.

l Renaming a file attachment: To rename a file attachment, right-click the attachment and then
click Rename. The name becomes editable and you can type your changes.

l Editing the attachment description: To define or edit the description for the file attachment,
select the file and then click Edit Description.

l Opening a file attachment: Select the file, and then click Open (or you can double-click the file).

If the attachment is an Excel-compatible file that opens within the Axiom Budgeting and Performance
Reporting session, it will open with read/write access. You can edit the file and save changes if desired.

If the attachment is a Word file or a PowerPoint file, then it opens in its native program with read/write
access if the corresponding Axiom Budgeting and Performance Reporting add-in is already installed (or if
it is successfully installed when the file is opened). You can edit the file and save changes by using the
add-in.

If theWord or PowerPoint add-in is not installed, or if the file is some other file type, then you cannot
edit and save the file directly. If you need to edit one of these files, you should save a copy of the file
locally and make your edits. You can then delete the existing file attachment in the Axiom Budgeting and
Performance Reporting database, and upload your edited copy.
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Saving budget plan files
Data resides in the budget plan file, which is not written back to the Axiom database until you save the
budget. When saving a budget, Axiom Budgeting and Performance Reporting verifies and validates the
spreadsheet, saves the file, and saves the information to the Axiom database.

Depending on how your system is configured, the system may require you to enter comments when a
line item exceeds a defined threshold in the Stat_Rev and Expense tabs before saving the plan file. A
message will display above the Comments column header, informing you of the number of variances to
address. A red flag icon displays in the Red Flag column. After you enter variance comments, you can
save the plan file.

The order of saving budget plan files is left to right. This means that if required variances are needed, the
notification on save displays first on the Stat_Rev tab. After all Stat_Rev required variances aremet, the
user saves again. If required variances also exist on the Expense tab, another save notification prompts
the user for comments on the Expense tab.

To save a budget plan file
In the Navigation panel, double-click Save Budget - Advance when complete.

NOTE: You can use the Save button in the ribbon tab, but when you close the budget plan file, the
system may prompt you to save again.

If your organization uses Axiom process management, then the system displays a message asking if you
want to advance the plan file for review and approval process.

Calc methods

� Employee sheet
For instructions on using this sheet, click here.
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Calc Method Type Description

JobCode Interface Sets up initial JobCode block on the Employee tab during the interface
process. Do no use when adding blocks to the JobCode tab.

AvgPerPaidHr Interface Calculates other Non-FTE related pay based on the relationship to
paid hours in the JobCode block. Monthly spread will be based on the
spread of paid hours.

AvgPerProdHr Interface Calculates other Non-FTE related pay based on the relationship to
productive hours in the JobCode block. Monthly spread will be based
on the spread of productive hours.

Dept_
AvgPerProdHr

Interface Calculates other Non-FTE related pay based on the relationship to
productive hours in the department. Monthly spread will be based on
the spread of productive hours. Only use this calc method to budget
labor dollars at a department level and not a JobCode level.

Dept_
InputMonthly

Interface Calculates other Non-FTE related pay by inputting monthly amounts
for the department. Only use this calc method to budget labor dollars
at a department level and not a JobCode level.

Dept_
InputTotal

Interface Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month. Only
use this calc method to budget labor dollars at a department level and
not a JobCode level.

Employee Interface Inserts a new employee into a JobCode block. You can input FTEs and
hourly rate. The default hourly rate comes from Mid Rate column in
the Budget Labor Limits driverr.

Holiday Interface Calculate salary dollars based on YTD holiday pay and spreads by the
listed holiday months in the Budget Labor Configuration driver.

Input_
Monthly

Interface Calculates other Non-FTE related pay by typing in themonthly totals.
Add New JobCode 22 Lines New Sets up a new JobCode block on the
Employee tab. This calc method allows you to enter FTEs and hourly
rate for each labor category.

Add New
AvgPer Paid
Hr PayType

New Calculates other Non-FTE related pay based on the relationship to
paid hours in the JobCode block. Monthly spread will be based on the
spread of paid hours. This calc method is only used when adding a
new pay type.

Add New
AvgPer Prod
Hr PayType

New Calculates other Non-FTE related pay based on the relationship to
productive hours in the JobCode block. Monthly spread will be based
on the spread of productive hours. This calc method is only used
when adding a new pay type.
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Calc Method Type Description

Add New
Input
Monthly
PayType

New Calculates other Non-FTE related pay by typing in themonthly totals.
This calc method is only used when adding a new paytype.

� Expense sheet
For instructions on using this sheet, click here.

Calc Method Type Description

Depreciation Interface Pushes depreciation calculations to the budget plan
file from List Driver file, Budget Expense
Assumptions. The end-user cannot change the totals
or the spread in the budget plan files. Only users
with administrative rights can update the
calculations.

Detail Interface Zero-based expense calculations. Inputs are done on
the Expense tab in the budget plan file.

FICA Interface Transfers FICA expense from the designated labor
tab (JobCode, Staffing, Employee, Provider) to the
Expense tab.

Fixed_Days Interface Allows changes to the projected year as well as
budget. This calc method uses calendar days as its
default spread option. Users choose themonthly
spread from the drop-down.

Fixed_Even Interface Allows changes to the projected year as well as
budget. This calc method uses an even monthly
spread as its default spread option. Users choose the
monthly spread from the drop-down.

Fixed_History Interface Allows changes to the projected year as well as
budget. This calc method uses history as its default
spread option. Users choose themonthly spread
from the drop-down.

Fixed_Stats Interface Interface Allows changes to the projected year as
well as budget. This calc method uses the key
statistic monthly spread as its default spread option.
Users choose themonthly spread from the drop-
down.
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Calc Method Type Description

Fixed_WorkDays Interface Allows changes to the projected year as well as
budget. This calc method uses worked days as its
default spread option. Users choose themonthly
spread from the drop-down.

GlobalAmt Interface Pushes expense calculations to the budget plan file
from List Driver file, Budget Expense Assumptions.
An end-user cannot change the totals or the spread
in the Budget Plan files. Only users with
administrative rights can update the calculations.

GlobalExpense Interface Pushes expense calculations to the budget plan file
from List Driver file, Budget Expense Assumptions.
An end-user cannot change the totals or the spread
in the Budget Plan files. Only users with
administrative rights can update the calculations.

Hours Interface Transfers hours from the designated labor tab
(JobCode, Staffing, Employee, Provider) to the
expense tab.

InputMonthly Interface Month-by-month input.

Labor Interface Transfers salary dollars from the designated labor
tab (JobCode, Staffing, Employee, Provider) to the
Expense tab.

NoBudget Interface Brings in historical values into the budget plan file,
but the budget for next year will be zero, and cannot
be changed.

GlobalData Interface This calc method allows the administrator to create
configurable budget relationships for calculating NYB
amounts for the Expense tab only. The GlobalData
calc method is similar to GlobalExpense but allows
you to use up to four configurable tabs in Global
Data Assumptions. Has to be setup in the Global
Data Assumptions Driver file.

PctofGrossRevenue Interface Uses the historical percentage of the account to
gross revenue from the Stat_Rev tab.

PctofSalaries_Rolling12 Interface Calculates based on the relationship to salaries using
Rolling12 instead of YTD. Monthly spread will be
based on the spread of salaries.
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Calc Method Type Description

PctofNetRevenue Interface Calculates based on the relationship to net revenue.
Monthly spread will be based on the spread of net
revenue.

GlobalSum Interface This calc method allows you to budget for an
account at a percentage of the total of specific other
account(s) on the Stat_Rev tab within the same plan
file.

PctofSalaries Interface Calculates based on the relationship to salaries.
Monthly spread will be based on the spread of
salaries.

PctofSalaries _FixedPct Interface Calculates a designated fixed percent from List Driver
file, Budget Expense Assumptions, based on the
relationship to salaries. Monthly spread will be
based on the spread of salaries.

RatePerFTE Interface Calculates based on the relationship to FTEs.
Monthly spread will be based on the spread of FTEs.

RatePerFTE_Fixed Interface Allows you to define the fixed dollar amount in List
Driver file, Budget Expense Assumptions.per FTE to
apply globally to benefit accounts.

Variable Interface Calculates based on the relationship to key statistics.
A dollars-per-key statistic rate is calculated based on
YTD history, and is used to calculate the projection
and budget.

Variable_Stat Interface Calculates based on the relationship to a user-
chosen statistic that is listed on the Stat_Rev tab. A
dollars-per-key statistic rate is calculated based on
YTD history, and is used to calculate the projection
and budget.

Add NewDetail New Zero-based expense calculations. Inputs are done on
the Detail sheet in the budget plan file.

Add New Fixed New Allows changes to the projected year as well as
budget. Monthly spread is chosen by the user from
a drop down box selection. Choose the spread
methodology from the drop-down. This Calc
Method is only used when adding a new account.

Add New Input Monthly New Month-by-month input. Use this calc method only
when adding a new account.
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Calc Method Type Description

Add NewVariable New Calculates based on the relationship to key statistics.
A dollars-per-key statistic rate is calculated based on
YTD history, and is used to calculate the projection
and budget. This calc method is only used when
adding a new account.

Add New Labor New Use this new labor calc method to add a new labor
account to the Expense sheet.

Add NewHours New Use this new labor calc method to add a new hours
account to the Expense sheet.

Provider Version Only
If your organization purchased the Provider module license, you have access to the following additional
calc methods:

Calc Method Type Description

ProviderComp Interface Transfers Salary calculations from the
ProviderComp sheet to the Expense sheet to save in
the Financial Data Tables.

ProviderLaborComp Interface Transfers Salary calculations from the
ProviderComp and designated labor sheet
(JobCode, Staffing, Employee) sheet to the Expense
sheet to save in the Financial Data Tables.

ProviderCompFICA Interface Transfers FICA calculations from the ProviderComp
sheet to the Expense sheet to save in the Financial
Data Tables.

ProviderLaborFICA Interface Transfers FICA calculations from the ProviderComp
and designated labor sheet (JobCode, Staffing,
Employee) sheet to the Expense sheet to save in the
Financial Data Tables.

ProviderCompHours Interface Transfers Hours calculations from the
ProviderComp sheet to the Expense sheet to save in
the Financial Data Tables.

ProviderLaborHours Interface Transfers Hours calculations from the
ProviderComp and designated labor sheet
(JobCode, Staffing, Employee) sheet to the Expense
sheet to save in the Financial Data Tables.
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Calc Method Type Description

ProviderCompOther Interface Transfers other labor calculations from the
ProviderComp sheet to the Expense sheet to be
saved in the Financial Data Tables.

Add New ProviderLaborComp New Use this new labor calc method to add a new labor
account to the Expense sheet for Providers.

Add New ProviderLaborHours New Use this new labor calc method when necessary to
add a new hours account to the Expense sheet for
Providers.

� JobCode sheet
For instructions on using this sheet, click here.

Calc Method Type Description

JobCode Interface Sets up initial JobCode block on the JobCode sheet during
the interface process. Do not use when adding blocks to
the JobCode tab.

AvgPerPaidHr Interface Calculates other Non-FTE related pay based on the
relationship to paid hours in the JobCode block. Monthly
spread will be based on the spread of paid hours.

AvgPerProdHr Interface Calculates other Non-FTE related pay based on the
relationship to productive hours in the JobCode block.
Monthly spread will be based on the spread of productive
hours.

Dept_
AvgPerProdHr

Interface Calculates other Non-FTE related pay based on the
relationship to productive hours in the department.
Monthly spread will be based on the spread of productive
hours. Only use this calc method to budget labor dollars at
a department level and not a JobCode level.

Dept_
InputMonthly

Interface Calculates other Non-FTE related pay by inputting monthly
amounts for the department. Only use this calc method to
budget labor dollars at a department level and not a
JobCode level.

Dept_InputTotal Interface Calculates other Non-FTE related pay by typing in a total
for the department. Monthly spread will be spread evenly
by month. Only use this calc method to budget labor
dollars at a department level and not a JobCode level.
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Calc Method Type Description

Holiday Interface Calculates salary dollars based on YTD holiday pay and
spreads by the listed holiday months in the Budget Labor
Configuration driver.

Input_Monthly Interface Calculate other Non-FTE related pay by typing in the
monthly totals.

Add New
JobCode

New Sets up a new JobCode block on the JobCode sheet. This
calc method allows the input of FTEs and hourly rate for
each labor category. The default hourly rate comes from
theMid Rate column in the Budget Labor Limits driver.

Add NewAvgPer
Paid Hr PayType

New Calculate other Non-FTE related pay based on the
relationship to paid hours in the JobCode block. Monthly
spread will be based on the spread of paid hours. This calc
method is only used when adding a new pay type.

Add NewAvgPer
Prod Hr PayType

New Calculates other Non-FTE related pay based on the
relationship to productive hours in the JobCode block.
Monthly spread will be based on the spread of productive
hours. This calc method is only used when adding a new
pay type.

Add New Input
Monthly
PayType

New Calculates other Non-FTE related pay by typing in the
monthly totals. This calc method is only used when adding
a new paytype.

� Provider sheet
For instructions on using this sheet, click here.

Calc Method Type Description

FinancialClass Interface Inserts financial class data to use during the initial interface
process.

Provider Interface Sets up the Provider Block to use during the initial interface
process.

Revenue Interface Inserts revenue data to use during the initial interface
process to insert revenue data.

RVU Interface Inserts RVU data to use during the initial interface process.

Statistic Interface Inserts Procedure/Statistic data to use during the initial
interface process.
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Calc Method Type Description

WRVU Interface Inserts WRVU data to use during the initial interface
process.

Add New
Encounter

New Inserts additional Encounter/Visit lines, if needed, after the
initial interface is complete.

Add New
FinancialClass

New Inserts additional Financial Class lines, if needed, after the
initial interface is complete.

Add New
Procedure

New Inserts additional Procedure lines, if needed, after the
initial interface is complete.

Add New
Provider

New Inserts a new Provider Block.

Add New
Revenue

New Inserts additional Revenue lines, if needed, after the initial
interface is complete.

Add NewRVU New Inserts additional RVU lines, if needed, after the initial
interface is complete.

Add NewWRVU New Inserts additionalWRVU lines, if needed, after the initial
interface is complete.

Copy From
Existing Provider

New Inserts a new Provider Block and allows the statistical
history from an existing Provider to copy into the new
Provider block.

� Staffing sheet
For instructions on using this sheet, click here.

Calc Method Type Description

JobCode Interface Sets up initial JobCode block on the Staffing tab during the
interface process. Do not use when adding blocks to the Staffing
tab.

AvgPerPaidHr Interface Calculates other Non-FTE related pay based on the relationship to
paid hours in the JobCode block. Monthly spread will be based
on the spread of paid hours.

AvgPerProdHr Interface Calculates other Non-FTE related pay based on the relationship to
productive hours in the JobCode block. Monthly spread will be
based on the spread of productive hours.
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Calc Method Type Description

DeptAvgPerPaidHr Interface Calculate other Non-FTE related pay based on the relationship to
paid hours in the department. Monthly spread will be based on
the spread of paid hours. Only use this calc method to budget
labor dollars at a department level and not a JobCode level.

Dept_
InputMonthly

Interface Calculates other Non-FTE related pay by inputting monthly
amounts for the department. Only use this calc methid to budget
labor dollars at a department level and not a JobCode level.

Dept_InputTotal Interface Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month.
Only use this calc method to budget labor dollars at a
department level and not a JobCode level.

Holiday Interface Calculates salary dollars based on YTD holiday pay and spreads by
the listed holiday months in the Budget Labor Configuration
driver.

Input_Monthly Interface Calculates other Non-FTE related pay by typing in themonthly
totals.

Input_Total Interface Calculates other Non-FTE related pay by typing in the total
dollars. Themonthly spread will be spread evenly.

Add New JobCode New Sets up a new JobCode block on the Staffing tab. This calc
method allows the input of FTEs and hourly rate for each labor
category. The default hourly rate comes from theMid Rate
column in the Budget Labor Limits driver.

Add New Input
Monthly PayType

New Calculates other Non-FTE related pay by typing in themonthly
totals. This Calc Method is only used when adding a new pay
type.

Add New Input
Total PayType

New Calculates other Non-FTE related pay by typing in the total
dollars. Themonthly spread will be even. This calc method is only
used when adding a new pay type.
The FTEs from Target should have no variance for a budget to be
acceptable.

� Stat_Rev (Statistics and Revenue) sheet
For instructions on using this sheet, click here.

Calc Method Description

Allowance Calculate deductions based on a percentage of gross revenue.

BadDebt Calculate bad debt based on a percentage of gross revenue.
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Calc Method Description

Detail Zeros base revenue calculations.

FixedRevenue Allows changes to the projected year as well as budget. Usually used
for other operating revenue accounts. Select themonthly spread
from the drop-down.

GlobalRevenue Pushes revenue or deduction calculations to the budget plan file from
Budget Assumptions. End users cannot change the totals or the
spread in the budget plan files. Only users with administrative rights
can update the calculations.

GlobalSum This SPM allows you to budget for an account at a percentage of the
total of specific other account(s) on the Stat_Rev tab within the same
workbook.

InputMonthly Month by month input.

IP_Per_Unit This revenue calc method is now an independent calculation of IP
revenue by account using the historical revenue per unit.

IP_Payor Calculates the total IP revenue, and then allocates it based on the
historical percentages by payor. Only use this calc method if the GL
gross revenue account structure is by payor.

OP_Per_Unit This revenue calc method is now an independent calculation of OP
revenue by account using the historical revenue per unit.

OP_Payor This calc method calculates the total IP revenue, and then allocates it
based on the historical percentages by payor. Use this calc method
only if the GL gross revenue account structure is by payor.

Oth_Per_Unit This revenue calc method is now an independent calculation of Other
Patient revenue by account using the historical revenue per unit.

Oth_Payor This calc method calculates the total IP revenue, and then allocates it
based on the historical percentages by payor. Only use this calc
method if the GL gross revenue account structure is by payor.

NoBudget Brings in historical values into the budget plan file, but the budget for
next year will be zero, and cannot be changed.

Statistic Calculates projected and budget key statistics.

Statistic_Oth Calculates projected and budget non-key statistics based on their
relationship to the key statistic.
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Calc Method Description

Revenue_Stat This revenue calc method allows you to define the statistic account
from the Stat_Rev tab to use as the basis of the per unit calculation
and themultiplier for the budget. For example, theremy be an Other
Department statistic in the OR for implant cases that should be used
to drive the Revenue-Implant account.

Add NewDetail Zero-based expense calculations when adding a new account. Inputs
are done on the Detail tab in the budget plan file.

Add New Fixed Revenue Use this new revenue calc method to add a new Fixed Revenue
account to the Stat_Rev tab.

Add New Input Monthly Use this new revenue or statistic calc method to add a new account
to the Stat_Rev tab.

Add New Statistic Use this new statistic calc method to add a new key statistic account
to the Stat_Rev tab.

Add New Statistic_Oth Use this new statistic calc method to add a newOther Statistic
account to the Stat_Rev tab.

Provider Version Only
If your organization purchased the Provider module license, you have access to the following additional
calc methods:

Calc Method Description

ProviderRev Transfers Revenue calculations from the Provider Summary/Provider
Detail tab to the Stat_Rev tab to save to the Financial Data tables.

ProviderStat Transfers Statistic calculations from the Provider Summary/Provider
Detail tab to the Stat_Rev tab to save to the Financial Data tables.
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Calc Method Description

ProviderComp Transfers Salary calculations from the Provider tab to the Stat_Rev
tab to save to the Financial Data tables.

NOTE: Provider Light Version Only: Calc Methods – Stat_Rev Sheet

If your organization has purchased the Provider module, you can
access the following additional calc methods if using the Provider
Light.

l Provider_Simple_Rev – Transfers Revenue calculations from the
Provider Simple Rev tab to the Stat_Rev tab to save to the
Financial Data Tables. If your GL structure has multiple revenue
accounts for Provider revenue, then apply the calculation method
Provider_Simple_Rev to each revenue account.

l Provider_Simple_Stat – Transfers Statistic calculations from the
Provider Simple Rev tab to the Stat_Rev tab to save to the
Financial Data Tables. Assign this to the key statistic you are using
as your driver stat on the Provider tab. For example, when using
WRVU as your Driver stat, add Provider_Simple_Stat to the GL
acct on the ACCT dimension table for WRVUs.

Budgeting health plans
The HealthPlan Operations utility allows your organization to calculate revenues and expenses based on
Membership Per Member Per Month (PMPM)Membership Per Member Per Month (PMPM)
calculations, which you can then use to determine the profitability of each health plan and/or insurance
product.

TIP: The ability to determine profitability depends on the data provided by your organization. The
more revenue and expense data you enter into the system, the closer you can get to a truemargin
ratio.

This utility is primarily for Axiom Budgeting administrators and/or finance liaisons of health plan
companies and their key stakeholders.

The following list and image describe the different areas and functions of the utility:

a. Key Results Summary - Summarizes the results of all the health plans included in the utility.

b. Insurance Plans - Displays a list of all the health plans and their key metrics for members as well as
the PMPM rates for revenue and expenses. The system calculates historical PMPM values for
historical periods such as Last Year Actual and Year-to-Date. Projection and monthly budget
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values are calculated based on members multiplied by the PMPM rate for revenues and expenses.
The header bar for each entity/department displays the entity and department number, the
insurance plan product, and the location. For each entity/department, the system shows the
number of covered members, the revenue, and the expenses.

c. Annual Comparison and Budget - The first half of the sheet displays the Annual Comparison
section, which shows values for the current year, including the current fiscal year budget, YTD
actuals, and projected actuals and next year budget. The other half of the sheet is the Budget
section, which shows themonthly and total budgeted values for the next fiscal year.

d. Expand/Contract entity/department rows - By default, the list of entities/departments is

expanded, but you can double-click to expand or double-click to contract it. After you save
your changes, the system remembers this setting the next time you open the driver.

IMPORTANT: The utility does not allow your organization to enter any health plan data containing
patient identifying information.

To budget health and insurance plans:
1. In the Bud AdminBud Admin task pane, in the Budget Files Administration section, double-click

Open HealthPlan Utility.

2. In the Refresh Variables dialog, do any of the following to filter the list of records that display in
the utility, and click OK:
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l In the Filter by ENTITY field, enter or select one or more entities.
l In the Filter by DEPT.KHABgtMap field, enter or select one or more departments.
l To include all entities and departments, leave the fields blank.

3. To enter details for a line item, in the Comments column, type information in the blue cells for the
appropriate line item.

NOTE: The information in the HealthPlan Operations utility is controlled by a series of dimension
tables and drivers. See theManaging utility information section below on how to update information
and calculations in the utility.

� Using different views
The system provides several different ways to view the sheet information. In theMain ribbon tab, click
Change View.

The following table provides a description of the different options.
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Column views

View Description

Select All Show all Annual Comparison, Comments, and Budget columns

Deselect All Hide all Annual Comparison, Comments, and Budget columns

Show Section - Annual
Comparison

Hide or show the Annual Comparison columns

ShowComments Hide or show only the Comments column

Show Section - Budget Hide or show only the Budget columns

Row views

View Description

Select All Show both the HealthPlan Operations title and Key Results Summary
Area

Deselect All Hide both the HealthPlan Operations title and Key Results Summary
area

Show Title Hide or show the HealthPlan Operations title

Show Section - Key Results
Summary

Hide or show the Key Results Summary area

Sheet views

View Description

Default Show both the Annual Comparison, Comments, and Budget rows
and columns

Annual Show only the Annual Comparison and Comments rows and columns

Monthly Show only the Comments and Budget row and columns

� Managing utility information
The information that displays in the utility comes from several different sources. The following table lists
where to update information, as needed:

NOTE: To update dimensions specific for health plan budgeting, see Updating dimensions for health
plan budgeting.To update dimensions specific for health plan budgeting, see "Updating dimensions
for health plan budgeting" in the online help.
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Location Description

LOCATION dimension Add or edit department locations.

INSCODE dimension Add or edit healthcare or insurance plans.

DATATYPE dimension Assign budget types to plan revenue and expense streams.

ACT_HP_20XX table Add or edit plans and the corresponding actual account data.

Membership Enrollment
Trend driver

Enter enrollment percentages for each health plan or insurance
product offered by your organization. The purpose of this driver is to
determine themembership trend of each product. The trend
percentages are then used in theMembership Per Member Per
Month (PMPM) driver to adjust themembership statistics.

Membership Per Member
Per Month driver

Reviewmember lives, revenue PMPM, and expense PMPM for each
health plan.

� Printing the HealthPlan Operations utility
Axiom Budgeting allows you to save the Annual or Monthly version of the HealthPlan Operations utility
as a PDF.

To print the HealthPlan Operations utility:
1. Open the HealthPlan Operations Utility.

2. In theMain ribbon tab, click Publish > Print > Print This Sheet.

3. In the Print Sheet dialog, do any of the following:
l Print Details - Click the View/Edit link to edit print view options, scaling, and header/footer

information.
l Print Preview - Click the Print Preview link to view a preview of the report.

4. Next to the sheet name, click the check box for the report to print, and click Print.
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Working with Deductions Modeling
The Deductions Modeling utility is a set of reports that allows organizations to budget for deductions in a
separate department, outside of their regular departmental budget plan files.

IMPORTANT: Do NOT create a budget workbook for the deductions department when using the
Deductions Modeling utility. Doing so will create two different sources for the   budget values.

The Deductions Modeling utility combines and summarizes historical and next year departmental detail
gross budget data for Cases, Patient Days, Outpatient Visits, and Gross Revenue to serve as the key
drivers when computing net revenue by patient type and payor. If the necessary data is not available,
you may enter payment assumptions by patient type or payor to compute net revenue.

The utility computes GL allowances as:

(Gross Revenue) – (Net Revenue by Patient Type/Payor)

GL Accounts can be assigned to each patient type/payor allowance computation, after which you can
post the resulting allowance to the database for the active budget and include the allowance in all related
budget analysis reports.

As budgets and assumptions change, simply refresh data in the Deductions Modeling reports to update
and post newly computed allowances for computing net revenue (assuming the payment assumptions
remain unchanged).

You may also choose to set up models for different budget groups. To create separatemodels for
different budget groups, you need to savemultiple versions of themodel using Save As, and then select
the desired budget group when refreshing report data.

NOTE: The topics following in this section assume a working knowledge of reimbursement principals
and are familiar familiarity with the previous version of this utility. Additionally, a working knowledge
of Axiom reporting concepts such as Table.Column and report filtering is assumed.

Setting up the Budget Deductions utility
There are threemain areas to configure to set up the Budget Deductions utility.

7
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� Security roles
The Budgeting Deductions Admin and Budgeting Deductions Analyst roles support allows users to
configure and use the Budget Deductions utility. You must first assign one of these roles to an existing
user to provide access to the utility. The definitions of the two roles include:

l Budgeting Deductions Admin: Grants read/write access to the Budget_Deductions tab and the
DeductionModels tab of the utility.

l Budgeting Deductions Analyst: Grants read/write access to the Budget_Deductions tab only.

� Security filters
This utility works with the existing User Write Filter as established by the Budget Security Update utility
for the Financial Table Filter. For example, if my financial table filter is Dept>0, then I can save records in
the utility that meet this criteria. If my financial table filter is Dept.BudgetGroup=’EMC’, then I can only
save records that meet this criteria.

� DeductionModels tab
To configure the report to the values needed, you need to configure the DeductionModels tab. Only
users with the Budgeting Deductions Admin role can access this tab. To allow configurable filters for the
utility, the administrator must set up each model.
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� ACCT dimension
Setting up the ACCT dimension grouping columns is an important step to ensure the report retrieves
data correctly for each section. The two primary grouping columns you need to configure are
Acct.BPCode and Acct.BPCategory.

NOTE: The Budget Deductions Utility no longer uses Acct.FPCode and Acct.FPCategory, so these
columns no longer work in this version of Axiom Budgeting and Performance Reporting.

To set up the Budget Deductions utility:
1. Assign either the Budgeting Deductions Admin or the Budgeting Deductions Analyst roles to the

appropriate users.

For instructions on assigning security roles, see Assigning users to roles.

2. This utility works with the existing User Write Filter as established by the Budget Security Update
utility for the Financial Table Filter. For example, if my financial table filter is Dept>0, then I can
save records in the utility that meet this criteria. If my financial table filter is
Dept.BudgetGroup=’EMC’, then I can only save records that meet this criteria.

3. In the Bud Admin task pane, in the Budget Financial Tools section, double-click Budget
Deductions.
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4. In theDeductionModels tab, complete the following columns for each row:

� Code
Type a code name for your model. (For example, EMC.) This code displays as a selection in the
utility.

� Description
Type a user-friendly model name for your code.

� Filters
This is an important step in the set up of the data used to query data in the report. Where the
prior version of this report used one AQ for the entire report, the current version contains an AQ
for each section so a unique filter can be used, if needed. The sections to configure include the
following:

l Discharges
l Days
l Visits
l IP Revenue
l OP Revenue
l IP Deductions
l OP Deductions

We recommend that you use the Axiom Filter Wizard to enter the correct syntax. In the following
example, the user assigns the filter Dept.BudgetGroup=’EMC’ to Discharges.
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The system then automatically copies the same Discharges filter to the remaining sections, but
you can configure a different filter, if needed.

After you set the filter for a section, you need to manually segregate the filter into Table.Column
and Element. This is needed for the SumBy of that AQ for the section so the data is correct. In the
following example, Table.Column is Dept.BudgetGroup and Element is EMC. These values should
match the syntax used in the filter.
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For each section, you can configure up to two unique Table.Column and Element to meet more
complex requirements. For example, if you need a filter using both Dept and Acct, you would
enter the second set of Table.Column and Element containing Acct.FSDetail and S_Discharges,
shown in the following example.

� Dept and Acct
This section includes the department and account used to post the contractual adjustment to.
This section is essentially the same as previous versions of Axiom Budgeting and Performance
Reporting but with some key differences:

l Because each row is configurable, you can use different department and account values for
each model, if needed.

l You enter Department and acct values on the row for each model, which the system copies
to the Budget_Deductions tab where it’s posted to the BUD20XX table.
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5. After you finish configuring the row, in theMain ribbon tab, click Save.

NOTE: The row nowdisplays above the section where it was fist configured. This row is now an
activemodel for use in the utility. You can still make edits to the activemodel, as needed.

6. Configure the ACCT dimension by doing the following:

� Acct.BPCode
These codes are used to define the statistics, revenue, and deductions sections of the utility and
are defined values as noted:

l Disch - Discharges
l IPPD - Patient Days
l OPVisits - Visits
l IPRev - IP Revenue
l OPRev - OP Revenue
l DedIP - IP Deductions
l DedOP - OP Deductions
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� Acct.BPCategory
These are codes used to define payor categories for the statistics, revenue, and deductions
sections of the utility. These should be prefixed by BPCode+Payor name. Examples may include
the following:

l IPRev - IP Revenue
o IPRevMedicare
o IPRevMedicaid
o IPRevBlueCross
o IPRevComm
o IPRevOther
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When configured, the Budget Deductions Utility summarizes the data by Acct.BPCode and
Acct.BPCategory along with the SumBy-level configured on the DedutionModels tab.

7. Configure your payor groups using the FP Payor form. Configure your payor groups using the FP
Payor form. For instructions, see Configuring payor groups.
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Using the Budget Deductions utility
The Deductions Modeling utility is a set of reports that allows organizations to budget for deductions in a
separate department, outside of their regular departmental budget plan files.

The utility includes the following sections:

l Patient Volume
o Discharges by Payor
o Patient Days
o Inpatient Length of Stay
o Outpatient Visits

l Patient Revenue
o Inpatient Revenue
o Outpatient Revenue

l Deductions
l Contractual Allowances
l Revenue Deductions Upload

NOTE: Before you can use the Budget Deductions utility, you must identify Payor groupings in the FP
Payor table.

To use the Budget Deductions utility:
1. In the Bud Admin task pane, in the Budget Financial Tools section, double-click Budget

Deductions.

2. On the Budget_Deductions tab, from the Budget Deduction Group drop-down, select the Budget
Deduction model code.

NOTE: Themodel name displays next to themodel code. Selecting themodel code refreshes
the report.
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3. From the RESET to Default Calculations drop-down, select one of the following, as needed:

� Reset
This option is a master reset that changes ALL rows back to the Default Calc setting. This means
that each rowwill use the standard calculation for that row and is used as a starting point for the
related row.

For example, the default setting for Inpatient Revenue is to query the financial database for prior
and current fiscal year for each payor group (For example, Medicare).

NOTE: Use caution when selecting this option since doing so sets all manual changes back to
default calculations. For example, you may want to use this setting as the start of a new
planning year where all themanual changes in the table need to be reset back to default
calculations for a fresh start. After selecting Reset to initialize, remember to change the setting
back to Last Saved.

� Last Saved
This option is most commonly used during the planning cycle. This setting allows for each
selectable row to use either Default Calc or Last Saved based on what you selected for the
individual row.

For more details, we recommend that you review Example: Resetting to default calculations for
budget deductions.

4. Complete the following sections, as needed:

� Patient Volume
TheDischarges by Payor, Patient Days, and Outpatient Visits sections follow the same basic
pattern. Within each section, you will find a section for percentage by payor, followed by a section
for entering historical and projected values. Review and adjust historical and projected values as
needed, and then return to the % by payor section and scroll to the right to review and adjust
monthly distributions.
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NOTE: Medicare is the reconciliation payor to ensure distribution sums to 100%.

The Inpatient Length of Stay section displays calculated values based on Discharges and Patient
Days information. It cannot be adjusted directly.

� Patient Revenue
The Inpatient Revenue section features rows for each payor group.
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Initial values are calculated based on one of two methods:

l NYB uses the budget amount for the next year
l Compute uses ratemultiplied by patient days

Select between thesemethods using the drop-down at the top of the section.

TheOutpatient Revenue is handled similarly, except that compute uses ratemultiplied by
outpatient visits.

� Deductions
The Inpatient Deductions and Outpatient Deductions section display Next Year Budget data
based on Net Revenue computations. You may adjust the calculated values, if desired.

� Contractual Allowances
The Contractual Allowances section contains Reimbursement sub-sections for each payor group.
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For the inpatient and outpatient sections of each payor group, do the following:

a. From the drop-down, select themethod of reimbursement.

All input cells associated with themethod display blue and historical rates calculated
appropriately.

b. Enter the appropriate reimbursement parameters.

c. Scroll right to review and adjust the associated monthly rates for the new year. The original
monthly rates will be the same as the projection year until they aremanually changed.

The computed reimbursement, gross charges, and associated net revenue display.
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� Revenue Deductions Upload
The Revenue Deductions Upload section allows you to save the revenue deductions calculations
for each Payor Group to specific department/account combinations.

Enter a Department and Account number for each Patient Type/Payor combination. Code each
active row to a GL Dept/Account, even if the deduction amount is zero.

If you enter the same combination in more than one Payor Group, the utility posts the total for all
of the designated Payor Groups.

5. In theMain ribbon tab, click Save to post your results.

IMPORTANT: Do not post until you have completed your GL Dept/Account mapping. If you do post,
and then change your mind on some of this mapping, you will need to zero out the deductions for
ProjTtl and months 1-12 of the active Next Year Budget table.

After you complete this process, review the resulting contractual allowances by running the Budget
Income Summary or Budget Income Detail reports located in Explorer > Budgeting Reports > Budget
Income Summary
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Example: Resetting to default calculations for budget
deductions

In the following example, Medicare Inpatient Revenue is set to Default Calc in the row selection. This
means that the calculation returns values from the ACT tables for prior year and YTD.

Let’s assume that I want to change the values of prior year, YTD and Projection for purposes. The row
selection drop-down changes to Last Saved (see red arrow). I can enter changes in the blue fields, and
then click Save.

NOTE: The report displays as read-only (R/O), but the Save option works similar to the driver files, in
which the system saves the selected options and values to a new table. In this case, the table is
named BPDed. The system retrieves all the values from DPDed and places them into the report, as
shown in the following example.
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To replicate returning at a later time to continue working on the report, I exit and reopen it. Because
multiple models could exist for other users, the first step I need to perform is to select the desired model.

After I select themodel (EMC), Medicare Inpatient Revenue still shows Default Calc instead of Last Saved,
which is where I set it earlier. That is because I need to refresh the utility. Even though we selected the
model, refreshing the data means that the system will retrieve the last saved values.
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The Last Saved selection and values are now viable in the report. This is true for each row, so the general
rule is if you modify a specific row, you need change the row selection to Last Saved.

Finally, to demonstrate themaster Reset option, note that making the section automatically changes
every row selection back to Default Calc. If the report is saved in this condition, the system sets all of the
values in the BPDed and BUD20XX tables to the resulting calculation of the default.
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Running the FSDetail and FSPayor reports
Use the FSDetail report when the gross revenue breakdown by payor is not available from the GL
account detail. Instead, payor mix percentages are input to allocate the gross revenue to each Payor
Group.

Use the FSPayor report when the gross revenue breakdown by payor is available from the GL account
detail. In this case, the Acct.FSPayor column is used to allocate gross revenue to each Payor Group.

� Configuring the FSDetail report
This report uses the Acct.FSDetail grouping column to define Gross Revenue and Contractual Allowance
categories.

To configure the FSDetail report:
1. In the Bud Admin task pane, in the Budget Reporting section, click Budget Utilities > Balance

Sheet & Deductions, and double-click NYB_Deductions_FSDetail.

2. Identify the Payor Groupings to use in the Patient Revenue by Payor column.
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3. Input your payor mix allocation percentages for Inpatient, Outpatient, and Other revenue in the
YTD, Rest of Year, and Projected Next Year Budget columns.

NOTE: YTD generally comes from the decision support or billing system.

4. Initialize the report by pressing F9.

5. In the Refresh Variables dialog, do the following:
l From the Select BudgetGroup (Leave blank for ALL) (optional) field, select a Budget

Group, if applicable (or leave the field blank for all departments).
l From the Select FSDetail grouping used for Bad Debt (optional) drop-down, select the

group.

6. In the Contractuals section, identify the Revenue Driver for each contractual allowance account by
selecting a category for each account.
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7. After you complete the Revenue Driver assignment, press F9 to update the relationships.

8. Scroll to the right and enter any desired adjustments for each account as dollar amounts or
percentages.

9. In theNet Revenue section, review the results of the calculations.

10. To post the results to the database, in theMain ribbon tab, click Save.

11. Update the report and re-post whenever gross revenue or reimbursement assumptions change.

12. Run your Budget Income Summary report located at Explorer > Budgeting Reports > Budget
Income Summary

� Configuring the FSPayor report
This report uses the Acct.FSPayor grouping column to define Gross Revenue and Contractual Allowance
categories.

To configure the FSPayor report:
1. In the Bud Admin task pane, in the Budget Reporting section, click Budget Utilities > Balance

Sheet & Deductions, and double-click NYB_Deductions_FSPayor.
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2. Identify the Payor Groupings to use in the FSPayor column. Update the coding in Acct.FSPayor to
correspond to the payor categories defined for gross revenue as well as contractual allowance
accounts.

3. Initialize the report by pressing F9

4. In the Refresh Variables dialog, do the following:
l From the Select BudgetGroup (Leave blank for ALL) (optional) field, select a Budget

Group, if applicable (or leave the field blank for all departments).
l From the Select FSDetail grouping used for Bad Debt (optional) drop-down, select the

group.
l From the Reset drivers to original, clear inputs drop-down, select Yes orNo.

5. In the Contractuals section, identify the Revenue Driver for each contractual allowance account by
selecting a category for each account.

6. After you complete the the Revenue Driver assignment, press F9 to update the relationships.

7. Scroll to the right and enter any desired adjustments for each account as dollar amounts or
percentages.
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8. Review the results of the calculations in theNet Revenue section.

9. To post the results to the database, from theMain ribbon tab, click Save.

10. Update the report and re-post whenever gross revenue or reimbursement assumptions change.

11. Run your Budget Income Summary report located at Explorer > Budgeting Reports > Budget
Income Summary.

Comparing deductionsmodels
There are three reports available for deductions modeling: Budget Deductions, FSDetail, and FSPayor.
Use the following table to help you determine themost appropriate option.

Category Budget Deductions FSDetail FSPayor

Volumes by Payor Yes No No

Gross Revenue by
Payor

Database or
allocation

Allocation of total
from input

Summarized from
database

Reimbursement Multiple options Gross less
Contractual

Gross less Contractual

Contractuals Gross less Net
Reimbursement

% of gross charges
w/adjustment

% of gross charges
w/adjustment

Monthly Spread Driven by monthly
volume, revenue, or
input

Driven by gross
revenue spread

Driven by gross
revenue spread

GL Accounts Summarized by Payor Match to GL structure Match to GL structure

Administrator's Guide Axiom Budgeting and Performance Reporting │ 383



Working with Current Year
Forecasting

Axiom Budgeting and Performance Reporting 2020.3 provides reports and utilities that allow you to
forecast the remaining periods of the current year based on actuals to date.

Review to verify that all computations on report are as you expected.

The final forecast will be the original forecast calculated by theMonthly Forecast plus any manual
changes made in Monthly Forecast Adjustments. All changes are posted to CYF20XX.

Configuring dimensions for current year forecasting
Before taking advantage of the Current Year Forecasting reports, populate the following columns in the
dimension tables:

l CYFMethod column in the ACCT dimension table - This column determines which forecasting
method is applied to each account. Refer to theMonthly Forecast Utility report for a list of
account types and themethods most commonly used for each of them.

l CYFDimGrp column in the DEPT dimension table - This column determines which CYFMethod
column each department uses to forecast accounts.

After you complete your changes to the ACCT dimension table, save your changes by clicking Save in the
Main ribbon tab. To apply different sets ofmethods for different departments, create an additional
column, and enter a method for each account. You determine which column each department refers to
in the CYFDimGrp column of the DEPT dimension table.

Use the Dimension Maintenance utility to edit the ACCT and DEPT dimension tables.

Configuring drivers on the Monthly Forecast Utility
After configuring dimensions for current year forecasting, you need to configure settings and key
statistics on the PROJDriver tab of theMonthly Forecast Utility.

8
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To configure drivers on the Monthly Forecast utility:
1. In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities > Current

Year Forecast > Forecast Processing, and double-clickMonthly Forecast Utility.

2. In the PROJDriver tab, define the high-level statistical drivers to apply when calculating the
individual departmental forecast volumes.

3. After you set up the drivers, in theMain ribbon tab, click Save.
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Processing the monthly forecast
TheMonthly Forecast Utility runs the report by KHABgtCode in DEPT in dimensions. Results post to the
CYF20XX table (where 20XX is the current year) for each department and account using the projection
methods that you selected.

NOTE: This is a custom report not designed to work with Quick Filter or Multipass.

To process the monthly forecast:
1. In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities > Current

Year Forecast > Forecast Processing, and double-clickMonthly Forecast Utility.

2. To view the current totals, click theMthly_Fcst_Utility tab.

3. To view the report, click the Report tab.

4. Review the results to verify that all computations on report are as you expected.

If the data seems to be in order, then the forecast data is now available to use. Practical uses of CYF20XX
include but are not limited to:
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l Budget Variance reports-Monthly projection section
l Budget integration with Financial Planning
l Projected Income Statement reporting

Adjusting current year forecasts
There are two reports that allow you to enter overrides for current- year forecasts:

l Monthly Forecast Adjustments – Allows for overrides at an income statement category level
l Dept. Specific Forecast Adjustments – Allows for overrides for a specific dept/acct level

� Processing monthly forecast adjustments
Use this report to changes themonthly forecast at an Income Statement Summary level. The report runs
by KHABgtCode in DEPT in dimensions. It posts the results by department and account using the
projection methods that you selected earlier to a table named CYF20XX, where 20XX is the current year.

To Process Monthly Forecast Adjustments:
1. In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities > Current

Year Forecast > Forecast Adjustments, and double-clickMonthly Forecast Adjustments.

2. In theMonthlyFcstAdju tab, enter changes in the blue cells for futuremonths by positive or
negative percent or whole number by each category.
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3. To apply the adjustments to categories, you must first create a dummy department/account
combination for each category in the dimensions, and then enter the dummy
department/account combinations on the Control tab.

4. Refresh the data to make sure you have the latest information by doing one of the following:
l In theMain ribbon tab, in theWorkbook Options group, click Refresh Data.

l Press F9.

5. In theMain ribbon tab, in the File Output group, click Publish > File Processing > Process File.
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6. Review the report to verify that all computations on report are as you expected.

7. After the reports runs, to save your changes, in theMain ribbon tab, click Save.

� Processing Dept Specific Forecast Adjustments
Use this report to change themonthly forecast at a department/account level.

To Process Dept Specific Forecast Adjustments:
1. In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities > Current

Year Forecast > Forecast Adjustments, and double-click Dept Specific Forecast Adjustments.

2. Refresh the data to make sure you have the latest information by doing one of the following:

l In theMain ribbon tab, in theWorkbook Options group, click Refresh Data.
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l Press F9.

3. In theDeptSpecificFcstAdj tab, make the appropriate changes in the blue cells.

4. Do one of the following:

l To process only selected departments, in theMain ribbon tab, in the File Output group,
click Publish > File Processing > Process File.

l To process for all the departments, click Publish > File Processing > Process File
Multipass.
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Working with Flexible Budgeting
The Flexible Budgeting utility analyzes the impact of volume changes on the budgets for accounts that
normally flex or change in proportion to volume changes.

Often, it does not make sense to hold managers accountable for meeting fixed, overall budget targets
when their department can be severely impacted by volume, a variable out of their control. Hence,
Flexible Budgeting seeks to correct departmental targets for volume variances, allowing managers to
focus on rate and efficiency variances ("Howmuch does it cost to provide services on a per-unit basis?").

� Defining volume statistics
Before we can correct for volume, wemust first define how volume is to bemeasured. Different
organizations and departments measure volume differently, so as part of the Flex Budgeting setup
process, you need to specify which statistics in the Axiom Budgeting and Performance Reporting
database you will use to measure volume for each department and account.

Commonly used statistics include patient days, revenue, square footage, visits, encounters, and so on.

� Target setting for flexible budgets
The Flex Budget for a department/account equals the Budget Amount (howmuch the department is
expected to spend) divided by the key volume statistic (howmuch volume the department expects to
handle), multiplied by actual volume for the period.

Refer to individual report instructions to see whether and how flexible budget data can be used.

Setting up flexible budgets
To compute a flexible budget, you must set up flexible budgets by doing the following:

l Modify columns in your ACCT and DEPT dimension tables to reflect how and howmuch various
departments and accounts should flex.

l Specify any exceptions using the Flex Budget Setup utility.
l Process the FlexCalculator by Month report utility.

9
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Set up columns in your DEPT and ACCT dimension tables to specify how and howmuch various
department and account budgets will flex.

� Modify the ACCT and DEPT dimension tables
Change the ACCT and DEPT dimension tables to reflect how departments and accounts should flex.

To modify the ACCT and DEPT dimension tables:
1. Use the Dimension Maintenance utility to open the DEPT and ACCT dimension tables.

2. In the DEPT dimension table, make changes to the following columns:

l FlexGroup – Used to identify groups of departments for flex budget exceptions. Valid
entries are either a group name or NA.

l FlexDept – Used to indicate if a department should be flexed or not. Valid entries are Yes or
No.

If there aremultiple departments in your organization that should flex in the samemanner, you
can assign a group name in the FlexGroup column of the DEPT dimension table. In the following
example below, the departments in the Imaging flex group will all flex per the same settings:

3. In the ACCT dimension table, as part of the budget process, each department should have key
statistics that define the department's key budget drivers. For this step, assign each account with
what variety of statistic should be the variable driver for that account. A few examples:

l Inpatient Revenue would use KeyIP as a default type of statistic.
l Medical Supplies would use KeyToT to represent the combined inpatient/outpatient

statistics.
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Review and modify the following columns, as necessary:

l FlexStat – Use to assign the default type of statistic account to use as the variable driver for
each account.

NOTE: The BudgetType column also identifies each account's statistic type as KeyIP,
KeyOP, or KeyOth.

Allowable values are:

Value Definition

KeyTot Total key statistic for the department

KeyIP Inpatient revenue key statistic

KeyOP Outpatient revenue key statistic

KeyOth Other key statistics

Stat Acct Number For any statistic account or any account driven by a specific
statistic account

NA Any account to be excluded from the flex calculations

l FlexPercent – Use this to identify fixed or variable percent. You must enter these as a
percentage. Set all variable accounts to between 0 and 100%.

l FlexGroup – Use this to identify Flex Budget groups for flexible budget exceptions. Use the
group name(s) created by you, except for all statistics which should be assigned as Statistic.
The default value is NA.
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� Define flex budget parameters
The Flex Budget Setup utility allows you to configure exceptions to override the Dept and Acct flex
settings:

l Dept.FlexGroup/Account override
l Dept/Acct.FlexGroup override
l Dept/Acct override

To define flex budget parameters:
1. In the Bud Admin task pane, in the Financial Reportingsection, click Financial Utilities > Flex

Budget, and double-click FlexBudgetSetup.
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2. In the Time Series section, complete the following:

NOTE: By default, the TimeSeries fields are updated automatically based on your system
period.

Option Description

Actual TimeSeries The time series for actual.

Budget TimeSeries The time series for budget.

Flexible Budget
TimeSeries

The time series for flex budget.

3. In the Flex Parameters section, complete the following:

NOTE: This section uses the column names that currently exist in the DEPT and ACCT
dimension tables. You should only have to change these if you use another column name to
store this information in the dimensions. The default data on this form are the recommended
Kaufman Hall settings. Beforemaking any changes to the default values using the following
table, please consult your Kaufman Hall Implementation Consultant or Customer Success
Representative.

Option Description

Group Column for
Dept Exceptions

The column name in the DEPT dimension used to identify Flex Budget
groups for flexible budget exceptions. The default value is FlexGroup.

Group Column for
Acct Exceptions

The column name in the DEPT dimension used to identify Flex Budget
groups for flexible budget exceptions. The default value is FlexGroup.
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Option Description

Group Column for
Stat Code

The column in the ACCT dimension used to assign the default type of
statistic account to use as the variable driver for each account. The
default value is FlexStat.

Group Code for Flex
%

The column in the ACCT dimension used to identify fixed or variable
percent. The default value is FlexPercent.

Defining Key
Statistic Dimension

The dimension where the Acct Key Statistic types reside: ACCT or
DEPT. The default value is Acct.

Acct Key Statistic
Type Filter

l GroupCode - The column in the ACCT dimension used to identify
each statistic account's statistic type.

l Element - The account's statistic type.
The default value is BudgetType.

4. To make exceptions, do the following:

� Department Range Exceptions
Configure exceptions for groups of departments defined in the dimension for an account.

a. Click + Add Department Range Exception.

b. In the Add Department Range Exceptions dialog, in the FlexGroup field, type the name of
the group from the DEPT dimension for which you would like to create an exception.

c. In the Acct field, type the number of the account for which you would like to create an
exception within the group.

d. In the FlexStatistic field, type the column to use to calculate volume for the group.

e. In the FlexPercent field, type the percentage of the budget that will flex in proportion to the
selected FlexStatistic.

f. Click Save.

� Dept/Account Range Exceptions
Configure exceptions for groups of accounts for a department.

a. Click + Add Dept/Account Range Exception.

b. In the Add Dept/Account Range Exceptions dialog, in theDeptfield, type the department
number for which you would like to create an exception.

c. In the FlexGroup field, type the FlexGroup name from the ACCT dimenson.

d. In the FlexStatistic field, type the column to use to calculate volume for the group.
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e. In the FlexPercent field, type the percentage of the budget that will flex in proportion to the
selected FlexStatistic.

f. Click Save.

� Dept/Account Exceptions
Configure exceptions for a specific department/account.

a. Click + Add Dept/Account Exception.

b. In the Add Dept/Account Range Exceptions dialog, in theDeptfield, type the department
number for which you would like to create an exception.

c. In the Acct field, type the account number.

d. In the FlexStatistic field, type the column to use to calculate volume for the group.

e. In the FlexPercent field, type the percentage of the budget that will flex in proportion to the
selected FlexStatistic.

f. Click Save.

5. After making your changes, click Save in the upper right corner of the page.

� Process flexible budget data
The FlexCalculator by Month report computes the flexible budget by department and account when run
as a multipass process.
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To process the FlexCalculator by Month report:
1. In the Bud Admin task pane, in the Financial Reportingsection, click Financial Utilities > Flex

Budget, and double-click FlexCalculator by Month.

2. In theMain ribbon tab, in the File Output group, click Publish > File Processing > Process File
Multipass.
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NOTE: In addition to this report, the flex amounts resulting from the flex budgeting
calculations reside in a table named FLX20XX, where XX is the current year.

Using flexible budget data in reports
You can use flexible budget data in place of regular budget data in various reports. Two of themany
examples include:

l Budget Variance by Dept. – his report prompts you to select Flex or regular budget data when
refreshed. You can find this report in the Financial Reporting section of the Bud Admin task pane.
Navigate to Financial Reporting > Report Packages > Manager > Budget Variance by Dept.
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l Variance Comments Collection – To use flex budgeting values rather than current year budget
values for comparisons in Variance Comments Collection, do the following:

1. In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities >
System Setup, and double-click VCC_Threshold.

2. From the Comparison Time Series drop-down, select Flex.

For more information on configuring tolerance levels for Variance Comments Collection, see
Setting variance thresholds.

Refer to individual report instructions to see whether and how flexible budget data can be used.
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Managing Plan Files
The topics in this section address how to purge and restore budget plan files.

To archive plan files, see Archiving current year plan files.

Managing restore points
You can create custom restore points and you can delete existing restore points that are no longer
needed. For example, you may be preparing to open the file group for end user input, and you want to
manually create a restore point before users start editing plan files.

To manage restore points:
1. In the Explorer task pane, in the File Groups section, right-click the budget to manage the restore

points for, and clickManage Restore Points.

2. Do any of the following:
l To create a new restore point, click New. Enter a description for the new restore point, and

then click OK. The date/time for the new restore point will be the current date/time.

l To delete a restore point, select the restore point, and then click Delete. This action simply
deletes the restore point so that it is no longer available for selection; it does not delete the
associated plan file versions from the database audit history.

NOTE: Restore points are automatically deleted when the plan file versions associated
with the restore points are no longer available in the database audit history.

The availability of restore points and the associated plan files depend on your system purge settings, as
defined in the Scheduler system job System.SystemDataPurge.

The setting Audit History: Number of days to keep system history determines how long old plan file
versions are stored in the database. For example, if this option is set to 15 days (the default setting), then
you can only restore plan files from the last 15 days; anything older than that has been purged from the
database. Therefore, Axiom Software also uses this setting to automatically delete old restore points
from the same time frame, since those restore points no longer have any plan files available to restore.

For more information, see Configuring plan file purging.

10
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Restoring archived plan files
NOTE: For instructions on archiving, see Archiving current year plan files.

You can reverse the archive process by restoring the previous versions of plan files using the restore
point created by the Archive Current Year Plan Files command. However, the previous versions of the
plan files are only available until they are deleted by the system Scheduler job Purge System Data, which
by default runs nightly and deletes old items based on a configured time frame. The restore point is only
intended as a safeguard for a situation where the command is run accidentally, so that the plan files can
be restored immediately. It is not intended to be used to convert the plan files back to "live" plan files at
a later date. The archive process is permanent except for this short-term safeguard.

This feature is limited to administrators and to users with one of the following security permissions:
Administer File Groups (for all file groups) or Modify File Group (for specific file groups). Users with the
Administer File Groups permission can restore all plan files for all file groups, even if the user does not
otherwise have access to those files. Users with theModify File Group permission can only restore plan
files for which the user has read/write access.

NOTE: If a plan file is deleted, it cannot be restored using restore points. Restore points can only
restore earlier versions of existing plan files.

When restoring plan files, you first select a restore point and then you select the plan files to restore.

To restore archived plan files:
1. In the Explorer task pane, in the File Groups section, right-click the budget for the file to restore,

and click Restore Plan Files.

2. On the first screen of the Restore Plan Files dialog, select the restore point to use, and then click
Next. Restore points are identified by date/time and description.

3. On the second screen of the dialog, select the plan files to restore, and then click Finish.

This screen only lists the plan files that have been changed since the date/time of the selected restore
point. You can select individual plan files or you can select the check box in the header to restore all of
the plan files. You can use Axiom grid features to sort and filter the list.

If no plan files have been changed since the selected restore point, a message displays to inform you of
this.

The restore process creates a new plan file version that is a copy of the version from the selected restore
point, and that new version becomes the active version. For example, imagine that the current plan file
version is version 10, and you want to restore version 9. The system creates version 11 of the plan file,
which is a copy of version 9. Both version 9 and 10 still exist as independent versions in the document
history for the plan file.
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Configuring plan file purging
When setting the number of days to purge, we recommend keeping the number of days to a minimum
because it can affect the system performance as a result of storing plan file copies for an extended period
of time.

To configure plan file purging:
1. In the Admin ribbon tab, click Scheduler.

2. In the Schedule Jobs tab, double-click System.SystemDataPurge.

3. On the left side of the screen, click Tasks > SystemDataPurgeTask.
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4. In theNumber of days to keep result history field, type the number of days to keep the archived
file, and click Save.
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Working with Reports
Reports use Axiom file functionality to bring in data from the database, and if desired, to save data back
to the database. You can use any Axiom file feature in a report except calc method libraries.

Report files, unlike other Axiom files, are not associated with any file group. You can bring in data from
any table. For example, if you have two file groups that are configured to save data back to two different
tables (or to different columns in the same table), you can use a report to compare the data.

� Report structure
Axiom reports are free-format. When you create a new report, you can use various query options to
bring data anywhere into the report, and you can use spreadsheet functionality to format the report and
calculate values such as subtotals and percentages.

Reports can have any number of sheets. Each sheet can be configured to bring in data from the
database, and, if desired, save data back to the database. If you want to use an Axiom query on a sheet,
or save data to the database from a sheet, that sheet must be configured on the Control Sheet. Other
Axiom file functionality, such as Axiom functions or GoTo bookmarks, do not require the sheet to be
configured on the Control Sheet.

� Reports Library
Report files are stored in the Axiom Software database. To make it easy to access and organize reports,
Axiom Software supports a virtual folder structure known as the Reports Library.

Each report is assigned to a folder in the Reports Library. When you open reports, you can navigate
through the Reports Library structure to quickly locate the report that you want to open.

The Reports Library is managed by using Axiom Explorer. If you are an administrator, or if you have
Administer Axiom Explorer rights, then you can use Axiom Explorer to create report folders, move reports
between folders, and delete existing reports.

You can also save reports outside of the Axiom Software database—for example, to your local computer
or to a network folder. In this case the file is considered to be a non-managed file. It is recommended to
maintain all reports as managed files unless you have a compelling reason to use a non-managed file.

11
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� Report output and distribution
In addition to the standard output options for Axiom files—such as the ability to take a snapshot of an
Axiom file—report files can use the File Processing feature.

Using file processing, you can refresh a report file and perform output and distribution actions such as
saving a snapshot copy of the file, emailing a snapshot copy of a file, or exporting data to a CSV/TXT file.
You can process the file "as is," or perform Multipass processing on the file, where the file is processed
multiple times using a unique filter for each pass.

� Saving data to the database
In addition to viewing data, you can also use reports to calculate data and save data back to the
database. In certain circumstances, it may bemore appropriate to use a report to save data rather than
plan files or driver files. If a report file has been configured to save to the database, you can use the Save
button in the File Options group to save data.

Contact Kaufman Hall Support if you are unsure about the best way to manage a certain set of data.

Budgeting reports
Axiom Budgeting and Performance Reporting 2020.3 comes with a variety of standard budget reports,
organized within the following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Budgeting Analysis reports
The following reports allow you to view general budget data. For examples of these reports, see Analysis
reports.

Report Description

Budget Account Analysis Use to analyze the proposed budget compared to last year
actual, current year budget, and current year projected for
an individual account by department. Comments entered
into the budget plan files also show on the report to assist
with the analysis.

Budget FTE Comparison Use to analyze the proposed budget for FTE compared to
last year actual, current year budget, year-to-date actual,
and current year projected by department.
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Report Description

Budget Key Statistics By Department Use to view highlighted key statistic trends across multiple
fiscal years.

Budget Per Unit Analysis Use to analyze per-unit amounts by comparing the current
year projection to next year’s budget for Patient Revenue,
Salaries, Supplies, and Other Expenses.

Budget Plan Questions Use to report on inputs from the Plan tab in plan files.

Budget Red Flag Analysis Use to review the comments and explanations for
accounts flagged in the budget plan files because they
exceeded the defined red-flag threshold. The report shows
year-to-date actual and current year projection compared
to the proposed budget request. The report also includes
fields for the adjustments and comments posted from the
budget workbook for each account.

Budget Salary Comparison Use to analyze salary variances for the proposed budget
compared to the current year projection. The report also
includes prior year and current year actual history to use
for comparison.

Budget Salary Rate Analysis Use to analyze departmental average hourly-rate variances
in the proposed budget. The report shows prior year and
current year actual history and projection compared to the
new budget. The variance is broken out into two different
categories—FTE and Rate Effect.

Budget Summary by Department Use to analyze total-expense variances by department,
comparing the proposed budget to the current-year
projection. The report shows prior-year actual, current-
year actual, and current-year budget history.

Budget Threshold Analysis Use to analyze account categories by applying a low and
high threshold for variances. Historical data for last-year
actual and current-year budget are also included.

Budget Workbook Changes for CYB
and NYB

Use to view highlighted areas where users made inputs in
the yellow cells in budget plan files.

� Budgeting Statement reports
The following reports are designed for budget analysis. For examples of these reports, see Statement
reports.
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Report Description

Budget Income Detail Use to analyze the proposed budget-by-income statement
category compared to last-year actual, current-year
budget, current-year projected, year-to-date actual, and
current-year annualized. Each category shows all values for
all accounts in that category.

Budget Income Financial Plan Use to view annuals income statement comparisons across
multiple scenarios.

Budget Income Scenarios Use to analyze the proposed budget by FSDetail category
compared to the Baseline Budget, NYBScenario1, and
NYBScenario2. BudScenario1 and BudScenario2 are fields
in the database used to store the results of different sets of
driver files. You can use this report to compare passes of
the budget (BudPass1, BudPass2).

Budget Income Summary Use to summarize the proposed budget by FSDetail
category compared to last-year actual, current-year
budget, current-year annualized, and current-year
projected.

Budget Monthly Dept P&L Use to review themonthly spread by account for the
proposed budget by Budget Type category for an
individual department. This report is often used to provide
the department manager with a final copy of their month-
by-month budget.

� Initiative Analysis reports
The following reports are designed for budget analysis of new initiatives. For examples of these reports,
see Initiative Analysis reports.

Report Description

Budget Income Summary-Initiative Use to review new initiatives by Income Statement
category.

Budget Income Summary-Initiative
Monthly

Use to review new initiatives by Income Statement
category by month.

Income Statement by Initiative ID Use to review new initiatives side-by-side for multiple
initiatives.

Initiative Summary Use to review new initiatives by department by category,
with monthly FTEs.
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� Payroll Analysis reports
The following reports are designed for payroll budget analysis. For examples of these reports, see Payroll
Analysis reports.

Report Description

FTE Additions and Changes by
JobCode

Use to review the FTE summary by department by
JobCode, highlighting changes made to the projected year
and budget in the plan files.

FTEs by Department Use to review the FTE summary by department, including
prior-year actual, current-year budget, and year-to-date
actual. The proposed budget is compared to year-to-date
actual as well as the current-year budget.

FTEs by Department by JobCode Use to review FTE report by department by job code,
including prior-year actual, current-year budget, and year-
to-date actual. The proposed budget is compared to year-
to-date actual as well as the current-year budget.

FTEs by JobCode Use to review the FTE report by job code, including prior-
year actual, current-year budget, and year-to-date actual.
The proposed budget is compared to year-to-date actual
as well as the current-year budget.

Monthly FICA by Department Use to showmonthly total FICA expense by department
for both current-year projected and next-year budget.
Monthly expense shows for next-year budget. Designed
for use by clients who budget FICA in a central department
or to review the overall monthly spread of FICA expense.

Monthly FTE Target Variance by
Department

Use to review a department summary of the FTE variance
by month for next year’s budget to the department target.

Monthly FTEs by Department Use to review a department summary of total FTEs by
month for next year’s budget. Designed to be used to
review themonthly spread of total FTEs as well as by
department.

NYB Hours and Dollars by Employee Use to review hours and dollars by employee, job code,
paytype, and department. To use this report, the
department must use the employee labor option in plan
files.

Worked Hours Per Unit by
Department by JobCode

Use to compare the projected and NY Budget by Provider
to the current year by selected DataType.
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� Provider Budget Analysis reports (optional feature)
The following reports are designed for physician analysis. For examples of these reports, see Running
Provider Budget Analysis reports.

NOTE: You can also find these same reports in the Financial Reporting section > Financial Reporting
> Provider Analysis.

Report Description

Current Period vs Previous
Comparison

Use to compare current period vs previous period
information by provider as well as last year actual. You can
select the data type to analyze in the report.

Current Period vs Previous
Comparison_CPT

Use to compare current period vs previous period
information by CPT or CPT Summary category and last
year actual. You can select the data type to analyze in the
report.

CY Actual vs Budget Comparison Use to compare current period and year-to-date actual vs
budget information by provider and last year actual. You
can select the data type to analyze in the report.

CY Actual vs Budget Comparison_CPT Use to compare current period and year-to-date actual vs
budget information by CPT or CPT Summary code and last
year actual. You can select the data type to analyze in the
report.

NY Budget Comparison Use to compare current year projections with next year's
budget.

NY Budget Comparison_CPT Use to compare current year projections with next year's
budget by CPT or CPT Summary category.

Provider Key Indicators By Month Use to comparemonth-by-month values for last year,
current year, and target by data type.

Provider Key Indicators By Month_
Rolling 12

Use to comparemonth-by-month values for themost
recent 12months by data type.

Provider Revenue Per Encounter Use to compare the current month to the prior three-
month average for different years for revenue per
encounter.

Provider Revenue Per RVU Use to compare the current month to the prior three-
month average for different years for revenue per RVU.

Provider Revenue PerWRVU Use to compare the current month to the prior three-
month average for different years for revenue perWRVU.
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Report Description

Provider Volume by Specialty Use to compare actual vs budget volume by data type for
the current period and year-to-date, subtotaled by
provider specialty.

Provider Volume by Specialty_
Monthly

Use to showmonthly totals by provider, for a chosen data
type and year, subtotaled by provider specialty.

Provider Compensation Benchmark Use to compare the proposed budget salary to a salary
target for each provider. The target is factored for the
budget FTE.

Provider Compensation Comparison Use to compare the calculated budget salary under each of
the available compensation methods, by provider, to
evaluate the cost ofmoving providers to another model or
standardizing the compensation model. There is also a
comparison of the current year vs proposed budget salary
cost per work RVU to test if the compensation is changing
+\- the Hold Harmless percentage.

� Provider Budget Compensation reports (optional feature)
The following reports are designed for payroll/provider budget analysis. For examples of these reports,
see .

Report Description

Provider Compensation Benchmark Use to compare the proposed budget salary to a salary
target for each provider. The target is factored for the
budget FTE.

Provider Compensation Comparison Use to compare the calculated budget salary under each of
the available compensation methods, by provider, to
evaluate the cost ofmoving providers to another model or
standardizing the compensation model.

Analysis reports
These reports are designed for budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Budget
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Budget Analysis.
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� Budget Income Detail
Use to analyze the proposed budget compared to last year actual, current year budget, and current year
projected for an individual account by department. Comments entered into the budget plan files also
show on the report to assist with the analysis.

� Budget FTE Comparison
Use to analyze the proposed budget for FTE compared to last year actual, current year budget, year-to-
date actual, and current year projected by department.
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� Budget Key Statistics By Department
Use to view highlighted key statistic trends across multiple fiscal years.

� Budget Per Unit Analysis
Use to analyze per-unit amounts by comparing the current year projection to next year’s budget for
Patient Revenue, Salaries, Supplies, and Other Expenses.
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� Budget Plan Questions
Use to report on inputs from the Plan tab in plan files.

� Budget Red Flag Analysis
Use to review the comments and explanations for accounts flagged in the budget plan files because they
exceeded the defined red-flag threshold. The report shows year-to-date actual and current year
projection compared to the proposed budget request. The report also includes fields for the
adjustments and comments posted from the budget workbook for each account.

� Budget Salary Comparison
Use to analyze salary variances for the proposed budget compared to the current year projection. The
report also includes prior year and current year actual history to use for comparison.
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� Budget Salary Rate Analysis
Use to analyze departmental average hourly-rate variances in the proposed budget. The report shows
prior year and current year actual history and projection compared to the new budget. The variance is
broken out into two different categories—FTE and Rate Effect.

� Budget Summary by Department
Use to analyze total-expense variances by department, comparing the proposed budget to the current-
year projection. The report shows prior-year actual, current-year actual, and current-year budget
history.
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� Budget Threshold Analysis
Use to analyze account categories by applying a low and high threshold for variances. Historical data for
last-year actual and current-year budget are also included.

� Budget Workbook Changes for CYB and NYB
Use to view highlighted areas where users made inputs in the yellow cells in budget plan files.
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Statement reports
These reports are designed for budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Budget
Statements. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Budget Statements.
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� Budget Income Detail
Use to analyze the proposed budget-by-income statement category compared to last-year actual,
current-year budget, current-year projected, year-to-date actual, and current-year annualized. Each
category shows all values for all accounts in that category.

� Budget Income Financial Plan
Use to view annuals income statement comparisons across multiple scenarios.

� Budget Income Scenarios
Use to analyze the proposed budget by FSDetail category compared to the Baseline Budget,
NYBScenario1, and NYBScenario2. BudScenario1 and BudScenario2 are fields in the database used to
store the results of different sets of driver files. You can use this report to compare passes of the budget
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(BudPass1, BudPass2).

� Budget Income Summary
Use to summarize the proposed budget by FSDetail category compared to last-year actual, current-year
budget, current-year annualized, and current-year projected.

� Budget Monthly Dept P&L
Use to review themonthly spread by account for the proposed budget by Budget Type category for an
individual department. This report is often used to provide the department manager with a final copy of
their month-by-month budget.
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Initiative Analysis reports
These reports are designed for budget analysis of new initiatives.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Initiatives
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Initiatives Analysis.

� Budget Income Summary - Initiative
Use to review new initiatives by Income Statement category.
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� Budget Income Summary - Initiative Monthly
Use to review new initiatives by Income Statement category by month.
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� Income Statement by Initiative ID
Use to review new initiatives side-by-side for multiple initiatives.
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� Initiative Summary
Use to review new initiatives by department by category, with monthly FTEs.

Initiative Analysis reports
These reports are designed for budget analysis of new initiatives.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Initiatives
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Initiatives Analysis.

� Budget Income Summary - Initiative
Use to review new initiatives by Income Statement category.
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� Budget Income Summary - Initiative Monthly
Use to review new initiatives by Income Statement category by month.
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� Income Statement by Initiative ID
Use to review new initiatives side-by-side for multiple initiatives.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 425



� Initiative Summary
Use to review new initiatives by department by category, with monthly FTEs.

Payroll Analysis reports
These reports are designed for payroll budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Payroll
Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Payroll Analysis.
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� FTE Additions and Changes by Jobcode
Use to review the FTE summary by department by JobCode, highlighting changes made to the projected
year and budget in the plan files.

� FTEs by Department
Use to review the FTE summary by department, including prior-year actual, current-year budget, and
year-to-date actual. The proposed budget is compared to year-to-date actual as well as the current-year
budget.
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� FTEs by Department by Jobcode
Use to review FTE report by department by job code, including prior-year actual, current-year budget,
and year-to-date actual. The proposed budget is compared to year-to-date actual as well as the current-
year budget.

� FTEs by Jobcode
Use to review the FTE report by job code, including prior-year actual, current-year budget, and year-to-
date actual. The proposed budget is compared to year-to-date actual as well as the current-year budget.

� Monthly FICA by Department
Use to showmonthly total FICA expense by department for both current-year projected and next-year
budget. Monthly expense shows for next-year budget. Designed for use by clients who budget FICA in a
central department or to review the overall monthly spread of FICA expense.
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� Monthly FTE Target Variance by Department
Use to review a department summary of the FTE variance by month for next year’s budget to the
department target.

� Monthly FTEs by Department
Use to review a department summary of total FTEs by month for next year’s budget. Designed to be
used to review themonthly spread of total FTEs as well as by department.
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� NYB Hours and Dollars by Employee
Use to review hours and dollars by employee, job code, pay type, and department. To use this report,
the department must use the employee labor option in plan files.

� Worked Hours Per Unit By Department by Jobcode
Use to compare the projected and NY Budget by Provider to the current year by selected DataType.
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Running Provider Budget Compensation reports
These reports are designed for payroll/provider budget analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Reports\Provider
Budget\Compensation.For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Analysis > Provider Budget > Compensation.

� Provider Compensation Benchmark
Use to compare the proposed budget salary to a salary target for each provider. The target is factored for
the budget FTE.
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� Provider Compensation Comparison
Use to compare the calculated budget salary under each of the available compensation methods, by
provider, to evaluate the cost ofmoving providers to another model or standardizing the compensation
model. There is also a comparison of the current year vs proposed budget salary cost per work RVU to
test if the compensation is changing +\- the Hold Harmless percentage.
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Budgeting utilities
Axiom Budgeting and Performance Reporting 2020.3 comes with a variety of standard budget utilites,
organized within the following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Balance Sheet and Deductions
The following utilities are designed for budget balance sheet calculation and deductions modeling to post
the results to the database. For examples of these reports, see Balance Sheet and Deductions utilities.

Report Description

Budget Balance Sheet and Cash Flow Use this save-to-database report to project the balance
sheet for the remainder of the current year and next year’s
budget by category.

Budget Deductions All statistics, revenues and deductions are broken out by
payer. You can make assumptions for the projection and
budget in each payer section.

NYB_Deductions_FSDetail Use this deductions model to project deductions using the
historical relationship to gross revenue for each deduction
category.

NYB_Deductions_FSPayor Use this deductions model to project deductions using the
historical relationship to gross revenue by payer.

� Budget Reconciliation utilities
The following utilities are designed for budget balance sheet calculation and deductions modeling to post
the results to the database. For examples of these reports, see Reconciliation utilities.

Report Description

Budget Department Audit Report Use to resolve possible mapping errors at the department
level by highlighting mapping and process management
inconsistencies in the DEPT dimension table before
building plan files and starting process management.

Budget Process Management Report Use to showwhat stage each budget plan file is in when
using process management for budget staging.
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Report Description

Budget Workbook Reconciliation Use to compare check totals from different columns in the
budget workbooks to the summary fields in the database
to make sure they are in balance. If the budgets are all in
balance, then this report returns no data, which is the
desired outcome of this report.

Global Depreciation Reconciliation
Report

Use to show the variance between the budgeted
depreciation accounts to the same accounts in the general
ledger budget for a user-specified budget year.

Global Expense Reconciliation Report Use to show the variance between the budgeted
depreciation accounts to the same accounts in the general
ledger budget for a user-specified budget year.

Global Revenue Reconciliation Report Use to show the variance between the budgeted global
revenue accounts to the same accounts in the general
ledger budget for a user-specified budget year.

Labor Non-Matched Use to identify the JobCode/PayType combinations that
have dollars but have no FTE hours for the year.

NewDepartment Utility Use to create default records for a new department. You
can save records to the Financial, Payroll, Provider, or
RevUsage tables.

Payroll12 Hours Reconciliation Use to highlight job codes saved in the Payroll12 data
source from the budget workbooks that have hours but
no dollars in the budget.

Payroll12 Negative Hours Use to highlight job codes and pay types that have any
negative FTEs budgeted in any month. The report returns
all job codes in the database, but only the ones with the
Review flag need to be investigated and changed, if
necessary.

PayTypeMapping Analysis Use during budget set up for payroll budgeting to show
what PayTypes map to which payroll budget category.

Reconcile NYBDetail to Financial Reconcile values saved in NYBDetail table to those values
saved in the Budget Table which could indicate that values
in your budget plan files are not saving properly.

Reconcile Payroll12 to Financial-
Dollars

Use to test the data transfer from the Labor tab to the
Expense tab in the budget workbook.

Reconcile Payroll12 to Financial-FICA Use to test the data transfer from the Labor tab to the
Expense tab in the budget workbook.
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Report Description

Reconcile Payroll12 to Financial-Hours Use to test the data transfer from the Labor tab to the
Expense tab in the budget workbook.

Salaries Do Not Match Use to identify accounts on the Labors tabs in the plan files
that do not have history on the Expense tab and would
cause a balancing mismatch.

� Budget Setup utilities
The following utility is designed to help set up security. For examples of these reports, see Setup utilities.

Report Description

PayrollGLMapping To allowmapping of GL accounts and Hours accounts
different from the Jobcode dimensions table or Paytype
dimensions table as a result of various combinations to
match GL accounts.

� Budget Extract from EPM utilities
The following utility is designed to extract budget data from the Axiom database. For examples of this
reports, see Extract from EPM utilities.

Report Description

PayrollGLMapping To allowmapping of GL accounts and Hours accounts
different from the Jobcode Dimensions Table or Paytype
Dimensions Table as a result of various combinations to
match GL accounts.

� Budget Provider Utilities - Reconciliation utilities
These utilities are designed to reconcile data to support physician analysis. For examples of these
reports, see Provider Reconciliation utilities.

Report Description

Matching Provider Dept Revenue to
Dept Salaries

Use to determine if there are situations where the provider
revenue and salaries do not match by department.

Matching Provider Revenue to
Salaries

Use to check the net difference between revenue and
salaries by provider.
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Report Description

ProviderComp JobCodes Use to compare the coding in global assumptions to the
information in the Payroll27 tables before creating budget
plan files.

Reconcile GL Revenue to Provider Use to reconcile the gross charges in the Financial data
source to the gross charges in the Provider data source for
both the current period as well as year-to-date.

Review Provider Data Use to identify situations where there is revenue without
matching volume in the historical data that is used for
projection and budget purposes.

� Budget Provider – Statistics utilities (optional feature)
This utility is designed to reconcile data to support physician analysis. For examples of this reports, see
Provider Statistics utilities.

Report Description

Summarize Provider Statistics to
Financial

Use this save-to-database report to summarize provider
data into monthly statistics to be used in Financial data
tables and reports.

� Budget Provider – System Setup utilities
This utility is designed to reconcile data to support physician analysis. For examples of this reports, see
Provider System Setup utilities.

Report Description

ProvBenchmark This table may be used for reports to compare provider
compensation to benchmarks.

� Budget Report Batch utilities
This utility is designed to run multiple reports together. For examples of this report, see Report Batch
utilities.

Report Description

Budget Reconciliation Reports Batch Use to run multiple budget reconciliation reports for
distribution.

� Budget Security utilities
This utility is designed to run multiple reports together. For examples of this report, see Security utilities.
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Report Description

Budget Driver Security Update Use to update the Driver security settings and filters for
Admin users who have access to update Driver files.

Budget Security Update Use to update security settings and filters for all users.

Balance Sheet and Deductions utilities
These reports are designed for budget balance sheet calculation and deductions modeling to post the
results to the database.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Balance
Sheet & Deductions. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, and click
Budget Utilities > Balance Sheet & Deductions.

� Budget Balance Sheet and Cash Flow
Use this save-to-database report to project the balance sheet for the remainder of the current year and
next year’s budget, by category.

The Budget Balance Sheet and Cash Flow utility allows you to project the remainder of the current year
and next year budget balance sheet and cash flow numbers. This utility integrates with the budgeted
income statement numbers and allows for frequent updates to the budgeted balance sheet and cash
flow numbers, if the income statement is updated. The utility’s results save back to the database and
then become available in the budget data tables and reports for budget analysis.
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Running the Budget Balance Sheet and Cash Flow utility
1. Open the report.

2. In the Refresh Variables dialog, do the following, and click OK:

l From the Select 'Yes' to add New Income to Fund Balance drop-down, select Yes orNo to
determine whether to add net income to the fund balance.

l To select the default departments, where you would like the budget balance sheet
numbers to be saved back to, click Choose Value, and select a department.

l In the Create a Save Tag Value box, type a save tag (max of 100 characters). This save tag
ensures that the data saving back to the database is saved with a save tag that is unique to
a specific entity/group that you may want to filter this report for. It also avoids having to
createmultiple Balance Sheet reports for different entities/groups.

3. After the report populates, do the following:

l At the top of the spreadsheet, make sure that the data in the Net Income rowmatches the
balance sheet to be prepared.

l Verify historical information for Two Years Ago, Last Year, and Current YTD all balance.

l In the header section, review to the Balance Check row to confirm that themodel is in
balance.
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TIP: If themodel appears to be out of balance, we recommend that you refresh the report and
verify that the Add Net Income to Fund Balance setting was configured properly per your
organization’s accounting practice.

4. In column AD, in the blue input cells, enter the default accounts numbers that you would like the
balance sheet numbers to save back to. For example, you may choose to save back the numbers
for Board Designated Investments and Other Assets to the same default asset account OR you
may choose to use accounts specific to each of these categories.

5. Complete the following sections of the utility, as needed:
l Balance Sheet Assumptions – Use this section to enter key balance sheet metrics to

calculate various balance sheet numbers. Values for balance sheet categories can be
adjusted or keyed in directly in the detailed schedules / inputs section.

l Assets
l Liabilities and Net Assets
l Detailed Schedules - Use this section to input detailed schedules for each category.
l Statement and Cash Flows

TIP: Enter inputs incrementally. For example, to change days in AR from 64 to 56, enter 8 and
not 56.

NOTE: The Budget Balance Sheet utility is configured to always stay in balance. As a result,
inputs/adjustments to Balance Sheet metrics will result in the out of balance difference being
plugged to either the other assets/other liabilities section.

6. To save your changes to the database, in theMain ribbon tab, click Save.

The Summary tab of the Budget Balance Sheet utility will populate with next year’s budgeted balance
sheet and cash flow numbers by month for budget analysis purposes.
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� Budget Deductions
This is a deductions modeling tool that is similar to the deductions modeling in Kaufman Hall Financial
Planning. All statistics, revenues and deductions are broken out by payer. You can make assumptions for
the projection and budget in each payer section. The resulting calculated values post to the database.
When using this model, do not create budget workbooks for your deduction department(s).

GL Accounts are summarized by balance sheet categories, and the resulting summary data can be posted
back to the database for both the Current Year Projection and Next Year Budget as well as inclusion in all
related Budget Analysis reports. If necessary, values for balance sheet categories can be adjusted or
keyed in directly.

As budgets and assumptions change, simply refresh data in the Budget Balance Sheet to update and
post newly computed balance sheet information for calculating metrics driven by income statement
parameters (assuming the balance sheet assumptions remain unchanged).

The Budget Balance Sheet report assigns GL accounts to balance sheet categories per the FSSummary,
FSDetail, and FPCode grouping columns in the ACCT dimension table.

The Balance Sheet and Cash Flow Report includes the following sections:

l Balance Sheet Assumptions – Key metrics used to drive various balance sheet calculations. Valid
entries are listed in the Balance Sheet Assumptions Inputs section.

l Assets
l Liabilities and Net Assets
l Detailed Schedules – Contains rows to input detailed schedules for each category.
l Statement of Cash Flows
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l Summary Income Statement

You can filter the report by Entity or group, as defined in dimensions by using the Quick Filter option in
theMain ribbon tab. You may make adjustments to the values in any blue cells in the report. After
making your changes, review the cash flow statement to make sure it balances to total cash and make
sure the summaries match your expectations on the summary tab.

To run the Budget Sheet and Cash Flow report:
1. In the Refresh Variables dialog, do the following, and click OK:

l From the Select 'Yes' to add New Income to Fund Balance drop-down, select Yes orNo to
determine whether to add net income to the fund balance.

l To select the default departments to include in the report, click Choose Value, select a
department, and click OK.

2. Add or enter information in the blue cell, as appropriate.

3. After the report populates, verify the following:
l At the top of the spreadsheet, make sure that the data in theNet Income rowmatches the

balance sheet to be prepared.
l Historical information for Two Years Ago, Last Year, and Current YTD all balance.
l In the header section, review to the Balance Check row to confirm that themodel is in

balance.

NOTE: If themodel appears to be out of balance, you might want to refresh the report
and verify that the Add Net Income to Fund Balance setting was configured properly
per your organization’s accounting practice

4. To save your changes back to the database, in theMain ribbon tab, click Save.

Balance Sheet assumption inputs

NOTE: Enter inputs incrementally. For example, to change days in AR from 64 to 56, enter 8 and not
56.
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Asset inputs (All inputs should be in whole dollars)

Cash and cash
equivalents

Computed through days of
operating cash

Short-term cash
investments

Input Schedule

Current assets limited as
to use

Input Schedule

Patient Accounts
Receivable

Computed from Gross A\R days in
gross patient receivables

Configurable sections are
netted from the total
calculation on the first row.

Physician Accounts
Receivable

Input Schedule

Allowance for
Uncollectibles

Calculated from Net A\R Days less
Gross receivables

Configurable sections are
netted from the total
calculation on the first row

Third Party Settlements Computed from 3rd Party days in
Net Patient Receivables

Configurable sections are
netted from the total
calculation on the first row.

Current Receivables Input Schedule

Supply Inventories, at
cost

Computed from Days in Supply
inventories

Configurable sections are
netted from the total
calculation on the first row.

Driven by total supplies expense
from the income statement

Prepaid Expenses Computed from Days in Prepaid
Expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Other Current Assets Input Schedule

Assets Limited as to use –
Trusteed Assets

Input Schedule

Assets Limited as to use –
Board Designated
Investments

Computed
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PPE – Land Input Schedule Net Capital Acquisitions

Revaluation amount

PPE – Property and
Equipment

Input Schedule Net Capital Acquisitions

+\- Revaluation amount

PPE – Accumulated
Depreciation

Input Schedule Depreciation Expense –
Automatic flow from Income
Statement

+\- Disposals

PPE – Construction in
Progress

Net Capital Acquisitions +\- Revaluation amount

Unamortized Financing
Fees

Input Schedule

Amortization of existing
fees

Input Schedule

Investment in
subsidiaries

Input Schedule

Notes Receivable Input Schedule

Other Long-Term Assets Input Schedule Liability Inputs (All inputs
should be in whole dollars)

Line of credit Calculated

Current maturity of long-
term debt

Input Schedule Est. current portion of long-
term debt

Adj of current portion of long-
term debt

Accounts Payable Computed from A\P days in other
expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Accrued Payroll Computed from Acc Payroll days in
salary expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement
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Accrued Expenses Computed from Accrued Exp days
in other expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Third Party Settlements Computed from 3rd party days in
other expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Other Accrued Liabilities Input Schedule

Other Long Term
Liabilities 1

Input Schedule

Other Long Term
Liabilities 2

Input Schedule

Long-Term Debt Input Schedule Net new loans

Regular principal payments

Equity inputs (All inputs should be in thousands)

Fund Balance Input Schedule Net Income – Computed and
included in projection if
Instructions tab diaplsy Yes to
include in Fund Balance. Net
Income is automatically added
to fund balance for budget.

Temporarily restricted
net assets

Input Schedule

Permanently restricted
net assets

Input Schedule

� NYB_Deductions_FSDetail
Use this deductions model to project deductions using the historical relationship to gross revenue for
each deduction category. This report summarizes categories using the Acct-FSDetail column in
dimensions. The resulting calculated values posts to the database. If you are using this model, do not
create budget workbooks for your deduction department(s).
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� NYB_Deductions_FSPayor
Use this deductions model to project deductions using the historical relationship to gross revenue by
payer. This report summarizes categories using the Acct-FSPayor column in dimensions. The resulting
calculated values post to the database. If you are using this model, do not create budget workbooks for
your deduction department(s).
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Reconciliation utilities
These utilities are designed for budget reconciliation to the database.

� Accessing these reports
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Budget
Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Budget Reconciliation.

� Budget Department Audit report
Use to resolve possible mapping errors at the department level by highlighting mapping and process
management inconsistencies in the DEPT dimension table before building plan files and starting process
management.
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� Budget Process Management report
Use to showwhat stage each budget plan file is in when using process management for budget staging.

� Budget Workbook Reconciliation
Use to compare check totals from different columns in the budget workbooks to the summary fields in
the database to make sure they are in balance. If the budgets are all in balance, then this report returns
no data, which is the desired outcome of this report.
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� Global Depreciation Reconciliation report
Use to show the variance between the budgeted depreciation accounts to the same accounts in the
general ledger budget for a user-specified budget year.

� Global Expense Reconciliation report
Use to show the variance between the budgeted depreciation accounts to the same accounts in the
general ledger budget for a user-specified budget year.
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� Global Revenue Reconciliation report
Use to show the variance between the budgeted global revenue accounts to the same accounts in the
general ledger budget for a user-specified budget year.

� Labor Non-Matched
Use to identify the JobCode/PayType combinations that have dollars but have no FTE hours for the year.
This causes a matching issue because to create a JobCode block on the labor tabs, that JobCode needs to
have YTD FTE related hours. This report identifies thosemismatches and posts a 1 to the NYBKHA field so
that the JobCode interfaces into that labor tab.
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� Payroll12 Hours Reconciliation
Use to highlight job codes saved in the Payroll12 data source from the budget workbooks that have
hours but no dollars in the budget.
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� Payroll12 Negative Hours
Use to highlight job codes and pay types that have any negative FTEs budgeted in any month. The report
returns all job codes in the database, but only the ones with the Review flag need to be investigated and
changed, if necessary.

� PayType Mapping Analysis
Use during budget set up for payroll budgeting to showwhat PayTypes map to which payroll budget
category.

NOTE: Prior to reviewing the report, your organization needs to load and reconcile the payroll data
as well as complete the Labor Configuration driver. To understand this report, the user needs to have
knowledge of the Labor Configuration Driver.

Running the PayType Mapping Analysis report
Use the following instructions to run and review the report.
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1. Open the report.

2. Press F9, and select the proper Refresh Variables to review based on organizational needs.

3. Review the following in the report:
l In the top section of the report, which provides an overall summary, ensure that all the pay

types are loaded and map to a specific grouping. The variance should be zero. If not, review
your PAYTYPE dimension table to see what pay type is not mapped.

l The remaining sections of the report correspond to the Labor Configuration driver set up
and how the pay types are grouped/mapped in the PAYTYPE dimension table. These
sections give you an overall summary of what pay types are grouped together, the overall
hours and dollars, the FTE status, as well as the GL accounts if the GL is structured by pay
type.

l Review the overall groupings to make sure they are grouped as expected. The bottom
section shows what is not interfaced or coming into the plan files. Confirm that these are
accurate prior to beginning the budget cycle. If you need to make changes, update the
PAYTYPE dimension table and rerun the report to review.

� Reconcile NYBDetail to Financial
Reconcile values saved in NYBDetail table to those values saved in the Budget Table which could indicate
that values in your budget plan files are not saving properly.

� Reconcile Payroll12 to Financial-Dollars
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the dollars saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Reconcile Payroll12 to Financial-FICA
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the FICA dollars saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Reconcile Payroll12 to Financial-Hours
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the hours saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Salaries Do Not Match
Use to identify accounts on the Labors tabs in the plan files that do not have history on the Expense tab
and would cause a balancing mismatch. This utility posts a 1 to the NYBKHA fields so those accounts
interface in the plan files.
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Setup utilities
These reports are designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Budget Set
Up. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Budget Setup.
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� PayrollGLMapping
To allowmapping of GL accounts and Hours accounts different from the Jobcode Dimensions Table or
Paytype Dimensions Table as a result of various combinations to match GL accounts.

Extract from EPM utilities
These reports are designed to extract budget data from the Axiom database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Extract from
EPM. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Extract from EPM.

� Budget Extract Utility
Use to extract budget data from Axiom EPM to upload into GL systems such as Meditech, for example.
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Provider Reconciliation utilities
These reports are designed Designed to reconcile data to support physician analysis.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Provider
Utilities\Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Provider Utilities > Reconciliation.
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� Matching Provider Dept Revenue to Dept Salaries
Use to determine if there are situations where the provider revenue and salaries do not match by
department.

� Matching Provider Revenue to Salaries
Use to check the net difference between revenue and salaries by provider.
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� ProviderComp JobCodes
Use to compare the coding in global assumptions to the information in the Payroll27 tables before
creating budget plan files.
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� Reconcile GL Revenue to Provider
Use to reconcile the gross charges in the Financial data source to the gross charges in the Provider data
source for both the current period as well as year-to-date.

� Review Provider Data
Use to identify situations where there is revenue without matching volume in the historical data that is
used for projection and budget purposes.
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Provider Statistics utilities
These reports are designed to reconcile data to support physician analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Provider
Utilities\Statistics. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Provider Utilities > Statistics.
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� Summarize Provider Statistics to Financial
Use this save-to-database report to summarize provider data into monthly statistics to be used in
Financial data tables and reports.

Provider System Setup utilities
This report is designed to reconcile data to support physician analysis.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Provider
Utilities\System Setup. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Provider Utilities > System Setup.
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� ProvBenchmark
This table may be used for reports to compare provider compensation to benchmarks.

Report Batch utilities
These utilities are designed for budget reconciliation to the database.

� Accessing these reports
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Report
Batches. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Report Batches.
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� Budget Reconciliation Reports Batch
Use to run multiple budget reconciliation reports for distribution.

Security utilities
These reports are designed for budget balance sheet calculation and deductions modeling to post the
results to the database.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Security. For
instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Security.
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� Budget Driver Security Update
Use to update the Driver security settings and filters for Admin users who have access to update driver
files.

� Budget Security Update
Use to update security settings and filters for all users.

Financial reports
Axiom Budgeting and Performance Reporting 2020.3 comes with a variety of standard financial reports,
organized within the following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Financial Analysis reports
The following reports allow you to view general budget data. For examples of these reports, see Analysis
reports.
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Report Description

Account Analysis Use to analyze the current month- and year-to-date
variances for an individual account by department.

Current Year Actual (CYA) Per Unit
Analysis

Use to analyze year-to-date (current) per-unit amounts for
Patient Revenue, Salaries, Supplies, and Other Expenses
compared to current-year budget (Budget).

Expense Summary by Department Use to analyze expense variances by department.

Key Dept Ratios Use to analyze current month and year-to-date salary
variances for an individual department. The salary variance
is broken into categories for Price, Volume, and Efficiency.
A summary section is also provided to show the
components of the total variance.

Labor Price, Volume, & Efficiency
Variances

Use to quickly analyze salaries to determine if the variances
are related to rate or volume.

Labor Summary by Department Use to analyze labor variances by department.

MultiYear Statistic Review Use to show key and non-key statistical accounts for the
current-year actual and budget, prior year, and two years
ago. You can run this report for a single department or
combined for multiple departments. If is often used to
confirm that the statistical basis across different years is
consistent.

Threshold Analysis Use to analyze current month values compared to the
average of the previous threemonth. You can enter a
dollar threshold. After the report is populated, you can
change the view to only show the departments that
exceed the threshold. The purpose of this report is to show
unusual activity or possible missing entries in the current
month.

� Financial Statement reports
The following reports are designed for month-end financial analysis. For examples of these reports, see
Running Financial Statement reports.

Report Description

Balance Sheet Use to review and analyze the Balance Sheet values by
FSDetail category across multiple years.

Balance Sheet and Cash Flow Use to review and analyze the Balance Sheet and Cash
Flow across multiple years.
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Report Description

Balance Sheet By Entity Use to show by entity for one fiscal year across the balance
sheet categories in FSDetail. You can update the report to
run for any fiscal year in the database.

Balance Sheet Detail Use to show the detail accounts within each balance sheet
category of FSDetail, showing last-year actual and current-
year actual.

Forecast Income Summary Use to show the Current Year Forecast by FSDetail
category compared to Current Year Budget and Current
Year Annualized.

Forecast Scenario Comparison Use to show the Current Year To Date, Current Year
Annualized compared to the Current Year Forecast and
Alternate Forecast.

Income Statement By Entity Use to show the Income Statement categories by entity for
the current fiscal year.

Income Statement Detail Use to show the detail accounts within each income
statement category of FSDetail showing current-year detail
and last-year actual.

Income Statement Multi-Year Use to review the Income Statement totals by FSDetail
category across multiple fiscal years.

Income Statement Projection Use to review the Income Statement totals by FSDetail
category by month. For the remaining months of the year,
it projects using the current-year budget or current-year
forecast, which you can then compare to the annual
budget.

Income Statement Summary Use to review the Income Statement totals by FSDetail
category for the current period and year-to-date compared
to budget and prior year.

Income Statement Summary-12
Month

Use to view the Income Statement totals by FSDetail
category, by month. You can also update the report to
process for any fiscal year in the database.

Income Statement Summary-Drill Use to view review the Income Statement totals by
FSDetail category for the current period and year-to-date
actual compared to budget and prior year. You can drill
down to the detail transactions for revenue, expense,
payroll data, or show a trend for each category.

Provider Income Statement Summary Use to show the Income Statement totals by FSProvider
category for the current period and year-to-date compared
to budget and prior year.
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� Payroll reports
The following reports are designed for bi-weekly payroll analysis. For examples of these reports, see
Payroll reports.

Report Description

Employee Roster Use to show employee-related information for a single
department by job code. This information is used for
budget-labor budgets.

Employee Roster – Position Control Use to show employee-related information by job code
and by employee.

Labor Distribution Use to show bi-weekly paid hours and dollars by job code,
employee, and pay category for a single pay period.

Labor Distribution Detail Use to show hours and dollars by a department, by job
code for multiple pay period, and by category of pay.

Overtime Alert Use to show highlights of overtime trends by pay period
and department.

Overtime Analysis Use to show overtime FTE-related hours by department
trended for multiple pay periods. This report is normally
processed by VP or Director.

� Provider Analysis reports (optional feature)
The following reports are designed for physician analysis.

NOTE: You can also find these same reports in the Budget Reporting section > Provider Budget >
Analysis.

For a description of each report, see Provider Budget reports.

� Report Packages
The following reports are designed for month-end or payroll electronic reporting.

Executive
For examples of these reports, see .
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Report Description

Budget Variance Rollup Use to show the current month and year-to-date Actual,
Flexible, or Fixed Budget and Prior Year values by category
in detail. This report can be processed at a rolled-up level
by Entity, VP, Director, and so on. You can use any
grouping column in dimensions for summarization.

Budget Variance Summary Use to show the expense, cost-per-unit of service, and
hours-per-unit of service variances for each department.
This report is typically run by VP to give them a summary
of the departments that have variances for the current
month.

Cover_Executive Use as the cover page for monthly Executive report
package. You can customize this report to meet your
reporting needs.

Dept Variance Rollup Use to show department variances over a chosen
threshold by category for revenue and expenses for the
current period and year-to-date. This report also contains
a monthly variance output and projection for the rest of
the fiscal year.

ExecutiveMonthly Package Use to speed up report processing and distribution by
running all of the individual executive reports and including
them in one report package.

Pay Summary by Department Use to show bi-weekly paid hours by department, by
payroll summary category trended over multiple pay
periods. This report is normally processed by VP but can
also be processed by Director, Division, and so on.

Statistic Variance Summary Use to show key statistics by department for the past four
months to show statistical trends and variances.

Top 10 Variances Use to show top and bottom ten department variances for
salaries, supplies, and other expenses.

Variance Overview Use to showmonthly variances by department, by
account that exceed the thresholds set by the system
administrator.

Manager
For examples of these reports, see.
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Report Description

AP Distribution Report (optional
feature)

Use to show themonthly Accounts Payable (AP) detail by
general ledger account by vendor, check number, and
check date.

AR Distribution Report (optional
feature)

Use to show themonthly Accrued Receipts (PO Received
Not Invoiced) detail by vendor, PO Number, line item
description, and receipt date subtotaled by general ledger
account.

Budget Variance By Department Use to show the current month and year-to-date actual,
which are then compared to the Flexible or Fixed Budget as
well as Prior Year values by category and in detail.

Cover_Manager Use to generate a cover page for monthly Manager report
package. You can customize this report to meet your
reporting needs.

Dept Monthly Package Use to run all of the individual manager reports and
distribute them in one report package

GL Distribution Report (optional
feature)

Use to show themonthly journal entry detail for each
general ledger account.

MM Distribution Report (optional
feature)

Use to show themonthly materials management issues,
including the location of issue, unit of issue, unit price,
quantity, and the amount subtotaled by general ledger
account.

Pay By Employee ID Use to show the biweekly paid hours by employee, by
payroll summary category trended over multiple pay
periods.

Pay By JobCode Use to show the biweekly paid hours by job code, by
payroll summary category trended over multiple pay
periods.

RU Report (optional feature) Use to show the current month and year-to-date Revenue
and Usage units and gross revenue by CDMCode. Units for
specific CDM can be RVUweighted to use for monthly
statistics summarization.

RU Report_Budget (optional feature) Use to show the current-month actual, budget, and year-
to-date Revenue and Usage units and gross revenue by
CDMCode. Units for specific CDM can be RVUweighted to
use for monthly statistics summarization.

Scorecard Use to show financial and ratio indicators for the chosen
department compared to budget and trend.
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Report Description

Variance Alert Use to show accounts that exceed variance thresholds for
themonth.

Package Utilities
For examples of these reports, see Report Packages - Utilities.

Report Description

Monthly All in One VP Package Use to automatically build a report packaging batch using
the database and dimensions. You may build a batch to
distribute reports based on a single dimension grouping by
another dimension grouping (For example, Dept by VP,
Manager by Director, etc.).

Monthly Manager Package Use to package and email monthly reporting packages to
managers. Each column in the report represents a
recipient, with the reports listed under each person as the
reports they receive in their monthly package.

Monthly VP Package Use to package and email monthly reporting packages to
VPs. Each column in the report represents a recipient, with
the reports listed under each person as the reports they
receive in their monthly package.

Analysis reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Analysis.
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� Account Analysis
Use to analyze the current month- and year-to-date variances for an individual account by department.

� Current Year Actual (CYA) Per Unit Analysis
Use to analyze year-to-date (current) per-unit amounts for Patient Revenue, Salaries, Supplies, and Other
Expenses compared to current-year budget (Budget).
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� Expense Summary by Department
Use to analyze expense variances by department.

� Key Dept Ratios
Use to analyze current month and year-to-date salary variances for an individual department. The salary
variance is broken into categories for Price, Volume, and Efficiency. A summary section is also provided
to show the components of the total variance.
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� Labor Price, Volume, and Efficiency Variances
Use to quickly analyze salaries to determine if the variances are related to rate or volume.

� Labor Summary by Department
Use to analyze labor variances by department.
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� MultiYear Statistic Review
Use to show key and non-key statistical accounts for the current-year actual and budget, prior year, and
two years ago. You can run this report for a single department or combined for multiple departments. If
is often used to confirm that the statistical basis across different years is consistent.

� Threshold Analysis
Use to analyze current month values compared to the average of the previous threemonth. You can
enter a dollar threshold. After the report is populated, you can change the view to only show the
departments that exceed the threshold. The purpose of this report is to show unusual activity or
possible missing entries in the current month.
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Balance Sheet and Cash Flow reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Balance Sheet & Cash Flow. For instructions, see Browsing the Report
Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Balance Sheet & Cash Flow.
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� Balance Sheet
Use to review and analyze the Balance Sheet values by FSDetail category across multiple years.

� Balance Sheet and Cash Flow
Use to review and analyze the Balance Sheet and Cash Flow across multiple year
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� Balance Sheet by Entity
Use to show by entity for one fiscal year across the balance sheet categories in FSDetail. You can update
the report to run for any fiscal year in the database.
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� Balance Sheet Detail
Use to show the detail accounts within each balance sheet category of FSDetail, showing last-year actual
and current-year actual.
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Reports in the Department Monthly Package
These reports are designed for month-end or payroll electronic reporting. For more information on
setting up and configuring this report package, see Configuring the Department Monthly Package report.

� AP Distribution Report (optional feature)
Use to show themonthly Accounts Payable (AP) detail by general ledger account by vendor, check
number, and check date.
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� AR Distribution Report (optional feature)
Use to show themonthly Accrued Receipts (PO Received Not Invoiced) detail by vendor, PO Number, line
item description, and receipt date subtotaled by general ledger account.

� Budget Variance By Department
Use to show the current month and year-to-date actual, which are then compared to the Flexible or Fixed
Budget as well as Prior Year values by category and in detail.

The Budget Variance by Department report also shows themonthly values by category and account. It
will fill in the remainder of the year with last year actual, current year budget, or forecast data to calculate
a year-end projection.
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� Cover_Manager
Use to generate a cover page for monthly Manager report package. You can customize this report to
meet your reporting needs.

� GL Distribution Report (optional feature)
Use to show themonthly journal entry detail for each general ledger account.
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� MM Distribution Report (optional feature)
Use to show themonthly materials management issues, including the location of issue, unit of issue, unit
price, quantity, and the amount subtotaled by general ledger account.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 484



� Pay By Employee ID
Use to show the biweekly paid hours by employee, by payroll summary category trended over multiple
pay periods.

� Pay By JobCode
Use to show the biweekly paid hours by job code, by payroll summary category trended over multiple
pay periods.

� RU Report (optional feature)
Use to show the current month and year-to-date Revenue and Usage units and gross revenue by
CDMCode. Units for specific CDM can be RVUweighted to use for monthly statistics summarization.
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� Scorecard
Use to show financial and ratio indicators for the chosen department compared to budget and trend.

� Variance Alert
Use to show accounts that exceed variance thresholds for themonth.
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Reports in the Executive Monthly Package
These reports are designed for month-end or payroll electronic reporting. For more information on
setting up and configuring this report package, see Configuring the ExecutiveMonthly Package report.

� Budget Variance Rollup
Use to show the current month and year-to-date Actual, Flexible, or Fixed Budget and Prior Year values
by category in detail. This report can be processed at a rolled-up level by Entity, VP, Director, and so on.
You can use any grouping column in dimensions for summarization.

The Budget Variance Rollup report also shows themonthly values by category and account. It will fill in
the remainder of the year with budget last year or forecast data to show a year end projection.
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� Budget Variance Summary
Use to show the expense, cost-per-unit of service, and hours-per-unit of service variances for each
department. This report is typically run by VP to give them a summary of the departments that have
variances for the current month.

� Cover_Executive
Use as the cover page for monthly Executive report package. You can customize this report to meet your
reporting needs.
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� Dept Variance Rollup
Use to show department variances over a chosen threshold by category for revenue and expenses for
the current period and year-to-date. This report also contains a monthly variance output and projection
for the rest of the fiscal year.

The Budget Variance Rollup report also shows themonthly values by category and account. It will fill in
the remainder of the year with budget last year or forecast data to show a year end projection.
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� Pay Summary by Department
Use to show bi-weekly paid hours by department, by payroll summary category trended over multiple
pay periods. This report is normally processed by VP but can also be processed by Director, Division, and
so on.

� Statistic Variance Summary
Use to show key statistics by department for the past four months to show statistical trends and
variances.
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� Top 10 Variances
Use to show top and bottom ten department variances for salaries, supplies, and other expenses.

� Variance Overview
Use to showmonthly variances by department, by account that exceed the thresholds set by the system
administrator.
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Income Statement reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Income Statement. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Income Statement.
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� Forecast Income Summary
Use to show the Current Year Forecast by FSDetail category compared to Current Year Budget and
Current Year Annualized.
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� Forecast Scenario Comparison
Use to show the Current Year To Date, Current Year Annualized compared to the Current Year Forecast
and Alternate Forecast.

� Income Statement By Entity
Use to show the Income Statement categories by entity for the current fiscal year.
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� Income Statement Detail
Use to show the detail accounts within each income statement category of FSDetail showing current-year
detail and last-year actual.
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� Income Statement Multi-Year
Use to review the Income Statement totals by FSDetail category across multiple fiscal years.

� Income Statement Projection
Use to review the Income Statement totals by FSDetail category by month. For the remaining months of
the year, it projects using the current-year budget or current-year forecast, which you can then compare
to the annual budget.
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� Income Statement Summary
Use to review the Income Statement totals by FSDetail category for the current period and year-to-date
compared to budget and prior year.

� Income Statement Summary-12 Month
Use to view the Income Statement totals by FSDetail category, by month. You can also update the report
to process for any fiscal year in the database.

� Income Statement Summary - Detail
Use to view review the Income Statement totals by FSDetail category for the current period and year-to-
date actual compared to budget and prior year. You can drill down to the detail transactions for revenue,
expense, payroll data, or show a trend for each category.
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Provider Income Statement reports
These reports are designed for month-end financial analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Provider. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Provider.
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� Provider Income Statement Summary
Use to show the Income Statement totals by FSProvider category for the current period and year-to-date
compared to budget and prior year.

Payroll reports
These reports are designed for bi-weekly payroll analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting\Payroll.
For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Payroll.
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� Employee Roster
Use to show employee-related information for a single department by job code. This information is used
for budget-labor budgets.

� Employee Roster - Position Control
Use to show employee-related information by job code and by employee.
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� Labor Distribution
Use to show bi-weekly paid hours and dollars by job code, employee, and pay category for a single pay
period.

� Labor Distribution Detail
Use to show hours and dollars by a department, by job code for multiple pay period, and by category of
pay.

� Overtime Alert
Use to show highlights of overtime trends by pay period and department.
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� Overtime Analysis
Use to show overtime FTE-related hours by department trended for multiple pay periods. This report is
normally processed by VP or Director.

Provider Analysis reports
These reports are designed for physician analysis.

NOTE: These reports are optional reports that you can purchase as an add on to your current
license.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Provider Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Provider Analysis.

� Current Period vs Previous Comparison
Use to compare current period vs previous period information by provider as well as last year actual. You
can select the data type to analyze in the report.
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� Current Period vs Previous Comparison_CPT
Use to compare current period vs previous period information by CPT or CPT Summary category and last
year actual. You can select the data type to analyze in the report.

� CY Actual vs Budget Comparison
Use to compare current period and year-to-date actual vs budget information by provider and last year
actual. You can select the data type to analyze in the report.
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� CY Actual vs Budget Comparison_CPT
Use to compare current period and year-to-date actual vs budget information by CPT or CPT Summary
code and last year actual. You can select the data type to analyze in the report.

� NY Budget Comparison
Use to compare current year projections with next year's budget.

� NY Budget Comparison_CPT
Use to compare current year projections with next year's budget by CPT or CPT Summary category.
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� Provider Key Indicators By Month
Use to comparemonth-by-month values for last year, current year, and target by data type.

� Provider Key Indicators By Month_Rolling 12
Use to comparemonth-by-month values for themost recent 12months by data type
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� Provider Practice Summary
Use to analyze by provider, by practice the worked vs target productivity by provider.

� Provider Productivity
Use to analyze by provider worked vs target productivity.
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� Provider Revenue Per Encounter
Use to compare the current month to the prior three-month average for different years for revenue per
encounter.

� Provider Revenue Per RVU
Use to compare the current month to the prior three-month average for different years for revenue per
RVU.
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� Provider Revenue Per WRVU
Use to compare the current month to the prior three-month average for different years for revenue per
WRVU.

� Provider Volume by Specialty
Use to compare actual vs budget volume by data type for the current period and year-to-date,
subtotaled by provider specialty.
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� Provider Volume by Specialty_Monthly
Use to showmonthly totals by provider, for a chosen data type and year, subtotaled by provider
specialty.

Report Packages - Utilities
These reports are designed for month-end or payroll electronic packaging for distribution.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting\Report
Packages\Package Utilities. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Report Packages > Package Utilities.
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� DeptMonthlyPackage_FileCollect
Use this utility to combine all of theMonthly Manager Package reports into one file, configure the file
source and output settings and delivery method (email and/or save as a file to a directory location) for
the . If sending the report by email, you can configure the email subject line and body text, the recipient
type, and file attachment options. For more information, see Processing and distributing the
Department Monthly Package report.

� ExecutiveMonthlyPackage_FileCollect
Use this utility to combine all of the ExecutiveMonthly Package reports into one file, configure the file
source and output settings and delivery method (email and/or save as a file to a directory location) for
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the . If sending the report by email, you can configure the email subject line and body text, the recipient
type, and file attachment options. For more information, see Processing and distributing the Executive
Monthly Package report .

Running the Revenue Usage - Budget report
This reports shows the current-month actual, budget, and year-to-date Revenue and Usage units and
gross revenue by CDMCode. Units for specific CDM can be RVUweighted to use for monthly statistics
summarization.

� Accessing this report
The report is located in \Axiom\Reports Library\Management Reporting\Report Packages\Manager.
For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Report Packages > Manager.
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Financial utilities
Axiom Budgeting and Performance Reporting 2020.3 comes with a variety of standard financial reports,
organized within the following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Financial Current Year Forecast – Forecast Adjustment utilities
These reports are designed to post calculated values to the database. For examples of these reports, see
Current Year Forecast – Forecast Adjustment Utilities.

Report Description

Dept Specific Forecast Adjustments This is a save-to-database report used to make
adjustments to the current-year forecast at a specific
department and account level.
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Report Description

Monthly Forecast Adjustments This is a save-to-database report used to make
adjustments to the current-year forecast at an income-
statement level.

� Current Year Forecast – Forecast Processing utilities
This report is designed to post calculated values to the database. For examples of these reports, see
Current Year Forecast – Forecast Processing Utilities.

Report Description

Monthly Forecast Utility Use to calculate and post a monthly forecast for the
remaining months of the fiscal year to the database using a
variety of forecast methods.

� Financial Data Audit
This report is designed to improve the quality of data. For examples of these reports, see Data Audit.

Report Description

Standard Data Assessment Use to improve the quality of your data, keep you
compliant with Kaufman Hall standards, and save time
preparing for monthly reporting and annual budgeting.

� Financial Data Input utilities
These reports are designed as save-to-database reports for statistics and contract labor hours. For
examples of these reports, see Data Input utilities.

Report Description

Input Biweekly Contract Labor Use as an input report for biweekly contract labor hours
data collection. You enter biweekly hours and then post
them to the database from this report.

Input Monthly Contract Labor Use as an input report for monthly contract labor hours
data collection. You enter monthly hours and then post
them to the database from this report.

Input Monthly Statistics Use to input monthly statistics data collection or
calculations. You enter themonthly statistics and then
post to the database from this report.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 514



� Financial Data Reconciliation utilities
These reports are designed for designed for month-end close analysis. For examples of these reports, see
Data Reconciliation utilities.

Report Description

Acct Standards Review Use this report to map standardized data for accounts in
your organization to KHA Standard Class codes.

BiWeekly Payroll Reconciliation report After the payroll file is loaded, run the Biweekly Payroll
Reconciliation report.

Consolidations and Eliminations This is a save to database report that allows you to input
eliminations for your Financial database.

Dept Standards Review Use this report to map standardized data for departments
in your organization to KHA Standard Class codes.

Entity Standards Review Use this report to map standardized data for entities in
your organization to KHA Standard Class codes.

Jobcode Standards Review Use this report to map standardized data for job codes in
your organization to KHA Standard Class codes.

Monthly RevUsage Reconciliation After all data is loaded, run theMonthly RevUsage
Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for
each month.

Paytype Standards Review Use this report to map standardized data for pay types in
your organization to KHA Standard Class codes.

Reconcile GL to GL Transactions
report

If you load subledger detail into Axiom, such as Accounts
Payable (AP), Accrued Receipts (AR), Materials
Management (MM) and Journal Entries (JE), we have a
reconciliation utility that ties the subledger data back to
the ledger data (ACT20XX). This report confirms that the
data loaded to the GL matches the data loaded to Journal
Entry (JE) detail.

Reconcile GL to Pay12 to Pay27 report Use this report to compare the Current Year Gross
Revenue in the Financial tables to the RevUsage tables.

Reconcile GL to Rev Usage report Use to reconcile GL revenue data in the Financial tables to
the Revenue and Usage data imported into the database
on a monthly and year-to-date basis.

� Financial Dimensions System Structure reports
These reports are designed to help you review and confirm that your dimensions coding is complete and
correct. For examples of these reports, see Dimensions System Structure reports.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 515



Report Description

System Structure Accounts Use to show the current mapping in the ACCT dimension
table.

System Structure Departments Use to show the current mapping in the DEPT dimension
table.

System Structure JobCodes Use to show the current mapping in the JOBCODE
dimension table.

System Structure PayTypes Use to show the current mapping in the PAYTYPE
dimension table.

� Financial Dimensions Flex Budget utilities
These reports are designed to help you review and confirm that your dimensions coding is complete and
correct. For examples of these reports, see Flex Budget utilities.

Report Description

FlexBudgetSetup Use configure options for the Flex Calculator utility.

FlexCalculator by Month Use this save-to-database report to post flexible budget
calculations to the database.

� Financial Payroll utilities
These utilities are designed to post calculated values to the database. For examples of these reports, see
Payroll utilities.

Report Description

BiWeekly To Monthly Use this utility to accrue for both hours and dollars from
your biweekly payroll load (Payroll26) into themonthly
data tables (Payroll12).

BiWeekly to Monthly with LY Use this utility to post accrued biweekly hours or dollars
from the Payroll27 tables to the Payroll12 tables.

Monthly to BiWeekly Use this utility to post reverse-accrued budgeted monthly
hours from the Payroll12 tables to biweekly amounts and
post them to the Payroll27 tables for labor or productivity
reporting.

Monthly to GL If payroll hours are not coming through your GL Import,
you can move your hours from the Payroll12 data tables
created from the previous process to your Financial tables
by running theMonthly to GL accrual utility.
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� Financial Report Batches
These reports are designed to process multiple reports for multiple outputs. For examples of these
reports, see Report Batches.

Report Description

Monthly All in One Executive
Reporting Batch

Use to run the ExecutiveMonthly Package report for
distribution.

Monthly All in OneManager
Reporting Batch

Use to run the Department Monthly Package report for
distribution.

Monthly Financial Statements Batch Use to run themonthly Financial Statements for
distribution.

Monthly Hours Accrual Batch Use to run themonthly the Hours accrual reports.

� Financial RevUsage utilities
These reports are designed to process multiple reports for multiple outputs. For examples of these
reports, see RevUsage utilities.

Report Description

Summarize CDM Statistics (optional
feature)

Use to summarize CDM values to department-level
statistics and post them to the Financial database to use as
key statistics for monthly reporting as well as budgeting.

� Financial Security Setup utilities
These reports are designed to manage user roles and permissions. For examples of these reports, see
System Setup utilities.

Report Description

Performance Reporting Security
Update

Use to configure security.

� Financial Statistic Transfer utilities
These reports are designed as save-to-database reports for statistics. For examples of these reports, see
Statistic Transfer utilities.
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Report Description

Transfer Key Stats from Fin to PR12 Use this save-to-database report to transfer statistics from
the Financial tables to the Payroll12 tables at the end of
the budget process.

Transfer Key Stats for Fin to PR26 Use this save-to-database report to transfer statistics from
the Financial tables to the Payroll27 tables at the end of
the budget process.

� Financial System Setup utilities
These reports are designed as utility reports to help you set up the system. For examples of these
reports, see System Setup utilities.

Report Description

Benchmark Used as factors in productivity reports.

CalDate Update Utility Use as a utility to help you fill out the necessary columns in
the CALDATE dimensions table. Only needed if licensed for
Daily Productivity.

FP Payor Use to assign the payors for use in the Axiom Financial
Planning product.

Names Use this table in reports or FileCollect process to look up
email, names, titles, and login information.

Payroll_Dates Used in reports to look up the pay period end date and
pay date for current year and last year. There are two
sections if your organization uses two pay cycles.

VCC_Payroll_Mapping Used by Variance Comments and other payroll utilities to
map GL accounts to job codes and/or pay types.

VCC_Threshold Used to set configure howmuch an account can vary from
budget before department managers are required to enter
comments explaining the variance

YearPeriod Used in configure the first year and month of the fiscal
year, number of work days in the current, last, and next
year, and the standard FTE hours worked by employees in
a year.

Current Year Forecast – Forecast Adjustment Utilities
These reports are designed to post calculated values to the database.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Current Year Forecast\Forecast Adjustments. For instructions, see Browsing the Report
Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Current Year Forecast > Forecast Adjustments.

� Dept Specific Forecast Adjustments
This is a save-to-database report used to make adjustments to the current-year forecast at a specific
department and account level.
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� Monthly Forecast Adjustments
This is a save-to-database report used to make adjustments to the current-year forecast at an income-
statement level.

Current Year Forecast – Forecast Processing Utilities
This report is designed to post calculated values to the database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Current Year Forecast\Forecast Processing. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Current Year Forecast > Forecast Processing.
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� Monthly Forecast Utility
This is a save-to-database report used to calculate and post a monthly forecast for the remaining months
of the fiscal year to the database using a variety of forecast methods.

Data Audit
This report is designed to improve the quality of data.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
ReportingUtilities\Data Audit. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Data Audit.

� Standard Data Assessment
Use to improve the quality of your data, keep you compliant with Kaufman Hall standards, and save time
preparing for monthly reporting and annual budgeting. For more information, see Standardizing data.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 522



Data Input utilities
These reports are designed as save-to-database reports for statistics and contract labor hours.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
ReportingUtilities\Data Input. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Data Input.

� Input Biweekly Contract Labor
Use as an input report for biweekly contract labor hours data collection. You enter biweekly hours and
then post them to the database from this report.
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� Input Monthly Contract Labor
Use as an input report for monthly contract labor hours data collection. You enter monthly hours and
then post them to the database from this report.

� Input Monthly Statistics
Use to input monthly statistics data collection or calculations. You enter themonthly statistics and then
post to the database from this report. In some cases, theremay be an import for statistics that already
loads statistics on a monthly basis. You can use this report as a replacement for an import or in addition
to the statistics import.
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Data Reconciliation utilities
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Data Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Data Reconciliation.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 525



� Acct Standards Review
Use this report to map standardized data for accounts in your organization to KHA Standard Class codes.
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� BiWeekly Payroll Reconciliation report
After the payroll file is loaded, run the Biweekly Payroll Reconciliation report.

Using the loaded import file, total the dollars and hours from the import file, and enter the totals into the
BiWeekly Payroll Reconciliation report to see if your check totals from your import file match what was
loaded in to Axiom.

If your dollars and hours for the loaded period matches the Grand Total, the data is reconciled, and you
can move on to either loading another payroll for the current month or running the Payroll Accrual utility
to accrue your biweekly payroll to a monthly payroll.

� Consolidations and Eliminations
This is a save to database report that allows you to input eliminations for your Financial database.
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� Dept Standards Review
Use this report to map standardized data for departments in your organization to KHA Standard Class
codes.

� Entity Standards Review
Use this report to map standardized data for entities in your organization to KHA Standard Class codes.

� Jobcode Standards Review
Use this report to map standardized data for job codes in your organization to KHA Standard Class
codes.
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� Monthly RevUsage Reconciliation
After all data is loaded, run theMonthly RevUsage Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for each month.

Using the import file that was loaded, total the Volumes and Revenue dollars from the import file, and
key the totals into theMonthly RevUsage Reconciliation report to see if your check totals from your
import file match what was loaded in to Axiom.

If your dollars and volumes for the period loaded matches the Grand Total, the data is reconciled. If you
use RevUsage volumes to calculate statistics for productivity, you can move forward to summarize your
IP\OP volumes from your RevUsage data table (ACT_RU_20XX) to your Financial data table (ACT20XX)
using the Summarize CDM Statistics utility.

� Paytype Standards Review
Use this report to map standardized data for pay types in your organization to KHA Standard Class
codes.
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� Reconcile GL to GLTransactions report
If you load subledger detail into Axiom, such as Accounts Payable (AP), Accrued Receipts (AR), Materials
Management (MM) and Journal Entries (JE), we have a reconciliation utility that ties the subledger data
back to the ledger data (ACT20XX). This report confirms that the data loaded to the GL matches the data
loaded to Journal Entry (JE) detail. It also compares the JE Detail to AP, MM, AR transactions to make
sure the data is in balance.

TIP: Your Kaufman Hall Implementation Consultant will help you set up this report during
implementation.

NOTE: Use the Reconcile GL to RevUsage report to reconcile your chargemaster data for Inpatient
and Outpatient between the Financial data source (ACT20XX) and the RevUsage data set (ACT_RU_
20XX). Manual adjusting journal entries outside of the source system will cause reconciling variances
to the General Ledger RevUsage data so do not use this report regularly. The report is located in the
Reports Library in theManagement Reporting Utilities > Data Reconciliation folder.

� Reconcile GL to Pay12 to Pay27 report
Use this report to compare the Current Year Gross Revenue in the Financial tables to the RevUsage
tables.
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� Reconcile GL to Rev Usage report
Use to reconcile GL revenue data in the Financial tables to the Revenue and Usage data imported into the
database on a monthly and year-to-date basis. The desired result for this report is to show a zero
variance.

Dimensions System Structure reports
These reports are designed to help you review and confirm that your dimensions coding is complete and
correct.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Dimension System Structure Reports. For instructions, see Browsing the Report Library.
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You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Dimension System Structure Reports.

� System Structure Accounts
Use to show the current mapping in the ACCT dimension table.
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� System Structure Departments
Use to show the current mapping in the DEPT dimension table.

� System Structure JobCodes
Use to show the current mapping in the JOBCODE dimension table.

� System Structure PayTypes
Use to show the current mapping in the PAYTYPE dimension table.
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Dimension Update utilities
These reports are designed to help you update dimension table coding.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Dimension Update Utilities. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Dimension Update Utilities.
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� Update DIM - CALDATE
Use to update the CDM dimension table.

� Update DIM - GLPERIOD
Use to update the GLPERIOD dimension table.
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� Update DIM - INITIATIVEID
Use to update the INITIATIVEID dimension table.

Flex Budget utilities
These reports are designed to post calculated values to the database.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 536



� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Flex Budget. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Flex Budget.

� Flex Budget Setup
Use configure options for the Flex Calculator utility.
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� FlexCalculator by Month
Use this save-to-database report to post flexible budget calculations to the database. The calculations are
based upon default assignments in the department and account dimensions as well as exceptions that
can be defined in custom tables.

Payroll utilities
These utilities are designed to post calculated values to the database.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Payroll. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Payroll.

� BiWeekly to Monthly
Use this utility to accrue for both hours and dollars from your biweekly payroll load (Payroll26) into the
monthly data tables (Payroll12).

Depending on howmany years of biweekly payroll data are stored in your Axiom system, you have two
utility options:

l Biweekly to Monthly – Your organization is in their first year in Axiom and have no prior year
payroll data utilize this utility.

l Biweekly to Monthly with LY – Your organization has more than one year of historical payroll
data to capture the days of the year-end biweekly payroll that may cross over their fiscal year
utilize this utility.

In the Refresh Variables dialog, select from the following drop-downs options, and click OK:
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Option Description

Choose Year (Current Year
or Last Year

Depending on what biweekly payrolls you want to accrue, select CYA
(Current Year) or LYA (Last Year) .

Choose Payroll Sequence
(Hours, Dllrs, Stats)

Select Hours or Dllrs.

NOTE: These need to be run individually so once you run one (Hours)
you will have to then run the other (Dllrs).

Post results to the
database?

To post the results to the Axiom database, select Yes; otherwise,
select No.

TIP: Ensure that the number of FY days in First Pay Period are correct. If they are not, review the pay
period dates on the Custom Tables > Payroll tab.

In the File Processing task pane, click Process file multipass to run the utility by department and post
the values to the database. Repeat this step for the Hours by refreshing the report variables, select Hours
from the refresh variable, and then Process File multipass. If you also load statistics into you biweekly
payroll tables, you can also run this utility to move the statistics to your financial data source.
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� BiWeekly to Monthly with LY
Use this utility to post accrued biweekly hours or dollars from the Payroll27 tables to the Payroll12 tables.
The first period of the year is calculated using the final LY pay period.

� Monthly to BiWeekly
Use this utility to post reverse-accrued budgeted monthly hours from the Payroll12 tables to biweekly
amounts and post them to the Payroll27 tables for labor or productivity reporting.
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� Monthly to GL
If payroll hours are not coming through your GL Import, you can move your hours from the Payroll12
data tables created from the previous process to your Financial tables by running theMonthly to GL
accrual utility.

IMPORTANT: Only run this utility if you are not loading hours from your GL via the GL12Month or
Monthly Statistics imports.
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NOTE: Use theMonthly to BiWeekly utility to take budgeted Payroll12 data and reverse accrue it to a
biweekly data set.

Report Batches
These reports are designed to process multiple reports for multiple outputs.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Report Batches. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Report Batches.

� Monthly All in One Executive Reporting Batch
Use to run the ExecutiveMonthly Package report for distribution.
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� Monthly All in One Manager Reporting Batch
Use to run the Department Monthly Package report for distribution.

� Monthly Financial Statements Batch
Use to run themonthly Financial Statements for distribution.

� Monthly Hours Accrual Batch
Use to run themonthly the Hours accrual reports.

RevUsage utilities
This report is designed to calculate and post values to the database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\RevUsage. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > RevUsage.
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� Summarize CDM Statistics (optional feature)
Use to summarize CDM values to department-level statistics and post them to the Financial database to
use as key statistics for monthly reporting as well as budgeting.

Security Setup utilities
These reports are designed to manage user roles and permissions.
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� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Security Setup. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Security Setup.

� Performance Reporting Security Update
Use to configure security.
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Statistic Transfer utilities
These reports are designed as save-to-database reports for statistics.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Statistic Transfers. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Statistic Transfers.

� Transfer Key Stats from Fin to PR12
Use this save-to-database report to transfer statistics from the Financial tables to the Payroll12 tables at
the end of the budget process. The statistics can then be used once they are reverse accrued into
biweekly periods for biweekly productivity.
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� Transfer Key Stats from Fin to PR26
Use this save-to-database report to transfer statistics from the Financial tables to the Payroll27 tables at
the end of the budget process. The statistics can then be used once they are reverse accrued into
biweekly periods for biweekly productivity.

System Setup utilities
These reports are designed as utility reports to help you set up the system.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\System Setup. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > System Setup.
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� Benchmark
Used as factors in productivity reports.
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� CalDate Update Utility
Use as a utility to help you fill out the necessary columns in the CALDATE dimensions table. Only needed
if licensed for Daily Productivity.

� FP Payor
Use to assign the payors for use in the Axiom Financial Planning product.
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� Names
Use this table in reports or FileCollect process to look up email, names, titles, and login information.

� Payroll_Dates
Used in reports to look up the pay period end date and pay date for current year and last year. There are
two sections if your organization uses two pay cycles.
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� VCC_Payroll_Mapping
Used by Variance Comments and other payroll utilities to map GL accounts to job codes and/or pay
types.

� VCC_Threshold
Used to set configure howmuch an account can vary from budget before department managers are
required to enter comments explaining the variance

� YearPeriod
Used in configure the first year and month of the fiscal year, number of work days in the current, last,
and next year, and the standard FTE hours worked by employees in a year.
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Browsing the Report Library
In addition to browsing the report folders in the Axiom Budgeting and Performance Reporting task
panes, you can search all of the available Axiom reports in the Reports Library.

To browse the Report Library:
1. In theMain ribbon tab, in the Reports group, click Reports > Browse All Reports.

2. In the Reports Library dialog, you can do the following:
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l To sort, group, or search by any of the columns, click the drop-down arrow next to the
column label.

l To open a report, select it from the list, and click OK.

The system includes many different reports, but you can search through them more easily by using the
following search functionality:

1. Click the down arrow beside theDocument Name column header.
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2. In theGroup By box, type a search value, and click OK.

The system will display the reports that include the value you entered in the report name.

Navigating reports
Apart from each report having an Instructions tab, Axiom Software report files do not have a standard
structure. Each report can have any number of sheets, layouts, custom views, drill-downs, GoTo targets,
quick filters, and associated task panes—all configured for the specific information that displays.

Although not all of these features are available for every report, here is an overview of common report
features:

� Instruction tab
Each report has an Instructions tab that provides an overview of its specific business purpose, features,
and steps for processing the report.

� Custom views
Custom views allow for different presentations of data within a report. For instance, a report might
default to showing monthly data but have custom views defined for displaying data by quarter or year.

NOTE: Not all reports have custom views defined.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 555



If custom views have been defined within a report, you can access them by doing the following:

1. In theMain ribbon tab, in theWorkbook Options group, click Change View.

2. From themenu, select the view to use.

� Quick Filter
AQuick Filter is a temporary report filter. This allows you to quickly view the data at a different level of
detail, without needing to alter the report configuration. For more information, see the following:

l Applying a Quick Filter to a report
l Using the Advanced Filter Wizard
l Understanding hierarchy-based Quick Filters

� Drills
Some reports contain rows (or columns) where the data represents a roll-up of values for multiple
database records. For instance, an income summary report might combine patient revenue for all
departments into a single total for the year, or a report on payroll by department might roll up both
regular and non-productive hours into a combined number of hours for each department. In such cases,
you can use drills to view the individual values for each item included in the roll-up.

To drill in a report, do the following:

1. In the report spreadsheet, select a cell.

2. In theMain ribbon tab, in theWorkbook Options group, click Drill.

3. From the drop-down, select any of the available drills to view a breakdown by that dimension or
value.

A new spreadsheet opens to display data at the specified drill-down level.
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NOTE: While we havemade an effort to deactivate any drill options that do not apply to a particular
row/column/cell, there are simply too many possibilities for us to deactivate every invalid drilling
method for every cell in every report. As a result, certain drill methods may produce strange results.
For themost part, common sense should imply which dimensions or values you can drill for a given
roll-up (for example, drilling by Vice President on a single department might result in a report with a
single record, as a department typically has one VP assigned to it).

� GoTo targets
GoTo targets are simply bookmarks that allow you to jump to different sections of a report. Not all
reports include GoTo targets. To navigate to a target, do the following:

1. In theMain ribbon tab, in theWorkbook Options group, click GoTo.

2. From themenu, select the GoTo target.

Refreshing a report with data
To update a report with themost current data from the database, refresh the file. A refresh does the
following:

l Updates active Axiom queries with data, according to the update settings defined for the query.
l Updates Axiom functions with data.
l Performs an Excel calculation.
l Reapplies the currently active views (if applicable).

To refresh a report with data:
Do one of the following:

l On theMain ribbon tab, in theWorkbook Options group, click Refresh Data.

l Press F9.
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The system may prompt you to define values before the refresh occurs. If so, the system applies these
values to the report to affect the data refresh.

Saving a report
When you save a report, the report file is updated in the Axiom Budgeting and Performance Reporting
file system. If the report is configured to save data to the database, a save-to-database also occurs.

To save a report:
l On theMain ribbon tab, in the File Options group, click Save.

Your file permission settings in Security determine whether you can save a particular report. If a report is
open with read/write permissions, then you can save it.

If a report is open with read-only permissions, then clicking Save opens the Save As dialog. You can save
a copy of the report to any Reports Library folder location where you have read/write permissions, or to
your My Documents folder (if applicable). A lock icon displays next to folders where you do not have
read/write permissions to any folder in that folder tree.

If you do not have read/write permissions to any folder, then when you click Save you are informed that
you cannot save the file anywhere inside the Axiom file system. Alternatively, you can save a snapshot
copy of the file, or save a copy locally using Save As (Local).

Note the following:

l Some files may use a Control Sheet setting that causes the data in Axiom functions to zero when
the file is saved. This is a security precaution that is normally enabled in reports only. You can click
Refresh to restore the data.

l You may have non-managed report files that are saved on your local computer or a network file
share. The Save option also updates these files. However, a save-to-database cannot be
performed on non-managed files.

Applying a Quick Filter to a report
Using the Quick Filter feature, you can apply a temporary filter to a report. This allows you to quickly view
the data at a different level of detail, without needing to alter the report configuration.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 558



For example, you may be viewing an Income Statement report for the entire consolidated organization,
and you want to view the same report at a different level of detail, such as for just North America or just
the South region. You can use the Quick Filter to recalculate the report at the desired level of detail, and
then clear the filter when you are done.

The Quick Filter is combined with your table security filters and any filters that are currently defined in
the report, such as sheet filters and filters defined for Axiom queries.

NOTE: You can also use the Quick Filter feature on file group utilities and drivers.

To apply a Quick Filter to a report:
1. On theMain ribbon tab, in theWorkbook Options group, click Quick Filter.

2. At the top of the dialog, specify how the filter should be applied:
l Workbook (default): The Quick Filter is applied to all sheets in the workbook.
l Active Sheet: The Quick Filter is only applied to the currently active sheet.
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This selection may determine which hierarchies and tables are available in the dialog to build the
filter. For more information, see Hierarchy and table availability in the Quick Filter dialog.

3. In theQuick Filter dialog, define a filter using one of the following methods:

l Data Hierarchies: Select the desired hierarchy level(s) from the hierarchies listed in the
dialog. As you select items in the hierarchy, the corresponding filter is automatically built in
the Filter box.

For example, you might have a hierarchy named Geography, which has local regions rolling
up into countries, and countries rolling up into world regions. You can select the desired
items that you want to see in the report, such as Europe, Asia, or North America as world
regions. For more information and examples, see Understanding hierarchy-based Quick
Filters.

l Manual Filter: You can manually type a filter into the Filter box using standard filter criteria
statement syntax. Fully qualified Table.Column syntaxmust be used.

l Advanced Filter: Click Advanced Filter to create a filter using any reference table columns
(not just hierarchy columns).

Administrator's Guide Axiom Budgeting and Performance Reporting │ 560



For more information about general filter settings in this dialog, see Using the Filter Wizard.

NOTE: If the data in the report comes from tables that usemultiple-level hookups, then using
a hierarchy to apply a Quick Filter may not result in the intended data. Instead, you should
use the Advanced Filter to build up the filter using the appropriatemultiple-level syntax.

4. Click OK.

If the Quick Filter is applied to the entire workbook, a warning message informs you that the
entire workbook will be refreshed. If you do not want to see this message again in the future,
select Don't show this message again. Click OK to continue.

� Clearing the Quick Filter
After you have applied a Quick Filter to a report, the filter remains applied until one of the following
occurs:

l The file is closed. Quick Filters cannot be saved in the file and are always cleared when the file is
closed.
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l A newQuick Filter is applied by using theQuick Filter button and selecting a different filter.
l The Quick Filter is manually cleared. To clear the Quick Filter, click theQuick Filter button again

and then click Clear Filter.

� Hierarchy and table availability in the Quick Filter dialog
The hierarchies and tables shown in the Quick Filter dialog are based on the Axiom queries in the report.
Axiom Budgeting and Performance Reporting looks up the primary tables for the queries, and only
shows the hierarchies and reference tables that are relevant to those primary tables. This is done to help
ensure that the Quick Filter will be applicable to at least one query in the report.

If the filter applies to the entire workbook, then Axiom Budgeting and Performance Reporting looks at
the primary tables for all Axiom queries in the workbook. If the filter applies to the active sheet only, then
Axiom Budgeting and Performance Reporting looks at only the primary tables for the Axiom queries
defined on the active sheet.

NOTE: In the Advanced Filter view, only reference tables are shown unless the primary table has
potentially ambiguous lookup relationships. In that case, the primary data table is also shown so
that the selections can bemade directly on these lookup relationships, to avoid any ambiguity. For
example, if the primary data table has columns PrimaryPhysician and SecondaryPhysician that both
look up to Physician.Physician, then the selection must bemade through the primary data table so
that the correct path to Physician.Physician is used.

If the report uses GetData functions instead of an Axiom query, then all hierarchies and reference tables
are listed in the dialog because Axiom Budgeting and Performance Reporting cannot determine the
primary table in this context. In this case, it is possible to define a Quick Filter that does not apply to any
GetData functions in the workbook. If this occurs, the filter will simply have no effect.

Understanding hierarchy-based Quick Filters
When you use hierarchies to create a Quick Filter, Axiom Budgeting and Performance Reporting
automatically creates the filter based on your selections. When only one item is selected, the filter is
simple—only data that matches the selected item is included. For example, if you select Asia from a
Geography hierarchy, you will get a filter something like: Dept.WorldRegion='Asia', as shown in the
following example:
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NOTE: Sometimes when you select a single child item underneath a parent item, the child and parent
are joined with AND. For example: DEPT.VP='Jones' AND DEPT.Manager='Smith'. This means
that the DEPT table has other instances ofManager Smith that belong to different VPs, so the
compound statement ensures that you only get the data whereManager Smith is under VP Jones.
(You can manually edit the filter to remove the Jones portion of the statement to see all of the data
for Manager Smith, regardless of VP). If instead Axiom Budgeting and Performance Reporting
constructs the filter as just Dept.Manager='Smith', that means all instances ofManager Smith
are also under VP Jones.

You can select multiple items in the same hierarchy or from different hierarchies. Items from the same
hierarchy are combined using OR, which means data matching any of the selected items is included.
Items from different hierarchies are combined using AND, which means only data that matches both
selected items is included. In the following example, we selected two items from the same grouping level
in a single hierarchy, so a simple filter criteria statement is created using IN. The resulting filter includes all
of the data from Asia and Europe.
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Next, we selected two items from different grouping levels, but within the same hierarchy. In this case, a
compound filter criteria statement is created using OR. The resulting filter includes all of the data that
belongs to Italy or US East.
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Finally, we selected two items from different hierarchies, so a compound filter criteria statement is
created using AND. The resulting filter includes only data that belongs to both US East and VP Jason
Guppy.
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Creating a new report
You can create a new report if you have read/write access to at least one folder in the Reports Library.
You can use any of themethods discussed below to create a new report. If you do not have these
permissions, then the associated menu options for creating new reports will not be available to you.

NOTE: After saving a new report to the Axiom file system, you may not see that new report displayed
in Axiom Explorer or the Reports menu until the file system has been refreshed. You can go to
Reports > Refresh file system to manually trigger a refresh and cause the new report to display.
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� Creating a new report using the Report Wizard
You can create a new report using the Report Wizard. In the wizard, you make selections regarding the
type of report that you want to create and the desired data, and then the wizard creates a report based
on your choices. You can then further modify the report as needed. For more information, see About the
Report Wizard in Help (Main ribbon tab >Help).

To create a new report using the Report Wizard:
l On theMain ribbon tab, in the Reports group, select Reports > Design Reports > Report Wizard.

� Creating a new blank report
You can create a new report from scratch using the default blank report template. This template is
entirely free-format.

If your organization has saved additional report templates, you can use those to create a new report as
well. Only administrators can create new report templates.

To create a new blank report:
l On theMain ribbon tab, in the Reports group, select Reports > Design Reports > New Report.

If your system has multiple report templates, you can select the template to use from this menu.
Otherwise, the default ReportTemplate is automatically used.

You can now use Axiom file functionality on this sheet, such as using Axiom queries to bring in data. For
more details on setting up Axiom files, see Axiom file setup in Help (Main ribbon tab >Help).

� Saving a new report
To save a new report, in the File Options group of theMain ribbon tab, click Save. When you save the
new report for the first time, you are prompted to define a file name and select a folder location in the
Reports Library. You can also define a description for the report.
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You must have read/write permissions to a folder to save a report there. A lock icon displays next to
folders where you do not have read/write permissions. If you have access to a My Documents folder,
you can also save reports there for your own use.

If you later want to change the file name, location, or description, you can use Axiom Explorer. If you do
not have rights to access Axiom Explorer, you can edit the description by using Save As (Repository)
(save the file with the same name and location, but edit the description).

You can also choose to save the report to your local drive or to a network location, by using Save As
(Local File). In this case the report is not stored in the Axiom Budgeting and Performance Reporting
database and is considered to be a non-managed file.

NOTE: Access to certain task panes (such as the Sheet Assistant) may depend on security
permissions defined at a folder level. When a new report file is created, the file location is assumed to
be the root of the Reports Library until the file is saved. Therefore access to task panes for brand new
reports depends on the user's permissions defined at the Reports Library level. If a user does not
have permission to the task panes at the Reports Library level but does have access at a sub-folder
level, then the user will not see the task panes until they save the file to that sub-folder.
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� Creating a new report based on an existing file
You can use Save As to create a new report based on a copy of an existing report. You can save the
copied file to the Reports Library, or as a local non-managed file.

You can also create a report based on an existing Excel file, by opening the Excel file in Axiom Budgeting
and Performance Reporting. To use certain Axiom file features such as Axiom queries, you must add a
Control Sheet to the report. For more information, see Control Sheets in Help (Main ribbon tab >Help).
Then you can use Save As (Repository) to save the file to the Reports Library.

Creating a new report using an existing report
Axiom Budgeting and Performance Reporting comes with a wide array of standard reports for a variety of
situations, and you should have no immediate need to create your own.

When the time comes that you require a customized report, however, Axiom Budgeting and
Performance Reporting offers powerful and flexible options for building your own reports.

When creating custom reports, you can start from scratch, or perform a Save As on a standard report
and begin customizing from there.

To create a new report using an existing report:
l To Save As, right click the report name, and select one of the following:

o To save the new report in Axiom Budgeting and Performance Reporting, select Save As
(Repository).

o To save the new report outside of Axiom Budgeting and Performance Reporting, select Save
As (Local File).

After you create a new report, we recommend saving it in My Files or some other location separate from
the Axiom Budgeting and Performance Reporting list of standard reports.

Working with Report Processing
Some reports support automated processing. If so, the File Processing task pane displays collapsed on
the left side of the screen when you open the report.
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By using file processing, you can automatically refresh a file, such as a report, and then perform various
actions on it. The file can be processed as-is, or you can leverageMultipass processing to cycle through
each element of a dimension or grouping, with an appropriate data filter automatically applied to each
pass.

You can use processing to perform the following actions:

l Save snapshot of file – Create a snapshot copy of the current file, and then save and/or email it.
l Print – Print the current file, using one or more print views.
l Export to delimited text file – Export data in the current file to a delimited text file, and then save

and/or email it.
l Save data – Perform a save-to-database from the current file.
l Alerts – Process alert conditions defined in the file.
l File collect – Combinemultiple spreadsheet files into a single file, and then save and/or email it.
l Batch – Perform file processing on multiple files in a batch process, including the ability to override

certain file processing settings for the file.

One common use for file processing is report distribution, which allows you to automatically deliver
report files to multiple recipients. This frequently involves using several different features of file
processing, for example:

l Multiple reports configured for snapshot file processing and using Multipass processing. For
example, an income statement processed by department, region, or VP, and creating a separate
snapshot file for each element.

l A report configured for file collect, to collect all of the snapshots into targeted report packages,
including adding things like cover sheets and other supporting information. These packages could
be saved to designated file locations and/or emailed to the appropriate recipients.

l A report configured for batch processing to run everything at once. For example, the batch would
contain an entry for each report configured for snapshot processing, and then finish with the file
collect report.

File processing is set up on a per-file basis. File processing can be set up on any Axiom file, but the
primary use case is in reports.

NOTE: To set up a report for processing, some processing actions require set up before they can be
performed. For example, to run a file collect process, the report must have a File Collect sheet
defined. For more information, see File Processing in Axiom Help (Main ribbon tab >Help).

After the file has been configured to use file processing, you can process it by using File Output > File
Processing. From this menu, you can choose to Process File or Process File Multipass. File processing
can also be performed using Scheduler and from a task pane.
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Removing reporting source files
Before running themonthly reports, we recommend that you first delete the reports that were sent out
last month. Copies of these reports are stored in the Explorer task pane, in the Financial Mgmt Utilities
> Report Distribution > Sent Files folder.

To remove reporting source files:
1. In Explorer, in the Libraries section, click Reports Library > Management Reporting Utilities >

Report Distribution > Source Files, and delete all of the files before running any batches.

2. In the Financial Mgmt Utilities > Report Distribution > Sent Files folder, make a copy for each
month, and move the reports to a monthly folder for storage.

TIP: You may also want to keep these copies off the Axiom application server and in a
designated place on your network.

Working with Variance Reporting
Variance Comments Collection automates the process ofmanagers submitting explanations for
variances between monthly budgets and actuals. In addition to collecting manager comments, Variance
Comments Collection also prompts managers to submit proposed action plans for bringing their
department's actuals in line with targets.

The Variance Comments Collection feature is implemented as an optional tab that you can include in the
Month End ReviewDashboard. This tab allows the following:

l Collect variance explanations and action plans for correction on a monthly basis.
l Enables one-stop shopping for the department manager by providing drill-downs.
l Provides a way to input variance explanations and actions plans for multiple departments at the

same time.

Configuring Variance Comments Collection
Before you can collect variance comments for a newmonth, you must do the following:

1. Set variance thresholds and alert flags.

2. Set VCC Payroll mapping.

3. Set additional data requirements

Confirm that all necessary monthly data has been loaded, the payroll accrual process has been
completed, and that periods have been set properly for the following data sources:
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Datasource Definition

Financial Monthly GL & Statistics loaded and proper period set

Payroll12 Biweekly payroll (Payroll27) accrued to Payroll12 with EMPLOYEE
NAME

l PP26to12_Hours– Act_Pay27_YYYY to Act_Pay12_YYYYHours
sequence

l PP26to12_Dollars – Act_Pay27_YYYY to Act_Pay12_YYYY Dollars
sequence

l EmpIDDesc

Use the PP27to12 utility report to filter hours properly as well as transfer employee names from
Payroll27 tables to Payroll12 tables.

Drilling Down to Detail

The following data is necessary to enable the corresponding drill-downs to detail.

l GLDetail – Journal entry transaction data imported for current period.
l GLTransactions - AP/MM/AR transaction data imported for current period.
l RevUsage –Monthly Gross Charges and Volumes by patient type (IP and OP) by CDM Code

Activating Variance Comments Collection
When activating Variance Comments Collection, you are adding the Variance Comments Collection tab
to theMonth End Review dashboard. This allows you to easily manage variance comments from one
location. After you activate the tab, see Using the Variance Comments Collection tab in theMonth End
Review dashboard.

NOTE: Before you can activate the tab, you must complete the setup steps. For more information,
see Configuring Variance Comments Collection.

To activate Variance Comments Collection:
1. Navigate to one of the following:

a. In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities >
System Setup, and double-click VCC_Threshold.

b. In theMgmt Admin task pane, in theDimension & Reference Maintenance section, click
System Setup, and double-click VCC_Threshold.

2. Click the Activate Variance Comments Collection tab on Month End Review Dashboard drop-
down and click Yes.
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3. Click Save.

Using the Variance Comments Collection tab in the Month End Review
dashboard
The Variance Comments Collection tab in theMonth End Review dashboard allows you to manage
variance comments. The tab displays as a sub-tab of the Operational Overview section within the
dashboard. For instructions on activating the tab, see Activating Variance Comments Collection.

� Applying filters
You must filter accounts before data will display.

To apply filters:
1. Click the filter icon in the upper-left toolbar.
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2. In the drop-down menus that display, click options to set your time period, target, category, filter,
and department. For more information on these filters, see Viewing and filtering theMonth End
Review dashboard.

3. In the Variance Comments Collection section, complete the following options, as needed:

Option Description

Which items do you want
to see? drop-down

Click one of the following options:

l All Items: displays all accounts.
l Show Required Comments Only: displays only the accounts

where variance comments are required based on threshold
settings.

Action Plan checkbox When checked, the tab displays the Action Plan column. The
Action Plan column displays a text box for each account where
comments are required. Use this text box to describe your action
plan in regard to the variance.

Rate Volume Variance
checkbox

This box is checked by default. When checked, the tab displays
the following columns: Rate, Volume, Efficiency, and 12mo.
Alert. The alerts are based on threshold settings.

Year-To-Date checkbox When checked, the tab displays the following columns: Current
year Actual, Last Year, Variance, Variance %, and Last Year Alert.
The alerts are based on threshold settings.
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4. Click Apply.

5. In the Variance Explanation column, type a description that explains the variance from the
previous year.

TIP: You can enter information in this column specific to the period you selected in Step 2.

6. In the Action Plan column, type the actions your organization plans on taking to address the
variance.

NOTE: This column only displays if you select the Action Plan check box in Step 3.

TIP: You can enter information in this column specific to the period you selected in Step 2.

7. After you finish making changes, click Save in the upper right corner of the page.

� Drilling down to detail
Once you apply the filters, you can drill-down to greater levels of detail. To drill down, click the blue
magnifying glass icon to see greater detail regarding the account in that row.

In the example below, we drill-down on Salaries - Overtime > all associated job codes > all associated
employees.
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NOTE: You can only access drill-downs for data that you have loaded already. For example, the
JobCode Variance drill-down will not be available if you have not loaded job code data.

� Viewing document images
AP and AR transactions may include links to supporting documentation that you can view directly in the
Variance Comments Collection tab. To view the document links, drill down to the appropriate
transaction, and click and drag the scroll bar until the Link to Image column displays. Click the icon to
open the document image.
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Running the Monthly Reporting Process
Complete the following steps to generate a monthly report for your organization:

1. Load GL 12-month data.

2. Load Monthly Statistics data.

3. Load GL Detail data.

4. Load AP Detail data.

5. Load MM Detail data.

6. Load Accrued Receipts data.

7. Reconcile GL to GL Transactions.

8. Load Revenue and Usage data.

9. Reconcile monthly RevUsage reconciliation.

10. Summarize CDM statistics to financial.

11. Load Biweekly Payroll data.

12. Reconcile Biweekly Payroll.

13. Run Biweekly to Monthly Payroll Accrual report.

14. Run Monthly to GL Accrual utility.

15. Remove reporting source files.

16. Configure the Department Monthly Package report.

17. Process and distribute the Department Monthly Package report.

18. View theMonth End Review dashboard.

Complete the following steps to generate a monthly report for your organization:

1. Load GL 12-month data.

2. Load Monthly Statistics data.

3. Load GL Detail data.

4. Load AP Detail data.

5. Load MM Detail data.

6. Load Accrued Receipts data.

7. Reconcile GL to GL Transactions.

8. Load Revenue and Usage data.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 577



9. Reconcile monthly RevUsage reconciliation.

10. Summarize CDM statistics to financial.

11. Load Biweekly Payroll data.

12. Reconcile Biweekly Payroll.

13. Run Biweekly to Monthly Payroll Accrual report.

14. Run Monthly to GL Accrual utility.

15. Remove reporting source files.

16. Configure the Department Monthly Package report.

17. Process and distribute the Department Monthly Package report.

18. View theMonth End Review dashboard.

Loading GL12 Month data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a GL_ prefix.

To load GL12 Month data:
1. To change the current period, in the Admin ribbon tab, in theDatabase group, click Imports &

Utilities > System Period/Year.

2. In the System Current Period dialog, in theNew Value field, type the newmonth value, and click
OK.

IMPORTANT: Do not change the System Current Year field unless changing over a new fiscal
year. Setting the system period and year could affect other Axiom Healthcare Suite products.
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3. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports,
Management Reporting> 01-Load GL 12 Months, and click Execute.

4. Click Execute.

5. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

6. In the Choose the import source file dialog, select the source file to load.-

If the import encounters validation errors, see Resolving import validation errors.

7. After you load the data, run the Income Statement Summary report in Explorer in Reports Library
> Management Reporting > Income Statement > Income Statement Summary to reconcile to
your GL income statement.

Loading Monthly Statistic data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a ST_prefix.

To load Monthly Statistic data:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 02-Load Monthly Stats, and click Execute.
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2. Click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a ST_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. If you are not loading your statistics through an import set up by your Kaufman Hall
Implementation Consultant, then you can also load statistics using a Save to Database report.
There are standard reports delivered with your system for this, which you can find in Explorer in
Management Reporting Utilities > Data Input > Input Monthly Statistics.

6. Use the top section of the report, labeled Add New Stats, when entering a newDept-Acct
combination into the database.
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If needed, you can copy additional rows by copying the entire row, and then using the Insert
Entire Row option in Excel. If you Refresh the report, it will bring in all existing statistic
combinations from the database, and you can then update any monthly value in the blue cells in
the Change Existing Stats section.

7. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.

Loading AP Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an AP_prefix.

To load AP Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

06-Load AP Detail > Execute.
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2. In the Execute Import: 06-Load AP Data dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading GL Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a JE_prefix.

To load GL Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

05-Load GL Detail > Execute.
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2. In the Execute Import: 05-Load GL Data dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading MM Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an MM_prefix.

To load MM Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

07-Load Materials Issues> Execute.
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2. In the Execute Import: 07-Load Materials Issues dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading Accrued Receipts data
Make sure the import file is created and saved to a directory accessible by the Axiom Application server.
We recommend naming the file with an AR_prefix.

To load Accrued Receipts data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 08-

Load Accrued Receipts > Execute.
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2. In the Execute Import: 08-Load Accrued Receipts dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading Revenue and Usage data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a RU_prefix.

To load Revenue and Usage data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 09-

Load RevUsage > Execute.
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2. In the Execute Import: 09-Load RevUsage dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

Month: Select
Current Month

In the drop-down, select themonth to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Loading GL12
Month data.

Summarizing CDM statistics to financial
To use your ChargeMaster (CDMCODE) to create your statistics, we offer a save-to-database utility that
summarizes the Inpatient and Outpatient volumes in the RevUsage database (ACT_RU_20XX) into
statistic accounts that can be stored in the Financial database (ACT20XX). For this utility to work, your
Kaufman Hall consultant will help you design your CDMCODE table during the implementation.

To summarize CDM statistics to financial:
1. To run this Save to Database utility, navigate to In the ExplorerExplorer task pane, in the Libraries

section, click the Reports Library > Management Reporting Utilities > RevUsage folder, and
double-click Summarize CDM Statistics.

2. In the drop down box in cell M19, select whether you are running the process for Current Year or
Last Year.
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3. Refresh the data by doing one of the following:

l In theMain ribbon tab, click Refresh Data.

l Press F9.

4. In the File Processing task pane, click Process file.
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NOTE: You do not need to run this utility using Multipass unless you are a large health system and
are noting performance issues when previously running.

Loading Biweekly Payroll data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
The file should be saved as LD_MMDDYY_PP. For example, LD_100418_1

To load Biweekly Payroll data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Table Current Periods.
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2. Filter using the Table Type, and select Payroll.

3. Change the period for all of the payroll tables where theUses System checkbox is not selected.
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4. In the Table Current Periods dialog, double-click the current period for the table, and type the
new period.

5. When you have finished all the tables, click OK.
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6. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 03-
Load Biweekly Payroll > Execute.

7. In the Execute Import: 03-Load Biweekly Payroll dialog, click Execute.

8. In the Variables dialog, do the following, and click OK:

Field Steps

Year Selection: Input
Year (YYYY)

Type the year to load.

PayPeriod: Input
Period (1 – 27)

In the drop-down, select the pay period to load to.
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9. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

10. If there are any import exceptions, follow the import exceptions remediation from .

Resolving import validation errors
If the import experiences import validation errors, you can view them in two places in the system: a
separate CSV file and the Execution log area of the Execute Import dialog, as shown in Step 8 of Loading
GL12Month data.

The CSV file is located in Explorer in the Imports Library > Management Reporting > Import Errors
folder.

The CSV file shows you which rows of data were invalid within the context of the import data. This error
file includes the following:

l Look up validation errors from Kaufman Hall's Software's built-in validation against lookup
columns.

l Validation errors from any Custom Data Validation steps in the transforms.

l Key validation errors such as blank keys or duplicate keys.
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You can also open the file from the Execute Import dialog by clicking the link the Status area. The status
displays either "failed" or "warning," followed by "click here to open errors in a spreadsheet." The status
type depends on whether the option to Ignore lookup and key errors is selected.

Each execution of an import that results in a lookup error generates a unique error file (differentiated by
a date/time stamp). These error files are not automatically deleted; you must manually delete them
when you finish investigating the error.

The CSV file contains the import data, followed by one or more validation columns. Validation columns
are labeled as follows:

l LookupColumnName Lookup Error column – Contains lookup and key validation messages. For
example, Acct Lookup Error"\ when looking up against the ACCT column.

l AXTRANSFORM_StepNumber column – Contains Custom Data Validation messages where
StepNumber is the number of the associated transformation step. For example, AXTRANSFORM_5
when the associated transform is step 5 in the list.

If there are errors (most commonly new codes in Dimensions), add those codes to dimensions, and re-
run the import.
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Working with the Month End Review dashboard
TheMonth End Review dashboard allows executives and managers to easily view variances between the
month/YTD plan versus actual for all of your organization all the way down to the department level. It
provides a visual summary of performance, including trends by month and Key Performance Indicators
(KPIs). Use the filter function to specify the information to display in the dashboard.

TIP: The rolling 12month charts actually display 13months of data so that you can compare the
current period with the same period last year.

� Summary tab
The Summary tab is the first tab that displays in the dashboard. It provides a visual representation of
actuals versus target, grouped into Revenue, Labor, and Expense categories. This tab provides KPI
visibility into all of your departments for the current period and year.

NOTE: The page will only include those departments in which you have permissions to view.

To view the statistic and per-unit KPI information at the department-level, go to the Operational
Overview tab.

To see a chart of rolling 12months actuals, click the chart icon in the upper left corner of each box.
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� Executive Overview
The Executive Overview tab displays summary-level revenue, expense, and statistics information for all
the departments in your organization.

To see a chart of rolling 12months actuals, click the chart icon in the upper left corner of each box.

You can also toggle between viewing the data for the period or YTD.

� Revenue Overview and Expense Overview tabs
The Revenue Overview and Expense Overview tabs work similarly by displaying the following sections for
revenue and expenses:
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l Income Statement Summary – Shows the actuals, targets, variance, and variance percentage for
inpatient revenue, outpatient revenue, other patient revenue, other revenue, and non-revenue
categories. As you click each category, the Top 10 Favorable and Unfavorable sections list the
departments that make up those values. For example, if you click Inpatient Revenue, the Top 10
Favorable and Unfavorable inpatient departments display.

l Top 10 Favorable Variances – Shows the top ten departments with the highest positive variance
(actuals minus target) by department, actual, target, and variance.
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l Top 10 Unfavorable Variances - Shows the top ten departments with highest negative variance
(actuals minus target) by department, actual, target, and variance.

For each department in the Top 10 Favorable and Unfavorable sections, click the department
chart icon to see a rolling 12months of actuals as well as the actuals, target, and variance listed by
account.

You can also access the ExecutiveMonthly Package from either tab.

� Statistical Overview tab
The Statistical Overview tab shows a list of key statistics by department for the selected month and year.
This tab shows:

l Prior month, two month, and threemonth data
l Four month average
l Variance to the prior month
l Variance to the four month average
l Current target (3Month Average, Last Month, or SameMonth Last Year)
l Variance to target

By using the filter function, you can filter the data by:
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l Target - Select the target of either Budget, 3Month Average, Last Month, or SameMonth Last
Year

l Category - Select VP, Director, Manager, Budget Group, Division, Dept (RPTMap).
l Time Period - Select a month and year.

You can also sort the data by either the Variance to Prior Month, Variance 4month Average, or Variance
to Target column as well as export the data to Excel.

� Operational Overview
The Operational Overview tab allows you to view the details regarding how a department is performing
by providing data regarding KPIs, patient revenue, expenses, labor, and benefits. This tab includes the
following sub-tabs:

� KPI tab
The KPI tab displays a visual representation of actuals versus target, grouped into Revenue, Labor, and
Expense categories. This tab provides KPI visibility into a department for the current period and year.
You can also access the Dept Monthly Package from this tab.
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� Patient Revenue tab
The Revenue tab displays inpatient and outpatient revenue, broken out by rate and volume variance.

To view the 12-month revenue trend and details, click the Inpatient Revenue and Outpatient Revenue
boxes.

To view actuals for the period or Year to Date, click the Period/YTD toggle in the upper right corner of the
page.
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� Other Revenue
The Other Revenue displays other patient, operating, and non-operating revenue. Click the boxes to
view the 12-month revenue trend for the associated revenue category.

� Labor tab
The Labor tab displays an overview of labor expenses excluding benefits. This tab shows salaries, the
average hourly rate, FTEs, and the paid hours per unit. The tab also shows the salary and hour details as
well as KPIs.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 607



� Benefits tab
The Benefits tab displays benefit information including benefits, percentage of salaries, rate per FTE, and
benefits per unit. The tab also displays details for each benefit type as well as KPIs.
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� Other Expenses tab

Supplies view

Other Expenses view
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Variance Comments Collection

� Drilling data
Some line items display a magnifying glass icon next to them. This indicates that you can drill for more
information regarding that line item. Some drills includemultiple layer of drills, depending on the types
of data available.

To open a drill, double-click themagnifying glass icon. The system opens a separate tab with the drill
information. Click the X in the tab to close the drill.
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Viewing and filtering the Month End Review dashboard
To view the Month End Review dashboard:

1. In theMgmt Reporting orMgmt Admin task pane, in the Performance Reporting section,
double-clickMonth End Review.

2. To filter the data for the dashboard, in the upper left tool bar, click the funnel icon.

3. Complete the following filter options, as needed:

Option Description

Time Period Select the period and year.
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Option Description

Target (All Except
Statistical)

Select one of the following target types:

l Budget
l Flex
l 3 Month Average
l Last Month
l Same Month LY

NOTE: This filter does not apply to the Executive Overview > Statistical
Overview tab.

Category & Filter
(Summary &
Executive)

a. From the Select Category drop-down, select the organization level
in which to view data. For example, to view all of the departments
and accounts at the VP level, select VP.

b. From the Select Filter drop-down, select the filter created by your
organization.

NOTE: This filter only applies to the Summary and Executive Overview tabs.

Target (Only
Statistical)

Select one of the following target types to filter the data in the Executive
Overview > Statistical Overview tab:

l Budget
l 3 Month Average
l Last Month
l Same Month LY

Dept (Only
Operational)

Select the department to filter the data in the Operational Overview tab.

NOTE: The drop-down list includes more departments than what the
system displays. To include a specific department, we recommend just
typing the department number into the field. Also, note that the list only
includes those departments assigned to you.

4. Click Apply.

Working with the Budget Assessment Dashboard
The Budget Assessment dashboard allows you to compare a department's proposed budget for next
year with internal and external peer groups.

NOTE: This feature requires a license for Axiom Comparative Analytics.
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� Opening the dashboard
Users must be assigned either the Budget Admin or Budget User role plus the Comparative Analytics -
Dept role to use the dashboard.

To open the dashboard:
In the Budgeting or Bud Admin task pane, in the Budget Reporting section, double-click Budget
Assessment.

Location of dashboard in Budgeting task pane

Location of dashboard in Bud Admin task pane

� Using the dashboard
The dashboard is comprised of the following areas:
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Filters
Do any of the following:

l Configure the criteria to include in the dashboard by selecting the filter criteria options in the drop-
downs, and click Apply.

l To clear a filter criteria option, click the X next to the drop-down.
l To clear all the filter criteria options, click Clear All.

The filter criteria detail you select also display above the tabs.

Tabs
Budget comparison data is segmented into four areas: Summary, Labor, Non-Labor, and Other
Expenses. Click any of the tabs to view the data comparison charts and KPIs.

Data Controls
The section below the tabs and above the data charts includes controls that allow you to customize the
report data.

Graph and data view

Toggle between viewing graphical and detailed data.
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These categories listed are the same for both the graph view and the data view.

Period

Select the period in which to view data.

Percentiles

Select the percentiles to use to display the dollar variance between each of the percentiles in the KPI
section of the dashboard and determine what data displays in the charts.

External and internal comparison

Select to compare data against peers outside of your organization (External) or your department
(Internal). This only applies to the KPI section.

Graphs
The graph view displays by default and compares the budget areas against performance of peers
(external) and your department (internal) across percentiles. The horizontal bars show how the
department selected in the filter and the peer data compare to the current, 3-month, and next year
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budget's percentages.

To view the detailed data behind this graph, click themagnifying glass icon in the upper right corner of
the screen. This opens theMetric Explorer dashboard. For more information, seeWorking with the
Metric Explorer dashboard.

Key Performance Indicators (KPIs)
The KPI boxes, to the right of the graphs, display the dollar variance between each of the percentiles
selected at the top of the report. You can customize the percentiles and the time period used for
calculations using those drop-down menus.

NOTE: The system shows the variance between the actuals (rather than budget) and each of the
percentiles.

Click the graph icon in the upper-right corner of the KPI card to display a detailed graph of the percentiles
and actuals over the last year.
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Working with the Metric Explorer dashboard
TheMetric Explorer dashboard allows you to evaluatemonthly and annual performance of key metric
areas for business segments and provides a deeper analysis of data that displays in the Budget
Assessment dashboard.

� Using the dashboard
The dashboard is comprised of the following areas:

Filters
Do any of the following:

l Configure the criteria to include in the dashboard by selecting the filter criteria options in the drop-
downs, and click Apply.

l To clear a filter criteria option, click the X next to the drop-down.
l To clear all the filter criteria options, click Clear All.

The filter criteria detail you select also display above the tabs.
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Tabs
Data metrics are segmented into several categories and sub-categories. Click a drop-down menu
category, and click a sub-category to display the data for that element.

Key Performance Indicators (KPIs)
TheMetric Explorer dashboard displays Key Performance Indicators (KPI) data in the form of cards,
which includes the following visual indicators and data points:

An arrow communicates month-over-month change. An up arrow indicates that the current
month has improved over the previous month. A down arrow indicates that the current month
worsened over the previous month. The large text next to the arrow displays the title of the
metric title and the text below displays themetric description.
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An alert icon indicates a visual representation of budget variance performance.

- Favorable variance to budget

-Within a 0%-5% threshold of budget

- Unfavorable variance by >5% to budget

The first line in this section details the actuals for the period selected. The second line displays
the percentile rank for the selected period. The text indicates if the percentile is rising (higher
rank than the previous period), steady, or falling (lower rank than the previous period).

Click the icon to viewmore information comparing your organization's KPI ranking among your
peer group.

A graph displays a 12-month trend from themost recent period of data available.

This area displays the budget variance percentage.

The indicator in the lower-right corner of the KPI provides you with the year-over-year (YoY)
percentage change value. An up arrow indicates that the current year has improved over the
previous year. A down arrow indicates the current year has worsened over the previous year.

Click the KPI card to view different charts associated with the data. When the chart view is activated, the
card displays a black background. Beneath the cards, the dashboard provides three different chart view
options in which to view the card data. Hover your cursor over each dot in any of the graphs to view the
percentage details. To exit the chart view, click the card again.
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Understanding the Executive Monthly Package
To help speed up report processing and distribution, you can generate executive-level reports by using
the ExecutiveMonthly Package, which combines all of the individual reports into one file. Each tab in the
workbook represents a different report.
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You can then process and email the report to the appropriatemanagement personnel and attach the
report file or a link to a directory. You can run the report generation process manually or set up a
Scheduler job to process the reports automatically at certain times of themonth.

For descriptions of each report included in the ExecutiveMonthly Package, see Reports in the Executive
Monthly Package.

Configuring the Executive Monthly Package report
Use this utility to select and combine themultiple executive reports into a single report, which you can
then distributemultiple ways - including sending an email with the attached report or a link to the
directory where the report is stored. For a description of each report included in this package, see
Reports in the ExecutiveMonthly Package.

To configure the Executive Monthly Package report:
1. Navigate to one of the following:

l In theMgmt Admin task pane, in theManagement Reporting section, click Executive, and
double-click Executive Monthly Package.

l In theMgmt Report task pane, in the Performance Reporting section, click Executive, and
double-click Executive Monthly Package.

2. Refresh the data by doing one of the following:
l In theMain ribbon tab, click Refresh Data.

l Press F9.

3. Complete the following refresh variables, and click OK:

Option Description

Select Time Comparison Select Budget , Flex, 3 Mth Avg, Last Month, or Last Year.

Select Method for
Projection Option in
Trend Reports

Select to populate the projection months by Budget, Current
Year Forecast, or Last Year Actuals.

Choose Rollup Level Select to run the report by VP or Director.
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Option Description

Pick Director/VP Select a Director or VP, depending on the option selected from
the Choose Rollup Level drop-down. To return the data for all,
leave the field blank. Leave the field blank to view all data.

Fiscal Year (optional) Select the fiscal year to include in the report.

Fiscal Period (optional) Select themonth to include in the report (based on the year you
selected in the Fiscal Year field).

Pay Period (optional) Select the pay period to include in the report (based on the year
you selected in the Fiscal Year field).

4. To specify the reports to output data in this batch report, do the following:
l To output data for a report when processing, type an X in the cell next to the report name.

By default, an X displays next to each report name.
l To exclude a report from generating data when processing, clear the X from the cell.

IMPORTANT: When you run the batch report on your screen, the system processes the
data for the reports and displays each report as a tab—even those where you have
removed the X. However, when you actually process the batch report, the system will
not include any data in those reports where you have removed the X, though the tab
still displays.

5. In the Configuration section, do the following:
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Option Description

File Prefix Displays the year and month selected in the refresh variables
selected in Step 3. You can edit this field, as needed. The prefix
name is followed by the executive level and name. For example,
Feb-2017VPSallyKlein.

Dept Variance Threshold Type the variance percentage to use in the trend-based reports.

Select Hours Code for
Dept_Variance and Dept_
Trend

Select the code used for hours accounts.

6. There aremultiple ways to generate and distribute the report package, depending on your need.
For more information and instructions, see Processing and distributing the ExecutiveMonthly
Package report.

Processing and distributing the Executive Monthly Package report
This topic covers the ways in which you can process and distribute the ExecutiveMonthly Package report
to executive personnel. To configure the reports to include in the package and the reporting variables,
see Configuring the ExecutiveMonthly Package report.

NOTE: Before processing this report package, you may consider removing the reports from last
month. For instructions, see Removing reporting source files.

� File collect
The ExecutiveMonthlyPackage_FileCollect utility allows you to process and distributemultiple Executive
Monthly Package reports to multiple people using one tool. You can configure the file source and output
settings and delivery method (email and/or save as a file to a directory location). If sending the report by
email, you can configure the email subject line and body text, the recipient type, and file attachment
options.

TIP: If you use file collect, you can add it to theMonthly All in One Executive Reporting batch control
sheet, which allows you to automate the process of
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To process and distribute package reports using the file collect:
1. From Axiom Explorer, in the Libraries section, click Reports > Management Reporting > Report

Packages > Package Utilities, and double-click ExecutiveMonthlyPackage_FileCollect.

2. Complete the following options in the Source and Output Settings section:
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Option Description

Source file name prefix Edit the source file name prefix, if needed.

Output file name suffix
(no extension)

Edit the file name for report.

Output file location Enter the location in which to save the generated report file(s).

3. Complete the following options in theDelivery Methods section:

Option Description

Assemble by Select the executive level in which to generate and distribute the
report package.

Save or email generated
files

Select one of the following:

l To save the report file(s) to a directory, select Save File.
l To include the report file(s) as attachment(s) or a link to a

directory where the files are stored in an email, select Email
File.

l To save the report file(s) to a directory and send an email,
select Save File and Send Email.

4. If you select email or save file and send email as the output option, complete the Email Settings
section:

Option Description

Subject text Type the subject line text for the email.
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Option Description

Body text Type the body text to include in the email.

Recipient Select the recipient type in which to send the reports.

Attach file to email Select one of the following:

l To attach the report file(s) to the email, select Yes.
l To include a link to the directory location for the report file

instead of attaching a file, click No.

Attach each file
separately

NOTE: This option does not display if you select the Save File
and Send Email option in step 3.

Select one of the following:

l To include the packaged reports into a single report file with
tabs for each report, click Off.

l To generate the packaged reports as individual report files,
click On.

5. After making your changes, in theMain ribbon tab, click Save.

NOTE: The system will prompt you to save your settings as a new file. This allows you to create
multiple setting versions, if needed.

6. In the Save As dialog, type a name for the file, and click Save.

7. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Executive Monthly Package utility
You can also process and distribute the report package directly from the ExecutiveMonthly Package
utility. This option is useful when generating one-off packages to just a few people or for someonewants
a variant of the reporting package outside of your normal regularly scheduled process.

To process and distribute package reports using the Executive Monthly Package utility:
1. Open the ExecutiveMonthly Package utility, and make any necessary report or variable

configuration changes, including selecting the executive-level personnel to receive the report.

2. From the Select How To Process the Files drop-down, select one of the following:

l To save the report, select Save Files. By default, the file saves to the following output
folder: \Axiom\Reports Library\Management Reporting Utilities

l To email the files, select Email Files. The report outputs to the recipient email addresses
listed in the Email Settings/Groupings section of this report.
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l To save and email the report, select Save and Email files.

3. If emailing the files, in the Email Settings/Groupings section, do the following:

Option Description

Recipient Email Address Displays the email addresses the report will be sent to.

NOTE: Email addresses are derived from the security profile for
the user.

Subject Line Edit the content for the email subject line, as needed.

Body Text Edit the content for the email body text, as needed.

4. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Batch processing and Scheduler
Another way to process the report package is to use a report batch control sheet, which allows you to
process multiple reports simultaneously. The system comes preloaded with theMonthly All in One
Executive Reporting Batch control sheet, which is pre-configured with the settings needed to run the
ExecutiveMonthly Package for both the VP-level and Director-level reports, but you can change these
settings if needed. After you have set up the batch control sheet, you can then perform a file process.

TIP: To make generating the report package even easier, you can configure a Scheduler job to
process the batch control sheet for a specific date and time. By default, theMonthly All in One
Executive Reporting batch control sheet does not include the ExecutiveMonthlyPackage_FileCollect
utility because not all organizations use file collect. However, you can also automate the process of
distributing the report by adding the file collect utility to the batch control sheet.

To process and distribute package reports using batch processing and Scheduler:
1. Open the ExecutiveMonthly Package utility, and make any necessary report or variable

configuration changes.

2. To include the file collect in the batch control sheet, open the file collect utility, and make any
necessary changes.
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3. In theMgmt Admin task pane, in the Financial Reporting Batches section, click Report Batches,
and double-clickMonthly All in One Executive Reporting Batch.

4. Update the batch control sheet, as needed, including adding the file collect utility location to
generatemultiple reports for multiple people. For more information, see the following:

l For configuring the Batch tab, see Batch Control Sheet.
l For an overview of file processing and how it works, see File Processing.

5. To process the batch, you can do one of the following:
l In the batch control sheet, click File Processing > Process File.
l Create a Scheduler job to process the report the package, if desired. For more information,

see Batch processing using Scheduler.

Understanding the Department Monthly Package
To help speed up report processing and distribution, you can generatemanager-level reports by using
the Department Monthly Package, which combines all of the individual reports into one file. The
Department Monthly Package allows management personnel to view department performance against a
static or flexible budget and against prior year’s performance and Enables one-stop shopping for the
department manager by providing the department’s overall performance as well as reports with the
detail transactions that support the expenses on the Summary reports. Each tab in the workbook
represents a different report.

The purpose of the this package is to understand financial performance and find opportunities for
improvement where possible. In this section, we describe the financial review process in two steps and,
in each section, provide an overview of the reports available in the Department Monthly Package to
complete the analysis:

l Analysis ofMonthly General Ledger (Account-level) data
l Additional Analysis of Labor (Salary Expenses and FTE amounts)
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You can then process and email the report to the appropriatemanagement personnel and attach the
report file or a link to a directory. You can run the report generation process manually or set up a
Scheduler job to process the reports automatically at certain times of themonth.

For descriptions of each report included in the Department Monthly Package, see Reports in the
Department Monthly Package.

NOTE: Before running the report package, you may need to update the imported data used in the
reports. For more information, see Preparing data for budget go-live .

Configuring the Department Monthly Package report
Use this utility to select and combine themultiple management reports into a single report, which you
can then distributemultiple ways - including sending an email with the attached report or a link to the
directory where the report is stored. For a description of each report included in this package, see
Reports in the Department Monthly Package.

Before generating this report package, you may consider removing the reports from last month. For
instructions, see Removing reporting source files.

To configure the Department Monthly Package report:
1. Navigate to one of the following:

l In theMgmt Admin task pane, in theManagement Reporting section, clickManager, and
double-click Dept Monthly Package.

l In theMgmt Report task pane, in the Performance Reporting section, clickManager, and
double-click Dept Monthly Package.
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2. Refresh the data by doing one of the following:
l In theMain ribbon tab, click Refresh Data.

l Press F9.

3. Complete the following refresh variables, and click OK:

Option Description

BudVar Report ONLY - Select Comparison
Time Series

For comparing to actual amounts within the
reports, select either Budget (Static Budget)
or Flex (Flex Budget).

BudVar Report ONLY - Populate Remaining
Months with...

To populate remaining months in your trend
report, select Budget (Static Budget), Current
Year Forecast, or Last Year Actuals(Flex
Budget).

Choose Department Rollup Select the department to include in the
report.

Fiscal Year (optional) Select the fiscal year to include in the report.

Fiscal Period (optional) Select themonth to include in the report
(based on the year you selected in the Fiscal
Year field).

Pay Period (optional) Select the pay period to include in the report
(based on the year you selected in the Fiscal
Year field).

4. To specify the reports to output data in this batch report, do the following:
l To output data for a report when processing, type an X in the cell next to the report name.

By default, an X displays next to each report name.
l To exclude a report from generating data when processing, clear the X from the cell.

IMPORTANT: When you run the batch report on your screen, the system processes the
data for the reports and displays each report as a tab—even those where you have
removed the X. However, when you actually process the batch report, the system will
not include any data in those reports where you have removed the X, though the tab
still displays.
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5. In the Configuration section, do the following:

Option Description

File Prefix Displays the year and month selected in the
refresh variables selected in Step 3. You can
edit this field, as needed. The prefix name is
followed by the executive level and name.
For example, Feb-2017SallyKlein.

Configured Comparison Period for BudVar
Tab

Select one of the following:

l Current Year Budget (CYB)
l Flex Budget (FLX)

Select Other Comparison Period for BudVar
Tab

Select one of the following:

l Last Year Actuals (LYA)
l Current Year Budget (CYB)

Trend - Remaining Yr Months for BudVar Tab Select one of the following:

l Current Year Forecast (CYF)
l Current Budget (BUD)
l Last Year Actuals (LYACT)

6. There aremultiple ways to generate and distribute the report package, depending on your need.
For more information and instructions, see Processing and distributing the Department Monthly
Package report.
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Processing and distributing the Department Monthly Package report
This topic covers the ways in which you can process and distribute the Department Monthly Package
report to executive personnel. To configure the reports to include in the package and the reporting
variables, see Configuring the Department Monthly Package report. The Department Monthly Package
report may also be referred to as theManager Monthly Report.

NOTE: Before processing this report package, you may consider removing the reports from last
month. For instructions, see Removing reporting source files.

� File collect
The DeptMonthlyPackage_FileCollect utility allows you to process and distributemultiple Department
Monthly Package reports to multiple people using one tool. You can configure the file source and output
settings and delivery method (email and/or save as a file to a directory location). If sending the report by
email, you can configure the email subject line and body text, the recipient type, and file attachment
options.

TIP: If you use file collect, you can add it to theMonthly All in OneManager Reporting batch control
sheet, which allows you to automate the process of

To process and distribute package reports using the file collect:
1. From Axiom Explorer, in the Libraries section, click Reports > Management Reporting > Report

Packages > Package Utilities, and double-click DeptMonthlyPackage_FileCollect.
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2. Complete the following options in the Source and Output Settings section:

Option Description

Source file name prefix Edit the source location, if needed.
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Option Description

Output file name suffix
(no extension)

Edit the file name for report.

Output file location Enter the location in which to save the generated report file(s).

3. Complete the following options in theDelivery Methods section:

Option Description

Assemble by Select themanagement level in which to generate and distribute
the report package.

Save or email generated
files

Select one of the following:

l To save the report file(s) to a directory, select Save File.
l To include the report file(s) as attachment(s) or a link to a

directory where the files are stored in an email, select Email
File.

l To save the report file(s) to a directory and send an email,
select Save File and Send Email.

4. If you select email or save file and send email as the output option, complete the Email Settings
section:
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Option Description

Subject text Type the subject line text for the email.

Body text Type the body text to include in the email.

Recipient Select the recipient type in which to send the reports.

Attach file to email Select one of the following:

l To attach the report file(s) to the email, select Yes.
l To include a link to the directory location for the report file

instead of attaching a file, click No.

Attach each file
separately

NOTE: This option does not display if you select the Save File
and Send Email option in step 3.

Select one of the following:

l To include the packaged reports into a single report file with
tabs for each report, click Off.

l To generate the packaged reports as individual report files,
click On.

5. After making your changes, in theMain ribbon tab, click Save.

NOTE: The system will prompt you to save your settings as a new file. This allows you to create
multiple setting versions, if needed.

6. In the Save As dialog, type a name for the file, and click Save.

7. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Dept Monthly Package utility
You can also process and distribute the report package directly from the Dept Monthly Package utility.
This option is useful when generating one-off packages to just a few people or for someonewants a
variant of the reporting package outside of your normal regularly scheduled process.

To process and distribute package reports using the Dept Monthly Package utility:
1. Open the Dept Monthly Package utility, and make any necessary report or variable configuration

changes, including selecting themanagement-level personnel to receive the report.

2. From the Select How To Process the Files drop-down, select one of the following:

l To save the report, select Save Files. By default, the file saves to the following output
folder: \Axiom\Reports Library\Management Reporting Utilities
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l To email the files, select Email Files. The report outputs to the recipient email addresses
listed in the Email Settings/Groupings section of this report.

l To save and email the report, select Save and Email files.

3. If emailing the files, in the Email Settings/Groupings section, do the following:

Option Description

Select the Recipient Role Select the role type of the email recipient.

Recipient Email Address Displays the email addresses the report will be sent to.

NOTE: Email addresses are derived from the security profile for
the user.

Subject Line Edit the content for the email subject line, as needed.

Body Text Edit the content for the email body text, as needed.

4. When you are ready to process the report, in theMain ribbon tab, click Publish > File Processing
> Process File Multipass. For more information, see Running file processing on an Axiom file.

� Batch processing and Scheduler
Another way to process the report package is to use a report batch control sheet, which allows you to
process multiple reports simultaneously. The system comes preloaded with theMonthly All in One
Manager Reporting Batch control sheet, which is pre-configured with the settings needed to run the
Department Monthly Package for multiple management-level reports, but you can change these settings
if needed. After you have set up the batch control sheet, you can then perform a file process.

TIP: To make generating the report package even easier, you can configure a Scheduler job to
process the batch control sheet for a specific date and time. By default, theMonthly All in One
Manager Reporting batch control sheet does not include the DeptMonthlyPackage_FileCollect utility
because not all organizations use file collect. However, you can also automate the process of
distributing the report by adding the file collect utility to the batch control sheet.
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To process and distribute package reports using batch processing and Scheduler:
1. Open the Dept Monthly Package utility, and make any necessary report or variable configuration

changes.

2. To include the file collect in the batch control sheet, open the file collect utility, and make any
necessary changes.

3. In theMgmt Admin task pane, in the Financial Reporting Batches section, click Report Batches,
and double-clickMonthly All in One Executive Reporting Batch.

4. Update the batch control sheet, as needed, including adding the file collect utility location to
generatemultiple reports for multiple people. For more information, see the following:

l For configuring the Batch tab, see Batch Control Sheet.
l For an overview of file processing and how it works, see File Processing.

5. To process the batch, you can do one of the following:
l In the batch control sheet, click File Processing > Process File.
l Create a Scheduler job to process the report the package, if desired. For more information,

see Batch processing using Scheduler.

Opening Manager reports
To open Manager reports:

1. In theMain ribbon tab, click Open App Menus, and clickManagement Reporting.

2. In theMgmt Report task pane, click Department Manager:
l Mgmt Report displays on the task bar tab to indicate that theManagement Reporting task

pane is open.
l The term Performance Reporting is used synonymously with Management Reporting.
l The task pane lists all of the reports listed within the Department Management folder.
l The Dept Monthly Package includes each individual report as a tab for a selected

department.
l To open a report, double-click the report name.
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Understanding financial performance
The purpose of themonthly financial package is to understand financial performance and find
opportunities for improvement where possible. In this guide, we describe the financial review process in
two steps and, in each section, provide an overview of the reports available in theManager Monthly
Report Package to complete the analysis:

l Analysis ofMonthly General Ledger (Account-level) data
l Additional Analysis of Labor (Salary Expenses and FTE amounts)

Understanding Monthly Variance Analysis
Monthly Variance Analysis is focused on departmental volumes and all expenses. While this also includes
Salary related expenses and FTEs, further analysis is often completed for these items by reviewing the bi-
weekly the reports in the Labor Analysis section.

Steps and questions for reviewing monthly general ledger data:

1. Reviewmonthly financial data for variances and determine cause of variances. Then, analyze
whether variances will continue, could have been prevented, or were strategic (such as “bulk buy
to reduce total costs”).

2. Reviewmonthly financial data for positive and negative trends.
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A focus on expense per unit (also known as per key statistic) values in volume-sensitive areas is
particularly useful to determine if any expense variances are caused by a volume variance, a rate or cost
variance, or related to efficiency. For example, if an expense line item is showing a variance and the actual
expense per unit equals the budgeted expense per unit, this situation is considered a Volume variance.
However, if the line item’s actual expense per unit is higher than the budgeted expense per unit, volume
cannot be the cause of the variance. In this case, you would determine the following:

l Is the price we are paying for the supply or service higher than budgeted causing a Rate variance?
If so are there ways to lower the price? Or was this an unexpected cost increase that will cause a
budget variance for the rest of the year?

l Are we using more of the supply or service on a per unit basis than planned causing an Efficiency
variance, or

l Is there a combination of the circumstances above causing the variance to be attributed to both
Rate and Efficiency?

In each case, why is this occurring and can we get a lower price or use the resourcemore efficiently?

The following tools in theManager Monthly Package can be used for this review:

� Cover
The Cover tab is the first sheet that displays within the Dept Monthly Package. It is also included as part
of theManager’s month-end distributed package.

This sheet provides general information such as the current reporting period and type of information
provided within each report.
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� Scorecard
The Scorecard report shows Key Financial and Ratio Indicators. It provides an overview of departmental
performance, and highlights areas requiring further review.
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� Scorecard Detail report (SCDetail)
The Scorecard Detail report (SCDetail) shows actual versus budget information and flags the areas
requiring variance comment input explanations within the Axiom Variance Comments Collection module.

Note that some additional details can be derived from this report, we can now answer some of the
questions posed within the Variance Items to Note box from the previous Scorecard section:

l Salaries are over due to Contract Labor; only benefits were budgeted in this department.

l In Other Expenses, the $6,000 unfavorable variance was spent on Recruitment.
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� Variance Alert report (VarAlert)
The Variance Alert (VarAlert) report provides the following:

l Variance by individual account lines provide further detail. If your organization uses the Variance
Comments Collection (VCC) tool, this report highlights which accounts require a variance
explanation entry.

l Displays any Variance Comments and Action Plans previously entered within the VCC tool.

� Budget Variance report (BudVar)
The Budget Variance report (BudVar) includes the following information:

l Key and supplemental statistics information
l Operating revenue and expenses
l Key per-unit calculations
l Staffing information

The Budget Variance Report is broken out into four sections:

l Income Statement Summary - Current Month and Year-to-Date
l Income Statement Account detail - Current Month and Year-to-Date
l Current Year Forecast Summary
l Current Year Forecast Account detail

If opened within the Axiom system, all four sections display on the same tab. If the report is delivered
through email or saved on a network drive, the four sections may be presented on a single sheet or
separated on four individual tabs.
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Review the Summary Level information, then look to the detail for further explanation regarding
variances. Determining the account numbers with variances will provide the link to the detailed
information on the AP, AR, MM, etc. reports that support the expense. As in our example above, Salaries
and Other Expenses resulted in a Red Flag Variance, specifically within accounts 60600 Salaries-Contract
Labor and 69230-Recruitment.

The first section of the report contains Current Month and Year to Date information at a Summary level.

Below the first section is Current Month and Year to Date information, detailed by Account Number.

To the right of the first section is Monthly Trend information at a Summary Level.
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To the right of the Detail for Current and Year to Date is Monthly Trend information by Account Number.

� Charts
The Charts report provides an overview of comparative trends across periods for Volume, Total Expense
per unit, Worked Hours per unit, and Salary Expense per unit.

Similar to the Scorecard, this report can be used to review performance trends that may require further
research.
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l Volume chart - Compares the department’s key statistic amounts by month for current year
actual, current year budget, and last year actual

l Total Expense Per Unit chart - Compares the department’s total expense per key statistic
amounts by month for current year actual, current year budget, last year actual, and current year
flex budget (if used)

l Worked Hours Per Unit chart - Compares the department’s total worked (productive) hours per
key statistic amounts by month for current year actual, current year budget, last year actual, and
current year flex budget (if used)

l Salary Expense Per Unit chart - Compares the department’s total salary expense per key statistic
amounts by month for current year actual, current year budget, last year actual, and current year
flex budget (if used)

For example, when reviewing the Volume and Total Expense Per Unit charts within the screen shot
below, you will notice the following:

l The department’s current year actual key statistic volume represented by the red line has been
moving in a positive direction since December, and is above the current year budget’s blue line
and is equal to last year actual’s yellow line for the current month of February.

l The department’s actual total expenses per unit (key statistic volume) represented by the red line
is moving in the right direction with the downward trend since December. For the current month
of February the actual is slightly below the current year static budget’s blue line, and slightly
above the current year flex budget’s green line.

These trends provide a couple of positive observations for the current month of February—
departmental volume is above budget expectations, and total expenses per key stat are below the static
budget and in line with the flex budget. The details behind these trends can be explained by reviewing
the pertinent reports within this package.
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� General Ledger report (GL)
The General Ledger report (GL) contains every transaction that makes up the total dollar amount for each
expense account. This report, combined with the AP, MM, and AR reports described below, helps you
understand the nature of the expenses. In other words, they help you recall items purchased or services
utilized for each account.

The standard JE Source codes of each GL transaction are categorized as follows (individual company
source codes may vary slightly):

l Salaries and wages come from the payroll source system and usually have a PR in the JE Source.
To ensure the JE Salary dollars are in line with FTE amounts, the JC and EmpID tabs included in the
reporting package allow you to review payroll hours by Jobcode and individual Employee.

l Invoices have a JE Source ofAP or accounts payable if the invoice has already been processed for
payment, click the AP tab.

l Invoices have a JE Source ofAR or accrued receipts for purchase order acquisitions that have been
received but have not been invoiced. For further detail of an AR expense, click the AR tab.

l Inventory items coming from supply chain or your materials management department
customarily have aMM in the JE Source. For further detail of an MM expense, click theMM tab.
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l A journal entry or JE code are expenses processed by the Accounting department. An example of a
JE item would be an annual prepaid subscription. Even though the invoice for the subscription
was paid in full with a single payment to the vendor, Accounting would hold the total amount and
book onemonth’s worth of the expense to your department for each of the 12months covered
under the subscription. For further details related to JE expense transactions, please contact your
assigned Finance representative.

� Accounts Payable Distribution report (AP)
The Accounts Payable Distribution report (AP) comes directly from the Accounts Payable Source System
and provides individual invoice information for purchases made including Description, Vendor Name, PO
Number, and Amount.
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AP transactions may include links to supporting documentation. In the Link to Image column, click the
folder to open the document image.

� Materials Management Distribution report (MM)
TheMaterials Management Distribution report (MM) comes directly from the inventory system (store
room) and provides transaction detail items pulled from inventory including Item Description, Quantity,
and Amount.
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� Accounts Receipts Distribution report (AR)
The Accrued Receipts Distribution report (AR) comes directly from the purchasing system and provides
purchase order detail. Items on this report have been received in your purchasing system, however,
your organization has not received an invoice for the purchases. Information provided on this report
includes Vendor Name, PO Number, Item Description, Invoice Number, and Amount.
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AR transactions may include links to supporting documentation. In the Link to Image column, click the
folder to open the document image.

� Labor Analysis
Labor is typically the largest expense in healthcare organizations and thus a key component to
understanding and potentially improving your department’s financial performance.

Steps and questions for reviewing labor (salaries and hours) data:

1. In the previous section you may have identified variances in salary and/or hours at a general
ledger account level. The expense per unit data on those reports would let you know if the
variance is related to volume. If not volume, more detail is helpful in determining whether the
cause is efficiency (using more labor hours than budgeted) or rate (paying more labor dollars per
unit). If the variance is due to paying more labor dollars per unit, the cause could be an issue
related to:

l Staffing Mix where higher paid positions are used more than the budgeted profile (an
unplanned higher use of RNs instead of LPNs); or

l Salary Rates where the individuals within the budgeted positions earning more dollars per
hour than planned.

2. Review payroll data to identify variances, their causes and trend data. Useful questions include:

Overtime:

l Is overtime usage value-added or resulting from undisciplined employee clocking habits?
l Is overtime usage approved?
l Is overtime themost efficient way to leverage departmental staff vs. float employees, or

could a different staffing mix be used (are there other staff members available for
scheduling who would not incur overtime in given period)?

Productivity:

l Are productive hours per unit consistent with budget? If not, what is cause? Are there
opportunities to flex or increase/decrease staffing with an increase/decrease in
departmental volumes?

l Are salary rates per productive hour consistent with budget? If not, is staffing mix a factor
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(using more high cost positions than lower cost)?

Use the following reports in theManager Monthly Package to complete the Labor Analysis:

Pay by Employee ID report (EmpID)
The Pay by Employee ID (EmpID) report contains Hour and FTE information by individual Employee ,
including recent individual pay periods and year-to-date.

Hours are categorized by Productive, Overtime, and Non Productive categories.

Pay by Job Code (JC) report
The Pay by Job Code (JC) report contains Hour and FTE information by individual Jobcode , including
recent individual pay periods and year-to-date.

Hours are categorized by Productive, Overtime, and Non Productive categories.
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Revenue and Usage report
This report displays actual Volume and Revenue by individual Inpatient/Outpatient CDM code for the
appropriate departments.

Please note the detailed lines shown here will sum up to the actual key stat volume totals displayed
within the other financial reports of this package. For example, the screen shot below provides the CDM
details related to the sample department’s current period key stat volume of 514 previously shown
within the Scorecard section of this guide.

CDM Codes Included in Department Statistics:

l Included to determine key stat volume totals for driving variable items for Budgeting, also used as
the denominator for departmental per unit calculations including Gross Revenue per unit, Salaries
per unit, etc.

CDM Codes Not Included in Department Statistics:

l CDM Charges that are billed and included as revenue, but not included in the departmental key
stat volume totals. For example, Supply related codes are captured and billed as revenue, but any
related volume is not included or counted as a key statistic.
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Understanding file output options
Axiom Budgeting and Performance Reporting provides a variety of file output options to share data with
people throughout your organization. This section explains the file setup to use these features.

l Print view setup: You can set up one or more custom print views for each sheet in an Axiom file.
You can associate these print views with sheet views to automatically hide and/or format rows
and columns in the print copy.

l Snapshot setup: Users can take snapshot copies of Axiom files without requiring any advance
setup. However, if desired, you can flag certain rows and columns in the sheet to be deleted in the
snapshot copy. The primary use for this would be to delete work areas or Axiom query artifacts
that are no longer necessary in the snapshot copy.

Printing an Axiom file
You can print an Axiom file on a per sheet basis by using the Print command. Each sheet can have one or
more defined print views. You can use the print views to print different views of the sheet, and to set
certain standard print options such as the print orientation. For example, for a plan file, you might have
one print view that prints a summary view of the sheet with certain columns and rows hidden for
printing, and another print view that prints a detail view of the sheet with all columns and rows visible.

If a sheet has no predefined print views, then you can print the sheet using the settings defined for the
spreadsheet using standard Excel printing features. For more information on defining print settings for a
spreadsheet, see theMicrosoft Excel Help. In theWindows Client, the spreadsheet print settings are
defined in theWorkbook Explorer, in the Page Setup section for each sheet.

NOTE: You can always print the file using standard spreadsheet print functionality, even if Axiom
print views have been defined.
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To print an Axiom file:
1. On theMain ribbon tab, in the File Output group, click Publish to do one of the following:

l To select the sheets to print, click Print > Print This Sheet.

The Print Sheets dialog opens. This dialog lists the available print views for the entire
workbook or for the current sheet, depending on how you entered the dialog. To sort this
list by the Sheet Name or Print View Name, click the column header.

Note the following:

o If a sheet does not have a defined print view, then it is listed with a print view name
of Default, and uses the print settings defined for the spreadsheet.

o Control Sheets cannot be printed using the Axiom Budgeting and Performance
Reporting printing feature, whether they are visible or hidden. To print a Control
Sheet, use the standard spreadsheet printing features.

2. In the Print Sheets dialog, select the sheet / print view combinations to print.
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To print all print views for all sheets, select the checkbox in the column header to select all.

If you opened this dialog by using Print This Sheet and the sheet has only one available print
view, then that view is selected by default.

3. You can also do any of the following before printing:

l View and edit the print settings. To view and potentially change the print settings for a
selected view, click the View/Edit link. In the Print Options dialog, you can change any of
the print settings for the current print job only (the changes are not saved in the file). For
more information, see Print Options dialog.

l Preview a print view. To preview a print view, click the Print Preview link. The native
spreadsheet Print Preview feature opens to preview the print job. You can only view one
preview at a time.

l Select a printer. To print to a different printer than your default printer, click Choose
Printer at the bottom of the dialog. In the Printer Setup dialog, select the printer to use,
and then click OK.
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4. Click Print.

The selected items print.

Print Options dialog
The Print Options dialog displays the print settings for the current print view. If desired, you can edit
settings for the current print job only. Any changes you make are not saved in the file.

NOTE: Print options are read-only when using the Print Plan Files option to print multiple plan files.

This dialog displays all of the settings that will be applied to the print job, whether the setting is defined
in the associated Print tag or inherited from the spreadsheet settings. If a setting is blank, then that print
option is not defined and is not applied to the print job.

� Print View Options

Item Description

Print View Name The name of the current print view.

View Name The name of the sheet view to be applied when printing. These are the
same sheet views that are available from the Change Viewmenu. For
example, if the sheet view is configured to hide columns or rows, those
columns and rows are hidden in the print copy. Row and column sizing are
also applied.

Paper Size The paper size for the print job, either Letter or Legal.

Orientation The print orientation for the print view, either Portrait or Landscape.

Repeat Rows The rows to repeat at the top of the page. Rows must be specified as a
range; for example: 1:3.

Repeat Columns The columns to repeat at the left of the page. Columns must be specified as
a range; for example: A:C.

� Scaling

Item Description

Fit To Pages Wide The number of pages on which to fit the print area. For example, if you
want the print area to fit on one page, specify 1.

Percent Zoom The percent zoom to apply to the print range. Specify the number without a
percent sign. For example, to zoom by 90%, specify 90.
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� Headers and Footers

Item Description

Left Header Header text to display in the left-hand side of the header.

Center Header Header text to display in the center of the header.

Right Header Header text to display in the right-hand side of the header.

Left Footer Footer text to display in the left-hand side of the footer.

Center Footer Footer text to display in the center of the footer.

Right Footer Footer text to display in the right of the footer.

Emailing a hyperlink to an Axiom file
You can email a hyperlink to an Axiom Budgeting and Performance Reporting file using the E-mail feature
on theMain tab. Axiom Budgeting and Performance Reporting creates a URL hyperlink to the file and
includes it in an email. The email recipient can click on the link to launch the system and open the file
directly, assuming that the recipient is an Axiom Budgeting and Performance Reporting user who has
rights to access the file.

NOTE: The email hyperlink feature is not supported for use with the Axiom Budgeting and
Performance Reporting shared client.

You can send the email using your default email client (such as Microsoft Outlook), or you can send the
file using the Axiom Budgeting and Performance Reporting Scheduler email service. For example, you
may be using Axiom Budgeting and Performance Reporting on a shared client server where you do not
have access to a local email client, and therefore you would use the system's email service to send the
email.

NOTE: The Scheduler email service does not support HTML format for email.

If you use the Scheduler service, the email message is sent the next time the Scheduler SMTP Email
Delivery task is run. The frequency of Scheduler email delivery depends on how this task has been
configured in your environment, but typically it runs continuously (or close to it).

Note the following:

l Alternatively, you can obtain a URL to an Axiom file using a variety of ways and then paste it into
an email that you createmanually. For example, you can use GetDocumentHyperlink or right-click
a file in Axiom Explorer to obtain a URL. The email hyperlink feature is provided as a convenience
to quickly send a hyperlink to the current file.
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l The email hyperlink feature cannot be used to send a hyperlink to open a form-enabled file as a
form; the source file is always opened as a spreadsheet.

l The hyperlink included in the email uses the same format as hyperlinks generated using
GetDocumentHyperlink, including the differing URL format for systems using SAML or OpenID
Authentication.

To email a hyperlink to an Axiom file:
1. Open the file in Axiom Budgeting and Performance Reporting.

2. On theMain ribbon tab, in the File Output group, click Publish > E-mail Workbook.

3. In the Email Active Workbook dialog, for Send As, select Document Link.
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4. For Send using, select one of the following::

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

NOTE: This option is not available if you use Axiom Budgeting and Performance
Reporting on a shared client server.

l Axiom Mail Service: Send the email using the Axiom Budgeting and Performance Reporting
Scheduler email service.

5. Optional. Complete the following Document Link Options in the dialog:
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Option Description

Sheet Filter If desired, enter a filter to apply to the file when it is opened. You can type the filter
statement or use the Filter Wizard.

The filter is applied like a Quick Filter and affects any data queries in the file. For
example, Dept.Region='West' means that all data queried is limited to the West
region.

If desired, you can specify a table or table type to apply the filter to, using the same
filter syntax that is available for the GetDocumentHyperlink function. In this case you
must manually type the filter syntax because the Filter Wizard does not account for
this type of syntax.

Cell Address If desired, specify the cell to be made active when the document is opened.

For example: Sheet1!D22

If the specified location would not be in view normally then the file will be scrolled
to that location; otherwise the file will open in its default view with the cursor
placed at that location.

6. Click OK.

If you selected to send the hyperlink using your default email client, then a new email message opens,
with the hyperlink included in the body text. You can then specify the recipient, subject, and additional
body text for the email, and then send it.

If you selected to send the hyperlink using the Axiom email service, then an E-Mail dialog opens so that
you can specify the recipient, subject, and additional body text for the email. In the Address fields (To ,CC
, and BCC fields, you can type an email address or click the button to select an Axiom Budgeting and
Performance Reporting user. If you select a user, the email will be sent using the user's email address as
defined in Axiom security. When you click OK, the email settings are saved to the database, to be sent
the next time the Scheduler SMTP Email Delivery task is run.

Emailing a snapshot of an Axiom file
You can email a snapshot of an Axiom file using the E-mail feature on theMain ribbon tab. Axiom
Budgeting and Performance Reporting creates a snapshot copy of the file and attaches it to an email. The
copy can then be viewed outside of Axiom Budgeting and Performance Reporting by someonewho may
have no access to the system. When you use this feature, the system creates a snapshot copy of the file
just like it would if you used the Snapshot feature.

You can send the email using your default email client (such as Microsoft Outlook), or you can send the
file using the Axiom Budgeting and Performance Reporting Scheduler email service. For example, you
may be using the software on a shared client server where you do not have access to a local email client,
and therefore you would use the Axiom Budgeting and Performance Reporting email service to send the
email.
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NOTE: The Scheduler email service does not support HTML format for email.

If you use the Scheduler service, the email message is sent the next time the Scheduler SMTP Email
Delivery task is run. The frequency of Scheduler email delivery depends on how this task has been
configured in your environment, but typically it runs continuously (or close to it).

Note the following:

l The name of the emailed file is Sheetname_snapshot (if the snapshot contains only one sheet) or
FileName_snapshot (if the snapshot has multiple sheets). You cannot change the name.

l You can also email snapshot copies using the File Processing feature. File processing is typically
used when you want to automate the process and employ Multipass processing to send the same
file to different people using different data. The E-mail feature is best used to send one-off
snapshots as needed.

To email a snapshot copy of an Axiom file:
1. Open the file in Axiom Budgeting and Performance Reporting.

2. On theMain ribbon tab, in the File Output group, click Publish > E-mail Workbook.

3. In the Email Active Workbook dialog, for Send As, select Snapshot.
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4. For Send using, select one of the following:

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

NOTE: This option is not available if you use Axiom Budgeting and Performance
Reporting on a shared client server.

l Axiom Mail Service: Send the email using the Axiom Budgeting and Performance Reporting
Scheduler email service.

5. Complete the following Snapshot Options in the dialog:
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Option Description

Send file as Select XLS, XLSX, XLSM, or PDF. XLSX is selected by default.

NOTE: PDF is not available in the Axiom Budgeting and Performance Reporting
Windows Client.

Include Select one of the following:

l Entire Workbook: All sheets are included in the snapshot (except Control Sheets
and hidden sheets, which are always removed).

l Active Worksheet Only (default): Only the active worksheet is included in the
snapshot.

Formulas l Convert All Formulas (default): All formulas are converted to values.
l Retain Excel Native Formulas: Axiom formulas are converted to values, but

Excel formulas are left as is.

If an Excel formula references a sheet that is not included in the snapshot, that
formula will be converted to a value.

NOTE: If the file contains a pivot table, this option must be selected in order for the
pivot table to work in the snapshot copy. This option does not apply if PDF is the
selected file type.

6. Click OK.

If you selected to send the file using your default email client, then a new email message opens, with the
snapshot file attached. You can then specify the recipient, subject, and body text for the email, and then
send it.

If you selected to send the file using the Axiom mail service, then an E-Mail dialog opens so that you can
specify the recipient, subject, and body text for the email. In the address fields (To, Cc, and BCC), you can
type an email address or click the button to select an Axiom Budgeting and Performance Reporting user.
If you select a user, the email is sent using the user's email address as defined in Axiom security. When
you click OK, the email settings are saved to the database, to be sent the next time the Scheduler SMTP
Email Delivery task is run.
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Working with Balance Sheets
A balance sheet is a financial statement that reports a company's assets, liabilities and shareholders'
equity at a specific point in time, and provides a basis for computing rates of return and evaluating its
capital structure. It is a financial statement that provides a snapshot of what a company owns and owes
as well as the amount invested by shareholders.

� Revenues and expenses
In Axiom Performance Reporting, the balance sheets cover the following areas:

l Current Assets - All of the assets of a company that are expected to be conveniently sold,
consumed, utilized or exhausted through the standard business operations, which can lead to
their conversion to a cash value over the next one year period.

l Other Assets - A group of accounts listed as a separate line item in the assets section of the
balance sheet, and contains minor assets that do not naturally fit into any of themain asset
categories.

l Current Liabilities - A company's debts or obligations that are due within one year or within a
normal operating cycle

l Other Liabilities - A balance sheet entry used by companies to group together current liabilities
that are not assigned to common liabilities such as debt obligations or accounts payable.

l Total Net Assets - The total assets minus total liabilities of a company. Net Incomemay be
included in this section, which is calculated by taking total revenues less deductions and expenses.

� Creating balance sheets in Axiom Management Reporting
In Axiom Performance Reporting, users with PR Admin and PR Analyst roles can create balance sheet
templates for their organization using the Balance Sheet Template Builder. For example, they can create
a summary and detailed version of the balance sheet using different accounting groupings for one entity,
and create another summary and detailed version for a different set of account groups for another entity
in the organization.

Users can select the balance sheets to view using the Balance Sheet Viewer. From the viewer, users can
filter the reports by selecting the report to view along with other variables, such as the period, year, and
level (summary or detail). You can also view the balance sheet by entity as well as drill down to the line
item level to view amounts by department and account.

12
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Creating or modifying a balance sheet template
The Balance Sheet Template Builder allows anyone with the PR Admin and PR Analyst roles to easily and
quickly configure balance sheets for their organization. The templates created using this wizard display to
all Axiom Performance Reporting users in the Balance Sheet Viewer.

Template building includes fivemain steps:

l Step 1: Define the template - Use this page to select the ACCT dimension column in which to pull
in data to the balance sheet. By default, the template includes FSSummary and FSDetail. The
FSSummary template only displays summary data to users, while FSDetail includes the line item
details. You can include other columns in the template builder, but you need to configure them in
the ACCT dimension before they will display as an option. For more information, see Configuring
ACCT dimension columns for the Income Statement and Balance Sheet Template Builders.

l Step 2: Define Sections - This step allows you to name themajor sections of your balance sheet.
By default, pre-loaded names are defined, but you can change them to best meet the needs of
your organization. This step also displays the filters used to pull in the data for each section.

NOTE: These filters cannot be changed, even if using a column other than FSSummary or
FSDetail. These filters are based on best practices related to creating balance sheets.
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l Step 3: Determine Subtotal Groups -Within each section, you can organize data that comes in
from the filters into subgroups. The system then displays a subtotal amount for the group.

TIP: Any line items with the subtotal group None automatically display first in balance sheet
report, but the system does not subtotal the amounts for those line items.

l Step 4: Configure Subtotal Groups - This page allows you to rename the subtotal group as well as
the line item detail names from the filter. You can reorder how you want the line item details to
display as well as exclude line items, which the system then excludes from the subgroup totals.

l Step 5: Summary and Preview - From this step, you can preview the template based on the
selections and configurations you selected. You can return to the wizard to make any necessary
changes. When you are ready to make the template available to users, publish the template, and
it will display in the Balance Sheet Viewer.

At the top of the template builder, the system displays the details about the template, including its
publication status.
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Templates display as one of the following:

l Pending - The template has not been selected for editing.

NOTE: For Pending templates, you must complete and save the configurations for each step
in the order they are presented. After you complete and save all of the steps, the template
changes to Draft, at which point you can move around the steps freely to makemodifications.

l Draft - Any stage during the creation of the template but before the Publish toggle has been
selected.

l Published - The template has been published to the Balance Sheet Viewer. If the template is
unpublished, the status changes back to Draft until it is published again.

NOTE: If you make and save changes to a published template, the system automatically
changes the template to Draft, at which point you will need to click the Publish toggle to Yes to
publish the template again.

To create or modify a balance sheet template:
1. In theMgmt Admin task pane, in theManagement Reporting section, double-click Balance Sheet

Template Builder.

2. Do one of the following:
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To... Then...

Create a
new
template

a. From theGroup By Column drop-down, select the column in the
ACCT dimension table based on the amount and type of data to show.

b. Click + Create New Template.

Modify a
template

a. From theGroup By Column drop-down, select the ACCT dimension
column in which the template is based.

b. From the Saved Templates drop-down, type or select the template to
modify.

TIP: After you select the column, the page displays a number next to the
Saved Templates title to indicate the number of available templates you
can select from.

c. ClickModify Template Details.

3. In the Create/Modify Template dialog, complete the following fields, and click Save:

Field Description

Display Name Type a name for the balance sheet.

TIP: This name displays in filter of the Balance Sheet Viewer
as well as the header at the top of the balance sheet page.

Description Typemore information about this template.

NOTE: This information only displays in the Balance Sheet
Viewer.

Target Select Budget orNone.
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Field Description

Include Net Income to Fund
Balance

Select the check box next to the year totals to include in the
Net Income row:

NOTE: By default, the balance sheet report includes
columns for the current year, -1 year, and -2 year amounts,
but these options allows you to configure whether or not to
include those amounts in the Net Income row at the
bottom of the report.

l Current Year - Include in the current year (based on the
system year) totals.

l Ultimate Year - Include the -1 year totals.
l Penultimate Year - Include -2 year totals.
l Target - Include in Budget if selected as target.

4. Click Next.

5. In the Step 2 page, in theDisplay Name column, modify the names used as section headers in the
balance sheet, as needed, and click Save.
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TIP: If you build a template based on a column other than FSSummary or FSDetail (especially a
customized column), you may want to rename the section headers to best suit the needs of
your organization.

6. Click Next.

7. In the Step 3 page, from the Subtotal Group column drop-down, you can group individual line
item categories into different subtotal groups by selecting a subgroup number, and click Save.

TIP: Any line items with the subtotal group None automatically display first in the balance
sheet report, but the system does not subtotal the amounts for those line items.

8. Click Next.

9. In the Step 4 page, do any of the following, and click Save:
l To rename a subtotal group, type a new name in the Subtotal Group column field.

NOTE: This column field only displays if you assign line items to groups in Step 7.

l To reorder the line item, select the order number from theOrder column drop-down.
l To change the name of the line item, edit the name in theDisplay Name column.
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l To exclude the line item from displaying in the statement, click the check box in the Exclude
column.

10. Click Next.

11. In the Step 5 page, do one of the following:
l To show a preview of the template, click Click to Preview Template. For more information

on how to navigate the balance sheet, see Steps 2-3 in Viewing balance sheets.

TIP: To fine tune your template, return to the Balance Sheet Template Builder and
repeat steps 2-10.

l To publish the template to the Balance Sheet Viewer, click the Publish toggle to Yes.
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Publishing or unpublishing balance sheet templates
If you unpublish a template, it will no longer display in the Balance Sheet Viewer.

To publish or unpublish balance sheet templates:
1. In theMgmt Admin task pane, in theManagement Reporting section, double-click Balance Sheet

Template Builder.

2. From theGroup By Column drop-down, select the ACCT dimension column in which the template
is based.

3. From the Saved Templates drop-down, type or select the template to modify.
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4. ClickModify Template Details.

5. Click the fifth square for Step 5 in the upper left corner of the page.

TIP: You can also navigate through each step by clicking Next > in the upper right corner of the
page.

6. In the Step 5: Summary and Preview Page, do one of the following:
l To publish the template, click the Publish toggle to Yes.
l To unpublish the template, click the Publish toggle to No.

7. Click Save.

Viewing balance sheets
The Balance Sheet Viewer allows you to viewmultiple balance sheet reports from an easy-to-use utility.
From the viewer, you can filter a report by selecting the report to view along with other variables, such as
year, period, level (summary or detail).
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By default, the report displays the balance sheet report by budget (e.g. MTD), but you can also view the
budget organized by entity by clicking View in the upper right corner of the page.

To view balance sheets:
1. Navigate to one of the following:

l In theMgmt Report task pane, in the Performance Reporting section, double-click Balance
Sheet Viewer.

l In theMgmt Admin task pane, in theManagement Reporting section, double-click
Balance Sheet Viewer.
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2. By default, the report displays the budget view (e.g. MTD). To view the report by entity, in the
upper right corner of the page, click View. From the View dialog, click Entity, and hen click OK.

3. From the Filters panel, do any of the following:

a. In the All Views section drop-downs, select the balance sheet report, the period, the year,
and the summary or detail level.

b. If you are viewing the report by entity (as described in Step 2 above), in the For Entity View
Only section, do one of the following:

To... Then...

Select entities by creating or
using a filter

a. From the Select Entity Filter Type drop-
down, select Filter.

b. From the Select Entity Filter drop-down,
select or create a new filter. For instructions,
see Using the Filter Wizard.

IMPORTANT: An entity must be active for it
to display in the report. Active entities are
indicated in the Entity dimension table in
the Active column. If the filter you create or
use includes more than 20 entities, the
system will not display the report until you
adjust the filter so that it includes less than
20 entities.

c. Click Apply.
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To... Then...

Select entities by group type and
name

a. From the Select Entity Filter Type drop-
down, select By Group.

b. From the Select Entity Group Type drop-
down, select the group type.

c. Optionally, from the Select Group Name
drop-down, select the name of the entity
group.

d. Optionally, from the Select Entity drop-
down, select an individual entity included in
the entity group.

e. Click Apply.

4. In the report, you can drill down to the department level by clicking themagnifying glass icon to
the left of the line item to view department details regarding the associated line item. From the
department level, you can then drill down to the account level.
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Working with Income Statements
An income statement measures an organization’s financial health over a specific accounting period. The
income statement reports income through a particular time period and focuses on four key areas:

l Revenue
l Expenses
l Gains
l Losses

� Revenues and expenses
In Axiom Performance Reporting, the income statements cover the following areas:

l Patient Revenue - Revenue realized through primary activities is often referred to as operating
revenue. For healthcare organizations, the revenue from primary activities usually refers to
revenue achieved from offering services to patients. This includes in patient, outpatient, and other
patient revenue.

l Deductions from Revenue - Deductions from Revenuemeans reductions from gross revenue
resulting from inability to collect payment of charges. Such reductions include bad debts,
contractual adjustments, uncompensated care, administrative, courtesy and policy discounts and
adjustments and other such revenue deductions.

l Other Revenue - Revenues realized through secondary, non-core business activities are often
referred to as Other Revenue.

l Operating Expenses -An operating expense is an expense a business incurs through its normal
business operations. Operating expenses for healthcare organizations usually include benefits,
salaries, medical supplies, drugs, rent, utilities, etc.

l Non-Operating Revenue - Non-operating revenue is the portion of your organization's income
that is derived from activities not related to its core business operations. Non-operating income
can include such items as dividend income, gains and losses from investments, asset write-downs,
and other non-operating revenues and expenses.

13
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� Creating income statements in Axiom Management Reporting
While the information covered above provides a basic overview of how income statements work in most
healthcare organizations, the way they are created in your organization may vary depending on who is
viewing the information and what they want to see. For example, someone at the Board of Directors
level my only want to view high-level information while managers may want to see specific details at the
line item level.

In Axiom Performance Reporting, users with PR Admin and PR Analyst roles can create income statement
templates for their organization using the Income Statement Template Builder. For example, they can
create a summary version of the income statement used by director-level personnel and create a
detailed version template to meet the needs of those that need to seemore details.

Users can select the income statement to view using the Income Statement Viewer. From the viewer,
users can filter the reports by selecting the report to view along with other variables, such as the period,
year, and level (summary or detail). They can also select the budget view and the target, as well as drill
down to the line item detail level to view specific data.

Configuring ACCT dimension columns for the Income
Statement and Balance Sheet Template Builders

By default, both the Income Statement and Balance Sheet Template Builders include the FSSummary
and FSDetail columns from the ACCT dimension. You can also include other columns from the
ACCT dimension, even custom columns, but you must complete the following steps:

1. In the column description, prefix the column namewith "FS ". This triggers the system to add the
column to the template builder.

NOTE: Make sure you add a space between "FS " and the column name.

2. The following dimension columns must be configured as follows:

Income Statements

Statement Column Type Column FSummary Column

IS Must have entries Must have entries

Balance Sheets

Statement Column Type Column FSummary Column

BS N/A Must have entries

3. Save the changes to the dimension.
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Creating or modifying an income statement template
The Income Statement Template Builder allows anyone with the PR Admin and PR Analyst roles to easily
and quickly configure income statements for their organization. The templates created using this wizard
display to all Axiom Performance Reporting users in the Income Statement Viewer.

Template building includes fivemain steps:

l Step 1: Define the template - Use this page to select the ACCT dimension column in which to pull
in data to the income statement. By default, the template includes FSSummary and FSDetail. The
FSSummary template only displays summary data to users, while FSDetail includes the line item
details. You can include other columns in the template builder, but you need to configure them in
the ACCT dimension before they will display as an option. For more information, see Configuring
ACCT dimension columns for the Income Statement and Balance Sheet Template Builders.

l Step 2: Define Sections - This step allows you to name themajor sections of your income
statement. By default, pre-loaded names are defined, but you can change them to best meet the
needs of your organization. This step also displays the filters used to pull in the data for each
section.

NOTE: These filters cannot be changed, even if using a column other than FSSummary or
FSDetail. These filters are based on best practices related to creating income statements.
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l Step 3: Determine Subtotal Groups -Within each section, you can group the data that comes in
from the filters into subgroups. In the following example, the Inpatient and Outpatient revenue
are configured to display in subtotal Group 1, and Other Patient Revenue displays in subtotal
Group 2.

l Step 4: Configure Subtotal Groups - This page allows you to rename the subtotal group as well as
the line item detail names from the filter. You can reorder how you want the line item details to
display as well as exclude line items, which the system then excludes from the subgroup totals.

l Step 5: Summary and Preview - From this step, you can preview the template based on the
selections and configurations you selected. You can return to the wizard to make any necessary
changes. When you are ready to make the template available to users, publish the template, and
it will display in the Income Statement Viewer.

At the top of the template builder, the system displays the details about the template, including its
publication status.

Templates display as one of the following:
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l Pending - The template has not been selected for editing.

NOTE: For Pending templates, you must complete and save the configurations for each step
in the order they are presented. After you complete and save all of the steps, the template
changes to Draft, at which point you can move around the steps freely to makemodifications.

l Draft - Any stage during the creation of the template but before the Publish toggle has been
selected.

l Published - The template has been published to the Income Statement Viewer. If the template is
unpublished, the status changes back to Draft until it is published again.

NOTE: If you make and save changes to a published template, the system automatically
changes the template to Draft, at which point you will need to click the Publish toggle to Yes to
publish the template again.

To create or modify an income statement template:
1. In theMgmt Admin task pane, in theManagement Reporting section, double-click Income

Statement Template Builder.

2. Do one of the following:

To... Then...

Create a
new
template

a. From theGroup By Column drop-down, select the column in the
ACCT dimension table based on the amount and type of data to show.

b. Click + Create New Template.
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To... Then...

Modify a
template

a. From theGroup By Column drop-down, select the ACCT dimension
column in which the template is based.

b. From the Saved Templates drop-down, type or select the template to
modify.

TIP: After you select the column, the page displays a number next to the
Saved Templates title to indicate the number of available templates you
can select from.

c. ClickModify Template Details.

3. In the Create/Modify Template dialog, complete the following fields, and click Save:

Field Description

Display Name Type a name for the income statement.

TIP: This name displays in filter of the Income Statement
Viewer as well as the header at the top of the income
statement page.

Description Typemore information about this template.

NOTE: This information only displays in the Income
Statement Template Viewer.

View Select how to view the income statement date.

12-Month If you select 12-Month from the View drop-down, select
the type of 12-month view to display.

Target Select the budget target.

NOTE: This drop-down is not enabled when you select 12-
Month or Entity from the View drop-down. We
recommend, however, that you set a target - even if it is not
the default view - because this information is passed on the
to the drills in the income statement.
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4. Click Next.

5. In the Step 2 page, in theDisplay Name column, modify the names used as section headers in the
income statement, as needed, and click Save.

TIP: If you are building a template based on a column other than FSSummary or FSDetail
(especially a customized column), you may want to rename the section headers to best suit
the needs of your organization.

6. Click Next.

7. In the Step 3 page, from the Subtotal Group column drop-down, you can group individual line
item categories into different subtotal groups by selecting a subgroup number, and click Save.

8. Click Next.

9. In the Step 4 page, do any of the following, and click Save:
l To change the name of the subtotal group, edit the name in the Subtotal Group column.
l To reorder the line item, select the order number from theOrder column drop-down.
l To change the name of the line item, edit the name in theDisplay Name column.
l To exclude the line item from displaying in the statement, click the check box in the Exclude

column.

10. Click Next.

11. In the Step 5 page, do one of the following:
l To show a preview of the template, click Click to Preview Template. For more information

on how to navigate the income statement, see Steps 2-3 in Viewing income statements.

TIP: To fine tune your template, return to the Income Statement Template Builder and
repeat steps 2-10.

l To publish the template to the Income Statement Viewer, click the Publish toggle to Yes.
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Publishing or unpublishing income statement templates
If you unpublish a template, it will no longer display in the Income Statement Viewer.

To publish or unpublish income statement templates:
1. In theMgmt Admin task pane, in theManagement Reporting section, double-click Income

Statement Template Builder.

2. From theGroup By Column drop-down, select the ACCT dimension column in which the template
is based.

3. From the Saved Templates drop-down, type or select the template to modify.

4. ClickModify Template Details.

5. Click the fifth square for Step 5 in the upper right corner of the page.
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6. In the Step 5: Summary and Preview Page, do one of the following:
l To publish the template, click the Publish toggle to Yes.
l To unpublish the template, click the Publish toggle to No.

7. Click Save.

Viewing income statements
The Income Statement Viewer allows you to viewmultiple income statement reports from an easy-to-use
utility. From the viewer, you can filter the reports by selecting the report to view along with other
variables, such as the period, year, and level (summary or detail). You can also select the budget view
and the target, as well as drill down to the line item detail level to view specific data.
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To view income statements:
1. Navigate to one of the following:

l In theMgmt Report task pane, in the Performance Reporting section, double-click Income
Statement Viewer.

l In theMgmt Admin task pane, in theManagement Reporting section, double-click Income
Statement Viewer.

2. From the Filters panel, do any of the following:

l Select from any of the variables, and click Apply.
l To remove the variable selections, click Clear All.

3. Do any of the following, as needed:
l View - Click View in the upper right corner of the page to change the budget view and/or

target.
l Drill down - Click themagnifying glass icon to the left of the line item to view details

regarding the associated line item. Drill-down options are available for the following levels:
o Department
o Account
o Transaction
o Job code
o Revenue usage
o Physician and Physician detail
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Setting Up Initiatives
In the budget workbook, users can budget new projects in the Initiatives tab by entering the project and
its monthly budget values for specified accounts related to the project. These projects are outside of
your organization or department's normal operations.

Before users can add projects to a budget plan file, however, you (as the Axiom Budgeting administrator)
must first enter the project into the INITIATIVEID dimension table and determine if the initiative is to
approved or excluded from the next year budget amounts in the database. The budgets for each new
initiative save to unique initiative IDs so that users can analyze the new initiative budget separately from
the ongoing operating budget.

There are two types of budgets your organization can create: System and Department. System projects
are those projects that includemultiple departments. Department projects are those specific to an
individual department. Before users can enter initiatives in their budgets, you must first set up the
projects in the INITIATIVEID dimension.

When a user enters the project in the Initiatives tab, part of the process includes adding each of the
individual accounts to budget for the project. Adding each account can be time consuming—especially
for larger projects that includemultiple accounts. To save time, you can create initiative profiles, which
allow users to copy an account structure from an existing department and use it as themodel for system
or department initiatives.

Configuring accounts for initiatives
Before setting up initiatives, you need to ensure that accounts are set up in the ACCT dimension to be
included for initiatives in the budget workbook.

To configure accounts for initiatives:
1. Open the ACCT dimension using the Dimension Maintenance Utility.

2. In the InitStdLine column for the account to make available for initiatives, double-click the folder
icon to the right of the InitStdLine column.

14
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In the Choose Value dialog for the InitStdLine, there are five validated values to select from. The
following table lists the Initiative Standard Lines that we recommend you assign to each account
type:

Account Type Initiative Standard Line

Statistics account Detail Line

Patient Revenue accounts Patient Revenue

Other Revenue accounts Detail Line

Deduction accounts Detail Line

Labor accounts Detail Line

Benefit accounts Detail Benefits w Percent

All other expense accounts Detail Line

Hours accounts Hours Line

For accounts not configured NA

3. In the Choose Value dialog, select the calc method to use for the account, and click OK.

4. In the InitType column for the same account, double-click the folder icon to the right of the
InitType column.

In the Choose Value dialog for the InitType, you can configure up to seventeen possible values.
The system selects the sections using the ACCT.InitType column so that when the user refreshes
the plan file, the accounts will insert into the appropriate section of the Initiative block. The
section types available are noted in the following list. NA is the default value until configured or for
any account not configured.
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l Benefits l IPRev l Salaries

l Contract
Labor

l NA l Statistic

l Deduction l OPRev l Supplies

l Depreciation l OtherExp

l Drugs l OtherRev

l Hours l ProFees

l Interest l PurchSvcs

5. In the Choose Value dialog, select where you want the account to display in the block by selecting
the account type for the initiative, and click OK.

6. Repeat steps 2-5 for each account to include in the initiatives.

7. When you are donemaking changes, in theMain ribbon tab, click Save.

Setting up initiative profiles
The Create Initiative Profile Utility is an optional feature that allows you to copy an account and/or calc
method structure from an existing department and use it as your model for system or department
initiatives. This saves time from having to add multiple accounts for each initiative. You can also create
multiple profiles to use with your initiatives.

This utility includes threemain sections:

l Initiative Profile - Includes the accounts from the department you select to use as a model for
your initiatives.

l Add Additional Rows - Allows you to add additional accounts not included in themodel
department you selected.

l Results of Saved Initiative Profile for Edit - Lists all of the accounts in the Initiative Profile section
that you selected as well as any accounts you added in the Add Additional Rows section.

NOTE: Ensure that the InitStdLine and InitType columns have been edited for each account in the
ACCT dimension before you begin setting up initiatives. For instructions, see Configuring accounts for
initiatives.

To set up initiative profiles:
1. In the Explorer task pane, in the File Group section, click Budget-20xx > Utilities, and double-click

Create Initiative Profile Utility.
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2. In the Refresh Variables dialog, next to the Select Existing Department field, click Choose Value.

3. In the Choose Value dialog, select the department to use as your model, and click OK.

NOTE: The system will only display those departments in which you have permission to
access.

4. In the Enter New Initiative Profile Name field, type a descriptive name for the profile (i.e. Nursing
Profile), and click OK.

The utility displays a list of all the accounts for the department you selected in Step 3. The account
number displays in the Account # column.

5. In the Initiative Profile section, from the Include? column, click the blue cell, and select No for
any accounts you do not want to include in the initiative.

These are the accounts that were included when you selected themodel department in Step 2.

If you select No, the account will not be included in the Results of Saved Initiative Profile for Edit
section at the bottom of the page.
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6. In the Add Additional Rows section, you can add any additional accounts not originally included
in the department you selected in Step 3 (listed in the Initiative Profile section) by doing the
following:

a. In the Include? column, select Yes orNo from the drop-down (if not already selected).

b. Double-click the Select Account cell.

c. In the Choose Value dialog, select the account to include, and click OK.

d. Repeat Steps a-c for each account to add.

7. In theMain ribbon tab, click Save.

8. In the Results of Saved Initiative Profile for Edit section, from the Include? column drop-down,
select one of the following:

l To keep the account in the profile, select Keep.
l To remove the account, select Delete.

IMPORTANT: If you select Delete and save your changes, the system will remove the
account from the Initiative Profile section at the top of the page. As a result, the
account will not be included in any future initiatives where you use this profile.

9. In theMain ribbon tab, click Save.

10. Repeat Steps 2-9 for each profile to create.

When a user adds a new project in the Initiatives tab in the budget workbook, the system automatically
inserts a block of the accounts you configured for the profile you set up in the Create Initiative Profile
Utility. The user can still modify the initiative by adding more accounts, as needed, directly in the
Initiatives tab, but using a profile gives the user a "running start" to complete entering the account
information more quickly and easily. The profile used to populate the initiative also displays in the
initiative header block next to the approval state.
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For more information, see the following:

l Adding or editing initiatives available to budget workbooks
l Configuring accounts for initiatives
l Initiatives tab - budget workbook

Adding or editing initiatives available to budget
workbooks

There are two types of projects you can create to add to the Initiatives tab in the budget workbook:
System and Department. System projects are those projects that includemultiple departments.
Department projects are those specific to an individual department.

Before users can add System initiatives in their budget workbooks, you must first set up these project
types in the INITIATIVEID dimension. You can also do the same for Department projects, but users have
the option to add them directly in the Initiatives tab, and they will automatically display in the
INITIATIVEID dimension. This is not the case for System initiatives. They can only be added using the
INITIATIVEID dimension.

After you enter and save the initiatives in the dimensions, they will automatically become available to
select in the workbook Initiatives tab.

To add or edit an initiative available to budget workbooks:
1. In the Explorer task pane, in the Libraries section, click Table Library > !Dimensions, and double-

click INITIATIVEID.

IMPORTANT: At this time, only users with the Bud Admin role profile can edit this dimension.

2. To create a new initiative, in a blank row, complete the following columns:
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Column Description

INITIATIVEID The INITIATIVEID used in Axiom Budgeting. This is used
during the budget process to store new initiatives.
InitiativeID 1 is used for baseline operations. All other
initiative numbering is determined by the system
administrator and must be numeric.

Description Enter a description for the initiative to use for
budgeting and reporting.

InitType Groups initiatives together for reporting and
categorization. Double-click the cell, and select one of
the following:

l System - Initiatives that affect multiple
departments.

l Dept - Initiatives for a single department.
TIP: You can add a Dept initiative directly in the
Initiatives tab in the workbook. The system will
then also add it to this dimension. You cannot add
System initiatives in this way. You must add them
directly to this dimension for them to show in the
Initiatives tab.

Approve The coding for Approve/Exclude for new initiatives.
Double-click the cell, and select one of the following:

l Approve - Initiatives that have been approved.
l Exclude - Initiatives that are declined or deleted.

SaveCustom Used to save from the Axiom Budgeting plan file to this
dimension table.

IMPORTANT: Do not alter or recode.

SaveTagDocID Used to save from the Axiom Budgeting plan file to this
dimension table.

IMPORTANT: Do not alter or recode.

Profile The profile type to apply to the initiative. Double-click
the cell, and select a profile to use for the initiative. For
more information, see Setting up initiative profiles.

3. Click Save.
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Configuring the Provider Module
The following table lists the incremental configurations needed for the areas noted to set up the Provider
module:

Area to Configure Configuration Details

Newprovider Configuring threshold parameters to limit Provider data

Provider dimensions l DEPT
l ACCT
l JOBCODE
l PAYTYPE
l PROVIDER
l CPT
l DATATYPE
l LOCATION
l FINCLASS

Driver files l Budget Provider Configuration
l Budget Provider Driver
l Budget Provider Global Provider
l Budget Provider Global ClobalVolChg
l Budget Provider List
l Budget Provider Simple Config
l Budget Provider Simple Dept Config
l Budget Provider Simple Dept Config Basic
l Budget Provider Simple Dept Rate
l Budget Provider Vol

Budget workbook tabs l Provider
l ProviderComp

o Comp model explanations

Calc methods l Provider sheet
l Stat_Rev sheet
l Expense sheet

15
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Adding a detail provider
IMPORTANT: When adding a new detail provider, it is important that you save any edits on this tab
before adding the new provider. This is important because the page can be refreshed after adding
the new provider, which results in the system collapsing and then rerunning the summary AQs. If
unsaved data exists in a provider block that was previously expanded, the edited data will be lost.

To add a detail provider:
1. Add the new provider in the PROVIDER dimension.

NOTE: They must exist as a valid provider with all required columns completed.

2. Navigate to one of the following:

l In the Bud Admin task pane, in the Budget Files Administration section, double-click Add
New Provider Detail Utility.

l In the Budgeting task pane, in the Budgets section, double-click Add New Provider Detail
Utility.

3. In the Refresh Variables dialog, complete the following:

Option Description

Select Existing
Provider

Select an existing provider to copy from.
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Option Description

Select Existing
Department

Select an existing department to copy from.

NOTE: The provider to copy from can be any existing department
because the provider data is coming from the Act_Prov_20XX table,
not an existing plan file.

Select New Provider Select the new provider to copy to.

Select New
Department

Select the new department to copy to.

4. Review the rows assigned to the new provider, and exclude any that you do not want as part of
the new provider profile.

In the following example, we do not want the Allowance rows as part of the actual data of the
donor provider, but wemay not want these for budgeting purposes so wewill set these rows to
No in the Include column.
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5. To add additional rows, use the Add Additional Rows section. In each of the columns for
DataType, CPT, FinClass, and Location, double-click the blue input cell to select from a validated
list of entries for that column.

6. After updating the new provider’s profile for all desired rows, in theMain ribbon tab, click Save.

The system posts the values to the Act_Prov_20XX table, and uses the database field NYBKHA as
the value to post to so no changes to actual imported data are affected.

7. Refresh the utility again to see the final results of the new provider’s profile that will be used in the
plan file.

To view log of the activity history, view the Results of added Provider Profile-Information Only
section. For example, in a previous step, we added one additional record, as shown in the example
below.
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8. Launch the plan file, and navigate to the Provider tab.

TIP: You can also use the GoTo navigation and note that the new provider will display there as
well. Selecting from this location will navigate directly to the new provider.

9. To immediately add the new provider to the budget plan file, open the budget workbook, and
navigate to the ProviderDetail tab.

NOTE: The system will also automatically add any new providers to the budget plan files
overnight during processing.

10. Double-click theDouble click to collapse/refresh Provider summaries cell to refresh the page.

NOTE: This action first collapses the existing list of provider details. Complete the next step to
refresh the list of providers.
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11. Again, double-click theDouble click to collapse/refresh Provider summaries cell to refresh the
list of providers.

NOTE: The providers will display in the collapsed mode.

12. After making any changes, click Save.

Adding a summary provider
To add a summary provider:

1. Add the new provider in the PROVIDER dimension.
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NOTE: They must exist as a valid provider with all required columns completed.

2. Open the budget workbook, and navigate to the ProviderSummary tab.

3. Double-click theDouble Click to Insert New Provider cell.

4. In the Calc Method Variables dialog, do the following for each provider to add, and click OK:
a. In the Select Provider field, type the provider name, or click Choose Value to select a

provider from the list.

b. In the Select Dept field, type a department number, or click Choose Value to select a
department from the list.

5. Enter values in the appropriate rows for each provider.

6. After making your changes, click Save.

Configuring dimensions for Providers
Make changes to the following dimension tables to implement the Provider Module:

� DEPT
Use the following table to make provider-specific changes to the DEPT dimension table:
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Column Valid Codes

TplOptions To use the Physician template for any department, type the
MasterProvider code.

KHACMDimGrp Type the PhyStdLine code.

ProviderType Select Provider Detail or Provider Summary.

� ACCT
Use the following table to make provider-specific changes to the ACCT dimension table:

Column Valid Codes

PhyStdLine Duplicate the KHAStdLine, and adjust Salaries, Statistics, and Revenue
accounts using the following New Std Planning Methods:

Stat_Rev Methodologies

l ProviderComp - Pulls information from ProviderComp sheet.
l ProviderRev - Summarizes gross charges from Provider sheet.
l Provider Stat - Summarizes statistics from Provider sheet.

Expense Methodologies

l ProviderComp – Summarizes salaries from ProviderComp sheet.
l ProviderCompFICA – Summarizes FICA from ProviderComp sheet.
l ProviderCompHours – Summarizes hours from ProviderComp sheet.
l ProviderCompOther – Summarizes other expenses from ProviderComp

sheet.
l ProviderLaborComp – Summarizes salaries from Labor and

ProviderComp sheet.
l ProviderLaborFICA – Summarizes FICA from Labor and ProviderComp

sheet.
l ProviderLaborHours – Summarizes hours from Labor and

ProviderComp sheet.

KHASum Additional codes are available for the following:

l Physicians and Midlevel Providers
l SalariesPhy
l SalariesMid
l BenefitsPhy
l BenefitsMid
l PaidHoursPhy
l PaidHoursMid
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� JOBCODE
Use the following table to make provider-specific changes to the JOBCODE dimension table:

Column Valid Codes

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file create process. Valid entries include the following:

l To assign to all statistics, revenue, and deduction accounts that will be
budgeted in the budget plan files, type Stat_Rev.

l To assign to all expense and hours accounts that will be budgeted in the
budget plan files, type Expense.

l To exclude an account from all budget plan files, typeNA.

� PAYTYPE
Use the following table to make provider-specific changes to the PAYTYPE dimension table:

Column Valid Codes

Provider Group the PayTypes according to the standard rules we use in the other
Labor-type columns. You need to define the PayTypes on the Configuration
sheet in Global Assumptions using a BudgetGroup defined for your Physician
Group. You only need to assign a PayType to Regular and the first non-
productive row.

PhyStdLine Identify themethod to use by typing any of the following codes:

l JobCode Block
l Input_Monthly
l NA

� PROVIDER
The PROVIDER dimension table contains all of the providers within the organization and is used for
monthly reporting and provider-level budgeting.

The following table lists all of the options available in this dimension table:

Column Description

Provider The Provider ID used in Axiom Budgeting and Performance Reporting.
Must be an alpha code, so a D is prefixed during the import process.

Description Identifies the provider description to use for budgeting and reporting.

Last_Name The last name of the provider.
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Column Description

First_Name The first name of the provider.

Middle_Name Themiddle name of the provider.

NPI The National Provider ID assigned to the provider.

Zip The zip code where the provider resides.

Entity The entity assigned from the ENTITY table.

Type Reporting Use – Used to define the provider type such as MD, NP, PA, and
so on.

HomeDeptNo Used to define the provider's home department number.

Specialty Reporting Use – Used to define the type of specialty.

EmpID The employee ID used to match billing data to payroll.

KHABgtCode Used to consolidate physicians where desired (such as all terminated
providers that you might not want to budget individually). The default is to
use the ProviderID from column A.

VolSum Used to identify physicians that work in more than one department, yet
paid in one, and their compensation package is based on TOTAL VOLUME
for all areas worked. Options include Yes or No.

There is the sheet in the Provider driver file that summarizes individual
department volumes by Provider if VolSum=Yes.

GLRevAcct The GL revenue account to transfer provider revenue to the Stat_Rev
sheet. This can also be defined by FinClass or, if FinClass or CPT are used,
default to 0 (zero). Do not leave blanks.

GLEncAcct The GL Statistic Account to transfer Encounters to the Stat_Rev sheet. For
non-Encounter codes, the default should be 0. Do not leave blanks.

GLVisAcct The GL statistic account to transfer visits to the Stat_Rev sheet. For non-
visit codes, leave the default at 0 (zero). Do not leave blanks.

GLWRVUAcct The GL statistic account to transfer provider WRVU to the Stat_Rev sheet.
For codes without a WRVU, leave the default at 0 (zero). Do not leave
blanks.

GLRVUAcct The GL statistic account to post provider RVUs to the Stat_Rev sheet. For
codes without an RVU, leave the default at 0 (zero). Do not leave blanks.

GLProAcct The GL statistic account to post provider procedures to the Stat_Rev
sheet. For codes without a procedure, leave the default at 0 (zero). Do not
leave blanks.
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Column Description

GLExpAcct The GL statistic account to post provider expenses to the Expense sheet.
For codes without a procedure, leave the default at 0 (zero). Do not leave
blanks.

RFProvider Same as Provider ID.

BudgetGroup Used for filtering Providers in the Provider List driver file.

CostProvider The Provider to use for costing purposes when using the Provider RVU
method. This allows providers to be grouped into a generic group for
costing purposes.

MedicalGroup The primary Medical Group the provider is associated with for grouping
and reporting purposes.

Active Used to determine if the provider is active. Valid entries include the
following:

l Yes
l No

City The city where the provider resides.

State The state where the provider resides.

Secondary Specialty The secondary specialty offered by the provider.

� CPT
The CPT dimension table contains all of the CPT Codes that have been billed within the organization and
is used for monthly reporting and provider-level budgeting.

The following table lists all of the options available in this dimension table:

Column Description

CPT The CPT code used in Axiom Budgeting and Performance Reporting. This
must be an alpha code, so a C is prefixed during the import process.

Description Identifies the CPT description to use for budgeting and reporting.

KHABgtCode The code to equal the preferred budget level. Examples include LAB, RAD,
SURG, and so on. All values in this column must be in the CPT column.

KHAInt Used during the budget creation process. Valid entries include the
following:

l To budget the CPT, select ZProvider.
l To not budget the CPT, select NA.
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Column Description

GLRevAcct The GL Revenue Account to transfer Provider Revenue to the Stat_Rev
sheet. This can also be defined by FinClass. If FinClass is used, the default
should be 0 (zero). Do not leave blanks.

GLEncAcct The GL Statistic Account to transfer Encounters to the Stat_Rev sheet. For
non-Encounter codes, he default should be 0 (zero). Do not leave blanks.

GLVisAcct The GL Statistic Account to transfer Visits to the Stat_Rev sheet. For non-
Visit codes, he default should be 0 (zero). Do not leave blanks.

GLWRVUAcct The GL Statistic Account to transfer Provider WRVUs to the Stat_Rev sheet.
For codes without a WRVU, he default should be 0 (zero). Do not leave
blanks.

GLRVUAcct The GL Statistic Account to transfer Provider RVUs to the Stat_Rev sheet.
For codes without an RVU, he default should be 0 (zero). Do not leave
blanks.

GLProAcct The GL Statistic Account to transfer Provider Procedures to the Stat_Rev
sheet. For codes without a procedure, he default should be 0 (zero). Do
not leave blanks.

KeyStat Used via utility to summarize CPT volume and post to the financial data
tables. Valid options are Yes orNo.

To summarize all of the Yes codes as monthly key stats, use the
Summarize Provider Statistics to Financial utility. This utility is available in
Axiom Budgeting and Performance Reporting in the Bud Admin task pane
in Budget Reporting > Budget Utilities > Provider Utilities > Statistics.

RVU Used via utility to adjust volume during summarization prior to posting to
the financial tables. This utility is available in Axiom Budgeting and
Performance Reporting in the Bud Admin task pane, in Budget Reporting >
Budget Utilities > Provider Utilities > Statistics.

Type Used during the import process to summarize CPT codes for Visits Counts.
Can also be used for reporting on types such as Visits, Lab, Radiology,
Surgery, and so on. If summarizing CPT codes for Visit counts, the type
must be Visit. The default value is NA.

RCPT

KHABgtCodeSum Used to configure the CPT codes for the Provider Summary option. While
any existing CPT Code can be used, the intent is to combine all CPT codes
to one value such as AllCodes. The value selected will be the value used to
build and process the Provider tab in a plan file.

NOTE: Use only one value in this column since all CPT codes will summarize
to one row in the plan file.

GKHABgtCode
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� DATATYPE
The DATATYPE dimension is used to load provider-level to the data tables. Each record is tagged with a
DataType when loaded. Examples of DataTypes include Revenue, Visit, WRVU, and so on.

The following table lists all of the options available in this dimension table:

Column Description

DATATYPE The DATATYPE used in Axiom Budgeting and Performance Reporting. This
must be an alpha code.

Description Identifies the description to be use for budgeting and reporting.

BudgetType Used during interface to determine which section each data type should
interface to. Valid codes Include the following:

l Encounter
l Revenue
l RVU
l WRVU
l Volume
l NA

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file creation process. Valid entries include the following:

l Driver
l Statistic
l Financial

� LOCATION
The LOCATION dimension contains all of the physical locations that have been billed within the
organization and is used for monthly reporting and provider-level budgeting.

The following table lists all of the options available in this dimension table:

Column Description

LOCATION The LOCATION used in Axiom Budgeting. This must be an alpha code, so an
L is prefixed during the import process. Default should be used as the
Location code if this dimension is not being used.

Description Identifies the LOCATION description to be used for budgeting and
reporting.
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Column Description

KHABgtCode Used for combining accounts together during budget plan file creation. If
there are historical values for two accounts that you want to budget as
one combined account, list the surviving account number on both lines. If
not combining accounts, this value should match value in the Account
column. The default value is 0 (zero).

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file create process. Valid entries include the following:

l To assign to all statistics, revenue, and deduction accounts that will be
budgeted in the budget plan files, type Stat_Rev.

l To assign to all expense and hours accounts that will be budgeted in
the budget plan files, type Expense.

l To exclude an account from all budget plan files, typeNA.

GLRevAcct The GL revenue account to transfer provider revenue to the Stat_Rev
sheet. This can also be defined by FinClass or, if FinClass or CPT are used,
default to 0 (zero). Do not leave blanks.

GLEncAcct GL Statistic Account to Transfer Encounters to the Stat_Rev sheet. For non-
Encounter codes, leave the default at 0 (zero). Do not leave blanks.

GLVisAcct The GL statistic account to transfer visits to the Stat_Rev sheet. For non-
visit codes, leave the default at 0 (zero). Do not leave blanks.

GLWRVUAcct The GL statistic account to transfer provider WRVU to the Stat_Rev sheet.
For codes without a WRVU, leave the default at 0 (zero). Do not leave
blanks.

GLRVUAcct The GL statistic account to post provider RVUs to the Stat_Rev sheet. For
codes without an RVU, leave the default at 0 (zero). Do not leave blanks.

GLProAcct The GL statistic account to post provider procedures to the Stat_Rev
sheet. For codes without a procedure, leave the default at 0 (zero). Do not
leave blanks.

GLAllAcct The GL Allowance Account to transfer Provider Allowances to the Stat_Rev
sheet.

RFLocation Not used at this time.

� FINCLASS
The FINCLASS dimension contains all of the financial classes that have been billed within the organization
and is used for monthly reporting and provider-level budgeting.

The following table lists all of the options available in this dimension table:
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Column Description

FinClass The FINCLASS used in Axiom Budgeting and Performance Reporting. This
must be an alpha code so that an F is prefixed during the import process.

Description The FINCLASS description to use for budgeting and reporting.

KHABgtCode Used for combining accounts together during budget plan file creation. If
there are historical values for two accounts that you want to budget as
one combined account, list the surviving account number on both lines. If
not combining accounts, this value should match value in the Account
column. The default value is 0 (zero).

KHAInt Used to identify which tab an account should be interfaced to during the
budget plan file create process. Valid entries include the following:

l To assign to all statistics, revenue, and deduction accounts that will be
budgeted in the budget plan files, type Stat_Rev.

l To assign to all expense and hours accounts that will be budgeted in
the budget plan files, type Expense.

l To exclude an account from all budget plan files, typeNA.

GLRevAcct The GL revenue account to transfer provider revenue to the Stat_Rev
sheet. This can also be defined by FinClass or, if FinClass or CPT are used,
default to 0 (zero). Do not leave blanks.

GLEncAcct GL Statistic Account to Transfer Encounters to the Stat_Rev sheet. For non-
Encounter codes, leave the default at 0 (zero). Do not leave blanks.

GLVisAcct The GL statistic account to transfer visits to the Stat_Rev sheet. For non-
visit codes, leave the default at 0 (zero). Do not leave blanks.

GLWRVUAcct The GL statistic account to transfer provider WRVU to the Stat_Rev sheet.
For codes without a WRVU, leave the default at 0 (zero). Do not leave
blanks.

GLRVUAcct The GL statistic account to post provider RVUs to the Stat_Rev sheet. For
codes without an RVU, leave the default at 0 (zero). Do not leave blanks.

GLProAcct The GL statistic account to post provider procedures to the Stat_Rev
sheet. For codes without a procedure, leave the default at 0 (zero). Do not
leave blanks.

GLAllAcct The GL Allowance Account to transfer Provider Allowances to the Stat_Rev
sheet.

RFFinClass The financial Class for Axiom Rolling Forecast.

GLPayAcct The GL Payment Account to transfer Provider Allowances to the Stat_Rev
sheet.
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Configuring threshold parameters to limit Provider data
Use this option to limit the Providers to include in the plan file by defining and configuring Volume and
Revenue threshold criteria.

There are two threshold criteria to configure: Volume and Revenue. You define the Volume criteria by
selecting a Statistics Datatype in the DATATYPE dimension table. For Revenue, you simply enter the
revenue amount the Provider must meet.

The following are themain tasks for setting up the Provider threshold criteria:

l Identify the Statistic Datatype to use as the Volume driver for the criteria in the
DATATYPE dimension table.

l Select the Statistic Datatype in the Provider Configuration driver.
l Enter the parameters for the Statistic Datatype and the Revenue amount that the Provider must

meet to be included in the plan file. Additionally, populate the Volume threshold (next to the
Revenue threshold).

IMPORTANT: If Providers do not meet both criteria, they will not be included in the plan file.

To configure threshold parameters to limit Provider data:
1. Open the Dimension Maintenance Utility to edit the DATATYPE dimension.

2. In the KHAInt column, typeDriver for any one of the Statistic Datatypes to use to test which
Providers to include in the plan file.

NOTE: You can only identify one Statistic Datatype as a driver.

In the following example, the user identifies worked RVU (WRVU) as the Statistics Datatype. The
client could also have used Research, RVU, Shadow, Visit, or Volume. All of these are identified
with Statistic in the KHAInt column.
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3. In the Bud Admin task pane, in the Budget Assumptions section, do one of the following:

l To open next year's budget drivers, click Access NY Budget Assumptions.
l To open this year's budget drivers, click Access CY Budget Assumptions.

4. Double-click Budget Provider Configuration.

5. In the Provider Driver Statistic Identification section, from the Enter the DATATYPE that houses
your Driver Stat drop-down, select the Statistics Datatype you identified as the driver in the
DATATYPE dimension table.

In the following example, the user selects WRVU.
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6. Navigate to the Threshold Options section at the bottom of the sheet, and complete the following
options:

Option Description

Turn on
Threshol
d
Option?

Use this option to activate the threshold option and related AQs. By default, the
option is set to No so that your provider plan files will process as usual.
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Option Description

Apply
Threshol
d Limits
to
Current
Year
Budget?

Use this option to determine whether to use the values in the current budget
(For example, CYB for Bud_Prov_20XX) to evaluate the threshold values.

You may set this to No in cases where you have no budget in this table, but you
have actuals in either/ both of the Act_Prov_20XX tables for prior year and YTD
current year.

In the following example where the criteria is set to Volume of 100 and Revenue
of $5,000, the system would exclude providers with zero values in Bud_Prov_
20XX because zero is not greater than either of the criteria settings.

NOTE: By default, this option is set to No so that all of the providers are included
in your plan files.

Apply
Threshol
d Limits
to Last
Year
Actual?

Use this option to determine whether to use the values in the prior year actual
(For example, LYA for Act_Prov_20XX) to evaluate the threshold values.

You may set this to No in cases where you have no actual prior year data in this
table, but you have actuals in either/both of the Act_Prov_20XX for the current
year and Bud_Prov_20XX tables.
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Option Description

Threshol
d
Paramet
ers to
limit
Provider
data

Do the following:

a. In the Volume (Driver Stat) cell, type the parameter the Provider must
meet based on the driver you selected in step 5.

b. In the Revenue cell, type the revenue amount the Provider must meet.

In the following example continued from above, a Provider must havemore than
100WRVUs and must have a revenue ofmore than $5,000 to be included in the
plan file. If the Provider has 100 or less WRVUs or $5,000 or less in revenue, the
system excludes the Provider from the plan file.

NOTE: The Provider must meet both criteria to be included in the plan file.
Provider data must be greater than the values to be included.

7. After making your changes, in theMain ribbon tab, click Save.
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Setting up filtered Budget driver security
NOTE: To grant write access to the driver tables, you must assign the General Budget drivers or the
Provider drivers to each Budget Admin user. If you want a Budget Admin user to manage the driver
only for a specific budget group, do not assign the GlobalDriverMgmt role to that user.

To set up filtered Budget driver security:
1. In the Bud Admin task pane, in the Budget Reporting section, click Budget Utilities > Security,

and double-click Budget Driver Security Update.

2. In the Budget Driver Security Setup utility, for each Budget Admin user, do the following:

NOTE: The users assigned with the Budget Admin role query into the utility when you open it.
If TRUE displays in theMember of Global Driver Mgmt cell, then you do not need to make
any changes; that user already has full access by virtue of the assigned role.

l To enable access to the General Budget drivers, in theGeneral Budget Drivers drop-down,
select Yes.

l To enable access to the Provider Budget drivers, in the Provider Drivers drop-down, select
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Yes.

3. To restrict the budget groups a user can view and edit, in each Filtered Budget Group drop-down,
select the group:

4. In theMain ribbon tab, click Save.

Configuring Budget Simple Provider Assumptions
Budget Simple Provider Assumptions include the following drivers:

Driver Description

Budget Provider Simple Config The primary configuration driver for the Provider Light edition.

Budget Provider Simple Dept
Config Basic

An alternate driver that provides more of a single-line
spreadsheet style input for the same data that loads in the
Budget Provider Simple Dept driver file.

Budget Provider Simple Dept
Config driver

The primary driver that controls all of the inputs used in the
Provider tab of the plan file. This driver is both provider and
department specific.

Budget Provider Simple Dept
Rate

Use as an override to the default Gross Charge revenue rate
calculation.
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Driver Description

Budget Provider Simple Config The primary configuration driver for the Provider Light edition.

Budget Provider Simple Dept
Config Basic

An alternate driver that provides more of a single-line
spreadsheet style input for the same data that loads in the
Budget Provider Simple Dept driver file.

Budget Provider Simple Dept
Config driver

The primary driver that controls all of the inputs used in the
Provider tab of the plan file. This driver is both provider and
department specific.

Budget Provider Simple Dept
Rate

Use as an override to the default Gross Charge revenue rate
calculation.

Budget Provider Simple Config

� Overview
This is the primary configuration driver to use for the Provider Simple edition.

NOTE: There are no configurable exceptions.

� Settings
Open the driver, and complete the following settings:
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Option Description

Use Provider Simple CM? From the drop-down, do the following:

l To use this driver for all provider plan files with
MasterProvider as the template option, select Yes.
NOTE: There are no configurable exceptions.

l To use the existing standard provider calculation method,
select No.

Show Compensation RVU?
(CRVU)

Select an alternate Compensation RVU (CRVU).

For example, you can use this option if theWRVU and the CRVU
are not the same value and the provider compensation is based
on the CRVU value instead. This would also need to be an
imported value in your database.

Use CRVU for Provider
Compensation?

From the drop-down, select one of the following:
l To use the CRVU as the statistic that the ProviderComp tab will

use for compensation calculations, select Yes.
l To use the driver stat that is configured for ProviderComp

calculations (for example, WRVUs, Visits, etc.), click No.

Show Shadow and Research
RVU?

IMPORTANT: Using these datatypes requires special
circumstances. Please contact Kaufman Hall Support for
additional details.

From the drop-down, select one of the following:

l To allow additional rows to display under the CRVU section in
the plan file and allow for additional values to add to the total
CRVU value, select Yes.

l To not allow additional rows to display under the CRVU
section in the plan file and allow for additional values to add to
the total CRVU value, select No.

Default CPT code Type the name used in the CPT dimension as the summary CPT
code. This allows the system to use a configured CPT.

NOTE: This must match the CPT summary code used in the CPT
dimension table.
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Budget Provider Simple Dept Config Basic

� Overview
This is an alternate driver that provides more of a single-line spreadsheet style input for the same data
that loads in the Budget Provider Simple Dept Config driver . We recommend that you use this driver as
the standard input method.

� Settings
Open the driver, and complete the settings.

Budget Provider Simple Dept Config driver
This is the primary driver that controls all of the inputs used in the Provider tab of the plan file. This driver
is both provider and department specific. This tab uses both the department and the provider as the
lookup values. For a description for each column, see Budget Provider Simple Dept Config Basic .

Settings in this driver include:

NOTE: The criteria used to create the provider block is simply any department and provider
combination that contains history in the current year actual Provider table.
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Option Description

FTEClinical Type the value of the FTE to use in the Provider and ProviderComp
tabs in the plan file.

The FTE you specify here overrides actual payroll FTEs. This allows
administrators to lock the FTE value when setting volume targets.
This function also overcomes data issues with payroll hours.

NOTE: The value you enter here will be the FTE value used in the
ProviderComp and Provider tabs.

FTEAcademic Type the FTE used to track the provider FTE into common functional
categories of clinical, academic, and admin.

NOTE: The FTE you enter here does not affect the plan file FTE. Only
the FTEClinical row affects the plan file, but all three of the FTE rows
save to the driver table for reporting.

FTEAdmin Type the FTE to use to track the provider FTE into common functional
categories of clinical, academic, and admin.

NOTE: The FTE you enter here does not affect the plan file FTE. Only
the FTEClinical row affects the plan file, but all three of the FTE rows
save to the driver table for reporting.

WRVU Type theWRVU value for this department provider.

This gives the administrator total control over the value of the current
year projection and next year budget as well as the spread of the
WRVUs for each month of the budget.

CRVU Type an adjustment to the per unit ratio to apply to CRVU if historical
relationship is not desired.

CRVU is designed in the Provide LE calculation method to be a per
unit relationship the driver stat (for example, WRVU) so CRVUwill not
be entered from this location.

Shadow Type the ShadowWRVU value for this department provider.

This gives the administrator total control over the value of the current
year projection and next year budget as well as the spread of the
ShadowWRVU for each month of the budget.

Research Type the Research WRVU value for this department provider.

This gives the administrator total control over the value of the current
year projection and next year budget as well as the spread of the
Research WRVU for each month of the budget.

AdjDays Type adjustments to the workdays for each department provider
combination.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 719



Budget Provider Simple Dept Rate

� Overview
Use this driver as an override to the default Gross Charge revenue rate calculation.

NOTE: There are Budget Group and Department exceptions. For example, assume each provider
within a plan file contains default revenue rates ranging from $175/unit to $182/unit. Now assume
that you want to apply a standard budget rate of $180/unit for all the providers within a plan file. This
is the tab where you would enter the standard revenue rate.

� Settings
Open the driver, and complete the settings.

Configuring Budget Provider assumptions
Budget Provider Assumptions include the following drivers:

Driver Description

Budget Provider Configuration Sets the default parameters for the Provider components of the
budget workbook.

Budget Provider Drives provider statistics to the Provider tab in the plan files.

Budget Provider Global Provider Allows you to input provider compensation to push to the
ProviderComp tab in the plan files.
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Driver Description

Budget Provider GlobalVolChg Provides a central location to budget volume by provider to
push into the Provider tab in the plan files.

Budget Provider List Stores themaster list of all physicians whose compensation is
calculated on the ProviderComp worksheet.

Budget Provider Vol Allows you to identify and provide total volumes for a provider
working in many departments, yet paid in a single department.

Budget Provider Configuration

� Overview
Use this driver to set the default parameters for the Provider components of the Budget workbook.

� Settings
Open the driver, and complete the following settings:

Administrator's Guide Axiom Budgeting and Performance Reporting │ 721



� Provider

Option Description

Provider 1. In the Select Dimension for GL Account for stat/charges cells,
from the drop-down, select the dimension to assign.

2. In the Show Finl Class / Location Detail On ProviderTab? cell, do
one of the following:
l To display the Financial Class allocations sections in the Provider

tab, from the drop-down, select Yes.
l To hide the sections to make the Budget workbook easier to

read for themanager or director, from the drop-down, select
No.

3. In the FinClass/Location Label cell, select the label to display in the
workbook.

Provider Driver
Statistic Identification

1. To assign the primary statistic driver in the Providers tab, in the
Enter the DATATYPE that houses your Driver Stat drop-down,
select Encounter, Visit,WRVU, or RVU.

NOTE: This option is used as the Volume criteria used to limit the
Providers included in the plan file. To specify the Volume Providers
must meet to be included in a plan file, see the Threshold
Parameters to limit Provider data section. For more information,
see Configuring threshold parameters to limit Provider data.

2. If you select WVRU or RVU in the previous cell, you can still budget
for Encounter or Visit in the Enter the DATATYPE that houses your
other non-driver to budget cell by doing following from the drop-
down:

l To budget for Encounter, select Encounter
l To budget for Visit, select Visit.
l To hide the additional rows of the Provider block where

Encounter or Visit would display, select None.

Provider
Payment/Allowance
Identification

To compute Percent of Net or Percent of Collections Provider
compensation, in the Enter the DATATYPE that houses your payments or
cell, select one of the following:

l Allowance
l Payment
l Hide
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Option Description

Provider Charge
Spread

In the Select Default Charge Spread Statistic cell, select one of the
following from the drop-down:

l Procedure
l WRVU
l RVU

Option Provider
Column Display

For each cell in this section, do the following:
l To hide the specified column in the Provider worksheet, typeHide.
l To show the specified column, type Show.

Default Seasonality
Index

Used as the default for seasonality for Providers without a full 12-month
history. For each cell in this row, the total of the 12monthly values must
sum to 12.

Default FTE if no on
ProviderComp tab

This is used on the Provider tab as the default FTE for each Provider block
when there is no Provider block found on the ProviderCompensation tab
in the Budget workbooks.

Do on e of the following:

l Type 0 (zero).
l Type 1.

Monthly FTE Spread
for Providers

For each month, type the spread amount to use as the default for the FTE
divisor factors used in FTE calculations on the ProviderComp tab.

New Provider
Financial Class
Defaults

1. In the FINCLASS cell, do the following:
l To assign the default Financial Classes to use in the Add New

Provider 85 Lines Calc Method in the Provider worksheet, type
the FINCLASS.

l If you do not need a row and want to hide it in the worksheet,
typeNotUsed.

2. In the%Allocation cell, type the default payor mix.

NOTE: This feature is limited to five default FinClass assignments. You
cannot add additional rows to insert in global assumptions, but you can
insert them into the calc method in the Budget workbook.
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� New Provider Default CPT Defaults

Option Description

Encounters

WRVU/RVU

Procedure Volumes

In the assignment cells for Encounters,WRVU/RVU, Procedure Volumes ,
do the following:

l To assign the default CPT category to use in the Add New Provider 85
Lines Calc Method in the Provider worksheet, type the CPT code.

l If you do not need a row and want to hide it in the worksheet, type
NotUsed.

FTE Provider CPT
Account

Leave the default as Z_FTE to save the Provider FTE value from the
Provider worksheet to the Provider database for reporting purposes.

Provider Comp -
Contract Labor

Do the following:

l In the cells in this area, type the JobCodes, PayTypes, and Default Rate
to assign to use for Contract Providers on the ProviderComp
worksheet.

l If you do not need to use all three categories, typeNotUsed.

� ProviderComp

Option Description

Compensation Starting with Show Compensation Calculations On Provider Comp? through
CompAlt3Tier - Include & Compute Method?, select whether to include (Yes) or
exclude (No) the calc method.

Default
Additional
Compensation
Pay Type

Select the Default Additional Compensation pay type.

Compensation
Adjustment
Budget from
Projected

Enter the Compensation Adjustment Budget from Projected.

Red Flag
Parameters

Do the following:

1. In the Percent Increase Threshold cell, type the percentage.

2. In the Percent Decrease Threshold cell, type the percentage.

3. In theDollar Threshold (+/-) cell, type the amount.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 724



Option Description

Threshold
Parameters to
limit Provider
data

This option checks to see if the Driver Stat Volume and Gross Charges meet a
certain level before including a provider when creating a plan file. These checks
can occur for CYA, CYB, and LYA (Provider_20XX tables).

For both the Volume and Revenue threshold criteria, type the threshold
parameters that Providers must exceed to be included in the plan file. For
example, if the Volume threshold is 3WRVUs and the Revenue is $10,000, the
Providers must exceed these thresholds to be included in the plan file.

NOTE: The Provider must meet both criteria to be included in the plan file. If no
records exist for Driver Stat Volume (i.e., WRVU) or Gross Charges but a
secondary stat record exists (i.e., Visits), the system will build a provider block.

Budget Provider

� Overview
Use this driver to input provider statistics in the Provider tab in the plan files.
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� Settings
Open the driver, and complete the following settings:

Option Description

Budget Group Code Type the budget group code that will use the driver that displays in the
Provider Driver cell in the same row. In the example above, the EMA
department will use the Visits driver instead of the default WorkDays driver.

Dept Type the department number that will use the driver that displays in the
Provider Driver cell in the same row.

Provider Driver Type the driver name to use as the default driver for all departments.
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Budget Provider Global Provider

� Overview
This driver allows you to input provider compensation to push to the ProviderComp tab in the plan files.
To add a new provider, double-click Double Click to Insert New Provider.

� Settings
Open the driver, and complete the settings.

Budget Provider GlobalVolChg

� Overview
Use this driver as a central location to adjust volume by provider that is pushed into the Provider tab in
the plan files.

NOTE: Only edit this driver if you are using the full version of the Provider product.
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� Settings
Open the driver, and complete the settings.

Budget Provider List

� Overview
The Budget Provider List driver is themaster list of all the physicians whose compensation is calculated
on the ProviderComp worksheet.

� Settings
Open the driver, and complete the following settings:

Option Description

Provider The provider whose compensation is calculated on the ProviderComp
worksheet in the budget workbooks.

EmpID The lookup from dimensions based on the Provider ID. This is used in
the Budget workbooks to link the provider billing information with
payroll information.

Name The lookup from dimensions based on the Provider ID.
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Option Description

Primary Comp Model From the drop-down, do one of the following:
l Select a comp model for each provider.
l If the provider's compensation method is not listed, do one of the

following:
o Select GlobalProvider. You can use GlobalProvider for offline

compensation calculations to feed into the Budget workbook.
o Select a comp model that most closely matches the provider's

compensation method, and then in the ProviderComp tab, use
the Compensation Adjustments line to make adjustments.

Secondary Comp Model From the drop-down, do one of the following:
l If a provider's compensation method is changing in the budget

year, select a comp model for the provider.
l If the provider's compensation method is not listed, do one of the

following:
o Select GlobalProvider. You can use GlobalProvider for off line

compensation calculations to feed into the Budget workbook.
o Select a comp model that most closely matches the provider's

compensation method, and then in the ProviderComp tab, use
the Compensation Adjustments line to make adjustments.

Comp ChangeMonth Identify themonth that the compensation will change to the
Secondary Comp Model by typing 1 for the first month of the
organization's fiscal year, typing 2 for the second month, and so on.

CY FTE Type the total FTE for the provider in the current year (CY).

CY FTE and NY FTE are used for allocating the guarantee if the provider
is split amongst multiple departments. They are also used in the FICA
calculation when a portion of the salary is grossed up.

NY FTE Type the total FTE for the provider for the next year (NY).

CY Guarantee Do one of the following:
l If the Comp Model is assigned as Guarantee, enter the amount.
l If the Comp Model is not assigned as Guarantee, type 0.

NY Guarantee Do one of the following:
l If the Comp Model is assigned as Guarantee, enter the amount.
l If the Comp Model is not assigned as Guarantee, type 0.

CY Net Rev Collection Pct Type the current year percentage when using the Percent of Net and
Percent of Cash Collections calculations.
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Option Description

NY Net Rev Collection Pct Type the Next Year Budget percentage when using the Percent of Net
and Percent of Cash Collections calculations.

CY Gross Charge Percent Type the current year percentage when using the Percentage of Gross
calculations.

NY Gross Charge Percent Type the Next Year Budget percentage when using the Percent of Gross
calculations.

Key Statistic From the drop-down, select the key statistic to use on the Provider tab
for the Revenue, WRVU, and RVU calculations. The default should be
Encounter.

Comp Driver From the drop-down, select the key statistic to use on the
ProviderComp tab for the compensation calculations. The default
should beWRVU.

CY Level 1-5 Type the rate per WRVU and the level threshold for the Current Year
Projection.

NY Level 1-5 Type the rate per WRVU and the level threshold for Next Year's Budget.

Alt Level 1-5 Type the alternate rate per WRVU and the alternate level threshold for
Next Year's Budget. This table is designed to allow you to model
different rates and level thresholds as you make changes to your
compensation model.

Additional Salary
Amounts

Use this section to add components that are physician specific. You can
use the first five categories to add on salary components such as
directorships, honorariums, and other types of compensation that
need to be added to their compensation. These rows are included in
the FICA calculation.

Additional Benefit
Amounts

Use this section to add components that are physician specific. You can
use the last five categories to add on provider-specific expenses such as
CME (Continuing Medical Education), phone allowance, malpractice,
etc.

These rows are excluded from the FICA calculation. You need to assign
a pay type for each category you use. You will need to add these codes
to your PayType tab in dimensions as they are used to save this
additional information to the Payroll12 database for each provider. We
recommend that they are prefixed with Z_ so they do not interfere with
your normal pay types.

If you do not want to use a category, leave the yellow cell blank. Use
the blue drop-down cell to identify how to spread the expense in the
Budget workbook. Options are: Even, FTE, Salary.
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Option Description

Provider Hours Spread From the drop-down, do the following:

l To spread the hours on the Provider Comp tab evenly, select Even.
l To spread the hours by FTE allocation, select FTE.

Budget Provider Vol

� Overview
Use this driver to identify and provide total volumes for a provider working in many departments, yet
paid in a single department. This information is for display purposes only.

� Settings
Open the driver, and complete the settings.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 731



Provider Detail and Provider Summary sheets
NOTE: This tab only displays if your organization purchased the Provider module license.

There are two sheets available that include provider level information: Provider Summary and Provider
Detail.

Provider statistics are computed using historical relationships. Provider volumes are computed using
today’s Encounters per Production Day and adjusted for next year’s Available Production Days.

IMPORTANT: Because the tab is rebuildable, any changes made in the Provider data tables after the
plan file is built will be automatically updated in the plan file. These changes are commonly referred
to as prior period adjustments, which will be reflected in the YTD columns in the tab.

To view a list of Provider calc methods, click one of the following:

l Expense sheet calc methods
l Provider sheet calc methods
l Stat_Rev sheet calc methods

� Provider Summary sheets
This sheet provides a summary of the totals at the department and individual provider level.

� Provider Detail sheet
This sheet shows summary subtotal information for each provider, but you can also access the details for
each provider by using the Click-to-Expand feature.
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The Click-to-Expand feature expands the rows and inserts the calc method that includes the provider
detail information such as WRVUs, gross charges, RVUs, encounters, and so on. You can simply scan and
review the summary information for each provider without having to sort through multiple lines of
details to view the information you need, and if necessary, expand the details and manage only those
providers that need it.

TIP: When you save the file, the system will remember which providers you have expanded the detail
rows for that day. Let's say you expanded the detail rows for five providers and saved your changes,
when you open the file later, the detail lines will still display for those five providers. When the plan
file processes that evening, however, the system will collapse all of the detail rows so that the tab
opens faster.
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IMPORTANT: The Summary Department Totals section at the top of the tab will not update values
until you save changes to the workbook.

� Updating detail provider values from the Stat_Rev tab
Any changes made to the provider's FTE value on the ProviderComp sheet will affect the values for that
provider in the Provider Detail sheet. To see that result within your session, double-click theDouble click
to collapse/refresh Provider summaries cell to refresh the data; otherwise, the nightly recalculation
process will update it automatically.
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ProviderComp sheet
NOTE: This sheet displays only if your organization has purchased the Provider module.

The ProviderComp sheet displays the selected calc methods for provider compensation, which you can
change in the Budget Provider Assumptions driver (if you have Administrator role privileges).

NOTE: Provider Volume data carries over from the Provider Summary or Provider Detail sheet.

You can automatically change compensation models at a set point during the budget year. To
accomplish this, designate the Primary and Secondary Comp Models for each provider in the Budget
Provider Assumptions plan file, along with the Comp Model Changemonth. To keep the same Comp
Model throughout the year, select the same Comp Model for both the primary and secondary options.
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IMPORTANT: Any changes made to the provider's FTE value on this tab will affect the values for that
provider in the Provider Detail tab. For instructions, see Updating detail provider values from the
Stat_Rev tab.

Comp model explanations
Model Description

Salary A traditional hourly rate calculation (usually used for Clinical Nurse
Practitioners and Physician Assistants who are referred to as Midlevel
providers). FTEs are input for the provider and hourly rate pulls from
payroll data.
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Model Description

Guarantee An annual salary guarantee is placed in the ProviderList sheet of the
Budget Provider Assumptions driver file (generally used in the first one to
two years of hire); You can also add an incentive compensation by placing
rates in the tier tables on the same line. For example, Dr. Falk’s guarantee
is $500,000 for next year and his totalWRVUs=5,200. In addition to his
guarantee, he will be paid:
l Level 1 - $7.00 for WRVUs up to 1,000

1000 x $ 7= $  7,000
l Level 2 - $8.00 for WRVUs from 1,001-2,000

1000 x $ 8= $  8,000
l Level 3 - $9.00 for WRVUs from 2,001-3,000

1000 x $ 9= $  9,000
l Level 4 - $10.00 for WRVUs from 3,001-4,000

1000 x $10=$10,000
l Level 5 - $11.00 for WRVUs above 4,000 (max 9,999)

1200 x $11=$13,200

His total compensation will be 5200 $54,720.

CompRate A five-tiered model where volume drives the rate paid. (Highest tier for
volume is paid at that tier rate) For example, Dr. Champion has total
WRVUs of 2,500.
l Level 1 – Threshold=1,000 $0
l Level 2 – Threshold=2,000 $0
l Level 3 – Threshold=3,000 2500 x $ 45 = $112,500
l Level 4 – Threshold=4,000 $0
l Level 5 – Threshold=9,999 $0

His total compensation will be 2500 $112,500.
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Model Description

CompStep A five-tiered model where an employee is paid a different rate, by tier, over
the course of a contract year. For example, Dr. Quintin has totalWRVUs of
1,800.
l Level 1 - $40.00 for WRVUs up to 750

750 x $40= $30,000
l Level 2 - $43.00 for WRVUs from 751-1,000

250 x $43= $10,750
l Level 3 - $45.00 for WRVUs from 1,001-1,500

500 x $45= $22,500
l Level 4 - $47.00 for WRVUs from 1,501-2,000

300 x $47= $14,100
l Level 5 - $50.00 for any Writs above 2,000 (max 9,999)

$0

Her total compensation will be 1800 $77,350.

Comp3Tier A three-tiered model where an employee is paid one rate up to a max and
another rate for any volume over themax. There is also a rate if it is below
a minimum level of volume. For example, Dr. Brush has totalWRVUs of
5,000.
l Level 1 - $32.00 if his totalWRVUs were below 3,600

$0
l Level 2 - $36.00 for all WRVUs up to 4,800

4800 x $36= $172,800
l Level 3 - $48.00 for WRVUs above 4,800

200 x $48= $9,600

His total compensation will be 5000 $182,400.

Max The highest value of Salary, Guarantee, CompRate, CompStep, and
Comp3Tier calculations.

AltRate Uses the same logic as CompRate. A five-tiered model where volume drives
the rate paid. (The highest tier for volume is paid at that tier rate.) Use this
model to compare an alternate CompRate table.

AltStep Uses the same logic as CompStep. A five-tiered model where an employee
is paid a different rate, by tier, over the year. Use this model to compare an
alternate CompStep table.

Alt3Tier Uses the same logic as Comp3Tier. A three-tiered model where an
employee is paid one rate up to a max and another rate for any volume
over themax. There is also a rate if the volume is below a minimum level.
Use this model to compare an alternate CompStep table
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Model Description

Percent of Net
Receivable

Calculates a percent of cash collections from the Provider sheet to use for
compensation calculations. The percentage to use needs to be entered on
the ProviderList sheet of the Budget Provider Assumptions driver file. For
example, Dr. Champion takes cash collections and receives 25%. If his
budgeted cash collections is $1,000,000, then his total compensation will
be $250,000. For example, $1,000,000 * 25% = $250,000.

Percent of Net
Revenue

Calculates a percent of net revenue by calculating Gross Charges minus
Allowances from the Provider sheet to use for compensation calculations.
The percentage to use needs to be entered on the ProviderList sheet of the
Budget Provider Assumptions driver file. For example, the Gross Charges
for Dr. Champion are $2,000,000 and Deductions are $1,500,000. He will
receive 40% of Net Revenue. As a result, his total compensation will be
$200,000. Example: $2,000,000-$1,500,000=$500,000 * 40%=$200,000

GlobalProvider Allows for a calculation amount that is calculated outside of the budget
workbook. This amount is entered into the GlobalProvider sheet in the
Budget Provider Assumptions driver file. The amount then pulls into the
budget workbook in the ProviderComp sheet.
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Rolling Forward to a New Fiscal Year
IMPORTANT: Upgrade Axiom to themost current release, and then follow these steps. Also make
sure you're not in an active budget cycle.

As part of the implementation process, a Kaufman Hall Implementation Consultant helps you create a
budget file group for the current year, as discussed the section Setting Up Budget Plan Files. As part of
the implementation process, a Kaufman Hall Implementation Consultant helps you create a budget file
group for the current year, as discussed the section "Setting up budget plan files" in the online help.

For the next or subsequent file year, however, there are steps you need to complete to set up next year's
file group. These steps include the following:

1. Archive the current year plan file. (Optional)

2. Prepare for the next fiscal year.

3. Review other system areas.

NOTE: To populate the Bud_Pay27 tables with budgeted hours, we recommend that you run the
Monthly to Biweekly utility located in the Reports Library >Management Reporting Utilities > Payroll.
For more information, see Payroll utilities see "Payroll utilities" in the online help.

Running the Budget Checklist process
Use this process to walk you through the steps needed to create plan files for the next budgeting season.
The Budget Checklist process displays all of the steps to complete on the left side of the window. Those
steps that include sub-steps are indicated with an arrow icon, which you can click to expand or contract
the list.

To run the Budget Checklist process:
1. In the Bud Admintask pane, in the Prepare Budget Plan Files section, double-click Budget

Checklist.
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2. In the Process Owner field of the Process Properties tab, do one of the following:
l To assign a specific user as process owner, click Select User.
l To assign users with specific roles as process owners, click Select Role.

NOTE: You must assign a user or role before you can run this process.

3. Click Start Process in the upper right corner of the dialog.

4. At the Start process 'Budget Checklist' prompt, click OK.

5. As you complete each step, click Complete step in the upper right corner of the screen.
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TIP: An arrow icon displays next to steps that contain sub-steps. Click the icon to expand or
contract the list of sub-steps.

NOTE: You can skip steps that do not apply to your organization.

6. In the Process Action dialog, you can enter any details about the step you performed, and click
OK.

TIP: The dialog also displays the next step in the process.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 742



7. If you need to stop the process as you work on the different steps, click Stop process in the upper
left corner above the list of steps. This places the process in an inactive status until you are ready
to start the process again.

TIP: To view a report of the process history, click Process history in the upper left corner above
the list of steps.

8. At the Are you sure that you want to stop this process? prompt, click OK.

1. Archiving current year plan files (optional)
The Archive Current Year Plan Files command allows you to convert the current plan files in a file group to
static snapshots of the files, for viewing only. This command is intended to be used in cases where
planning is finished for the file group, but you still want the ability to view the finalized plan files.
However, you do not want the plan files to be updated with new data or save data to the database.

When you run this command, the system first creates a plan file restore point, so that you can restore
the plan file if a user accidentally executes it. Then, the system opens each plan file and normal "open
processes" occur, including applying default views, hiding sheets, and executing refresh-on-open Axiom
queries and data lookups.

NOTE: The plan file starts out in the same state it would be in if the user executing the command
opened the file normally.

The system then processes each plan file as follows:

l Converts all formulas in the plan file to values.
l Deletes all control sheets. This disables any process that depends on a control sheet, such as

Axiom queries or save-to-database.
l Disables refresh variables, action codes, and data lookups by prefixing the primary tags with an x.

For example: [xActionCodes].
l Applies workbook and worksheet protection, as configured on the original default Control Sheet.
l Saves the plan file in this static state.
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When a plan file is opened after being archived by the command, data queries will not run because there
is no longer any Control Sheet, and no formulas are left to be calculated. Manually refreshing the file will
have no effect. Users can still save the file if they have read/write access to it, but save-to-database
processes will no longer execute because there is no longer any Control Sheet.

IMPORTANT: The system processes all plan files using the permissions of the user who is executing
the command. This means that the plan files will be opened, refreshed, and then "frozen" based on
the permissions of that user. All users who open the archived files will see the plan files in the same
state. For example, if the "live" plan file used formulas to dynamically show and hide sheets based on
the current user's permissions, this will no longer apply to the archived file.

After you run this command, you can reverse the archive process by restoring the previous versions of
plan files using the restore point created by the command. For more information, see "Restoring
archived plan files" in the online help.For more information, see Restoring archived plan files.

TIP: As a back up measure, you can also export the plan file to a network folder, import it back into
the system, and save over the range valued plan file, if needed.

To archive current year plan files:
1. In the Bud Admin task pane, in the Budget System Maintenance section, double-click Archive

Current Year Plan Files.

2. At the Are you sure you wish to archive file group 'Budget-year' file group? prompt, to
continue, click Yes.

NOTE: The system determines the budget file group to archive based on the file group
associated with the current year's budget plan.

IMPORTANT: Confirm your File Group Alias for Current Year is pointed to the file group you
intend to archive.
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2. Preparing for the next fiscal year
If you are applying the update, then it is likely you are ready to prepare your system for the next fiscal
year. This section includes some of the common steps, but it may not be an exhaustive list so please
contact Kaufman Hall Support with any questions.

l Update system periods
l Update year and period tables
l Update payroll dates tables
l Update the current payroll schedule

The new budget file group is now active, but see 3. Reviewing other systems for the new fiscal year to
make sure all systems have been reviewed and updated before you begin working with the new budget
file group.

3. Reviewing other systems for the new fiscal year
Refer to the budget checklist and all of the topics related to it. Although the budget file group is now
active, there remains a few system areas to review and possibly update.

l Bring data current – Bring the GL and Statistic data current.
l Verify Budget Control columns in the DEPT dimension table – Validate that the DEPT dimension

key Budget columns have been reviewed and updated.
l Verify the Budget Control columns in the ACCT, JOBCODE, and PAYTYPE dimension tables
l Load updated employeemaster data.
l Build 1-5 sample budgets for verification.
l Adjust dimension budget settings and driver information accordingly.
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Managing System Administration
This section includes topics related to system administration tasks for Axiom Budgeting and Performance
Reporting.

Configuring the home page
The Axiom Budgeting and Performance Reporting home page is Excel-based and table-driven, with each
section populated from table records. You do not need to modify the file itself, but instead you use a
template to make your changes.

NOTE: To update the home page tables, users must be assigned the Suite Admin role since the tables
may contain content that impacts all Axiom Healthcare Suite products.

The home page is comprised of the following sections:

Section Description

Announcements Post up to 8 announcements

Calendar Post up to 8 calendar items

Contacts Post up to 8 contacts

Dashboards Post up to 8 dashboard links

Key Reports Post up to 8 key report links

To configure the home page:
1. In the Explorer task pane, in the Libraries section, click Table Library > System Tables.

17
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2. Double-click the following tables to configure the corresponding section of the home page. The
following tables outline the rules for each data field.

NOTE: Only enter information in the fields listed in these tables.
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� HPAnnouncements (Announcements)

Data Field Parameters

AnnounceID Use number 1 – 8 for the order to display the announcement.

Product UseGlobal.

Type Use Announcement.

Description Type a description of the announcement. (Max length of 60 characters)

� HPAnnouncements (Calendar)

Data Field Parameters

AnnounceID Use number 1 – 8 in the order to display the calendar item.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 748



Data Field Parameters

Product UseGlobal.

Type Use Calendar.

Description Type a description of the calendar item.

CalendarDate Enter the date and time for the calendar item.

� HPContacts (Contacts)

Data Field Parameters

ProductID Type a number 1 – 8 in the order to display the contact item.

ProductDescription Type a contact description (description or name).

Contact Type contact information (name or phone number).

ProductRef TypeGlobal.
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� HPOtherSection (Dashboards)

Data Field Parameters

HPOtherID Type number 1 – 8 for the order to display the dashboard item.

NOTE: Because this table allows you to include dashboards and reports, the
number you assign to a dashboard cannot be the same number used for a
report. In the example above, the HPOtherID 1 is assigned to a report, so you
cannot assign this number to a dashboard.

Section1 TypeDashboard.

Section2 Enter the document path by copying it from Explorer and pasting it into this
field.

Section3 Type a name for the dashboard to display on the home page.

ProductRef TypeGlobal.

� HPOtherSection (Key Reports)

Data Field Parameters

HPOtherID Type a number 1 – 8 in the order to display the key report.

NOTE: Because this table allows you to include both dashboards and reports,
the number you assign to a report cannot be the same number used for a
dashboard. In the example above, the HPOtherID 11 is assigned to a
dashboard, so you cannot assign this number to a report.
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Data Field Parameters

Section1 Type Report.

Section2 Enter the report file path by copying it from Explorer and pasting it into this
field.

Section3 Type a name for the key report to display on the home page.

ProductRef TypeGlobal.

3. After making changes to the appropriate table, in theMain ribbon tab, click Save.

IMPORTANT: To see the changes you made to the home page, you must log out and log back into
the system.

Hiding or displaying items in the task panes
Axiom Budgeting includes many different utilities, drivers, files, and other items in the Bud Admin task
pane. If your organization does not use some of these items, you can remove them from the task pane
to make finding what users need easier.

To hide or display items in the task panes:
1. At the top of the Bud Admin task pane, double-click Configure Budget Admin Task Pane or

Configure Budget User Task Pane.

2. In the Configure Item Visibility dialog, do any of the following:

l To hide an item, clear the check mark next to the item name.
l To display an item, click the empty check box next to the item name.
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3. After you are donemaking changes, click OK.

4. Close and reopen the Budgeting or Bud Admin task pane to propagate the changes.

Importing and Integrating Source Data
To ensure that all statistics and drivers used in calculations are up to date, you will need to periodically
import data from other systems such as General Ledger, Accounts Payable, Payroll, and so on. Your
Kaufman Hall Implementation Consultant will help configure automated import processes for most of
these systems during implementation. From there, it is your responsibility as Administrator to ensure
that source data is available in the designated location in the requisite format when needed.

Importing Data
Imports can be used to import external data into Axiom Budgeting and Performance Reporting tables, so
that the data can be included in reports or used in planning models and calculations. Data can be
imported from files or by directly reading a database.

Imports are created in the Import Wizard, and stored in the Imports Library. Access to imports is
controlled via security.

For Axiom Cloud systems, a remote data connection can be used to access local databases or files for the
import data source.
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About imports

Imports can be used to import external data into Axiom Budgeting and Performance Reporting tables, so
that the data can be included in reports or used in planning models and calculations. This topic explains
some of the key concepts and requirements for importing data.

� Import sources
You can import data into Axiom Budgeting and Performance Reporting from the following sources:

l From an external database
l From a file (delimited or Excel)
l From special designated sources, such as Ellucian

� Import Wizard
Imports are defined in the Import Wizard dialog. Imports consist of the following:

l Source tab: Specifies the source of the data to be imported.
l Variables tab: Defines variables to be used in the import, in order to dynamically change certain

import settings.
l Mapping tab: Specifies the destination table for the import, and maps the import data to columns

in the destination table.
l Transforms tab: Defines transformation statements to be performed on the import data before it

is saved to the destination table. Transforms can use SQL or built-in Axiom Budgeting and
Performance Reporting functions.

The Import Wizard also contains the Execute tab, which can be used to execute the import in preview
mode for testing, or to execute the actual data import.

� The import process
When data is queried from the source file or database, it is first placed in a temporary table known as the
temp table. The import can perform actions on the temp table before the data is saved to the
destination table in Axiom Budgeting and Performance Reporting, such as mapping or data
transformations. Use the reserved term {temptable}whenever you want to refer to this temporary
table in SQL statements.

When an import is executed, the following processes occur:
1. If any import variables are defined on the Variables tab, the user is prompted to select values for

these variables. The selected variable values are then substituted for the variable names within
the import settings.

When running the import using a Scheduler job, you must specify values for the import variables
within the Scheduler import task, or use job variables that will populate the import variable values
when the job is executed.
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2. The import creates the temp table by querying data from the source database or by gathering
data from the specified file. The settings on theMapping tab are used to determine the structure
of the temp table. You can insert additional columns into the temp table (meaning columns that
were not in the source file or table) by adding them as work column mappings.

3. Any transforms defined on the Transforms tab are processed, in the order listed. Transforms can
edit the temp table directly, and they can reference information held in other tables in the Axiom
Budgeting and Performance Reporting database. Transforms can also set values for transform
variables, which can then be used in subsequent transform steps and in certain import settings.

4. The temp table data is validated and then saved to the destination table, based on the destination
column settings on theMapping tab. If a column in the temp table is not mapped, then that data
is not saved.

If the import utility is a multiple-file import, then steps 2-4 are performed for each file to be imported. For
more information, see Howmultiple-file imports work.

� Import save behavior
The save-to-database process for imports is performed as follows:

l If the destination table has any validated columns (columns that have an assigned lookup
column), then the temp table data is validated against these lookup columns before saving. If a
data row contains an invalid value, that data row is invalid and cannot be saved.

l By default, temp table data is aggregated before the save is performed. This means that duplicate
rows (rows with the same key column values) will be treated as follows:

o Columns holding numeric data will be summed.
o For all other column types, the duplicate rows must have the same values. For example, if a

column contains strings or dates, the duplicate rows must have the same string or the
same date.

If instead the optional setting Aggregate rows on final save option is disabled, then no
aggregation is performed on the temp table data. In this case, any duplicate rows are invalid and
cannot be saved.

NOTE: Aggregation only applies when importing data to a data table. If the destination table is
a reference table, aggregation is not allowed. If duplicate keys are present in the import data,
those rows are invalid and cannot be saved to the reference table.

l Blanks are not allowed in key columns. If a data row in the temp table contains a blank key value,
that data row is invalid and cannot be saved.

If any invalid rows are present in the import data, the import behaves as follows:
l By default, if any invalid data rows are present, then the import is aborted and no data is saved to

the destination table.
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l If instead the optional setting Ignore lookup and key errors is enabled, then the save-to-database
process ignores the invalid data rows and only valid data rows are saved.

Managing imports

Using the Importsmenu, you can create, edit, and delete imports as needed. Each import can import
data from a designated source to a designated destination table.

For information on how to execute an import, see Executing imports.

� Creating an import
Only administrators and users with the Administer Imports security permission can create imports. Non-
admin users must also have read/write access to at least one folder in the Imports Library, in order to
have a location to save the newly created import.

1. On the Axiom tab, in the Administration group, click Imports > Create New Import.

NOTE: In systems with installed products, this featuremay be located on the Admin tab.

TIP: You can also create new imports by right-clicking the Imports Library in the Axiom Explorer
dialog or the Explorer task pane.

2. In the Create New Import dialog, select one of the following and then click OK.
l Create from scratch (default): Create a new import starting with blank import settings.
l Create from existing: Create a new import by copying an existing import. If you select this

option, then select the import that you want to copy from the list in the bottom of the
dialog.

3. In the Import Wizard dialog, complete the settings on each tab as appropriate. For details on
specific import settings, see Import Wizard.

If you copied an existing import, that import's settings are copied into the Import Wizard, and the
import is named "Copy of ImportName." Edit these settings as appropriate for the new import.

You can move between tabs in any order, however, before you can save the import, all required
settings must be completed and no invalid settings must be present. If errors exist, an error
message displays at the bottom of the dialog; you can click the error link to be taken to the tab
with the error.

4. When you are finished completing the settings and no errors exist, click OK to save the import.

5. In the Save As dialog, navigate to the folder where you want to save the import, then click Save.
By default, the import will be saved to the root of the Imports Library. You can create a new sub-
folder from this dialog if desired (and if you have the appropriate permissions).

Once an import has been created, it becomes available on the Importsmenu (to users with the
appropriate permissions). Imports are listed in alphabetical order based on the import name.
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� Editing an import
You can edit existing imports as needed, as long as the import was not installed by a product package.
Only administrators and users with read/write access to the import file can edit imports.

Product-controlled imports are locked and cannot be edited. Some of these imports may be designed to
work as is, without customizations. If customizations are required, you can create a copy of the product-
controlled import and make customizations in the copy. If the original import is later updated by the
product, you can review the original import to see the changes that need to bemade in your copy (or
you can create a new copy of the import and re-make your customizations as needed).

To edit an existing import:
1. On the Axiom tab, in the Administration group, click Imports > ImportName > Edit.

NOTE: In systems with installed products, this featuremay be located on the Admin tab.

TIP: You can also edit an import from the Axiom Explorer dialog or the Explorer task pane. You
can double-click an import in the Imports Library to open it.

2. In the Import Wizard dialog, edit any import settings as desired. For details on specific import
settings, see Import Wizard.

3. Click OK to save your changes the import, or click Save As to save the edited import as a new
import file.

� Deleting an import
You can delete an existing import if it is no longer needed, as long as the import was not installed by a
product package. Only administrators and users with read/write access to the file and its folder can
delete imports.

Product-controlled imports are locked and cannot be deleted.

To delete an import:
l On the Axiom tab, in the Administration group, click Imports > ImportName > Delete.

NOTE: In systems with installed products, this featuremay be located on the Admin tab.

TIP: You can also delete an import from the Axiom Explorer dialog or the Explorer task pane.
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Using variables in imports

Imports can use variables, so that certain import settings can change dynamically depending on the
variable value. You can use two different types of variables in imports:

l Import variables: Import variables are defined on the Variables tab of the Import Wizard. Import
variables can be used throughout the import settings (though not in all settings—see the
documentation for each setting to see if variables are supported there). When the import is
executed manually, the user is prompted to define values for the variables. If the import is run
using Scheduler, the Scheduler job must define values for the variables.

l Transform variables: Transform variables are defined on the Transforms tab of the Import
Wizard. Transform variables can only be used in transform statements, and as destination
columns. Transform variables are associated with a specific SQL statement that results in a single
value.

The values for import variables are defined at the start of the import, before any other import steps are
processed. Therefore import variables are a good fit for actions such as:

l Selecting the appropriate source file based on user input.
l Selecting the appropriate destination table based on user input.

On the other hand, values for transform variables can only be determined as a result of a SQL statement,
and are defined near the end of the import, after the temp table has been created. Transform variables
are a good fit for situations where actions need to be driven dynamically based on the contents of the
imported data, not by a user selection.

� Variable syntax
To use a variable in the import, enter the variable name into one of the supported areas of the import
settings, enclosed in curly brackets {}. For example, if the variable name is "mycolumn", you would enter
{mycolumn}.

NOTE: If the variable defines the destination table, then you must place the variable in double curly
brackets when you use it in a SQL statement, so that the eventual table name value is enclosed in
curly brackets as expected. For example, if you have a variable named "destinationtable", you would
reference that variable as {{destinationtable}}. That way, when the {destinationtable}
value is defined, it will resolve as {GL2020}.

� System variables
In addition to the user-defined variables, you can reference system variables in imports. The following
variables are supported:
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System Variable Description Can Be Used In
{CurrentPeriod} The current period as

defined for the destination
table (if not set, then this is
the system current period).

All import locations that
support variables, except
the destination table.

{CurrentUserDomain} The domain name of the
user running the import.
Returns blank for users who
do not have a defined
domain.

All import locations that
support variables.

{CurrentUserEmail} The email address of the
user running the import.

All import locations that
support variables.

{CurrentUserLogin} The login name of the user
running the import.

All import locations that
support variables.

{DefaultRemoteDataConnection} The name of the default
remote data connection for
your system. If your system
has multiple defined
connections, then the
default is determined
alphabetically among the
connections that are not
enabled for authentication.
If all of the connections are
enabled for authentication,
then the default is simply
determined alphabetically.

If the variable is used in a
system without any remote
data connections, then the
variable returns blank and
the import will not attempt
to use a remote data
connection. This allows
products to develop
standard imports for use in
both on-premise and Axiom
Cloud systems.

In the Remote Data
Connection field on the
Source tab, or as an
import variable choice.
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System Variable Description Can Be Used In
{SourceFileName} The name of the source file

for the import.
Import transformation
steps only.

{SystemCurrentYear} The current year as defined
for the system.

All import locations that
support variables.

{SystemCurrentPeriod} The system current period. All import locations that
support variables.

{TempTable} The temporary table where
imported data is placed
before saving to the
destination table.

All import locations that
support variables.

{TableName} Any user-defined table
created in the Axiom
Budgeting and Performance
Reporting system. For
example, {ACCT}, {DEPT},
{GL2020}, {BGT2020}.

All import locations that
support variables.

Executing imports

When you execute an import utility, data is queried from the source database or file, import steps are
processed, and the resulting data is saved to the destination table. For more information on what occurs
when an import is executed, see About imports.

Only administrators and users with Execute permission to the import file can execute an import.

NOTE: You can also use Scheduler to execute import utilities, using the Import ETL Package task.

To execute an import:
1. Do one of the following to open the import for execution, depending on whether you need to

access the full import settings:
l Open the full Import Wizard: On the Axiom tab, in the Administration group, click

Imports > ImportName > Edit. Then in the Import Wizard, go to the Execute tab.

Using the Import Wizard, you can switch between the Execute tab and other tabs to view
and edit the import settings as needed, and then run the import again.

l Open in execute-only mode: On the Axiom tab, in the Administration group, click Imports
> ImportName > Execute.
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This opens a special Execute Import dialog that only displays the import execution options
and controls. Use this mode if you only need to execute the import and you don't need to
review or edit any import settings. This is the only mode available to users who have
execute-only permissions to the import.

NOTE: In systems with installed products, these features may be located on the Admin tab.

TIP: You can also open imports for execution using Axiom Explorer or the Explorer task pane. If
you have read/write or read-only access to the import, the full Import Wizard opens. If you
have execute-only permission to the import, then the Execute Import dialog automatically
opens when you access the import from the Imports Library.

2. Click Execute to start the import.

The option at the top of the dialog, Execute in development mode, should only be used if you
want to test or troubleshoot the import. When development mode is enabled, the import is
executed, but the data is not saved to the destination table. For more information, see Executing
imports in development mode.

3. If the import uses variables, the Variables dialog opens so that you can to define values for the
variables. For each variable, you can select a value from the drop-down list. Some variables may
also allow you to type in a user-defined value.

4. If the import uses a source file, you may be prompted to specify the location of the source file. In
theOpen dialog, navigate to the file that you want to use and then click Open.

In this case, a copy of the specified file is uploaded to the application server for processing. Once
the import is complete, the temporary copy of the file is deleted.

As the import is processed, status messages display in the Execution log box. If an error occurs, the error
message displays in the log and the import is stopped. If necessary, you can copy and paste the text in
the execution log—for example, to send the error to Axiom Support. To copy the log text, right-click
inside the log and choose Select All, then select Copy.

TIP: If an import experiences an error and you need more information on the error, try running the
import in development mode. The error messages in development modemay contain more detail.

If you want to stop the import while it is executing, click Stop. The import stops after completing the step
that is currently in-process. You cannot restart the import at the same spot—when you click Execute, the
import starts over from the beginning.
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� Import validation errors
If the import experiences import validation errors, then those errors are logged to a separate CSV file in
addition to being displayed in the Execution logwithin the dialog. You can open this file separately to see
exactly which rows of data were invalid within the context of the import data.
The error file includes the following information:

l Lookup validation errors from Axiom Budgeting and Performance Reporting's built-in validation
against lookup columns.

l Validation errors from any Custom Data Validation steps in the transforms.
l Key validation errors such as blank keys or duplicate keys.

You can open the file from the Execute Import dialog by clicking the link in the Status area. The status will
be either "failed" or "warning," followed by the text "click here to open errors in a spreadsheet." The
status type depends on whether the option to Ignore lookup and key errors is selected.

Example link to open validation errors in a spreadsheet

The CSV file contains the import data, followed by one or more validation columns. Validation columns
are labeled as follows:

l Lookup and key validation messages are in a column named LookupColumnName Lookup Error.
For example: "Acct Lookup Error" when looking up against the ACCT column.

l Custom Data Validation messages are in a column named AXTRANSFORM_StepNumber, where
StepNumber is the number of the associated transformation step. For example: "AXTRANSFORM_
5" when the associated transform is step 5 in the list.

The error CSV files are placed in a system-maintained folder in the Imports Library named Import Errors.
Access to the error files is automatically managed based on access to the import. You can access the
error file directly later by using the Explorer task pane or Axiom Explorer.
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Each execution of an import that results in a lookup error generates a unique error file (differentiated by
a date/time stamp). These error files are not automatically deleted; you must manually delete them
when you are finished investigating the error.

Executing imports in development mode

You can execute an import in development mode, in order to test import settings or troubleshoot an
import issue. In development mode, all import steps are performed except for the last step that saves
the temp table data to the destination table.

When executing in development mode, additional options are available:
l You can pause the import after certain transformation steps are performed, and view the data in

the temp table as it exists after performing the step. Reviewing this data can help you determine if
a particular transform is working as you expect. If an import doesn't have defined transformation
steps, you can view the import data as it exists after the temp table is populated from the source
data.

l For delimited file imports, you can limit development mode processing to a certain number of
rows, for more efficient testing and troubleshooting.

IMPORTANT: When an import is run in development mode, all of the steps in the Transforms tab are
performed, including any steps that modify tables other than the temp table. If you do not want
these steps to occur during testing, then you should disable the step on the Transforms tab before
executing the import in development mode.

To run an import in development mode:
1. Do one of the following to open the import for execution, depending on whether you need to

access the full import settings:
l Open the full Import Wizard: On the Axiom tab, in the Administration group, click

Imports > ImportName > Edit. Then in the Import Wizard, go to the Execute tab.

Using the Import Wizard, you can switch between the Execute tab and other tabs to view
and edit the import settings as needed, and then run the import again.

l Open in execute-only mode: On the Axiom tab, in the Administration group, click Imports
> ImportName > Execute.

This opens a special Execute Import dialog that only displays the import execution options
and controls. Use this mode if you only need to execute the import and you don't need to
review or edit any import settings. This is the only mode available to users who have
execute-only permissions to the import.

NOTE: In systems with installed products, these features may be located on the Admin tab.
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TIP: You can also open imports for execution using Axiom Explorer or the Explorer task pane. If
you have read/write or read-only access to the import, the full Import Wizard opens. If you
have execute-only permission to the import, then the Execute Import dialog automatically
opens when you access the import from the Imports Library.

2. In the Execute Import dialog (or the Execute tab of the Import Wizard), select Execute in
development mode.

Once development mode is enabled, theDevelopment Mode Options section becomes available.

3. Select theDevelopment Mode Options as needed:

Option Description

Limit the
number of
rows imported
to

Limits the development mode processing to a specified number of rows.
When testing the import, you may only need to process a handful of rows
in order to verify that the import is working as expected. Using a smaller
number of rows speeds import processing.

After selecting this option, enter a number of rows from 1 to 1000 into the
box. By default, the row limit is 1000.

NOTE: This option is only available when the import source is a delimited
file or Ellucian. If the import source is a database, you can limit the number
of rows by setting a temporary WHERE clause in the SQL Select Statement.

Pause after
specified
transforms and
display current
temp table
data

Specifies whether pauses are honored during development mode
processing.
l If enabled, then Axiom Budgeting and Performance Reporting honors

the pause settings on the Transforms tab. If a step has Pause enabled,
then the import pauses after performing the step, and displays the
temp table in the View Data dialog. When the dialog is closed, the
import continues to the next step. See Troubleshooting transforms
using pause.

l If disabled (the default setting), then the import continues without
pausing, regardless of whether any steps are flagged with Pause.

NOTES:
l This option is only available in the Execute tab of the full Import

Wizard, and only if you have read/write access to the import.
l If the import does not have any transforms, this option is renamed to

Pause and display temp table data after preview data is fetched. If
enabled, the temp table is populated with data from the import
source, and then the temp table data is displayed in the ViewData
dialog.
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NOTE: Development mode and its options only apply to the current import session—these
options are not saved in the import settings.

4. Click Execute to run the import in development mode.

The import is executed and status messages display in the Execution log as normal. If pauses are
enabled, the import pauses at the designated steps to display the View Data dialog. After closing the
dialog, click Continue to continue processing. Once all transform steps have been executed, the import
stops before saving data to the destination table.

� Troubleshooting transforms using pause
When running an import in development mode, you can configure the import to pause after performing
certain transform steps, and view the data in the temp table.

To configure an import to pause after a transform:

l On the Transforms tab, select the Pause check box for the transform.

l On the Execute tab, select Execute in development mode and then select Pause after specified
transforms and display current temp table data.

When the import is executed in development modewith pauses enabled, it continues until it reaches a
transform step that is configured to pause. After completing that step, the import pauses and shows the
current temp table data within the View Data dialog.
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Example View Data dialog

Using this dialog, you can view and filter the data to help determine whether the transform is working as
expected. When you are done viewing the data, click Close to return to the import. At this point the
import is still paused. You can click Continue to continue the import, or Stop to stop it.

By default, the View Data dialog shows the first 500 rows of data in the temp table. This row limit is
controlled by the ETLMaxRows system configuration setting. If desired, you can filter the data to make it
easier to find specific records you might be looking for. To do this, click Show Filter in the top right
corner of the ViewData dialog. This enables the following filter options for the dialog:

Item Description

Filter Type a filter to limit the data shown in the dialog. The filter must use column-only
syntax, using a column name in the temp table. For example:

Dept=45000

Where Dept is a column in the temp table.

Row count Type a number to limit the data to a certain number of rows. Themaximum
number of rows that can be shown is 5000.

Columns Select or clear columns to limit the temp table columns that display in the dialog.
You can use the All orNone options to select or clear all columns at once.

If you clear a column, then that column cannot be used in the filter.

NOTE: At least one column must be selected to display. If no columns are
selected, then all columns will display.

After modifying the filter options, click Refresh to filter the data in the dialog using your selections. To
clear your filter options and return to the default dialog, click Hide Filter.
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Example View Data dialog with filter options

Import Wizard

Using the Import Wizard, you can create new imports and edit existing imports. Import settings are
organized by tab.

Tab Description

General Defines the name of the import and other general settings.

Source Specifies the source of the data to be imported, and how to access it.

Variables Defines variables to be used in the import, in order to dynamically change
certain import settings.

Mapping Specifies the destination table for the import, and maps the import data to
columns in the destination table.

Transforms Defines transformation statements to be performed on the import data before
it is saved to the destination table. Transforms can use SQL or built-in Axiom
Budgeting and Performance Reporting functions.

Execute Execute the import. You can run the import normally, or you can run it in
development mode for testing and troubleshooting purposes.

NOTE: It is possible to configure user permissions so that a user has read/write
or read-only access to the import utility file, but the user does not have execute
permissions for the import. In this case, the Execute tab is hidden.

As you complete the import settings, the Import Wizard performs error checking for missing required
settings and invalid settings. If an error is detected, an error message displays in the bottom of the
dialog. You can click the link to be taken to the tab that contains the error. Only one error is displayed at
a time; once you resolve the current error message, a newmessagemay appear.
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Import Wizard: General tab

On theGeneral tab of the Import Wizard, you can define general properties for the import—such as the
import name and save options.

Item Description

Import Name The name of the import. The import name is how you access and execute
imports from the Importsmenu, and in other areas such as the Import ETL
Package task in Scheduler.

Description Optional. The import description. The description can be used to document the
purpose of the import and/or to detail important import instructions. The
description is limited to 2000 characters.

When an import is opened in execute-only mode, the description can be viewed
by clicking the Show description link in the Execute Import dialog.

Save Options
The save options impact how data is saved to the destination table when the import is executed.
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Item Description

Ignore lookup
and key errors

Specifies the import behavior if lookup and key errors exist in the temp table
data before saving to the destination table. These errors include invalid lookup
data, blank keys, and duplicate keys.
l If enabled, then any rows with lookup and key errors are ignored, and only

valid rows are saved to the destination table. Once the import is complete,
an error log is provided to detail the invalid rows. For more information, see
Import validation errors.
This option allows you to continue to save valid data even if invalid data is
present. You can then investigate the invalid data, make corrections, and
reimport.

l If disabled (the default setting), then the import is aborted if any lookup and
key errors exist in the temp table data. No data is saved to the destination
table.

NOTES:
l If this option is enabled and the import is executed by Scheduler, the

execution status of the job is set to Partial Success if any errors are found.
This will result in an email notification if the job is set to notify only on error.

l This option does not apply if a Pre-Save Validation function is used in the
import's transform steps. If this function is used, then the import is aborted
if any validation errors are found, and no further import steps are
processed.

l Duplicate keys count as an error condition when saving to a reference table,
or when Aggregate rows on final save is disabled.

Aggregate rows
on final save

Specifies whether duplicate rows are aggregated during the final save to the
destination table. Duplicate rows are rows that have the same key column
values.
l If enabled (the default setting), then duplicate rows are aggregated before

saving data to the destination table. This aggregation process may take
some time for large imports.

l If disabled, then the temp table data is not aggregated before saving data to
the destination table. If any duplicate rows exist, the import is aborted and
no data is saved to the destination table. You can optionally use the Ignore
lookup and key errors option to instead exclude the invalid rows and only
import valid rows.

Disabling this option may improve import performance for large imports where
aggregation is not necessary.

NOTE: This option does not apply when the destination table for the import is a
reference table, or any table with an identity key column.
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Item Description

Bypass updating
existing rows
when saving to
the destination
table

Specifies whether the import saves both updated data and new data, or just
new data.
l If enabled, then only new records of data are saved to the destination table

when the import is run. Updates to existing records are ignored.
l If disabled (the default setting), then new records and updates to existing

records are saved to the destination table when the import is run.

Enabling this option may improve import performance for use cases where the
import source is not expected to contain updates to existing data. Keep in mind
that if you enable the option and the import source does contain updates to
existing data, the updates are simply ignored with no warning.

NOTE: If this option is enabled, existing records in the source data may still
cause import errors, even though these records will be ignored for the final save
to the destination table.

Import Wizard: Source tab

The Source tab of the Import Wizard specifies the source of the data to be imported. The contents of the
tab depend on the Import type selection at the top of the tab.

The available import types are as follows. Select the type that corresponds to the source of the data that
you want to import:

Import Type Description More Information

File Use to import data from a file:
l Delimited files or Excel files
l A single file or multiple files

Importing from one
or more source files

External
database

Use to import data from an external database. The
following database connections are supported:
l SQL Server
l Oracle
l OLEDB
l ODBC

Importing from an
external database

NOTE: The OLEDB source type can also be used to import data from a file. If you want to import from
a file that is not one of Axiom Budgeting and Performance Reporting's supported file types, you may
be able to use the OLEDB source type. The database connection strings can be configured to pull
data from various file types.

The topics in this section detail the requirements and import settings for each import type.
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Importing from one or more source files

You can import data into Axiom Budgeting and Performance Reporting from a file, using either a
delimited file or an Excel file. You can import from a single file, or from multiple files that use the same file
structure.

� File requirements
When using a delimited file, the file must meet the following criteria:

l Delimiters can be any character. You specify the delimiting character in the import settings.

l The first row of the file can optionally contain column header names.

l Numeric values cannot be in scientific notation or formatted with extraneous characters such as
currency signs or parentheses.

When using an Excel file, the file must meet the following criteria:
l The file format must be XLS or XLSX. XLSM files cannot be imported.

l The first row can optionally contain header names.

l Each column in the Excel file translates to a column in the destination table. Each row in the file
translates to a data record in the table. Blank columns and rows are ignored.

l The data in the spreadsheet must match the designated data type for the destination column. For
example, if numeric values in the spreadsheet are prefixed with a quotation mark, then Excel
considers those values to be strings instead of numbers. This will cause an error if attempting to
import these string values into a numeric column.

Import source files can be no larger than 2GB. Additionally, some import features may impose a smaller
file size limit. If the source file exceeds the file size limit, it should be split into multiple smaller files.

� Source configuration
To import data from a file, complete the following configuration settings on the Source tab of the Import
Wizard.

General settings
The following settings are always present at the top of the tab.

Item Description

Import type Select File to import data from a file.
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Item Description

Remote Data
Connection

If your Axiom Budgeting and Performance Reporting system is hosted on the
Axiom Cloud, and you are not using the Prompt for path during execution
option to allow the user to select a file, then you must specify a remote data
connection so that the Axiom Cloud can read the file located on your network.

You can select any remote data connection defined in your system, or you can
enter an import variable name. For example, you can enter the built-in system
variable {DefaultRemoteDataConnection} to automatically use the default
remote data connection for your system. For information on how the default
remote data connection is determined, see System variables.

If no remote data connections have been defined in your system, then this
setting does not apply and will not display.

File import options
The following settings are present when File is selected as the import type.

Item Description

File type Select one of the following to specify the type of file to use as the import source:
l Delimited file: Import data from a delimited text file, such as CSV or

TXT files.
l Excel file: Import data from an Excel file (XLS or XLSX).
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Item Description

Source path Select one of the following to specify the location of the source file:
l Use specified path: Use this option if the file path is always known. To

specify the file path, use either the File path or Source folder setting,
depending on whether you are importing from a single file or multiple files.
The specified path must be accessible to the Axiom Application Server (for
on-premise installations) or to the Axiom Cloud Integration Service (for
Axiom Cloud systems).

l Prompt for path during execution: Use this option if you want the user to
be able to specify the file when running the import. You can optionally
complete theDefault folder setting to provide a starting point.
When using this option, a copy of the specified file is uploaded to the
application server for processing. Once the import is complete, the
temporary copy of the file is deleted.
NOTE: Files greater than 100MB cannot be uploaded using the "prompt"
option. While it is possible to increase this limit, it is not recommended.
Instead, you should use theUse specified path option if you need to import
a file larger than 100MB. Please contact Axiom Support if you need
assistance with a large file.

For more information, see Design considerations for the source path.

Import from Select one of the following:
l Single file: Use when importing data from a single designated file.
l Multiple files: Use when importing data from multiple files within a

designated folder. All of the files to be imported must use the same file
structure.
When importing from multiple files, additional configuration settings
become available on the Source tab, in theMultiple file options section.
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Item Description

File path

or

Source folder

This setting applies when Use specified path is selected for the Source path.
Specify one of the following, depending on whether you are importing a single
file or multiple files:
l File path: When importing from a single file, specify the path to the file. You

can type the file path or click the folder icon to navigate to the file.
l Source folder: When importing from multiple files, specify the path to the

folder. All of the files to be imported must reside in this folder. You can type
the folder path or click the folder icon to navigate to the folder.

Once the path is specified, Axiom Budgeting and Performance Reporting will
validate whether the application server or the cloud integration service can
access the file or folder, and will display an error if not.

If the path is to a network location, it must be a UNC path (i.e.
\\servername\foldername\filename). If you enter a mapped drive, the entry will
automatically be converted to a UNC path.

Import variables can be used in the path. See Using variables in imports.

NOTE: If a remote data connection is specified, then by default the file/folder
navigation dialog shows the folder structure of the server where Axiom Cloud
Integration Service is installed. If you need to point to a different location, you
can either manually type the file or folder path, or you can temporarily set
Remote Data Connection to <None>.

Default folder Optional. This setting applies when Prompt for path during execution is
selected for the Source path. Specify a folder path to use as the default location
when prompting the user to select a file. You can type the folder path or click
the folder icon to navigate to the folder.

If a folder is specified, then when the user is prompted to select a file, the file
selection dialog will open to this folder by default. The user can still browse to a
different location.

Import variables can be used in the path. See Using variables in imports.

File options (Excel)
The following options are present if the File type is Excel file.

Item Description

First row has
column names

Select this option if the first row of the file contains column names. If the first
row of the file contains data, leave this option unchecked.
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Item Description

Sheet name The sheet in the Excel file to import. Leave this blank to use the first sheet in the
file. Only one sheet can be imported.

Variables can be used to specify the sheet name. See Using variables in imports.

File options (Delimited)
The following options are present if the File type is Delimited file.

Item Description

First row has
column names

Select this option if the first row of the file contains column names. If the first
row of the file contains data, leave this option unchecked.

Import file has
multi-line values

Select this option if the import file has data where a field value splits across rows
(within the text qualifier). For example:

If this option is selected, then the split value will be read as a single import
value.

Delimiter In the box to the right of the option, enter the delimiting character used in the
source file. For example, if the delimiter is a comma, enter a comma into the
box.

If the delimiting character is a space or a tab, place your cursor in the box and
press the space bar or the tab key. The character will be indicated in
parentheses to the right of the box (since the character is not visible in this
case).

Text Qualifier By default, the text qualifier is double quotation marks ("). If desired, you can
enter a different character as the text qualifier, or you can clear the field if you
do not want to use a text qualifier.

The text qualifier is used when values in the source file may contain the
delimiting character. For example, if the delimiting character is a comma, but
the source file contains values such as full names that also contain a comma (for
example: "Doe, Jane"). In this case, the comma within the quotation marks is
considered part of the field value instead of starting a new field.
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Multiple file options
The following options are present if Import from is set toMultiple files.

Item Description

Import order Select one of the following to specify the order in which multiple files are
imported:
l Alphabetical: Files in the specified source folder are imported in alphabetical

order.
l Creation date: Files in the specified source folder are imported by creation

date (earliest first).

File filter Optional. Specify a filter to determine the files to import within the specified
source folder. If the filter is left blank, then all files in the folder are imported.

You can use wildcard characters (* or ?) to include groups of files that share
naming conventions. For example: North*.xls to collect all XLS files where the
file name starts with "North". Import variables cannot be used in the filter.

NOTE: The import attempts to process all files in the folder allowed by the file
filter, regardless of whether those files meet the specified file type for the import
(delimited or Excel). You should make sure that the folder only contains valid file
types, or set the filter appropriately so that invalid file types will not be
imported.

Archive folder Specify a target folder in which to archive source files after they have been
imported. You can type the folder path or click the folder icon to navigate to the
folder.

After the data in a file has been imported successfully, the file ismoved from the
original source folder to the archive folder. Files are not moved when running
the import in previewmode.

Import variables can be used in the path. See Using variables in imports.

NOTE: If a remote data connection is specified, then by default the file/folder
navigation dialog shows the folder structure of the server where Axiom Cloud
Integration Service is installed. If you need to point to a different location, you
can either manually type the file or folder path, or you can temporarily set
Remote Data Connection to <None>.
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Item Description

Add timestamp
prefix to file
names when
archiving
successful
import files

Optional. Select this option if you want to add a timestamp to the file names in
the archive folder.
l If enabled, then when a file is moved to the archive folder after a successful

import, the file is renamed so that the name starts with the current date and
time. This is intended to make it easier to find and identify files that were
imported as part of a particular import execution.

l If disabled, then file names are left as is when they aremoved to the archive
folder.

� Design considerations for the source path
There are two options to specify how the import obtains the source file: Prompt for path during
execution and Use specified path. When deciding which option to use, you should consider the
following to determine which option is most appropriate.

Prompt for path during execution

File permissions The file must be accessible by the user’s file system permissions.

Data flow l A copy of the file is streamed from the client machine to the application
server, then from the application server to the database server.

l The file copy on the application server is deleted after the import is complete.

Ramifications /
Limitations

l Slower performance (file is copied multiple times)
l Only available when running the import interactively
l Maximum file size of 100MB

Use specified path

File permissions l The file must be accessible by the application server or the cloud integration
service.

l The file path must be a UNC path, not a mapped drive (meaning
\\servername\foldername, not I:\foldername).

Data flow The file is streamed from the file source to the database server for import.

Ramifications /
Limitations

l Faster performance
l Maximum file size of 2GB
l Can be used in Scheduler
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� Howmultiple-file imports work
When the import is configured to usemultiple source files, the import works as follows:

l When the import begins, Axiom Budgeting and Performance Reporting inspects the source folder
and compiles a list of all files found in that folder. If a file filter is specified, the list is limited to only
those files that match the filter. If any files are added to the folder after this list is compiled, those
new files will not be imported during the current import execution.

If no files are found, the import stops. The absence of files to import is not an error condition.

l The files in the list are then imported sequentially, in the configured order (either alphabetical by
file name, or by creation date). For each file, the following occurs:

o Data is copied from the source file into the temp table.
o Transform statements are run.
o Data is saved to the destination table.
o The source file is moved from the source folder to the archive folder.

Each file must complete this import process successfully beforemoving on to the next file.

NOTE: If the import uses import variables, these values are set once, before the file list is
created. The import variables will remain the same for each file that is imported. However,
transform variables are set by transform statements. Since the transform statements are run
per file, it is possible that transform variables could resolve differently per file.

l If any file fails to import successfully, the import stops and the import status is set to Error. No
further files are imported. Currently, it is not possible to configure the import to ignore the error
and continue processing other files.

l If all files in the list import successfully, the import stops and the import status is set to Success.

Because all of the files are imported sequentially, if multiple files contain data for the same set of key
values, the data in the last-processed file will be saved in the database (overwriting any previously saved
data for the same keys). It is not currently possible to batch and aggregate the data from multiple files
before saving.

Importing from an external database

You can import data into Axiom Budgeting and Performance Reporting from an external database, such
as a SQL Server or Oracle database.

When importing from an external database, you must provide the appropriate information to allow
Axiom Budgeting and Performance Reporting to connect to the database, such as the server and/or
database name, and the login credentials. You must also create a SQL statement to query the necessary
data that you want to import into Axiom Budgeting and Performance Reporting.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 777



NOTE: The Connection information is only used to connect to the source and extract the data into
the import temp table. If the connection information includes a password, the password must be re-
entered anytime the connection information is changed.

� Source configuration
To import data from an external database, complete the following configuration settings on the Source
tab of the Import Wizard.

Item Description

Import type Select External Database to import data directly from an external database.

Import source Select one of the following database sources:
l SQL Server: Use this to import from a SQL Server database.
l Oracle: Use this to import from an Oracle database.
l OLEDB: Use this to connect to any database that supports OLEDB.
l ODBC: Use this to connect to any database that supports Open Database

Connectivity. Generally speaking, this option should only be used if no other
option is available to connect to your desired database.

NOTES:
l The OLEDB option can also be used to import data from files if necessary.

However, it cannot be used with Excel files. The Excel file option should be
used instead.

l An ODBC driver is required for use with the ODBC option. See ODBC driver.
l When using the Oracle option, the Oracle Data Access Connection software

(ODAC)must be installed on the Axiom Budgeting and Performance
Reporting application server. If you want to import directly from an Oracle
database without installing this software on the application server, you can
use the OLEDB import source instead.

Remote Data
Connection

If your Axiom Budgeting and Performance Reporting system is hosted on the
Axiom Cloud, then you must specify a remote data connection so that your
Axiom Cloud system can connect to the database server located on your
network.

You can select any remote data connection defined in your system, or you can
enter an import variable name. For example, you can enter the built-in system
variable {DefaultRemoteDataConnection} to automatically use the default
remote data connection for your system. For information on how the default
remote data connection is determined, see System variables.

If no remote data connections have been defined in your system, then this
setting does not apply and will not display.
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� Connection information for SQL Server
Complete the following connection information when the Import source is SQL Server.

Item Description

Server The name of the SQL Server.

Database The name of the database.

User The user name to use to connect to the specified server and database. The user
credentials must be for a SQL Server account; network domain credentials
cannot be used.

Password The password to use to connect to the specified server and database.

Once you have completed the connection settings, click the Test connection button to test the
connection. The Status updates to show either a success message or an error message.

� Connection information for Oracle
Complete the following connection information when the Import source is Oracle.

Field Description

Server The connection parameters for the Oracle server. You can obtain this
information from the Oracle TNS Names entry. A typical TNS Names entry for
Oracle looks like the following:

SERVER=(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)
(HOST=MyHOSTNAME)(PORT=MyPORT))(CONNECT_DATA=(SERVICE_
NAME=MyOracleServiceID)))

Axiom Budgeting and Performance Reporting requires this information in the
following format:

MyHOSTNAME:MyPORT/MyOracleServiceID

Where:
l MyHostName is the name of the Oracle server machine
l MyPort is the port number that the server is listening on, typically

1521
l MyOracleServiceID is the name of the Oracle service running on the

host machine

User The user name to use to connect to the database.

Password The password to use to connect to the database.

Once you have completed the connection settings, click the Test connection button to test the
connection. The Status updates to show either a success message or an error message.
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� Connection information for OLEDB
Complete the Connection string field when the Import source is OLEDB. The connection string identifies
the name and location of the database or file to connect to, including any necessary validation
information. Any valid SQL connection string can be used. The connection string cannot contain spaces.

Once you have completed the connection settings, click the Test connection button to test the
connection. The Status updates to show either a success message or an error message.

A good resource for connection strings is http://www.connectionstrings.com/ (external link). Some
examples of common connection strings are shown below:

Source Sample string

CSV Server=.\SQLExpress;Provider=MSDASQL;Driver={Microsoft Text Driver (*.txt;
*.csv)};UID=test;PWD=test!123;Database=AxiomFinancial

SQL Server,
trusted
connection

Data Source=myServerAddress;Initial Catalog=myDataBase;Integrated
Security=SSPI;

Oracle with TNS Data Source=TORCL;User Id=myUsername;Password=myPassword;

SQLOLEDB
(standard)

Provider=sqloledb;Data Source=myServerAddress;Initial
Catalog=myDataBase;User Id=myUsername;Password=myPassword;

SQLOLEDB
(trusted)

Provider=sqloledb;Data Source=myServerAddress;Initial
Catalog=myDataBase;Integrated Security=SSPI;

SQLOLEDB
(server instance)

Provider=sqloledb;Data Source=myServerName\theInstanceName;Initial
Catalog=myDataBase;Integrated Security=SSPI;

AS400 Provider=IBMDA400;Data Source=MY_SYSTEM_NAME;User
Id=myUsername;Password=myPassword;

� Connection information for ODBC
Complete the Connection string field when the Import source is ODBC. The connection string identifies
the name and location of the database to connect to, including any necessary authentication credentials.
The connection string requirements and syntax vary depending on the source database you are
attempting to connect to. Consult the documentation from your database vendor to determine an
appropriate ODBC connection string for this purpose.

Once you have completed the connection settings, click the Test connection button to test the
connection. The Status updates to show either a success message or an error message.
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� SQL Select Statement
The SQL SELECT statement defines the data query to the source database, resulting in the set of data to
be imported to the temp table. You can then perform mapping and transformations on the data before
importing into the destination table.

In the SQL Select Statement box, enter any valid SQL statement to define the data query. You can click
the SQL editor button to open the Edit SQL dialog. This dialog provides a text editor for entering and
reviewing large SQL statements, and several tools to check the statement. For more information, see
Creating the SQL SELECT statement.

Variables can be used in the SELECT statement. See Using variables in imports.

NOTE: The syntax of the SQL statement cannot be validated when using OLEDB or ODBC as the
source.

� ODBC driver
Use of ODBC requires an ODBC driver to be installed on the following servers:

l For on-premise systems, the driver must be installed on the Axiom Budgeting and Performance
Reporting Application Server.

l For Axiom Cloud systems, the driver must be installed on the local server that is hosting the Axiom
Cloud Integration Service.

The ODBC driver is specific to your source database. If you want to use ODBC with a particular database,
that database vendor should provide or recommend an ODBC driver for use with that database.

Creating the SQL SELECT statement

If the import source is an external database or an internal database, then you must define a SQL SELECT
statement to query the source database, resulting in the set of data to be imported to the temp table.

You can use the Edit SQL dialog to create and test the SELECT statement. To open the dialog:
l On the Source tab of the Import Wizard, click the browse button (...) to the right of the SQL Select

Statement box.

The Edit SQL dialog provides a text editor for the statement, and also several tools to help create and
test the statement.

� Creating the statement
You can type the statement into the text editor, or copy and paste from another source.

You can use the Choose Table tool to automatically generate a SQL statement that selects all columns in
a specified table. You can then edit the statement to meet the specific data needs. To do this:

1. Click the Choose source table to create SQL button .
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2. In the Choose Table dialog, select the table for which to generate the SQL statement, and then
click OK.

The Choose Table dialog lists all tables in the SQL Server database specified on the Source tab,
including views.

The generated SELECT statement is placed in the text editor. Any existing text in the editor is overwritten.

� Testing the statement

NOTE: If the SQL statement uses variables, then these validation features are not available.
Validation features are also not available if the source is OLEDB.

To validate the syntax of the SQL statement, click the Check SQL syntax button . Axiom Budgeting and
Performance Reporting sends the statement to your database server to see if the statement can be
parsed, resulting in either a success message or an error message.

To view a set of sample records, click the View data button . Axiom Budgeting and Performance
Reporting queries the database and returns the first 100 rows in the View Data dialog. You can review
this data to help determine if the SELECT statement is returning the desired set of data.

Within the View Data dialog, you can sort, filter, and group the sample data using standard Axiom grid
functionality. If desired, you can click the Export data to .CSV file button to export the data to a CSV file

.

When you are finished reviewing the data, click Close to return to the Edit SQL dialog.

Troubleshooting file access

When running an import or performing certain file processing actions, an error may occur when
attempting to access the specified file or folder location. Themost common reasons for this error are:

l Using a mapped drive instead of a UNC path
l Not having the appropriate permissions to the specified file or folder

� UNC path
When specifying the file or folder location, you must use a UNC path (Universal Naming Convention). A
UNC path identifies the location using a server name instead of a mapped drive. For example:

UNC path: \\servername\foldername\filename

Mapped drive: I:\foldername\filename

Mapped drives cannot be used because they may vary by computer. Themapped drives that you see
may be different than themapped drives your co-workers see, and different from themapped drives
seen by the Axiom servers. The UNC path is the only way to universally identify a location within your
organization's network.
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� File/Folder Permissions
The Axiom Budgeting and Performance Reporting server that is performing the process must have the
proper folder share and security permissions to access the specified file or folder location. The exact
configuration depends on what process you are trying to perform.

Task being
performed

Where to configure
permissions

Account Required permissions

Import: Source files
located on network
share local to the
Axiom server

l Cloud: Axiom Cloud
Integration Server

l On-Premise: Axiom
Application Server

Network
Service
Account

l Folder share: At least
Read permissions

l Folder security: At
least Read, Read &
Execute, and List
Folder Contents

Import: Source files
located on network
share not local to the
Axiom server

l Cloud: Axiom Cloud
Integration Server

l On-Premise: Axiom
Application Server

Application
Server
Computer
Account

l Folder share: At least
Read permissions

l Folder security: At
least Read, Read &
Execute, and List
Folder Contents

File processing:
Running via Scheduler

l Cloud: Axiom Cloud
Integration Server

l On-Premise: Axiom
Scheduler Server

Scheduler
Service
Computer
Account

l Folder share: Full
Access

l Folder security:
Modify, Read &
Execute, List Folder
Contents, Read and
Write

File processing:
Running in Desktop
Client

Desktop User's Domain
Account

l Folder share: Full
Access

l Folder security:
Modify, Read &
Execute, List Folder
Contents, Read and
Write

NOTE: On-premise installations can use an optional system configuration setting,
ETLAccessibleFolders, to further control access to folders when running imports. If this setting is
used, then any folder location in the import settings must also be listed in the ETLAccessibleFolders.
If it is not, then an error occurs when attempting to access files in the folder. Keep in mind that the
error message does not differentiate whether the folder is inaccessible due to general network
permissions or due to the ETLAccessibleFolders setting.
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Import Wizard: Variables tab

In the Variables tab of the Import Wizard, you can define variables to be used in the import. Import
variables can be used in the following import settings:

l Source and destination columns (Mapping tab)
l Destination table (Mapping tab)
l Transform statements or functions (Transforms tab)
l SQL SELECT statement to the source table (Source tab)
l Source file (Source tab)
l Sheet name (Source tab)

When the import is executed, before any import steps are processed, Axiom Budgeting and Performance
Reporting checks the Variables tab for variables. If variables are defined (regardless of whether they are
used in the import), the Variables dialog is presented to the user. Once the user has specified a value for
each variable, the import begins processing.

For example, you might have database tables that have the year incorporated into the table name. You
could define a variable for year, and configure the destination table to use the variable. Data would then
be imported into the appropriate table, depending upon the year selected by the user.

To use a variable in the import, enter the variable name into one of the supported areas of the import
settings, enclosed in curly brackets {}. For example, if the variable name is "mycolumn", you would enter
{mycolumn}.

NOTE: If the variable defines the destination table, then you must place the variable in double curly
brackets when you use it in a SQL statement, so that the eventual table name value is enclosed in
curly brackets as expected. For example, if you have a variable named "destinationtable", you would
reference that variable as {{destinationtable}}. That way, when the {destinationtable}
value is defined, it will resolve as {GL2020}.

� Managing import variables
This tab has two sections. In the top section, you can create user-defined variables for the import. The
bottom section displays the built-in system variables that can be used in the import. This Built-in
Variables section is for reference only, so that you can see the variables available for use.

l To add a variable, click Add variable . The new variable row is added below the row that is
currently selected.

l To edit a variable, type the changes into the grid.

If you change the name of a variable, you must update any references to that variable in the
import to use the new name.
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l To delete a variable, select the row that you want to delete and then click Remove variable .

Make sure the variable is not used in the import before deleting it. If the import references a
variable that is not defined, an error will result when executing the import.

The following settings are defined for variables:

Item Description

Prompt for value
even if variable
only contains
one choice

This setting applies to all defined variables for the import, and determines the
system behavior when a variable has only one choice.
l If enabled (default), then users will always be prompted to select variable

values, even if a variable has only one defined choice.
l If disabled, then users will not be prompted to select variable values for

variables that have only one defined choice.

Name The name of the variable.

Import variable names cannot use the same name as transform variable names,
and vice versa. Every variable namewithin the import must be unique.

NOTE: Import variables cannot use the same names as tables defined in your
system. This is because the syntax for referencing tables is the same as the
syntax for referencing variables. A validation message will display in the Import
Wizard if a variable namematches a table name. If a table is later created with
the same name as an existing variable, then subsequent executions of the
import will fail with an error identifying the table name / variable name
duplication.

Choices The set of valid choices for the variable, separated by semi-colons.

You can leave the choices blank if there is not a defined set of values for the
variable. When the import is executed, the user can type in a value for the
variable (ifAllow Free Input is enabled).

Variables (user-defined or system variables) can also be used as choices. Note
that variables used as choices will not be resolved to values in the Variables
dialog that is presented to the user when the import is run interactively.
However, the variable will be resolved during the import execution.

You can also specify a column or columns in the database by entering fully
qualified Table.Column syntax. The user will be presented with a drop-down list
of all values (up to 500) in the specified column. For example, enter DEPT.Region
if you want the user to select from the list of regions in the DEPT table. You can
specify multiple database columns, separated by semi-colons. For example,
DEPT.VP; DEPT.Mgr. The column values will be collected into a single list.
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Item Description

Description Optional description text that displays in the Variables dialog. This dialog
displays when the import is executed, to prompt the user to specify a value for
the variable.

Description text displays as follows above the variable selection drop-down list:

VariableName:DescriptionText

Allow Free Input Specifies whether users can type in their own values for the variable, or if they
are restricted to the list of choices.
l If enabled (default), then users can either select from the list of choices, or

type in their own value. Keep in mind that the user-defined valuemay not be
valid in the context of the import.

l If disabled, then users can only select from the defined list of choices.

Import Wizard: Mapping tab

TheMapping tab of the Import Wizard maps the import data to the destination table. In this tab, you
define:

l The columns to be created in the temp table, including any "work columns" to be used for interim
calculations only.

l The destination table for the imported data.
l The destination columns for the imported data.

When an import is executed, data is first imported from the source file or table into the temp table. Each
entry in the Temp Table Column field becomes a column in the temp table. After performing any
mappings or calculations on the temp table (as defined in the transforms), data is imported from the
temp table to the destination table. The entries in theDestination Column field determine whether a
column of data is imported to the destination table, and to which column in the destination table.

� Setting the destination table
TheDestination table field at the top of the tab specifies the table where imported data is to be saved.
To specify this table, you can:

l Type the name of an existing table into the field, or use the Choose table button to select an
existing table.

l Enter a variable name in curly brackets. When using this approach, the destination table will be
determined dynamically based on the variable value. For more information, see Using variables in
imports.

If needed, you can use the create destination table link to create a new table to hold the imported data.
This process opens the Create Tablewizard and populates the Columns screen with the columns defined
in theMapping tab, using the temp table names and data types. Before using this option, you should
first use Auto-generate temp table and destination columns to generate the list of columns based
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on the source data. Once the new table is created, the destination table and destination columns are
automatically set. Only administrators and users with the Administer Tables security permission can see
this option and create new tables.

� Populating the import column mappings
The top section of theMapping tab must contain a row for each column of data in the source. Each
column in the source data becomes a column in the import temp table, which is then mapped to a
column in the destination table.

The easiest way to generate the list of columns is to use the Auto-generate temp table and destination
columns button in the top right of the tab. This process reads the source data and creates a row for
each column. If a destination table is already specified, the auto-generate process attempts to map the
source columns to the appropriate destination columns, based on column name. After auto-generating,
you should review all entries to be sure they are correct.

NOTES:
l If the import source is set to Prompt for file during execution, you will be prompted to select

a file to use for the auto-generated mappings.
l If the import source is set to import from multiple files, themappings are generated based on

the first file that is found in the specified folder.
l If the import uses a remote data connection, that connection is used to access the specified

source file or database.
l If the import source is Ellucian, the import columns are automatically generated based on the

selected data type on the Source tab. In this case, the only purpose of the auto-generate
button is to map these columns to the destination columns.

l If the import source or the destination table uses variables, the Variables dialog opens so that
you can specify variable values to use when generating the column mappings.

You can also define columns manually, or edit the settings after auto-generating:
l To add a row, click Add imported column mapping . The new row is added below the row that is

currently selected. This option is not available for certain source types that have a fixed set of
source columns.

l To edit a row, type changes into the grid.

l To delete a row, select the row that you want to delete and then click Remove mapping . This
option is not available for certain source types that have a fixed set of source columns. Keep in
mind that all columns in the import sourcemust have a corresponding row in themapping tab. If
you do not need to save the corresponding data to the destination table (either because it is
unneeded or because you need to manipulate data using a work column), simply leave the
column unmapped.
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l To change the order of rows, select the row that you want to move and then click the arrow icons
to move it up or down.

IMPORTANT: For all import types except Ellucian, the columns must be listed in the order of
the columns in the source. For example, the first column of the source data must be row 1 in
themapping grid, the second column must be row 2, and so on. If you perform any action
that changes the existing order of rows, this may cause data to be imported incorrectly. After
making manual adjustments to the grid, check to make sure that each mapping row in the
grid matches up with the appropriate source column.

Each row in the top section of theMapping tab has the following properties:

Item Description

Source Column The number of the corresponding source column in the import source. The
first row in the grid corresponds with the first column in the source, and so
on.

These numbers cannot be edited. If you auto-generate themappings, the
name of the source column will display next to the number for reference.
Names are only displayed when the import source is a database or a file
with a header row.

NOTE: For Ellucian imports, this field displays the source column name
without a number, because the columns can be listed in any order.

Temp Table Column The name of the column to create in the temp table to hold the imported
data. The column name does not have to match the name of the column
in the source. The data is imported in column order, not by name.

Import variables can be used to define temp table column names. For
more information, see Using variables in imports.

NOTE: Temp table column names must follow the same rules as normal
table columns. See Column naming requirements. Keep in mind that if you
auto-generate the column mappings, the temp table column names are
based on the headers in the source. These headers may contain spaces or
other invalid naming conventions that should bemanually corrected.
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Item Description

Type The data type of the column.

The data typemust match the data type of the destination column. The
data type is automatically selected when you use the auto-generate
mappings feature, or when you manually select a destination column. You
only need to manually select a data type if the column is only for the temp
table and does not have a destination column. EXCEPTION: If you are
importing into a table with an identity column, and the identity column is
mapped, the type should be set to Integer. For more information, see
Importing data into tables with identity columns.

If the data type is String, you must also specify themaximum length of the
string field. This entry should match the string length of the destination
column so that data is saved appropriately. To specify the string length,
select the row and then click the browse button [...] to the right of the
field. In the Edit String Length dialog, type the string length (from 1 to
4000). The string length displays in parenthesis after the data type. For
example: String (200).

NOTES:
l To create a string column with unlimited size, leave the string field

blank. You should only do this if you understand the ramifications.
l If a string column has a destination column, the column in the temp

table automatically matches the Unicode status of the destination
column (True/False). However, if the string column does not have a
destination column, Unicode is assumed as True.
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Item Description

Nulls Determines how blank values in the import source are brought into the
temp table column.
l If disabled (the default behavior), then blank values are brought into

the temp table column as the default value for the specified destination
column. If the column is unmapped, then the system default value as
defined for the column type is used.

l If enabled, then blank values are brought into the temp table column
as null values.

This setting can impact transform statements that look for "blank" or
undefined values in the temp table. You should set this as appropriate
depending on whether you want to check for null values or the default
value for the affected column.

The presence of null values in the temp table does not necessarily mean
that the imported data will contain null values. When the temp table
values are imported into the destination table, the default values for the
destination columns are always applied to any null values at that point.
However, if the default value for a destination column is null, then the null
values will be retained.

Destination Column The name of the column in the destination table where you want this data
to be saved.

You can type the name of the column directly, or use the drop-down list to
select a column name. The data type of each column is displayed in the
drop-down list for reference. The data type of the destination column
must match the data type specified in themapping grid.

NOTE: If the destination table uses a variable and you aremanually
creating column mappings, the selections in the destination column drop-
down lists are based on the first choice listed for the variable.

If this column is not intended to be saved to the destination table, select
<not mapped>. "Not mapped" is the default if you do not explicitly select a
destination column.

Import variables or transform variables can be used to define destination
column names. If you are using a variable for a destination column and
you want to set the column to not mapped, the value of the variable must
be blank for import variables and empty string ('') for transform variables).
For more information, see Using variables in imports.
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� Using work columns
You can use work columns in the temp table to perform calculations and data mapping before saving
data to the destination table. For example, theremay be a column in the source data that you need to
manipulate before it can be saved to the destination table. In this case you would do the following:

l In the top mapping section, set the destination column for the source column to <not mapped>.
l In the work columns section, add a row for the work column, and set the destination column to

the appropriate column in the destination table.
l On the Transforms tab, define a transform that manipulates the data from the original source

column and populates the work column with the resulting desired data.

Any column defined in theWork column mappings section will be created in the temp table. If a
destination column is specified, the data will be saved to the destination table.

l To add a row, click Add work column mapping .
l To edit a row, type changes into the grid.
l To delete a row, select the row that you want to delete and then click Remove mapping .
l To change the order of rows, select the row that you want to move and then click the arrow icons

to move it up or down.

Each row in the work columns section of theMapping tab has the following properties:

Item Description

Temp Table Column The name of the work column in the temp table.

Import variables can be used to define temp table column names. For
more information, see Using variables in imports.

NOTE: Temp table column names must follow the same rules as normal
table columns. See Column naming requirements.

Type The data type of the work column.

See the Type entry in the previous table for more information.
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Item Description

Null Determines the starting values for work columns in the temp table (before
transforms are applied).
l If disabled (the default behavior), then the work column starts with the

default value for the specified destination column. If the column is
unmapped, then the system default value as defined for the column
type is used.

l If enabled, then the work column starts with null values.

This setting can impact transform statements that look for "blank" or
undefined values in the temp table. You should set this as appropriate
depending on whether you want to check for null values or the default
value for the affected column.

The presence of null values in the temp table does not necessarily mean
that the imported data will contain null values. When the temp table
values are imported into the destination table, the default values for the
destination columns are always applied to any null values at that point.
However, if the default value for a destination column is null, then the null
values will be retained.

Destination Column The name of the column in the destination table where you want this data
to be saved. If this column is used only for calculations in the temp table
and is not intended to be saved to the destination table, select <not
mapped>.

See the Destination Column entry in the previous table for more
information.

� Column naming requirements
When naming temp table columns, the following requirements apply:

l Column names can use standard ASCII alphanumeric characters (a-z, 0-9) and the underscore
character. No spaces and no other special characters are allowed.

l The first character in a column name cannot be a number or an underscore. For example, you can
have a column named Plan_09 but you cannot have a column named 09_Plan.

l Columns cannot be named Col#, where # is a number, such as Col1, Col2, etc. Other column
name constructions with text and numbers are allowed—for example, BUD1 is valid.

l Database reserved words should be avoided whenever possible.

l Column names are limited to 50 characters by default.
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� Miscellaneous behavior notes
l When importing numeric values, the number of digits in the import source cannot exceed the

number of digits allowed by the data type assigned to the temp table column.

l If column data is null in the temp table and the destination column is a String column, the null
data is converted to an empty string when the data is saved to the destination table (rather than
using the column's default value).

Import Wizard: Transforms tab

The Transforms tab of the Import Wizard contains a set of statements to perform actions on the data in
the temp table, in order to transform the data before saving it to the destination table.

When the import is executed, the transforms are processed after import variables have been selected
and after the data query has been made to the source table or file. Transforms are processed in the order
listed in the tab.

Transforms can use SQL statements or built-in Axiom transform functions.

� Managing transforms
l To add a transform, click Add transform . The new transform is added below the row that is

currently selected.

l To duplicate a transform, select the row that you want to duplicate and then click Duplicate
selected transform .

l To edit a transform, make changes directly in the grid.

l To delete a transform, select the row that you want to delete, and then click Remove transform
.

l To change the order of transforms, select the row that you want to move and then use the arrow
icons to move it up or down.

The following settings are defined for each transform:

Field Description

Number The ordinal number assigned to each transform, to determine processing order.
This setting is managed by Axiom Budgeting and Performance Reporting. When
you change the order of rows, Axiom Budgeting and Performance Reporting
automatically changes the order number.

Transform A SQL statement, or a built-in Axiom import function.

To define the transform, double-click the field or click the browse button (...) in
the field. The Edit Transform dialog opens so that you define the transform. See
Defining transform statements.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 793



Field Description

Description Displays the description of the transform. This is for reference only. You can
define this description when defining the transform.

Target Variable Displays the name of the target variable for the SQL transform.

For SQL statements, target variables are defined when editing the statement.
Target variables do not apply to import functions. See Defining transform
statements.

Select the Pause check box if you want the import to pause and display the
temp table after processing this transform. This option only applies when
executing the import in development mode, using the option Pause after
specified transforms and display current temp table data. For more
information, see Executing imports in development mode.

Select theDisable check box to disable the transform. When the import is
processed, this transform will be skipped.

� Transform notes
If the import contains a transform that zeroes old data before importing the new data, the Pre-Save
Validate function should be used before the zero step. This allows you to identify any data issues before
deleting existing data. If invalid data is found, the import is aborted and the zero step will not be
processed.

Defining transform statements

For each transform listed on the Transforms tab of the Import Wizard, you must use the Edit Transform
dialog to define the associated SQL statement or transform function. To open the dialog, click the ...
button in a transform field.

At the top of the Edit Transform dialog, specify whether the transform is a SQL statement, or a Built-in
Function. By default, SQL is selected.

� Defining a SQL statement transform
If the transform is a SQL statement, complete the following:
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Field Description

Enter a SQL
statement

Type or copy and paste the SQL statement into the text editor. To validate the
syntax of the SQL statement, click the Check SQL syntax button .

NOTE: When referencing Axiom Budgeting and Performance Reporting tables in
a SQL statement, place the table name in curly brackets. For example, to
reference the table DEPT, use {DEPT}.

The SQL statement can use import variables and/or transform variables (that
were defined in a previous transform statement). See Using variables in imports.
If the statement includes variables, then the ability to check the SQL syntax is
not available.

Variables can be used in calculations in the SQL statement, for example, to
calculate the value of a second variable based on the first variable.

NOTE: If the variable defines the destination table, then you must place the
variable in double curly brackets when you use it in a SQL statement, so that the
eventual table name value is enclosed in curly brackets as expected. For
example, if you have a variable named "destinationtable", you would reference
that variable as {{destinationtable}}. That way, when the
{destinationtable} value is defined, it will resolve as {GL2020}.

For some examples of common SQL transforms, see Example SQL statements
for transforms.

Target Variable
Name

If you want to define a target variable for the transform, type the name of the
variable.

The SQL statement can be any query that results in a single value. If the query
returns multiple values, the target variable uses the first value in the return set.

The target variable can be used in subsequent transforms, or as destination
columns in theMapping tab. To use the variable in the import, enter the
variable name into one of the supported areas of the import settings, enclosed
in curly brackets {}. For example, if the variable name is Column, you would
enter {column}.

Transform variable names cannot use the same name as import variable names,
and vice versa. Every variable namewithin the import must be unique.

Transform variables should not use the same name as an Axiom Budgeting and
Performance Reporting table that you plan to reference in the import, because
the syntax for table names is the same as for variables (both are placed in curly
brackets). If a variable name and a table share the same name, any references
will be interpreted as the variable, not the table.
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Field Description

Description If desired, type a description for the transform.

The description may be useful when viewing the list of transforms on the
Transforms tab, to easily identify specific transforms.

� Using a transform function
If the transform is a built-in function, select the function that you want to use from the Function list, and
then complete the parameters for the function.

l Add new dimension elements
l Custom data validation
l Delete rows
l Pre-save validate
l Update temp column

You can edit the description for the transform if desired. By default, the standard description of the
function is used.

NOTE: If you select a different function, the current description will be overwritten with the standard
description of the new function. If you go back to the original function before saving the transform,
the original description will be preserved.

Add new dimension elements during an import

To add new dimension elements during an import, create a transform step that uses the built-in function
Add new dimension elements. You can use this function to add new accounts, departments, or other
dimensions as part of the import.

This function is intended to be used in cases where the import data may contain new dimension
elements that have not yet been added to the relevant reference tables in Axiom Budgeting and
Performance Reporting, and the organization wants these records to be added automatically as part of
the import. Other organizations may prefer to prevent these records from importing and instead add the
new dimension elements manually, in which case this function should not be used.

If new dimension elements are added by this function, then after the import is complete an
administrator will most likely need to edit the reference table in order to fill in grouping columns for the
new element. This is why the function supports notifying one or more users of the added dimension
elements. Keep in mind that it is possible for invalid dimension elements to be added when using this
function, if the source data for the import is not correct.

� Function parameters
This function uses the following parameters:
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Parameter Description

Table The name of the dimension table to update. This can only be reference tables
that have a single-level lookup relationship with the destination table for the
import.

For example, if you are importing data into GL2020, and that table has columns
Acct and Dept which have lookup relationships with the Acct and Dept tables,
then you can add new dimension elements to the Acct and Dept tables.

When this transform step is performed, the data in the temp table will be
validated against this dimension table. If any dimension elements are found
that do not match the dimension table, those new dimension elements will be
added to the dimension table.

Column defaults Optional. Values to use for grouping columns in the target dimension table
when new dimension elements are added. You can add as many column=value
pairs as needed, separated by commas. See the discussion following this table
for more information on the specific syntax.

Any columns in the target dimension table that are not listed here will use the
column's default value (as defined in the column properties) when the new
record is added.

If the target dimension table contains any validated columns , then you must
do one of the following:
l List the validated column in this parameter with a valid value. That valid

value will be used when the new records are added to the table.
OR

l Make sure the validated column has a valid default value in its column
properties. If the validated column is not listed in this parameter, then its
default value from the column properties will be used when the new records
are added to the table.

If the validated column is not assigned a valid value using one of these options,
then an error will occur when this transform is processed and the import cannot
continue.

Email
notification

Users and or roles to notify via email when new dimension elements are added
to the table. Enter a list of one or more user and role names, separated by
commas.

Task pane
notification

Users and or roles to notify via the Notifications task pane when new dimension
elements are added to the table. Enter a list of one or more user and role
names, separated by commas.
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� Defining column defaults
You can populate a grouping column using a fixed default value, or by using a value from a column in the
import temp table.

l To use a fixed default value, use the following syntax:

GroupingColumnName='StringValue',GroupingColumnName=NumericValue, etc.

WhereGroupingColumnName is the grouping column in the target dimension table. If the
grouping column is a string column, then the valuemust be placed in single quotation marks, just
like when writing a filter statement.

l To use a value from a column in the import temp table, use the following syntax:

GroupingColumnName={temptable}.TempTableColumnName, etc.

For example, if the temp table contains a column named Desc that you want to use to populate
the Description column in the target dimension table, you would enter: Description=
{temptable}.Desc

NOTE: If the default values are populated from a column in the import temp table, those values must
be the same for all instances of a particular dimension element. If the same dimension element has
multiple rows in the temp table with different values in the specified temp table column, then the
maximum value will be placed in the grouping column for that dimension element.

� Example
To add new departments when importing GL actuals data, the function parameters could look as follows:

Table: Dept

Column defaults: Description={temptable}.Desc, DeptStatus='New'

Email notification: sysadmins

Task pane notification: jdoe

When the import is run, any departments that do not already exist in the DEPT table will be added to
that table. The Description column in the DEPT table will be populated with the value from the Desc
column in the import temp table, and the DeptStatus column in the DEPT table will be populated with
the string "New". An email notification of the added departments will be sent to users in the role
sysadmins, and a task pane notification of the added departments will display for user jdoe.

All other columns in the DEPT table will use the default value defined for the column in the column
properties.
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Deleting rows of data as part of an import

To delete rows from a target table during an import, create a transform step that uses the built-in
function Delete rows. For example, you could use this function to clear the existing rows in a table before
importing new data.

Function parameters

Parameter Description

Table The name of the table from which to delete rows.

Filter Optional. A filter used to identify rows to delete. If omitted, all rows in the table
are deleted.

The filter can be against the specified table or against a lookup reference table.
Standard Axiom filter criteria syntax applies.

NOTE: The temp table cannot be referenced in the filter.

For example, if the table is GL2020, then the filter could be something like:

GL2020.YrMo='{YrMo}'

Where the value of YrMo is defined by an import variable.

Dept.Region='North'

Where the GL2020 table has a column Dept that looks up to the Dept table.

NOTES:
l If you are only updating specific columns in the destination table, then you may want to use a

SQL step to zero data rather than using the Delete rows function.

l If all rows in the target table are being deleted, Axiom Budgeting and Performance Reporting
will perform a truncate instead of a delete, for improved performance. Truncate cannot be
used if a filter is defined in the Delete rows function, or if the user performing the import has
filtered access to the target table.

Updating data in the temp table based on another column

To update data in the temp table based on another column, create a transform step that uses the built-
in function Update temp column. This function updates a column in the temp table from a specified
column in another table, using the given match key. For example, this function would typically be used
to look up the credit reversal sign from the Account table.
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Function parameters

Parameter Description

Temp table
column

The name of the column in the temp table to be updated.

Source column The name of the column to use to update the temp table. Fully qualified
Table.Column syntaxmust be used.

Match columns The columns to use to match data to update, in the format TempColName =
SourceColName. Separatemultiple match sets with commas.

For example: ACCT = ACCT, DEPT = DEPT

Temp table filter Optional. A filter used in the SQLWHERE clause against the temp table, to
identify rows to update. If omitted, all matching rows are updated.

Fully qualified Table.Column syntaxmust be used. The temp table must be
represented as a variable.

For example: {temptable}.ACCT > 20000

NOTE: If a temp table column uses a database reserved word (such as "Key")
then in the filter you must place that column in double quotation marks and
use all upper-case letters. Use of database reserved words should be avoided
whenever possible.

Validating data to be imported before the save

To validate data against lookup columns before performing the save for the import, create a transform
step that uses the built-in function Pre-save validation. This function takes no parameters.

This is the same validation process that occurs automatically as part of the actual save for the data
import. By performing the validation before the save, you can check for invalid data and abort the
process before performing irrevocable data changes in subsequent transform steps (such as deleting old
data in the destination table). If instead you want to perform a different custom validation, see
Performing custom data validation for an import.

If any destination columns in the import are validated columns, this function validates the data in the
temp table against the lookup columns. If exceptions are found, an error message is written to the
import log and the import is aborted.

NOTE: If this function is used in an import, then the option to Ignore lookup and key errors does
not apply. If invalid data is found in the pre-save validation step, then the import is automatically
aborted and does not proceed to the data save.
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Performing custom data validation for an import

To exclude rows of data from an import based on a custom criteria, create a transform step that uses the
built-in function Custom data validation. Any data in the temp table that matches the specified filter will
be excluded from the save.

This custom validation is separate from the built-in lookup validation that occurs as part of the data save
(or by use of the Pre-Save Validate function).

Function parameters

Parameter Description

Filter A filter used in the SQLWHERE clause against the temp table. Any rows that
match this filter are excluded from the save, and will be reported in the import
error log with any other validation errors.

FailureMessage An error message to display next to records that are excluded due to this data
validation step.

Errors are logged in a column named AXTRANSFORM_StepNumber, where
StepNumber is the number of the associated transformation step. For example:
"AXTRANSFORM_5" when the associated transform is step 5 in the list.

For example, you might want to check to make sure that data exists in a particular column of the temp
table before importing that record. If the necessary data is missing, then that record will be excluded
from the import. In this case the function settings would be something like the following:

Filter: Benchmark=0

Failure Message: The Benchmark data is missing

Where Benchmark is the column in the temp table that must have a value in order to import the
record.

Example SQL statements for transforms

The following example SQL statements can be used to perform common transforms for imports.

� Converting data types

Convert a number to a string to populate into a string column
UPDATE {temptable} SET RATESTRING = CONVERT(NVARCHAR, RATENUM) WHERE
RATENUM IS NOT NULL

If Unicode is disabled for the string column, then convert to varchar instead.
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Convert a string to a number to populate into a numeric column
UPDATE {temptable} SET RATENUM = CONVERT (BIGINT, RATESTRING) WHERE
RATESTRING IS NOT NULL

or

UPDATE {temptable} SET ACCT=CAST (tAcct as BigInt)

If you are using Integer 32 or Integer 16, then convert to int or smallint instead.

Convert a datetime field to a concatenated string (yearmo)
UPDATE {temptable} SET YEARMO = YEAR(DateTimeField) * 100 + MONTH
(DateTimeField)

Convert a datetime field to a concatenated string (yearmonthday)
UPDATE {temptable} SET YEARMONTHDAY = (YEAR(DateTimeField) * 100 + MONTH
(DateTimeField)) * 100 + DAY(DateTimeField)

Other conversion statements
CONVERT(STRING(xx), RATENUM)

CONVERT(BIGINT, RATESTRING)

CONVERT(DECIMAL(28,14), RATESTRING)

� Math transformations

Convert values to a negative number if a credit column exists in the temp table
UPDATE {temptable} SET M1 = - M1, M2 = -M2, M3 = -M3, M4 = -M4, M5 = -M5,
M6 = - M6, M7 = -M7, M8 = -M8, M9 = -M9, M10 = -M10, M11 = -M11, M12 = -m12
WHERE Credit = 'C'

Perform math on a field if another field in the temp table contains a value
UPDATE {TempTable} SET M1 = M1 * Rate WHERE Rate <> ''

Round a value to 2 decimals and replace the value
UPDATE {temptable} SET RATE = ROUND(RATE, 2)
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Divide two integer numbers and keep the decimal
Remember that an integer divided by an integer returns only an integer (example: 5/7 = 0). If you
want to capture the decimal remainder, you must cast the integer values as decimal:

CAST(INT1 AS DECIMAL(28,14)) / CAST(INT2 AS DECIMAL(28,14))

� Pivoting data

Pivot incoming data with respect to time
UPDATE {temptable} SET

M1 = case when (TheMonth=1) then Amt else 0 end,
M2 = case when (TheMonth=2) then Amt else 0 end,
ETC.

Pivot data from columns to rows (using a monthly variable)
Update {temptable} set Amt =

Case
When ({VarMonth}=1) then M1
When ({VarMonth}=2) then M2
ETC.
Else 0

End

� General temp table transformations

Perform a find and replace in a data column to detect the # character and replace it with nothing
UPDATE {temptable} SET AcctDesc = REPLACE(AcctDesc,'#','')

Place zeros in a field rather than null values
UPDATE {TempTable} SET Rate = 0 WHERE Rate IS NULL

Insert new records into the temp table by summarizing transaction detail records
INSERT INTO {temptable} (DEPT,ACCT,TRANSID,M1,M2,M3,DELETE) SELECT
DEPT,ACCT,’Summarized’,SUM(M1),SUM(M2),SUM(M3),‘DeleteFlag’ FROM
{temptable} GROUP BY DEPT,ACCT

Add an identity or row number to each record, using the system column AxReference
UPDATE {temptable} SET MYROWNUMBER={temptable}.AxReference
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Delete records from the temp table with a flag set
DELETE from {temptable} where FLAG = 'DeleteFlag'

Delete records from the temp table where the dimension combination already exists in the
destination table
This examplemight be used to load only new transactional records and leave existing destination
records untouched.

DELETE FROM {temptable} WHERE {temptable}.DEPT IN (Select DEPT from
{TRANSACTIONTABLE} group by DEPT) and {temptable}.TRANSID IN (Select
TRANSID from {TRANSACTIONTABLE} group by TRANSID)

Concatenate strings together with a hyphen in between
UPDATE {temptable} SET DESCRIPTION = DESC1 + ‘ – ‘ + DESC2

Fill an entire column with the same value
UPDATE {temptable} SET RATE = 0

Copy the left 5 characters into a new column
UPDATE {temptable} SET ShortDesc = LEFT(LongDesc,5)

Subtract 1 character from the end of a field and copy the remaining text to a new column
UPDATE {temptable} SET ShortDesc = LEFT(LongDesc, (LEN(LongDesc) – 1))

Aggregate balance sheet records
UPDATE {temptable} SET M1=BegBal+M1
UPDATE {temptable} SET M2=M2+M1
UPDATE {temptable} SET M3=M3+M2
UPDATE {temptable} SET M4=M4+M3
UPDATE {temptable} SET M5=M5+M4
UPDATE {temptable} SET M6=M6+M5
UPDATE {temptable} SET M7=M7+M6
UPDATE {temptable} SET M8=M8+M7
UPDATE {temptable} SET M9=M9+M8
UPDATE {temptable} SET M10=M10+M9
UPDATE {temptable} SET M11=M11+M10
UPDATE {temptable} SET M12=M12+M11
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Import into only the current period using a variable
On theMapping tab, for each column where you want to use a variable, set the destination column
as {M1}...{M12} instead of the normalM1…M12.

On the Transforms tab, create 12 statements—one for each data column that you set up with a
variable. The SQL for each statement is as follows (each statement will have a different current period
value and a matching column name):

SELECT RESULT =
CASE

WHEN {CurrentPeriod} = 1 THEN 'M1'
ELSE ''

END

In the Target Variable Name section of the transform, type the name of each variable. In the text
above, the variable namewould beM1. The next statement would beM2, then M3, and so on. This
will set the variable value to the result of the SQL statement. Columns that do not match the current
period will be set to ", which means they will not be imported to the destination table.

Abort the import if no data exists to import
IF (SELECT COUNT(*) FROM {temptable}) = 0

RAISERROR ('Temptable was empty, aborting import', 11, 0)

� Updating a table other than the temp table

Update a reference table with new elements that currently exist in the temp table, but not in the
reference table
Whenever possible, the new built-in function Add new dimension elements should be used for this
instead of a SQL statement. See Add new dimension elements during an import. If this function
cannot be used, then use a SQL statement like the following:

INSERT INTO {ACCT}(ACCT, Description) Select ACCT, 'Exception from Import'
FROM {temptable} WHERE NOT EXISTS (SELECT ACCT FROM {ACCT} WHERE
{temptable}.ACCT = {ACCT}.ACCT GROUP BY ACCT) GROUP BY ACCT

Zero out columns in a destination based on a flag in a reference table
UPDATE {{destinationtable}} set M1=0,M2=0,M3=0,M4=0,
M5=0,M6=0,M7=0,M8=0,M9=0,M10=0,M11=0,M12=0 FROM {{destinationtable}} INNER
JOIN {ACCT} ON {ACCT}.ACCT={{destinationtable}}.ACCT WHERE
{ACCT}.ZEROME='1'

This example assumes that {destinationtable} is an import variable that resolves to a table name.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 805



Delete large numbers of records from a table
DECLARE @RowsDeleted INTEGER
SET @RowsDeleted = 1
WHILE (@RowsDeleted &gt; 0)

BEGIN
DELETE TOP (10000) FROM MyTable [WHERE .....]
SET @RowsDeleted = @@ROWCOUNT

END

TheWHERE clause in the DELETE step is optional.

Importing data into tables with identity columns

Columns that use the Identity data type contain automatically-generated, unique ID numbers. If you
want to import data into a table with an identity column, special considerations apply. The identity
column can bemapped as part of the import, or left unmapped. The decision of how to handle this
depends on whether you are updating existing data or only creating new records, and whether you want
new records to use automatically generated numbers or specific numbers.

� Updating existing data with an identity key column
If the import is updating existing data and the table contains an identity key column, the identity column
must bemapped. In order to update existing data, the import must be able to match the value in the
import temp table with an identity key in the destination table.

When mapping a temp table column to an Identity column in the destination table, the data type of the
temp table column must be set to Integer. (If the identity column is Identity32, the temp table column
should be set to Integer32.)
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� Creating new records with an identity key column
If the import is creating new records in the destination table, you can opt to use automatically-generated
ID numbers in the identity column or you can specify the ID numbers.

If you want to use automatically-generated ID numbers, there are two ways to accomplish this:
l Leave the identity column unmapped.When the identity column is unmapped, all records in the

import data are created as new records with automatically-generated ID values. This configuration
is appropriate when the only purpose of the import is to create new records. If the import data
contains a mix of new and updated records, then the identity column cannot be left unmapped.

This is also the only use case where it is possible to leave a key column unmapped in an import.

l Map the identity column, but leave the column blank for new records.When the identity
column is mapped, but the temp table column is left blank, new records are created for the blank
values using automatically-generated ID values. This configuration is appropriate when the import
data contains a mix of new and updated records. If the column contains an existing identity value,
the existing record is updated.
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In some cases, you may have a need to create new records using specific identity values. You can do this
by mapping the identity column, and populating the import data with the desired identity values. When
new records are created in the table, they will use the specified values instead of using automatically-
generated values. When using this approach, keep in mind the following:

l In order to create new records, the values in the temp table column must not already exist in the
destination table. If a temp table valuematches an existing value, then the existing record is
updated instead of creating a new record.

l The "seed" value for the identity column will be reset to the largest inserted value, instead of
continuing where it left off. For example, if the last auto-generated value was 20, but you import a
specific new value of 80, the next auto-generated value will start at 81.

l It is not possible to create new records with a mix of automatically-generated ID values and
specific values. If you want to create any new records with specific values, then all new records in
the import data must be assigned specific values. The temp table column cannot be left blank
when using this configuration.

When mapping a temp table column to an identity column, the data type of the temp table column must
be Integer (see previous section).

� Other considerations
It is also possible for a table to contain a non-key identity column. This column can bemapped or
unmapped for an import, and will be treated as follows:

l If the identity column is unmapped, then new records are created using automatically-generated
values, and existing values are unchanged. This is the recommended approach unless you need to
create new records with specific identity values (an unlikely situation).

l If the identity column is mapped, and new records are created in the table, the value in the temp
table column will be used if it is available. If the value already exists in the identity column on
another record, then the value is ignored and an automatically-generated value is used. When
updating existing records, the temp table value is ignored and the existing values are left as is (in
other words, it is not possible to change the identity value on an existing record).

As mentioned previously, if new records are created with specific values, the "seed" value for the
identity column is reset to the largest inserted value, instead of continuing where it left off.

Exporting Data
Using an export utility, you can export data from an Axiom table to an external database or to a delimited
file.

When you create an export, you specify a client-defined table in Axiom Budgeting and Performance
Reporting from which to export data. You can export all of the data in the table, or you can limit the data
by selecting columns to export or by defining a data filter. Then, you define the destination properties,
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such as connection information for the target database and table, or the name and location of the
destination file. For Axiom Cloud systems, a remote data connection is used to access the local target for
the export.

When an export is executed, Axiom Budgeting and Performance Reporting extracts the data from the
source table in the Axiom database, and then creates or updates the destination table in the target
database or creates the destination file.

� Export utility alternatives
The following features can be used as alternatives to export utilities:

l File Processing: The File Processing feature supports the ability to create a delimited export file,
using the Export to File processing option. Instead of extracting data directly from a table, the
desired data is first populated into an Axiom report, and then extracted from that report. The data
can bemanipulated within the report as needed before it is extracted.

l OData API: The Axiom Budgeting and Performance Reporting OData API can be used in custom
web solutions to access data from the Axiom Budgeting and Performance Reporting database.
Standard OData syntax is used to query data from specified tables, then the data is returned in
JSON format.

Managing exports

Export utilities can be created, edited, or deleted using the Exports Library.

To access the Exports Library:
l On the Axiom tab, in the Administration group, clickManage > Axiom Explorer. The Exports

Library is available in the Libraries section.

NOTE: In systems with installed products, this featuremay be located on the Admin tab, as
System Browser.

You can also use the Explorer task pane to access the Exports Library.

For details on executing an export, see Executing export utilities.

� Creating an export
Only administrators and users with the Administer Exports security permission can create exports. Non-
admin users must also have read/write access to at least one folder in the Export Library, in order to have
a location to save the newly created export.

1. Right-click the Exports Library, and then click New > Export Package.

2. In the Create New Export dialog, select one of the following and then click OK.
l Create from scratch (default): Create a new export starting with blank export settings.
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l Create from existing: Create a new export by copying an existing export. If you select this
option, then select the export that you want to copy from the list in the bottom of the
dialog. All settings for the existing export will be copied to the new export as a starting
point.

The Export Wizard dialog opens. You can move between tabs in any order, however, before you
can save the export, all required settings must be completed and no invalid settings must be
present. If errors exist, an error message displays at the bottom of the dialog; you can click the
error link to be taken to the tab with the error.

3. In theGeneral tab, enter a Name for the export and an optionalDescription.

The export name is how users access and execute the export. If this export is a copy of an existing
export, the default name is "Copy of ExportName".

4. In the Source tab, specify the source table for the export and then complete the source settings.
For more information, see Export Wizard: Source tab.

5. In theDestination tab, specify the destination type (database or delimited file) and then complete
the destination settings. For more information, see Export Wizard: Destination tab.

6. When you are finished completing the settings and no errors exist, click OK to save the export.

NOTE: By default, new exports are saved to the root of the Exports Library. If you want to save
an export to a sub-folder instead, click Save As to save the export instead of clicking OK. This
brings up the Save As dialog, where you can select a folder location to save.

� Editing an export
You can edit existing exports as needed, as long as the export was not installed by a product package.
Only administrators and users with read/write access to the export file can edit exports.

Product-controlled exports are locked and cannot be edited. Some of these exports may be designed to
work as is, without customizations. If customizations are required, you can create a copy of the product-
controlled export and make customizations in the copy. If the original export is later updated by the
product, you can review the original export to see the changes that need to bemade in your copy (or
you can create a new copy of the export and re-make your customizations as needed).

To edit an existing export:
l Right-click the export in the Exports Library, and then click Edit.

The Export Wizard opens. You can change any export settings as desired.

NOTE: When editing an export, you can use the Save As button to save the current export as a new
export file. If you have read-only rights to the export, then the Save As button is the only save option
available.
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� Deleting an export
You can delete an existing export if it is no longer needed, as long as the export was not installed by a
product package. Only administrators and users with read/write access to the file and its folder can
delete exports.

Product-controlled exports are locked and cannot be deleted.

To delete an export:
l Right-click the export in the Exports Library and then click Delete.

Executing export utilities

When you execute an export utility, data is queried from the source table in Axiom Budgeting and
Performance Reporting according to the export configuration settings, and then the resulting data is
saved to the destination table or the destination file. If the export destination is a table, the table is either
created or updated, depending on the export configuration.

NOTES:
l By default, only administrators can execute export utilities. Non-admin users can be granted

permission to execute specific exports, as defined on the Files tab of Security.
l If the user executing the export has a security filter for the source table, that filter will be

honored to determine the available data to export.
l You can also use Scheduler to execute export utilities, using the Export ETL Package task.

To execute an export:
1. On the Axiom tab, in the Administration group, clickManage > Axiom Explorer. You can also use

the Explorer task pane.

NOTE: In systems with installed products, this featuremay be located on the Admin tab, as
System Browser.

2. In the Exports Library, double-click the export that you want to execute.
l If your security permissions only allow you to execute the export, then the export opens in

a special execute-only dialog, which displays the contents of the Execute tab.
l If your security permissions allow you to view or edit the export settings, then the full

Export Wizard opens.

3. On the Execute tab, click the Execute button to start the export.

As the export is processed, status messages display in the Execution log at the bottom of the dialog. If
an error occurs, the error message displays in the log and the export is stopped. If necessary, you can
copy and paste the text in the execution log—for example, to send the error to Axiom Support. To do
this, right-click inside the log and choose Select All, then select Copy.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 811



If you want to stop the export while it is executing, click Stop. When the export is complete, click OK to
close the dialog.

Export Wizard

Using the Export Wizard, you can create new exports and edit existing exports. Export settings are
organized by tab.

Tab Description

General Defines the name of the export and other general settings.

Source Specifies the table data to be exported.

Destination Specifies the destination for the exported data, either a delimited file or an
external database.

Execute Execute the export.

NOTE: It is possible to configure user permissions so that a user has read/write
or read-only access to the export utility file, but the user does not have execute
permissions for the export. In this case, the Execute tab is hidden.

As you complete the export settings, the Export Wizard performs error checking for missing required
settings and invalid settings. If an error is detected, an error message displays in the bottom of the
dialog. You can click the link to be taken to the tab that contains the error. Only one error is displayed at
a time; once you resolve the current error message, a newmessagemay appear.

Export Wizard: General tab

On theGeneral tab of the Export Wizard, you can define general properties for the export.

Item Description

Export Name The name of the export. The export name is how you access and execute
exports from the Exports Library, and in other areas such as the Export ETL
Package task in Scheduler.

Description Optional. A description for the export. The description can be used to document
the purpose of the export and/or to detail important export instructions. The
description is limited to 2000 characters.

When an export is opened in execute-only mode, the description can be viewed
by clicking the Show description link in the Execute Export dialog.

Export Wizard: Source tab

Use the Source tab of the Export Wizard to specify the data to be exported. You can export data from any
user-defined table in the system.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 812



Item Description

Source table The Axiom table that contains the data to be exported. You can select any table
in the Table Library.

To specify a table, click the table icon to the right of the entry box. In the
Choose Table dialog, select the table to use as the source table and then click
OK. You can change the view and filter the list to find the table you are looking
for.

Filter Optional. A data filter to specify the rows in the table to export. If no filter is
applied, then all rows will be available for export.

NOTE: If the user executing the export has a security filter on the source table,
that filter will be honored in addition to any filter defined here.

You can type in a filter criteria statement, or you can use the Filter Wizard to
create one. Once you have specified a filter, you can click the validate icon to
validate the filter and return the current row count for the filter.

Choose columns
to export

The columns of the table to export. By default, all columns are selected for
export.

If desired, you can clear the check box for specific columns if you do not want to
export the data in those columns. Key columns must be included in the export
and cannot be changed.

The column list includes all regular columns, all calculated fields, and the system
information columns for modified by / date.

Export Wizard: Destination tab

Use theDestination tab of the Export Wizard to specify the export destination and configure the
necessary destination properties. You can export data to the following destinations:

l External database (SQL Server or Oracle)
l Delimited file

The destination properties differ depending on the selected destination type.

� Exporting data to an external database
Complete the following settings to export data to a target table in an external database.

Item Description

Remote
Destination

Select either SQL Server orOracle.
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Item Description

Remote Data
Connection

If your Axiom Budgeting and Performance Reporting system is hosted on the
Axiom Cloud, then you must specify a remote data connection in order to
connect with the external database.

You can select any remote data connection that has been set up in Scheduler. If
no remote data connections have been defined in your system, then this
setting does not apply and will not display.

Server l For SQL Server, enter the server name for the external database.
l For Oracle, enter the connection parameters for the external database. You

can obtain these parameters from the Oracle TNS Names entry. For more
information, see the similar discussion for setting up Oracle as an import
source (Connection information for Oracle).

Database Enter the name of the external database. This setting only applies if the
database is SQL Server.

User Enter the user name to use to connect to the external database. For SQL Server,
the user credentials must be for a SQL Server account; network domain
credentials cannot be used.

NOTE: The user credentials must have the appropriate permissions to perform
the table actions for the export in that database.

Password Enter the password to use to connect to the external database.

NOTE: The password must be re-entered whenever any of the other connection
properties are changed.

Target Table Specify the name of the table to create or update in the destination database. If
desired, you can use the Choose Table button to the right of the box to look
up existing table names in the destination database.

You can update an existing table or create a new table. The behavior is
determined by the setting Drop and Create Destination Table. Note that if
"drop and create" is not enabled for the export, then the table must already
exist in the destination database because the export will not create it. You can
either manually create the table in the destination database before running the
export, or you can run the export once with "drop and create" enabled to
initially create the table, then disable the option for future executions to update
the existing table.
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Item Description

Drop and Create
Destination
Table

Specifies whether the destination table is created or updated.
l If enabled (default), the destination table will be created as part of the

export. If the destination table already exists in the destination database, it
will first be dropped (deleted), and then re-created with the new data from
the export. Any existing data in the table will be lost.

l If disabled, the existing destination table will be updated with the new data
from the export. The destination table must already exist in the destination
database; the export will not create the table. Any existing data in the table
may or may not be retained, depending on whether the option Truncate
Destination Table is enabled.

Truncate
Destination
Table

Specifies whether the existing rows in the destination table are deleted before
updating the table with new data from the export. Only applies if the export is
configured to update an existing table (Drop and Create Destination Table is
disabled).
l If enabled, all existing rows in the destination table will be deleted before the

table is updated with new data.
l If disabled (default), then all existing rows in the destination table are

preserved, and new data rows are appended to the table.

NOTE: Newdata rows are added "as is", without validating for duplicate keys or
other constraints. This option should only be used if you are confident that new
data will not conflict with existing data.

Once the connection information is completed, you can click Test connection to test the connection
information for the external database. The Status updates to show either a success message or an error
message.

NOTE: The test connection requires the user to have the highest level of permissions that could
potentially be used by the export (permission to drop and create tables). If the specified user does
not have this level of permissions, the test connection will fail. However, if "drop and create" is not
enabled for the export, then the export may succeed even though the test connection failed.

� Exporting data to a delimited file

NOTE: The ability to export data to a delimited file using an export utility is only supported for Axiom
Cloud systems using a remote data connection. As an alternative, on-premise systems can use the
File Processing feature instead.

Complete the following settings to export data to a delimited file.
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Item Description

Remote
Destination

Select Delimited File to export data to a delimited text file.

Remote Data
Connection

Select a remote data connection to use for the export. You can use any remote
data connection that has been set up in Scheduler.

Folder path Enter the folder path where you want the destination file to be saved. You can
type the path or click the folder icon to navigate to the desired path.

The folder path must be a UNC path (i.e. \\servername\foldername). If you
enter a mapped drive, it will automatically be converted to a UNC path. The
folder path must be accessible to the Axiom Cloud Integration Service.

File name Enter the name of the delimited file for the export to create.

By default, comma-delimited files are saved as CSV format, and all other
delimiters are saved as TXT format. If you want a comma-delimited file to be
saved as TXT format instead, then include the file extension on the file name.

First row has
column names

Select this option if you want the first row of the delimited file to contain column
names.

Delimiter In the box to the right of the option, enter the delimiting character to use in the
export file. For example, to delimit by a pipe character, enter a pipe character
into the box. By default, the delimiter is set to comma.

If you want to use a space or tab as the delimiting character, place your cursor
in the box and press the space bar or the tab key. The character will be indicated
in parentheses to the right of the box (since the character is not visible in this
case).

Text Qualifier By default, the character used as the text qualifier is double quotation marks (").
If desired, you can enter a different character as the text qualifier, or you can
clear the field if you do not want to use a text qualifier.

The text qualifier is used when values in the data may contain the delimiting
character. For example, when the delimiting character is a comma, but the data
contains values such as full names with a comma (for example: "Doe, Jane").
When the delimited file is created by the export, the value with the comma will
be wrapped in quotation marks so that the comma is not read as a delimiter.

Compress Select this option if you want the export file to be compressed. If enabled, the
export generates a ZIP file that contains the export file.
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Managing document image links
Document links are stored in the VendorImageLink column of the GLTRANSACTIONS_20XX tables. Links
can be imported or managed manually.

NOTE: To import image URLs, you first need to add a column to your import file named
VendorImageLink. For more information, see the accounts payable and accrued receipts/received
not invoiced file layout topics.

The document links display in the Variance Comments Collection tab in theMonth End Review
dashboard as well as the AP and AR tabs in the Department Monthly Package.

Document links can only be added for AP and AR account types.

� Manually add, edit, or remove document links
To manually add, edit, or remove document links:

1. From Explorer, in the Libraries section, click Table Library > Management Reporting > Actuals >
Transactions folder.
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2. Open the appropriate GLTRANSACTIONS_20XX table.

3. To add or edit a link, in the VendorImageLink column, enter the URL in the cell for the appropriate
AP or AR account using the following format: https://link address

4. After making your changes, click Save.

Transferring capital project data fromAxiom Capital
Tracking

If your organization is licensed for Axiom Capital Planning and Axiom Budgeting, you can transfer capital
project data to Axiom Budgeting using the Transfer Capital Projects to Budget utility.

NOTE: You must have both Capital Planning Administrator and Budgeting Administrator privileges to
access this utility.

The system transfers the following information with the project:

l Capital request number (CAPREQ) and project ID
l Description of the project
l Total requested for the project
l Entity and department for the project
l Project type
l Project start year
l Project requestor
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NOTE: If you adjust capital project data or delete a project, you can transfer the project again, and
the system will update or remove the data in Axiom Budgeting. However, you will need to save the
budget plan file in Axiom Budgeting to propagate the changes. For more information, seeManaging
transferred projects.

� Mapping capital category codes to Axiom Budgeting accounts
The first step in transferring capital projects to Axiom Budgeting is to map the capital category codes to
specific accounts.

TIP: You only need to map those categories in which you are transferring projects to Axiom
Budgeting.

To map capital category codes to Axiom Budgeting accounts:
1. In the Cap Plan Admin task pane, in the Integration section, double-click Transfer Capital

Projects to Budget.

2. In the first page of the utility, click Update Budget Account Mapping Here.

TIP: You can also access this same report in the Administration section, click Administrative
Utilities, and double-click Dimension Update Reports.

NOTE: When you click the link, themapping worksheet opens in a separate tab.

Click image to view full size

3. At the bottom of the worksheet, click the CODE tab (if it not already selected).

4. For each category, in the BPAcct column, double-click the cell.
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Click image to view full size

5. In the Choose Value dialog, select the Axiom Budgeting account to map to, and click OK.

Click image to view full size

6. At the bottom of the sheet, map the codes in the Additional Codes for Mapping to BP section.
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Click image to view full size

7. After you finish mapping the appropriate categories, click Save.

Click image to view full size

8. At the Save to Database Status dialog, click OK.

9. Return to the Transfer Capital Projects to Budget utility to complete the transfer of projects.

� Selecting and transferring projects

NOTE: By default, any previously transferred projects will transfer again unless you select them not
to. For instructions on, seeManaging transferred projects.

To select and transfer projects:
1. From the Axiom Capital Planning home page, click Transfer Capital Projects to Budget.
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NOTE: To access this location from the Cap Plan Admin task pane, in the Integration section,
double-click Transfer Capital Projects to Budget.

Click image to view full size

2. From the Select Capital Planning Year drop-down, select the file group planning year in which to
transfer projects to Axiom Budgeting.

Click image to view full size

3. In the lower right corner of the page, click Next.

4. Next to the CAPREQ column, click the check box to select the project(s) to transfer.
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TIP: To view the plan file for a project, click the folder icon next to the CAPREQ number. The
plan file opens in a separate tab. From here, you can make any necessary changes to the
project. However, to propagate the changes in the Transfer Capital Projects to Budget utility,
you will need to refresh the utility.

Click image to view full size

5. In the lower right corner of the page, click Next.

6. The Summary page displays a list of all the capital project requests to be transferred to Axiom
Budgeting. Do any of the following, as needed:

a. If the Axiom Budgeting account is not properly mapped, an exclamation point icon displays
in the BP ACCT column.

b. Click theUpdate Budget Account Mapping Here link to open themapping utility to map to
the correct account code in the Code tab.

c. To filter the list, hover your cursor over a column heading, and click the funnel icon.

d. To return to the list of projects, for example, if you incorrectly selected a project or forgot
to include a project, click Previous.

e. To submit the projects to transfer to Axiom Budgeting, click Submit.
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Click image to view full size

7. After clicking the Submit button, review the confirmation prompt, and click OK.

The summary screen displays the number of plan files transferred.

For information on how to work with transferred projects in Axiom Budgeting, seeWorking with capital
projects in Axiom Budgeting in plan files.

� Managing transferred projects
By default, projects previously transferred automatically transfer again when you run the utility.
However, you can control this action by enabling or disabling these projects from transferring again.

To manage transferred projects:
1. In the Cap Plan Admin task pane, in the Integration section, double-click Transfer Capital

Projects to Budget.

2. Click Click to Show Previously Transferred Projects.
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Click image to view full size

3. Do any of the following:
a. To transfer all projects in the list, click Yes. To disable the transfer of all projects, click No.

b. To search for a specific project, type project information in the Search box such as the
CAPREQ number, the project ID, or description.

c. To view the plan file for a project, click the folder icon next to the CAPREQ number. The plan
file opens in a separate tab. From here, you can make any necessary changes to the
project. However, to propagate the changes in the Transfer Capital Projects to Budget
utility, you will need to close it and open it again.

d. For individual projects, click the toggle to Yes to transfer the project. Click the toggle to No
to disable the transfer.

Click image to view full size

4. Click Next to continue the transfer process as described in step 4 in the Selecting and transferring
projects section above.

NOTE: The projects you disable from transferring will not display in the list.

� Working with capital projects in Axiom Budgeting plan files
After you transfer projects into Axiom Budgeting, they display in the Expense and Stats & Revenue tabs
as dark gray cells. The system also adds "From CP Integration" in the Comments and Budget Method
columns.

From this point, you can enter or update budget data for each month in the blue-shaded cells, just like
any other budget item. If a project is updated or deleted, you need to re-transfer the project. The data is
then updated in Axiom Budgeting and the inputs are set to 0.
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The number in the Total Budget column in the Expenses tab always ties out to the amount coming in
from Axiom Capital Planning. The system allows you to change the spread, but you cannot change the
total value. If you need to transfer a project again and the Total Budget changes, the system
automatically self-balances the amounts.

Standardizing data
Kaufman Hall leverages artificial intelligence to review and categorize your key dimension elements to a
pre-defined Kaufman Hall taxonomy system. The artificial intelligencemethod leverages descriptions and
key characteristics to derive suggested classifications. These classifications provide a required level of
standardization and structure to enable comparative analysis as well as key integration points.

The purpose of this section is to explain the data integrity compliance features for your Axiom products
and the reasons for using them. Standardizing your data includes the following steps:

1. Map KHA Standard Class codes - To standardize data across accounts, departments, and so on in
your organization, you first need to map them to KHA Standard Class codes using a series of
reports that allow you to review and modify your data classification taxonomy.

2. Review codes for standards compliance - To help keep your organization compliant with Kaufman
Hall standards, the Standard Data Assessment dashboard uses a series of icons to provide a clear
and easy way to see if your accounts, departments, and so on meet the Kaufman Hall standards
criteria.

3. Assign KHAStandardClass by department and account - The Statistic Identification Update utility
allows you to map ACCT.KHAStandardClass values by account/department or
department/account combinations.

4. Review YTD statistics by KHAStandardClass classification - The Statistic Classification Review report
allows you to review YTD data for the statistic accounts to ensure they correctly tie out from the
department summed up to the entity level.

Mapping KHA Standard Class codes
We suggest you review each assignment and correct where you deem necessary.

If you feel there aremissing categories or identifiers to accurately classify our key elements, please e-mail
us at: taxonomy@kaufmanhall.com. Wewill continue to expand and adapt this taxonomy structure to
give you quality insights through comparative elements and planning process integration.

We have included five review tools:

l Entity Standards Review
l Dept Standards Review
l Acct Standards Review
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l Jobcode Standards Review
l Paytype Standards Review

Each one is similar in structure. Within each, you will review the assignment and, where needed, change
the standard assignment in the over-ride column.

As part of the development of future report tools and utilities, data needs to be standardized across
accounts, departments, and so on. Part of this process includes mapping these items in your
organization to KHA Standard Class codes.

NOTE: This process will benefit your organization in the future by providing more detailed data and
reporting capabilities. Once complete, you should only need to update these reports when you add
new accounts, departments, etc.

� About Machine Learning classifications
If your organization uses the cloud-based version of Axiom Budgeting and Performance Reporting, the
system has access to a back-end machine learning process that analyzes and determines the best
suggested classification code for the account. You can use this pre-determined classification or assign
your own, depending on howwell themachine learned classification meets your needs.

To map KHA Standard Class codes:
1. In theMgmt Admin task pane, in theData Maintenance section, click Data Reconciliation, and

double click one of the following:

NOTE: The results returned depend on the user’s write filter on the dimension table as
established when using the Dimension Maintenance Security utility.

l Acct Standards Review
l Dept Standards Review
l Entity Standards Review
l Jodcode Standards Review
l Paytype Standards Review
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2. In the Refresh Variables dialog, you can optionally filter the data in the report by KHA Standard
Class and/or State by clicking Choose Value, select the values to filter by, and click OK.

NOTE: To view all of the items (accounts, departments, etc.) in the report, click OK.

3. In the KHA Standard Classification column, do one of the following.

a. To use theMachine Learning classification as determined by the system, copy the
classification from theML Classification column, and paste it into the KHA Standard
Classification column.

NOTE: At this time, theML Classification is only used if your organization has a cloud-
based system. If your system is located on premise, the column will be blank.

b. To select a different classification, double-click the folder next to the KHA Standard
Classification column, select a classification, and click OK.

4. In the Entity Standards Review report, do the following:
a. In theMedicare Provider Number column, type theMPN number, as needed.
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b. In the Active column, identify which entity is active by doing one of the following:
i. In theMedicare Provider Number column, type theMPN number, as needed.

ii. In the Active column, identify which entity is active by doing one of the following:
l To activate the code, click TRUE.
l To deactivate the code, click FALSE.

5. After making your changes, in theMain ribbon tab, click Save.

The information you enter saves back to the corresponding dimension table. For example, after mapping
your accounts, the system saves your changes to the ACCT dimension table.

Reviewing codes for standards compliance
The Standard Data Assessment dashboard provides several benefits:

l Helps improve the quality of your data
l Ensures that you use standard Kaufman Hall codes to keep you compliant with Kaufman Hall

standards
l Helps save time in preparing for monthly reporting and annual budgeting

NOTE: The dashboard includes the KHAStandardClass column in the ACCT, DEPT, ENTITY, JOBCODE,
and PAYTYPE dimensions to help standardize reporting across the organization. Currently, the
column populates with a default value of NotMapped. These columns will be populated at a later
date, but until then they will be out of compliance.

To work with the Standard Data Assessment dashboard:

l To refresh the data in the dashboard, click Refresh.
l To include the net income in the fund balance, click the toggle to Yes; otherwise, click the toggle to

No.
l From the View drop-down, select to view all of the entities or just warnings and failures.

To navigate to the Standard Data Assessment dashboard, in theData Maintenance section of theMgmt
Admin task pane, double-click Standard Data Assessment.
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� Icon definitions

Balanced BS Actual and Budget
Shows if the balance sheet is in balance for both the actuals and budget. The icons in these columns
represent the following:

Balance sheet does not balance. Run a Balance Sheet report, and review it for accuracy. Update the
data using the Load GL 12Months import, and then review the data for accuracy.

Balance sheet balances correctly. No action is required.

Standard FSDetail
Shows if the values from the FSDetail column (located in the ACCT dimension table) comply with the
standard values established by Kaufman Hall. The icons in this column represent the following:

The codes do not comply with the standard Kaufman Hall values. To view the accounts with FSDetail
codes that do not comply, click , and update the ACCT dimension table with the standard Kaufman
Hall codes.

The codes comply with the standard Kaufman Hall values. No action is required.

Standard FSSummary
Shows if the values from the FSSummary column (located in the ACCT dimension table) comply with the
standard values established by Kaufman Hall. The icons in this column represent the following:

The codes do not comply with the standard Kaufman Hall values. To view the accounts with
FSSummary codes that do not comply, click , and update the ACCT dimension table with the standard
Kaufman Hall codes.
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The codes comply with the standard Kaufman Hall values. No action is required.

KHA Standard Class
Shows if the values from the KHA Standard Class column (located in the ENTITY, DEPT, ACCT, JOBCODE,
and PAYTYPE dimension tables) aremapped.

The value of Not Mapped exits for any record in the ENTITY, DEPT, ACCT, JOBCODE, and PAYTYPE
dimension tables. To view the records that are not mapped, click , and map the record in the
dimension table with the standard Kaufman Hall code.

All records have been mapped. No action is required.

Actual GL
Shows if the actual GL data has been loaded for the entity. The icons in this column represent the
following:

A zero YTD value exists for the entity. If incorrect, update the data using the Load GL 12Months
import, and review the data for accuracy. If you purposely did not import GL data, no action is required.

GL data has been loaded for the entity. No action is required.

Budget GL
Shows if the budget GL data has been loaded for the entity. The icons in this column represent the
following:

A zero YTD value exists for the entity. If incorrect, review the budget GL data for accuracy. If correct,
no action is required.

GL data has been loaded for the entity. No action is required.

Actual Bal Sheet
Shows if the actual balance sheet data has been loaded for the entity.

TIP: If you currently do not import your balance sheet data into Axiom Management Reporting, we
recommend you do so to provide better information to use in the system. For help on loading this
data, contact Kaufman Hall Support.

The icons in this column represent the following:

A zero value exists in the current month for the entity. If incorrect, import your actual GL and check it
for accuracy. If correct, no action is required.

Actual balance sheet data has been loaded for the entity. No action is required.
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Budget Bal Sheet
Shows if the budget balance sheet data has been loaded for the entity.

TIP: If you do not budget your balance sheet data in Axiom Budgeting, we recommend that you
implement a budget for your balance sheet during the next budget cycle. This will provide better
information to use in Axiom Budgeting and Performance Reporting going forward.

The icons in this column represent the following:

A zero budget value exists in the current month for the entity. If incorrect, review your budgeted
balance sheet for accuracy. If correct, no action is required.

Budget balance sheet data has been loaded for the entity. No action is required.

Actual Rev/Usasge
Shows if the actual Revenue Usage data has been loaded for the entity.

NOTE: Revenue Usage data is only loaded if patient revenue exists in the GL. If you do not currently
load Revenue Usage data, we recommend that you do so to take full advantage of Axiom
Management Reporting. For help on loading this data, contact Kaufman Hall Support.

The icons in this column represent the following:

A zero value exists for the entity for the current month. If incorrect, load the data using the Load
RevUsage import, and review the data for accuracy. If correct, no action is required.

Revenue Usage data has been loaded for the entity. No action is required.

Cur Month Volatility
Shows if the total expense in the current period compared to the percentage change from themean is
more or less than ten percent. The icons in this column represent the following:

The percentage change of expenses in the current period compared to themean is greater than ten
percent. If correct, no further action is required. If not correct, update the data using the Load GL12
Months import, and review the data for accuracy.

The percentage change is less than ten percent. No action is required.

Financial Current
Shows if the financial data has been loaded for themost recent closed period in your ACTYYYY table.
Kaufman Hall defines themost recent closed period as themonth and year 60 days prior to today’s date.
The icons in this column represent the following:
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The data loaded is older than 60 days from today. Update the data for themost recently closed
period using the Load GL 12Months import, and then review the data for accuracy.

The data has been loaded for the entity. No action is required.

Payroll Current
Shows if the payroll data has been loaded for themost recent closed period in your Pay_12_YYYY table.
Kaufman Hall defines themost recent closed period as themonth and year 60 days prior to today’s date.

TIP: If you do not process the BiWeekly to Monthly utility, we recommend that you include this step
monthly going forward to take full advantage of Axiom Management Reporting. For help on
processing this data, contact Kaufman Hall Support.

The icons in this column represent the following:

The data loaded is older than 60 days from today. Update the data for themost recently closed
period using the Load Biweekly Payroll import and processing the BiWeekly to Monthly utility to accrue
the biweekly payroll data to themonthly payroll tables.

The data has been loaded for the entity. No action is required.

Assigning KHAStandardClass by department and account
The Statistic Identification Update utility allows you to map ACCT.KHAStandardClass values by
account/department or department/account combinations. You can use this utility to filter the list of
accounts or departments in several different ways so that you can narrow the list down to only those
accounts/departments that you need to classify.

After you filter the accounts/departments, the utility then displays the list and populates the column
values based on the ACCT.KHAStandardClass column in the ACCT dimension. The system displays
unmapped items as NotMapped.

IMPORTANT: For updated or new accounts/departments, you will need to reclassify them.

To assign KHAStandardClass by department and account:
1. Update ACCT.KHAStandardClass using the Acct Standard Review utility. For instructions, see

Mapping KHA Standard Class codes.

NOTE: Depending upon the volume of data that is loaded, the performancemay be slow.

2. In theMgmt Admin task pane, in Data Maintenance > Data Reconciliation, double-click Statistic
Identification Update.
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NOTE: The utility opens in a separate web browser.

3. From the Filters panel, configure any of the following criteria, and click Apply:

Option Description

Filter by ACCT.Type Select to review KeyStat and/or Statistic accounts, and click OK.

Entity Filter To refine the results even further, you can create or select an
advanced Entity filter to select accounts using other grouping
columns. For instructions, see Using the Advanced Filter Wizard.

Select Entity Select one or more entities, and click OK.

Select Dept.RptMap
(ACT20XX)

Select one or more departments, and click OK.

NOTE: The system refers to the system period to determine the
ACT table in which to display the list of departments.

Standard Sort Order Select to sort the list by account and department (default) or
department and account.
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Option Description

Select Additional Display
Column(s)

Select an additional grouping column from the ACCT dimension.

NOTE: Only string data type columns display in the list.

4. Above the table, configure the following options, as needed:

Option Description

Show YTD Value? To view the YTD values for each account/department
combination, click the toggle to Yes.

Show
ACCT.KHAStandardClass?

To view the ACCT.KHAStandardClass defined in the ACCT
dimension, click the toggle to Yes.

Unlock All Records? To unlock all the records for editing, click the toggle to Yes. If the
list is long and you unlock all the records, you can edit the values
in spreadsheet mode by clicking Edit in Spreadsheet in the
upper-right corner of the page. Any changes you make in
spreadsheet modewill automatically update the values in the list
after you save.

NOTE: You may encounter performance issues if you unlock all
records.

5. If not using the Unlock All Records option, to edit individual item, click the lock icon next to the
Department or Account column (depending on how you selected to display the list).

TIP: The lock/unlock functionality simply provides a way for the system to update only those
items that have changed. This helps maintain better system performance while working with
the utility.

6. Select values in the following columns:

l Statistic Type
l Patient Type
l Function
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l Direct/Indirect
l DEPT/ACCT KHAStandardClass
l Conversion Factor

NOTE: The exclamation point icon in the last column indicates there is a difference between
the default KHAStandardClass code and the assignment selected using this utility.

7. After making your edits, click Save.

After the account/departments aremapped, you can use the Statistic Classification Review report to tie
out YTD values by entity based on KHAStandardClass classification.

� Deleting department/account classification assignments
Deleting a department/account does not delete it form the ACCT table. This action simply allows you to
"reset" the record by removing it from the classification identification table. After you delete an item, the
record will return with the original defaults assigned in ACCT.KHAStandardClass.

To delete department/account classification assignments:
1. Open the Statistic Identification Update utility.

2. Click the delete check box next to the lock/unlock column.

3. Click Save.

Review YTD statistics by KHAStandardClass classification
After you complete the classification process, you can use the Statistic Classification Review report to
review statistics to ensure the correct YTD values tie out from the department summed up to the entity
level.

To Review YTD statistics by KHAStandardClass classification:
1. In theMgmt Admin task pane, in Data Maintenance > Data Reconciliation, double-click Statistic

Classification Review.

NOTE: The report opens in a separate web browser.
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2. From the Filters panel, configure any of the following criteria, and click Apply:

Option Description

Entity Filter To refine the results even further, you can create or select an
advanced Entity filter to select accounts using other grouping
columns. For instructions, see Using the Advanced Filter Wizard.

Entity Selection Select one or more entities, and click OK.

Limit by Entity.Summary Select to limit the list to only specified entities, and click OK.

3. Review the YTD statistics in the report to determine that they are correctly summing and rolling up
from the department to the entity level. If needed, return to the Statistic Identification Update
utility to make the appropriate adjustments. You can then return to this report, where the
changes are automatically refreshed.
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File Processing
Using file processing, you can automatically refresh a file and then perform various actions on it. The file
can be processed "as is," or you can leveragemultipass processing to cycle through each element of a
dimension or grouping, with an appropriate data filter automatically applied to each pass.

File processing can be used to perform the following actions:
l Save snapshot of file: Create a snapshot copy of a spreadsheet-based file, and then save and/or

email it.
l Save snapshot of form: Create a snapshot copy of a form-enabled file, and then save and/or email

it.
l Print: Print the current file, using one or more print views.
l Export to delimited text file: Export data in the current file to a delimited text file, and then save

and/or email it.
l Save data: Perform a save-to-database from the current file.
l Alerts: Process alert conditions defined in the file.
l File collect: Combinemultiple spreadsheet files into a single file, and then save and/or email it.
l Batch: Perform file processing on multiple files in a batch process, including the ability to override

certain file processing settings for the file.
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Although all of these activities are performed using the file processing feature, the setup and
requirements differ for each processing type. In all cases, the file that you want to process must have a
File Processing Control Sheet (Control_FileProcessing) with a selected processing type. Some processing
types then require additional file processing settings (such as snapshot and export), while other types
require an additional control sheet where the settings specific to that operation are defined (such as file
collect and batch).

One common use for file processing is report distribution, to automatically deliver report files out to
multiple recipients. This frequently involves using several different features of file processing, for
example:

l Multiple reports configured for snapshot file processing, and using multipass processing. For
example, an income statement processed by department, region, or VP, and creating a separate
snapshot file for each element.

l A report configured for file collect, to collect all of the snapshots into targeted report packages,
including adding things like cover sheets and other supporting information. These packages could
be saved to designated file locations and/or emailed to the appropriate recipients.

l A report configured for batch processing to run everything at once. For example, the batch would
contain an entry for each report configured for snapshot processing, and then finish with the file
collect report.

File processing is set up on a per file basis. File processing can be set up on any Axiom file, but the
primary use case is in reports.

Once the file has been configured to use file processing, you can process it by using File Output > File
Processing. From this menu, you can choose to Process File or Process File Multipass. File processing
can also be performed via Scheduler, and from a task pane.

Enabling file processing for an Axiom file
In order to use file processing on an Axiom file, the file must have a File Processing Control Sheet. Once
the control sheet has been added, you can complete the file processing settings by using the File
Processing task pane.

To enable file processing for an Axiom file:
1. Open the file for which you want to enable file processing. File processing can be set up for report

files, templates/plan files, and driver files.

IMPORTANT: Before enabling file processing for a plan file, make sure that the plan file design
can accommodate ongoing data refreshes. When file processing is initiated, a full refresh
occurs, including all enabled Axiom queries in the file. For more information, see
Considerations for using file processing in plan files.

2. On the Axiom tab, in the File Output group, click File Processing > Enable file processing in this
workbook.
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NOTE: In systems with installed products, this featuremay be located on theMain tab (either
directly on the tab, or on the Publishmenu).

The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file. You can
now set up file processing using either the task pane or the control sheet. For more information on
configuring each type of file processing, see the detailed topics in this section.

Setting up file processing: Snapshot

Using file processing, you can set up an Axiom file to take a snapshot copy according to defined settings,
and then save that copy to a file location and/or email it. "Snapshot" is a process that converts an Axiom
file to a regular Microsoft Excel spreadsheet, so that it can be accessed outside of Axiom Budgeting and
Performance Reporting.

Taking snapshot copies via file processing has the following advantages over using the regular snapshot
features (Snapshot File and E-Mail Workbook):

l If you have a standard set of snapshot and delivery options that you use with a file, these options
are saved in the file processing settings so that you do not need to select them each time you take
a snapshot of the file.

l Using themultipass features of file processing, you can process a file multiple times for different
dimensions, saving or emailing the snapshot copy after each pass.

NOTE: File processing always performs a refresh of the file, in addition to taking the snapshot copy. If
you want to take a snapshot copy of the file without performing a refresh first, you must use one of
the regular snapshot features.

TIP: You can use snapshot file processing in conjunction with batch reporting and file collect. For
example, you can automatically process multiple files, save snapshot copies of the various results,
and then collect those copies into "report packages" to be emailed to recipients or saved to a
designated file location.

Snapshot file processing is intended for spreadsheet Axiom files. If you have a form-enabled file where
you want to process the form to create snapshot PDF copies, use the separate option Save Snapshot of
Form.

To set up file processing to take and deliver snapshot copies:
1. Open the file where you want to set up file processing, and enable it as follows: On the Axiom tab,

in the File Output group, click File Processing > Add File Processing control sheet to active
workbook.

NOTE: In systems with installed products, this featuremay be located on theMain tab (either
directly on the tab, or on the Publishmenu).

Administrator's Guide Axiom Budgeting and Performance Reporting │ 840



The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file.

2. In the File Processing pane, for Processing Type, select Save Snapshot of File.

3. In the Sheets to Process box, enter the name(s) of the sheet(s) to process. You can include any
sheet except control sheets and hidden sheets. Control sheets and hidden sheets are not included
in snapshot copies.

You can click the Select worksheets button to select sheet names from a list, or you can type
the sheet names. Separatemultiple sheet names with semicolons.

The sheets to process will be included in the snapshot copy when the file is processed. This setting
does not determine which sheets will be refreshed before the snapshot is taken; the refresh
always applies to all sheets in the file when using file processing.

4. In the Snapshot Settings section, complete the following settings for the snapshot:

Item Description

File Type Select one of the following to determine the file type for the snapshot:
XLSX (default), XLSM, XLS, or PDF.
NOTE: If you select XLS, and the spreadsheet contains features that are
not supported by the XLS format, the compatibility warning is not
displayed during file processing. You may want to test saving the file to XLS
to ensure that the end result will be as expected.

Formula
Conversion

Select one of the following to determine how formulas are handled in the
snapshot:
l Convert All Formulas (default): All formulas are converted to values.
l Retain Excel Native Formulas: Axiom formulas are converted to

values, but Excel formulas are left as is. Note that if an Excel formula
references a sheet that is not included in the snapshot, that formula
will be converted to a value.
NOTE: If the file contains a pivot table, this option must be selected in
order for the pivot table to work in the snapshot copy.

This option does not apply if PDF is the selected file type.
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Item Description

Sheet Name Specify how the sheets to process should be named in the snapshot. You
can do one of the following:
l You can use file processing variables to generate dynamic sheet names.
l You can type a "hard-coded" sheet name.
The sheet name setting cannot be left blank. By default the sheet name
uses file processing variables, and is set to [Current_Value]_
[Current_SheetName]. If you do not plan to usemultipass processing
on the file, you should change this to just [Current_SheetName], which
means that all sheets in the snapshot will use their current sheet names.

The sheet name setting takes a single entry that applies to all sheets being
processed. Therefore the option to use a "hard-coded" sheet name only
applies when processing a single sheet. If you are processing multiple
sheets, this setting must use file processing variables.

If you want to use a file processing variable, you can type the variable or
you can click the pencil icon to open a text editor. From the Insert
Variable list, select the variable that you want to use.

For more information, see Defining sheet names for file processing.

5. In theOutput File Settings section, complete the following settings to determine the delivery of
the output file (or files):

Item Description

Output To Select one of the following:
l Local File System (default): The output location is outside of Axiom, to

either your local computer or a network share. The specific path is
detailed in theOutput Folder setting. Access to output files is not
controlled by Axiom Budgeting and Performance Reporting.

l Axiom Repository: The output location is the Axiom file system, within
the Reports Library. The specific path is detailed in theOutput Folder
setting. Access to output files is controlled by security access to the
designated folder within Axiom.
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Item Description

Output file
name

Specify how the output file (or files) should be named. You can do one of
the following:

l You can use file processing variables to generate dynamic file names.
l You can type a "hard-coded" file name.
The file name setting cannot be left blank. By default the file name uses file
processing variables, and is set to [Current_Value]_Report. You can
change "_Report" to something more specific to the file contents (or omit
it to use only the current value). If you do not plan to usemultipass
processing on the file, then you can delete the current value variable and
just type the desired file name.

If you want to use a file processing variable, you can type the variable or
you can click the pencil icon to open a text editor. From the Insert
Variable list, select the variable that you want to use.

For more information, see Defining the file name for file processing.

Output folder Specify the folder location for the output file (or files). You can type a folder
path, or you can click the folder icon to browse to the folder location. The
browse dialog will display either your local file system or the Axiom file
system, depending on what you selected forOutput To. This setting does
not apply if you are only emailing files.

For more information, see Defining the output folder for file processing.

File Generation This option only applies when using multipass processing. Select one of
the following:

l Create a Single Output File (default): The results of each pass are
collected into a single output file. For example, if you specified 1 sheet
to process, and themultipass settings result in 10 passes, then one
output file is created, containing 10 sheets (one sheet for each pass).

l Create an Output File for Each Pass: The results of each pass are
saved as individual output files. For example, if themultipass settings
result in 10 passes, then 10 output files are created (one file for each
pass).

For snapshot, standard (non-multipass) processing always produces a
single output file.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 843



Item Description

Save or Email
Files

Select a delivery option for the output file (or files):

l Save Files: The output files are saved to the specified output folder.
l Email Files: The output files are emailed to the specified recipients. The

output files are not saved anywhere on the file system.
l Save and Email Files: The output files are both saved and emailed.
If you select an option that includes emailing, then the Email Settings
section displays in the File Processing pane.

Purge Setting This option only applies when the file output is being saved to the Axiom
Repository.

If you want the file output to be automatically deleted after a specified
period of time, then click the pencil icon to open the Choose Date
dialog.
l Static purge date: Select a specific date, after which the output will be

deleted.
l Relative purge date: Specify a number of days to keep the output after

it has been generated. The output will be deleted after the specified
number of days have passed.

For more information, see Automatically deleting file output generated by
file processing.

Remote Data
Connection

This option only applies when the file output is being saved to your local
file system, and only for Cloud Service systems that are using remote data
connections.

Select the name of the remote data connection to use for the file
processing operation. The designated remote data connection will be used
to access the local file system and save output file(s) to the designated
location.

A remote data connection is required to save files locally from a cloud
system. For more information, see the section on remote data
connections in the Scheduler Guide.

Microsoft Sharepoint support: You can specify a Sharepoint URL for the folder location, to save
the output files to a Sharepoint portal. This feature is only available when running file processing
locally via the Excel Client, and when the processing type is snapshot. The user executing the
processing must have the appropriate permissions to the target folder in Sharepoint. Note that if
the specified folder does not already exist in Sharepoint, this will not be detected by Axiom
Budgeting and Performance Reporting during the file processing, but a Microsoft error will report
the location as not found.
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Opening the file after processing: If desired, you can opt to automatically open the output file
within Axiom Budgeting and Performance Reporting after the processing is complete. This option
is only available if the result of the processing is a single file. If you want to use this option, it must
bemanually configured on the Control Sheet. In the File Settings section, set Open Output File
after Processing to On. For more information, see File Processing Control Sheet.

6. If you chose to email the output file (or files), complete the Email Settings:

Item Description

To

Bcc

Enter the email addresses to receive the output file via email. Separate
multiple addresses with a semicolon.

If the file will be processed using multipass processing, to multiple output
files, then you should use formulas to dynamically generate the
appropriate email recipients for each pass (otherwise each pass will be sent
to the same recipients). See Using dynamic email addresses with file
processing.

From Select one of the following to specify the From address:

l System User: The From address is the default From address specified
for Axiom Budgeting and Performance Reporting in the system
configuration settings.

l Current User: The From address is the email address for the user who
performs the file processing, as defined in Security.

Subject Line Enter a subject line for the email.

NOTE: If you want to use bracketed text in the subject line, you must
escape this text with an additional set of brackets, so that Axiom
Budgeting and Performance Reporting does not try to evaluate the
bracketed text as a file processing variable. For example, if you want the
text "[Axiom Message]" in the subject line of the email, you must enter
[[Axiom Message]] in the Subject Line field. The extra set of brackets is
removed when the email is generated.

Body Text Enter body text for the email.

NOTE: If you want to use bracketed text in the body text, you must escape
this text with an additional set of brackets, so that Axiom Budgeting and
Performance Reporting does not try to evaluate the bracketed text as a file
processing variable. For example, if you want the text "[Sent from Axiom
Budgeting and Performance Reporting]" in the body text of the email, you
must enter [[Sent from Axiom Budgeting and Performance
Reporting]] in the Body Text field. The extra set of brackets is removed
when the email is generated.
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For more information, see How email is delivered for file processing.

7. Optional. If you want to usemultipass processing on the file, then complete theMultiPass
Settings.

For Source Column, click the column icon to select the source column for multipass processing.
For example, if you select DEPT.VP as the source column, then the file will be processed once for
each VP, and the data in the file will be automatically filtered to show only the data for that VP.

To confirm that the file will be processed using your desired list of items, click Preview Multipass
List. A dialog opens, displaying the total number of items to process, as well as the list of individual
items.

For more information on multipass processing, and for details on advanced settings, see
Configuring multipass settings for file processing.

8. When you are finished configuring the file processing settings, click File Options > Save to save
the settings in the file.

� Results
Users can now use File Output > File Processing to process the file. The following actions will occur:

l When using Process File, the file will be refreshed "as is," the snapshot copy will be taken, and the
snapshot copy will be saved and/or emailed according to the file processing settings.

l When using Process File Multipass, the file will be refreshed using a multipass filter to limit the
data to the current multipass item (for example, for the current VP if processing by DEPT.VP). This
process will occur for each uniquemultipass item being processed, with a different multipass filter
being applied for each pass.

If the file generation is to multiple output files, then a snapshot copy is taken after each pass, and
then saved and/or emailed according to the file processing settings.

If the file generation is to a single output file, then the results of each pass are collected into a
single file. When all of the passes are complete, the snapshot copy is taken, and then saved
and/or emailed according to the file processing settings.

Snapshot settings for deleting rows and columns and for workbook/worksheet protection are honored
as normal.

Setting up file processing: Snapshot Forms

Using file processing, you can set up a form-enabled file to generate a PDF "snapshot" of the form, and
then save that copy to a file location and / or email it. The "snapshot" process converts an Axiom form to
a stand-alone PDF file, so that it can be accessed outside of Axiom Budgeting and Performance
Reporting. When used with multipass processing, snapshot form provides a production reporting
feature for Axiom forms, where the form can be processed multiple times over a specified dimension,
saving and/or emailing the PDF generated for each pass.
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When you use the snapshot form option, Axiom Budgeting and Performance Reporting processes the
form-enabled source file and renders the web form, then generates a PDF copy of it. This PDF generation
is the same process that occurs when using Tools > Generate PDF on an Axiom form in theWeb Client.
The Axiom form should be set up as needed for optimal PDF generation.

Special design considerations may apply to certain forms, especially if the target form contains
Embedded Form components. For more information, see Design considerations for snapshot form
processing.

IMPORTANT: Snapshot form processing can only be executed by Scheduler. It cannot be executed
locally on the Desktop Client. You must create a Scheduler job, add a File Processing task, and
configure that task to process the form-enabled file that has been configured for snapshot form
processing.

To set up file processing to create and deliver snapshot PDF copies of an Axiom form:
1. Open the file where you want to set up file processing, and enable it as follows: On the Axiom tab,

in the File Output group, click File Processing > Add File Processing control sheet to active
workbook.

NOTE: In systems with installed products, this featuremay be located on theMain tab (either
directly on the tab, or on the Publishmenu).

The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file.

2. In the File Processing pane, for Processing Type, select Save Snapshot of Forms.

3. In theOutput File Settings section, complete the following settings to determine the delivery of
the output file (or files):

Item Description

Output To Select one of the following:
l Local File System (default): The output location is outside of Axiom, to

either your local computer or a network share. The specific path is
detailed in theOutput Folder setting. Access to output files is not
controlled by Axiom Budgeting and Performance Reporting.

l Axiom Repository: The output location is the Axiom file system, within
the Reports Library. The specific path is detailed in theOutput Folder
setting. Access to output files is controlled by security access to the
designated folder within Axiom.
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Item Description

Output file
name

Specify how the output file (or files) should be named. You can do one of
the following:

l You can use file processing variables to generate dynamic file names.
l You can type a "hard-coded" file name.
The file name setting cannot be left blank. By default the file name uses file
processing variables, and is set to [Current_Value]_Report. You can
change "_Report" to something more specific to the file contents (or omit
it to use only the current value). If you do not plan to usemultipass
processing on the file, then you can delete the current value variable and
just type the desired file name.

If you want to use a file processing variable, you can type the variable or
you can click the pencil icon to open a text editor. From the Insert
Variable list, select the variable that you want to use.

For more information, see Defining the file name for file processing.

Output folder Specify the folder location for the output file (or files). You can type a folder
path, or you can click the folder icon to browse to the folder location. The
browse dialog will display either your local file system or the Axiom file
system, depending on what you selected forOutput To. This setting does
not apply if you are only emailing files.

For more information, see Defining the output folder for file processing.

File Generation This option only applies when using multipass processing. Select one of
the following:
l Create a Single Output File (default): The results of each pass are

collected into a single output file. For example, if themultipass settings
result in 10 passes, then one output file is created, containing the
output of all 10 passes.

l Create an Output File for Each Pass: The results of each pass are
saved as individual output files. For example, if themultipass settings
result in 10 passes, then 10 output files are created (one file for each
pass).

For snapshot, standard (non-multipass) processing always produces a
single output file.
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Item Description

Save or Email
Files

Select a delivery option for the output file (or files):
l Save Files: The output files are saved to the specified output folder.
l Email Files: The output files are emailed to the specified recipients. The

output files are not saved anywhere on the file system.
l Save and Email Files: The output files are both saved and emailed.
If you select an option that includes emailing, then the Email Settings
section displays in the File Processing pane.

Purge Setting This option only applies when the file output is being saved to the Axiom
Repository.

If you want the file output to be automatically deleted after a specified
period of time, then click the pencil icon to open the Choose Date
dialog.
l Static purge date: Select a specific date, after which the output will be

deleted.
l Relative purge date: Specify a number of days to keep the output after

it has been generated. The output will be deleted after the specified
number of days have passed.

For more information, see Automatically deleting file output generated by
file processing.

Remote Data
Connection

This option only applies when the file output is being saved to your local
file system, and only for Cloud Service systems that are using remote data
connections.

Select the name of the remote data connection to use for the file
processing operation. The designated remote data connection will be used
to access the local file system and save output file(s) to the designated
location.

A remote data connection is required to save files locally from a cloud
system. For more information, see the section on remote data
connections in the Scheduler Guide.

4. If you chose to email the output file (or files), complete the Email Settings:
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Item Description

To

Bcc

Enter the email addresses to receive the output file via email. Separate
multiple addresses with a semicolon.

If the file will be processed using multipass processing, to multiple output
files, then you should use formulas to dynamically generate the
appropriate email recipients for each pass (otherwise each pass will be sent
to the same recipients). See Using dynamic email addresses with file
processing.

From Select one of the following to specify the From address:
l System User: The From address is the default From address specified

for Axiom Budgeting and Performance Reporting in the system
configuration settings.

l Current User: The From address is the email address for the user who
performs the file processing, as defined in Security.

Subject Line Enter a subject line for the email.

NOTE: If you want to use bracketed text in the subject line, you must
escape this text with an additional set of brackets, so that Axiom
Budgeting and Performance Reporting does not try to evaluate the
bracketed text as a file processing variable. For example, if you want the
text "[Axiom Message]" in the subject line of the email, you must enter
[[Axiom Message]] in the Subject Line field. The extra set of brackets is
removed when the email is generated.

Body Text Enter body text for the email.

NOTE: If you want to use bracketed text in the body text, you must escape
this text with an additional set of brackets, so that Axiom Budgeting and
Performance Reporting does not try to evaluate the bracketed text as a file
processing variable. For example, if you want the text "[Sent from Axiom
Budgeting and Performance Reporting]" in the body text of the email, you
must enter [[Sent from Axiom Budgeting and Performance
Reporting]] in the Body Text field. The extra set of brackets is removed
when the email is generated.

For more information, see How email is delivered for file processing.

5. If you want to usemultipass processing on the file, then complete theMultiPass Settings.

For Source Column, click the column icon to select the source column for multipass processing.
For example, if you select DEPT.VP as the source column, then the file will be processed once for
each VP, and the data in the file will be automatically filtered to show only the data for that VP.
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To confirm that the file will be processed using your desired list of items, click Preview Multipass
List. A dialog opens, displaying the total number of items to process, as well as the list of individual
items.

For more information on multipass processing, and for details on advanced settings, see
Configuring multipass settings for file processing.

6. When you are finished configuring the file processing settings, click File Options > Save to save
the settings in the file.

� Results
The file can now be scheduled for execution using Scheduler. As noted previously, snapshot form
processing can only be executed via Scheduler, using a File Processing task.

Example Scheduler job configured to run snapshot form processing

When the Scheduler job is run, the following actions will occur, depending on whether Process File
Multipass is enabled for the job:

l If Process FileMultipass is not enabled, the file will be refreshed "as is," the PDF snapshot copy will
be taken, and the PDF will be saved and/or emailed according to the file processing settings.
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l If Process FileMultipass is enabled, the file will be refreshed using a multipass filter to limit the
data to the current multipass item (for example, for the current VP if processing by DEPT.VP). This
process will occur for each uniquemultipass item being processed, with a different multipass filter
being applied for each pass.

If the file generation is to multiple output files, then the PDF snapshot copy is taken after each
pass, and then saved and/or emailed according to the file processing settings.

If the file generation is to a single output file, then the results of each pass are collected into a
single PDF file. When all of the passes are complete, the PDF is saved and / or emailed according to
the file processing settings.

Design considerations for snapshot form processing

When designing a form to be used with snapshot form processing, keep in mind the following design
considerations.

� Executing Axiom queries
Axiom queries in the form document are executed according to the normal file processing requirements.
If you are performing multipass processing and you want an Axiom query to be executed for each pass,
that query must be active and must be enabled for Refresh during document processing. For more
information on executing Axiom queries during file processing, see:

l Refreshing Axiom queries during file processing
l Dynamic settings for multipass processing

These Axiom query rules only apply to the target form being processed. If the target form uses
Embedded Form components, the child forms displayed as embedded forms are refreshed as normal
and are not considered to be part of the document processing. Any Axiom queries that would be run in
the Axiom forms environment when the child form is first loaded will be run for each pass of file
processing. For more information, see the Embedded forms section of this topic.

� PDF settings in the form
During snapshot form processing, the PDF form settings apply as normal to generate the PDF:

l The Is PDF property on the Form Control Sheet is set to On for each pass. This means that you can
dynamically show or hide certain components in the form during the snapshot form processing.

l The PDF Size and PDF Orientation settings on the Form Control Sheet are honored when
generating the PDF.
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� Embedded forms
When executing file processing on a form, only the target form is manipulated by the file processing. If
the target form contains an Embedded Form component to a display child form, the child form is
"unaware" of the file processing and it is rendered and refreshed within the target form as normal. This
means:

l The GetCurrentValue and IsRunningMultipass functions only resolve in the target (parent) form.
These functions will not return any values in the child form.

l Themultipass filter is only applied to the target (parent) form. The child form is not automatically
filtered for each pass.

l As noted previously, Axiom queries in the child form are run as normal and do not depend on
having Refresh during document processing enabled (since the child form is not aware of the
document processing context).

If you want to filter the child form by the same dimension element for each pass, you can use shared
variables to pass the value to the child form. For example, imagine that you aremultipass processing by
Dept.Region, and you want the child form to be filtered by the current region value as well. You can:

l In the parent form, use the GetCurrentValue function to return themultipass filter for the current
pass. For example:

=GetCurrentValue("Filter")

When processing for theWest region, themultipass filter would be Dept.Region='West'

l In the parent form, use the SetSharedVariable function to set a variable to the current filter value.
For example:

=SetSharedVariable("FPFilter",GetCurrentValue("Filter"))

This sets the shared variable FPFilter to the current pass filter.

l In the child form, use the GetSharedVariable function to return the current filter value. For
example:

=GetSharedVariable("FPFilter")

This will return the value of FPFilter filter as set in the parent form for the current pass.

l In the child form, set up Axiom queries to be filtered as needed based on the value of the FPFilter
variable.

This is just an example of how to pass information about the current multipass value to the child form.
The GetCurrentValue function has several options that you can use to return different values in the
parent form and then use SetSharedVariable to pass those values to the child form.

Additionally, keep in mind that snapshot form processing does not provide support for sequentially
processing multiple child forms within a parent form. If the target parent form uses a Menu component
to change which child form displays in the Embedded Form component, only the initially visible child
form will be included during snapshot form processing.
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Setting up file processing: Export to file

Using file processing, you can export data from an Axiom file to a delimited text file, and then save that
file to a file location and/or email it.

The following file formats / delimiters are supported for data export files:
l CSV: Comma-delimited text file
l TXT: Text file delimited by space, period, pipe, tab, semicolon, or colon

In order to use file processing to export data, two setup steps must occur:
l The file must be set up with export-to-file tags, to specify the data to be exported. For more

information, see Placing data export tags in a sheet.
l The file must be enabled for file processing, and configured to export to a file. This process is

discussed in this topic.

To set up file processing to export data to a file:
1. Open the file where you want to set up file processing, and enable it as follows: On the Axiom tab,

in the File Output group, click File Processing > Add File Processing control sheet to active
workbook.

NOTE: In systems with installed products, this featuremay be located on theMain tab (either
directly on the tab, or on the Publishmenu).

The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file.

2. In the File Processing pane, for Processing Type, select Export to Delimited Text File.

3. In the Sheets to Process box, enter the name(s) of the sheet(s) to process.

You can click the Select worksheets button to select sheet names from a list, or you can type
the sheet names. Separatemultiple sheet names with semicolons.

The sheets to process are the sheets from which data will be exported. This setting does not
determine which sheets will be refreshed before data is exported; the refresh always applies to all
sheets in the file when using file processing.

Any sheet included heremust be set up with export-to-file tags, or else no data will be exported
from that sheet when the file is processed.

4. From the Export File Type list, select the type of file to create for the data export. You can select
CSV (comma-delimited), or a variety of different TXT formats using different delimiters.

NOTE: If text in a cell contains the delimiter, that text will be qualified using double quotation
marks in the export file.

5. By default, the export file will include a header row that uses the tags in the export-to-file control
row. If you do not want a header row in the export file, then set Include Column Headers to Off.
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6. In theOutput File Settings section, complete the following settings to determine the delivery of
the output file (or files):

Item Description

Output To Select one of the following:
l Local File System (default): The output location is outside of Axiom, to

either your local computer or a network share. The specific path is
detailed in theOutput Folder setting. Access to output files is not
controlled by Axiom Budgeting and Performance Reporting.

l Axiom Repository: The output location is the Axiom file system, within
the Reports Library. The specific path is detailed in theOutput Folder
setting. Access to output files is controlled by security access to the
designated folder within Axiom.

Output file
name

Specify how the output file (or files) should be named. You can do one of
the following:

l You can use file processing variables to generate dynamic file names.
l You can type a "hard-coded" file name.
The file name setting cannot be left blank. By default the file name uses file
processing variables, and is set to [Current_Value]_Report. You can
change "_Report" to something more specific to the file contents (or omit
it to use only the current value). If you do not plan to usemultipass
processing on the file, then you can delete the current value variable and
just type the desired file name.

If you want to use a file processing variable, you can type the variable or
you can click the pencil icon to open a text editor. From the Insert
Variable list, select the variable that you want to use.

For more information, see Defining the file name for file processing.

Output folder Specify the folder location for the output file (or files). You can type a folder
path, or you can click the folder icon to browse to the folder location. The
browse dialog will display either your local file system or the Axiom file
system, depending on what you selected forOutput To. This setting does
not apply if you are only emailing files.

For more information, see Defining the output folder for file processing.
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Item Description

File Generation Select one of the following:

l Create a Single Output File (default): The results of each pass are
collected into a single output file. Note that if you selected multiple
sheets to process, you will get a single output file for each sheet. In the
latter case, the sheet name is automatically appended to the output
file name.

l Create an Output File for Each Pass: The results of each pass are
saved as individual output files. For example, if themultipass settings
result in 10 passes, then 10 output files are created (one file for each
pass). Note that if you selected multiple sheets to process, you will get
an output file for each sheet / pass combination.

Save or Email
Files

Select a delivery option for the output file (or files):

l Save Files: The output files are saved to the specified output folder.
l Email Files: The output files are emailed to the specified recipients. The

output files are not saved anywhere on the file system.
l Save and Email Files: The output files are both saved and emailed.
If you select an option that includes emailing, then the Email Settings
section displays in the File Processing pane.

Purge Setting This option only applies when the file output is being saved to the Axiom
Repository.

If you want the file output to be automatically deleted after a specified
period of time, then click the pencil icon to open the Choose Date
dialog.
l Static purge date: Select a specific date, after which the output will be

deleted.
l Relative purge date: Specify a number of days to keep the output after

it has been generated. The output will be deleted after the specified
number of days have passed.

For more information, see Automatically deleting file output generated by
file processing.
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Item Description

Remote Data
Connection

This option only applies when the file output is being saved to your local
file system, and only for Cloud Service systems that are using remote data
connections.

Select the name of the remote data connection to use for the file
processing operation. The designated remote data connection will be used
to access the local file system and save output file(s) to the designated
location.

A remote data connection is required to save files locally from a cloud
system. For more information, see the section on remote data
connections in the Scheduler Guide.

Opening the file after processing: If desired, you can opt to automatically open the output file
within Axiom Budgeting and Performance Reporting after the processing is complete. This option
is only available if the result of the processing is a single file. If you want to use this option, it must
bemanually configured on the Control Sheet. In the File Settings section, set Open Output File
after Processing to On. For more information, see File Processing Control Sheet.

7. If you chose to email the output file (or files), complete the Email Settings:

Item Description

To

Bcc

Enter the email addresses to receive the output file via email. Separate
multiple addresses with a semicolon.

If the file will be processed using multipass processing, to multiple output
files, then you should use formulas to dynamically generate the
appropriate email recipients for each pass (otherwise each pass will be sent
to the same recipients). See Using dynamic email addresses with file
processing.

From Select one of the following to specify the From address:

l System User: The From address is the default From address specified
for Axiom Budgeting and Performance Reporting in the system
configuration settings.

l Current User: The From address is the email address for the user who
performs the file processing, as defined in Security.
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Item Description

Subject Line Enter a subject line for the email.

NOTE: If you want to use bracketed text in the subject line, you must
escape this text with an additional set of brackets, so that Axiom
Budgeting and Performance Reporting does not try to evaluate the
bracketed text as a file processing variable. For example, if you want the
text "[Axiom Message]" in the subject line of the email, you must enter
[[Axiom Message]] in the Subject Line field. The extra set of brackets is
removed when the email is generated.

Body Text Enter body text for the email.

NOTE: If you want to use bracketed text in the body text, you must escape
this text with an additional set of brackets, so that Axiom Budgeting and
Performance Reporting does not try to evaluate the bracketed text as a file
processing variable. For example, if you want the text "[Sent from Axiom
Budgeting and Performance Reporting]" in the body text of the email, you
must enter [[Sent from Axiom Budgeting and Performance
Reporting]] in the Body Text field. The extra set of brackets is removed
when the email is generated.

For more information, see How email is delivered for file processing.

8. If you want to usemultipass processing on the file, then complete theMultiPass Settings.

For Source Column, click the column icon to select the source column for multipass processing.
For example, if you select DEPT.VP as the source column, then the file will be processed once for
each VP, and the data in the file will be automatically filtered to show only the data for that VP.

To confirm that the file will be processed using your desired list of items, click Preview Multipass
List. A dialog opens, displaying the total number of items to process, as well as the list of individual
items.

For more information on multipass processing, and for details on advanced settings, see
Configuring multipass settings for file processing.

9. When you are finished configuring the file processing settings, click File Options > Save to save
the settings in the file.

� Results
Users can now use File Output > File Processing to process the file. The following actions will occur:

l When using Process File, the file will be refreshed "as is," the data will be extracted to the specified
file format, and the export file will be saved and/or emailed according to the file processing
settings.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 858



l When using Process File Multipass, the file will be refreshed using a multipass filter to limit the
data to the current multipass item (for example, for the current VP if processing by DEPT.VP). This
process will occur for each uniquemultipass item being processed, with a different multipass filter
being applied for each pass.

If the file generation is to multiple output files, then the data is extracted to the specified file
format after each pass, and then saved and/or emailed according to the file processing settings.

If the file generation is to a single output file, then the data from each pass is extracted and stored
in memory until all passes are complete. When all of the passes are complete, the data is placed in
the specified file format, and then saved and/or emailed according to the file processing settings.

Placing data export tags in a sheet

Using file processing, you can export data from an Axiom file to a CSV or TXT file. You may want to export
data to one of these file formats in order to import the data into another application.

In order to export data to a file, you must set up the sheet with ExportToFile tags. These tags work in a
similar manner as the Save2DB tags used for Save Type 1, except that instead of flagging data to be saved
to the database, they flag data to be exported to a file.

There are three components:
l The primary ExportToFile tag, which enables data export and defines the control row and control

column.
l Column tags in the control row, which flag columns of data to be exported and define the

contents of the header row in the export file.
l Row tags in the control column, which flag rows of data to be exported.

Once a file has been set up with ExportToFile tags, you can create the export file using the File Processing
feature. When setting up file processing for a file, you can choose to export to a specific file format. You
can also usemultipass processing to generatemultiple export files, one for each pass.

Tag Type Tag Syntax

Primary tag [ExportToFile; CustomSaveTag]

Row tags [Save]

[CustomSaveTag]

Column tags HeaderName

Export-to-file tag summary

� Defining the export-to-file control row and control column
To define the location of the export-to-file control row and control column, place the following tag in any
cell in the sheet, within the first 500 rows:

[ExportToFile; CustomSaveTag]
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CustomSaveTag is optional, and defines a custom save tag to place in the control column, to determine
rows to be saved. If you want to use the default save tag, [Save], then this parameter should be
omitted. The primary purpose of this optional feature is to allow you to use the same export-to-file
control column with multiple export-to-file control rows.

The row containing ExportToFile becomes the export-to-file control row, and the column containing
ExportToFile becomes the export-to-file control column.

NOTES:
l The primary tag must be placed in the first 500 rows of the sheet.
l Formulas can be used to create the tags, as long as the initial bracket and identifying keyword

are whole within the formula.

� Marking columns to export in the control row
Within the export-to-file control row, for each column of data that you want to export, enter a header tag
for that column.

The header tags can be anything you like. When the data is exported to a file, the text in the export-to-file
control row becomes the first row in the file, and defines the header row.

The header tags do not need to be enclosed in brackets. For example, the header tag can be just ACCT,
not [ACCT].

Header tags are required. A column of data is only exported if it is marked with a header tag in the export-
to-file control row.

NOTES:
l If desired, you can exclude the header row from the export file. When configuring the file

processing settings for the export, set Include Column Headers to Off.
l Reserved Axiom tags are ignored by the export process. For example, if the export-to-file

control row also contains a [DeleteColumn] tag for the purposes of deleting the column in
snapshot copies, that column is ignored when exporting.

� Marking rows to export in the control column
Within the export-to-file control column, for each row of data that you want to export, enter the save
tag. By default, the save tag is [Save]. If you defined a custom save tag in the ExportToFile tag, use that
tag instead.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 860



NOTE: If you defined a custom save tag for the export process, that export process only recognizes
that unique save tag. For example, if you have defined a custom save tag of [SavePayroll], only
rows flagged with [SavePayroll]will be exported. You cannot also use the default [Save] tag for
that export process.

� Export file example
The following sheet is set up with ExportToFile tags. The entries in row 1 (the control row)mark the
columns to be exported, and define the contents of the header row. The [save] tags in column G (the
control column)mark the rows to be exported.

When the file is processed, the resulting output file would look like this, if saved as a CSV file:

Saving data to the database using file processing

You can use file processing to refresh the file and then perform a save-to-database. Multipass processing
can be used to iterate this action over many passes, processing different data in each pass.

There are two different file processing types for saving data:
l Save Data: Save data to the database as part of regular or multipass processing. All normal

multipass settings and behaviors apply. This is the standard option for saving data using file
processing.
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l Save Data in Batches: This is a specialized multipass processing option that uses an Axiom query
to define the records to process, and then processes those records in batches—meaning, multiple
records are included in each pass. Although the processing iterates over many passes, normal
multipass settings and behaviors do not apply. This option is intended for specialized use cases
wheremany records are being processed but processing does not depend on filtering each pass
for a particular dimension element.

� Save-to-database setup for file processing
The relevant sheets in the file must be enabled for Save Type 1, and set up with save-to-database tags.
For more information on setting up save-to-database, see the Axiom File Setup Guide.

Only Save Type 1 processes are performed when using file processing. If sheets in the file are enabled for
other save-to-database processes, those processes are ignored.

All sheets in the file will be processed. If the file has multiple sheets that are enabled and configured for
Save Type 1, all those sheets will save data to the database during this process.

NOTE: The [Delete] tag for Save Type 1 is not supported for use with multipass file processing.

Setting up file processing: Saving data

Using file processing, you can save data from an Axiom file to the Axiom Budgeting and Performance
Reporting database. Themost typical use of this feature is to save data via multipass processing.

NOTE: This topic discusses the standard option for saving data to the database using file processing.
Another specialized option is available to process many records per pass. For more information on
this option, see Setting up file processing: Saving data in batches.

To set up file processing to save data to the database:
1. Open the file where you want to set up file processing, and enable it as follows: On the Axiom tab,

in the File Output group, click File Processing > Add File Processing control sheet to active
workbook.

NOTE: In systems with installed products, this featuremay be located on theMain tab (either
directly on the tab, or on the Publishmenu).

The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file.

2. In the File Processing pane, for Processing Type, select Save Data.

3. From the Save Data Mode list, specify how data should be saved:

l Save After Each Pass: A save-to-database occurs after each pass.
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l Save Once at the End: The data from each pass is saved in memory until all passes are
complete, and then the save-to-database occurs.

You should save at the end if the process could result in multiple rows of data with the
same key codes, so that the rows are summed before saving to the database, rather than
having the data from one pass overwrite the other.

l Save to Output Sheet: The data from each pass is collected and saved to an "output sheet"
within the file being processed. No data is saved to the database. The output sheet is
named SaveData_SheetName, where sheetname is the name of the sheet set up to save to
the database.

This option is primarily intended for testing the file setup, so that you can review the data
that would be saved without actually saving it.

4. Optional. Select Save data tags are static for all passes if your save-to-database setup is static
and will not dynamically adjust for each pass.

This option assumes that your data is brought in using functions or update-only Axiom queries, so
that the number of rows and the placement of the save-to-database tags remain static for each
pass. Enabling this option allows Axiom Budgeting and Performance Reporting to read the save-
to-database tags once at the start of the process. The File Processing Control Sheet settings and
the default Control Sheet settings are also cached at the start of the process and will not be
refreshed for each pass. Eliminating the need to refresh these settings speeds up processing for
each individual pass.

If instead you are using rebuild Axiom queries to bring in your data, or if you are dynamically
enabling or disabling save-to-database tags or other settings for each pass, then you should not
select this option.

5. Complete theMultiPass Settings. Although it is not required to perform save data using
multipass processing, this is themost typical use of the feature.

For Source Column, click the column icon to select the source column for multipass processing.
For example, if you select DEPT.VP as the source column, then the file will be processed once for
each VP, and the data in the file will be automatically filtered to show only the data for that VP.

To confirm that the file will be processed using your desired list of items, click Preview Multipass
List. A dialog opens, displaying the total number of items to process, as well as the list of individual
items.

For more information on multipass processing, and for details on advanced settings, see
Configuring multipass settings for file processing.

6. When you are finished configuring the file processing settings, click File Options > Save to save
the settings in the file.
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� Results
Users can now use File Output > File Processing to process the file. The following actions will occur:

l When using Process File, the file will be refreshed "as is," and the data will be saved according to
the specified savemode.

l When using Process Multipass, the file will be refreshed using a multipass filter to limit the data to
the current multipass item (for example, for the current VP if processing by DEPT.VP). This process
will occur for each uniquemultipass item being processed, with a different multipass filter being
applied for each pass. Data will be saved according to the specified savemode.

Setting up file processing: Saving data in batches

Using file processing, you can save data to the database from an Axiom file. The processing type Save
Data in Batches is intended for specialized use cases wheremultipass processing is desired but many
records can be processed per pass.

The Save Data in Batches processing type works as follows:
l You create an Axiom query to define the list of records to be processed. This query is then

specified as the source query for the file processing action. The query should be set up as normal
within the sheet, where it will serve as themain driver for processing records.

l When file processing is initiated, Axiom Budgeting and Performance Reporting runs the
designated Axiom query in memory first to obtain the full list of records. The number of passes for
the process is determined by dividing the total number of records by the specified batch size. For
example, if the Axiom query returns 7,000,000 records and the batch size is 7,000, then there will
be 1000 passes (each pass processing 7,000 records).

l Multipass processing then begins. For each pass of the process, Axiom refreshes the file but only
returns a subset of records (a "batch") to the Axiom query in the sheet. This process continues,
iterating over multiple passes, until all of the records that were retrieved in memory have been
processed.

l Data is saved to the database according to the save options specified in the file processing setup.
You can save data after each pass, or save data once at the end of the process, or save data to an
output sheet (for testing).

l Although the process is iterative and therefore considered "multipass processing," none of the
normal multipass settings apply and will be ignored if set. No dimension filter is applied to each
pass as when using normal multipass processing, because each pass encompasses multiple
records.

NOTE: When using Save Data in Batches, the only valid use of the GetCurrentValue function is the
PassNumber option to return the number of the current pass. All other options are inapplicable in
this context. For example, GetCurrentValue() is inapplicable because there is no single current value
to return; instead multiple values (records) are being processed in each pass.
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To set up file processing to save data in batches:
1. Open the file where you want to set up file processing, and enable it as follows: On the Axiom tab,

in the File Output group, click File Processing > Add File Processing control sheet to active
workbook.

NOTE: In systems with installed products, this featuremay be located on theMain tab (either
directly on the tab, or on the Publishmenu).

The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file.

2. In the File Processing pane, for Processing Type, select Save Data in Batches.

3. From the Save Data Mode list, specify how data should be saved:

l Save After Each Pass: A save-to-database occurs after each pass.
l Save Once at the End: The data from each pass is saved in memory until all passes are

complete, and then the save-to-database occurs.

You should save at the end if the process could result in multiple rows of data with the
same key codes, so that the rows are summed before saving to the database, rather than
having the data from one pass overwrite the other.

l Save to Output Sheet: The data from each pass is collected and saved to an "output sheet"
within the file being processed. No data is saved to the database. The output sheet is
named SaveData_SheetName, where sheetname is the name of the sheet set up to save to
the database.

This option is primarily intended for testing the file setup, so that you can review the data
that would be saved without actually saving it.

4. For Source Worksheet, specify the worksheet that contains the Axiom query to use for the
process.

5. For Source Axiom Query ID, specify the Axiom query to use for the process.

TIP: You can use the Preview Axiom Query Data button to see the number of records that will
be processed and to preview the data to be returned by the query.

6. Optional. For Batch Size, specify the number of records to include in each pass. By default this is
set to 7,000.

In most cases, you can leave the default batch size. However, you might consider making the
batch size smaller if your in-sheet calc method uses many rows.
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For example, if your calc method is 1 row and the batch size is 7,000, that means the Axiom query
will return and process 7,000 rows of data per pass. However, if the calc method is 20 rows and the
batch size is 7,000, that means the Axiom query will return and process 140,000 rows of data per
pass. In the latter case, the processing performancemay be improved if you lower the batch size
to lower the overall rows of data to be processed per pass.

7. When you are finished configuring the file processing settings, click File Options > Save to save
the settings in the file.

Users can now process the file. Although the traditional multipass settings do not apply, the file must be
processed using Process File Multipass in order to enable the iterative pass behavior. This can also be
initiated using the Process Save Data in Batches action in the File Processing task pane.

Setting up file processing: Printing

Using file processing, you can print the current file. In most cases this would be used with multipass
processing, so that you would print the file multiple times, using the data for each pass—for example, to
print an income statement once for each region. However, you could also use the print option with non-
multipass processing, simply to save your desired print view and preferred printer for convenience.

NOTE: File processing always performs a refresh of the file before performing the file processing
action (in this case, printing). If you want to print the file without performing a refresh first, you must
use regular printing features.

TIP: You can use print file processing in conjunction with batch reporting. For example, you can use
batch to specify multiple files to process, and print them all at once by processing the batch.

To set up file processing to print the file:
1. Open the file where you want to set up file processing, and enable it as follows: On the Axiom tab,

in the File Output group, click File Processing > Add File Processing control sheet to active
workbook.

NOTE: In systems with installed products, this featuremay be located on theMain tab (either
directly on the tab, or on the Publishmenu).

The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file.

2. In the File Processing pane, for Processing Type, select Print.

3. In the Print Views box, enter the name(s) of the print views to process. This setting also defines
the sheets to process.

Print views are specified using the following syntax: SheetName:ViewName. You can type the
view names, or click the Select Print Views button to select print views from a list. Separate
multiple view names with semicolons.
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You can specify multiple print views for a single sheet if applicable. If a sheet does not have any
defined print views, select the Default view, which uses the native spreadsheet print settings. You
can print any sheet except control sheets and hidden sheets.

4. In the Printer box, enter the name of the printer to use, or leave this setting blank to use the
default printer. Use the Select Printer button to select a printer other than the default printer.

5. If you want to usemultipass processing on the file, then complete theMultiPass Settings.

For Source Column, click the column icon to select the source column for multipass processing.
For example, if you select DEPT.VP as the source column, then the file will be processed once for
each VP, and the data in the file will be automatically filtered to show only the data for that VP.

To confirm that the file will be processed using your desired list of items, click Preview Multipass
List. A dialog opens, displaying the total number of items to process, as well as the list of individual
items.

For more information on multipass processing, and for details on advanced settings, see
Configuring multipass settings for file processing.

6. When you are finished configuring the file processing settings, click Save to save the settings in the
file.

� Results
Users can now use File Output > File Processing to process the file. The following actions will occur:

l When using Process File, the file will be refreshed "as is" and then printed using the specified print
view(s) and printer.

l When using Process File Multipass, the file will be refreshed using a multipass filter to limit the
data to the current multipass item (for example, for the current VP if processing by DEPT.VP). This
process will occur for each uniquemultipass item being processed, with a different multipass filter
being applied for each pass. Each pass will be printed using the specified print view(s) and printer.

Setting up file processing: Alerts

You can process alerts using file processing. The primary reason to use file processing for alerts is so that
you can set up one set of alert conditions, and then leveragemultipass processing to evaluate those
conditions for all members of a particular grouping level—such as for each department, each region, or
each VP.

For example, imagine that you want to alert the department manager if their department exceeds a
variance threshold for a particular area. While you could set up a report that brings in each department
and calculates the variance, and then define an alert for each individual department value. However, it
would bemuch more streamlined to set up a report that brings in the consolidated value and then
define one dynamic alert against that value, and then process the report using multipass processing by
department. For each pass, it will automatically apply the department-specific filter for the data and then

Administrator's Guide Axiom Budgeting and Performance Reporting │ 867



process the alert against that data. The alert settings would need to dynamically change for each pass—
for example you could set up the alert ID, message title, etc., using GetCurrentValue() so that the current
department number is reflected for each pass of alerts.

In order to use file processing to process alerts, two setup steps must occur:
l Alerts must be defined in the file, on the Alert Control Sheet (Control_Alert).

l The file must be enabled for file processing, and configured to process alerts. This process is
discussed in this topic.

To set up file processing to process alerts:
1. Open the file where you want to set up file processing, and enable it as follows: On the Axiom tab,

in the File Output group, click File Processing > Add File Processing control sheet to active
workbook.

NOTE: In systems with installed products, this featuremay be located on theMain tab (either
directly on the tab, or on the Publishmenu).

The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file.

2. In the File Processing pane, for Processing Type, select Alerts.

This is the only setting to complete in the File Processing Settings section of the task pane. No
other settings apply. You do not need to specify a sheet to process because it is always Control_
Alert.

3. In theMultiPass Settings section, click the column icon to select the source column for
multipass processing.

For example, if you select DEPT.VP as the source column, then the file will be processed once for
each VP, and the data in the file will be automatically filtered to show only the data for that VP.

To confirm that the file will be processed using your desired list of items, click Preview Multipass
List. A dialog opens, displaying the total number of items to process, as well as the list of individual
items.

For more information on multipass processing, and for details on advanced settings, see
Configuring multipass settings for file processing.

NOTE: The only reason to use File Processing to process alerts is to apply multipass settings. If
you do not need to usemultipass processing, then you can process alerts by using the
Process Document List task in Scheduler; you do not need to set up File Processing.

4. When you are finished configuring the file processing settings, click File Options > Save to save
the settings in the file.
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� Results
You can now use File Output > File Processing > Process File Multipass to process the alerts, or you
can schedule processing using the File Processing Scheduler task. The following actions will occur:

l The file will be refreshed using a multipass filter to limit the data to the current multipass item (for
example, for the current VP if processing by DEPT.VP). This process will occur for each unique
multipass item being processed, with a different multipass filter being applied for each pass.

l For each pass, alert conditions will be evaluated. If an alert evaluates to True and does not match
an existing alert (based on alert ID), then an alert notification will be created for that alert. All the
specified recipients will see the alert notification in their Notifications task pane.

l If the alert points to the source document as the supporting file, then when the user clicks on the
link to open the file from the Notifications task pane, themultipass filter will automatically be
applied to the file. This way the user can see the file using the same context that generated the
alert.

File Processing task pane

The File Processing task pane is provided to assist you in completing file processing settings.
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Example task pane

NOTE: Access to the File Processing pane is controlled by Security for plan files and reports.
Administrators always have access to the pane for managed files. The File Processing task pane is not
available for non-managed files.

As you select options in the pane, such as the processing type, the pane updates to display only the
relevant settings. In most cases, it is easier to use the pane rather than editing the File Processing Control
Sheet directly.

The pane displays the file processing settings as currently defined in the control sheet. As you edit the
settings in the pane, the control sheet is updated for your changes, and vice versa. Ultimately you must
save the file in order to save any changes madewithin the current session.

You can use cell references and formulas just as you can when defining settings in the control sheet. The
pane displays formula results by default, but if you click in a field that contains a formula, you can edit
the formula.
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You can use file processing variables in the pane. These variables will return values when the file is
processed, such as returning the item being processed in the current pass (for multipass processing).

File processing settings are validated as you complete them. If an entry is invalid, a red outline appears
around the box of the invalid entry. To get more information about the error, hover your cursor over the
box, and the error message will display in a tooltip.

NOTE: Certain advanced file processing settings cannot bemade in the File Processing pane; they can
only bemade in the control sheet:

l Enabling or disabling file processing (conditional processing)
l Enabling or disabling screen updating
l Enabling the output file to open in Axiom Budgeting and Performance Reporting after

processing
l Defining current value defaults for source columns
l Defining batch variables

Once you have completed the file processing settings, you can initiate file processing directly from the
pane. In the Actions section, click Process File or Process File Multipass. These are the same actions
available in the Ribbon, in File Output > File Processing.

The pane updates automatically in response to changes in the workbook—for example, changes made to
the File Processing Control Sheet directly, or changes made to cells that are referenced by formulas in the
pane. However, you can also click Refresh Settings from Workbook in the Actions section of the pane to
manually refresh the pane.

File Processing Control Sheet

The File Processing Control Sheet defines settings for file processing. Using file processing, you can
automate certain processes for a file, including file delivery, exporting data, and saving data to the
database. Files can be processed "as is," or you can usemultipass processing to process the file using a
unique filter for each pass.

To add a File Processing Control Sheet to an Axiom file:
l On the Axiom tab, in the File Output group, click File Processing > Enable File Processing in this

workbook.

NOTE: In systems with installed products, this featuremay be located on theMain tab (either
directly on the tab, or on the Publishmenu).

The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file. In most
cases, it is easiest to use the File Processing pane instead of the control sheet. The control sheet is
updated for changes made in the pane, and vice versa. However, there are certain configuration settings
that cannot bemade in the pane:

l Enabling or disabling file processing (conditional processing)

Administrator's Guide Axiom Budgeting and Performance Reporting │ 871



l Enabling or disabling screen updating
l Enabling the output file to open in Axiom Budgeting and Performance Reporting after processing
l Defining current value defaults for source columns
l Defining batch variables

The File Processing Control Sheet is only visible to administrators or to users with the Allow File
Processing permission to the file. Otherwise, it is hidden by default.

� Multipass Columns and Current Value Defaults
The following settings apply when using multipass processing:

Item Description

Source Columns The source columns for multipass processing. Each source column must be
placed in a separate cell in this row.

For more details on source columns, see Configuring advanced multipass
settings.

Current Value
Defaults

The corresponding current value default for each source column.

Current value defaults are optional. If defined, each current value default
must be placed directly underneath its corresponding source column.

If a current value default is defined for a source column, then that value
will be returned by the GetCurrentValue function (and the [Current_
Value] variable) when the file is processed using standard, non-multipass
processing (Process File).

If no current value default is defined for a source column, then the
function and the variable will return nothing (blank) when the file is
processed using standard, non-multipass processing.

For more information, see Defining default values for current value.

The only way to edit current value defaults is on the control sheet. Current
value defaults cannot be defined in the File Processing pane.
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� General Settings
The following general settings apply to all configurations of file processing:

Item Description

Processing Enabled Determines whether or not the file processing action occurs once the file
refresh is complete. If True, the action (snapshot, export, save data)
occurs. If False, the action does not occur and the process either ends (if
not using multipass processing) or continues to the next pass (if using
multipass processing).

The purpose of this setting is to allow turning the file processing action on
or off based on a condition in the file. For example, if the data in the file is
all zeros for a particular pass, you may not want to send that file. You can
set up a formula that returns True if the file has data, and False if the file
has no data.

The Processing Enabled setting is checked after the file refresh occurs. The
file refresh always occurs when you execute file processing, regardless of
this setting.
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Item Description

Processing Type Specifies the action to be taken on the file when it is processed. Select from
one of the following:

l Snapshot File: Take a snapshot of the file and deliver it. For more
information, see Setting up file processing: Snapshot.

l Snapshot Forms: Generate a PDF of an Axiom form and deliver it. For
more information, see Setting up file processing: Snapshot Forms.

l Export to Delimited Text File: Export data in the file to a text file and
deliver it. For more information, see Setting up file processing: Export
to file.

l Save Data: Save data in the file to the database using standard
processing features. For more information, see Setting up file
processing: Saving data.

l Save Data in Batches: Save data in the file to the database using a
specialized processing style wheremultiple records are processed in
batch. For more information, see Setting up file processing: Saving data
in batches.

l File Collect: Collect the contents ofmultiple spreadsheet files into a
single file and deliver it. For more information, see File Collect.

l Batch: Process multiple files in a batch process, and/or the same file
using different settings. For more information, see Batch Processing.

l Alerts: Process alerts in the file and generate alert notifications. For
more information, see Setting up file processing: Alerts.

l Print: Apply a print view to the file and then print the specified sheets.
For more information, see Setting up file processing: Printing.

NOTE: The file is always refreshed before the action is performed.

Screen Updating Specifies whether the screen is updated during file processing, or whether
all actions take place using background processing.

By default, this is set to Off. Updating the screen can be resource-intensive
and slow the process, particularly when performing multipass processing.

If set to On, then the screen refreshes as if you were performing the
process manually. If using multipass processing, the screen updates for
each pass of data.

This setting is primarily for demonstration or testing purposes.
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� Multipass Settings
For more information on these settings, see Configuring advanced multipass settings. For more
information on howmultipass processing works, see How themultipass list of items is determined and
Howdata is filtered during multipass processing.

These settings do not apply and will be ignored if the processing type is File Collect, Batch, or Save Data in
Batches.

Item Description

Primary Table The primary table for themultipass query that determines the list of items
to process.

Sum data by these
columns

The sum level for themultipass query that determines the list of items to
process.

Sort results by these
database columns

The sort for themultipass query that determines the list of items to
process. The sort determines the order in which items are processed.

Limit MultiPass
iterations by this filter

A filter criteria statement to filter the list of items to process.

Apply MultiPass Data
Filter to these
Tabletypes

Apply MultiPass Data
Filter to these Tables

Specifies the tables and/or table types that you want filtered by the
current pass item, when multipass processing occurs.

IMPORTANT: These settings are optional and are only used if you want to
override the default multipass filter behavior. If these settings are used,
then only the tables or table types listed here are filtered, and the default
multipass filtering behavior no longer applies.

� Snapshot Settings
These settings only apply if the file processing type is Snapshot File.

Item Description

Snapshot file type The file type for the snapshot: XLSX (default), XLSM, XLS, or PDF.

NOTE: If you select XLS, and the spreadsheet contains features that are
not supported by the XLS format, the compatibility warning is not
displayed during file processing. You may want to test saving the file to XLS
to ensure that the end result will be as expected.
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Item Description

Formula Conversion Specifies how formulas are handled in the snapshot:

l Convert All Formulas (default): All formulas are converted to values.
l Convert Axiom Formulas Only: Axiom formulas are converted to

values, but Excel formulas are left as is. Note that if an Excel formula
references a sheet that is not included in the snapshot, that formula
will be converted to a value. This option is shown as Retain Excel
Native Formulas in the File Processing task pane.
NOTE: If the file contains a pivot table, this option must be selected in
order for the pivot table to work in the snapshot copy.

This option does not apply if PDF is the selected file type.

� Export to Text File Settings
These settings only apply if the file processing type is Export.

Item Description

Delimiter and File
Type

The file type and delimiter for the output file. You can select CSV (comma-
delimited), or a variety of different TXT formats using different delimiters.

Include Headers Specifies whether to include the header row in the export file. By default,
this is On. The header row uses the tags in the export-to-file control row.

If you do not want a header row in the export file, change this setting to
Off.

� File Settings
These settings only apply if the file processing type is Snapshot or Export.

Item Description

Sheets to Process The sheets to include in the output file. Separatemultiple sheet names
with semicolons.
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Item Description

Output To Local File
System or Axiom
Repository

The location for the output file, either:
l Local File System (default): The output location is outside of Axiom, to

either your local computer or a network share. The specific path is
detailed in theOutput Folder setting. Access to output files is not
controlled by Axiom Budgeting and Performance Reporting.

l Axiom Repository: The output location is the Axiom file system, within
the Reports Library. The specific path is detailed in theOutput Folder
setting. Access to output files is controlled by security access to the
designated folder within Axiom.

Remote Data
Connection Name

Specifies the name of the remote data connection to use for the file
processing operation. This option only applies when snapshot or export
file output is being saved to your local file system, and only for Axiom
Cloud systems that are using remote data connections.

When the output file is created, the designated remote data connection
will be used to access the local file system and save the file to the
designated location.

A remote data connection is required to save files locally from an Axiom
Cloud system. For more information, see the section on remote data
connections in the Scheduler Guide.

Purge Files Setting Specifies whether and when the file output will be automatically purged by
Axiom Budgeting and Performance Reporting. This only applies if the file
output is saved to the Axiom Repository.

If blank, then file output is not purged. Otherwise, specify either of the
following:
l A date, to delete output after that date. For example, specify
12/10/2014 (or the appropriate date format for your locale) to delete
the output after that date is passed.

l A number representing the number of days to keep the output after it
is generated. For example, specify 20 to keep the output for 20 days
and then delete it.

The deletion is performed by the System Data Purge job in Scheduler.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 877



Item Description

Output Folder The folder location for the output files. For more information, see Defining
the output folder for file processing.

Microsoft Sharepoint support
You can specify a Sharepoint URL for the folder location, to save the
output files to a Sharepoint portal. This feature is only available when
running file processing locally via the Excel Client, and when the processing
type is snapshot. The user executing the processing must have the
appropriate permissions to the target folder in Sharepoint. Note that if the
specified folder does not already exist in Sharepoint, this will not be
detected by Axiom Budgeting and Performance Reporting during the file
processing, but a Microsoft error will report the location as not found.

Output Filename The file name for the output file. For more information, see Defining the file
name for file processing.

Output Sheet Name Specifies how the sheets to process will be named in the output file. The
sheet name setting takes a single entry that applies to all sheets being
processed.

For more information, see Defining sheet names for file processing.

Save or Email
Generated Files

Specifies a delivery option for the output file (or files):

l Save Files: The output files are saved to the specified output folder.
l Email Files: The output files are emailed to the specified recipients. The

output files are not saved anywhere on the file system.
l Save and Email Files: The output files are both saved and emailed.

If you select an option that includes emailing, then the Email Settings
section displays in the File Processing pane.

Multipass File
Generation Mode

Select one of the following:

l Create a Single Output File (default): The results of each pass are
collected into a single output file.

l Create an Output File for Each Pass: The results of each pass are saved
as individual output files. For example, if themultipass settings result in
10 passes, then 10 output files are created (one file for each pass).

Note that if you are exporting data to a file, and you selected multiple
sheets to process, then you will get one file per sheet (and also per pass, if
you selected to create an output file for each pass).
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Item Description

Open Output File
after Processing

Optional setting to open the output file in Axiom Budgeting and
Performance Reporting after processing. By default, this is set to Off.

IfOn, and if the processing results in a single file, then the output file is
opened after processing. If an output folder is specified, then the file is
saved as normal and then opened. If no output folder is specified, then the
file is opened as a temporary file and must bemanually saved if you want
to retain it.

� Save Data Settings
These settings only apply if the processing type is Save Data or Save Data in Batches.

Item Description

Save Data Mode Specifies how data is saved:

l Save After Each Pass: A save-to-database occurs after each pass.
l Save Once at the End: The data from each pass is saved in memory

until all passes are complete, and then the save-to-database occurs.
You should save at the end if the process could result in multiple rows
of data with the same key codes, so that the rows are summed before
saving to the database, rather than having the data from one pass
overwrite the other.

l Save to Output Sheet: The data from each pass is collected and saved
to an "output sheet" within the file being processed. No data is saved
to the database. The output sheet is named SaveData_SheetName,
where sheetname is the name of the sheet set up to save to the
database.
This option is primarily intended for testing the file setup, so that you
can review the data that would be saved without actually saving it.
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Item Description

Use Cached Settings Specifies whether save data tags and other settings are read once at the
start of the process, or whether they are refreshed and evaluated for each
pass. By default this option is not enabled, which means that the tags and
settings are refreshed each pass. (This is the same setting as Save data
tags are static for all passes on the File Processing task pane.)

This option should only be enabled if you are bringing in data using
functions or update-only Axiom queries, so that the number of rows and
the placement of the save-to-database tags remain static for each pass.
Enabling this option allows Axiom Budgeting and Performance Reporting
to read the save-to-database tags once at the start of the process. The File
Processing Control Sheet settings and the default Control Sheet settings
are also cached at the start of the process and will not be refreshed for
each pass. Eliminating the need to refresh these settings speeds up
processing for each individual pass.

If instead you are using rebuild Axiom queries to bring in your data, or if
you are dynamically enabling or disabling save-to-database tags or other
settings for each pass, then you should not enable this option.

Batch Mode Batch
Size

The number of records to process in each batch. Only applies when using
Save Data in Batches.

By default, this is set to 7,000. In most cases, you can leave the default
batch size. However, you might consider making the batch size smaller if
your in-sheet calc method uses many rows.

For example, if your calc method is 1 row and the batch size is 7,000, that
means the Axiom query will return and process 7,000 rows of data per
pass. However, if the calc method is 20 rows and the batch size is 7,000,
that means the Axiom query will return and process 140,000 rows of data
per pass. In the latter case, the processing performancemay be improved
if you lower the batch size to lower the overall rows of data to per
processed per pass.

Batch Mode Source
Sheet

The sheet that contains the source Axiom query for the process.

Batch Mode Source
AQ

The source Axiom query for the process. Only applies when using Save
Data in Batches.
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� Print Settings
These settings only apply if the file processing type is Print.

Item Description

Print views Specifies the print views (and sheets) to print. Print views are specified
using the following syntax: SheetName:ViewName. Separatemultiple
view names with semicolons.

You can specify multiple print views for a single sheet if applicable. If a
sheet does not have any defined Axiom print views, specify the Default
view, which uses the native spreadsheet print settings. You can print any
sheet except control sheets and hidden sheets.

Printer The name of the printer to use. Leave this setting blank to use the default
printer.

� Email Settings
These settings only apply if an email option is selected for Save or Email Generated Files. For more
information, see How email is delivered for file processing.

Item Description

Distribution List The email addresses to receive the output file via email. (This corresponds
to the "To:" field on the File Processing task pane.) Separatemultiple
addresses with a semicolon.

If the file will be processed using multipass processing, to multiple output
files, then you should use formulas to dynamically generate the
appropriate email recipients for each pass (otherwise each pass will be sent
to the same recipients). See Using dynamic email addresses with file
processing.

Bcc The email addresses to be blind copied on the email. Separatemultiple
addresses with a semicolon.

If the file will be processed using multipass processing, to multiple output
files, then you should use formulas to dynamically generate the
appropriate email recipients for each pass (otherwise each pass will be sent
to the same recipients). See Using dynamic email addresses with file
processing.
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Item Description

From Select one of the following to specify the From address:

l System User: The From address is the default From address specified
for Axiom Budgeting and Performance Reporting in the system
configuration settings.

l Current User: The From address is the email address for the user who
performs the file processing, as defined in Security.

Subject Line Enter a subject line for the email.

NOTE: If you want to use bracketed text in the subject line, you must
escape this text with an additional set of brackets, so that Axiom Budgeting
and Performance Reporting does not try to evaluate the bracketed text as
a file processing variable. For example, if you want the text "[Axiom
Message]" in the subject line of the email, you must enter [[Axiom
Message]] in the Subject Line field. The extra set of brackets is removed
when the email is generated.

Body Text Enter body text for the email.

NOTE: If you want to use bracketed text in the body text, you must escape
this text with an additional set of brackets, so that Axiom Budgeting and
Performance Reporting does not try to evaluate the bracketed text as a file
processing variable. For example, if you want the text "[Sent from Axiom
Budgeting and Performance Reporting]" in the body text of the email, you
must enter [[Sent from Axiom Budgeting and Performance
Reporting]] in the Body Text field. The extra set of brackets is removed
when the email is generated.

� Batch Variables
Batch variables can be used when processing the file using batch processing, or when processing via
Scheduler. You can specify variable values in the Batch Control Sheet or in the Scheduler File Processing
task, and those values will be placed in the corresponding value cells on the File Processing Control
Sheet. If the file is set up to reference those cells and use the value in someway, then the file can be
processed differently for each batch or File Processing task.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 882



For more information, Using batch variables with file processing.

Item Description

Variable Names The names of the batch variables. Each variable must be in a separate cell.

When the file is processed via batch processing or via Scheduler, the value
for the variable will be placed in the cell directly underneath the variable
name.

Variable Values The cells where the variable values will be placed by Scheduler. Each cell
corresponds to the variable name directly above it.

You can reference these cells in the report, to change the report in some
way based on the variable value.

Configuring multipass settings for file processing
To set up multipass processing, you specify a "source column" to define the list of items to process. For
example, to process by region, the source column would be DEPT.Region. If your organization is
divided into four regions (North, South, East, West), then the file would be processed using four different
passes, with each pass being filtered for a particular region.

Any file can usemultipass processing once themultipass settings have been defined using the File
Processing task pane (or the File Processing Control Sheet). You do not have to do any special setup in
the worksheets, although you will likely want to use the GetCurrentValue function to create dynamic
settings such as dynamic titles. For example, if you are processing a report by region, you can use this
function to create a title that displays the region for the current pass.

Multipass settings have a basic mode and an advanced mode. The basic mode settings should be
sufficient for most multipass use cases. When using basic mode, you can define one setting, the source
column, and Axiom Budgeting and Performance Reporting takes care of all supplementary settings
automatically. However, the advanced multipass settings are available if your file requires a different
multipass configuration.

This topic assumes that you have already set up the file processing settings for the desired process, such
as saving snapshot copies for distribution, or saving data to the database.

When you open the File Processing pane, theMultipass Settings section displays the basic mode by
default. If you seemore than one setting in this section, then the advanced mode has been opened. To
return to basic mode, click Hide Advanced View.

To specify a source column for multipass processing:
1. In the File Processing pane, in theMultipass Settings section, click the column icon to the

right of the Source Column box.
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The Column Chooser dialog opens. By default, this dialog only displays reference tables, which is
themost common use case for multipass processing. If you want to use a data table, you must
use the advanced mode settings.

2. Select the column that you want to use for multipass processing, and then click OK.

For example, you may want to process by DEPT.DEPT or ACCT.ACCT, or by a grouping column in
a reference table, such as DEPT.VP or ACCT.Category.

The selected column is entered into the Source Column box. When multipass processing is performed, it
will include a pass for every unique item in the selected column. If you want to filter the list of items to a
subset, or use only the items that exist in a particular data table, you can use the advanced mode
settings.

If the basic multipass settings are not sufficient for this particular file, then you can use the advanced
settings. For more information, see Configuring advanced multipass settings.

� Previewing the multipass list
You can check the list of items to be processed by clicking the Preview Multipass List button. The
MultiPass Data dialog opens, displaying the total number of items to be processed, as well as the list of
individual items. For example, if the source column is DEPT.WorldRegion and your organization is divided
into six regions, then the preview returns six items to be processed, and shows you what those six items
are.

Example preview
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In the case of largemultipass lists, this dialog only displays the first 100 items in the list. However, the
number displayed at the top of the dialog is always the total number of items.

� Multipass data filtering
When multipass processing is performed, for each pass Axiom Budgeting and Performance Reporting
automatically applies a filter to the report. If a data query is made to any data table that links to the
reference table, then the filter will be applied. If you want different filter behavior for themultipass
processing, you can use the advanced mode settings.

NOTES:
l Themultipass filter is only applied during multipass processing, and is not visible in the file

itself. Themultipass filter is applied in addition to any filters defined in the file (sheet filters,
Axiom query data filters, etc.), and in addition to the current user's security filters.

l The IgnoreSheetFilter parameter for the GetData function can be used to prevent the
multipass filter from being applied to a particular GetData function in the file.

For more details, see Howdata is filtered during multipass processing.

Configuring advanced multipass settings

When using multipass processing, you can use the basic settings and allow Axiom Budgeting and
Performance Reporting to automatically apply all supplementary settings, or you can use the advanced
settings to configure advanced properties such as:

l Specify a data table as the source table
l Specify additional source columns to return pass-specific information during themultipass

process
l Specify grouping and sorting settings other than the default settings
l Specify a subset of items to be processed instead of processing all items
l Apply different multipass filter settings than the default filter settings, to explicitly control which

tables are filtered by themultipass filter in the report

To access the advanced multipass settings on the File Processing pane, click the Show Advanced View
link in theMultipass Settings section. (You can also use the File Processing Control Sheet.)

If you show the advanced mode settings after already completing the Source Column in basic mode, you
will see that some settings have been automatically determined by Axiom Budgeting and Performance
Reporting based on your source column selection. You can edit any of these settings as desired in
advanced mode, as well as define additional settings.
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NOTE: If you return to basic mode after making advanced mode changes, and then you change the
Source Column in basic mode, the advanced mode settings are cleared. Once you have used the
advanced mode settings, any future changes should also bemade in advanced mode (or on the File
Processing Control Sheet).

Multipass settings are validated as you complete them. If an entry is invalid, a red outline appears
around the box of the invalid entry. To get more information about the error, hover your cursor over the
box, and the error message will display in a tooltip.

� Multipass Data Settings
Themultipass data settings determine the list of items to be processed. For more information, see How
themultipass list of items is determined. After making any changes to themultipass data settings, click
Preview Multipass List to make sure that the list of items to process is as you expect.

IMPORTANT: If a report uses advanced multipass data settings, and you want to process that report
using batch processing, then you cannot set a multipass source column for the report in the batch
settings. When a multipass source column is specified in the batch settings, it overwrites the current
multipass settings in the target report (as if you had gone back to "basic mode" and selected a new
multipass source column). However, the report can be run using batch processing if you use the
nativemultipass settings defined in the report (meaning, leaveMultipass Source Column blank in
the batch settings).

Item Description

Source Table The source table for themultipass processing. The source table is similar to the
primary table for Axiom queries. All other data settings for themultipass
process must be valid in the context of the source table.
l If the source table is a reference table, then the data settings can only be

columns in the reference table.
l If the source table is a data table, then the data settings can be columns in

the source table, or columns in a lookup reference table, or columns from
other data tables that share the same key columns.

You can type a table name, or click the table icon to the right of the box to
select a table.

If you use basic mode, the source table is automatically set to the table of your
specified source column.
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Item Description

Source Columns The source column or columns for themultipass processing. Source columns
provide information about the current pass.

You can type a column name, or you can click on the column icon to the right
of the box to select a column. Separatemultiple columns with semicolons.

In basic mode, you specify a source column, which also determines theGroup
By and Source Table settings, and therefore determines themultipass list of
items. In advanced mode, it is not required to specify a source column. You only
have to specify source columns in advanced mode if you want to:
l Return the current pass value for a related column, using the

GetCurrentValue function. For example, you may be processing the report
by department, but you also want to dynamically display the name of the
department's VP in the report titles. If you include DEPT.VP as a source
column, then you can use GetCurrentValue("DEPT.VP") to return the
relevant VP name for each pass.

l Define a current value default for a column, to be returned by the
GetCurrentValue function during non-multipass processing. These current
value defaults can be defined on the File Processing Control Sheet.

Group By The column or columns to group by, to determine themultipass list of items.
For example, if you want to process by department, the group by column
should be DEPT.DEPT.

You can type a column name, or you can click on the column icon to the right
of the box to select a column. Separatemultiple columns with semicolons.

Although this setting is not technically required, it should be specified in most
cases. If left blank, themultipass list is grouped by the key columns of the
source table.

If you use basic mode, the grouping level is automatically set to your specified
source column.

Sort By The column or columns by which to sort themultipass list of items, to
determine the order in which the list of items is processed. Separatemultiple
columns with a semicolon. The sort is always ascending order.

You can type a column name, or you can click on the column icon to the right
of the box to select a column. Separatemultiple columns with semicolons.

If left blank, themultipass list is sorted by theGroup By column(s).
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Item Description

Source Filter If desired, you can specify a filter criteria statement to limit themultipass list of
items to be processed. For example, if you are processing by department, you
could specify DEPT>2000 to process the departments greater than 2000, or
DEPT.Region='North' to process only the departments that belong to the
North region.

You can type a filter criteria statement, or you can use the Filter Wizard .

The only purpose of this filter is to limit themultipass list of items to be
processed. It does not impact any data queries in the report.

NOTE: Alias names and column-only syntax can be used in themultipass data settings.

� Multipass Filter Settings
Using this section, you can override the default filter behavior for multipass processing. For more
information on how the filter is applied by default, see Howdata is filtered during multipass processing.

Item Description

Override Default
Filter Behavior

Select this check box if you want to override the default filter behavior for the
multipass process.

Once this check box is selected, the other settings in this section become
available. If you do not select a table type or a table to be affected by the
multipass filter, then the default filter behavior continues to apply. The default
filter behavior is only overridden once you specify a different filter behavior.

Affected Table
Types

Click the table icon to select table types to be affected by themultipass filter.
The Select Table Types dialog lists all table types defined in the system. To
select a table type, click the folder for the table type and then click Add. You can
expand the table type folders to see that tables that belong to the table type.

NOTE: Tables that do not have a table type are listed under a (No Type) folder;
that folder cannot be added as an affected table type. If you want to filter tables
that do not belong to a table type, use the Affected Tables setting.

Themultipass filter will be applied to any table that belongs to a table type listed
in this field.

Affected Tables Click the table icon to select individual tables to be affected by themultipass
filter. The Select Tables dialog lists all data tables defined in the system. To
select a table, click the table name and then click Add (or double-click the table
name).

Themultipass filter will be applied to any table listed in this field.
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How the multipass list of items is determined

When you usemultipass processing, the file is processed multiple times, using a different item for each
pass. This topic explains how themultipass list of items is generated based on themultipass settings.

Behind the scenes, a system-controlled Axiom query is used to generate themultipass list of items.
When you click Preview Multipass List, you are viewing the rows returned by this Axiom query.

When using themultipass "basic mode" settings, you specify a single source column from a reference
table, such as DEPT.DEPT. This setting creates an Axiom query as follows:

Primary Table: DEPT

Sum data by: DEPT.DEPT

Field definition row: DEPT.DEPT

By default this data is sorted by the key column of the primary table, so no sort level is explicitly set. This
basic setting would return the full list of departments in the DEPT table, and therefore themultipass
process would result in one pass per department.

When using advanced mode, you can definemore of the system-controlled Axiom query settings, to
explicitly control how themultipass list is generated.

Themultipass advanced mode settings correspond to Axiom query settings as follows:

Advanced Mode
Multipass Setting

Corresponding
Axiom Query Setting

Source Table Primary Table

Source Columns Entries in the Field Definition Row

Group By Sum data by these columns

Entries in the Field Definition Row

Sort By Sort by database columns

Entries in the Field Definition Row

Source Filter Data Filter

You can adjust these settings as needed to result in the desired multipass list of items to process.
Whatever results would be returned by an equivalent Axiom query will be returned by themultipass
query. For example, if you want to process by department, and the source table is DEPT, then you will
get one pass for each department defined in the DEPT table. On the other hand, if the source table is
GL2020, then you will get one pass for each department that has data in the GL2020 table.
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How data is filtered during multipass processing

When multipass processing is performed, Axiom Budgeting and Performance Reporting automatically
applies a filter to the report, to limit the data returned by the item currently being processed. For
example, if you are processing by department, then the pass for Dept 1000 has a filter applied to limit the
data in the report to Dept 1000.

By default, themultipass filter for each pass works as follows:
l The filter criteria statement for themultipass filter is determined by theGroup by column(s)

defined for themultipass settings.

In basic mode, the group by column is automatically set to the selected source column. In
advanced mode, you can manually specify a group by column, including multiple columns if
desired. IfGroup by is left blank, then the key columns of the source table are the group by
columns.

For example, if the group by column is DEPT.VP, then each pass is filtered by VP (such as
DEPT.VP='Jones').

l In the report, themultipass filter is applied as follows:
o If the source table is a reference table, the filter is applied to any Axiom query or GetData

function that queries a data table that links to the reference table (or the reference table
itself).

o If the source table is a data table, the filter is applied to any Axiom query or GetData
function that queries a data table that belongs to the same table type as the source table.
(If the source table does not have a table type, then only the source table is filtered.)

If desired, you can use the advanced mode settings to define different behavior for themultipass filter.
Although the filter criteria statement is always defined by theGroup by columns, you can override the
default filter behavior and explicitly specify which tables or table types the filter should be applied to in
the report. See Configuring advanced multipass settings.

NOTES:
l Themultipass filter is only applied during multipass processing, and is not visible in the file

itself. Themultipass filter is applied in addition to any filters defined in the file (sheet filters,
Axiom query data filters, etc.), and in addition to the current user's security filters.

l The IgnoreSheetFilter parameter for the GetData function can be used to prevent the
multipass filter from being applied to a particular GetData function in the file.

l When performing snapshot form processing, if the target form contains an Embedded Form
component to display a child form, themultipass filter is not applied to the child form. For
more information, see Design considerations for snapshot form processing.
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Using a data table as the source table for multipass processing

When using "basic mode" to definemultipass settings, the source table is determined automatically
based on your selected source column. Because basic mode only allows selecting columns from
reference tables, the source table is always a reference table, such as ACCT or DEPT. However, in some
cases you may want to use a data table as the source table.

For example, imagine that you want to perform multipass processing by department. In basic mode you
select DEPT.DEPT as the source column, which means that the report will be processed once for each
department in the DEPT table. Depending on the data in the data tables that the report queries, this may
result in processing the report for departments that have no data.

Imagine that the report queries data in the BGT2020 table. The DEPT table contains department 3200,
but this is a newly-added department that was not part of the 2020 planning process, and therefore has
no records of data in the BGT2020 table. When department 3200 is processed as part of themultipass
process, it will return no data for that report.

This may be the desired result—you may want to process the full list of departments, even if a few
departments may not have data in the current context. Reference tables are used by default in basic
mode so that you can be certain that every item was included, and because this is themost common use
case. However, if you only want to process the items that are relevant to the data being queried, you can
specify a data table as the source table instead.

Continuing the example, you could use advanced mode settings to specify BGT2020 as the source table
instead of DEPT. Although the source column and grouping level is still DEPT.DEPT, because the
multipass list of items is now being generated from the data table, themultipass process will only
process departments that are found in the BGT2020 table. While the DEPT table might have 100
departments, the BGT2020 table might have data for only 90 of those departments. When BGT2020 is
the source table, themultipass process will result in 90 passes instead of 100 passes.

TIP: You can see exactly howmany items will be processed based on the current multipass settings
by using Preview Multipass List.

Now imagine that the report queries two tables, GL2020 and GL2019, and you want to usemultipass
processing on this report by department. The easiest and most common way to ensure that the report is
processed for all relevant items is to use DEPT as themultipass source table. However, if you do not want
any no-data passes, but you want to ensure that the report is processed for every department that has
data in either GL2020 or GL2019, then you can do the following:

l Set the source table to one of the data tables. For example: GL2019.
l Specify two columns for the source columns. For example: DEPT.DEPT and any data column from

the GL2020 table.

DEPT.DEPT is evaluated against the source table by default, and includes all of the departments that
have data in the GL2019 table. By including any data column from the GL2020 table, themultipass list
also includes any departments that have data in the GL2020 table.
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IMPORTANT: If the source table is a data table, then by default themultipass filter is only applied to
Axiom queries and GetData functions that query a data table from same table type as the source
table. If your file uses tables from multiple table types, then either the source table should be a
reference table instead, or you should override the default filter behavior using the advanced
multipass settings. For more information, see Howdata is filtered during multipass processing and
Configuring advanced multipass settings.

Returning related values for each pass

When performing multipass file processing, you may need to bring in related values for each pass. For
example, if you aremultipass processing by Dept, you may also want to return the VP associated with
each department, or the Region associated with each department.

It is not necessary to use the GetData function to query these values. Instead, you can use the
GetCurrentValue function to dynamically bring in the related information for each pass. In order to do
this, you must first add the desired columns as source columns in themultipass settings.

� Adding source columns
To add source columns to themultipass settings, click Show Advanced View in the File Processing task
pane. This exposes the full set of advanced multipass settings.

By default, the Source Columns field lists the column that you selected for multipass processing in the
simple view. In this example, we are processing by department, so Dept.Dept is listed in the Source
Columns.

The Source Columns field determines which values from the source record will be available for each pass.
You can list any number of columns in addition to themain multipass column (Dept.Dept), to make
those values available as well. In this example, we have added Dept.VP and Dept.Region to the
Source Columns list. You can type additional column names manually (separated by semicolons), or you
can click the columns icon to open the Select Columns dialog.

Using multiple source columns does not affect the overall list of values to be processed, as that is
determined by theGroup By field.
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If the source table is a reference table, then you can list any column in that table, or any column in a
lookup reference table. If the source table is a data table, then you can list any column in that table, any
column in a lookup reference table, or any column from another data table that would be eligible to join
with the source table. Basically, if you could include the column in the field definition of an Axiom query if
the source table were the primary table of the query, then you can list it in the source columns.

Alternatively, you can add source columns directly in the File Processing Control Sheet (Control_
FileProcessing), in theMultipass Columns and Current Value Defaults section at the top of the sheet.
Any columns added here will automatically be listed in the advanced multipass settings, and vice versa.

IMPORTANT: If additional source columns are used in the report, and you want to process that
report using batch processing, then you cannot set a multipass source column for the report in the
batch settings. When a multipass source column is specified in the batch settings, it overwrites the
current multipass settings in the target report, including any additional source columns. However,
the report can be run using batch processing if you use the nativemultipass settings defined in the
report (meaning, leaveMultipass Source Column blank in the batch settings).

� Returning values using GetCurrentValue
Once additional columns have been listed in the Source Columns, you can return those values by using
the GetCurrentValue("ColumnName") function. For example:

=GetCurrentValue("Dept.VP")

During multipass processing, this function returns the VP name associated with the department
for the current pass.

The column must be listed in the Source Columns in order for the GetCurrentValue function to return a
value. If it is not, then GetCurrentValue returns #ERR during multipass processing.

This is themost efficient way to return related values during multipass processing. Axiom Budgeting and
Performance Reporting is already querying the source table to gather the list of values for processing,
and can obtain the necessary related values as part of that query. If you instead use GetData functions or
data lookups to return related values, that introduces additional data queries which can impact
performance.

When multipass processing is not occurring, the GetCurrentValue function will return the values defined
in the Current Value Defaults section of the File Processing Control Sheet. If the cell underneath the
column name is blank, then GetCurrentValue("ColumnName") will return blank. Otherwise, it will return
the value defined here.
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Dynamic settings for multipass processing

As you perform multipass processing on a file, you may want certain settings to change for each pass. A
classic example is the email address for file delivery—in most cases you want each pass to be emailed to
different email recipients. However, you may also want to dynamically skip certain passes or adjust other
settings per pass. This topic explains howmultipass file processing executes and which settings can be
dynamically adjusted for each pass.

The following diagram indicates the general processing steps that occur during multipass processing.
Understanding the process can assist in setting up dynamic file processing.
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* Only certain file processing settings are re-read for each pass, and only certain worksheet settings are reapplied
for each pass. See the following sections for more information.

It is important to understand that the file is not closed and reopened for each pass. All passes are
performed in the same file instance, and the starting point for each pass is the ending point of the prior
pass.
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Most importantly, data is not zeroed between passes. This means that you should not dynamically
enable or disable an Axiom query per pass, because this means that the query will still contain the data
from the previous pass. Depending on what you are trying to accomplish, you should do one of the
following instead:

l Dynamically use an "empty" filter in the Axiom query, such as 1=2. This will effectively zero the
query for the pass, because the filter does not match any data.

l Dynamically disable the pass, using the Processing Enabled setting.

NOTES:
l If you are performing snapshot form processing, and the form uses an Embedded Form

component to display a child form, keep in mind that the child form is rendered normally and
is not impacted by the file processing filter or Axiom query requirements. For more
information, see Design considerations for snapshot form processing.

l The discussions in this topic generally do not apply to multipass file collect processing,
because the purpose of file collect processing is not to refresh data, and themajority of file
collect settings are defined on the File Collect Configuration sheet. All of the settings on the File
Collect Configuration sheet can be dynamic per pass.

� Dynamic file processing settings
The following file processing settings are refreshed during each pass and therefore can be dynamic. The
report worksheets are refreshed with data first, then the file processing settings are refreshed, and then
the file processing action occurs. See the diagram in the previous section for more information.

When the file processing action is snapshot or export, the dynamic settings only apply if the file
generation option isMultiple Output Files. If you are using Single Output File, then there is only one
file to save and/or email, and therefore only one file name, file folder, list of email recipients, etc. The
exception is sheet names—these can be dynamic in all cases (and must be dynamic if using Single
Output File).

All other file processing settings that are not listed here are evaluated once, at the start of the process.
For example, you cannot change settings such as the file processing type or the file type on a per pass
basis.

Setting Description More Information

Output File
Name

The file output name can change to reflect the
contents of each pass. For example, if you are
multipass processing by region, you may want to
include the region name on the file name. You can
use the [Current_Value] variable or the
GetCurrentValue function to achieve this.

Defining the file name
for file processing
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Setting Description More Information

Output folder The output folder name and/or path can change for
each pass. For example, you might have folders on
your network that are designated to hold reports for
certain regions or managers. You can use the
[Current_Value] variable or the GetCurrentValue
function to read the current value and save the file to
the appropriate location.

Remember that Axiom Budgeting and Performance
Reporting will attempt to create the folder if it does
not already exist.

N/A

Sheet Names The sheet name can change to reflect the contents of
each pass. For example, if you aremultipass
processing by region, you may want to include the
region name on the sheet name. You can use the
[Current_Value] variable or the GetCurrentValue
function to achieve this.

Defining sheet names
for file processing

To The list of email recipients can change for each pass.
In this case you are likely to use GetData to look up
email addresses stored in a table, but you can use
any variable or function in a formula to resolve to
valid email addresses.

Using dynamic email
addresses with file
processing

Subject Line The subject line of the email can change for each
pass. For example, if you aremultipass processing by
region, you may want to include the region name in
the subject line. You can use the [Current_Value]
variable or the GetCurrentValue function to achieve
this.

N/A

Body Text The body text of the email can change for each pass.
For example, you could set up an IF formula to use
different body texts depending on information in the
report. If the variance in the report is over a certain
amount, you could send one version, otherwise send
the other version.

N/A

Processing
Enabled

You can turn the file processing action on and off for
each pass. For example, you could set up an IF
formula so that if the contents of the report is all
zeros, the report is not saved or emailed.

Setting up conditions
for file processing
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Setting Description More Information

Sheets to
Process

The sheets to process can dynamically change for
each pass. For example, if you aremultipass
processing by department, some department types
might use 3 sheets to process, while other
department types use 2 sheets. You could use a
formula to change the list of sheets to process based
on the department type of the current pass.

NOTE: Theremust be at least one sheet to process
for each pass. If a pass has no designated sheets to
process, then no action will occur for that pass.

N/A

� Dynamic Axiom query settings
Axiom query settings are read at the start of each pass and can be dynamic—for example, to dynamically
change the data filter applied to a query.

Generally speaking, you should not dynamically enable or disable an Axiom query on a per pass basis. If a
query runs for pass A, and then does not run for pass B, then the data for pass Awill still be present in
the query when pass B is performed. Because the query is inactive for pass B, the query is not rebuilt or
updated and therefore the data for pass A remains. Alternatively, you can leave the query active but
dynamically set a filter that will result in no data (such as 1=2). This approach will result in the query being
rebuilt or updated to reflect no data for that pass.

� Dynamic worksheet settings
The sheet options from the default Control Sheet are also applied for every pass of a multipass process.
This means that settings such as freeze panes, sheet visibility, and the active cell can be dynamic for each
pass.

NOTE: It is not possible to dynamically change the view applied during file processing. Whatever view
is applied when the process begins will be used for the duration of the process. If you aremanually
performing file processing, you can apply the desired view before initiating the process. If processing
is performed via Scheduler or Batch processing, then the process will use the Initial Dynamic View if
defined (otherwise it will use whichever viewwas applied when the file was last saved).

This does not apply during snapshot form processing, because the form is not affected by these
spreadsheet display settings.

GetCurrentValue function

Returns information about the current filter context applied to the file, for either multipass processing or
for a temporary sheet filter.
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Temporary filters supported by this function include:
l Sheet filters applied by use of the Quick Filter feature.
l Sheet filters applied by use of a GetDocumentHyperlink URL.

This function is most commonly used for report titles and headers, so that the information updates
dynamically when different filters are applied to the file.

� Syntax
GetCurrentValue("ColumnNameorCode")

The valid entries for ColumnNameorCode depends on whether you are using the function in conjunction
with multipass processing or with a temporary sheet filter.

Multipass processing

Value Description

Blank If the parameter is left blank (open parentheses), the function returns the item
being processed for the current pass. For example, if themultipass process is by
department, then the function returns the department code for the current
pass.

ColumnName You can specify any column listed as a Source Column for themultipass
process, and the function returns the value in that column, for the current pass.
You can also specify columns that are listed only in theGroup By and Sort By
settings for themultipass process, but in this case no values can be returned for
standard (non-multipass) processing. See GetCurrentValue behavior during
non-multipass processing for more information.

For example, if themultipass process is by department, and you specify
DEPT.VP as the column name, then the function returns the VP of the
department for the current pass.

You can use fully qualified Table.Column syntax to specify the column, or you
can use column-only syntax.

PassNumber You can enter the keyword PassNumber to return the number of the current
pass in the context of the overall multipass operation. For example, if the
multipass process has 10 items to process, and the current item is the fifth item
to be processed, the function returns 5.

Filter You can enter the keyword Filter to return the full filter criteria statement
being applied for the current pass. For example, this would return
Dept.Region='West' when processing by Dept.Region and the current pass is for
theWest region.
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Value Description

Table You can enter the keyword Table to return the table being used for the
multipass process. For example, this would return Dept when processing by
Dept.Region.

Column You can enter the keyword Column to return the column being used to
determine the list of values for themultipass process. For example, this would
return Region when processing by Region.

When using the Column keyword, an optional Boolean parameter is available to
specify whether to return just the column name or the fully qualified column
name. By default, this parameter is False, which means the column name is
returned. To return the fully qualified column name, specify True. For example:
GetCurrentValue("Column",True) to return Dept.Region instead of just
Region.

Temporary sheet filter

Value Description

QuickFilter You can enter the keyword QuickFilter to return the filter criteria statement
that is being applied by a temporary sheet filter. For example, if the sheet filter
uses the filter criteria statement Dept.VP='Jones', that value is returned. If
no temporary sheet filter is currently applied to the file, the function returns
None.

NOTE: The prior version of this keyword is Temp_Filter_Value.

Temp_Filter_Key You can enter the keyword Temp_Filter_Key to return the table or table type
that is being used as the "key" for a temporary sheet filter. For example, if the
filter uses the table type GL, that table type name is returned. If no temporary
sheet filter is currently applied to the file, the function returns None.

All non-numeric entries must be placed in double quotation marks, unless you are using cell references
to reference the text held in another cell.

� Remarks
l The return values for multipass processing and temporary sheet filters aremutually exclusive. The

codes used for multipass processing do not recognize temporary sheet filters, and the codes used
for temporary sheet filters do not recognizemultipass processing. The function cannot be
constructed in a way to return a filter value in both contexts.

l When using the file processing type of Save Data in Batches, the only valid use of GetCurrentValue
is to return the pass number. The other options do not apply in this context and will not return
data.

l GetCurrentValue is a non-volatile function.
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� Multipass examples
=GetCurrentValue()

This example returns the value of the current item being processed. For example, "Jones" if processing
by DEPT.VP.

=GetCurrentValue("DEPT.VP")

This example returns the value in the DEPT.VP column for the current item being processed.

The difference between this example and the first one is that DEPT.VP does not have to be the column
that defines themultipass list of items. For example, you may be processing by departments, but you
have included DEPT.VP as an additional source column. As each department is processed, this example
returns the name of the VP associated with that department.

Note that you could accomplish the same result by passing the current item value into
GetData: =GetData("vp","dept="&GetCurrentValue()&"","dept")

=GetCurrentValue("PassNumber")

This example returns the number of the current pass. For example, "5" if the current pass is the fifth pass
of the process. If themultipass process has 10 passes, this function will return 1-10 for each successive
pass.

=GetCurrentValue("Filter")

This example returns the filter being applied for the current pass. For example, "Dept.Region='West'".

� Temporary sheet filter examples
=GetCurrentValue("QuickFilter")

This example returns the filter criteria statement of the temporary sheet filter applied by the Quick Filter
feature or GetDocumentHyperlink. For example: DEPT.Region='West'.

=GetCurrentValue("Temp_Filter_Key")

This example returns the table or table type that the temporary sheet filter applies to. For example:
DEPT.

� GetCurrentValue behavior during non-multipass processing
Although the primary intent of the GetCurrentValue function is to return information during multipass
processing, you can configure themultipass settings so that the function also returns relevant values
when using non-multipass processing (Process File). This applies when using GetCurrentValue with open
parentheses or with a source column name.

The top of the File Processing Control Sheet has a section to define source columns and their current
value defaults. For each source column listed in the top row, you can define a corresponding current
value default in the bottom row. For example:
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In this example, when using multipass processing, GetCurrentValue("DEPT.VP") returns the name
of the VP currently being processed. When using non-multipass processing, the same function returns
the text "All VPs". If the default value was left blank, then the function would return nothing (blank)
during non-multipass processing.

You can define a default value for each source column as desired, or leave it blank to return blank.

If you use the GetCurrentValue function with open parentheses—GetCurrentValue()—then a value
will only be returned during non-multipass processing if theGroup By column is also listed as a source
column (this happens automatically when using basic modemultipass settings), and the source column
has a default value defined on the control sheet. Otherwise, the open parentheses function returns
nothing during non-multipass processing.

When no file processing is occurring, using open parentheses or a column name returns the default
values if defined; otherwise the function returns blank.

NOTES:
l You must use the File Processing Control Sheet if you want to define current value defaults for

your source columns. The File Processing pane does not have a section to define these values.

l The other options for GetCurrentValue are only intended to return values during multipass
processing. This applies to the keywords PassNumber, Filter, Table, and Column. All of these
options return blank when multipass processing is not occurring, except for PassNumber.
PassNumber returns 0 if no processing is occurring, and 1when non-multipass processing is
occurring.

IsRunningMultiPass function

Returns True if the file that contains the function is currently being processed using multipass processing.
Can be used to create dynamic headers or change file settings based on whether multipass processing is
occurring.

� Syntax
IsRunningMultiPass()

This function does not take any parameters.

� Remarks
IsRunningMultiPass is a non-volatile function.
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� Examples
=IsRunningMultiPass()

This example returns "False" when multipass processing is not occurring, and "True" when it is occurring.

=IF(IsRunningMultipass()=TRUE,GetCurrentValue(),"Consolidated")

In this example, the IsRunningMultiPass function is used within an IF function to change the result
depending on whether multipass processing is occurring. This function returns the current pass item
during multipass processing, and returns the text "Consolidated" otherwise. (You can get the same end
result by using just the GetCurrentValue function, if you define the current value default as
"Consolidated" for the column that defines themultipass list of items.)

Additional Setup Considerations
This section contains detailed setup information for various aspects of file processing. File processing can
be configured to handlemany different use cases.

File processing variables

File processing variables can be used in file processing settings, to return information such as the current
pass value. These variables are valid when entered into one of the following areas:

l File Processing task pane
l File Processing Control Sheet

File processing variables are typically used to generate dynamic values when during multipass
processing. For example, if you are using multipass processing to create a snapshot copy of a file, and all
of the sheets are being combined into one output file, you can use file processing variables to
dynamically generate unique sheet names for each pass.

NOTE: File processing variables cannot be used on the special File Collect Configuration Sheet or the
Batch Control Sheet. If you need to create dynamic settings for file collect multipass processing, you
can use the GetCurrentValue function and other special settings. For more information, see Using
multipass processing with file collect.

The following rules apply to file processing variables:
l File processing variables only return values when they are used in file processing settings. They

can be entered into the setting field directly, or referenced via a cell reference.

When used anyplace else, file processing variables do not return a value. If you want to return the
current value or current pass number for use within a report sheet (for example, to create a
dynamic report title), then you can use the GetCurrentValue function instead.

l File processing variables only return values during file processing. When viewing the variables
within the file processing settings, they will always display just the variable name.
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l File processing variables use the following syntax: [VariableName]. The variables must be
placed in brackets in order to be recognized during file processing.

Variable Description

[Current_PassNumber] Returns the number of the current pass.

l When multipass processing, the first pass returns 1. Subsequent
passes are incremented by 1. If themultipass settings result in 10
passes, then this variable will return 1-10, with the sort order
determining which item is the first pass.

l When non-multipass processing, the variable always returns 1.

[Current_SheetName] Returns the name of the current sheet being processed. This variable
is for use in generating sheet names for snapshot copies.

For example, you could use [Current_Value]_[Current_
SheetName]when using multipass processing and combining all
results into a single file. If themultipass processing was by VP, the
sheets would have names such as Jones_IncomeStmt, Smith_
IncomeStmt (where the sheet being processed is named
IncomeStmt).

If you are doing standard (non-multipass) processing, or if you are
multipass processing to separate files, then you can use just
[Current_SheetName] to replicate the original sheet name in the
snapshot copies.

This variable is only valid within the Sheet Name setting for file
processing. It cannot be used in other settings.

[Current_Value] Returns the item being processed in the current pass.

For example, if themultipass process is by VP, this variable would
return "Jones" when VP Jones is being processed, "Smith" when
VP Smith is being processed, etc.

This variable returns nothing (blank) during standard (non-multipass)
processing, unless a default current value is defined for the column
that defines themultipass list of elements. Default current values can
be defined on the File Processing Control Sheet.

File processing variables are not case sensitive.

If you want to use a file processing variable within a formula, the formula must be constructed so that
the file processing variable is returned as text within the file processing setting. For example:

Valid formula: =Sheet1!B5&"_IS_[Current_Value]"

Invalid formula: =Sheet1!B5&"_IS_"&[Current_Value]
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Defining sheet names for file processing

When you use file processing to save a snapshot copy of a file, you must specify how the sheet names
are determined in the snapshot. This setting is called Sheet Names in the File Processing pane, and
applies to all snapshot file types except PDF.

The sheet name setting cannot be left blank. You must use file processing variables to dynamically
generate sheet names, or type a "hard-coded" sheet name.

NOTE: The sheet name setting takes a single entry that applies to all sheets being processed.
Therefore if you are processing more than one sheet (as specified in the Sheets to Process setting),
you must use file processing variables to define the sheet name. "Hard-coded" sheet names can only
be used when processing a single sheet.

How you define the sheet name primarily depends on whether you plan to usemultipass processing on
the file, and whether themultipass output is to a single file or multiple files.

� Sheet names for standard processing
If the file will be primarily processed using standard (non-multipass) processing, you can do one of the
following:

l Use the file processing variable [Current_SheetName]. The sheets in the snapshot copy will use
the same names as the original file.

l Type a sheet name. The sheet in the snapshot copy will use this "hard-coded" file name. This
option only applies when processing a single sheet (otherwise you will havemultiple sheets with
the same name). Formulas can also be used to create sheet names.

[Current_Value] primarily applies to multipass processing and is typically not used in this context.
However, if you have a file that you process using both standard and multipass processing, you can
define a default current value for themultipass source column on the File Processing Control Sheet, and
that value will be returned by [Current_Value] during standard processing.
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� Sheet names for multipass processing
If the file will be primarily processed using multipass processing, then how you define the sheet name
depends on whether you are outputting to a single file or multiple files (the File Generation setting).

l If you are outputting to a single file, then the sheet (or sheets) resulting from each pass must have
unique sheet names, so that you can tell which sheets are associated with each pass. In this case,
you should use the default setting of [Current_Value]_[Current_SheetName]. This will
append the current pass value to the original sheet name.

For example, if you are using multipass processing to process by VP, you will get sheet names like
the following: "Jones_IncomeStmt", "Smith_IncomeStmt", etc. If you are processing multiple
sheets, then you will get sheet names like the following: "Jones_IncomeStmt", "Jones_Analysis",
"Smith_IncomeStmt", "Smith_Analysis", etc. (where you are processing two sheets named
IncomeStmt and Analysis).

l If you are outputting to multiple files, then you have the option of whether to use the [Current_
Value] variable in the sheet name or not.

In this case, the current value variable is most likely being used in the file name, so you could have
a file named "IncomeStatement_Jones.xlsx", with a sheet name of simply "IncomeStmt".
However, you may want to leave the current value variable in the sheet name anyway, so that the
sheet namewill work regardless of whether you output to a single file or multiple files.

In this case, you also have the option of using a "hard-coded" sheet name instead of using the
current sheet variable (as long as you are processing only one sheet).

Formulas can also be used to create sheet names.

Defining the file name for file processing

When you use file processing to create an output file (either a snapshot or an export file), you must
specify how the file name is determined. This setting is called Output File Name in the File Processing
pane.

The file name setting cannot be left blank. You must use file processing variables to dynamically generate
file names, or type a "hard-coded" file name.

How you define the file name primarily depends on whether you plan to usemultipass processing on the
file, and whether themultipass output is to a single file or multiple files.

NOTE: This discussion does not apply to file collect processing, because the output file settings for file
collect are defined on the special File Collect Configuration sheet. For more information, see File
Collect Configuration sheet.
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� File names for standard processing
If the file will be primarily processed using standard (non-multipass) processing, then you can type the
desired file name, without using any file processing variables. When you process the file, the output file
will use the specified file name. Formulas can also be used to create file names.

By default, the file name is set to [Current_Value]_Report. If you never plan to process this file using
multipass processing, then you can delete the default text and enter the desired file name, such as:
Income_Statement.

If you leave the [Current_Value] variable in the file name, then it will return nothing during standard
processing unless you have: 1) configured multipass settings for the file, and 2) defined a default current
value for the source column on the File Processing Control Sheet.

� File names for multipass processing
If the file will be primarily processed using multipass processing, then how you define the file name
depends on whether you are outputting to a single file or multiple files (the File Generation setting).

l If you are outputting to a single file, you can use the [Current_Value] variable, or you can type
the desired file name, such as Income_Statement_by_VP. Formulas can also be used to create
file names.

If you use the [Current_Value] variable, make sure to define a default current value for the
multipass source column on the File Processing Control Sheet. In this context, the [Current_
Value] variable returns the default value. If no default value is defined, the variable will return
nothing.

l If you are outputting to multiple files, then the file name for each pass must be unique, so that
you can tell which file is associated with each pass. You can use the [Current_Value] variable,
or you can use formulas and the GetCurrentValue function to create a file name.

For example, if the file name is set to Income_Statement_[Current_Value] then each pass
will create file names such as Income_Statement_Jones.xlsx, Income_Statement_Smith.xlsx, etc.

Defining the output folder for file processing

When you use file processing to create an output file (either a snapshot or an export file), you must
specify where the file is to be saved. This setting is called Output Folder in the File Processing pane. This
setting does not apply if you are only emailing files.

You can use file processing variables or formulas to generate the output folder name (for example, if you
aremultipass processing and you want to save the file for each pass to a different location). If the
specified folder does not already exist, Axiom Budgeting and Performance Reporting attempts to create
it.

The valid entries for the output folder depends on whetherOutput To is set to Local File System or
Axiom Repository:
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NOTE: This discussion does not apply to file collect processing, because the output folder settings for
file collect are defined on the special File Collect Configuration sheet. For more information, see File
Collect Configuration sheet.

� Local file system
If you are outputting to your local file system, then the folder location should be entered as a UNC path
instead of a mapped drive. If you browse to the folder, it is automatically entered as a UNC path.

You can use a folder on your local drive, but it will only be valid when running file processing interactively
from your own computer. If you want to process this file using Scheduler, the output folder should be a
shared network drive (or you can override the output folder in the Scheduler task). For Axiom Cloud
systems, a remote data connection is required to save a file locally when processing via Scheduler.

The ability to save files to the specified location and to create new folders (if necessary) depends on the
network permissions for the user processing the file. Access to the files after they are created is also
dependent on your network permissions.

� Axiom repository
The specified location in the Axiom file system must be within the Reports Library, and the location must
use the full path (meaning: \Axiom\Reports Library\...). The ability to save files to the specified
location and to create new folders (if necessary) depends on the Axiom Budgeting and Performance
Reporting security permissions for the user processing the file. Users can only create new folders if they
have read/write permissions to the parent folder, and they can only create new files if they have
read/write permissions to the target folder.

Once the files are created within the Axiom file system, access to those files is dependent on the user's
permissions to the output folder. Typically you should create the output folder in advance (or if you want
to create output folders on-the-fly, create a parent folder to hold the output folders), and then set
permissions for that folder as appropriate in Axiom Budgeting and Performance Reporting security, so
that the appropriate users will be able to access the files after they are created.

Setting up conditions for file processing

When using file processing, you may want to conditionally determine whether the file processing action
occurs, depending on information within the file. This can be especially useful when using multipass
processing, and you want the action to occur on some passes but not others.

The Processing Enabled setting on the File Processing Control Sheet enables conditional processing. By
setting up a formula in this field that conditionally returns either True or False, you can turn the file
processing action on or off for each individual pass.
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When file processing is initiated, the file is always refreshed. After the refresh occurs, Axiom Budgeting
and Performance Reporting checks the Processing Enabled setting to see if the file processing action
(snapshot, export, save data) should be performed.

l If True, the file processing action is performed as normal.
l If False, the file processing action is not performed.

In both cases, the process moves on to the next pass (if using multipass processing), refreshes the file
again, and checks the Processing Enabled setting again. This continues until all passes are complete.

For example, you may want to configure file processing so that a snapshot is not sent if a particular pass
results in zero data. You can set up a formula in the report sheet that totals all of the data columns. Then
you can set up a formula in the Processing Enabled setting that checks this total, and returns False if the
total results in zero, or True if it doesn't. Snapshots will be created for passes that have data, and passes
without data will be skipped.

The Processing Enabled setting is only available on the File Processing Control Sheet. You cannot turn file
processing on and off from the File Processing pane.

Using dynamic email addresses with file processing

When you are emailing the results ofmultipass file processing, in most cases you will want to dynamically
determine the email address for each pass. If instead the email address is hard-coded, then all passes of
the process will be sent to the same email address.

NOTE: This discussion does not apply to file collect processing, because the email settings for file
collect are defined on the special File Collect Configuration sheet. For more information, see File
Collect Configuration sheet and Using multipass processing with file collect.

There are a variety of ways to obtain the appropriate email address for each pass. Themethod you use
will depend on how you have stored email addresses within the system and what dimension you are
using to perform themultipass processing. This topic details some examples that you may be able to use
directly, or the examples may get you started in the right direction for your particular system.
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Example 1: Obtaining email addresses from a reference table
Imagine that you are performing multipass processing by department, and you want to send the
output to the "owner" of each department. If the Dept table contains a column that lists the
appropriate email address for each department (such as Dept.Email), then you can return this email
address using GetCurrentValue.

In this example, you can use GetCurrentValue by itself if you list Dept.Email as an additional source
column for themultipass process. In order to do this, you must switch the file processing task pane
to Advanced View, and then add Dept.Email as a second source column (assuming the primary
source column is Dept.Dept). Themultipass settings would look like the following:

For the To field of the Email Settings, you could then enter the following formula:
=GetCurrentValue("Dept.Email")

When multipass processing is performed, this function will return the email address associated with
the department for the current pass.

Alternatively, you could use GetCurrentValue to return the department code, and then use GetData
to return the email address. When using this approach, you do not need to add any additional
source columns to themultipass settings.

=GetData("Dept.Email","Dept="&GetCurrentValue())
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Example 2: Obtaining email addresses from security
In order to obtain email addresses from security as part of a multipass process, a user login name
must be associated with themultipass source column in someway. For example, you may be
performing multipass processing by department, and the Dept table contains a column lists the user
name of the department "owner" (such as Dept.Owner). You can return the user name using
GetCurrentValue, and then return the email address from security using GetSecurityInfo.

As discussed in the first example, you must first add Dept.Owner as an additional source column for
themultipass process (again we are assuming that Dept.Dept is the primary source column for the
process). Then in the To field of the Email Settings, you could enter the following formula:

=GetUserInfo("UserEmail",GetCurrentValue("Dept.Owner"))

When multipass processing is performed, the GetCurrentValue function will return the user name
from the Owner column for the current department, and then GetUserInfo will return the email
address for that user name.

Alternatively you could use GetCurrentValue() with GetData to look up the owner name based on the
department code, instead of using Dept.Owner as an additional source column.

Defining default values for current value

Axiom Budgeting and Performance Reporting has two ways to return the current value during multipass
processing: the file processing variable [Current_Value], and the function GetCurrentValue.

During multipass processing, these features return information relating to the current item being
processed. For example, if processing by region, they would return "North" when North is the region
being processed.

You may want to process the same report using "standard," non-multipass file processing. In this case,
you must decide what you want the current value to return when not using multipass processing.

On the File Processing Control Sheet, you can define a default value to use when using non-multipass
processing. For example, if your multipass setting is DEPT.VP, you can define a default value that is
something like "Consolidated" or "All VPs". When you process the file using multipass processing, the
current value will return the VP name. When you process the file using non-multipass processing, the
current value will return "All VPs". This way you can use the same settings for both processing contexts.

If you do not define a default value, then the current value will return nothing (blank) during non-
multipass processing. This may be the desired effect. However, if you have set up file names or other
settings using constructions such as "[Current_Value]_IncomeStatement," then you should define a
default value, otherwise you will get the following when non-multipass processing: "_IncomeStatement".
(This may not matter if the file is only for use with multipass processing.)

To define a default value for the current value:
1. In the file, go to the File Processing Control Sheet (Control_FileProcessing).
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You must use the control sheet to set default values. The task pane does not contain settings for
this feature.

2. At the top of the control sheet, under Source Columns and their Current Value defaults, locate
the source column for which you want to define a default value.

If you used "basic mode" to set up themultipass settings, this area lists only one column: the
column you selected as the source column. If you used advanced mode settings, then this area
may list multiple columns. Each column listed here can have a corresponding default value.

3. In the cell directly underneath the source column, type the value that you want to use as the
default value.

Example
This file has been set up to use "All VPs" as the default value for the DEPT.VP source column:

When using Process File to process the file, the current value is "All VPs". When using Process File
Multipass to process the file, the current value is whichever VP is being processed for the current
pass (for example, "Jones").

Using batch variables with file processing

When you set up file processing for a report, you can define one or more batch variables to be used
when processing the report via Scheduler's File Processing task, or via batch processing.

Batch variables can be used to change the report in someway as part of file processing. When you set up
a file processing task for Scheduler, or when you list the report in a batch, you can define values for the
variables. When the report is processed, the variable values are temporarily placed in designated cell
locations in the report. If the report is configured to reference those cells, then the report will change
based on the variable values.

The batch variables can be used for virtually anything within the report. You could reference them in
report titles, or in data query settings, or within the file processing settings. The usage of the variables is
entirely user-definable.

NOTE: Batch variables cannot be used to change the Initial Dynamic View of the report for
processing. The Initial Dynamic View is already applied by the time the variables are passed in, and it
is not applied again. There is no way to dynamically determine the view to be applied for file
processing; it will use whatever view is already applied in the file when the processing begins.
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� Defining a batch variable
Batch variables are defined on the File Processing Control Sheet. This is an advanced file processing
setting that is not available in the File Processing pane.

To define a batch variable, go to the Batch Variables section at the bottom of the File Processing Control
Sheet, and type a value into any empty cell in the Variable Names row. The name can be anything you
want, but it should reflect what the variable value is used for.

To use the batch variable in the report, you would reference the cell in the Variable Values row directly
below the variable name (in this case, cell D66).

You can leave the value blank, or you can type in a value to be used by default. When the file is
processed, it will be replaced by whatever value is specified in the Scheduler task settings or the batch
settings. (If no value is specified, then the default value in the file is used.)

� Using a batch variable
Batch variables can be used when the file is processed by a batch report, or when it is processed by
Scheduler's File Processing task.

l To specify a variable value in a batch report, use the Batch Variables column. Enter each
variable/value pair using the following syntax: variablename=variablevalue

If you want to define values for multiple variables, separate each variable/value pair with a
semicolon.

l To specify a variable value for a Scheduler File Processing task, use the Batch Variables section of
the task. Select theOverride check box and then type the desired value.

Automatically deleting file output generated by file processing

If file processing creates an output file—such as when using snapshot or export file processing—then you
can configure the file processing settings so that the output file is automatically deleted after a certain
period of time. Using this feature can help prevent a buildup of outdated files from regular executions of
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file processing.

NOTE: This feature only applies when saving output files to the Axiom repository. Axiom Budgeting
and Performance Reporting cannot automatically delete files that are saved to a file share outside of
Axiom Budgeting and Performance Reporting.

In the File Processing task pane, you can use the Purge Setting to configure output files for automatic
deletion. Clicking the pencil icon brings up the Choose Date dialog, where you can select either of the
following:

l Static purge date: Select the purge date from a calendar. Files will be deleted after the specified
date has passed.

l Relative purge date: Specify the number of days to keep the output after it has been generated.
The output will be deleted after the specified number of days have passed.

Example Choose Date dialog

� How the file output is purged
When file processing is executed, the output files are stamped with a purge date according to the
configured purge setting. For example, if the purge setting is 20 days and file processing is executed on
12/1/2020, then the stamped purge date is 12/21/2014. Files are eligible to be purged after that date, in
this case starting on 12/22/2014.

The file deletion is performed by the System Data Purge job in Scheduler. This is a system job that runs
periodically to purge old data and files from the Axiom Budgeting and Performance Reporting database.
When the job runs, if it finds files that are eligible to be deleted based on the stamped purge date, then it
will delete those files.
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Executing file processing from a custom task pane or ribbon tab

You can perform file processing on a report file directly from a custom task pane or ribbon tab, by linking
to the file and then using shortcut parameters to trigger file processing. You can choose to perform
either regular file processing or multipass file processing.

If file processing is enabled for the shortcut target, double-clicking the item executes the file processing
action. The file itself is opened in the background and is not visible to the user.

When using this option, you may want to configure the file processing report so that the output file
opens in Axiom Budgeting and Performance Reporting after processing instead of being saved or emailed
(or in addition to that). You can use theOpen Output File after Processing option on the File Processing
Control Sheet . If the output folder is left blank, then the output file will open as a temporary file within
Axiom Budgeting and Performance Reporting, and the user will need to manually save it if they want to
keep it. (Note that this feature is not supported when using file collect or batch.)

NOTES:
l If the file is already open when this command is executed, it will be closed at the end of the

process, regardless of whether the file contains any unsaved changes.

l The user does not need to have the Allow File Processing permission for the file in order to
initiate file processing from a task pane, the user only needs access to the file.

File processing using Scheduler

Using the File Processing Scheduler task, you can schedule a report for processing. The report must
already be configured for file processing in order to process it using Scheduler.

Once you have a Scheduler job set up, you can run it on demand, or you can schedule it for future
execution. For example, you may have a set of reports that you want to run every week, every month, or
every quarter. For more information on using Scheduler, see the Scheduler Guide.
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� Requirements and limitations
Note the following requirements when running file processing using Scheduler:

l TheOutput Folder location must be accessible by the Scheduler service user account. If you
specify a network folder location using the Browse button, the location is automatically entered as
a UNC path. If you specify a C: drive location, that location will be evaluated as the C: drive of the
Scheduler server.

l If the file processing type is Print, the Scheduler server(s) must be configured to access the
specified printer. This may require the assistance of your IT department.

� Creating the Scheduler job
In order to create a Scheduler job, you must be an administrator or have the Scheduled Jobs User
security permission. Non-admin users must also have read/write access to at least one folder in the
Scheduler Jobs Library.

Scheduler jobs can only be created in the Desktop Client. Although you can view the status of existing
jobs in theWeb Client, you cannot create new jobs in that environment.

To create a File Processing job in Scheduler:
1. On the Axiom tab, in the Administration group, clickManage > Scheduler.

Scheduler on default Axiom ribbon tab

In systems with installed products, this featuremay be located on the Admin tab. In the System
Management group, click Scheduler.
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Scheduler on Admin tab (example product ribbon)

2. In the Scheduler dialog, click New.

A new job is opened in the dialog, with a tab name ofNew Job.

3. Click Add > File Processing to add the task to the new job.
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The task is added to the job, and you can now configure the task properties.

4. In the Task Details section, click Browse to select the File to Process.
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You can select any file that you have access to in the Reports Library, or in the Utilities folder of a
file group. The file must already be enabled for file processing in order to be processed using
Scheduler. If you select a file that is not enabled for file processing, the task will display a
configuration error.

5. If you want to process the file using multipass processing, make sure that Process File Multipass
is selected. It is selected by default for most file processing files. However, if you do not want to
perform multipass processing, then you should clear this option.

6. If needed, you can override certain file processing settings defined in the file (including batch
variables), so that the override value is used when the file is processed by Scheduler. In order to
override a setting, select theOverride check box for that setting and then enter the override value
into the field.

In the following example, the file type of the output file has been overridden and changed to PDF
output for the Scheduler execution.
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When overriding values, Scheduler job variables can be used in fields that accept typed input. The
following example shows a Scheduler job variable being used to set the value of a batch variable.

7. Complete any other job or task properties as needed. For example, you may want to configure
the following:

l Scheduling Rules: You can create a scheduling rule to execute the job according to a
predefined schedule.

l Notification: You can edit the notification settings to send emails to designated recipients
when the job executes successfully and/or when it errors.

For the remaining properties, in most cases the default settings are sufficient.
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8. Click Save. You can define a name for the job and save it to the desired location in the Scheduler
Jobs Library.

Once the job is saved, you can run it as needed by clicking Run Once. If the job has a defined scheduling
rule, then it will be automatically placed on the schedule for future execution according to that rule.

File Processing Behavior Notes
This section details how certain features behave during file processing. It is important to understand this
behavior so that you can set up file processing appropriately.

� Refreshing Axiom queries during file processing
When you perform file processing, the file is refreshed before the processing action occurs. If you are
using multipass processing, the file is refreshed for each pass of themultipass operation.

Axiom queries have several different refresh options that dictate when they are refreshed. These options
are configured in the Refresh behavior section for the query on the Control Sheet. The following details
which Axiom queries are refreshed as part of file processing.

l When the file is opened, any queries set to Refresh on file open are run. This occurs before file
processing begins.

NOTE: When performing file processing, the file is not closed and reopened for each pass. If
you open a file and then initiate file processing, the "refresh on open" queries are not run
again because the file is not being opened again. For more information on how file processing
is executed, see Dynamic settings for multipass processing.

l If multipass processing is being performed, then any queries set to Refresh once before
multipass processing are run. This occurs before the file processing begins.

l When the file processing begins, any queries set to Refresh during document processing are run.
If non-multipass processing is performed, then this refresh occurs once, before the file processing
action. If multipass processing is performed, then the refresh occurs for each pass, before the file
processing action is performed for that pass.
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These refresh options are configured independently—multiple options can be enabled for a single query.
So if a query is set to refresh on open and to refresh during document processing, then it will be
refreshed multiple times when the file is processed—once when the file is opened, and then one or more
times during file processing (depending on whether you are performing multipass processing or not). If
you have a query that is set to refresh on open or to refresh beforemultipass processing, and you do not
want that query to run again during processing, then you should disable refresh during document
processing for that query.

NOTE: File processing does not support the ability to run Axiom queries in parallel. If a Batch Number
is specified for an Axiom query, it will be ignored during file processing and the queries will be
processed in sequential order as normal.

� How email is delivered for file processing
When you select to email the output file for file processing, the email operation is handled by Axiom
Budgeting and Performance Reporting Scheduler. This means:

l Email is processed by the SMTP Message Delivery task set up in Scheduler for the current Axiom
Budgeting and Performance Reporting system. This task must be configured to point to a valid
SMTP server and set up to run at regular intervals, or else email will not be delivered.

l The email resulting from file processing will be delivered the next time themessage delivery task is
run by Scheduler.

The email client on the local machine is not used and will not open when file processing is initiated.

When you define the email settings for file processing, you specify whether to send the email as the
Current User (the user initiating the file processing), or as the System User. The system user is the user
defined as the default "From" address for Scheduler, in the system configuration settings for the
database.

You may want to use the system user so that it is clear that the emails are coming from Axiom Budgeting
and Performance Reporting, regardless of which user happens to perform the file processing.

If you use the current user, the email address is the address defined for that user in Axiom Budgeting and
Performance Reporting security.

� Considerations for using file processing in plan files
File processing can be used in plan files. In the plan file environment, the primary use case is standard
(non-multipass) processing, for the purposes of snapshot file delivery.

It is very important to understand that file processing always performs a full refresh of the file, including
refreshing all enabled Axiom queries. If plan files are being used for typical financial planning purposes,
such as budgeting and forecasting, the files may be designed so that after the plan files are initially
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created, the files are not intended to be refreshed again. Or, they may be designed to be refreshed by
administrators at specific intervals, such as after a newmonth of actuals has been imported into the
database.

If your plan files are designed this way, then you should not set up plan files to use file processing,
because the act of file processing will refresh the file and may update data that is intended to remain
static, such as a YTD value.

Plan files are extremely flexible and can be used for many different purposes. With other plan file designs,
it may be perfectly fine to refresh the file periodically. If your plan files are designed to accommodate
ongoing data refreshes, then you can use file processing in those files if desired.

� Considerations for using feature tags with file processing
Axiom Budgeting and Performance Reporting supports several features that are defined using tags in a
sheet. You may want to use some of these features in conjunction with file processing, such as:

l Action codes
l Print views
l Sheet views

When file processing is initiated, Axiom Budgeting and Performance Reporting checks the worksheets for
any instances of the primary tags for these features (for example, the ActionCodes tag or the View tag). If
these tags are not found, Axiom Budgeting and Performance Reporting does not check for them again
during the file processing. This is to optimize the performance of file processing.

This means that primary tags cannot be inserted into the sheet by use of Axiom queries, because Axiom
Budgeting and Performance Reporting will not check for them again after failing to find them initially.
However, once Axiom Budgeting and Performance Reporting has found the primary tags, the system
knows to continue to scan the sheet for tags during file processing, so supporting row and column tags
such as Copy and HideRow can be brought in by Axiom query.

In most cases, primary tags are "hard-coded" into the sheet and do not need to be brought in by Axiom
query. However, if you have a setup where this is required, and you want these features to be applied
during file processing, you can set up "dummy" tags in the file, for the sole purpose of forcing Axiom
Budgeting and Performance Reporting to continue to scan for the "real" tags during file processing.

� Considerations for using refresh variables with file processing
Refresh variables are ignored during file processing and therefore cannot be used to impact file
processing data. However, you may have a report that you want to set up for both end user access ("on-
demand reporting") and for use with file processing. If you use refresh variables in a report that is also
enabled for file processing, you need to be careful to configure the report to handle both use cases.

For example, imagine that you have a refresh variable that prompts the user to select a region. The
Axiom query in the report is then filtered by the user's selected region. If a user runs the report, selects a
region, and then saves the report, that region filter is now saved in the Axiom query settings.
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This isn't an issue for the "on-demand reporting" use case, because the next time a user opens the file
and refreshes it, the refresh dialog will prompt the user to select a region. The previous region will be
selected by default, but the user can still select any region they want at this point. However, the file
processing use case is broken now. The region filter that got saved in the file from use of the refresh
variable will now be applied during file processing. When performing multipass file processing, every pass
of the process will now be filtered by that region filter (in addition to the automatically applied filter for
the current pass).

To prevent this situation, you can use the function IsRunningMultipass to "toggle" the refresh variable
filter on and off depending on whether multipass file processing is being performed. For example, the
data filter for the Axiom query could be defined using a formula like the following:

=IF(IsRunningMultipass()=True,"",Variables!C3)

Where Variables!C3 indicates the location in the file where the result of the refresh variable is used
to construct a filter.

When the file is refreshed by an end user, IsRunningMultipass will return False, so the value in
Variables!C3will be used to define the Axiom query filter. When multipass file processing is being
performed, IsRunningMultipass will return True, which means that the Axiom query filter will be left
blank (thereby ensuring that no additional unintended filter will be appended to the automatic multipass
filter).

NOTE: IsRunningMultipass only returns True for multipass file processing. If you process the file
using non-multipass file processing, then IsRunningMultipass will return False, which in this example
means the refresh variable filter would still be applied. Currently there is no way to toggle between all
three use cases (end user refresh, non-multipass file processing, and multipass file processing).

File Collect
Using the "file collect" feature, you can combinemultipleMicrosoft Excel spreadsheets into a single file,
and then deliver the file.

For example, you might have several reports that are set up to usemultipass file processing to save
snapshot copies to various folders. After running all of those reports, you could use file collect to
combine the various snapshot copies into a single "report package." You can process these packages
with different settings to impact which files are collected and how they are delivered—for example, you
could use a file filter to collect all of the "North" reports into one package, and all of the "West" reports
into another package, and send them to the appropriate department managers.

File collect allows you to:
l Combinemultiple Excel spreadsheets into one output file, and then save that file to a designated

file location and/or deliver it via email to one or more recipients.
l Define "common files" to be automatically added to each package, such as a cover page, or a

supporting document, or a consolidated top-level report.
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l Automatically refresh file lists based on source folder locations, so that the list of files to collect can
be determined dynamically. Source files can also be "hard-coded" as needed.

l Definemultiple packages for processing and/or usemultipass processing to dynamically change
package settings such as the output file name, file filter, and target email recipient.

File collect is a special feature of file processing. Unlike other file processing types, where you are
refreshing sheets in the file with data and then performing actions on those sheets, file collect uses a
special configuration sheet to define the settings of the collect operation. Although the file can contain
other sheets, these sheets are essentially ignored for the file collect operation (unless the configuration
sheet references the other sheets to determine file collect settings). In most cases, the only purpose of
the file is to contain the file collect configuration settings.

When you set up file processing for file collect, you specify the processing type, the sheets to process,
and optional multipass settings. All other file processing settings do not apply to file collect. All file collect
settings aremanaged within the special File Collect Configuration sheet.

Setting up file collect

Using file collect, you can combinemultipleMicrosoft Excel spreadsheets into a single output file and
then save and/or email the file. To set up file collect, you must enable the file for file processing, and then
complete one or more special File Collect Configuration sheets.

� Enabling file collect within a file
It is recommended to use a dedicated report file to hold the file collect settings. Using a report file allows
the file to be scheduled using Scheduler's File Processing task.

1. Open or create a report to contain the file collect settings, and enable the report for file
processing:

l On the Axiom tab, in the File Output group, click File Processing > Enable File Processing
in this workbook.

NOTE: In systems with installed products, this featuremay be located on theMain tab
(either directly on the tab, or on the Publishmenu).

The File Processing task pane opens, and a sheet named Control_FileProcessing is added to the
file.

2. In the File Processing task pane, for Processing Type, select File Collect.
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3. Amessage box prompts you to add a file collect sheet to the file. Click Yes.

A File Collect Configuration sheet, named FileCollect, is added to the file. The File Collect
Configuration sheet is where you define the configuration settings for the file collect option.

4. By default, the newly added FileCollect sheet is automatically set as the Sheets to Process. There is
no need to change this unless you want to rename the sheet or add more File Collect
Configuration sheets.
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5. Optional. If you want to usemultipass processing for the file collect operation, then complete the
MultiPass Settings.
For Source Column, click the column icon to select the source column for multipass processing.
For example, if you select DEPT.VP as the source column, then the file collect operation will be
processed once for each VP. You can use the GetCurrentValue function in the File Collect
Configuration sheet to dynamically change certain settings per pass, such as the email address or
the output file name. Additionally, the file filter can use special syntax to filter the file list based on
a column relating to themultipass column.
For more information, see Using multipass processing with file collect.

6. Define one or more file collect packages on the File Collect Configuration sheet (FileCollect). Each
package column defines a set of files to collect and delivery settings, such as:

l An optional package name, such as "Monthly Report Package".
l Whether to save and/or email the collected files
l A source folder and other related settings to generate a list of files to collect
l Email settings such as the recipient, subject, and body text
l Output file settings such as the file name, file type, and target folder location

For more information on setting up a file collect package, see:
l File Collect Configuration sheet
l Creating and refreshing file lists for file collect
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Example File Collect Configuration sheet

NOTE: On the File Processing Control Sheet (Control_FileProcessing), the only settings that apply to
file collect are the Processing Type, the Sheets to Process, and themultipass settings. All information
relating to the file collect packages, including the output file and email details, are defined on the File
Collect Configuration sheet instead of the File Processing Control Sheet.
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� Using multiple File Collect Configuration sheets
If desired, you can add multiple File Collect Configuration sheets to the file, and process them in the
same operation.

l To add more File Collect Configuration sheets to the file: In the Actions section of the File
Processing task pane, click Add new file collect sheet. If you are using multiple File Collect
Configuration sheets, it is recommended to rename the sheets to something that indicates the
purpose of each sheet.

l To process multiple File Collect Configuration sheets: In the File Processing Settings section of the
File Processing task pane, click the Select worksheets icon to the right of the Sheets to
Process box, and then select the desired sheets. Only File Collect Configuration sheets are eligible
for processing.

However, since there aremany different options to process different file collect packages, it is typically
not necessary to usemultiple sheets. You can definemultiple packages in a single sheet (all using

Administrator's Guide Axiom Budgeting and Performance Reporting │ 929



different settings), and/or you can process the sheet using multipass to dynamically change key settings
for each pass. You can also process the same sheet using different multipass settings by use of batch
processing and batch variables.

One reason you might add a new File Collect Configuration sheet is if you need to make changes to the
existing sheet, or if you need to get an updated copy of the File Collect Configuration sheet. You can add
a new sheet to the file, copy and update the existing file collect settings from the old sheet to the new
one, and then update the file processing settings to use the new sheet. You can then keep the old sheet
as an archive or remove it if you no longer need it.

File Collect Configuration sheet

The File Collect Configuration sheet defines settings for the File Collect action of file processing.
l The first column of the sheet, titled Common Files, can be used to maintain a list of common files

to be automatically added to each package when file collect is processed.

l Each subsequent column in the sheet can be used to define a file collect package. By default, the
sheet contains one package column. In many cases, you can meet your file collect and delivery
needs by defining one package column with dynamic settings and then processing that column
using multipass processing. However, if you need more package columns, you can add them by
using the Add additional package columns action in the File Processing task pane.

File Collect Configuration sheets can only be added to a file that is enabled for file processing and where
File Collect has been specified as the processing type. When you initially select the processing type, you
will be prompted to add a configuration sheet to the file. You can add more configuration sheets to the
file by using the Add new file collect sheet action in the File Processing pane.

The File Collect Configuration sheet is only visible to administrators or to users with the Allow File
Processing permission to the file. Otherwise, it is hidden by default.

� General Settings
The following general settings are defined for each package:

Item Description

Package name Optional. The name for the file collect package, such as "Monthly Report
Package".

Active Specifies whether the package is included when the file is processed. By default,
this is set to Off. Change this to On if you want the package to be included in
processing.

This setting can be used to dynamically enable or disable certain packages
based on a condition. For example, you may have certain packages that you run
monthly and others that you run quarterly. You could define these packages in
different files and run the files at different times, or you could define them in the
same file and disable the packages that you do not need to run currently.
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� Email Settings
These settings only apply if Save or email generated files is set to Email File or Save File and Send
Email.

Item Description

Email to list The email addresses to include on the To line of the email. Separatemultiple
addresses with a semicolon.

When performing multipass processing, this setting should be determined
dynamically so that the results of each pass are emailed to a different recipient.
For example, if the email addresses are stored in a table column, you can use
the GetCurrentValue function to return an email address relating to the current
pass.

Email CC list The email addresses to include on the CC line of the email. Separatemultiple
addresses with a semicolon.

Email from The email address to include on the From line of the email.

Subject text The subject line of the email.

When performing multipass processing, you can optionally use formulas such
as GetCurrentValue to dynamically change the subject text for each pass.

Body text The body text of the email.

When performing multipass processing, you can optionally use formulas such
as GetCurrentValue to dynamically change the body text for each pass.

Message priority The priority of themessage, eitherNormal (default) or Urgent.

Attach file to
email

Specifies whether the output file is attached to the email. By default, this option
is set to On. You can set this option to Off to exclude the output file from the
email.

For example, you might want to save the file to a network location and then
send an email to recipients to let them know the file is available for viewing,
without attaching the file to the email.
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Item Description

Attach each file
separately (don't
combine them
into one)

Specifies whether to attach the individual files from the file list to the email
directly. By default, this is set to Off, which means that "normal" file collect
processing applies—the files in the file list are collected into a single output file,
and that single file is attached to the email.

If this option is set to On, then the files in the file list are attached to the email as
individual files instead of being collected into a single output file. This option is
useful when there is not a one-to-one correlation between the desired email
recipients and the package output.

For example, imagine that you need to generate one report package per region
and then deliver those packages to the appropriate VPs. If each region has a
unique VP, then this can easily be done in one file collect operation. But if some
VPs are responsible for multiple regions, then normal file collect processing will
result in the VPs getting multiple emails (one for each region). If instead you
want those VPs to get one email with multiple region attachments, then you
can perform file collect processing in two phases:
l Phase one to collect and create the report packages for each region, and

save them to a file location.
l Phase two to attach the relevant region packages to an email for each VP. In

this phase, Attach each file separately is enabled, so that all files in the file
list are attached as individual files rather than being collected together.

For a detailed example of using this feature, see Two-phase file collect example.

NOTE: In order to use this option, Save or email generated filesmust be set to
Email File. This option is ignored otherwise.

� Source Folder Settings
In order to automatically generate the file list for a package, you must specify one or more source
folders. By default, each package has settings for two source folders. If you need more source folders,
use the Add new source folder section action in the File Processing pane.

Source folders are only used when Refresh file list is set to On.
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Item Description

File source Specifies the location of the source folder or folders:
l Local File System: The source folders are located outside of Axiom

Budgeting and Performance Reporting—on a shared network drive or on
your local machine.

l Axiom Repository: The source folders are located in the Axiom Budgeting
and Performance Reporting file system, within the Reports Library.

This setting applies to all source folders for this package.

Source folder
path

The path to the desired source folder. This folder contains the source files that
you want to include in the file collect operation. What you enter here depends
on the file source.

Local File System
The path should be entered as a UNC path. For example:
\\ServerName\Reports\MonthlyReports

If you use a folder on your local drive, it will only be valid when running file
processing interactively from your own computer. If you want to process this
file using Scheduler, the output folder should be a shared network drive.

If your system is a Cloud Service system, then you must also specify a Remote
Data Connection Name in order to collect files from a local location.

Axiom Repository
Specify the full path to the folder within the Reports Library. For example:
\Axiom\Reports Library\File_Processing

To browse to the desired location, right-click this cell and select Select Reports
Library Folder. In the Choose Folder dialog, select the desired folder and then
click OK.
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Item Description

File filter list Optional. File filter(s) to specify which files in the source folder to add to the file
list.

Only Excel files can be collected (XLS, XLSX, or XLSM). If the filter is left blank,
then Axiom Budgeting and Performance Reporting will include all valid files in
the folder.

You can use wildcard characters (* or ?) to include groups of files that share
naming conventions. For example: North*.xls to collect all XLS files where the
file name starts with "North". You can also exclude files using the ! operator—
such as !*Branch* to exclude all files that contain the word "Branch". If only
exclusion filters are used, then it is assumed that all files are included except
those that match the exclusion filters. If inclusion filters are used, then only the
files that match the inclusion filters are included (minus any files that also match
any exclusion filters).

Separatemultiple filters with commas. For example, the following filter would
include XLS files and XLSX files, but exclude XLSM files: *.xls, *.xlsx

(Multipass only)
Filter template

Optional. A filter template to apply during multipass processing, to specify
which files in the source folder to add to the file list.

The filter template serves the same purpose as the File filter list, but it can
change dynamically during multipass processing by using a column value. For
example, imagine that the source folder contains files where the file name starts
with a department code. If you aremultipass processing by Dept.VP, you want
to collect all files where the department is assigned to that VP.

To do this, you can set a filter template such as {Dept.Dept}*.xlsx. When
multipass processing is performed, the {Dept.Dept} portion of the filter is
resolved using the department codes that belong to the current pass VP. If
departments 200, 300, and 600 belong to the current pass VP, then the filter list
will be resolved as:

200*.xlsx, 300*.xlsx, 600*.xlsx

The filter template can use any Table.Column that can be resolved in the
context of themultipass Source Column. The Table.Column namemust be
placed in curly brackets, such as {Dept.Dept} or {Dept.VP}.

If the File filter list and the Filter template are both defined, then the file filter
list is combined with the resolved filter template for each pass.

The filter template only applies when performing multipass processing. When
performing non-multipass processing, or when manually refreshing file lists, it is
ignored.
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� Output File Settings
These settings define the output file to be created for the package. The output file is the file that contains
the collected results of the source files.

Item Description

Output location The location for the output file, either:
l Local File System (default): The output location is outside of Axiom, to either

your local computer or a network share. The specific path is detailed in the
Output Folder setting. Access to output files is not controlled by Axiom
Budgeting and Performance Reporting.

l Axiom Repository: The output location is the Axiom file system, within the
Reports Library. The specific path is detailed in theOutput Folder setting.
Access to output files is controlled by security access to the designated
folder within Axiom.

Output file purge
setting

Specifies whether and when the output file will be automatically purged by
Axiom Budgeting and Performance Reporting. This only applies if the output file
is saved to the Axiom Repository.

If blank, then the output file is not purged. Otherwise, specify either of the
following:
l A date, to delete the output file after that date. For example, specify
12/10/2020 (or the appropriate date format for your locale) to delete the
output file after that date is passed.

l A number representing the number of days to keep the output file after it is
generated. For example, specify 20 to keep the output for 20 days and then
delete it.

The file deletion is performed by the System Data Purge job in Scheduler.
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Item Description

Output folder
path

The folder location in which to save the output file. This setting only applies if
Save or Email Generated Files is set to Save File or Save File and Send Email.

Local File System
The path should be entered as a UNC path. For example:
\\ServerName\Reports\ReportPackages

If you use a folder on your local drive, it will only be valid when running file
processing interactively from your own computer. If you want to process this
file using Scheduler, the output folder should be a shared network drive.

The ability to save the output file to the specified location and to create a new
folder (if necessary) depends on the network permissions for the user
processing file collect. Access to the file after it is created is also dependent your
network permissions. If your system is on the Axiom Cloud, then you must also
specify a Remote Data Connection Name in order to save the output file to a
local location.

Axiom Repository
The specified location in the Axiom file system must be within the Reports
Library, and the location must use the full path (meaning: \Axiom\Reports
Library\...). To browse to the desired location, right-click this cell and select
Select Reports Library Folder. In the Choose Folder dialog, select the desired
folder and then click OK.

The ability to save the output file to the specified location and to create a new
folder (if necessary) depends on the Axiom Budgeting and Performance
Reporting security permissions for the user processing file collect. Users can
only create a new folder if they have read/write permissions to the parent
folder, and they can only create a new file if they have read/write permissions to
the target folder.

Once the file is created within the Axiom file system, access to the output file is
dependent on the user's permissions to the output folder. Typically you should
create the output folder in advance (or if you want to create output folders on-
the-fly, create a parent folder to hold the output folders), and then set
permissions for that folder as appropriate in Axiom Budgeting and Performance
Reporting security, so that the appropriate users will be able to access the file
after it is created.
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Item Description

Remote Data
Connection
Name

Specifies the name of the remote data connection to use for the file collect
operation. Enter the name of any defined remote data connection in your
system. This option only applies to Axiom Cloud systems.

A remote data connection is required to save files locally from the Axiom Cloud,
or to collect files stored on a local file system. For more information, see the
section on remote data connections in the Scheduler Guide.

By default, this setting uses the function GetSystemInfo
("DefaultRemoteDataConnection"), so that the field is automatically populated
with the name of your default remote data connection. If you do not have any
remote data connections, the field is blank. If you want to use a different
remote data connection, you can simply delete the function and enter the
desired name.

Output file name The name of the output file, without a file extension. For example, enter
"MonthlyReports" (not "MonthlyReports.xlsx").

When performing multipass processing and saving files, this setting should be
determined dynamically so that each pass results in a unique output file name
(or alternatively, a unique output folder path). For example, if you aremultipass
processing by VP, you can use the GetCurrentValue function to include the
current VP name in the output file name.

Output file type The file type of the output file: XLS, XLSX, XLSM, or PDF.

Save or email
generated files

Specifies the action to take after the output file has been created:
l Save File: The output file is saved to the output folder path.
l Email File: The output file is emailed to the specified recipients.
l Save File and Send Email: The output file is saved and emailed.

NOTES:
l If you want to save the file to a folder and then send a notification email to

recipients (without attaching the file to the email), then select Save File and
Send Email. In the email settings, set Attach file to email to Off.

l If you want to use the Attach each file separately option, then select Email
File.

� File List Settings
These settings impact the file list for the package.
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Item Description

Auto-generate
file list

Specifies whether the file list for the package is automatically generated:
l IfOn (default), then the file list is automatically generated based on the

source folder settings defined for the package. The auto-generation occurs
when the file lists are refreshed manually, and whenever file collect is
processed. Any existing content in the file list is cleared when the list is auto-
generated.

l IfOff, then the file list is not automatically-generated. Only the files that are
currently listed in the column will be included when processed.

Continue on
error

Specifies whether the file collect process will continue or cancel if an error
relating to the file list occurs—for example, if a listed file is missing or if the file
list is empty.
l IfOn, then errors will be ignored and the file collect process will continue.

Errors will be listed in the confirmation dialog shown at the end of the
process.

l IfOff (default), then any errors will cancel the process.

This setting should be set to On if you want packages to be created even if some
or all of the source files cannot be found.

Include common
files in package

Specifies whether common files are included in the package:
l IfOn (default), then when file collect is processed, any files listed in the

Common Files column will be added to the beginning of the package. If the
Common Files column uses auto-generation to create its file list, that auto-
generation will occur before any of the packages are processed.

l IfOff, then common files are ignored and will not be added to the package.

� File List
The file list section contains the list of source files to be collected within the output file. This list can be
generated automatically (using the source folder settings), or it can be created manually. For more
information, see Creating and refreshing file lists for file collect.

When file collect processes the file list and collects the contents of each file into the output file, it takes a
snapshot of each file. The result of each snapshot is the same as if you had manually snapshot the file
and selected to Retain Excel Native Formulas while including All Sheets in File. The snapshot version of
the file is what gets included in the output file.

NOTE: IfAttach each file separately is enabled, then the files in the file list are not transformed in
any way. The files are simply attached to the email as is.
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Creating and refreshing file lists for file collect

When you create a file collect package, you specify the source files to be combined into the output file.
The list of source files for a package can be created in the following ways:

l You can automatically generate the list of files, given a source folder and optional file filter. When
you refresh the file list, Axiom Budgeting and Performance Reporting checks the source folder,
finds all of the files that match the file filter, and then creates the list of files to collect. Each file
collect package can havemultiple source folders.

l You can manually type file names and folder paths, to create a fixed list of files.

In addition to the file lists for each defined package, you can specify "common files" that are
automatically added to the beginning of each package. For example, if you have a cover sheet or a
supporting document that you want added to each package, you can define these as common files. The
list of common files can be generated in the sameway as for packages—dynamically generated from a
source folder, or manually typed.

� Setting up source folders to automatically generate file lists
Each package has a Source Folder Settings section that can be used to specify source folders to
automatically generate file lists. By default, the File Collect Configuration sheet contains settings for two
source folders per package. If you need more source folders, click Add new source folder section in the
Actions area of the File Processing pane.

Complete the following settings to define a source folder:

Item Description

File source Specifies the location of the source folder or folders:
l Local File System: The source folders are located outside of Axiom

Budgeting and Performance Reporting—on a shared network drive or on
your local machine.

l Axiom Repository: The source folders are located in the Axiom Budgeting
and Performance Reporting file system, within the Reports Library.

This setting applies to all source folders for this package.
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Item Description

Source folder
path

The path to the desired source folder. This folder contains the source files that
you want to include in the file collect operation. What you enter here depends
on the file source.

Local File System
The path should be entered as a UNC path. For example:
\\ServerName\Reports\MonthlyReports

If you use a folder on your local drive, it will only be valid when running file
processing interactively from your own computer. If you want to process this
file using Scheduler, the output folder should be a shared network drive.

If your system is a Cloud Service system, then you must also specify a Remote
Data Connection Name in order to collect files from a local location.

Axiom Repository
Specify the full path to the folder within the Reports Library. For example:
\Axiom\Reports Library\File_Processing

To browse to the desired location, right-click this cell and select Select Reports
Library Folder. In the Choose Folder dialog, select the desired folder and then
click OK.

File filter list Optional. File filter(s) to specify which files in the source folder to add to the file
list.

Only Excel files can be collected (XLS, XLSX, or XLSM). If the filter is left blank,
then Axiom Budgeting and Performance Reporting will include all valid files in
the folder.

You can use wildcard characters (* or ?) to include groups of files that share
naming conventions. For example: North*.xls to collect all XLS files where the
file name starts with "North". You can also exclude files using the ! operator—
such as !*Branch* to exclude all files that contain the word "Branch". If only
exclusion filters are used, then it is assumed that all files are included except
those that match the exclusion filters. If inclusion filters are used, then only the
files that match the inclusion filters are included (minus any files that also match
any exclusion filters).

Separatemultiple filters with commas. For example, the following filter would
include XLS files and XLSX files, but exclude XLSM files: *.xls, *.xlsx
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Item Description

(Multipass only)
Filter template

Optional. A filter template to apply during multipass processing, to specify
which files in the source folder to add to the file list.

The filter template serves the same purpose as the File filter list, but it can
change dynamically during multipass processing by using a column value. For
example, imagine that the source folder contains files where the file name starts
with a department code. If you aremultipass processing by Dept.VP, you want
to collect all files where the department is assigned to that VP.

To do this, you can set a filter template such as {Dept.Dept}*.xlsx. When
multipass processing is performed, the {Dept.Dept} portion of the filter is
resolved using the department codes that belong to the current pass VP. If
departments 200, 300, and 600 belong to the current pass VP, then the filter list
will be resolved as:

200*.xlsx, 300*.xlsx, 600*.xlsx

The filter template can use any Table.Column that can be resolved in the
context of themultipass Source Column. The Table.Column namemust be
placed in curly brackets, such as {Dept.Dept} or {Dept.VP}.

If the File filter list and the Filter template are both defined, then the file filter
list is combined with the resolved filter template for each pass.

The filter template only applies when performing multipass processing. When
performing non-multipass processing, or when manually refreshing file lists, it is
ignored.

When the file list is refreshed, Axiom Budgeting and Performance Reporting checks each source folder,
finds all of the valid files that match the filter (if defined), and then creates the list of files to collect
(overwriting anything that is listed there currently). The files will be listed in alphabetical order per source
folder. There is no way to specify an alternate file order when auto-generating the file list.

� Manually defining source files
If desired, you can manually define source files for a file collect package. To do this, go to the File List
section for the package and type in each source file to be collected. If you do this, make sure to set Auto-
generate file list to Off, so that file collect processing will not overwrite your manual list.

If the File Source is Local File System, then you can enter the source files using the full path and file name,
or you can enter a folder path followed by one or more file names. For example:

\\server\folder\myfile.xlsx
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or
\\server\folder

myfile1.xlsx

myfile2.xlsx

However, if the File Source is Axiom Repository, then you must use the second approach of a folder path
followed by one or more file names. Full paths and file names on the same line will not be recognized.

Each entry in the list must resolve to a valid path and file name. Wildcard characters cannot be used in
this list—if you want to include files by using wildcards, then you must automatically generate the list
using source folders. Only Excel files (XLS, XLSX, or XLSM) can be listed here—if other file types are listed,
an error will result when file collect is processed.

If a folder path is listed without any subsequent file names, then that folder path will be ignored as long
as the package has other valid files to include.

When using a manual list of source files, the order of the files is honored during file collect processing.

� Using common files
Using the "common files" feature, you can specify one or more files to automatically add to the
beginning of each package when file collect is processed.

l The common files are defined in the first column of the File Collect Configuration sheet. If you do
not want to use common files, then you can simply ignore this column.

l You can specify the list of common files just like you would for a regular file collect package. You
can define one or more source folders to automatically generate the file list, or you can manually
type the file list.

l By default, the common files are added to all packages in the sheet when file collect is processed. If
you have a package that you do not want to add the common files to, you can disable common
files for that package by setting Include common files in package to Off.

l When file collect is processed, the common file list is refreshed first (ifAuto-generate file list is
On), before any of the packages are processed.

NOTE: If the file list for a package is blank, but common files have been defined, then the package will
be created and only the common files will be added. However, if the file list for a package is blank and
no common files are defined, then a file collect error occurs and processing stops (unless Continue
On Error is enabled, in which case the package is skipped).

The following screenshot shows an example File Collect Configuration sheet using common files. When
this package is processed, the output file will first collect CoverSheet.xlsx from the Common Files column,
then collect the files in theMonthly Reporting Package column.
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� Refreshing file lists
When file collect processing is performed, the file lists are automatically refreshed for any package
column (and common files) where Auto-generate file list is set to On. When a file list is refreshed, the
following occurs:

l Any existing content in the list is cleared.
l The file list is updated with files from the designated source folders for the package, limited by any

file filter.

You can also refresh file lists manually using the File Processing task pane. Generally speaking, there are
two reasons to do this:

l For testing purposes, to help verify that you have set the source folder and file filters correctly.

l To generate an initial list of files that you plan to convert to a manual list. You can refresh the file
list, then disable Auto-generate file list, then make further manual updates to the file list.

NOTE: If you intend to usemultipass processing and have defined a multipass filter template, the
filter template is not applied when refreshing file lists manually. It cannot be applied because it has
no current pass value to resolve any columns referenced in the template.

To manually refresh file lists:
l Click Refresh file lists to refresh all lists in the workbook.
l Click Refresh file lists in selected column(s) to refresh only selected columns. You must select

one or more package columns in a File Collect Configuration sheet (or place your cursor in a single
package column) before performing this action. Note that the common files list will be refreshed
along with the selected columns.

Processing file collect

When you process file collect, Axiom Budgeting and Performance Reporting creates all active packages in
the specified sheets to process. IfAuto-generate file list is set to On for a package, then the file list is
refreshed before processing occurs.
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This topic discusses how to process file collect within the file itself. You can also process file collect as part
of a File Processing Scheduler task. For more information, see Using Scheduler to perform file collect.

To process file collect:
1. Open the file that you want to process. The file must already be set up for file collect and at least

one packagemust be active.

2. In the File Processing task pane, in the Actions section, click one of the following options to start
processing:

l Process File: File collect processing is performed without multipass settings. All enabled
package columns are processed once.

l Process File Multipass: File collect processing is performed multiple times, with a unique
value applied to each pass. For example, if the file is set up to process by DEPT.VP, then file
collect processing is performed once per VP. The function GetCurrentValue and the
multipass filter template are resolved using values relating to the current pass VP. All
enabled package columns are processed per pass.

TIP: You can also process the file using the File Processingmenu on the Axiom tab. (In
systems with installed products, this featuremay be located on theMain tab.)

All active packages in the specified sheets to process are created. When the process is complete, a
confirmation message displays information about the created output files.

When file collect processes the file list and collects the contents of each file into the output file, it takes a
snapshot of each file. The result of each snapshot is the same as if you had manually snapshot the file
and selected to Retain Excel Native Formulas while including All Sheets in File. The snapshot version of
the file is what gets included in the output file.

NOTE: IfAttach each file separately is enabled, then the files in the file list are not transformed in
any way. The files are simply attached to the email as is.

Using multipass processing with file collect

File collect can usemultipass processing to iteratively generate report packages over a designated
dimension, such as by Facility, Region, or VP. This can streamline the setup and maintenance necessary
to perform file collect. Instead of needing to definemultiple file collect packages for different recipients, in
many cases you can define one file collect package and usemultipass processing to dynamically adjust
the package settings per pass.

For example, imagine that your organization has six regions and you want to create and deliver a report
package for each region. When using non-multipass processing, this requires you to define six different
package columns in the File Collect Configuration Sheet—one for each region. Each package column
needs to use different settings such as email addresses, output file names and/or locations, and file
filters in order to generate a unique report package for each region.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 944



When using multipass processing, you can define just one package column in the File Collect
Configuration sheet. If the source column for multipass processing is Region, then this single package
column will be evaluated six times, using a different region for each pass. Assuming that the package
column uses dynamic settings, then each pass in multipass processing is resolved differently to generate
a unique report package for each region. The function GetCurrentValue can be used in the file collect
settings to dynamically return information about the current pass, and a special multipass filter template
can be used to dynamically generate the list of files to collect.

� Multipass settings
The easiest way to definemultipass settings is to designate a Source Column. In this example, the source
column is Dept.Region. When multipass processing is performed, the File Collect Configuration sheet will
be iteratively processed over the values in the designated column (once per region). All enabled package
columns will be processed once per pass.

This works in a similar manner as normal multipass processing, but the goal is slightly different. For
example, when performing snapshot multipass processing on a report, you are filtering the report data
per pass. When performing multipass processing for file collect, the goal is not to filter report data but
simply to dynamically change the package settings per pass.

To confirm that the file will be processed using your desired list of items, click Preview Multipass List. A
dialog opens, displaying the total number of items to process, as well as the list of individual items.
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If you need to configure advanced multipass settings, you can click Show Advanced View to expose the
advanced settings. For example, you may want to define a Source Filter to limit the list of items. For
more information, see Configuring advanced multipass settings.

� Using GetCurrentValue in file collect settings
You can use the GetCurrentValue function in various file collect settings to dynamically change the
settings per pass. Themost common use case is in the output file name and/or folder path, and in the
email settings to determine the recipient's email address. You might also use the function in the source
folder path, if the source files for each path were saved to unique folder locations.

The two most common ways to use the GetCurrentValue function are as follows:
l The syntax GetCurrentValue() returns the name of the current pass value. If you aremultipass

processing by Dept.Region, and the current pass is for region US West, the function returns "US
West".
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l The syntax GetCurrentValue("ColumnName") returns the value in that column for the current
pass. For example, the column Dept.Region looks up to the Region table, and the Region table
contains a column named Reporting that holds the target user to receive the report package for
each region. If the current pass is for region US West, the function GetCurrentValue
("Dept.Region.Reporting") returns the name of the user to receive the report package for
that region.

In order for GetCurrentValue to return a value for a particular column, that column must be used
in themultipass settings, typically as a secondary source column. To add more source columns,
you can use the advanced multipass settings in the File Processing task pane, or you can go to the
File Processing Control Sheet (Control_FileProcessing) and add the additional source columns to
themultipass section at the top of the sheet. When editing the File Processing Control Sheet
directly, you can also specify default values that the GetCurrentValue function will return when
multipass processing is not occurring.

For more information, see GetCurrentValue function and Returning related values for each pass.

NOTE: It is not possible to use the file processing variables such as [Current_Value] in the File
Collect Configuration Sheet. File processing variables are only valid for use in the File Processing
Control Sheet.

Output file name and/or folder
The following example shows GetCurrentValue being used to set the output file name, so that the file
name changes for each pass. For example, when the pass is performed for region "US West", the name of
the file will be resolved as "US West_MonthlyReportPackage". The function returns "Consolidated" when
multipass processing is not occurring, because that is the current value default set on the File Processing
Control Sheet (as seen on the previous screenshot).

The same concept could be used to change the output folder path per pass, if desired.
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Email recipients
The following example shows GetCurrentValue being used to return the name of the user who should
receive the report package for each region. In this example, the column Dept.Region looks up to the
Region table, and the Region table contains a column named Reporting that holds the target user. If the
current pass is for region US West, the function GetCurrentValue("Dept.Region.Reporting") returns the
name of the user to receive the report package for that region. The GetUserInfo function is then used to
look up the user's email address from security.

The GetCurrentValue function returns user "jdoe" when multipass processing is not occurring, because
that is the current value default set on the File Processing Control Sheet.

If the target email addresses were stored in the table directly (instead of looking them up from security),
then GetCurrentValue could be used on its own to return the email address.

� Using a file filter template
When performing multipass processing with file collect, you can use the (Multipass only) Filter
template setting to dynamically filter the files to collect per pass. Although you could use
GetCurrentValue in the file filter, themultipass filter template is a more flexible option to set the file filter
for multipass processing. Themultipass filter template can use a table.column name that will be resolved
during each pass to dynamically set the file filter.

For example, imagine that you are performing multipass file collect processing by region, and you want
to collect all files that contain a department code that belongs to the current region. Using
GetCurrentValue doesn't work in this case, because there aremultiple departments per region, and
GetCurrentValue("Dept.Dept") would only return one of these values (themax department). Instead you
can set a file filter template using {Dept.Dept}, and a filter will be created for each department value
that belongs to the region. For example:

If departments 200, 300, and 600 all belong to the current pass region, then this file filter template will
create the following filter:
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200*.xlsx, 300*.xlsx, 600*.xlsx

All xlsx files that start with these values will be collected into the report package.

Using Scheduler to perform file collect

You can use Scheduler to run one or more reports, collect the results into report packages, and then
save and/or email the packages.

In themajority of cases, this is accomplished by creating a single batch report, and then running that
report using a File Processing task in Scheduler. The batch report lists each report to process, and then
the last report in the list would be the file collect report. For more information on setting up a report for
batch processing, see Batch Processing.

However, theremay be times when you want the file collection to be a separate operation, not included
within a batch report. For example, you may have decided to create a "batch" of reports by using
multiple File Processing tasks in a Scheduler job, instead of using one batch report. In this case, there are
two ways that you can perform file collect using Scheduler:

l You can create another File Processing task in the Scheduler job, and use it to process the file
collect report.

l You can use the Collect Worksheets Scheduler task. This is a special task that is only available
within Scheduler.

The basic file collect functionality is the same for both options. However, the file processing option has
more robust features, and offers some additional setup advantages. For example, when using file
processing to perform file collect, you can:

l Use additional features such as multipass processing, common files, email priority, email CC list,
and the ability to send a notification email without attaching the file. You can also pull source files
from the Axiom file system, and save the output file to the Axiom file system.

l Create settings and file lists using a spreadsheet interface. This allows use of formulas to complete
settings, and may be a preferable user experience for some users.

On the other hand, the Scheduler task has fewer settings and thereforemay be simpler to set up for
smaller, on-the-fly jobs. Additionally, because all of the file collect settings are defined within Scheduler
instead of a source file, you can use Scheduler job variables.

NOTE: When using file processing to perform file collect, you will not be able to override any file
collect settings in the Scheduler task because they are defined in the special File Collect Configuration
sheet, not in the File Processing Control Sheet. The only setting that you can override is the sheets to
process. Alternatively, you may be able to use batch variables to "override" certain settings if
necessary.
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File collect examples

The following examples are intended to show common file collect configurations. These examples use
batch processing to generate snapshots and then collect the snapshots into report packages. The
second example also uses the "attach files separately" option to email collected files at a different level
than the file collect operation.

� Simple file collect example
This example does the following:

l Snapshot file processing on three different reports, using multipass to generate snapshots per
region

l File collect processing to collect the region snapshots into a report package, and email the package
to the region owner

The batch file lists the three snapshot reports, then the file collect report at the end.

Batch file to create snapshots and then collect them into packages

The first three reports are set up using standard snapshot processing, to process each report by VP and
then create a snapshot. The snapshot output files are prefixed with the VP name and saved to a
designated output folder. The following screenshot shows an example of the snapshot settings.
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Snapshot settings to generate reports by VP

After the first three reports in the batch are processed, the folder containing the snapshot output files
looks something like the following screenshot. There are three snapshot reports for each VP. The file
collect report will collect the three reports into a report package for each VP.
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Output files after running the three snapshot reports using multipass processing

In this example, the file collect setup is fairly straightforward, because the goal is to create one report
package for each VP and deliver that package to the VP. In the File Processing task pane, the process is
configured for multipass processing by Dept.VP.

Multipass settings for the file collect operation

The File Collect Configuration Sheet is set up as follows:
l The Common Files column is used to start each report package with a cover sheet.

l The GetCurrentValue function is used in the Email to field, to dynamically change the email for
each pass. In this example, the target email addresses for each VP are being held in a table
column, so we can use GetCurrentValue ("Dept.VP.Email") to return the relevant email
address.
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l A (Multipass only) Filter template of {Dept.VP}*.xlsx is used to dynamically filter the file list
to only return the snapshots that start with the current VP name. For example, when the current
VP is Bree Sigman, the filter template is resolved as Bree Sigman*.xlsx, which will collect the
first three files in the example snapshot folder shown previously.

l The GetCurrentValue function is used in the output file name, to prefix the name of the resulting
report package with the VP name.

File Collect Configuration sheet to create and deliver the report packages to VPs

Administrator's Guide Axiom Budgeting and Performance Reporting │ 953



Note the following about this example File Collect Configuration Sheet:
l The file list currently shows all files in the source folder path, because themultipass filter template

is only applied during multipass processing. If you refresh the list manually as shown here, the
filter template is ignored. Unfortunately there is no way to preview the resulting file lists when
using the filter template.

l The GetCurrentValue functions currently return information for user jdoe, because that is what is
set as the Current Value Defaults for the source columns on the File Processing Control Sheet.
When multipass processing is performed, the functions will return the values relating to the
current pass VP. It can be useful to set current value defaults so that the functions do not return
errors when multipass processing is not being performed.

When the file collect report is processed at the end of the batch, it creates the report packages for each
VP. The cover page and the three report snapshots for each VP have been placed in the output files.

Output files after running file collect

Additionally, each report package has been emailed to the appropriate VP:
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Email to VP after running file collect

� Two-phase file collect example
This example is similar to the first example, except that nowwewant to create the file collect packages at
a different level than the email recipients. To do this, we need to use a two-phase file collect operation,
where the first file collect phase creates the report packages, and the second file collect phase attaches
multiple individual report packages into emails. This example does the following:

l Snapshot file processing on three different reports, using multipass to generate snapshots per
department

l File collect processing to collect the department snapshots into a report package by region
l File collect processing to email the region snapshots to the appropriate VPs, where some VPs are

responsible for multiple regions

The batch file lists the three snapshot reports, then two file collect reports at the end.

Batch file to create snapshots, then collect snapshots into region packages, then email the packages to VPs

The first three reports are set up using standard snapshot processing, to process each report by
department (Dept) and then create a snapshot. The snapshot output files are prefixed with the
department code and saved to a designated output folder. The following screenshot shows an example
of the snapshot settings.
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Snapshot settings to generate reports by department

After the first three reports in the batch are processed, the folder containing the snapshot output files
looks something like the following screenshot. There are three snapshot reports for each department.
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Output files after running the three snapshot reports using multipass processing

The first file collect report (phase 1) will collect the department reports into a report package per region.
In the File Processing task pane, the process is configured for multipass processing by Dept.Region.

Multipass settings for the phase 1 file collect operation, to create region packages

For phase 1, the File Collect Configuration Sheet is set up as follows:
l The Common Files column is used to start each report package with a cover sheet.

l There are no email settings configured, because phase 1 just creates the report package files.
Phase 2 emails them.
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l A (Multipass only) Filter template of {Dept.Dept}*.xlsx is used to dynamically filter the file
list to only return the snapshots that start with the department codes for the current region. For
example, when the current region is US West, the filter template will be resolved using department
codes such as 40000*.xlsx, 40500*.xlsx, 44000*.xlsx (and so on, depending on which department
codes belong to the current region).

l The GetCurrentValue function is used in the output file name, to prefix the name of the resulting
report package with the region name.

File Collect Configuration sheet to create the region report packages
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Note the following about this example File Collect Configuration Sheet:
l The file list currently shows all files in the source folder path, because themultipass filter template

is only applied during multipass processing. If you refresh the list manually as shown here, the
filter template is ignored. Unfortunately there is no way to preview the resulting file lists when
using the filter template.

l The GetCurrentValue functions currently return information for region Corporate, because that is
what is set as the Current Value Defaults for the source column on the File Processing Control
Sheet. When multipass processing is performed, the functions will return the values relating to the
current pass region. It can be useful to set current value defaults so that the functions do not
return errors when multipass processing is not being performed.

When the phase 1 file collect report is processed at the end of the batch, it creates the report packages
for each region. The cover page and the report snapshots for all departments in the region have been
placed in the output files.

Output files after running file collect

The second file collect report (phase 2) will send an email to each VP and attach the appropriate region
files to the email, where some VPs are responsible for multiple regions. In the file processing task pane,
the process is configured for multipass processing by Dept.VP.
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Multipass settings for the phase 2 file collect operation, to email packages to VPs

An email could have been sent as part of the phase 1 file collect, but in that case there would be one
email per region, so some VPs would have received multiple emails. If you want to consolidate the emails
in cases where there is not a one-to-one correlation between the output files and the email recipients,
you can use this two-phase collect approach instead.

For phase 2, the File Collect Configuration Sheet is set up as follows:
l The GetCurrentValue function is used in the Email to field, to dynamically change the email for

each pass. In this example, the target email addresses for each VP are being held in a table
column, so we can use GetCurrentValue ("Dept.VP.Email") to return the relevant email
address.

l The option Attach each file separately is enabled, so that the files in the file list will be attached to
the email as individual files, rather than being collected into an output file. This option is only valid
when Save or email generated files is set to Email File.

l A (Multipass only) Filter template of {Dept.Region}*.xlsx is used to dynamically filter the
file list to only return the files that start with the region names for the current VP. For example,
when the current region is Bree Sigman, the filter template will be resolved using region names
such as France*.xlsx, UK*.xlsx (and so on, depending on which regions belong to the current VP).

l The output file settings are blank, because no output file is being generated in this phase. The files
in the file list are being attached to the email directly.
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File Collect Configuration sheet to email the region report packages to VPs

Note the following about this example File Collect Configuration Sheet:
l The file list currently shows all files in the source folder path, because themultipass filter template

is only applied during multipass processing. If you refresh the list manually as shown here, the
filter template is ignored. Unfortunately there is no way to preview the resulting file lists when
using the filter template.

l The GetCurrentValue functions currently return information for user jdoe, because that is what is
set as the Current Value Defaults for the source column on the File Processing Control Sheet.
When multipass processing is performed, the functions will return the values relating to the
current pass VP. It can be useful to set current value defaults so that the functions do not return
errors when multipass processing is not being performed.
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When the phase 2 file collect report is processed as the last item in the batch, the relevant region report
packages are emailed to the appropriate VPs. In the following example, this VP is responsible for two
regions, so two report packages were attached to the email.

Email to VP after running file collect (two region packages attached as individual files)

Batch Processing
Using the batch processing feature, you can perform file processing on multiple files in batch. Each file
can use its own native file processing settings, or you can override certain settings and use batch
variables.

For example, you might have several reports that you want to run at the end of each month. You can set
up these reports in a batch, and then run the batch manually or schedule it for execution using
Scheduler. Each report can be processed once or multiple times, using different settings—for example,
you might have an income statement that you want to run by country, then by region, then by VP.

Batch processing allows you to:
l Create a list of files to be run in a single batch process. Files can be enabled or disabled for each

particular execution of the batch. The files must already be set up to use file processing.
l Define alternate file processing settings for each file as desired, or use the native settings defined

in the file itself. Batch variables can also be used to impact the file processing.
l Process the same file multiple times, using different file processing settings for each execution.
l Combinemultiple file processing types within a batch, for an "end-to-end" process. For example,

you can process several files to create various snapshot copies, and then run a file collect report to
combine all the snapshots into a single report package.

Batch processing is a special feature of file processing. Unlike other file processing types, where you are
refreshing sheets in the file with data and then performing actions on those sheets, batch processing
uses special control sheets to define the settings of the batch operation. Although the file can contain
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other sheets, they are essentially ignored for the batch operation (unless the control sheets reference
those sheets to determine batch settings). In most cases, the only purpose of the file is to contain the
batch settings.

When you set up file processing for batch, you specify the processing type and the sheets to process. All
other file processing settings, including multipass, do not apply to the batch process itself. All batch
settings aremanaged within the special Batch Control Sheets.

Setting up a batch

Using batch processing, you can perform file processing on multiple files in batch. To set up batch
processing, you must enable the file for file processing, and then complete one or more special Batch
Control Sheets.

� Enabling batch processing within a file
It is recommended to use a dedicated report file to hold the batch settings. Using a report file allows the
file to be scheduled using Scheduler's File Processing task.

1. Open or create a report to contain the batch settings. The report must first be enabled for file
processing before you can configure the batch settings:

l On the Axiom tab, in the File Output group, click File Processing > Enable File Processing
in this workbook.

The File Processing pane opens, and a sheet named Control_FileProcessing is added to the file.

2. In the File Processing pane, for Processing Type, select Batch.

3. Amessage box is displayed, asking if you want to add a batch sheet to the file. Click Yes.

A Batch Control Sheet, named Batch, is added to the file. This sheet will hold the configuration
settings for the batch processing.

Only one setting displays in the File Processing pane: Sheets to Process. By default, the Batch sheet is
listed here. This means that when the file is processed, it will process all of the enabled files listed on the
Batch Control Sheet.

If desired, you can add multiple Batch Control Sheets to the file, and process them in the same
operation. In the File Processing pane:

l To add more Batch Control Sheets to the file: In the Actions section, click Add batch sheet. If you
are using multiple Batch Control Sheets, it is recommended to rename the sheets to something
that indicates the purpose of each sheet.

l To process multiple Batch Control Sheets: Click the Select worksheets icon to the right of the
Sheets to Process box, and then select the desired sheets. Only Batch Control Sheets are eligible
for processing.

No other file processing settings apply to batch processing. All information relating to the batch process
is defined on the Batch Control Sheet.
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� Setting up the batch file list
Each row in the Batch Control Sheet represents a file that you want to process as part of the batch. For
each file, you specify:

l The folder path and name of the file. The Reports Library is assumed as the location unless a full
repository path is specified.

l Whether the report is enabled or not within the batch.
l Whether the report is to be processed using multipass processing. If multipass processing applies,

you can use the settings defined in the report or specify optional override settings.
l If batch variables are defined in the report, you can specify values for the batch variables, to be

used when the report is processed.

For more information on the batch settings, see Batch Control Sheet.

The files in the batch can run any file processing action. For example, the batch could contain several
reports to be processed using snapshot, and then the last report in the batch could be a report that is
set up for file collect.

Example Batch Control Sheet

Once you have set up the list of batch files, you can validate it using the Validate batch configuration
action in the File Processing pane. The validation process checks for issues such as:

l Invalid file paths or names
l Invalid source column or data filter entries
l Invalid batch variable entries

The validation process reports the first error that it finds in the list. Once you have corrected that error,
run the validation again to ensure that no additional errors exist.

The validation process only checks rows where a file is listed and enabled for processing.

Batch Control Sheet

The Batch Control Sheet defines settings for the batch action of file processing. Each row in the control
sheet lists a file to be processed as part of the batch. If desired, you can list the same file multiple times,
using different configuration settings.

NOTE: All files listed for batch processing must already be set up to use file processing. If a file is not
set up to use file processing, an error will occur during processing.
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Batch Control Sheets can only be added to a file that is enabled for file processing and where Batch has
been specified as the processing type. When you initially select the processing type, you will be
prompted to add a Batch Control Sheet to the file. You can subsequently add more control sheets to the
file by using the Add batch sheet action in the File Processing pane.

When the batch processing is performed, only the control sheets listed in the file processing Sheets to
Process will be processed.

To validate entries in the Batch Control Sheet, use the Validate batch configuration action in the File
Processing pane.

The Batch Control Sheet is only visible to administrators and to users with the Allow File Processing
permission to the file. Otherwise, it is hidden by default.

The following settings are defined for each file in the batch:

Item Description

File Path The folder location and file name of the file to be processed, including the file
extension.

The Reports Library is assumed as the file location and can be omitted from the
file path (however, full paths can be used as well). However, if you want to
process a non-report file, you must specify the full repository path. Only files in
the Axiom Budgeting and Performance Reporting file system can be processed.

For example:
l If the report is located in a subfolder of the Reports Library, specify the

subfolder name and the file name. Do not place a slash before the folder
name.
MonthlyReports\IncomeStatement.xlsx

l If the report is located in the root of the Reports Library, specify only the file
name.
IncomeStatement.xlsx

l If you want to process a non-report file, specify the full repository path.
\Axiom\File Groups\Budget 2021\Drivers\US_Drivers.xlsx.

To look up a report file path, right-click and select Select Report. In the Select
Report to Process dialog, navigate to the desired report and then click OK. The
file path and report name is inserted into the cell.

Enabled Specifies whether the file will be processed as part of the batch (On/Off). If
blank, Off is assumed.

You can use this setting to temporarily exclude files from a batch process, or to
conditionally include files based on some other selection in the file (if the cell is
set up to use an IF formula to return either On or Off).
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Item Description

Process
Multipass

Optional. Specifies whether the file is processed using multipass processing.
l IfOn, then the file is processed using multipass processing. The file must

have valid multipass settings defined, and/or you can definemultipass
settings within the Batch Control Sheet.
If the processing type of the target file is Save Data in Batches, then only
multipass processing is supported and this setting must be On.

l IfOff or blank, then the file is processed using normal non-multipass
processing. Any multipass settings in the file or in the Batch Control Sheet
are ignored.
If the processing type of the target file is Batch, then multipass processing
does not apply and this setting must be Off.

Multipass
Source Column

Optional. Specifies the source column for themultipass processing. For
example: DEPT.DEPT to process the file once for each department. This setting
only applies if Process Multipass is set to On.

This setting must use Table.Column format to specify the column.

If left blank, then themultipass process will use the source column settings
defined in the report.

IMPORTANT: This override is equivalent to specifying a source column in the
multipass "basic" view, meaning that advanced settings such as the source
table and the "group by" are automatically configured based on the source
column. If the file to be processed uses advanced multipass settings (including
additional source columns), then using the overridemay not return results as
expected. For example, if the source report uses a data table as the source
table, and you specify a batch override of DEPT.VP, then the source table will be
changed to DEPT. If this does not meet your needs, you may be able to use
batch variables instead to override specific multipass settings.

Multipass Data
Filter

Optional. Specifies a filter for themultipass processing, to limit the items to be
processed. This setting only applies if Process Multipass is set to On.

For example, you could specify DEPT > 5000 to only process departments
greater than 5000, or DEPT.Region='North' to only process departments in
the North region.

If left blank, then themultipass process will use the source filter settings defined
in the report.
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Item Description

Batch Variables Optional. Specifies values for one or more batch variables, to be applied to the
file during processing.

Batch variables use the following syntax:

VariableName=VariableValue

The variable namemust be defined in the source file, and the file must be set up
to use the value in someway. When the batch is processed, the variable value
defined in the Batch Control Sheet will be placed into the corresponding
Variable Value cell within the source file, and then the file will be processed.

You can list multiple variable name/value pairs, separated by semicolons. For
example:

VariableName1=Value1;VariableName2=Value2

Processing a batch

When you process a batch, Axiom Budgeting and Performance Reporting processes each enabled file
listed in the Batch Control Sheet. Reports are processed in the order that they are listed.

In order to run the batch, you must have rights to the file that contains the batch settings, as well as all
of the files to be run by the batch. If you do not have rights to one of the files in the batch, then an error
will occur during processing.

NOTE: You can also process a batch using Scheduler, using the File Processing task. For more
information, see Batch processing using Scheduler.

To process a batch manually:
1. Open the file that contains the batch settings. The file must already be set up for batch processing

and at least one file in the batch must be enabled.

2. On the Axiom tab, in the File Output group, click File Processing > Process File.

TIP: You can also perform batch processing using the File Processing pane. In the Actions
section, click Process batch.

When the process is complete, a confirmation message displays information about the files that were
processed and the results.
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Batch processing using Scheduler

You can use Scheduler to perform batch processing of files. There are two options to perform batch
processing in Scheduler:

l Run batch report using a File Processing task. You can set up a report file for batch processing,
using a Batch Control Sheet. Then in Scheduler, you use a File Processing task to run the single
report that is set up for batch. That batch report then processes all the files in the list.

OR

l Run multiple File Processing tasks in the same job. You can set up multiple File Processing tasks
in a Scheduler job, each one processing a different report (or the same report with different
settings). In this scenario, no Batch Control Sheet is used—effectively, the Scheduler job defines
the batch.
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In most cases, it is more intuitive and flexible to set up a file for batch processing, rather than use
multiple File Processing tasks. Using the Batch Control Sheet, you can easily see all of the files in the
batch and review their settings side-by-side. You can list a file collect report as the last file in the batch, to
collect the results of the prior files in the batch. Additionally, you have the option of processing the batch
manually, without Scheduler.

Generally, only certain edge cases will gain advantages from using multiple Scheduler tasks to define a
batch. For example:

l You can process the reports in parallel instead of consecutively. When using the Batch Control
Sheet, reports are processed consecutively, in the order listed. If you instead create a batch by
using multiple Scheduler tasks, you can configure the tasks to run as parallel sub-jobs, which may
improve the performance of the overall job. This would only be a significant advantage if the batch
contained several reports with lengthy processing times.

l You can easily override any file processing setting for any file. When using the Batch Control Sheet,
the only "built-in" override settings are for themultipass source column and the source filter. It is
possible to override other settings, but you must set up batch variables to do so. If you instead
use File Processing Scheduler tasks for each report, you can directly override any file processing
setting.
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� Batch processing and file collect
If batch processing is used to generate snapshot copies of various reports, you can use file collect to
combine those snapshot copies into report packages and then deliver the packages to the appropriate
recipients (and/or save the packages to a file share).

There are a variety of ways that you can incorporate file collect as part of a batch process. Themost
common method is to create a file collect report (using the file collect option of file processing), and then
list that report as the last file in the batch. This way, the entire batch process—from generating
snapshots, to creating report packages, to delivering the packages—is contained within a single file that
can be processed manually or via Scheduler.

If desired, you can use any of the alternatemethods for incorporating file collect. For example:
l If you are using themultiple-Scheduler-task method of creating a "batch," the last task in the job

can perform the file collect operation. This task can be either a File Processing task that processes
a file collect report, or it can be the Scheduler-specific Collect Worksheets task.

l You could still use a batch report to define the files to process, but maintain file collect separately.
When running the batch report via Scheduler, you could use either the Collect Worksheets task or
a separate File Processing task to perform the file collect. For example, you might want to separate
the file collect operation from the batch list if you wanted to process multiple batch reports and
then have only one file collect process at the very end. If your file collect process is set up to
dynamically generate file lists, then you could optionally include or exclude reports or entire
batches, and still generate file collect packages.

For more information on the differences between using file collect reports and the Scheduler-specific
Collect Worksheets task, see Using Scheduler to perform file collect.

Using ProcessManagement
Using the Process Management feature, you can define a set of process steps—including assigning
ownership and due dates—and then track the completion of these steps.

Process management provides the following benefits:
l A documented workflow to complete a particular process in Axiom Budgeting and Performance

Reporting. You can detail all of the necessary steps in the process, including steps that happen
outside of Axiom Budgeting and Performance Reporting. Steps can be dependent on prior steps,
or they can be performed in parallel, as appropriate.

l Clear ownership of each process step, including due dates. Users who are assigned a step are
notified of this responsibility, and can view and complete the step within their Process task pane.

l Easy access to features necessary to complete process steps. You can associate each step with
certain features in Axiom Budgeting and Performance Reporting, so that the user responsible for
the step can often launch the necessary feature directly from the Process task pane and perform
the assigned task.
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l A permanent audit trail for the process, including who completed a step and when. You can view
the process status details while the process is active, and also after the process is complete, so
that there is always a record of the process.

When using the Process Management feature to manage a planning process, you use a special type of
process known as a plan file process. These processes are defined at the file-group level using a plan file
process definition.

Plan file processes are dedicated to editing and reviewing plan files. Each plan file in the file group
progresses independently through the process steps. Although the basic process features and setup are
the same, plan file processes support additional features that only apply to plan file processes.

NOTE: This chapter includes only a portion of the features available when using Process
Management. For more information, see the Axiom Software Process Management Guide.

About process management
Process management can be used to manage and track an Axiom-related process from end to end—
encompassing all aspects of the process, including steps that may need to be completed outside of the
system.

� Defining processes
In order to use process management, you first create a process definition. This file defines the properties
of the process, such as:

l Name and description (for example "Annual Rollover")
l Process owner
l Steps in the process
l Owners and due dates for each step
l Associated files and features for each step
l Notifications to be sent during the process
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Example process definition

The process definition is a file that is stored in the Process Definition Library (or for processes that belong
to a file group, within the file group's Process Definitions folder). The process definition can be
subsequently edited and "activated" as needed, whenever you need to perform and track the process.
When a process is activated, a new incarnation of the process is created to track the details of that
particular process instance. This ensures that you always have a history of each time the process is
performed, including who completed each step in the process and when.

� Performing a process
When you are ready to perform a process, you "activate" or start it. The first step in the process is made
active, and a notification is sent to the assigned step owner (or owners). This default notification gives
the user information such as the process name, the step name and description, and the due date. You
can optionally customize the notifications for a process, and you can disable them if desired.

When a process is active, the process owner and all administrators can see the process in the Process
task pane. Other users only see the process if they are the assigned owner of a step in the process.
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Example process task pane for a step owner (non-admin)

The assigned user must perform the task and then mark the step as complete by the designated due
date. For more information, see Step ownership and completing process tasks. If necessary, an
administrator or the process owner can override step ownership and complete the step.

Once the currently active step is complete, the process moves to the next step, and so on until all steps
are complete. Generally speaking, only one step at a time is active in a process. However, there can be
multiple active steps at the same time if a Parallel Subprocess step is used in the process. When the
active step is a parallel subprocess, all sub-steps of the subprocess become active simultaneously and
can be completed in parallel. The subprocess is not completed until all sub-steps are completed. For
more information, see Performing process steps in parallel. TheMultiple Approvals Process Step also
counts as a parallel subprocess.

When all steps in the process are complete, the process instance is automatically completed.

� Step ownership and completing process tasks
Each step in a process represents a task to be performed, and that step has one or more assigned
owners. When a step becomes active in a process, a task is generated for the assigned owner. This user is
expected to perform the task for that step, and then mark the step as complete by its assigned due date.
This is done using the Process task pane.

If a user is the assigned owner of an active step, the process and the active step display in the Process
task pane (or in a custom task pane that has been configured to show the process task control).
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Example active task in task pane

The process task may be an activity that the assigned user performs in Axiom Budgeting and
Performance Reporting, such as running an import, or it may be an activity that the user completes
externally, such as obtaining the source file for the import from another system and saving it to the
designated location. The task may be simply to confirm that the process is ready to continue (an
approval step).

The step name and description should be defined so that the assigned user clearly understands what
they are expected to do to complete the task. In some cases, the step may have an associated "action",
such as theOpen report button in the example screenshot above. This is provided as a convenience, so
that the user can easily access features that are related to the task. However, once the file or feature is
open, it is up to the user to decide what to do with that file or feature in order to perform the task. Axiom
Budgeting and Performance Reporting does not perform any validation before allowing a step to be
completed; it is up to the assigned user to determine that the step is complete.

Once the user has completed the task to their satisfaction, they can mark the step as complete by
clicking the button in the task pane. This opens the Process Action dialog, so that the user can confirm
that they want to complete the step, as well as enter any step comments.

This dialog displays slightly differently depending on step type. Most steps will display as follows,
showing a step progression diagram for context:
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NOTE: If the step is part of a Parallel Subprocess, then the step progression diagram is not displayed,
because the process does not continue to the next step until all steps in the subprocess are
complete. The user is simply informed that they are completing the current step.

Certain step types have slightly different step completion behavior. For example:
l If the step is an Approval Process Step, then theMark step as complete button does not display

in the task pane. Instead, the user can click either Approve or Reject. If they click Approve, the
step is completed and the process moves to the next step. If they click Reject, the process is
moved back to the prior step.

l If the step is a Scheduler Process Step, then the step displays in the Process task pane for
information only, because the step will be processed and completed automatically by Axiom
Budgeting and Performance Reporting. However, if the Scheduler job experiences errors, then the
user has various options to restart the job or to manually mark the step as complete if the job
does not need to be re-run.

In most cases, the current, next, and prior step owners show in the completion dialog. Prior steps and
their owners only showwhen the task can be rejected back to the prior step. However in some cases, it is
not possible or feasible to show the step owners. For example, if the next step in the process is a
subprocess that may resolve to multiple steps with multiple possible owners, then Axiom Budgeting and
Performance Reporting does not attempt to show the next steps or their owners. Instead it displays the
name of the subprocess and that there will be "(multiple step owners)".
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Once the step is completed, the process no longer displays in the user's Process task pane (unless the
user is also the step owner of the next step). If the user has no active tasks in any processes, then the
Process task pane will be empty for the remainder of the current session, and will not open the next time
the user logs in (unless the user has been assigned a new active task in themeantime). Exceptions are as
follows:

l Process owners see the process in their Process task pane as long as the process is active.
l The Process task pane is visible to administrators as long as any process in the system is active.

If necessary, an administrator or the process owner can mark a step as complete. For example, imagine
that the assigned user already performed the necessary task but then left on vacation before they
marked the step as complete. The administrator can mark the step as complete so that the process can
continue. In this case the process history will reflect both the original assigned owner, and the fact that
the administrator completed the step.

� Performing process steps in parallel
In general, the order of steps in your process definition determines the order in which tasks for the
process can be completed.

When the process is started, the individual steps aremade active in the order they are listed. By default,
each step is dependent on the prior step being completed (sequential steps). So if step 1 is the currently
active step, step 2 is not made active and cannot be completed until step 1 is marked as complete. Once
step 1 is completed, step 2 becomes active, and so on.

However, you may have some steps in your process that are not dependent on each other and can be
completed in any order. These steps are known as parallel steps, meaning they can all be active at the
same time.

To configure parallel steps, you must use a Parallel Subprocess step, and then define the parallel steps
as sub-steps of the subprocess. This tells Axiom Budgeting and Performance Reporting that the sub-
steps of the subprocess can be completed in any order.
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When the Parallel Subprocess step becomes the active step, all sub-steps are also made active. Once all
sub-steps in the subprocess are completed, then the Parallel Subprocess step is automatically marked as
completed, and the process moves to the next step.

Imagine that step 2 of a process is a Parallel Subprocess step, and the subprocess has 5 sub-steps. Once
step 1 is completed, then step 2 becomes active as well as all 5 of its sub-steps. The owners of the sub-
steps can work on these steps and complete them in any order. Once all 5 of the sub-steps are
completed, step 2 is automatically completed, and then step 3 of the process becomes the active step.

NOTE: TheMultiple Approvals Process Step is a special type of Parallel Subprocess. It can only
contain Approval Process Steps as sub-steps, but otherwise its behavior is the same as the Parallel
Subprocess.

� Tracking process status and history
Administrators and process owners can view process status and history at any time. Using the Process
Manager dialog, you can see the status of all active processes or all current processes at-a-glance.

Example Process Manager dialog
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Administrators and process owners can view the details for an active process, to see when each step was
completed and by whom, as well as any comments added by users. You can also perform process
administration tasks within this dialog, such as overriding step ownership, restarting stalled steps, and
stopping the process.

Example process details in the Process Status dialog

Administrators can view the historical details for any process. For example, if you have a process that you
run monthly, you can go back and view the prior month's details, or any amount of history that you
want to retain.

Creating Process Definitions
Using a process definition, you can define the set of steps to bemanaged and tracked as part of a
process, including step order, ownership, associated actions, and due dates.

Process definitions are stored in the Process Definition Library. Access to the definitions is controlled by
the file security settings on the Files tab of security. Only users who need to create and modify the
process definitions need access to these files. Users who are assigned to perform individual steps in the
process do not need access to the definition in order to perform the task or to view the process status.
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NOTE: This topic discusses how to create a general process definition. If you want to manage plan
files in a planning process, then you should use a plan file process definition instead. General process
definitions and plan file process definitions share certain basic settings, but plan file process
definitions are dedicated to plan file process steps, and also support additional features that are
unique to plan file processes.

Process definitions are typically created by administrators, or other power users who are responsible for
administrating parts of the system. The creator of the process definition needs to understand all steps of
the process, who needs to perform each step, and when that step needs to be performed.

Process definitions do not have any impact on the system until they are activated.

To create a new process definition:
1. On the Axiom tab, in the Administration group, clickManage > Processes > Process Definitions.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Process Definitions.

The Axiom Explorer dialog opens, filtered to show the Process Definition Library. If you have access
to the Process Definitions folder for any file groups, those folders also display here.

2. Right-click the Process Definition Library (or a subfolder), then click New > Process Definition. If
you want to create a process definition for a file group, you can right-click the Process Definitions
folder in the file group.

The Edit Process dialog opens. As you are working in this dialog, any validation errors for missing
or invalid settings will display at the bottom of the dialog. You can save the process definition with
configuration errors, however, you will not be able to start the process until all configuration
errors are resolved.

3. In the Process Properties tab, complete the general process settings as desired. For more
information, see:

l Designating the process owner
l Configuring process visibility to step owners
l Process Definition Properties

4. In the Process Steps tab, define the steps for the process.

l To add a step, click Add and then select the type of step to add. New steps are added after
the step that you currently have selected in the list.

However, if the currently selected step supports sub-steps, then the new step is added as a
sub-step. This applies to step types such as Parallel Subprocess. In this case, if you want to
add a new top-level step that comes after the subprocess step, you must click Add After
Current Step and then select the type of step to add.
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l To remove a step, select that step and then click Delete. If the deleted step has child steps,
those steps are removed as well.

l To change the order of steps, you can drag and drop them to different locations in the list.

l To copy a step, select the step and then click Duplicate. You can then modify the copied
step as needed and move it to the desired location in the list.

Steps are performed in the order listed. By default, steps are dependent and sequential—
meaning, each step in the list must be completed before the next step can be done. However, it is
possible to use a Parallel Subprocess to define parallel steps—meaning multiple steps that are not
dependent and can be performed at the same time. The parallel steps are then defined as sub-
steps to the Parallel Subprocess. (Multiple Approvals Process Steps also behave like Parallel
Subprocesses.)

Once you have added a step to the process, you can configure the settings for that step in the
right-hand pane. This includes the display text for the step, the step ownership and due date, and
other properties specific to the step type. You can also configure step-specific notification settings.

For more information on configuring the steps in the process, see the following topics:
l Assigning owners to process steps
l Defining the due date for a process step
l Process step types
l Defining notifications at the step level

TIP: In most cases, you should configure the process-level notification settings on the
Notifications tab before configuring any step-level notification settings. This way the steps will
have access to the inherited process-level settings.

5. In theNotifications tab, complete the notification settings for the process. You can enable or
disable notifications for the process, define the default notification delivery method, and define
default notifications to apply to the steps in the process. For more information, see Configuring
Notifications.

6. Click Apply to save, orOK if you are finished editing.

� Copying an existing process definition
You can create a new process definition by copying an existing definition. To do this, use normal Axiom
Explorer functionality:

l Right-click the definition file in the Process Definition Library, and then select Copy.
l Right-click a folder, and then select Paste to paste a copy of the file. The new file will be named

OriginalFileName - Copy.
l Rename the file, then open the file and change the process definition settings as desired.
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� Creating a general process definition for a file group
You can create general process definitions that belong to a file group. For example, you might use a
general process definition in a file group to document and manage the rollover procedures for the file
group.

General process definitions in file groups have the following special properties:
l The processes are stored in the Process Definitions folder of the file group, instead of in the

Process Definition Library.

l All step types that require a designated file group are automatically associated with the current file
group. There is no option to specify a file group because the current file group is assumed.

l Processes can be copied when the file group is cloned, so that you do not have to create new
processes for cloned file groups.

l The ability to create and edit processes for a file group is reserved for administrators and for users
with the appropriate file access to the Process Definitions folder of the file group (as granted on
the Files tab of the Security Management dialog).

General process definitions cannot be used to manage the plan files in a file group through a defined set
of planning steps. To do that, you must use a plan file process definition. This is a special type of process
definition that can only be created in a file group.

Designating the process owner

Each process definition has a designated owner. The process owner receives all administrative
notifications for the process, and can also:

l Start and stop the process
l Access the Process Status dialog when the process is active
l Move, complete, and regenerate steps

NOTE: Administrators can also perform all of these actions, regardless of whether or not they are the
process owner.

The owner of the process is designated by the Process Owner setting on the Process Properties tab. By
default, the process owner is set to the user who created the process definition. If desired, you can
change the owner to a different user or to a role by clicking Select User or Select Role. If the owner is a
role, then all users in that role are treated as process owners.
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If the designated owner is a non-admin user, then you should make sure that the user has read/write
access to the process definition, so that the user can open and edit the definition as needed, and can
start the process. Once the process has been started, the process will display in the owner's Process task
pane for the duration of the process, and the owner will gain access to the View status link so that they
can perform any necessary administrative functions for the process. Process owners can also access the
Process Manager dialog to perform process management activities for the processes they own.

� Administrative notifications
Notifications are automatically sent to the designated process owner when the following situations
occur:

l The process is started or stopped.
l An error occurs in a process step.

These notifications are system-managed and cannot be disabled or customized. However, you can
designate additional users to receive these notifications.

The Admin Notification Recipients are designated on theNotifications tab. By default, the process
owner is the only recipient of these notifications. To add or remove recipients, click Edit Recipients.

In the Edit Recipients dialog:
l To add a recipient, click Add Recipients>User or Add Recipients> Role to choose a user or role.
l To remove a recipient, select the user or role in the Notification Recipients list and then click

Delete.

The process owner cannot be removed as a recipient. If the designated process owner is a role, then all
users in that role will receive the administrative notifications.
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NOTE: If the user who stopped or started the process is also an administrative notification recipient,
that user will not receive a notification, because that user already knows about the change in process
status. The intent of the started/stopped notifications is to inform interested parties that somebody
else stopped or started the process.

Configuring process visibility to step owners

When you create a process definition, you can specify whether step owners can see all steps in the
process in the Process task pane, or only their current step. This is controlled using the following setting
on the Process Properties tab: Allow step owners to see all steps in the process task pane.

This setting is disabled by default, which means that step owners only have access to the Task View in the
Process task pane. The Task View displays the currently active step as follows:

l The name and details of the currently active step are displayed without any reference to the step
number. However, the user can see the step number in the tooltip.

l The step owner cannot see any other steps in the process, within the Process task pane. When
the user completes the step, they can see the next step in the process. If the step can be rejected
backwards, the user can also see the prior step.

If desired, you can enable this setting, which gives step owners access to the Process View in the Process
task pane. Process View displays the full list of all steps in the process, so that the user can understand
the context of the currently active step within the overall process. Process View is for information only—
users cannot complete steps or launch files / features from Process View. Users can toggle between Task
View and Process View as desired.

The following screenshots show examples of Task View versus Process View, including the toggles to
switch back and forth. If a user does not have permission to see Process View, then the Show process
view toggle does not display.
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Task View

Process View

This setting does not apply to administrators or to process owners. These users always have access
to Process View, regardless of whether this setting is enabled. Process View is the only available view for
these users when they do not have an active task in the process.

Assigning owners to process steps

Each step in a process definition must have a defined owner to perform that step and mark it as
complete. The assigned step owner can be a user or a role.

When a step is made active, the assigned owner is notified that they have a task to complete in the
process (if notifications are enabled for the process and for the step). The owner can view the active task
in the Process task pane, perform actions associated with the task, and then mark the step as complete.

This topic discusses step ownership options for general process definitions. Plan file process definitions
have additional options to assign step ownership, so that each plan file can be assigned a different owner
for each step.

NOTE: When using a Parallel Subprocess or a Multiple Approvals step, ownership assignments are
only made on the child steps. The parent step does not have ownership assignments.

� Assigning owners to individual steps
In the process definition, step owners are assigned on the Process Steps tab, in the Assignments sub-
tab. Select the step for which you want to assign ownership, then use the Assignment Type field to select
the ownership type.
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For steps in general process definitions, the assigned owner can be a user or a role:

Assignment Type Description

User Assign a specific user as the owner of the step. When the step becomes
active, a process task will be generated for the user to complete the step.

Click the Edit button to the right of the Assigned User box to select a
user. You can select any user in the Axiom Budgeting and Performance
Reporting system.

NOTE: If most or all of the steps in your process use the same owner, you
can choose to set a default owner at the process level. If you do this, then
you can leave the Assigned User at the step level blank, and that step will
automatically be assigned to the default owner.

Role Assign a role as the owner of the step. When the step becomes active, a
process task will be generated for all users in that role, and any of those
users can complete the step.

Click the Edit button to the right of the Assigned Role box to select a
role. You can select any role in the Axiom Budgeting and Performance
Reporting system.

Until a process is active, you can edit step ownership settings as desired. Once a process is active, you
can edit ownership settings for any step that is not already completed. If you change the ownership
settings of an active step, new tasks will be regenerated as needed to reflect the new settings, including
sending new Step Activated notifications (if enabled for the process).

� Defining a default user assignment for the process
If desired, you can specify a default user assignment at the process level. This option is useful when you
have a process wheremost or all of the steps are performed by the same user.

The default user assignment can be set on the Process Properties tab, as theDefault Process
Assignment.
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If an individual step is set to User as the Assignment Type, but no user has been specified, then the step
will use the default assignment. This is indicated in the step properties as follows:

Once a process has been started, the default process assignment cannot be changed. However, you can
still change the owner of any individual steps that have not yet been completed.

� Step ownership and security permissions
For steps in a general process definition, step ownership only grants the ability to mark the step as
completed in the process. It does not grant the user the necessary security permissions to perform any
associated action for the step, and it does not prevent any other user from performing that associated
action. When assigning owners to process steps, you should be sure that the owner has the appropriate
security permissions to perform the associated task for the step.

For example, imagine that the step is "Import actuals data" and the step has been linked to the
GLActuals import utility. If the user has permission to execute that import (as defined in security), then
the user can click Open import for the task in the Process task pane to execute that import. However, if
the user does not have permission to execute the import, then being the step owner does not grant
them the permission. Additionally, if other users have security permissions to execute that import, they
can still do so.

Defining the due date for a process step

Each step in a process definition can have a defined due date. If a step has not been completed by the
due date, then the step becomes overdue. If the active step in a process has become overdue, a warning
displays in the Process task pane and the due date displays in red.
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Example display of overdue step

In the process definition, step due dates are defined per step on the Process Steps tab, in the
Assignments sub-tab.

To define the due date for a step:
1. Click the Edit icon to the right of theDue Date box.

2. In the Choose Date dialog, select one of the following options:
l No Due Date: The step does not have a due date.

l Static Due Date: Select a specific date for the due date. You can select the date from a
calendar.

l Relative Due Date: Specify a number of days to dynamically determine the due date. The
number of days can be relative to the date the process was started (process start date), or
to the date this particular step was started (step start date). For example, the step can be
due 7 days after the process was started, or 7 days after this step was started. By default,
the process start date is used.
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Example Choose Date dialog

3. If you specified a relative due date that is based on the step start date, decide whether or not to
enable Reset relative due date when step is reopened. This option displays underneath theDue
Date field.

By default this option is disabled, which means that the step due date is calculated when the step
is first started, and that due date does not change if the step is later reopened. So if the step due
date is 6/1/2020when the step is first started, and then later the step is reopened on 6/2/2020,
the step due date will remain at 6/1/2020 and the reopened task will be 1 day past due.

If instead you want the step due date to be reset (recalculated) based on the date the step is
reopened, then you should enable this option. Continuing the above example, if the step is
reopened on 6/2/2020 and the due date for the step is configured to be 3 days after the step start
date, the due date for the reopened task will be recalculated to 6/5/2020.

� Changing due dates
You can change the due date of a step at any time if the process is not active. If you have already defined
a due date and now you want to clear it (so that the step has no due date), click theDelete icon to the
right of theDue Date field.

For active processes, you can change the due date of any step that is not already completed. If you
change the due date of an active step, new tasks will be regenerated as needed to reflect the new due
date, including sending new Step Activated notifications (if enabled for the process).
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Using the result of a previous step

You can configure a step in a process definition to perform an action on the result of a previous step. This
is intended to support processes where an item is created in one step and then you want to perform one
or more actions on this newly created item.

Currently, this configuration is only supported for processes that use a File Group Process Step with the
Clone File Group action. This is the only step type that officially creates a new item in Axiom Budgeting
and Performance Reporting. Although you can use other process steps to direct step owners to create
any kind of item, the creation is not an official step action and is not tracked by the process.

The typical use case for this configuration is for a rollover process. For example:
l Step 1 uses the Clone File Group action to create a new file group for the new cycle of planning.
l Step 2 creates the plan files for the new file group that was created in Step 1.
l Step 3 processes the plan files for the new file group that was created in Step 1.

For Step 1, you would point the step to an existing file group such as Budget 2020. When the process is
activated, the step owner would perform the cloning process and create a new file group such as Budget
2021. However when setting up the process definition, you can't point Step 2 to the Budget 2021 file
group because it isn't created yet. Instead, you would configure Steps 2 and 3 to use the result of Step 1.

� Configuring a step to use the result of a previous step
When defining a File Group Process Step, do the following to use the result of a previous step:

1. For File Group Source, select Previous Process Step.

2. For Selected Process Step, click the Browse button to select the step where the file group is
created.
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The Select Process Step dialog displays a list of steps that are eligible for selection. If no steps are
eligible, a message informs you of this. Only steps that meet the following criteria are eligible for
selection:

l Must precede the current step.
l Must create a file group using the Clone File Group action.

To continue the example in the previous section, the configuration for Step 2will look like the following:

This means that Step 2will create plan files for the file group that was created in Step 1.

� Tracking the step result in active processes
If a process is configured to use the result of a previous step, then the result of that step must be tracked
within the process. To continue the previous example, when Step 1 is completed the process needs to
know the name of the file group that was created, so that it can pass the name of that file group to Steps
2 and 3.

When a step owner completes a step where the created file group is used by a subsequent step, then as
part of the completion process they must specify the name of the file group that was created.
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This selected file group is then associated with the step. In the Process Action dialog, it is displayed as the
Step Result. If needed, you can change the selected file group here before completing the step, by
clicking Select. However, once the step has been completed, the step result is then fixed and cannot be
changed without reopening the step.

The file group that is specified as the step result will be passed to the subsequent steps that use that
result. The step result is also documented in the process details for future reference.
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Process Definition Properties

This topic is a reference for all properties that can be configured for general process definitions.

� Process Properties tab
This tab defines the basic properties of the process definition.

Item Description

Process Name The name of the process. This name defines:
l The name of the process definition file.
l The process name displayed in process dialogs and web pages, if no separate

display name is defined.

Display Name Optional. The display name of the process. By default, the process name is used
as the display name.

If a display name is defined, then the process displays in process dialogs using
the display name instead of the process name. The process definition file
continues to use the process name.

Description Optional. The description of the process definition. This description displays in
the Process Status dialog.

Process Owner The owner of the process. By default, this is set to the user who created the
process definition, but it can be changed to another user.

The process owner receives all administrative notifications for the process and
can perform all administrative actions for the process (such as starting and
stopping the process, overriding task ownership to mark steps as complete,
and so on).

Configuration Properties
The following configuration properties can be set for the process:
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Item Description

Allow step
owners to see all
steps in the
process task
pane

Specifies whether the assigned step owners can see all steps in the process
when they interact with tasks in the Process task pane.

By default, this option is disabled, which means that step owners only have
access to the Task View in the Process task pane, which shows the currently
active task. If this option is enabled, then step owners gain access to the
Process View, which shows all steps in the process. Users can toggle between
each view.

This setting is only applicable to non-admin step owners. Administrators and
process owners can always see all steps of any process.

Default Process
Assignment

The user to be used as the default step owner if no specific user assignment is
made for a particular step. The default assignment only applies to steps where
the Assignment Type is set to User.

� Process Steps tab
This tab defines the steps for the process. Steps aremanaged in the left-hand pane. Step properties are
defined in the right-hand pane using the following sub-tabs: Step Properties, Assignments, and Step
Notifications.

Step Properties
This sub-tab defines basic properties for the selected step.

Item Description

Display Text The display text for the step.

If left blank, the display text is the step type (for example, "Approval Step" or
"Generic Process Step"). It is strongly recommended to define display text that
clearly identifies the specific purpose of this step.

Description Optional. The description of the step.

You can use this field to further explain the purpose of the step or to provide
additional instruction to the step owner. Users can see the step description in a
tooltip when hovering the cursor over the step in the Process task pane.

Process Step
Configuration

Some step types have additional properties that only apply to that particular
step type. For more information about each step type and its unique
configuration properties, see Process step types.

Assignments
This sub-tab defines ownership assignments and due dates for the selected step. This tab does not apply
to parent Parallel Subprocess or Multiple Approvals steps.
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Item Description

Assignment Type Specifies the type of ownership assignment. The following assignment types are
available:
l User: A specific user will be assigned to the step.
l Role: A specific role will be assigned to the step.

Additional inputs are required, depending on the selected type. For example, if
the type is User, then you must specify the assigned user. For more
information, see Designating the process owner.

Due Date The date when the step must be completed. This can be a specific calendar date,
or the due date can be relative based on a number of days after either of the
following: the date the process was started, or the date this particular step was
started.

The due date can also be left blank if the step does not have a specific due date.
For more information, see Defining the due date for a process step.

Reset relative
due date when
step is reopened

Specifies whether the due date is reset when the step is reopened. This option is
only available if the step uses a relative due date that is based on the step start
date.

By default, the step due date is calculated when the step is started, and that
due date persists if the step is reopened. If instead you want the due date to be
reset (recalculated) based on the date the step is reopened, select this option.

Step Notifications
This sub-tab defines notification properties for the selected step. The settings on this tab are only used if
notifications are enabled at the process level. If notifications have been disabled for the entire process, a
note displays across the top of the tab.

This tab has the following sections:
l Inherited Notifications: Use this section to manage the inherited notifications for this step.

Inherited notifications are notifications defined at the process level. You can optionally enable or
disable the inherited notifications on a per step basis, and you can edit the recipients for this step.

l Custom Notifications: Use this section to manage custom notifications for this step. You can add
new notification types, or you can add custom versions of the inherited notification types.

For more information on customizing notifications for steps, see Defining notifications at the step level.

� Notifications tab
This tab defines email notification settings for the entire process.
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Item Description

Enable Process
Notifications

Specifies whether notifications will be sent for the process. These notifications
are typically sent to step owners, but can also be sent to other recipients.

This option is enabled by default. When this option is enabled, you can also
optionally enable or disable notifications for individual steps, using the Step
Notifications sub-tab for the steps.

If this option is disabled, then no notifications will be sent for the process. Any
step-level notification settings will be ignored.

This setting does not affect administrative notifications, which are always sent
to the process owner (and any other recipients designated in Admin
Notification Recipients).

Default
Notifications

Defines the default notifications to apply to each step in the process. Each
process starts with two notification types by default: Step Activated and Step
Rejected. By default, these notifications are enabled for all eligible steps.

You can define additional default notification types as desired and customize
the existing default notifications. For more information, see Defining default
notifications for a process.

Notification
Delivery

Specifies the default delivery setting for all notifications in this process. Select
one of the following:
l Notification task pane: Display the notification in the recipient's

Notifications task pane.
l Email notification (default): Send the notification by email, using the

recipient's email address as defined in Axiom Security.
l Both notifications: Send the notification by email and display it in the

Notifications task pane.

All notifications defined for the process will use the default delivery setting,
unless you choose to specify a different delivery setting on a per notification
basis. Administrative notifications always use the default delivery setting.

Notification
Email From
Address

Specifies the "from" email address for all notifications sent for the process.

By default, the "from" address is the default "from" address defined for
Scheduler in the system configuration settings (for example,
noreply@axiomepm.com). If desired, you can override this default and type in
a different email address to be used for the process.

Admin
Notification
Recipients

Specifies the recipients of administrative notifications for the process. By
default, the process owner receives all administrative notifications, but you can
designate other users or roles to receive these notifications as appropriate. For
more information, see Designating the process owner.
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Deleting a process definition

You can delete a process definition if it is not active and you no longer need it. Deleting a process
definition will also delete all history for that process, so you should make absolutely sure that the
definition and its history are not needed before you delete it.

To delete a process definition:
1. On the Axiom tab, in the Administration group, go toManage > Process Management > Process

Definitions.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Process Definitions.

The Axiom Explorer dialog opens, filtered to show the Process Definition Library (as well as any file
group Process Definition folders that you have access to, if applicable).

2. Right-click the definition that you want to delete, then click Delete.

You will be prompted to confirm that you want to delete the definition, and warned that all
associated history will also be deleted.

3. At the confirmation prompt, click OK.

The process definition is now deleted.

Process step types
Process management supports various step types to be used for different purposes. This section details
the available step types for general process definitions, and the type-specific settings.

This section does not cover the special step types supported by plan file process definitions.

Approval Process Step

The Approval Process Step is intended to be used for steps where you need the explicit approval of a user
in order to move forward with the process.

� Process behavior
When the Approval Process Step is the active step, the step owner has the following options:

l Approve the process so that it will move to the next step.
l Reject the process so that it will return to the prior step.

The Approval Process Step is the only step type that supports moving the process either forward or
backward; all other steps only have the option to move forward when completed.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 996



� Step-specific settings
Approval Process Steps in general processes do not have any unique step settings. Only the general step
settings apply.

� Restrictions
Approval Process Steps cannot be sub-steps of a Parallel Subprocess step. Because the sub-steps of a
parallel subprocess can be completed in any order, an approval or a rejection would not make sense in
this context. If you want to approve the steps in a parallel subprocess, then the next step after the
parallel subprocess should be an approval step. In this case, note that if the assigned user rejects the
process to return to the prior step, the entire parallel subprocess will be "reopened" and made active
again.

If you want to enable parallel approval steps (approvals that can occur concurrently instead of
sequentially), then you can use the special Multiple Approvals Process Step. This step works like a parallel
subprocess, however, it is specially designed to handle approval steps only. For more information, see
Multiple Approvals Process Step.

File Group Process Step

The File Group Process Step is intended to be used for steps where you need the user to perform some
kind of action on a file group.

NOTE: This step type is for performing actions on a file group as part of a larger process. If instead
you want to manage plan files through a planning process, use a plan file process.

� Process behavior
When the File Group Process Step is the active step, the step owner has two actions available in the
Process task pane:

l <Action>: The user can click the action link to open a file or perform the action associated with this
step. The text of the action and what it does depends on the selected action for the step. For
example, if the selected action is Process Plan Files, then the link text is "Process Plan Files" and
clicking on it opens the Process Plan Files dialog for the file group.

l Mark step as complete: The user can click on this link to complete the active task.

� Step-specific settings
When configuring a File Group Process Step, complete the following settings in addition to the general
step settings:
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Item Description

File Group
Source

Specify the source of the file group for this step:
l Selected File Group: You will select an existing file group on which to

perform an action.
l Previous Process Step: The file group for this action is created in a previous

process step. You will select the step in the process where this file group is
created.

For example, imagine a process where step 1 clones a file group to create a new
file group, and then step 2 creates plan files for the new file group. In step 1, you
would use Selected File Group to specify the existing file group that you want to
clone. In step 2, you would use Previous Process Step to specify the file group
that was created in step 1.

This step does not apply if the process definition is associated with a particular
file group. In that case, the current file group is assumed.

Selected File
Group

The file group for the step. Click the Select button to select an existing file group.
This option is only available if File Group Source is set to Selected File Group.

This step does not apply if the process definition is associated with a particular
file group. In that case, the current file group is assumed.

Selected Process
Step

The previous step in the process where the file group for this step is created.
This option is only available if File Group Source is set to Previous Process Step.
For more information, see Using the result of a previous step.

Click the Select button to select the step. Only steps that meet the following
criteria are eligible for selection:
l Must precede the current step.
l Must create a file group using the Clone File Group action.

This step does not apply if the process definition is associated with a particular
file group. In that case, the current file group is assumed.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 998



Item Description

Selected Action The action to perform on the file group:
l Open Plan Files—If the user has one available plan file in the file group, that

plan file will open. Otherwise, the Open Plan Files dialog opens, showing the
user's available plan files.

l Create Plan Files—Opens the Create Plan Files dialog with no special setup;
the user will need to configure it as needed to complete the step.
NOTE: If the file group is an on-demand file group, then this action behaves
like the "Add new file" link in the Open Plan Files dialog. The user can click on
the link to create a new on-demand plan file.

l Clone File Group—Opens the Clone File Group dialog with no special setup;
the user will need to configure it as needed to complete the step.

l Edit File Group—Opens the Edit File Group dialog with no special setup; the
user will need to configure it as needed to complete the step.

l Process Plan Files—Opens the Process Plan Files dialog with no special
setup; the user will need to configure it as needed to complete the step.

The display text and/or description for the step should make it clear to the user
what they are expected to do in order to consider the step complete.

NOTE: The assigned user for the step must have the appropriate security permissions to access the
file group and perform the designated action. The File Group Process Step does not grant any
permissions or elevate any existing permissions.

Generic Process Step

The Generic Process Step can be used for any step that is not covered by the other step types. This step
type has no special behaviors and is not associated with any particular feature in Axiom Budgeting and
Performance Reporting.

You might use this step for:
l A task that a user needs to compete outside of Axiom Budgeting and Performance Reporting.
l A task that uses an Axiom Budgeting and Performance Reporting feature for which there is no

specific step type.

� Process behavior
When the Generic Process Step is the active step, the step owner can useMark step as complete in the
Process task pane to complete the step.
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This step cannot be associated with an action; the assigned user will need to perform the task on their
own. It is important to define the display text and description clearly so that the user understands what
they need to do in order to consider the step complete.

� Step-specific settings
Generic Process Steps do not have any unique settings. Only the general step settings apply.

Import Process Step

The Import Process Step is intended to be used for steps where you need a user to access an import
utility in Axiom Budgeting and Performance Reporting, whether to edit the import settings and/or
execute the import.

� Process behavior
When the Import Process Step is the active step, the step owner has two actions available in the Process
task pane:

l Open import: The user can click this link to access the import according to their security
permissions. The step name and/or description should make it clear to the user what they are
expected to do with the import.

l Mark step as complete: The user can click this link to complete the active task.

� Step-specific settings
When configuring an Import Process Step, complete the following setting in addition to the general step
settings:

Item Description

Selected Import The import utility to associate with this step. Click the folder icon to select the
import.

NOTE: The assigned user for the step must have the appropriate security permissions to access the
import and perform the desired action. The Import Process Step does not grant any permissions or
elevate any existing permissions.

Multiple Approvals Process Step

TheMultiple Approvals Process Step is intended to be used when you want multiple users to approve a
process concurrently instead of sequentially. The difference in approach is as follows:

l For sequential approvals, use several Approval Process Steps in a sequential order. Only one
approval step is active at a time, and that step must be completed before the process moves to
the next approval step.
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l For concurrent approvals, use a Multiple Approvals Process Step with two or more Approval
Process Steps as sub-steps. When the parent Multiple Approvals Process Step becomes active,
then all approval sub-steps become active concurrently. All of the sub-steps must be completed
before the process moves to the next step.

� Process behavior
When theMultiple Approvals Process Step is the active step, then all of its approval sub-steps are also
made active. Owners of the approval sub-steps can complete their steps as appropriate without any
dependencies on the other sub-steps. When all sub-steps are approved by their owners, then the
Multiple Approvals Process Step is automatically marked as complete and the process moves on to the
next step. However, if any of the sub-steps are rejected, then the entire step is rejected and the process
is moved back to the step immediately before theMultiple Approvals Process Step.

� Step-specific settings
The only available step settings for Multiple Approvals Process Steps are display text and description.
These steps do not have owner assignments or due dates. Owner assignments and due dates are
defined individually for each sub-step.

� Restrictions and limitations
l AMultiple Approvals Process Step must have two or more sub-steps. The sub-steps can only be

Approval Process Steps.

l When an owner of a sub-step in a Multiple Approvals Process Step completes a step, the previous
and next steps shown in the Process Action dialog are the top-level steps before and after the
Multiple Approvals Process Step. The other sub-steps do not have an order and therefore are not
shown in relation to the step being approved or rejected.

Parallel Subprocess

The Parallel Subprocess step is intended to be used when you have several steps that are not dependent
on each other, and instead can be performed at the same time (in parallel). The only purpose of this step
is to define a set of sub-steps that can be performed concurrently.

� Process behavior
When the Parallel Subprocess step is the active step, all sub-steps of that subprocess are also made
active. Owners of the sub-steps can complete their steps as appropriate without any dependencies on
the other sub-steps. When all sub-steps of the subprocess aremarked as complete by their owners, then
the Parallel Subprocess step is automatically marked as complete. For more information, see Performing
process steps in parallel.
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� Step-specific settings
The only available step settings for Parallel Subprocesses are display text and description. They do not
have owner assignments or due dates. Owner assignments and due dates are defined individually for
each sub-step.

� Restrictions and limitations
l A Parallel Subprocess must have two or more sub-steps, to define the steps that can be

performed in parallel.

l Approval Process Steps cannot be sub-steps of a Parallel Subprocess. Because the child steps of a
Parallel Subprocess can be completed in any order, an approval or a rejection would not make
sense in this context.

o If you want to approve the steps in a Parallel Subprocess, then the next step after the
Parallel Subprocess should be an Approval Process Step. In this case, note that if the
assigned user rejects the process to return to the prior step, the entire Parallel Subprocess
will be "reopened" and made active again.

o If you want multiple Approval Process Steps to be active simultaneously, then you should
use a Multiple Approvals Step. This is a special type of parallel subprocess that only allows
for approval steps.

l When an owner of a sub-step in a Parallel Subprocess completes a step, they will not see the
previous and next steps in the Process Action dialog. Within the context of the subprocess, all sub-
steps are occurring concurrently and there is no "previous" and "next". However, if a user has the
ability to view all steps of the process in the Process task pane, they can see the overall step
progression there.

Report Process Step

The Report Process Step is intended to be used for steps where you need a user to run a report in Axiom
Budgeting and Performance Reporting. For example, you may want a user to run a report for any of the
following reasons:

l Verify data beforemoving on in the process
l Run a save-to-database report utility
l Distribute report packages using File Processing features
l Process alerts

� Process behavior
When the Report Process Step is the active step, the step owner has two actions available in the Process
task pane:

l Open report: The user can click this link to access the report according to their security
permissions. The step name and/or description should make it clear to the user what they are
expected to do with the report.
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l Mark step as complete: The user can click this link to complete the active task.

� Step-specific settings
When configuring a Report Process Step, complete the following settings in addition to the general step
settings:

Item Description

Selected Report The report to associate with this step. Click the folder icon to select a file in the
Reports Library.

Open Form As If the report is form-enabled, then you can specify how the file is opened when
the user opens it from the Process task pane:
l Form in the client(default)
l Form in web browser
l Spreadsheet

This option only displays if the selected report is form-enabled.

NOTE: When using the Axiom Excel Client, Axiom forms will always open in the
user's browser instead of within the application, regardless of this setting.

NOTE: The assigned user for the step must have the appropriate security permissions to access the
report and perform the desired action (such as Allow Save Data to perform a save-to-database). The
Report Process Step does not grant any permissions or elevate any existing permissions.

Scheduler Process Step

The Scheduler Process Step is intended to be used for steps where you want to run a Scheduler job as
part of the process. Unlike other step types, the Scheduler Process Step is an automated step, meaning
that no user intervention is required to run the Scheduler job or to complete the step (assuming no
errors occur).

� Process behavior
When the Scheduler Process Step is made active, Axiom Budgeting and Performance Reporting will
automatically place the job in the Scheduler queue for immediate processing (pending Scheduler thread
availability). If the processing completes successfully, then the step is automatically marked as complete
and the process continues to the next step. Any notifications defined in the job are honored; no
additional notifications are sent.
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If the job experiences any errors, or if Axiom Budgeting and Performance Reporting is unable to schedule
the job for some reason, then the step is effectively stalled. However, unlike other stalled steps, if this
occurs the assigned user has several options available in the Process task pane to attempt to resolve the
issue:

l View job results: The user can view the job results to troubleshoot the issue. However, note that
the user must have the Scheduled Jobs User permission and at least read-only access to the job
in order to view the job results.

l Restart scheduled job: This option places the job in the Scheduler queue to be run again. This
assumes that the error was the result of some temporary issue which no longer applies, or that
the underlying issue has been addressed and the job is now expected to complete without error.

l Mark step as complete: This option can be used to ignore the job error and manually complete
the step. This may be appropriate for situations where the job completed with partial success
which is sufficient to consider the step complete, or for cases where the step owner or an
administrator ran the Scheduler job or related utility manually as part of troubleshooting the
original issue, so the job does not need to be run again as part of processing this step.

� Step-specific settings
When configuring a Scheduler Process Step, complete the following settings in addition to the general
step settings:

Item Description

Selected
Scheduler Job

The Scheduler job to associate with this step. Click the folder icon to select the
job.

Although the step is automated, you must still specify an assigned user for the step. The job will run
using the permissions of the assigned user. The assigned user is not required to have any access to
Scheduler or to the specified job, although ideally the user will have this level of permissions in order to
troubleshoot the job results if any errors occur.

Table Process Step

The Table Process Step is intended to be used for steps where you need a user to perform some kind of
administrative action on a table.
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� Process behavior
When the Table Process Step is the active step, the step owner has two actions available in the Process
task pane:

l <Action>: The user can click the action link to open a table or perform the action associated with
this step. The text of the action and what it does depends on the Selected Action for the step. For
example, if the Selected Action is Clone Table, then the link text is "Clone Table" and clicking on it
opens the Create Table dialog for table cloning.

l Mark step as complete: The user can click on this link to complete the active task.

� Step-specific settings
When configuring a Table Process Step, complete the following settings in addition to the general step
settings:

Item Description

Selected Table The table on which to perform the designated action. Click the folder icon to
select a table.

Selected Action The action to perform on the table:
l Clone Table
l Edit Table Data (meaning Open Table in Spreadsheet)
l Edit Table Structure

In all cases, the assigned user will be able to open the associated dialog from the
Process task pane when the step is active. The display text and/or description
for the step should make it clear to the user what they are expected to do in
order to consider the step complete.

If Edit Table Data is the selected action, then you can optionally define a Data
Filter and/or a Row Limit for the task.

Data Filter Optional. Define a data filter to limit the data to be displayed in Open Table in
Spreadsheet. Use the Filter Wizard to create the filter criteria statement.

This setting only applies if Edit Table Data is the selected action.

Row Limit Optional. Enter a number to limit the number of rows to be displayed in Open
Table in Spreadsheet.

This setting only applies if Edit Table Data is the selected action.

NOTE: The assigned user for the step must have the appropriate security permissions to access the
table and perform the designated action. The Table Process Step does not grant any permissions or
elevate any existing permissions.
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Configuring Notifications
General processes can send several different types of notifications, all of which can be configured at the
process level and at the step level. These notifications are used to inform or remind users about tasks
they need to perform, or to inform other interested parties about the current step status.

When setting up notifications for a process, you can determine:
l The types of notifications that are sent for the process and for each step
l The recipients of each notification
l The content of each notification
l The delivery method of each notification (email, Notifications task pane, or both)
l Whether notifications are sent at all, for the entire process or per step
l The frequency and timing of reminder notifications

When defining notifications for a process, you can define default notifications at the process level. These
process-level notifications are inherited by the individual steps in the process. At the step level, you can
choose to enable or disable the inherited notifications as needed, and you can define custom
notifications to be used for that step only.

NOTE: The information in this section does not apply to administrative notifications for a process,
which are system-managed notifications intended to inform the process owner about the general
operation of the process and any errors encountered. For more information about process
ownership and administrative notifications, see Designating the process owner.

Notification types for general processes

The following types of notifications can be sent for a general process in process management:

Notification
Type

Description Available Recipient
Types

Step Activated Notification that is sent when a step is made active.
By default, the notification informs the step owner(s)
that they have a task to perform in the process. You
can customize the default notification as desired.

NOTE: This notification type is not used when a
previously active step is reopened due to an approval
step rejection. Instead, the Step Reopened
notification type is used.

l Task owners
l Any named user or

role
l Process owner
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Notification
Type

Description Available Recipient
Types

Step Reopened Notification that is sent when a step is reopened, due
to a subsequent approval step being rejected. By
default, the notification informs the step owner that
their task has been reopened. You can customize the
default notification as desired.

l Task owners
l Any named user or

role
l Process owner

Step Rejected Notification that is sent when an approval step is
rejected. This notification type is not configured by
default and is entirely user-definable.

This notification type only applies to approval steps
and multiple approval steps.

NOTE: This notification type is about the step that
was rejected, not about the prior step that was
reopened as a result of the rejection. It is intended to
inform the process owner or other interested parties
about the rejection.

l Previous step
owners

l Any named user or
role

l Process owner

Step Completed Notification that is sent when a step is completed.
This notification type is not configured by default and
is entirely user-definable.

l Previous step
owners

l Any named user or
role

l Process owner

Due Date
Reminder

Notification that is sent to remind users of an
upcoming step due date. This notification type is not
configured by default and is entirely user definable,
including the reminder schedule.

l Task owners
l Any named user or

role
l Process owner

Overdue
Reminder

Notification that is sent to remind users of an
overdue step. This notification type is not configured
by default and is entirely user definable, including the
reminder schedule.

l Task owners
l Any named user or

role
l Process owner

NOTE: For more information on the recipient types, see Customizing recipients for process
notifications.

Most of these notification types do not apply to subprocess steps (the parent step of the subprocess).
For example, a Step Activated notification is not sent when a multiple approvals step is made active;
instead the notification is sent for the first sub-step in the subprocess. Similarly, the Due Date Reminder
and Overdue Reminder notification types do not apply to subprocess steps, because these steps do not
have due dates (only the sub-steps do).
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The only notification types that apply to subprocess steps are:
l Step Completed: This can be used with any subprocess. It will be sent when all sub-steps in the

subprocess are completed.

l Step Rejected: This only applies to multiple approvals steps. It will be sent when themultiple
approvals subprocess is rejected due to any of its approval sub-steps being rejected.

You can definemultiple instances of the same notification type, at any level of the process. If multiple
notifications apply when a particular step activity occurs (such as when a step is activated), then all
eligible notifications will be sent. For example, you might do this if you want to define different
notification content for different recipients of the notification type.

� Notification design considerations
Keep in mind the following design considerations when defining notifications for a process.

l Step Activated / Step Reopened - Sending to recipients other than step owners
If you want to send the Step Activated or Step Reopened notification to any recipients other than
the step owners, you should consider creating a second instance of the notification type with text
that is appropriate for the other recipients.

The default text for these notification types assumes that the notification is being read by the step
owners. The text includes statements such as "You have a new task..." and "Please login to Axiom
Budgeting and Performance Reporting to complete your tasks." It may be confusing for process
owners or other recipients to receive this notification because these users do not actually have a
new task, they are just being informed of someone else being assigned a new task. The non-owner
recipients should have a separate instance of the notification type, with text that better reflects
the informational status of the notification, such as: "A new task has been issued for Step 'Import
data' in Process 'Rollover'."

l Step Activated / Step Reopened - Delivering to the Notifications task pane
Because the default delivery method is email, the default text for these notifications contains the
sentence "Please login to Axiom Budgeting and Performance Reporting to complete your tasks." If
you decide to deliver notifications to the Notifications task pane instead, this sentence does not
apply and should be removed.
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l Step Rejected - Using with multiple approvals steps
If you want to use the Step Rejected notification type with a multiple approvals step, you should
consider at which level you want the notification to be issued. You can enable Step Rejected for
each approval sub-step in the subprocess, which means that the notification will be sent at the
level of the individual sub-step that was rejected. Or, you can enable Step Rejected at the
subprocess level (the parent multiple approvals step), which means that the notification will be
sent for the parent step when any of the sub-steps are rejected.

This choice impacts how the variables are resolved in the notification text and what information is
available to the notification. You can also choose to send both levels of notification, but this is
probably more notifications than necessary for the same event, unless each notification is for
different recipients.

Disabling notifications for a process

By default, each process includes "built-in" notifications intended to inform step owners about new and
reopened tasks in the process. You can define additional notifications and customize the built-in
notifications as needed.

However, if you don't want to send these notifications, then you can disable notifications for the entire
process or for specific steps. If notifications are disabled, then the only way users can learn of their active
tasks is through the Process task pane, or through other custom reports created by your organization.

� Disabling notifications at the process level
Use the Enable Process Notifications option on the Notifications tab to enable or disable notifications
for the entire process.

l By default, this check box is selected, which means notifications are enabled for the process.
Notifications will be sent according to the notification settings defined for each individual step
(which may include using the inherited process-level notifications).

l If you clear this check box, then notifications are disabled for the process. No notifications will be
sent. TheDefault Notifications section becomes grayed out and cannot be edited. Additionally,
any notification settings made at the individual step level will be ignored.

Notifications disabled for a process
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Administrative notifications are always sent and cannot be disabled. For more information on these
notifications, see Designating the process owner.

� Disabling notifications at the step level
If Enable Process Notifications is enabled at the process level, then you can enable or disable
notifications at the individual step level.

To disable notifications for a particular step, go to the Process Steps tab and then select the desired step.
In the Step Notifications sub-tab, you can enable or disable notifications by type.

l Inherited Notifications: These notifications are inherited from the process-level notifications. To
disable the inherited notifications at the step level, clear the Enabled check box for each
notification.

Inherited notifications disabled for a step

l Custom Notifications: These notifications are defined for the current step. To disable a custom
notification, clear the Enabled check box.

It would be unusual to define a custom notification for a step and then disable it, unless you are
disabling it temporarily for testing purposes or for other transient reasons. If you do not need the
custom notification for the step, you can delete it instead of disabling it.

Any inherited or custom notifications that are disabled for the step will not be sent for that step.

If Enable Process Notifications is disabled at the process level, then any step-level notification settings
are ignored and no notifications will be sent for the process. However, you can continue to edit the step-
level notification settings so that they are configured as you want them in case you later re-enable
notifications at the process level. Awarning message displays across the top of the Step Notifications
sub-tab to inform you when notifications are disabled at the process level.

� Disabling notifications at the subprocess level
It is not possible to disable notifications for all sub-steps of a subprocess. If you want to disable
notifications for a subprocess, you must disable them for each individual sub-step in the subprocess,
using themethodology described in the previous section.
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Inherited and custom notifications can also be disabled for the subprocess (parent) step itself, using the
methodology described in the previous section.

Defining default notifications for a process

You can define default notifications at the process level. These notifications are inherited by all eligible
steps in the process, and can be enabled or disabled for those steps.

Default notifications are best for notifications that you want to use for all or most of the steps in the
process. If many steps use the same notification, then it is easier to define it at the process level rather
than for each individual step. If you don't want a default notification to apply to a particular step, then
you can disable it at the individual step level.

The following steps are eligible to inherit the default notifications defined at the process level:
l Any top-level step that is not a subprocess step can inherit all default process-level notifications.

l Subprocess steps (the parent step of the sub-steps) can only inherit certain notification types from
the default process-level notifications. Notification types that do not apply to subprocess steps
will not be inherited by those steps.

l Sub-steps of parallel subprocesses (including multiple approvals steps) can inherit all default
process-level notifications.

� Built-in default notifications for all processes
By default, all process definitions start with two default notifications at the process level: a Step Activated
notification and a Step Reopened notification.

Built-in default notifications for a process

These built-in notifications are configured as follows:
l Notification recipients are set to task owners.
l Notification delivery is set to use the process-level setting (which by default is email delivery).
l Themessages contain basic details about the process and the current task.

You can use the built-in notifications as is, or you can customize them as desired. All aspects of the
notification are customizable. You can also opt to delete the built-in notifications and create your own
from scratch.

The following screenshots show example default process notifications for a general process definition.
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Step Activated notification

Step Reopened notification

� Adding, editing, and deleting default process notifications
You can add, edit, and delete default process notifications using theNotifications tab of the Edit Process
dialog. Any existing default notifications defined for the process (including the built-in notifications)
display in theDefault Notifications grid.
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You can define default process notifications at any time. If the process is already active, any changes
madewill apply to new notifications delivered after that point.

To add a default notification:
1. Click Add Notification, then select the notification type that you want to add. For more

information on the available notification types, see Notification types for general processes.

2. In the Edit Process Notification dialog, define the properties for the new notification. For more
information, see Notification properties for process definitions. Note the following:

l Most newly added notifications do not have any default recipients. You must add the
desired recipients before the notification is valid for use. The exception is reminder
notification types—these notifications go to task owners by default.

l Newly added notifications do not have any defined message text. You must define this
content before you can save the notification.

3. Click OK to save the notification.

4. You are prompted to choose whether you want the new notification to be enabled in existing
steps by default. Click Yes orNo as appropriate.

NOTE: It is not possible to globally enable the notification for all steps after it is saved. If you
don't enable the notification at this point, you must manually go to each existing step and
enable it as needed.

The notification is added to the grid, and is available to be inherited by all eligible steps. Whether the
notification is enabled in existing steps depends on your Yes/No selection when saving the notification.
Whether the notification is enabled for newly created steps depends on theDefault Enablement setting
for the notification.

To delete a default notification:
l Select the notification in the grid, and then click Delete.

The deleted notification is removed from the process. Any steps that were inheriting the notification can
no longer use it.

To edit a default notification:
l Double-click the notification in the grid. You can also select the notification in the grid and then

click Edit Notification.

Within the Edit Process Notification dialog, you can edit notification properties such as:
l The delivery method for the notification (email, Notifications task pane, or both)
l The urgency of the notification
l The recipients of the notification
l The notification message contents
l The notification reminder schedule (for reminder notification types only)
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Defining notifications at the step level

For each step in a process definition, you can configure notifications as follows:
l You can manage inherited notifications for the step. These are notifications that the step inherits

from the default process-level notifications. Inherited notifications can be enabled or disabled,
and you can optionally add recipients for the current step.

l You can define custom notifications for the step. These notifications only apply to the current
step.

NOTE: If multiple instances of the same notification type apply to a step, then each instance will be
sent when the notification is triggered. For example, if a step has an inherited Step Activated
notification as well as a custom Step Activated notification, then both notifications will be sent
(unless one of the notifications is disabled).

� Manage inherited notifications for a step
You can manage inherited notifications for the individual steps in a process. All steps inherit the default
notifications defined at the process level. You can enable or disable inherited notifications at the step
level, and you can add recipients at the step level.

To manage inherited notifications for a step, go to the Process Steps tab in the Edit Process dialog. Select
the step, then go to the Step Notifications sub-tab. Any existing inherited notifications for the step
display in the Inherited Notifications grid.

l Use the Enabled check box to enable or disable an inherited notification. If enabled, the
notification will be sent for this step; if disabled, the notification will not be sent.

Whether an inherited notification is enabled by default for a step depends on the choices made
when the notification was created at the process level or the subprocess level.
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l To add recipients to an inherited notification, select the notification in the grid and then click Edit
Recipients. For more information, see Adding step-specific recipients to inherited notifications.

The only inherited notification property that can be customized at the step level is the recipients. If you
want to customize the text of an inherited notification for use with a specific step only, then you should
do one of the following (depending on what you want to accomplish):

l Disable the inherited notification and instead create a custom notification of the same type for the
step.

OR

l Leave the inherited notification enabled and create a custom notification of the same type for the
step, but send each notification to different recipients.

Inherited notifications for subprocess steps
Parallel subprocess steps and multiple approvals steps can only inherit certain types of notifications from
the process. This only applies to the parent subprocess step itself. The child steps of the subprocess can
inherit all notification types as normal.

The only notification types that a subprocess step can inherit are:
l Step Completed: When all steps in the subprocess have been completed, the Step Completed

notification will be sent.

l Step Rejected: This notification type only applies to multiple approvals steps. If any of the
approval sub-steps are rejected, the Step Rejected notification will be sent for the parent multiple
approvals step. Note that this type of notification should be defined at either the parent level or
the child level, but not both (unless you want to send each notification to different recipients).

� Define custom notifications for a step
You can define custom notifications for each step in a process. The custom notifications defined at the
step level only apply to that step. If the process is already active, any changes will apply to new
notifications delivered after that point.

To define custom notifications for a step, go to the Process Steps tab in the Edit Process dialog. Select
the step, then go to the Step Notifications sub-tab. Any existing custom notifications defined for the
step display in the Custom Notifications grid.

To add a custom notification:
1. Click Add Notification, then select the notification type that you want to add. For more

information on the available notification types, see Notification types for general processes.

2. In the Edit Process Notification dialog, define the properties for the new notification. For more
information, see Notification properties for process definitions. Note the following:
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l Most newly added notifications do not have any default recipients. You must add the
desired recipients before the notification is valid for use. The exception is reminder
notification types—these notifications go to task owners by default.

l Newly added notifications do not have any defined message content. You must define this
content before you can save the notification.

3. Click OK to save the notification.

The notification is added to the grid, and by default it is enabled for the step. You can disable it if desired,
if you want to temporarily turn off the notification for the step.

To delete a custom notification:
l Select the notification in the grid, and then click Delete.

The deleted notification is removed from the step.

To edit a custom notification:
l Double-click the notification in the grid. You can also select the notification in the grid and then

click Edit Notification.

Within the Edit Process Notification dialog, you can edit notification properties such as:
l The delivery method for the notification (email, Notifications task pane, or both)
l The urgency of the notification
l The recipients of the notification
l The notification message contents
l The notification reminder schedule (for reminder notification types only)

Custom notifications for subprocess steps
You can define custom notifications for parallel subprocess steps and multiple approvals steps. The
process is the same as for normal steps. However, only Step Completed and Step Rejected (for multiple
approvals steps) notifications can be defined for the parent subprocess step. The child steps of the
subprocess can use all notification types as normal.

Customizing notification content for general process definitions

The default Step Activated and Step Reopened notifications for process definitions have default content
that you can use as is, or you can customize it as desired. When defining all other notifications, the
content is entirely up to you—there is no default content.

All notification content is defined in theNotification Message tab of the Edit Process Notification
dialog. To access this dialog, go to theNotifications tab for the process or the Step Notifications tab for
a step, and then add or edit a notification.
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NOTE: If a step has inherited a notification from the process level, the content of that notification
cannot be edited at the step level. You must go to the process level to edit the content of the
inherited notification.

Process management supports a set of process variables that can be used to return process, step, and
task information for use in notification content. For example, you can return the name of the process,
the name of the step, and the due date of the step.

� Notification message sections
Each notification message has two sections—theNotification Subject and theNotification Message
Body. Both sections for the notification must have some content in order to be valid.

The subject is rendered as the email subject line and/or as the notification title in the Notifications task
pane. Themessage body is the body text.

Example notification for a general process definition
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� Process variables
Process variables can be used in all sections of the notification message, although certain variables can
only be used in certain sections. The variables use standard variable syntax in Axiom Budgeting and
Performance Reporting—for example: {StepDueDate}.

Use the Insert variablemenu for the current section to insert a variable into the text. Themenu displays
only the variables that are currently valid for use, based on the current section, the step type, and the
process type. Although you can manually type the variables, it is recommended to use themenu to
ensure that you only use variables that are valid for the current section. When you choose a variable
from themenu, it is displayed in plain text—for example, Due Date for {StepDueDate}.

General variables
The following variables return general information about the process and its steps.

Variable Description Notification
Types

{CompletingUserComment} The comment made by the user who
completed the step.
l This variable resolves to blank if no

comment was entered.
l If the step that was completed was a

parallel subprocess or a multiple approvals
step, then this variable resolves as a list of
sub-steps, completing users, and
comments, such as:

Sub-step 1 name - user name -
comment
Sub-step 2 name - user name -
comment

Step Completed

{CompletingUserName} The name of the user who completed the
step.
l If the step that was completed was a

parallel subprocess or a multiple approvals
step, then this variable resolves as a list of
sub-steps and completing users, such as:

Sub-step 1 name - user name
Sub-step 2 name - user name

Step Completed

{CurrentStepName} Name of the current step. All notification
types
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Variable Description Notification
Types

{CurrentStepDescription} Description of the current step. All notification
types

{CurrentStepNumber} Number of the current step. All notification
types

{DaysPastDue} Number of days past the due date for the
current step.

Due Date
Reminder,
Overdue
Reminder

{DaysTilDueDate} Number of days until the due date for the
current step.

Due Date
Reminder,
Overdue
Reminder

{OwnerFullName} The full name of the current task owner. Step Activated,
Step Reopened,
Due Date
Reminder,
Overdue
Reminder

{NextStepDueDate} The due date of the next step in the process.

l If the next step is a parallel subprocess or a
multiple approvals step, then this variable
resolves as a list of sub-steps and due
dates, such as:

Sub-step 1 name - due date
Sub-step 2 name - due date

l If the completed step was a sub-step of a
parallel subprocess or a multiple approvals
step, and the subprocess is still active,
then this variable resolves to text such as
"N/A - parallel subprocess step is not
complete".

l If the completed step was the last step in
the process, then this variable resolves to
text such as "N/A - the process is
complete".

Step
Completed,
Step Rejected
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Variable Description Notification
Types

{NextStepName} The name of the next step in the process.

l If the next step is a parallel subprocess or a
multiple approvals step, then this variable
resolves as follows:

Parallel Subprocess Step Name
(Comma-separated list of sub-step
names)

l If the completed step was a sub-step of a
parallel subprocess or a multiple approvals
step, and the subprocess is still active,
then this variable resolves to text such as
"N/A - parallel subprocess step is not
complete".

l If the completed step was the last step in
the process, then this variable resolves to
text such as "N/A - the process is
complete".

Step
Completed,
Step Rejected

{NextStepOwner} The owner of the next step in the process.

l If the next step is a parallel subprocess or a
multiple approvals step, then this variable
resolves as a list of sub-steps and owners,
such as:

Sub-step 1 name - user name
Sub-step 2 name - user name

l If the completed step was a sub-step of a
parallel subprocess or a multiple approvals
step, and the subprocess is still active,
then this variable resolves to text such as
"N/A - parallel subprocess step is not
complete".

l If the completed step was the last step in
the process, then this variable resolves to
text such as "N/A - the process is
complete".

l If the owner is a role, then this variable
resolves as a comma-separated list of all
owners in the role.

Step
Completed,
Step Rejected
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Variable Description Notification
Types

{PreviousStepName} The name of the previously active step in the
process.
l This resolves to N/A for the first step in the

process when used in Step Activated
notifications.

l If the previous step was the last-completed
step of a parallel subprocess or a multiple
approvals step, then this variable resolves
as follows:

Parallel Subprocess Step Name
(Comma-separated list of sub-step
names)

Step Activated,
Step Reopened

{PreviousSubmitterComment} The comment made by the user who
completed the previously active step.
l This resolves to N/A for the first step in the

process. For other steps, it resolves to
blank if no comment was entered.

l If the previous step was a parallel
subprocess or a multiple approvals step,
then this variable resolves as a list of sub-
steps, submitters, and comments, such as:

Sub-step 1 name - user name -
comment
Sub-step 2 name - user name -
comment

Step Activated

{PreviousSubmitterName} The name of the user who completed the
previously active step.
l This resolves to N/A for the first step in the

process.
l If the previous step was a parallel

subprocess or a multiple approvals step,
then this variable resolves as a list of sub-
steps and submitters, such as:

Sub-step 1 name - user name
Sub-step 2 name - user name

Step Activated
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Variable Description Notification
Types

{ProcessName} The name of the process (display name if
defined, process name if not).

All notification
types

{RecipientFirstName} The first name of the notification recipient. All notification
types

{RecipientFullName} The full name of the notification recipient. All notification
types

{RejectingUserComment} The comment made by the user who rejected
the step (or in the case of On Demand Process
Aborted, the user who aborted the plan file in
the process).
This variable resolves to blank if no comment
was entered.

Step Reopened,
Step Rejected,
On Demand
Process
Aborted

{RejectingUserName} The name of the user who rejected the step
(or in the case of On Demand Process
Aborted, the user who aborted the plan file in
the process).

Step Reopened,
Step Rejected,
On Demand
Process
Aborted

{StepDueDate} The due date for the step. Step Activated,
Step Reopened,
Due Date
Reminder,
Overdue
Reminder

{TaskCount} The count of tasks covered by this
notification.

Step Activated,
Step Reopened,
Due Date
Reminder,
Overdue
Reminder

Other variables
The following variables can only be used in notifications for Report Process Steps.

Variable Description Notification
Types

{LinktoReport} Link to open the specified report for the step. Any notification
type
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Note the following when using the {LinkToReport} variable:
l If the report is form-enabled, then the hyperlink will open the file as a form or as a spreadsheet

depending on the step-level setting Open Form As. For email notifications, if the step is
configured to open the file as a form, then the form will be opened in theWeb Client (browser) in
all cases. For notifications delivered to the Notifications task pane, the option to open the form in
the browser or the desktop client will be honored.

l If the report is not form-enabled, the hyperlink opens the report as a spreadsheet in the user's
default desktop client.

l When the report is opened as a spreadsheet and the notification is sent via email, the hyperlink
uses the same format as hyperlinks generated using GetDocumentHyperlink, including the
differing URL format for systems using SAML or OpenID Authentication.

Customizing recipients for process notifications

When defining the notifications for a process definition, you can customize the recipients for each
notification. You can choose specific users and roles to receive notifications, and you can select defined
classes of recipients such as task owners and the process owner.

� Recipient types
The following recipient types are available for process notifications. Certain recipients are only available
for certain notification types.

Recipient Types Description

Task Owners The notification will be sent to the current task owners for the step.

This recipient type is not available for the Step Completed or Step Rejected
notification types, because once the step is completed it has no current owners.

User Select any named user defined within Axiom Budgeting and Performance
Reporting security to send the notification to that user. This recipient type is
available for any notification.

Role Select any named role defined within Axiom Budgeting and Performance
Reporting security to send the notification to all users in that role.

Process Owner The notification will be sent to the process owner. This recipient type is available
for any notification.

Previous Step
Owners

The notification will be sent to the users who completed all previous steps in the
process. This recipient type is only available for the Step Completed and Step
Rejected notification types.

For more information, see Behavior of Previous Step Owners recipient type.
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Generally speaking, the Task Owners recipient type is intended to be used when you want to inform a
user that they have a task to complete in the process, or to remind the user that they need to complete
the task. All other recipient types are intended to inform interested users about what is currently going
on with the process. For example, a process owner may want to receive a notification as each step in the
process is completed, to help them keep tabs on the process. Similarly, theremay be a specific user or
role who is also interested in receiving this information, for the entire process or perhaps for a specific
step.

When using different types of recipients for the same notification type, in most cases you should define
multiple notifications with different text. The text for task owners should be action-oriented (such as
"You have a new task to complete for process Rollover"), whereas the text for interested parties is more
informational ("User jdoe completed step Import Actuals for process Rollover").

� Defining recipients for a notification
When you create or edit a notification at any level of the process, you can specify the recipients on the
Notification Configuration tab of the Edit Process Notification dialog. The Add Recipient list only
shows the recipients that are valid for the current notification type and process type.
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Once the notification has been saved, you can see the list of recipients in the notifications grid:

� Adding step-specific recipients to inherited notifications
When a step inherits a notification from the process level, you have the option of adding recipients for
that step only.

For example, imagine that you want to notify a specific user when a particular step completes. You can
always choose to create a custom notification for that step and send it to that user. However, if an
inherited Step Completed notification is already available to the step, then you can just add the user to
that notification.

To add the user to the inherited notification, select the step and go to the Step Notifications sub-tab.
Select the notification in the grid, then click Edit Recipients.

In the Edit Recipients dialog, you can see the default recipients defined for the inherited notification at
the top of the dialog. You cannot remove any of these recipients, but you can add a recipient for this
step only. In the following screenshot, the user Jane Doewill be included in the notification when this
step is completed.
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l To add a recipient, click Add Recipient and then select the type of recipient to add. Any recipient
types that are already included in the default recipients are not listed here.

l To remove an additional recipient, select the recipient and then click Delete.

Any recipients listed in the Additional Recipients section will receive the notification for this step only.

� Behavior of Previous Step Owners recipient type
The Previous Step Owners recipient type can be used to notify the previous owners of a process about
the status of subsequent process steps. For example, users who completed the previous steps of the
process may want to knowwhen a certain milestone step of the process is completed, or when the final
step of the process is completed. This notification type has some special behaviors depending on the
particular process configuration.

For purposes of determining the users who are considered "previous step owners," only the users who
completed previous steps qualify. Note the following:

l Assigned step owners who did not complete a step are not included as a recipient. For example, if
the owner of a step was a role with three users, only the user who actually completed the step will
receive the notification.

l If a previous step was completed by an administrator or the process owner (overriding step
ownership), then that completing user will receive the notification instead of the assigned step
owner.
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l If a previous step was skipped or not completed (due to aMove current step operation), then
that step will not have a completing user to receive the notification.

If a process definition contains a parallel subprocess (including multiple approvals), the previous step
owners are treated as follows:

l When a sub-step of the parallel subprocess is completed, the other sub-steps in the subprocess
are ignored for purposes of determining previous step owners. This is because the sub-steps of
the parallel subprocess do not have an order, so the concept of "previous" does not apply.
However, the previous step owners of steps completed before the subprocess will receive a
notification.

l When steps after the parallel subprocess are completed, the previous step owners of all sub-steps
of the parallel subprocess will receive a notification.

Setting up schedules for reminder notifications (standard processes)

When defining a Due Date Reminder or Overdue Reminder notification for a process definition, you must
set the schedule for these reminders.

Within the Edit Process Notification dialog, the schedule is defined on the Reminder Configuration tab.
This tab is only present for reminder notifications—all other notifications are triggered by step events
such as step activation or completion.
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Example Reminder Configuration tab

� Due Date Reminder schedules
To decide on the appropriate Due Date Reminder schedule, you should consider the following:

l Howmany days before the due date do you want the reminders to start? This will impact the start
of the schedule.

l Howmany reminders do you want to send / how frequently should the user be reminded? This
will impact the reminder frequency and the end of the schedule.

l Do you want to send a reminder on the due date itself?

If you want to send reminders prior to the due date and on the due date itself, keep in mind that you
may want to use different text for these notifications. For example, when sending reminders before the
due date, you probably want to include text such as: "This is a reminder that your task for Step 'Import
Data' is due in 3 days." If you use the same text on the due date, it will resolve as "due in 0 days"—which
is technically true, but not as clear as saying "this task is due today." You might also want to use stronger
wording in the notification on the due date itself. To do this, you can create two Due Date Reminder
notifications, one to be sent before the due date, and one to be sent only on the due date. Each
notification would have different text, and use a different reminder schedule.
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To set the reminder schedule for a Due Date Reminder notification, complete the following settings on
the Reminder Configuration tab:

1. In the Reminder Schedule section, set the start date for the reminder by editing the setting Start _
_ day(s) before process step is due. Enter any number of days before the due date. By default,
this is set to 1 day before the due date.

For example, if the step is due on 1/10/2016 and you set the start date to 3 days before the due
date, then reminders will start on 1/7/2016.

You can specify 0 days as the start date if you only want to send a reminder on the due date itself.

2. In the Reminder Schedule section, set the stop date for the reminder by selecting one of the
following options:

l Until due date (default): Reminders will be sent from the start date until the due date
(including the due date itself).

l Until __ day(s) before process step is due: Reminders will be sent from the start date until
the number of days specified before the due date. By default this is set to 1 day before the
due date.

l Single notification only: The reminder will be sent once, on the start date.

3. In the Reminder Frequency section, select the frequency of the notifications:
l Every __ day(s) (default): The reminder notification will be sent according to the specified

day interval, from the start date to the end date. By default this is set to send a notification
every 1 day, meaning a notification will be sent each day. All days of the week are included
when choosing this option, including Saturday and Sunday.

l Every weekday: A reminder notification will be sent each weekday (Monday-Friday), from
the start date to the end date. No notifications will be sent Saturday or Sunday.

NOTE: If Every weekday is selected and the configured schedule causes a notification to
fall on the weekend, that notification is simply not sent—it is not moved to the nearest
weekday. This means that some schedule configurations may not send any
notifications if the entire schedule happens to fall on the weekend. Specifically, you
should not select this option if you are only sending a single notification, in case that
single notification falls on the weekend.

4. In the Reminder Time section, select the time of day at which this reminder will be evaluated and
delivered. You can select any hour from 12:00 AM to 11:00 PM. By default, this is set to 5:00 PM.
See How reminder schedules work for more information.

The following table contains some example schedules and the resulting notifications. The frequency is
assumed as every 1 day in these examples.
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Example Start Date Stop Date Resulting Notifications

Reminders before and on
the due date

3 days
before

Until due
date

4 - one each on the three days before
the due date, and one on the due
date

Reminders only before
the due date

3 days
before

Until 1 days
before step is
due

3 - one each on the three days before
the due date, none on the due date

Reminder only on the
due date

0 days
before

Single
notification

1 - one on the due date

The frequency impacts howmany of these notifications are ultimately sent. If the frequency is set to
every 2 days in the first example, then only 2 of the 4 eligible notifications will be sent. Similarly if the
frequency is set to weekdays only, then the number of notifications sent depends on howmany of those
days (if any) fall on a weekend.

� Overdue Reminder schedules
To decide on the appropriate Overdue Reminder schedule, you should consider the following:

l Howmany days after the due date do you want the reminders to start?
l Howmany reminders do you want to send / how frequently should the user be reminded?

Of course, at a certain point, if a task is persistently overdue then some other action should be taken.
Your organization may run reports that are intended to inform the process owner about tasks that are
overdue, so that they can take action accordingly. Another option in this case would be to create an
Overdue Reminder notification that goes to the process owner or to other designated users. For
example, your organization may have a rule that if a task is 3 days late, the situation should be escalated
to the task owner's manager. You could have two Overdue Reminder notifications—one that goes to the
task owners when the task becomes overdue, and another that goes to the process owner when the
task is 3 days late.

To set the reminder schedule for an Overdue Reminder notification, complete the following settings on
the Reminder Configuration tab:

1. In the Reminder Schedule section, set the start date for the reminder by editing the setting Start _
_ day(s) after process step is due. Enter any number of days after the due date. By default, this is
set to 1 day after the due date.

For example, if the step is due on 1/10/2016 and you set the start date to 1 day after the due date,
then reminders will start on 1/11/2016.
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2. In the Reminder Schedule section, set the stop date for the reminder by selecting one of the
following options:

l No end date (default): Reminders will be sent from the start date until the step is
completed.

l Until __ day(s) after process step is due: Reminders will be sent from the start date until
the number of days specified after the due date. By default this is set to 1 day after the due
date.

l Single notification only: The reminder will be sent once, on the start date.

3. In the Reminder Frequency section, select the frequency of the notifications:
l Every __ day(s) (default): The reminder notification will be sent according to the specified

day interval, from the start date to the end date. By default this is set to send a notification
every 1 day, meaning a notification will be sent each day. All days of the week are included
when choosing this option, including Saturday and Sunday.

l Every weekday: A reminder notification will be sent each weekday (Monday-Friday), from
the start date to the end date. No notifications will be sent Saturday or Sunday.

NOTE: If Every weekday is selected and the configured schedule causes a notification to
fall on the weekend, that notification is simply not sent—it is not moved to the nearest
weekday. This means that some schedules may not send any notifications if the entire
schedule falls on the weekend. Specifically, you should not select this option if you are
only sending a single notification, in case that single notification falls on the weekend.

4. In the Reminder Time section, select the time of day at which this reminder will be evaluated and
delivered. You can select any hour from 12:00 AM to 11:00 PM. By default, this is set to 5:00 PM.
See How reminder schedules work for more information.

� How reminder schedules work
Reminder notifications are evaluated once per hour using the system Scheduler job
System.ProcessNotifications.

This job checks all active steps in all active processes to see if these steps have any configured reminder
notifications.

l If a step has reminder notifications, the job checks the due date of that step and the schedule of
those notifications to see if any are eligible to be sent.

l If the notification is eligible to be sent, and the configured reminder time of the notification falls
within the current hour in which the job is running, the notification will be sent.

Under normal circumstances, this setup results in only one reminder being sent per day, for each eligible
step / notification combination. However, a reminder notification could be sent multiple times in a day if
either of the following occurs:

l The reminder time is edited for an active process.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1031



l The schedule for the system job is changed so that the job runs multiple times in an hour (or the
job is manually run again within an hour).

All times for this process are evaluated on the Axiom Application Server. When you select a time, you
select it based on your local time zone (shown next to the selected time for your reference). This selected
time is converted to Coordinated Universal Time (UTC) when it is saved to the server, so that the
reminders will be evaluated relative to your selected local time.

Reminder schedules are only evaluated while the step is active. If the step is completed, rejected, or
aborted, then no reminder notifications will be sent.

Notification properties for process definitions

The following properties can be set for each notification defined in a general process definition.

� Notification Configuration tab
This tab defines general properties for the notification.

Item Description

Display Name Optional. The name of the notification. This name is for use when configuring
notifications for the process; it is not displayed anywhere in the actual
notification to users.

If left blank, the notification type is used as the display name (such as "Step
Activated"). If you havemore than one of a particular notification type, you
should define a unique display name for each to avoid confusion.

Notification
Delivery

Specifies how the notification will be delivered to recipients.

By default, the option Use current process setting is enabled, which means that
the notification will be delivered according to the process-level delivery settings
on theNotifications tab. If you want to override the process-level settings for
this particular notification, then select Use notification-specific setting instead.

IfUse notification-specific setting is enabled, then select one of the following:
l Notification task pane: Display the notification in the recipient's

Notifications task pane.
l Email notification (default): Send the notification by email, using the

recipient's email address as defined in Axiom Security.
l Both notifications: Send the notification by email and display it in the

Notifications task pane.
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Item Description

Notification
Urgency

Specifies the urgency of the notification. Select one of the following:
l Normal Importance: The notification will not be called out as having any

particular importance.
l High Importance: The notification will be flagged as important. In the

Notifications task pane, the notification will display with an exclamation
point. For email notifications, the display depends on the recipient's email
client configuration.

Default
Enablement

Specifies whether the notification will be enabled by default in newly added
process steps that are eligible to inherit the notification. Select one of the
following:
l Enabled by default (default): The notification will be enabled by default in

newly added process steps.
l Disabled by default: The notification will be disabled by default in newly

added process steps.

This setting is only present when defining default notifications for the process. It
does not display for step-specific custom notifications.

This setting does not impact whether a notification will be enabled in existing
steps. When you create a new default notification, you will be prompted to
choose whether you want the new notification enabled in existing steps.

Notification
Recipients

The recipients of the notification. If recipients have already been selected, they
will display in the Notification Recipients box.
l To add recipients, click Add Recipient and then click the type of recipient to

add.
l To delete a recipient, select the recipient in the Notification Recipients box

and then click Delete.

� Notification Message tab
This tab defines themessage for the notification. All message sections for the notification must have
some content in order to be valid. For more information, see Customizing notification content for
general process definitions.

Item Description

Notification
Subject

Defines the subject line for the notification.

Notification
Message Body

Defines themessage body for the notifications. This text should contain all
necessary task details for the notification.
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� Reminder Configuration tab
This tab defines the reminder schedule for the "reminder" notifications. This tab only applies to the
following notification types: Due Date Reminder and Overdue Reminder. For more information, see
Setting up schedules for reminder notifications (standard processes).

Item Description

Reminder
Schedule

Specifies when reminder notifications will start, and how long they will continue.

To specify when reminder notifications will start (the start date):
l For due date reminders, enter the number of days before the due date that

you want reminders to start. By default, reminders start 1 day before the
step is due.

l For overdue reminders, enter the number of days after the due date that
you want reminders to start. By default, reminders start 1 day after the step
is due.

To specify how long reminder notifications will continue (the stop date), select
one of the following:
l Until due date / No end date (default): For Due Date Reminders,

notifications will continue until the due date is reached. For Overdue
Reminders, notifications will continue until the step is completed.

l Until __ day(s) before / after process step is due: Notifications will
continue until the specified number of days before the step is due (for Due
Date Reminders) or after the step is due (for Overdue Reminders). By default
this is set to 1 day.

l Single notification only: The notification will only be sent once, on the
specified start date.

Reminder
Frequency

Specifies the frequency of reminder notifications between the start date and the
stop date. Select one of the following:
l Every X days: A reminder notification will be sent according to the specified

day interval. By default this is set to send a notification every 1 day, meaning
a notification will be sent each day. All days of the week are included when
choosing this option, including Saturday and Sunday.

l Every weekday: A reminder notification will be sent each weekday (Monday-
Friday). No notifications will be sent Saturday or Sunday.

This option does not apply if the notification is set to Single notification only.

Reminder Time Specifies the time of day when reminders will be evaluated and delivered. Select
any hour from 12:00AM to 11:00PM. By default, this is set to 5:00 PM.
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Managing Active Processes
Once process definitions have been created, administrators and process owners can perform tasks such
as starting or stopping a process, viewing overall process status and process history, and managing step
status.

Management tasks can be performed from the following locations:
l On the Axiom tab, in the Administration group, go toManage > Process Management > Current

Processes.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Current Processes.

l From the Process task pane, click View status. This is only available for active processes.

You can also start processes and access process details from within the process definition itself.

Starting or stopping a process

A process is only managed by the system if it has been started. Once a process is started, it will remain
active until it is completed or stopped.

NOTE: Only administrators or process owners can start or stop a process.

� Starting a process
Once you have completed a process definition and you are ready to work on the process, you can start
it. When you start a process, Axiom Budgeting and Performance Reporting does the following:

l Creates a unique process instance to track the process steps and store the process details. Each
activation of a particular process definition is stored separately, so that you can always see the
historical details.

l Activates the first step in the process and creates one or more tasks as appropriate.

l Displays the activated process in the Process task pane. Administrators can see every activated
process; other users will only see the process if they are the process owner or if they have a task
for the currently active step.
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To start a process:
1. On the Axiom tab, in the Administration group, clickManage > Process Management > Process

Definitions.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Process Definitions.

This opens the Axiom Explorer dialog, showing the Process Definition Library (and any file group
Process Definitions folders that you have access to). You can also access these definitions from the
Explorer task pane.

2. Open the process definition that you want to start, and then click Start Process in the top right-
hand corner of the dialog.

NOTE: The process definition cannot be started if it contains any missing or invalid settings.
These validation errors will display at the bottom of the dialog if present. You can click the link
to be taken to the tab or step that contains the error. Once all errors are resolved, you will be
able to start the process.

3. At the confirmation prompt, click OK.

The process is now active. Once a process has been started, you can track its progress using the Process
Manager or by clicking the View status link in the Process task pane. For more information, see Viewing
process status and comments.

You can also start processes from the Process Manager dialog. On the Axiom tab, clickManage >
Process Management > Current Processes. In the Process Manager dialog, select Show inactive
processes. Select the process that you want to start, then click Start.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In the
Workflow group, click Process Management > Current Processes.

� Stopping a process
When you stop a process, all current tasks are deleted and the process status changes from Active to
Aborted. If the process definition is started again later, a new process instance will be created and the
process will start over from the first step. There is no way to restart a particular process instance at the
step it was on when it was stopped.
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To stop a process:
1. On the Axiom tab, in the Administration group, go toManage > Process Management >

Current Processes.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Current Processes.

2. In the Process Manager dialog, select the process that you want to stop, and then click Stop.

3. At the confirmation prompt, click OK.

You can also stop processes using the Process Status dialog. From the Process task pane (or a custom
task pane configured to show the process control), click View status. In the Process Status dialog, click
Stop process.

� Completing a process
General processes are automatically completed when all steps in the process are complete. Once a
particular process instance is completed, that same instance cannot be restarted. If the process
definition is started again, a new process instance will be created and the process will start over from the
first step.

Axiom Budgeting and Performance Reporting saves the process details for each activated instance of a
process. Administrators and process owners can always go back and view the available history. For more
information on viewing process history, see Viewing process history.

� Scheduling a process
You can use the Scheduler task Start Process to automatically start a process at a specific point in time.
The schedule can be one-time, or recurring.

If the process is already active when the Scheduler job executes, you can decide what to do with the
current process. You can leave the current process running, or you can stop the current process and
then start a new process.

If you use a recurring schedule to start the process, then the process steps should use relative due dates
so that the due dates will adjust dynamically for each execution. If the due dates are specific calendar
dates, then you must remember to edit the process definition before each scheduled execution for the
new calendar dates.

Modifying active processes

If a process is not active, you can edit its definition as desired. When a process is active, then certain edits
are not allowed, and other edits have no effect on the active process.
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To edit a process definition:
1. On the Axiom tab, in the Administration group, go toManage > Process Management > Process

Definitions.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Process Definitions.

The Axiom Explorer dialog opens, filtered to only show the Process Definition Library.

2. Double-click the process definition that you want to edit.

3. In the Edit Process dialog, make any allowed edits as needed.

If the process is currently active, a warning message displays at the top of the Process Properties
tab.

4. Click Apply to save (orOK if you are finished making edits).

� Disallowed edits for active processes
The following edits cannot bemade to the process definition of an active process, because they would
invalidate the currently active step or the process history:

l Making any edits to the properties of a completed step
l Moving the currently active step to another level
l Deleting the active step

� Editing considerations
All properties of the currently active step can be edited. Note the following:

l If you change the step name, description, or action of the active step, and the current step owner
currently has the Process task pane open, they will need to refresh it in order to see these
changes.

l If you change the step owner or due date of the active step, this will cause the task for the step to
be regenerated with the new information, including sending a new Step Activated notification to
the step owner (if applicable).

l If you add a step to an active parallel subprocess or multiple approvals step, the new step will be
automatically activated in the process when you save the change to the process definition.
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For themost part, any new, deleted, or moved steps should be after the currently active step, so that
they will still be part of the step progression. However, it is possible to add new steps to any point of the
process, delete any steps other than the currently active step, and move any steps (except as noted in
the previous section). You should carefully consider the effect any of these types of changes will have on
the active process beforemaking them. For example:

l If you add a step before the currently active step, then that step will not be part of the progression
unless you move the process back to that step, or unless it is possible for the process to be
rejected back to that step.

l If you move the currently active step to an earlier point in the process, this may result in re-
activating already completed steps as the process moves forward from the currently active step. If
you move the currently active step to a later point in the process, this may result in some steps
never being started.

l If you delete a completed step, that step will no longer display in the process definition or in the
Process Status dialog for the current instance. The only way to view the details of that step would
be to query the Axiom.ProcessEvents table, which would still contain the events for the step
activation and completion.

Viewing process status and comments

Administrators can view the status of all processes at any time. They can view a summary of process
status, and they can view details for each individual process. Any comments added by users when
completing steps are also displayed in these details.

Designated process owners can also view the status of processes that they own.

� Process status summary
The Process Manager dialog shows key information for processes at a glance, such as the current state of
the process and the current step of the process. To access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Process Management > Current
Processes.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Current Processes.

By default, the Process Manager dialog shows active processes only. You can click Show inactive
processes to see all processes. The details displayed are for themost recent instance of the process (the
"current" process).
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Example summary of active processes

From here you can perform actions such as viewing the process details, editing the process definition,
and starting and stopping the process. You can also view process history.

For administrators, this dialog shows all processes. For process owners, the dialog only shows processes
that the user owns.

� Viewing individual process details
To view the details of a specific process from the Process Manager dialog, select the process in the list
and click View Details. Alternatively, administrators and process owners can view the details of an active
process by clicking the View status link in the Process task pane (or in the process definition).

In the Process Status dialog, you can view all of the information about the process, including:
l Status of each individual step, whether it is completed, active, or not yet started
l Properties of each individual step, including step type, assigned owner, due date, and any

associated file or feature
l Details of all step activity, such as when it was made active, when it was completed (and by

whom), and any comments associated with the activity
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Example process details

You can also perform administrative activities for the process from this dialog, such as stopping the
process, performing step actions, completing steps (overriding step ownership), and reactivating stalled
steps.

Moving processes to different steps

Administrators and process owners can move an active process to a different step. There are two
different options for moving a process to a different step. These options are intended to be used for
different circumstances as follows:

l Complete step should be used when you need to override step ownership, but the step should be
completed as normal and the process should move on to the next step. For example, the step
owner may have forgotten to complete the step before leaving for vacation, so they have asked
an administrator to complete it for them.

l Move current step should be used when you need to make administrative adjustments to the
process. When moving a step, the current task is aborted instead of completed, and the target
step is activated. Any steps in between the aborted step and the target step are simply not
started.

These actions can be performed in the Process Status dialog. To open this dialog, click View status for
the process in the Process task pane (or in a custom task pane configured to show the process control).

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1041



The process definition also contains a View status details link to open the Process Status dialog, when
the process is active.

� Completing a step (overriding step ownership)
As necessary, you can override step ownership and mark the active step as completed. The process
history will track both the original ownership assignment and the user who actually completed the step.

For example, imagine that the assigned user for a step performed the necessary task, but forgot to mark
the step as complete before leaving on vacation. In this case, an administrator can mark the step as
complete so that the process can continue.

To do this in the Process Status dialog, select the step that you want to complete, then click Complete
step. If the step is an approval step, then you can click Approve step or Reject step as appropriate.

This opens the same Process Action dialog that you see when completing a step from the Process task
pane, where you can define a comment if desired. When you click OK, the step will be completed just as
if the owner had completed it (including any resulting notifications), except that you will be recorded as
the completing user instead of the owner.
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� Moving to a different step
As necessary, you can move a process from the currently active step to a different step. The ability to
move the current step depends on which step is currently active and whether it is a top-level step or part
of a subprocess:

l If the currently active step is a top-level step, then the process can bemoved to any other top-
level step. If the process is a plan file process definition, then any or all plan files can bemoved to
any other top-level step.

l If the currently active step is a sub-step in a parallel subprocess (including sub-steps of a multiple
approvals step), then you can select the parent subprocess step and choose to move the process
to any other step at the same level. In this case, all subprocess steps are aborted and the process
is moved to the selected step.

To move a step in the Process Status dialog:
1. Select a currently active step (or its parent step) and then clickMove current step.

2. In theMove Current Step dialog, select the step that you want to move to. The dialog only
displays eligible steps as described previously in this section.

3. By default, notifications are not sent to new step owners when moving the current step. If you
want to send notifications as part of themove, then select Send notifications to users affected
by this current step change. If this check box is selected, then you can also optionally enter a
comment to be included in the notification and stored with the process.

If enabled, the notification sent when a step is moved will always be the Step Activated notification
for the target step. Because the currently active step is aborted instead of completed, no Step
Completed notifications will be sent.

4. Click OK to move the step.

The current step is aborted, and the target step is made active.

Fixing common process issues

While a process is active, administrators and process owners may need to address common process
issues such as:

l Regenerating tasks for a stalled step
l Regenerating tasks to reflect changes in the process assignments or security
l Restarting a Scheduler Process Step

These actions can be performed in the Process Status dialog. To open this dialog, click View status for
the process in the Process task pane (or in a custom task pane configured to show the process control).
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The process definition also contains a View status details link to open the Process Status dialog, when
the process is active.

� Regenerating tasks for a stalled step
If an issue occurs that prevents a step from becoming active, the step will stall in the process, and the
process cannot continue.

For example, imagine that the assigned user for step 2 of a process has been disabled or deleted in
security. When step 1 is completed, step 2 cannot bemade active because the assigned user is not
eligible or the user record does not exist. Step 2 then becomes stalled, which causes the overall process
to become stalled.

In this example, if the user was disabled in the system accidentally, you could edit Security to re-enable
the user, and then regenerate the tasks for the step. To do this in the Process Status dialog, select the
stalled step and then click the link in the error message.

Axiom Budgeting and Performance Reporting will attempt to reactivate the step, which causes any
associated tasks to be regenerated. If the task generation is successful, the step will bemade active and
the process can continue as normal.
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NOTE: If instead the step needs a different owner, then you can edit the process definition to assign
a different user. When you save the change to the process definition, the task for that step will
automatically be regenerated for the new owner, and the error state will be removed.

� Regenerating tasks to reflect process or security changes
In certain cases, you may need to regenerate tasks for an active step in order to incorporate changes
made to the process assignments or to security. For example:

l If the owner assignment is an assignment column or an assignment workbook, and the
assignments in the column or workbook have been changed since the step became active.

l If the owner assignment is a role, and themembers of the role have changed since the step
became active.

l If security permission changes have been made that would affect the ownership of the active step.

NOTE: It is not necessary to manually regenerate tasks if you change the assignment type for a step
(for example, from user to assignment column), or change the specifically assigned user or role. In
these cases, the tasks are regenerated automatically when you save the change to the process
definition. In the examples listed above, the process is not aware of the changes made outside of the
process definition, so the process does not know to automatically regenerate the tasks.

To regenerate tasks for a step in the Process Status dialog, select the step and then click Regenerate
tasks.

Amessage box informs you that all current tasks for the step will be deleted and new tasks will be
created. Click OK to continue.

� Restarting Scheduler jobs after errors
If a Scheduler Process Step experiences an error when attempting to run a Scheduler job, then you have
the option to restart the job. You should restart the job if the error was the result of a temporary
condition that no longer applies, or if the underlying condition that caused the error has since been
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addressed and you no longer expect the job to experience any errors. If you are not certain why the job
experienced errors, you can click the View job results link to investigate the issue before restarting the
job.

To restart the job from the Process Status dialog, select the stalled Scheduler step, and then click the link
in the error message. This will remove the error state and place the job in the Scheduler queue again.

Alternatively, you can choose to manually mark the step as complete if the job does not need to be run
again. For example, the job results may have been Partial Success and in this case that may be enough to
consider the step complete. Or, you may havemanually run the job or run the associated activity while
troubleshooting the error, and therefore the job does not need to be run again.

Unlike other error conditions for active processes, the administrator or process owner is not required to
intervene. The step owner also has access to these options within the Process task pane when a
Scheduler job experiences errors, and thereforemay be able to address the issue without requiring
assistance.
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Viewing process history
Each time a process is started, a new process instance is created to track the details of that particular
execution of the process. This ensures that you always have a history of each time the process is
performed, including who completed each step in the process and when. You can retain this history as
long as needed.

Administrators and process owners can view the history for a process. Administrators can view history
for all processes, whereas process owners can only view history for processes they own.
To view the history for a process:

1. On the Axiom tab, in the Administration group, clickManage > Process Management > Current
Processes.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Current Processes.

2. In the Process Manager dialog, select the process for which you want to view the history. If
necessary, select Show inactive processes to display all processes.

When you select a process in the top of the dialog, the bottom of the dialog populates to show
the historical instances for that process.

3. In the Process History section, select the process instance for which you want to view the history,
and then click View Details.

Make sure to click the ViewDetails button that is directly over the Process History section, not the
button that is above the Current Processes section.
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The Process Status dialog opens, displaying the details for the historical instance of that process. In
addition to reviewing the details, you can perform the following actions from this dialog:

l View process definition: Opens a read-only copy of the process definition as it existed at the time
of this historical instance. If desired you can use Save As to "restore" this historical definition as a
new definition.

l Start process: Starts a new instance of the process, using the current process definition. This
option is only available if there is not already an active instance of the process.

If there is already an active instance of the process, a message will display at the top of the dialog
to inform you of this. You can click the link in this message to be taken to the currently active
instance.

� Deleting process history
If you do not need the history of a particular process instance anymore, you can select that instance in
the Process History section and then click Delete . Process history is retained until it is manually
deleted (it does not get automatically purged by the Purge System Data Scheduler job).

If the process definition is deleted, all history for that process is also automatically deleted.

Scheduler Overview
Using Scheduler, you can schedule certain Axiom Budgeting and Performance Reporting tasks to be
processed on a Scheduler server at a specific date and time. For example, you can schedule plan file
processing or data imports.

Processing tasks using Scheduler has advantages over manual processing, such as:
l Leverages the server's processing power and frees up your computer's resources.
l Enables recurring scheduling of ongoing tasks.
l Allows tasks to be scheduled during "off hours," during periods of low network and system

activity.
l Allows tasks to be performed in batch, including enforcing task dependencies.

Scheduler processes tasks using jobs. Each job is a scheduled unit that can contain one or more tasks.
The tasks in a job can be processed sequentially or concurrently as appropriate.

Only system administrators and users with the Scheduled Jobs User security permission can access
Scheduler.

Most Scheduler setup activities can only be performed in the Desktop Client (Excel or Windows Client).
Therefore, the Desktop Client Scheduler is the primary focus of this document. However, some job
management activities can be performed in theWeb Client, such as monitoring the job schedule, viewing
job results, and running jobs manually on demand. For more information, seeWeb Scheduler.
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About Scheduler
This section contains conceptual information about the Scheduler feature in Axiom Budgeting and
Performance Reporting.

� Scheduler jobs and tasks
The primary unit of Scheduler processing is a job. Each Scheduler job can contain one or more tasks to
be performed as part of that job.

Each Scheduler job defines the following basic properties:
l The tasks to perform for the job and the properties of those tasks
l The schedule of the job, including recurrence (if any)
l The priority of the job
l The notification options for the job

The tasks define the actual activities to be performed by the job, such as importing data or processing
plan files. Some Scheduler tasks correspond to existing features that can also be processed manually
(such as Process Plan Files), while other tasks are Scheduler-specific and can only be processed via
Scheduler. Each task has a unique set of options that are specific to that task and to the activity to be
performed. For more information on the available task types, see Scheduler Task Reference.

The tasks in a job can be processed sequentially or concurrently as appropriate. Tasks can be dependent
on other tasks in the job as needed—for example, you can configure a job so that if a task fails, the job
stops and does not process the next task. Tasks can also be processed iteratively, to perform the same
task repeatedly over a defined set of values.

The Scheduler jobs in your system fall into the following basic categories:
l Client-created: You can create Scheduler jobs as needed to perform tasks in your system.
l System jobs: Axiom Budgeting and Performance Reporting provides a set of system jobs to

perform necessary system tasks.
l Product-controlled: When a product is installed, it may include one or more Scheduler jobs to

support the use of that product. Generally speaking, these jobs should not be changed unless the
product documentation says customization is allowed, or as advised by Axiom Support.

� How Scheduler jobs are run
Once a Scheduler job has been created, it can be run using any of the following options:

l The job can be scheduled for execution at a future date and time using a scheduling rule.
Scheduling rules can be one-time only, or recurring.

l The job can be run "one time" manually as needed through Scheduler.
l The job can be triggered for execution using an event handler. This allows Scheduler jobs to be

triggered in various ways, such as by clicking a button in an Axiom form.
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Scheduler jobs are processed by one or more servers running the Scheduler service. For Axiom Cloud
systems, the Scheduler service is part of your cloud system and managed by Axiom Support. For on-
premise systems, the Scheduler service is installed on one or more servers in your environment. The
Scheduler service polls the Axiom Application Server periodically to check for any jobs that are ready to
be run. Eligible jobs are then executed on the server, based on their processing priority.

When a job is executed by Scheduler, it is run using a particular user identity. In order for a job to be
executed successfully, the user must be an active user defined in Axiom Budgeting and Performance
Reporting security, and the user must have the appropriate security permissions to perform the tasks in
the job. The user identity for a job is determined as follows:

l If a job is a system job, then it is run as the system-managed identity of System instead of a user
identity.

l If a job is run by using Run Now, then it is run as the user who placed the job on the schedule.
l If a job is run by an active scheduling rule, then it is run as the job owner. The job owner is the

user who last saved the job.
l If a job is run via an event handler, then the job may be run as either the job owner, or the job

requester (the user who raised the event).

� System jobs
System jobs are automatically created by Axiom Budgeting and Performance Reporting to support
necessary system functionality. Some system jobs are created as part of the initial installation and are
intended to run on an ongoing basis, while other system jobs are created on-demand in response to
system events. Only administrators can edit these system jobs.

System jobs have two defining characteristics:
l System jobs are run using the system-managed identity of System instead of a user identity. The

System identity has full rights to the system as necessary to perform system tasks.

l System jobs are run by the default System Scheduler service. For on-premise systems, this service
is created and started automatically on the Axiom Application Server, and does not require a
separate installation. This service is exclusively for running system jobs.

Axiom Cloud systems may or may not have a separate System Scheduler service, depending on
the system configuration (as determined by Axiom Support). If your cloud system does not have a
System Scheduler service, then your system jobs are run using the available Scheduler services for
the cloud system.

In the Scheduler dialog (Desktop Client), the System Scheduler service is listed on the Servers tab
using the following naming convention: <ServerName>-System.

If necessary, a product-controlled or client-created job can be flagged as a system job, so that it can be
run using the System identity instead of a user identity. To designate a job as a system job, enableMark
as System Job in theGeneral job properties. The following rules apply to manually-created system jobs:

l Only system administrators can designate a job as a system job.
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l The job cannot contain any tasks that are designated as “non-system” tasks. Non-system tasks
are any tasks that might involve spreadsheet processing, such as Process Plan Files.

� Processing priority for scheduled jobs
Once a job reaches its start time, it is eligible to be processed by Scheduler and joins the processing
queue. For scheduled jobs, the start time is based on the scheduling rule that placed it on the schedule.
For other jobs, the start time is the time that the job was placed on the schedule using Run Once or
triggered by an event handler.

Each Scheduler service has a configured number of threads that are used to process jobs. As a Scheduler
thread becomes available, it takes the next job in the processing queue. The priority of jobs in the
processing queue is determined by the combination of the job's priority category, and its Priority
Elevation setting.

Each job has a priority category, based on how the job execution was initiated. The priority categories
are as follows:

1. Manual: The job was executed manually.

2. Event Handler: The job was executed by a Scheduler event handler.

3. Scheduled Job: The scheduled instance of the job results from an active scheduling rule.

4. Subordinate Job: The job was generated as a subordinate job, from a currently executing job.

Manual jobs are highest priority and are processed first, and subordinate jobs are lowest priority and are
processed last. Within each category, jobs are processed according to their Priority Elevation setting.

For example, imagine that Scheduler has 2 available threads and the following jobs are eligible to be
processed:

Job Priority Category Priority Elevation

A Manual Default

B Event Handler Default

C Scheduled Default

D Scheduled Elevated

l Scheduler will execute jobs A and B first, because those are the highest priority jobs based on their
priority category.

l When the next thread becomes available, Scheduler will execute job D. Although job C may have
entered the queue first, and the two jobs have the same priority category, job D's priority
elevation is set to Elevated so it takes precedence within the category. If instead both jobs were
set to Default, then job C would be executed first if it entered the queue before job D.

l When the next thread becomes available, Scheduler will execute job C.
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NOTE: If a job's Priority Elevation is set to Interrupt, then it is run as soon as it is eligible, regardless
of its priority category and regardless of whether any Scheduler threads are currently available to
process the job. If no Scheduler threads are available, a new one is created to process the job, even if
this temporarily exceeds the number of configured threads for the server.

The Scheduler dialog
The Scheduler dialog is used to create and manage Scheduler jobs.

To access Scheduler:
l On the Axiom tab, in the Administration group, clickManage > Scheduler.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Scheduler.

The top section of the Scheduler dialog contains a ribbon-style toolbar with two tabs: Job and Service.
l On the Job tab, you can create, run, and edit jobs.
l On the Service tab, you can manage scheduled jobs, view job results, and perform other

Scheduler management activities.

As you perform actions on the Job and Service tabs, additional tabs are opened in the navigation pane of
the dialog. For example, clicking the Scheduled Jobs button on the Service tab opens the Scheduled
Jobs tab in the navigation pane. You can move between any open tab in the navigation pane, regardless
of which tab is selected in the ribbon. The ribbon updates to show the related commands for the
selected item.
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Example Job tab

Example Service tab

When you right-click a tab in the dialog's navigation pane, you can close or save items as follows:
l For all items, you can Close, Close All, or Close All But This.
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l For jobs, you can Save or Save As. Selecting Save As allows you to save a copy of the job to the
Scheduler Jobs Library in the Axiom Budgeting and Performance Reporting file system.

The Scheduler Jobs Library is also accessible via Axiom Explorer.
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Scheduler Job Setup
To perform Axiom Budgeting and Performance Reporting tasks using Scheduler, you must create jobs.
Each job can execute one or more tasks. This section discusses how to set up jobs, including how to
schedule jobs for future execution and how to be notified when a job has been completed.

Managing Scheduler jobs and tasks

Using the Axiom Scheduler dialog, administrators can create and edit Scheduler jobs. To access this
dialog:

l On the Axiom tab, in the Administration group, clickManage > Scheduler.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Scheduler.

This section discusses how to create, edit, and delete jobs and tasks, not how to manage the Scheduler
queue once jobs have been placed on the schedule. If you need to stop or reschedule a scheduled job,
seeManaging scheduled jobs.

Scheduler jobs are saved as XML files and are stored in the Axiom Budgeting and Performance Reporting
file system at \Axiom\Scheduler Jobs Library.

� Creating a Scheduler job
You can create a new Scheduler job to perform one or more tasks.

To create a new job:
1. In the Scheduler dialog, on the Job tab, click New.

A new tab appears in the navigation pane, labeled New Job. The left-hand side of the job lists
sections for which you can define various job settings. When you click a section name, the settings
for that section display in the right-hand side of the job.

2. In theGeneral section, define general job settings as desired.

For detailed information on the available settings for a job, see Job properties.

3. In the Scheduling Rules section, specify scheduling details for the job.

18
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You can schedule the job for future execution, for one time or on a recurring basis.

NOTE: If you are always going to run the job manually, and do not need to schedule it for
future execution, then you do not need to define scheduling rules.

For more information, see Defining scheduling rules for a job.

4. In theNotification section, specify email notification options for the job.

You can send email notifications every time the job completes, or only when the job experiences
errors. By default, the job is configured to notify on completion.

For more information, see Setting up email notification for jobs.

5. In the Tasks section, add one or more tasks to the job.

a. On the Job tab of the ribbon, in the Tasks group, click Add. This brings up a list of available
tasks. Select the task that you want to add.

The task is added to the Tasks section, and the settings for the task display in the right-
hand side of the job.

b. Complete the settings for the task as desired.

The Task Control section of the task contains standard task settings, and the Task Details
section contains settings unique to the task type. For more information, see Task Control
properties.

If a required setting is not completed, the setting is highlighted in red and error text
appears in the bottom of the dialog. Make sure to complete all required settings for the
task before saving.

Repeat this process until you have added all desired tasks to the job. Tasks are processed in the
order listed. If you need to change task order, select a task and then clickMove Up orMove
Down.

6. In the Job tab of the ribbon, click Save.

7. At the bottom of the Save As dialog, in the File name box, type a name for the job, and then click
OK.

The job is saved as an XML file in the Scheduler Jobs Library.

If the job was saved with an active scheduling rule, Axiom Budgeting and Performance Reporting
determines the next scheduled date of execution and schedules the job. You can view the job in the
Scheduled Jobs list (on the Service tab of the ribbon, click Scheduled Jobs).
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Advanced job settings
This procedure covers the basic steps of creating a job. Jobs also support the following advanced
options:

l Event handlers: You can create event handlers for the purposes of running the job using the
RunEvent function. This allows users to trigger job execution from within an Axiom file.

l Job variables: You can create job variables and then use those variables within certain job
settings. You can then dynamically pass in values for those variables when using the RunEvent
function to execute the job.

For more information, see Advanced options, Using job variables, and Using RunEvent to execute a
Scheduler job.

� Editing a job
You can edit a job at any time to change job settings, add or remove tasks, change scheduling rules, or
change notification options.

This section describes the general process of opening a job for editing. For more details on the impacts of
editing scheduling rules, see Defining scheduling rules for a job.

To edit a job:
1. In the Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Select the job and then click Open.

The job opens in the Scheduler dialog. Make sure the job is the active tab in the navigation pane
(themost recently opened tab is the active tab by default).

3. Edit the job and task properties as desired.

For detailed information on the available settings for a job, see Job properties. For detailed
information on task settings, see Task Control properties.

4. In the Job tab of the ribbon, click Save.

� Deleting a job
Deleting a job removes any scheduled executions of the job from the scheduled jobs list.

To delete a job:
1. In the Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Navigate to the job that you want to delete, then right-click the job and select Delete.

You can also delete Scheduler jobs from Axiom Explorer or the Explorer task pane.
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Defining scheduling rules for a job

Once a job has been created, you can run it on demand, or you can schedule it for future execution. Jobs
can be scheduled to be run one time, or on a recurring basis. To schedule a job, you define scheduling
rules for the job.

You can add, edit, and remove the scheduling rules for a job at any time using the Scheduling Rules
section of the job properties. You can also flag a rule as active or inactive. If a job has no scheduling rules,
or if all of its scheduling rules are inactive, then it will not be run unless it is run manually by a user.

If a job is saved with an active scheduling rule, then Axiom Budgeting and Performance Reporting
determines the next scheduled instance of the job and places it in the scheduled jobs list. Once that
instance has been processed, the next scheduled instance is determined and scheduled, and so on. Each
time the job is run using an active scheduling rule, it is run as the current job owner (unless the job is a
system job, in which case it is run as the Scheduler Service System identity).

If a job has multiple active scheduling rules, Axiom Budgeting and Performance Reporting evaluates all of
the rules and schedules a single instance of the job, for the earliest time allowed by the rules. Multiple
scheduling rules do not result in multiple scheduled instances of the job.

NOTE: If a time zone is listed on the Scheduling Rules section of the job, then the defined rules will be
evaluated in the context of that listed time zone. Otherwise, scheduling rules are evaluated in the
context of the local time zone for the Scheduler Server. If necessary, the system configuration setting
SchedulingBehaviorTimezone can be used to specify a particular time zone for evaluating scheduling
rules.

� Adding a Scheduling rule
You can add a scheduling rule to a job to schedule it for future execution, either one time or on a
recurring basis.

If you only plan to run the job manually on demand, then you do not need to create a scheduling rule.

To add a scheduling rule to a job:
1. In the Scheduler dialog, open a job to edit or create a new job.

2. In the left-hand side of the job, select Scheduling Rules.

By default, this area is empty. You must add a rule in order to define scheduling for the job.

3. On the Job tab of the Scheduler ribbon, in the Scheduling Rules section, click Add.

A new row appears in the right-hand side of the job. By default, the new row is active, but does
not have start / end dates or any specific recurrence settings.

4. Complete the following settings within the row as needed:
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Item Description

Active If you want the job to be placed on the schedule as soon as you save the
job with the new scheduling rule, then you should leave this option
checked.

However, if you just want to save your schedule settings but you are not
ready to begin scheduling the job, then you can clear the Active check box
for the rule. The job will not be scheduled until it is saved with an active
scheduling rule.

Starting On

Ending On

Optional. These dates specify the time frame for the scheduling rule. The
starting date defines the earliest point in time that the job can be
scheduled, and the ending date defines the latest point in time that the
job can be scheduled.

If these dates are not defined (left blank), then the job will be perpetually
scheduled according to the rule settings, as long as the rule is active.

If you want to schedule a one-time job, then set the starting / ending
dates to the same date and time.

NOTE: Your system locale determines the format of dates.

Day ofWeek Specify the day(s) of the week that you want the job to be run:
l * (Default): The job will be run on all days within the start / end range.
l 0-6: The job will be run on the specified day or days, where 0 is Sunday

and 6 is Saturday. Use a comma or a hyphen to separatemultiple days
(hyphen if the days are contiguous, commas if not).

For example, you can enter 1,3,5 for Monday, Wednesday, and Friday,
or enter 1-5 for Monday through Friday.

Hours Specify the time of day (hours) that you want the job to be run, in relation
to the specified days:
l * (Default): The job will be run on all hours.
l 0-23: The job will be run on the specified hour or hours, where 0 is

midnight and 23 is 11:00 PM. Use a comma or a hyphen to separate
multiple hours (hyphen if the hours are contiguous, commas if not).

For example, you can enter 0,12 to run at midnight and noon, or enter 0-
12 to run every hour from midnight to noon.
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Item Description

Minutes Specify the time of day (minutes) that you want the job to be run, in
relation to the specified hours:
l * (Default): The job will be run on all minutes (essentially the job is run

continuously, once per minute).
l 0-59: The job will be run on the specified minute or minutes of the

hour, where 0 is the first minute of the hour and 59 is the last minute of
the hour. Use a comma or a hyphen to separatemultiple minutes
(hyphen if the hours are contiguous, commas if not).

For example, you can enter 0,30 to run at the top of the hour and the half
hour, or enter 0-30 to run every minute from the top of the hour to the
half hour.

NOTE: If you specify an hour, then in most cases you should also specify a
minute (such as 0 to run the job at the top of the specified hour). If you
enter an hour but leave theminutes at the default asterisk, then the job
will run every minute in that hour.

If the Active check box for the rule is selected when the job is saved, then Axiom Budgeting and
Performance Reporting will calculate the date and time of the first scheduled execution and will place the
job on the schedule.

� Editing a scheduling rule
You can edit a scheduling rule at any time, to toggle between active and inactive, and to change the start
/ end dates and recurrence settings.

NOTES:
l If a pending instance of this job is currently on the schedule, and you edit the scheduling rule,

the pending instance will be updated to match the new schedule.
l If you inactivate a scheduling rule, any currently scheduled instances of the job will be

automatically removed from the schedule.

To edit a scheduling rule:
1. In the Scheduler dialog, open a job to edit or create a new one.

2. In the left-hand pane of the job, select Scheduling Rules.

The defined rules display in the right-hand pane of the job.

3. Make any desired changes directly within the scheduling rules grid.
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� Deleting a scheduling rule
You can delete a scheduling rule at any time. If a job has no active scheduling rules, it will not be
processed unless it is manually run.

To delete a scheduling rule:
1. In the Scheduler dialog, open a job to edit.

2. Select the Scheduling Rules section of the job, and then select the rule that you want to delete.

3. On the Job tab of the Scheduler ribbon, in the Scheduling Rules group, click Remove Selected.

Alternatively, if you want to delete all scheduling rules for the job, click Clear All.

Any jobs in the scheduled jobs queue that were related to the deleted rule(s) are also deleted.

� Scheduling rule examples
The following are some example schedules and the rules used to achieve them:

Schedule Start/End Day of Week Hours Minutes

Weekdays at 11:00
PM

<optional> 1,2,3,4,5 23 0

Every 15minutes <optional> * * 0,15,30,45

Mondays at 11:30 PM <optional> 1 23 30

One time (6/30/2020)
at 1:30 PM
(Option 1)

Start: 06/30/2020 00:00

End: 07/01/2020 00:00

* 13 30

One time (6/30/2020)
at 1:30 PM
(Option 2)

Start: 06/30/2020 13:30

End: 06/30/2020 13:30

* * *

Every Wednesday in
July at noon

Start: 07/01/2020 00:00

End: 08/01/2020 00:00

3 12 0

Continuous <optional> * * *

To schedule a job to executemonthly, create twelve active scheduling rules, one for each month. This is
necessary because scheduling rules do not have a property for day ofmonth, so it is not possible to use
a single scheduling rule to create a monthly schedule. In the following example, the job will be executed
on the first day of each month, at 3:30 AM:

Example scheduling rules to execute a job monthly
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When you save the job, the rules will be evaluated and the first scheduled execution will be placed on the
schedule—in this example, the January 1 execution. Once that scheduled execution is complete, the rules
will be evaluated again, which will cause the next scheduled execution (Feb 1) to be placed on the
schedule, and so on.

Setting up email notification for jobs

Scheduler can be configured to send an email notification when a job completes, or when a job has
errors. In order for an email to be sent for a particular job, the following must be set up:

l The job must be configured to send a notification on completion or error. The notification settings
must include valid To and From email addresses (or use system variables).

l The System.SMTPMessageDelivery system job must be configured with a valid SMTP server for
your environment. For more information, see Scheduler setup.

When a job creates an email notification, the notification is first saved to the database. When
notifications are detected in the database, the System.SMTPMessageDelivery system job is triggered to
deliver the notifications.

NOTE: By default, all new Scheduler jobs are configured to send notification on completion, to the
user who created the job. You only need to edit these settings if you want to change the default
settings.

To configure a job to send email notifications:
1. In the Scheduler dialog, open a job to edit or create a new one.

2. In the left-hand side of the job, select Notification.

3. In the Job Notification Level section, select one of the following:

l Send all email notifications: (Default) An email notification is always sent when the job is
executed, regardless of the job status (success, failure, aborted, etc.).

l Send email notification only when the job has errors: An email notification is only sent if
the job experiences errors. If the job completes successfully with no errors, no email
notification is sent.

l None: No email notifications are sent for this job. The only way to check the status of the
job execution is to check the job history.

l Send email notification to different email addresses when the job has errors or
succeeds: This option works the sameway as Send all email notifications, except that a
separate email address can be specified to receive the error notifications.

4. In theNotification Message Content section, complete the following for the notification email:
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Item Description

To The email address(es) to receive the notification email. Separatemultiple
addresses with a semicolon. For example:
l To send the email to two recipients, enter the addresses such as:
jdoe@company.com;dsmith@company.com

l To use a Scheduler job variable to define a notification recipient, enter
the variable namewith curly brackets. You can combine regular email
addresses and variables, such as: {JobOwner.EmailAddress};
jdoe@company.com

By default, the notification is configured to be sent to the user who
executed the job, using the variable {CurrentUser.EmailAddress}.

The entries in the To field must be valid email addresses, or Scheduler job
variables that will resolve to valid email addresses. Currently, it is not
supported to list user or role names, or to look up email addresses from
Axiom Security.

NOTE: When using Send email notification to different email addresses
when the job has errors or succeeds, this user will be notified if the job
completes successfully (including partial success), but not if the job fails.
Job failure notifications are sent to the To (on error) recipients.

From The email address that themessage is sent from. This can be something
like axiomscheduler@company.com, so that the recipient can easily tell
that themessage has been generated by Scheduler.

By default, this is set to the Scheduler "from" email address as defined in
the system configuration settings, using the system variable
{Scheduler.FromEmailAddress}.

NOTE: For installations that are using subsystems, the system variable
{Scheduler.FromEmailAddress}may resolve to a subsystem
administrator email address instead of the Scheduler "from" email
address.

Subject The subject of themessage. By default, this is set to "Axiom Scheduler
Notification."

User Message Optional body text for the email. This text is included in addition to the
Scheduler auto-generated text regarding the job status.

If Send email notification to different email addresses when the job has errors or succeeds is
enabled, the following additional options are available:
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Item Description

To (on error) The email address(es) to receive the notification email when the job result
is Failed. Separatemultiple addresses with a semicolon.

This user only receives a notification if the job fails. If the job result is
Success or Partial Success, this user will not receive a notification (only the
To user will).

Subject (on
error)

The subject of the job failuremessage. By default, this is set to "Axiom
Scheduler Notification."

Job variables can be used in all notification settings.

When this job is executed, it will generate an email notification according to the defined settings, and
save that notification to the database to await delivery.

Job properties

This topic is a reference for the settings that can be defined for a Scheduler job.

� General
This section defines general settings for the job.

Item Description

Description Optional. The description of the job.

The job description can also be edited in Axiom Explorer, in the Scheduler Jobs
Library.

Job Restart
Behavior

Specifies whether and how the job should be restarted if it is interrupted prior
to completion. Select one of the following:
l Do not reschedule this job. In this case, you must manually reschedule the

job if it needs to be run before its next scheduled execution.
l Restart the job from the first task. The entire job is run again, even if some

of the tasks were completed successfully before the job was interrupted.
l Resume the job beginning with the first uncompleted task. (Default) The

job resumes and only the uncompleted tasks are run.

A job would be interrupted if the Scheduler server processing it was restarted,
or if the Scheduler service on the server was stopped or restarted, or if the
Scheduler server was disabled from the Servers tab (Service > Servers) of the
Scheduler dialog.
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Item Description

Job Results
Cleanup

Specifies whether historical job results are purged when the job is run.

To purge job results:
1. Select Purge historical job results whenever this job runs.

2. In Number of days to keep results for this job, specify the number of
days to keep when purging results. By default this is set to 0, which
means all job results will be purged except the result for the current job
execution.

A day is counted as 24 hours from the time the cleanup task is executed. So if
you specify 1 day, and the task is run at 11:00 PM on Tuesday, then all results
prior to 11:00 PM Monday are purged.

If this option is not selected, then historical job results remain in the database
until the system's Purge System Data task is run.

Priority Elevation Specifies the priority of the job in the scheduled jobs queue, within the job's
priority category. Select one of the following:
l Default: (Default) This job is run on a "first come, first served" basis. The

total number of jobs that can be run at one time is determined by the
configured number of Scheduler threads for the installation.

l Reduced: The job is designated as a low priority job, and remains at the
bottom of the queue until other jobs with Default and Elevated priority have
been run.

l Elevated: The job is designated as a high priority job, and is moved to the
top of the queue to be run before Default and Reduced priority jobs.

l Interrupt: The job is run immediately, regardless of any jobs currently
waiting in the scheduled jobs queue, and regardless of whether any
Scheduler threads are currently available to run it. If no Scheduler threads
are currently available, a new thread is created, even if this exceeds the
configured thread limit for the installation.

Job execution order also depends on the priority category of a specific job
execution. See Processing priority for scheduled jobs.
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Item Description

Mark as System
Job

Specifies whether the job is run as a system job. Only administrators can edit
this check box.

If this check box is selected, the job is run under the "Scheduler Service" system
identity instead of a user identity, and the job is run by the system Scheduler
server which operates on the Axiom Application Server.

Generally, this check box should only be selected for system "support" tasks
that should not depend on individual user rights. This check box is not available
if the job contains non-system tasks (generally, spreadsheet-related tasks).

For more information, see System jobs.

Put the system
in 'admin only'
mode during this
job

If this option is selected, then the system will be placed into administrator-only
mode at the start of the job, and then placed back into full access modewhen
all tasks are completed (including any sub-jobs). This is the same behavior as
going toManage > Security > System Access and selecting Administrators
Only.

NOTES:
l You should make sure that any jobs using admin-only mode do not overlap.

For example, imagine that job A starts and places the system in admin-only
mode. While job A is still running, job B starts and finishes. If job B also uses
admin-only mode, then when job B finishes the system will be placed back
into full access mode, meaning the remainder of job Awill be processed in
full access mode.

l Any job using admin-only modemust be run by an administrator.

Generally speaking, any job set to run using admin-only mode should be run at
a timewhen no end users will be logged into the system and no other Scheduler
jobs will be running.

� Job Variables
This tab has two sections for job variables:

l In the Job values section at the top of the tab, you can manage user-defined variables for use in
the current job.

To add or remove variables, use the Add, Remove Selected, or Clear All commands in the Job
Variables group of the Job tab. This group is only available when you have selected the Job
Variables section in the left-hand side of the job.

When creating user-defined variables, do not add curly brackets to the variable name. Curly
brackets are only required when you use the variable in a job or task setting.
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l In the System defined values section at the bottom of the tab, you can view the system variables
available for use in the job.

You can right-click any variable in this section (user-defined or system-defined) and select Copy variable
name to clipboard. You can then navigate to the setting where you want to use the variable, and then
paste it. The variable will be pasted with the necessary curly brackets.

For more information, see Using job variables.

� Scheduling Rules
Each row in this section defines a scheduling rule for the job. Jobs will be automatically scheduled
according to the settings in this section.

To add or remove scheduling rules, use the Add, Remove Selected, or Clear All commands in the
Scheduling Rules group of the Job tab. This group is only available when you have selected the
Scheduling Rules section in the left-hand side of the job.

For more information, see Defining scheduling rules for a job.

Item Description

Active Specifies whether the scheduling rule is active. If this check box is not selected,
then the rule is ignored for purposes of scheduling the job.

Starting On Optional. Specifies the earliest date and time for the scheduling rule to take
effect.

If you want the job to run one time only, set Starting On and Ending On dates
to the same date/time.

Ending On Optional. Specifies the expiration date and time for the scheduling rule. Once
this date is past, no further executions will be scheduled for this rule.

Day ofWeek Specifies the day(s) of the week that you want the job to be run:
l * (Default): The job will be run on all days within the start / end range.
l 0-6: The job will be run on the specified day or days, where 0 is Sunday and 6

is Saturday. Use a comma or a hyphen to separatemultiple days (hyphen if
the days are contiguous, commas if not).

Hours Specifies the time of day (hours) that you want the job to be run, in relation to
the specified days:
l * (Default): The job will be run on all hours.
l 0-23: The job will be run on the specified hour or hours, where 0 is midnight

and 23 is 11:00 PM. Use a comma or a hyphen to separatemultiple hours
(hyphen if the hours are contiguous, commas if not).
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Item Description

Minutes Specifies the time of day (minutes) that you want the job to be run, in relation
to the specified hours:
l * (Default): The job will be run on all minutes (essentially the job is run

continuously, once per minute).
l 0-59: The job will be run on the specified minute or minutes of the hour,

where 0 is the first minute of the hour and 59 is the last minute of the hour.
Use a comma or a hyphen to separatemultiple minutes (hyphen if the hours
are contiguous, commas if not).

� Event Handlers
If an event handler is associated with the job, it is listed here. There are two types of event handlers:

l System event handlers, for completing system-triggered tasks. SeeManaging event handlers.
l User-defined event handlers, for running jobs via RunEvent. See Advanced options.

To add or remove event handlers, use the Add, Remove Selected, or Clear All commands in the Event
Handlers group of the Job tab. This group is only available when you have selected the Event Handlers
section in the left-hand side of the job.

Item Description

Active Specifies whether the event handler is active or not within the current job. If
inactive, then actions that trigger the event handler will ignore this job.

Event Name The name of the event handler.

Multiple jobs can have an event handler with the same name; all those jobs will
be affected when the event handler is triggered.

Execute As The user identity under which the job will be run when the event handler is
triggered.
l Owner: For system-managed event handlers, the owner is the system

Scheduler identity. For user-defined event handlers, the owner is the user
who last saved the job.

l Requester: For all event handlers, the requester is the user who caused the
event handler to be triggered.

� Notification
This section defines email notification settings for the job. For more information, see Setting up email
notification for jobs.

Job variables can be used in this section. For more information, see Using job variables.
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Item Description

Job Notification
Level

Specifies when email notifications are sent for the job. Select one of the
following:
l Send all email notifications (Default)
l Send email notification only when the job has errors
l None
l Send email notification to different email addresses when the job has

errors or succeeds

If anything other than None is selected, then you must complete the remaining
fields.

To The email address(es) to receive the notification email. Separatemultiple
addresses with a semicolon.

To (on error) The email address(es) to receive the notification email when the job fails.
Separatemultiple addresses with a semicolon. Only applies when Send email
notification to different email addresses when the job has errors or succeeds
is enabled.

From The email address to use as the "From" address for the notification email.

Subject The subject text for the notification email.

Subject (on
error)

The subject text for the notification email when the job fails. Only applies when
Send email notification to different email addresses when the job has errors
or succeeds is enabled.

User Message Optional. The body text for the notification email.

Text entered here will be appended to the body text generated by Scheduler.

� Tasks
This section defines the tasks in the job. In the ribbon, task commands are available on the Job tab, in
the Tasks group.

l To add a task, click Add.
l To change the order of tasks, select a task and then clickMove Up orMove Down.
l To delete a task, select the task and then click Remove Selected.
l To delete all tasks, click Clear All.
l To copy a task, right-click the task and then click Copy. You can copy the task within the same job,

or to another open job in the Scheduler window. Right-click any task (or the Tasks section header)
and then select Paste. The job is pasted underneath the job you right-clicked (or at the end of the
list if you right-clicked the Tasks section header).
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l To rename a task, double-click the task name to make it editable, and then type the new name.
For example, if you have a job with multiple File Processing tasks, then you may want to edit the
name of each task so that you knowwhich file each task relates to at a glance. (You can also right-
click and select Rename.)

Tasks are processed in the order they are listed in the job. By default, when you add a new task to a job,
it is placed at the bottom of the list. Make sure to move the new job if it should not be processed last.

Tasks can be processed concurrently instead of sequentially if they are configured to be run as a
subordinate job within the parent job.

Each task type has its own unique settings in addition to the standard task settings. For more
information, see Scheduler Task Reference.

� Job Results
Displays historical results for the job. This section is blank if the job has never been run.

Job results may be purged periodically by using the Job Results Cleanup option for the job, or by the
system Purge System Data task.

NOTE: Users with the Scheduled Jobs User security permission only see results for jobs that they
executed. Administrators see results for all executions.

For more information on job results, see Viewing job results.

Advanced options

Creating event handlers for a job

You can create user-defined event handlers in a job, for the purposes of automatically triggering the job
for execution when the event name is called by another feature. Axiom Budgeting and Performance
Reporting supports several features that can be used to raise an event:

l The RunEvent function and command
l File Group triggers
l The Raise Event Scheduler task

Event handlers are defined by name. Multiple jobs can have an event handler with the same name.
When that event handler is called, it will affect all jobs that contain the event handler with thematching
name.

To create an event handler in a job:
1. In the Scheduler dialog, open a job to edit or create a new job.

2. In the left-hand side of the job, select Event Handlers.

3. On the Job tab of the ribbon, in the Event Handlers group, click Add.
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A new event handler is added to the job.

4. Double-click the Event Name field so that the field becomes editable, and then type the desired
event handler name.

For example, if the event handler will be used to trigger Process Plan Files jobs, you might name
the event handler ProcessPlanFiles.

This event name is the name that will be used in features such as RunEvent to trigger this job for
execution.

5. In the Execute As field, select one of the following to determine the user identity that will be used
to run the job when it is executed via the event handler:

l Owner: The job will be run under the identity of the job owner.

The job owner is the user who last saved the job. If you are not sure who the current job
owner is, you can check the Job Variables tab. The current job owner is listed in the System
defined values section.

l Requester: The job will be run under the identity of the user who triggered the event
handler.

By default, event handlers are set to run as theOwner. You should carefully consider this option
as it may affect whether the job can be run and how the job is run.

For example, if the event handler is set to Requester, but the user who triggered the job does not
have access to the file group specified for a Process Plan Files task, then the task will fail.

This may be the desired outcome—you may want the job to be dependent on the user's rights,
and therefore you should specify Requester. On the other hand, you may want the job to run in
the sameway every time, regardless of the user that triggers the job. In that case you should
specify Owner.

By default, the event handler is set to Active, which means it will be found by any process that triggers
the event handler. If you want to temporarily exclude this job from event handler processing, you can
clear the Active check box.

� Associating an event handler with a file group
If a Scheduler job with an active event handler is stored in a file group Utilities folder, then the event
handler is associated with that file group. When using RunEvent to trigger jobs for execution, you can
optionally specify a file group context so that only event handlers associated with that file group (or no
file group) are considered.

In order to store a Scheduler job within a file group, you must first create and save the job within the
Scheduler Jobs Library. Then, you can use Axiom Explorer to move the job from the Scheduler Jobs
Library to the file group Utilities folder. If the file group and its utilities are later cloned using any
process—such as regular file group cloning, scenario creation, or file group rollover—then the event
handler is also cloned and will be associated with the new file group.
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� Deleting an event handler
If you no longer need an event handler, you can delete it from the job. Select the event handler and then
click Remove Selected. You can also Clear All to remove all event handlers from the job.

User-defined event handlers display along with the system event handlers in the Event Handlers tab
(Service > Event Handlers). If you right-click a user-defined event handler in this location and select
Remove event handler, it does not delete the event handler from any jobs that use it, but it does set the
event handler to inactive.

Using job variables

You can use job variables within a Scheduler job, to define the value of the variable when the job is run.
Job variables aremanaged in the Job Variables section of the job.

There are two types of variables:
l User-defined variables: You can create a variable and then use it within any job or task setting

that supports variables, but only within that particular job. The primary use for user-defined
variables is to run a job via RunEvent (either the function or the command), and pass in a variable
value at that time.

l System variables: Axiom Budgeting and Performance Reporting provides a number of system
variables that can be used within relevant job and task settings. For example, instead of specifying
a "hard-coded" email address for the job notification, you can use a system variable to specify
that whoever ran the job should receive the notification.

In all cases, to use a variable within a job or task, enter the variable name into the desired setting,
enclosed in curly brackets. For example: {variable}

TIP: If you want to use a variable in a job, you can right-click the variable and then select Copy
variable name to clipboard. Navigate to the setting where you want to use the variable, and then
paste it into the setting (the curly brackets are added automatically).

At the job level, variables can be used in any of theNotification Message Content settings in the
Notification tab. At the task level, in general, variables can be used in any task field that accepts typed
user input.

When the job is run, the variable values used for the job display in the job results under Job Values, and
also in the email notification (if applicable).

� User-defined variables
User-defined variables are created in the Job Variables tab. You define the name of the variable (without
brackets), and if desired, define a default value for the variable.
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When the job is run, the user-defined variable will be replaced with a value as follows:
l If the job was scheduled using RunEvent (function or command), and RunEvent sent a name /

value pair that matches the name of the job variable, that value is used.

l If the job was scheduled as a result of a file group trigger, and the trigger has a defined variable
that matches the name of the job variable, that value is used. Multiple values are returned as a
comma-separated list.

l If the job contains a Process Document List task or a Process Plan Files task with a defined post-
processing variable that matches the name of a job variable, that value is used after that task has
been processed.

l Otherwise, the default value defined in the Job Variables tab is used.

If the value is blank, then the job or task setting using the variable will be evaluated as blank. If the
setting cannot be blank, then an error will result when the job is executed.

� System variables
The available system variables are listed at the bottom of the Job Variables tab. Most of these variables
relate to user names and addresses, for use within the job notification settings.

When the job is run, the system variable is replaced with the applicable system value.

The following values are available:

Variable Description
{CurrentUser.EmailAddress}

{CurrentUser.LoginName}

{CurrentUser.FullName}

Returns the current user's email address,
login name, or full name.

The current user is the user identity under
which the job is currently being run.
Generally, this is the user who executed the
job. If the job was executed via an event
handler and the event handler is set to
owner, then the current user will be the job
owner.

{JobOwner.EmailAddress}

{JobOwner.LoginName}

{JobOwner.FullName}

Returns the job owner's email address, login
name, or full name.

The job owner is the user who last saved the
job.

{Scheduler.ConfiguredFromEmailAddress} Returns the system's default "from" address,
as defined in the system configuration
settings.
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Variable Description
{Scheduler.FromEmailAddress} This returns a value as follows:

l If the current user belongs to a
subsystem, this returns the subsystem
administrator's email address.

l If the current user does not belong to a
subsystem, this returns the default
configured "from" address.

{CurrentSubsystem.AdminEmailAddress} Returns the email address of the subsystem
administrator for the subsystem that the
current user belongs to.
l If the subsystem has multiple

administrators, the email is sent to the
first administrator.

l If the user belongs to multiple
subsystems, the first returned subsystem
for the user will be used. No specific logic is
applied to determine the "correct"
subsystem for any particular job.

l If the user does not belong to a
subsystem, then no email address is
returned.

{EventHandler.EventName} Returns the name of the event handler that
caused the job to be scheduled, if applicable.
Otherwise the variable returns blank.

{NotificationAddress} Returns the notification address defined for
the plan codes that triggered a Scheduler job.

This variable only applies when the job is
executed as a result of a file group trigger, and
only if the optional notification address
settings are defined for the file group.
Otherwise, no email address is returned.

{Task.CurrentIterationValue}

{Task.IterationNumber}

Returns the current iteration value and the
current iteration number. These variables
only apply when using the Iteration feature
for a task.

For more information, see Using iterative task
processing.
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Processing tasks in parallel

Each Scheduler job can havemultiple tasks. By default, each task in the job is processed sequentially, in
the order that the tasks are listed in the job.

If desired, you can configure tasks so that they are processed concurrently (in parallel) instead of
sequentially. If appropriate, this may speed up the processing of the job.

� Configuring tasks for parallel processing
In order to process tasks in parallel, the tasks must be configured to run as subordinate jobs (sub-jobs).
To do this, edit the following settings in the Task Control section for each task:

l Select Create a Subordinate Job for this Task.
l Ensure that the following setting is not selected:Wait for all Subordinate Jobs to complete

before proceeding to the next Task.

In the following example, if all four tasks are configured to be run as subordinate jobs, then they can be
run in parallel (depending on the available Scheduler threads).

Scheduler task configured to run as a subordinate job to enable parallel processing

� How parallel processing works
When a task is configured to execute as a subordinate job, then it is not processed within the "parent"
job. Instead, a sub-job is created for the task. The sub-job joins the Scheduler queue and is eligible for
processing according to the normal Scheduler processing rules. For more information, see Processing
priority for scheduled jobs.

For example, imagine that you have a job with four tasks, and these tasks are not dependent on each
other. If you use the default settings, Scheduler takes the first task in the list and starts processing. The
second task is not started until the first task is complete, and so on.
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If instead you configure each task as a sub-job, then when the "parent" job is processed, it will create
four sub-jobs. If two Scheduler threads are available for processing, then two of the sub-jobs are
processed at the same time. If four Scheduler threads are available, then all four sub-jobs are processed
at the same time. Once all of the sub-jobs are complete, the parent job is completed, and its status
reflects the overall status of all of the sub-jobs.

If tasks are dependent on each other, then you should not process them as sub-jobs, or you should use
theWait setting as appropriate. For example, imagine that the first four tasks in the job can be run in any
order, but the fifth task must be processed last. In that case, you can configure the first four tasks to run
as sub-jobs, but on the fourth task you must enableWait for all Subordinate Jobs to complete before
proceeding to the next Task. This will cause Scheduler to wait for all sub-jobs to finish before it proceeds
to the fifth, final task.

In the following example, the file processing tasks are configured as sub-jobs so that they can be run in
parallel. The last file processing task is configured to wait, so that all of the file processing tasks will be
finished before the file collection task begins.

Scheduler task configured to wait for all subordinate jobs to complete

Using iterative task processing

You can configure a Scheduler task to use iterative processing, so that the task is repeated multiple times
using a designated list of values. Each iteration of the task uses a different item in the list, until all items
have been processed.

When you enable iterative processing for a task, you define the list of values by specifying a table column
and an optional filter. The task will then be processed for each unique item in the table column. You can
reference the column values within the task properties by using a built-in Scheduler job variable. As each
iteration of the task is processed, the variable is replaced with the column value for the current iteration.
Using this approach, the task can dynamically change for each iteration.
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For example, you may have an import that you want to perform for four different entities in your
organization. The import configuration is exactly the same except that the source file or query is different
for each entity. If the import uses entity as a variable, then you can set up a single import task and
configure it to iterate over the list of entities. Each iteration uses a different entity name or code, which
you can pass into the import variables so that the import uses the correct source file or query for the
current entity.

� Enabling iterative processing
Iterative processing is enabled in the Task Control properties of the task. Select the task within the
Scheduler job, then click Task Control to expand that section. Any task can use iterative processing,
though it is more useful for certain task types such as Import ETL Package.

Complete the following properties in the Iteration section of the Task Control properties.

Item Description

Iterate this Task Specifies whether iterative processing is enabled for the task. If enabled,
then the task will be performed N times, where N is the number of unique
items in the specified iteration column. Job variables can be used to apply
the current iteration value and iteration number to the task.

Create a Subordinate
Job for each iteration

Specifies whether each iteration is processed as a separate subordinate
job. By default, this is disabled, which means that all iterations are
processed sequentially within the overall subordinate job created to
process the iterations.

If enabled, then each iteration is processed as a separate subordinate job,
enabling concurrent execution ofmultiple iterations. This option should
only be enabled if the order of iteration processing is not important.

Column The column that contains the values to iterate over. Use Table.Column
syntax to specify the column. Multiple-level lookups can be used.

For example, if you specify Dept.Region, then the task will be processed
once for each unique region value in the column (after applying any filter
to limit the list of values).

Group By Optional. By default, the group by column is the same as the iteration
column, so that the task is processed once for each unique value in the
iteration column. However, if needed, you can specify a different grouping
level.

You can use any column or columns that would be valid as the "sum by"
level for an Axiom query, where the primary table is the table specified for
the iteration column.
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Item Description

Order By Optional. By default, the values are sorted based on the iteration column,
in ascending order. You can specify a different sort column, or use the
same sort column but change the order to descending.

The sort order is ascending unless the keyword desc is used to specify
descending order. For example:

Dept.Dept desc

Filter Optional. A filter criteria statement to limit the list of values for the iterative
processing. You can use any filter that is valid against the source table (the
table of the iteration column).

When iterative processing is enabled for a task, the iterations are always processed within a subordinate
job. Therefore, enabling the Task Control option of Create a Subordinate Job for this Task is
unnecessary.

If your job has multiple tasks, and you want the tasks after the iterative task to wait for all iterations to
complete before executing, then you must enable the following Task Control option for the iterative task:
Wait for all Subordinate Jobs to complete before proceeding to the next Task.

� Configuring the task to change for each iteration
In order for the Scheduler task to apply the current iteration value to each iteration, you must use the
built-in iteration variables within the task. These variables are job variables, and can be used like any
other job variable. The following variables are available:

Variable Description
{Task.CurrentIterationValue} Returns the current value from the iteration list.
{Task.IterationNumber} Returns the number of the current iteration.

To continue the previous example, imagine that you are setting up an import for iterative processing by
entity. To define the list of entities, you set up the Iteration settings in the Task Control section like the
following:
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This example will iterate over the list of entities in the Entities column, limited to only those entities
where the Costing column is set to True. If this resolves to 4 entities, then the task will be processed 4
times, once for each entity.

The import is configured with a variable {Entity}, which it uses to process the correct entity source file.
In order to pass the current task iteration value to the import variable, you can use the job variable
{Task.CurrentIterationValue} in the import task settings. For example:
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When the first iteration is performed, the {Task.CurrentIterationValue}will be resolved as
Entity_1, so the import will be processed using Entity_1 as the value for the {Entity} import variable.
For the second iteration, the value Entity_2will be used, and so on. Using this approach, the import will
be processed for all entities in the iteration column.

Conditionally processing tasks in a job

You can configure a task so that it is only processed if a particular condition is met. This feature is
configured in the task settings, in the Task Control section, under Process task only if the value of this
expression is true.

To enable conditional processing, you must specify a logical expression that will resolve to either true or
false when the job is executed. If true, then the task is processed as normal. If false, then the task is
skipped.
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The logical expression is evaluated using an IF function on the Scheduler server as follows:

=IF(Expression, 1, 0)

You can enter any expression that would be valid in an IF function. You can use Excel functions, Axiom
functions, and Scheduler job variables in the expression. If you use a job variable, it must be placed in
quotation marks unless you expect the variable value to be resolved and evaluated as a number.

If the task is not processed because the condition resolves to false, this is not considered a failed task. If
there are other tasks in the job, they will be processed. If you want an entire job to be conditional, you
can do either of the following:

l Repeat the condition in each individual task settings. Keep in mind that the condition will be
evaluated for each individual task, which means that if it is possible for the condition to change in
between tasks, some tasks might be processed while others aren't.

l Use the condition on a Raise Event task that then triggers another job for processing. For more
information, see Raise Event task.

� Examples
The following are some example expressions for conditional processing:

GetData("Process","FG='2012 Budget'","SystemStatus")=1

If this GetData function returns 1, the expression resolves to true and the task is processed. If not, it is
false and the task is skipped.
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AND("{EventHandler.EventName}"="ProcessPlanFiles",{Dept}=1000)

If this job was triggered for execution by the ProcessPlanFiles event handler, and if the job variable Dept
resolves to 1000, then this expression is true and the task is processed. Note that in the first part of the
expression, the event handler variable will return a string value so it must be placed in double quotation
marks. In the second part of the expression, the department variable will return a number so it is not
placed in quotation marks.

AND(Day(Now())<=7,Weekday(Now())=2)

This expression will return true if it is the first Monday of themonth, otherwise it will return false.

Using RunEvent to execute a Scheduler job

Using RunEvent, you can trigger the execution of a Scheduler job from various contexts, such as within
Axiom files, task panes, or Axiom forms. There are two different versions of RunEvent:

l RunEvent function: The RunEvent function can be used in Axiom files to trigger the execution of a
Scheduler job from a spreadsheet.

l RunEvent command: The RunEvent command can be used in task panes or Axiom forms to trigger
the execution of a Scheduler job.

Both the function and the command work in the sameway and use similar parameters. Some limitations
apply depending on the context where RunEvent is being used. It is assumed that an administrator (or a
power user with the necessary rights) sets up the desired jobs within Scheduler, and then sets up
RunEvent in the appropriate context so that end users can trigger it.

The end user who triggers the job using RunEvent does not need to have file permission to the job or
any access to Scheduler. The job itself can be configured to execute its tasks using the permissions of the
job owner or using the permissions of the end user who triggered the job (the requester). If the job is run
as the requester, then the end user must have the appropriate permissions to the files impacted by the
job (for example to the target file for File Processing, or to the target file group and plan files for Process
Plan Files).

NOTE: You can also use the Raise Event Scheduler task to trigger the execution of a Scheduler job
from a different Scheduler job. This works in a similar manner as the RunEvent features.

� Setting up a Scheduler job for RunEvent
All uses of RunEvent require the same job setup in Scheduler:

l The job that you want to execute via RunEvent must already be created within Scheduler. When
setting up the job, consider items such as the notification settings. Do you want the notifications
to go to the user that executed the job, or to the job owner, or both?
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l The job must contain an event handler that will be used to trigger the job execution. When
creating the event handler, consider whether you want the job to run as the job owner, or as the
requester (the user who clicks on the RunEvent function). This may impact email notifications and
determines the user rights under which the job will run.

For more information, see Advanced options.

l Optionally, the job can use variables. Variable values can be defined in the RunEvent function or
command and passed to the job. You would do this if aspects of the job need to be dynamic; for
example, if you want to use a different filter depending on which user is running the job or based
on a user selection in the file. For more information see the Variable example section below.

� Setting up RunEvent
RunEvent uses the following properties to trigger Scheduler jobs:

l The event handler name that identifies the Scheduler job(s) to trigger for execution.
l An optional confirmation message to present to the user before proceeding with the event. Not

available when using the command within an Axiom form.
l An optional success message to present to the user after the event has been raised.
l An optional file group context to target the job execution to only event handlers that are

associated with a particular file group (or no file group). For the RunEvent command, this is an
optional parameter. For the RunEvent function, the current file group context is automatically
applied if the file with the function belongs to a file group.

l If variables are being used, one or more variable names and values to pass to the Scheduler job.
This is available in all contexts, however, task panes do not currently support the ability to
determine the variable values dynamically.

The following shows an example RunEvent function for use in an Axiom file:

=RunEvent("Click here to process plan files","ProcessPlanFiles","You are
about to process plan files for the "&C3&" region. Do you want to
continue?",,"filter = "&C4)

The first parameter defines the display text for the function, while the second parameter specifies the
event handler name. In this example we have also defined a custom confirmation message for the user
and a variable value to pass a filter to the job. The following screenshot shows the function in the
spreadsheet:
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The next screenshot shows a RunEvent command set up on a Button component for an Axiom form. You
can see the same event name and the filter variable also being read from a sheet location.
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� RunEvent behavior and user experience
The behavior and user experience for RunEvent depends on the context and whether you are using
optional custom messages.

l The user starts the process by doing one of the following:
o Double-clicking the RunEvent function in the spreadsheet.
o Clicking the Button component that is configured for RunEvent in the Axiom form.
o Double-clicking the RunEvent item in the task pane.

l A confirmation prompt displays to the user, asking them to confirm that they want to proceed.
The user can click Yes to proceed, orNo to cancel. Default text is used if no custom text is defined
in the RunEvent properties.

NOTE: This step does not apply when executing RunEvent from an Axiom form. The Axiom
form context does not support a confirmation message. However, you can configure the
Button component to display a confirmation message before executing the RunEvent
command.

l Axiom Budgeting and Performance Reporting checks the list of event handlers in Scheduler to see
if any match the specified event handler name in RunEvent. This check works as follows:

o If RunEvent has a file group context, then Axiom Budgeting and Performance Reporting
only tries to match with event handlers that are associated with the same file group, or with
no file group. Any event handlers associated with a different file group are ignored. The
RunEvent command has a file group context if a file group is specified in the shortcut
parameters, whereas the RunEvent function automatically has a file group context if the file
with the function belongs to a file group.

o If RunEvent does not have a file group context, then all event handlers are eligible to match.

If any matching event handler names are found, then all Scheduler jobs that reference the event
handler are triggered for execution. If multiple jobs reference thematching event handler, then all
of those jobs will be executed.

If variable values are defined in the RunEvent properties, those values are passed to the job and
are used when the job is executed.
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l A confirmation message displays to the user as follows:
o If no jobs were found that contained the specified event handler, the user is notified that

no jobs were found.

o If jobs were placed on the schedule, the user is notified that the specified event was
scheduled. Default text is used if no custom text is defined in the RunEvent properties.

NOTE: If executing RunEvent from an Axiom form, this message displays in the bottom left
corner of the form, not in a separatemessage dialog.

When the job is finished processing, email notifications are sent according to the settings in the job.

� Variable example
When using RunEvent to execute a Scheduler job, you can pass a variable value to the job. For example,
imagine that you want to execute a Process Plan Files job, and you want to send a filter value to the job.

Step 1: Set up the variable in the job
The first step would be to create a job variable in the job, and then use the job variable in the filter
setting.

Example job variable

NOTE: In this case, we have defined a default value for the filter variable (1=0) that does not result in
any plan files. This is because we do not want to process any plan files unless a filter is provided by
RunEvent. If we left the default value blank, that would mean all plan files would be processed if no
filter was provided by RunEvent.
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Example use of variable in job settings

For more information on Scheduler job variables, see Using job variables.

Step 2: Configure RunEvent to use the Variable
Now that the job is set up to use the filter variable, you must configure RunEvent to pass in a value for
that variable. If you are using the RunEvent function in an Axiom file, you use the following syntax within
the function parameters:

variablename=variablevalue

These name / value pairs can be placed in the RunEvent function starting in the fifth parameter of the
function. If you have two name / value pairs to pass to the job, you can use the fifth and sixth
parameters, and so on.

For example, to pass the filter DEPT.Region='North' to the job, the RunEvent function would be
constructed as follows:

=RunEvent("Double-click to process plan
files","ProcessPlanFiles",,,"filter=dept.region='North'")

More likely, you would be reading the variable value from another place in the sheet, so the function
would look something like:

=RunEvent("Double-click to process plan
files","ProcessPlanFiles",,,"filter="&C4)

Where the filter value is read from cell C5.

When the job is executed by use of this RunEvent function, the value DEPT.Region='North'will be
placed in the Plan File Filter box of the Process Plan Files task, and the job will be run using that filter.
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When using RunEvent in an Axiom form, the variables and their values are defined in the Event Variables
section. In this context you place the name of the variable in the left-hand box, and then in the right-
hand box you enter the cell reference (in brackets) where the variable value will be read.

The Event Variables section is also present when configuring RunEvent for use in a task pane, however in
this context the only option is to "hard-code" the values in the RunEvent properties.

Run another Scheduler job from within a Scheduler job

Scheduler jobs have two ways to run another Scheduler job:
l Raise Event task: This task uses an event handler name to trigger one or more Scheduler jobs for

execution. The jobs triggered by the event handler are run independently from the job containing
the Raise Event task.

l Run Scheduler Job task: This task runs a specified Scheduler job as a subordinate job within the
current "parent" job. Essentially, the tasks in the target job are run within the parent job, which
means that other tasks in the parent job can reference the results of those tasks.

The decision of which task to use depends on several factors, but themost important is whether the
Scheduler jobs are independent or dependent. If the first job is dependent on the execution of the
second job, then you must use the Run Scheduler Job task. When the Raise Event task is used, the
triggered jobs are run independently.

The following chart details some comparison points between the two tasks:

Comparison Raise Event Run Scheduler Job

Can pass variables to target job Yes Yes

Can execute target job as requester or owner Yes No

Can wait for target job to complete before
continuing

No Yes

Can use results of target job in subsequent tasks No Yes

� Using the Raise Event task
The Scheduler Raise Event task is typically used when you need to trigger another job for execution once
the current job is complete. The Scheduler job(s) triggered by the event handler are added to the
schedule and then executed independently from the current job. For example, you might place the Raise
Event task at the end of the task list, so that all tasks in the current job must complete successfully
before the Raise Event task is run.
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Because the jobs triggered by the event handler are run independently, you cannot perform additional
tasks in the current job that depend on the results of the triggered jobs. The current job will not wait for
the triggered jobs to be run.

Event handlers can be configured to run a job as either the job owner or as the requester (meaning the
user that triggered the event). This allows some additional flexibility in how the triggered jobs are run.
For example, you may want to trigger a job that needs to be run using administrator permissions. As
long as the event handler is configured to run as job owner (and the owner is an administrator), then
that triggered job will always have the necessary permissions, regardless of the user who is running the
job with the Raise Event task.

� Using the Run Scheduler Job task
The Run Scheduler Job task is typically used when you need to run another job and then perform
additional tasks once that job is complete. Because the target job is run as a subordinate job within the
"parent" job, the parent job can wait for the "child" job to complete before it continues processing tasks.
Later tasks in the parent job can reference the results of the completed child job, such as querying data
saved from the child job, processing plan files created by the child job, and so on.

Keep in mind that it is not possible to stop processing tasks in the parent job based on the general
success or failure of the child job. Although Scheduler jobs automatically stop processing if a task fails,
the task in this case is just the Run Scheduler Job task. As long as the child job can be successfully added
to the Scheduler queue for processing, the Run Scheduler Job task will report success. If needed, you can
use the option Process task only if the value of this expression is true to detect whether a subsequent
task in the parent job should be processed. For example, if you know that the child job saves a particular
value to the database, you can check for the existence of that value to determine whether to process a
task. For more information on using this option, see Conditionally processing tasks in a job.

The child job is run using the same user permissions as the parent job. The user running the parent job
must have the appropriate permissions to complete all tasks in both the parent job and the child job.

� Chaining multiple Scheduler jobs
You can "chain" multiple Scheduler jobs together using either approach. For example, you may have
three Scheduler jobs that you want to run, in a particular order.

You can placemultiple Run Scheduler Job tasks in a parent job, where each task triggers a separate job.
Because these tasks run as subordinate jobs, and the parent job can wait for each child job to complete,
it is easy to run the jobs in order. However, if you want to stop processing the jobs if one fails, there is no
built-in way to do that (as discussed in the previous section). You would need to set up the Run
Scheduler Job tasks to run or not based on a condition, where the condition tests some result from the
previous job.

To chain jobs using Raise Event, the last task in each job can be a Raise Event task. Each job will perform
its tasks and then trigger the next job in the chain. When using this approach, the chain automatically
stops if failure occurs, because if a task in the job fails then the job stops and will not proceed to the
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Raise Event task. The disadvantage of this approach is that the jobs cannot also be run separately, unless
you manually disable the Raise Event tasks or configure the Raise Event tasks to not run based on a
condition.

Running a job
If a job is saved with an active scheduling rule, then the job is automatically placed on the schedule to be
run according to that rule. Each time the job is run according to the rule, it is run as the current job
owner (unless it is a system job, in which case it is run as the System identity).

However, you can also choose to run a job manually. If you run a job manually, the job is added to the
Scheduled Jobs list with a start time of now, to be processed according to its job priority settings. The
job will be run using your user identity (again, unless it is a system job).

Running a job manually does not impact any scheduled executions of the job as determined by
scheduling rules. For example, if a job is scheduled to be run at 10:00 PM tonight, and you run the job
manually at 2:00 PM, the job will still be run as scheduled at 10:00 PM.

To manually run a job:
1. In the Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Select the job and then click Open.

The job opens in the Scheduler dialog. Make sure the job is the active tab in the navigation pane
(themost recently opened tab is the active tab by default).

3. In the Job tab of the ribbon, click Run Once.

A confirmation message informs you that the job has been placed on the schedule.

NOTE: When you click Run Once, any unsaved changes to the job are automatically saved. This save
will designate you as the job owner (if you are not already the job owner).

You can also run jobs manually using the Scheduler area of theWeb Client. For more information, see
Running a job manually in theWeb Client.

Scheduler Task Reference
Each Scheduler task in a job has two sections of task properties:

l Task Control: Common task properties that apply to all task types. For more information, see
Task Control properties.

l Task Details: Properties specific to the current task type. For more information, see the topics for
each individual task type.

The following task types are available:
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Task Description

Active Directory
Import

Import users from Active Directory into Axiom Budgeting and Performance
Reporting. This task adds new users, and can also disable users that no
longer exist in the Active Directory domain.

Collect Worksheets Collect worksheets from multiple files into a single file.

Copy On Demand
Plan Files

Copy plan files from one on-demand file group to another.

Create Plan Files Create new plan files (same as the Create Plan Files utility for file groups).

Echo Task Test the Scheduler server. This task sends a message to the Scheduler
server and asks it to send themessage back.

Execute Command
Adapter

Execute a command from the Command Library.

Execute SQL
Command

Run a SQL statement on an Axiom database.

Export ETL Package Export data to an external database, using an export utility defined in the
Exports Library.

File Processing Perform file processing actions on a report. You can use the report's native
file processing settings, or override the settings.

Import ETL Package Import data into Axiom Budgeting and Performance Reporting, using an
import utility defined in the Imports Library.

Process Document
List

Process any set of Axiom files—for example, driver files or report utilities.
The task calculates and saves the files, and can also refresh Axiom queries
and save data to the database.

Process Plan Files Process plan files (same as the Process Plan Files utility for file groups).

Process Template List Process a template file. The task runs designated Axiom queries, time-
stamps the queries, and saves the template.

Purge System Data Purge old Scheduler results and system temp tables.

Raise Event Trigger another Scheduler job for execution, using a named event handler.

Run Scheduler Job Run another Scheduler job as a subordinate job.

SMTP Message
Delivery

Deliver email notifications resulting from Scheduler jobs.

Start Process Start a process definition for Process Management.

Update Indexes and
Constraints

Update the indexes and constraints in your Axiom Budgeting and
Performance Reporting database.
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Task Control properties

The following task properties are available for all Scheduler task types. To edit these properties, select the
task in the Scheduler job, then expand the Task Control section.

Item Description

Skip this Task If selected, the task will not be run when the job is processed.

By default, this option is not selected, which means this task will be run.

Process task only if
the value of this
expression is true

Optional. Enter a logical expression to conditionally process this task
depending on whether the expression resolves to true or false at the time
the job is executed. If true, the task is processed as normal. If false, the
task is skipped.

The logical expression is evaluated by the Scheduler server using an IF
function. The expression can be any statement that would be valid within
an IF function. You can use Excel functions, Axiom functions, and
Scheduler job variables in the expression. If you use a job variable in the
expression, you must place the variable in double quotation marks unless
you expect it to be resolved and evaluated as a number.

For more information, see Conditionally processing tasks in a job.

If this Task fails,
continue executing
subsequent Tasks

If selected, the job will continue processing even if this task fails.

By default, this option is not selected. If a task in a job fails, the job is
canceled and no further tasks are processed.

Create a Subordinate
Job for this Task

If selected, this task will be processed as a subordinate job to the current
job.

Selecting this check box enables concurrent processing of different tasks, if
the option toWait for all Subordinate Jobs to complete before
proceeding to the next Task is not selected.

NOTE: This option is not available for Process Plan File tasks.

Wait for all
Subordinate Jobs to
complete before
proceeding to the
next Task

If selected, the job will wait for any subordinate jobs to complete before
moving to the next task.

If this check box is not selected, and the option Create a Subordinate Job
for this Task is selected, then tasks can be processed concurrently instead
of sequentially.

This check box is selected by default for Plan File Refresh and File
Processing tasks. For other task types, this option is not selected by
default.
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Item Description

Override Log Level for
this Task

By default, Scheduler jobs perform logging at the same level that is
specified for the application. If necessary, you can override the logging
level for a particular task, so that it always runs at a specified logging level.
You may want to do this if you encounter performance issues for tasks
that generate a lot of logged messages.

To do this, select the check box forOverride Log Level for this Task, then
select the desired logging level from the drop-down list.

NOTE: This option is only available for File Processing tasks.

NOTE: Older systems may see a setting namedWorkbook processing engine to use. If this option is
present, it should always be set to Axiom Web Engine. Use of Excel for processing on the Scheduler
server is no longer supported. All Scheduler tasks that involve spreadsheet processing are processed
using the same spreadsheet emulation engine as theWindows Client.

Iteration
This section can be used to optionally enable iterative processing for the task. For more information, see
Using iterative task processing.

Item Description

Iterate this Task Specifies whether iterative processing is enabled for the task. If enabled,
then the task will be performed N times, where N is the number of unique
items in the specified iteration column. Job variables can be used to apply
the current iteration value and iteration number to the task.

Create a Subordinate
Job for each iteration

Specifies whether each iteration is processed as a separate subordinate
job. By default, this is disabled, which means that all iterations are
processed sequentially within the overall subordinate job created to
process the iterations.

If enabled, then each iteration is processed as a separate subordinate job,
enabling concurrent execution ofmultiple iterations. This option should
only be enabled if the order of iteration processing is not important.

Column The column that contains the values to iterate over. Use Table.Column
syntax to specify the column. Multiple-level lookups can be used.

For example, if you specify Dept.Region, then the task will be processed
once for each unique region value in the column (after applying any filter
to limit the list of values).
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Item Description

Group By Optional. By default, the group by column is the same as the iteration
column, so that the task is processed once for each unique value in the
iteration column. However, if needed, you can specify a different grouping
level.

You can use any column or columns that would be valid as the "sum by"
level for an Axiom query, where the primary table is the table specified for
the iteration column.

Order By Optional. By default, the values are sorted based on the iteration column,
in ascending order. You can specify a different sort column, or use the
same sort column but change the order to descending.

The sort order is ascending unless the keyword desc is used to specify
descending order. For example:

Dept.Dept desc

Filter Optional. A filter criteria statement to limit the list of values for the iterative
processing. You can use any filter that is valid against the source table (the
table of the iteration column).

Active Directory Import task

This task imports users from Active Directory groups into Axiom Budgeting and Performance Reporting
security. For more information on using Active Directory integration with Axiom Budgeting and
Performance Reporting, see the Security Guide.

This task has three tabs of settings: Source Directory, Notification, and Preview Import.

NOTE: The user running this task must be an administrator or have the Administer Security
permission.

For Axiom Cloud systems, the Active Directory Import task can import users from your local Active
Directory by use of the Axiom Cloud Integration Service. If you have a remote data connection that is
enabled for user authentication, this task will use that connection when the job is executed by Scheduler.

� Source Directory tab
On this tab, you specify the domain to import from and the groups to import.
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Item Description

Domain or
Server

Select either Domain or Server to specify the source domain for the import.
l If you select Domain, enter the name of the domain.
l If you select Server, enter the name of the domain controller server.

The server option is available in case you are not currently logged into the
source domain, and your current domain does not have access to the source
domain. In this case, you must use domain credentials in order to access the
source domain.

Only one domain can be selected per import task. If you want to import users
from multiple domains into an Axiom Budgeting and Performance Reporting
system, then you must createmultiple import tasks.

Credentials Specifies the credentials to use when accessing Active Directory for the import.
Select one of the following:
l Use process credentials: (Default) Use the credentials of the network service

account for Axiom Scheduler Server (on-premise installations) or Axiom
Cloud Integration Service (Axiom Cloud systems).

l Specify domain credentials: Enter the credentials of a specified domain User
and Password. This option is required if you identified the source domain
using the server name instead of the domain name.

Never Enable
Users

Specifies whether the import enables imported users as part of the process:
l If unchecked (default), then newly imported users are enabled as part of the

import. Additionally, any existing imported users who have been changed to
disabled are re-enabled.

l If checked, then newly imported users are not enabled as part of the import.
A security administrator must modify the security settings after the import is
complete to enable the new users. Existing imported users retain their
current enabled status.

Groups to
import

The Active Directory groups for which members will be imported into Axiom
Budgeting and Performance Reporting Security.
l Click Add to select from a list of groups for the specified domain. If the

specified domain name is not valid or if Axiom Budgeting and Performance
Reporting cannot connect to it, then an error will result when attempting to
add groups.

l If you need to remove a group, select the group and click Remove.
l Click Role Mapping to definemappings for the selected groups. If a mapping

exists for a group, then when users are imported for that group they are
automatically assigned to themapped role and subsystem. See the
discussion following this table for more information.
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Role mapping
In the Role Mapping dialog, click Add mapping (the plus icon) to add a role mapping for a group. Then
complete the following:

l In theDirectory Group column, select the Active Directory group to bemapped.

l In the Axiom Role column, select the role to be assigned to users in that group. If you want to
map the group to more than one role, add another mapping row. You can select None if you do
not want the users in the group to be assigned to any role.

l In the Subsystem column, select the subsystem for users in that group. If you want to map the
group to more than one subsystem, add another mapping row. This option only displays if
subsystems are enabled for your system.

l In theUser Type column, select the license type for the imported users. The default license type is
Standard.

l In the Authentication Type column, select the authentication type for the imported users,
Windows User or SAML. The default authentication type is Windows User. Note that the selected
authentication type will be assigned to users regardless of whether that authentication type is
currently enabled for the system.

You can map each group to multiple roles and subsystems. If a group has no defined mappings, then the
users will not be assigned to any roles or subsystems. If the import creates new users without mappings,
the assigned user type is Standard and the assigned authentication type is Windows User.

To remove a mapping, select themapping in the grid and then click Remove mapping (the X icon). If
users have already been imported using this mapping, removing themapping will not remove the users
from the role or subsystem in subsequent imports (unless other group mappings in the import use the
same role or subsystem, and the users are not also part of that group).

NOTE: If a user belongs to multiple mappings—either multiple mappings for a single group, or
multiple mapped groups—then the user will be assigned to the user type and the authentication
type for the last-processed mapping.

� Notification tab
On this tab, you specify users to be notified when changes aremade in Axiom Budgeting and
Performance Reporting Security due to the import.

Type in one or more email addresses to be notified. Separatemultiple addresses with a semi-colon. For
example:

jdoe@axiomepm.com;jsmith@axiomepm.com
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When the import task is run, if any users are created or modified in the Axiom Budgeting and
Performance Reporting system, an email notification will be sent to the addresses specified here. The
email summarizes the changes made. This email notification is independent of any job-level notification
settings (which notify based on overall job completion or failure).

We recommend setting up this task-level notification to send emails to the security administrator(s)
responsible for maintaining the security settings in Axiom Budgeting and Performance Reporting, so that
he or she can define security settings for newly added users, validate changes made to existing users,
and perform any other follow-up tasks.

Scheduler job variables can be used in this setting.

� Preview Import tab
On this tab, you can preview the import results to test that the import is set up as desired.

To preview the results, click Preview. Axiom Budgeting and Performance Reporting processes the import
task but does not actually make the changes to the system. Instead, the tab displays a summary of the
changes that would result.

The preview shows a list of users that would be added, changed, or disabled.

NOTE: The preview is always executed locally, even for Axiom Cloud systems. The remote data
connection to the Cloud Integration Service is only used when the task is executed by Scheduler.

Collect Worksheets task

This task collects sheets from multiple source workbooks and combines them into a single target
workbook. You can then save the target workbook to a specified file location, and/or email the
workbook.

NOTE: This task is primarily intended for backward-compatibility only. Themain method of
performing a file collect operation is to use the file processing feature with the File Processing
Scheduler task. For more information on setting up a file collect report using file processing, see the
Axiom File Setup Guide.

Typically, this task would be used at the end of a job with multiple File Processing tasks, to take the
results of those tasks and collect them into a single workbook.
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Item Description

Save or Email
Workbook

Specifies the delivery option for the target workbook. Select one of the
following:

l Save Workbook: The target workbook is saved to the specified output
folder.

l Email Workbook: The target workbook is emailed to the specified recipients.
The file is not saved anywhere on the file system.

l Save and Email Workbook: The target workbook is both saved and emailed.

� Target Workbook
Complete the following settings to define the target workbook:

Item Description

Output Folder The folder location where the target workbook will be saved (if you are saving
the workbook). Click the folder icon to select a folder location, or type a folder
location.

If the specified folder does not already exist, Axiom Budgeting and Performance
Reporting attempts to create it.

Job variables can be used in this setting.

Output File
Name

The name of the target workbook. Job variables can be used in this setting.

File Type The file type of the target workbook. Select XLS, XLSX, or XLSM.

NOTE: PDF displays as an option, but it is not supported in this context.

� Email Settings
This section only applies if you are emailing the target workbook. The "From" address is always the
Scheduler default From address (as defined in the system configuration settings).

Item Description

To Enter the email addresses to receive the target workbook via email. Separate
multiple addresses with a semicolon.

Subject Line The subject line for the email.

Body Text The body text for the email.
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� Source Workbooks
In this section, you specify one or more source workbooks from which to collect worksheets. Workbooks
are identified by folder location. Within a folder location, you can specify one or more workbooks by
name, or by using wildcards, or by using *.* to collect all workbooks at the location.

All sheets in each source workbook will be collected. Ideally, you will be collecting from workbooks that
only contain relevant sheets (for example, no blank "Sheet2," etc.), and where the sheets have unique
names. If multiple workbooks have sheets with the same name, the sheets will be incremented by
number in the target workbook.

To add a workbook, click the Add button. In the Edit Workbooks Source dialog,
complete the settings as described below, then click OK to add the workbook to the
list.

To remove a workbook, select the workbook in the list and then click the Remove
button. Only one workbook can be selected at a time.

To change the order of workbooks, select the workbook in the list and then click the
arrow buttons to move the workbook up or down. Source workbooks are processed
in the order they are listed in the grid.

Item Description

Folder Path The folder location of the source workbook(s). Click the folder icon to select a
folder location.

NOTE: The Folder Path location must be accessible by the Scheduler service
user account. If you specify a network folder location using the Browse button,
the location is automatically entered as a UNC path. If you specify a C: drive
location, that will be evaluated as the C: drive of the Scheduler server.

Job variables can be used in this setting.

Workbooks The workbooks from which you want to collect worksheets, within the specified
folder path.

l Specify *.* if you want to collect all files in the folder path.
l Specify individual file names to collect from specific files. Separatemultiple

file names with semicolons.

You can use wildcards (* or ?) to specify groups of files that share naming
conventions. For example: North*.xls to collect all XLS files where the file
name starts with "North".

Only files with the following file types are valid to be collected: XLS, XLSX, XLSM.
If you are using wildcards, thematches must be valid file types, or else the task
will fail with an error.

Job variables can be used in this setting.
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Once you have saved a source workbook location, you can edit it by double-clicking the row.

Copy On Demand Plan Files task

This task copies on demand plan files from one file group to another. It performs the same actions as the
Copy On Demand Plan Files command in the Command Library.

This is an advanced feature and should only be used if it is the only way to achieve the desired
population of plan files between two related file groups. It is the responsibility of the solution designer to
ensure that the copied plan files will behave as expected in the target file group. For example, the plan file
must be designed to dynamically save to the appropriate tables and columns within the context of the
new file group.

The Copy On Demand Plan Files task uses two tabs to define the properties of the task.
l Options: Defines the options to be used for the copy operation
l Plan Files: Specifies the plan files to copy

� Options tab
The following options are available on the Options tab. Note that all of these options can be changed
dynamically by using system variables.

Item Description

Source File
Group

The file group to copy plan files from. Click the folder icon to select a file group.
You can select any on-demand file group, or any file group alias that currently
points to an on-demand file group.

Destination File
Group

The file group to copy plan files to. Click the folder icon to select a file group. You
can select any on-demand file group, or any file group alias that currently points
to an on-demand file group.

Keep original
plan file creator

Specifies whether the plan file creator for the copied plan files is set to the same
creator as the original plan files. By default, this option is enabled.

If this option is disabled, then the plan file creator for the copied plan files is set
to the user identity used by the Scheduler job when it is run.
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Item Description

Use default
template

Specifies whether the copied plan files have the option to adopt the default
template of the new file group. This is primarily intended to be used when
copying plan files to a file group that uses virtual, form-enabled plan files, so
that the copied plan files can be converted to virtual files and use the new
template.
l If disabled (default), then the target file group must contain copies of the

original templates that were used to create the plan files from the source file
group. If these templates are not present, then the copy process will fail.

l If enabled, then the copied plan files will be assigned a template as follows:
o If the target file group contains copies of the original templates that were

used to create the plan files from the source file group, the copied plan
files use those templates.

o If the target file group does not contain copies of the original templates,
the copied plan files use the default template specified for the target file
group in the file group properties.

If the target file group does not contain copies of the original templates and
does not have a designated default template, then the copy process will fail.

Copy plan file
attachments

Specifies whether plan file attachments are copied to the target file group when
a plan file is copied. By default, this option is enabled.

If this option is disabled, then plan file attachments will not be copied to the
target file group.
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Item Description

Save plan files
after copy

Specifies whether the new plan files are processed and saved in the target file
group after the copy is performed. This is intended to perform a save-to-
database within the context of the new file group. By default, this option is
disabled.

If you enable this option, then after the plan files are copied to the new file
group, they are opened, refreshed, and saved (including a save-to-database).
The refresh includes all active Axiom queries where Refresh during document
processing is enabled.

Regardless of whether this option is enabled, if it is ever intended to save the
copied plan files in the target file group, then they must be designed so that
they save data to the appropriate tables after being copied.

NOTES:
l If Process with Utilities is enabled for the target file group, then utility

processing is performed instead of normal processing. The default data
source is used.

l If you enable this option but also specify a Copy data utility, then the new
plan files are not processed and saved. Instead, the designated utility file is
processed for each new plan file.

Copy data utility Optional. Specifies a utility file to process for each copied plan file. You can select
any file in the Utilities folder of the target file group, or a file in the Reports
Library.

The primary purpose of this option is to handle copying virtual plan files
between file groups. Because the plan files are virtual, no data exists in the file
itself and therefore saving the new plan file will not populate data for the new
file group. Instead, you should create a utility file that queries in the necessary
data for the original plan file, then saves the necessary data for the new plan file
to the appropriate tables for the new file group. Reserved document variables
are available to return information in the utility file such as the old plan file code
and the new plan file code.

For more information, see Copy data utility.

NOTE: Save plan files after copymust be enabled in order to specify a copy
data utility. If a utility is specified, then the new plan files are not saved and
instead the utility file is processed for each new plan file.

Default Values Optional. This section can be used to apply default values to any columns in the
target plan code table, when the new record is created in the target file group.
For more information, see Defining default values.
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� Plan Files tab
On the Plan Files tab, specify the plan files from the source file group that you want to copy to the target
file group. There are three different options that you can use to specify the plan files: Choose from list,
Use filter, and All.

Themost common option when copying plan files using Scheduler is to define a filter. You can
dynamically copy a subset of designated plan files using the filter. If the Scheduler task is triggered by
using RunEvent, you can pass in the filter from the source of the RunEvent (such as an Axiom form).

Copy a filtered set of plan files
To use a filter to copy a subset of plan files, select Use Filter. When the Scheduler task is executed, Axiom
Budgeting and Performance Reporting will process only the plan files that meet the filter. You can specify
the filter directly, or use a job variable.

To specify the filter, click the Filter Wizard button. You can also manually type a filter criteria statement
into the filter box. The filter must use the plan code table of the source file group, or a lookup table. For
example: CapReq2019.Transfer=1, where CapReq is the plan code table.

Once you have entered a filter, you can click Refresh plan file list to show the plan files that currently
match the filter. The refresh feature is intended to help you determine whether you have defined the
filter correctly.

If you want to set the filter dynamically, you can use the Filter system variable to override the filter
defined in the task. This is intended for use when running Scheduler jobs via RunEvent. If a variable value
is specified when triggering the event, such as the value CapReq2019.CapReq IN (45,67,98) , then
that filter statement is used to determine the plan files to be copied instead of the filter defined in the
task.

Copy all plan files
To copy all plan files, select All. When the Scheduler task is executed, Axiom Budgeting and Performance
Reporting will copy all plan files in the file group (except for those hidden via the Show on List column).
This is not a common use case for the copy feature, but can be used if needed.

Copy selected plan files
To copy certain plan files, select Choose from list, and then select the check boxes for the plan files that
you want to copy. When the Scheduler task is executed, Axiom Budgeting and Performance Reporting
will copy only the selected plan files. This is not a common use case for the copy feature, but can be used
if needed.

NOTE: This option is not available when using a file group alias as the source file group for the task.
This is because the alias could change to point to any file group, which could result in a different list of
plan files.
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� Defining default values
When the copy action is performed, the columns for the new record are populated as follows:

l If a value has been defined for a column in theDefault Values section, that value is used.
l Otherwise, the value from the original record in the source file group is used. This only occurs if

the column names match in the source and target tables, and if the column in the target table is a
compatible data type to accept the copied value.

If a column exists in the source table but not the target table, that value is ignored and does not cause an
error. If a column exists in the target table but not in the source table, then it is only populated during
the copy action if a default value has been defined. If the target table contains columns with lookup
relationships, those columns must be populated with valid values (either from the original record or by
using default values) or else the copy action will fail.

To define default values for the new records:
l Click the plus button to add a new column/value pair to theDefault Values section.

l In the left-hand box, type the name of the column in the target plan code table. For example:
SourceID. Do not use Table.Column syntax.

l In the right-hand box, type the value to be placed in this column. You can enter a "hard-coded"
value, or you can enter the name of a column from the source plan code table in brackets to use
the value from that column. For example, [CapID]. The column reference is only necessary if you
want the source column value to be placed in a column that has a different name than the source
column. If the columns have the same name, the value will be copied automatically as noted
previously in this section.

For both the column name and the value, you can use file group variables via a file group alias. Axiom
Budgeting and Performance Reporting looks up the current target of the alias, and finds the current
value of the designated variable within that file group. Built-in variables and custom variables can both
be used. To reference a variable, use the following syntax:

{FileGroupAliasName.VariableName}

For example: {CP_CurrentYear.FileGroupYear} returns the file group year for the file group
that is currently the target of the CP_CurrentYear alias.

Scheduler job variables can also be used in the column name and in the value.

� Overriding task settings using system variables
All of the settings for the Copy On Demand Plan Files task can be overridden using system variables. This
is intended for use when the task is being triggered by RunEvent (such as from within an Axiom form),
and you want to pass in variable values to determine how the task is run.

The variable names for this task are as follows:
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Variable Description

CopyDataSourceFileGroupID Overrides the Source File Group. Must be set to a valid file group ID.
File group names or alias names cannot be used.

CopyDataTargetFileGroupID Overrides theDestination File Group. Must be set to a valid file
group ID. File group names or alias names cannot be used.

CopyDataUtilityPath Overrides the Copy data utility. Must be set to a valid document
path in Axiom Budgeting and Performance Reporting.

Filter Overrides the Plan File Filter to specify the plan files to copy. Must
be set to a valid filter criteria statement.

KeepOriginalPlanFileCreator Overrides the option Keep original plan file creator. Must be set to
a valid Boolean value (True/False).

UseDefaultTemplate Overrides the option Use default template. Must be set to a valid
Boolean value (True/False).

CopyPlanFileAttachments Overrides the option Copy plan file attachments. Must be set to a
valid Boolean value (True/False).

SavePlanFilesAfterCopy Overrides the option Save plan files after copy. Must be set to a
valid Boolean value ( True/False).

To override task properties using these variables:
l Add the variables that you want to use to the Job Variables tab. For example, if you want to

override the source and target file groups, the copy data utility, and the plan file filter, then add
those variables to the Job Variables tab. You do not need to add a variable name if you do not
plan to override it.

Example Job Variables tab to override certain settings for the copy task

You do not need to define a default value for the variable. If the value is blank, then the setting
defined in the task is used. The corresponding task property will only be overridden if the variable
has a defined value.

l You do not need to add the variables to the task properties. The variables automatically overwrite
the task properties if they have defined values.
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l When configuring RunEvent, define values for the variables as needed. For example, you could
have a form where you allow the user to select the source and target file group for the copy
action. Based on the user's selected file group names, you can use the GetFileGroupID function to
determine the IDs for those file groups. You can then pass those IDs as variable values for the
variables CopyDataSourceFileGroupID and CopyDataTargetFileGroupID.

Example RunEvent properties to pass certain variable values to the copy task

� Plan file process considerations
If the target file group has an active plan file process, the new plan file is started in that process as part of
the plan file creation. The process initiator for the plan file is set as follows:

l If the plan file process has a designated Process Initiator Column, the user listed in that column is
the process initiator.

l If the plan file process does not have a Process Initiator Column, or the column value is blank,
then:

o If Keep original plan file creator is enabled for the command, then the original plan file
creator is the process initiator.

o Otherwise, the user performing the copy operation is the process initiator.
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� Copy data utility
If a Copy data utility is specified, this processing is performed as follows:

l The selected plan files are first copied to the new file group. If the plan files are virtual, then the
placeholder document records are copied instead of physical plan files.

l The utility file is opened once before processing begins. Any data lookups or Axiom queries that
are configured to refresh on open are executed at that time.

l The utility file is then iteratively processed for each new plan file as follows:
o Document variables are set in the utility, and the workbook is calculated.
o Axiom queries set to Refresh during document processing are refreshed.
o A save-to-database is executed.

The utility file is not closed and reopened for each new plan file. All processing occurs within the same file
session, similar to when performing multipass file processing.

The following reserved document variables are available to the utility file, to be returned using
GetDocumentInfo. These variables return necessary information about the copied plan files and the
source and target file groups.

Variable Description

SourceFileGroupID The ID of the source file group. You can use this ID in functions such as
GetFileGroupVariable—for example, to return the name of the data table
to query from the source file group.

SourcePlanCode The plan code of the original plan file from the source file group. You can
use this code to filter Axiom queries to return data for the original plan file.

TargetFileGroupID The ID of the target file group. You can use this ID in functions such as
GetFileGroupVariable—for example, to return the name of the data table
to save data to for the target file group.

TargetPlanCode The plan code of the new plan file in the target file group. You can use this
code to save data for the new plan file.

For example, GetDocumentInfo("Variable","SourceFileGroupID") returns the ID of the source
file group.

Create Plan Files task

This task creates plan files for a file group. It works the sameway as the Create Plan Files utility that is
available from the file group menu.

This task has two tabs of settings in the Task Details area: General and Plan Files.
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NOTE: If you are using Create Plan Files to create new on-demand plan files, those plan files will be
automatically started in the designated Plan File Process for the file group. This only applies when
creating a brand new plan file. If an existing plan file is overwritten, its process status will be left as is.

� General tab
The following settings are available on the General tab:

Item Description

Select File Group The file group for which plan files will be created. You can select any file group or
file group alias.

If the Scheduler job is stored in a file group Utilities folder, then you can select
Use Current File Group to automatically use the file group that the Scheduler
job belongs to. This is the recommended approach when the Scheduler job
belongs to a file group, so that it will automatically update to point to the
current file group when the file group is cloned.

NOTE: If the task uses an alias, then you cannot select individual plan files on
the Plan Files tab. Only theUse Filter and All options are available.

Overwrite
existing plan
files?

By default, this option is not selected, which means that existing plan files will
not be overwritten, even if the plan file is selected to be created.

If selected, existing plan files will be overwritten.

� Plan Files tab
On the Plan Files tab, specify the plan files that you want to create. This tab lists all plan codes that you
have the right to access. (If a plan code has been set to False in the designated Show On List Column for
the plan code table, then it is not available in this list.)

You can create plan files in any of the following ways:
l Create all plan files: To create all plan files, select All. This will cause all plan files to be created, for

all existing and future plan codes.

Alternatively, you can select Choose from list and then select the check box in the column header,
causing all plan codes to be selected, but then the list of plan codes is fixed and will not adjust for
any future changes. For example, if you add a new department in the future, that new
department will only be created by this task if you use the All option.
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l Create selected plan files: To create certain plan files, select Choose from list and then select the
check boxes for the desired plan codes.

To find the plan files you are looking for, you can sort, filter, and group the list using standard
Axiom grid features. You can show additional columns and hide columns by right-clicking in the
column header. If you have filtered the list, you can select the check box in the header to select
only the plan codes that currently display in the dialog.

NOTE: This option is not available if the file group for the task is an alias. This is because the list
of plan files could change when the alias target changes.

l Create a subset of plan files using a filter: To use a filter to create a subset of plan files, select
Use filter, and then type a filter into the filter box. You can also use the Filter Wizard to build the
filter. The filter must use the plan code table or a reference table that the plan code table links to.
For example: DEPT.Region='West'.

Once you have entered a filter, you can click Refresh plan file list to show only those plan codes
that currently match the filter. This feature is to help you determine whether you have defined the
filter as intended. The filter will be applied to the list of plan codes when the Scheduler job is
processed, so if changes have been made to the plan code table since then, the actual list of plan
files processed will reflect those changes.

You can also use a job variable for the filter. For example, you can define a job variable named
"filter" and then place the text {filter} in the filter box. This is intended for use when running
Scheduler jobs by using the RunEvent function. If a value is specified in the RunEvent function,
such as "Filter=dept.region='west'", then that filter will be used in place of the {filter} variable
to determine the list of plan files to be created.

NOTE: If you use a variable, and you leave the default value for that variable blank within the
Job Variables tab, then all plan codes will be created if no value is passed by the RunEvent
function (or if the value is invalid). You may want to define a default filter that results in no
values (such as 1=0), so that plan files are only created if a valid filter value is passed.

IMPORTANT: For all of these options, theOverwrite existing plan files option on the General tab
determines whether all selected plan files are created, or only the plan files that do not already exist.

Echo task

This task is used for testing purposes only, to check whether a Scheduler server is running and
operational. The task sends a message to the Scheduler server, and asks it to send themessage back (an
"echo"). If successful, themessage displays in the job results. No other action is performed.
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Item Description

Message to Echo Themessage to send to the Scheduler server for testing.

Job variables can be used in this setting.

Sleep Time The time to pause in between message echoes, in seconds. Scheduler will echo
themessage once, then wait the specified sleep time, then echo themessage
again.

Execute Command Adapter task

This task executes a selected command from the Command Library.

� Task properties
This task has one property named Command Name that specifies the command to execute.

To select a command to execute:
1. Click Edit Command.

2. In the Shortcut Properties dialog, click the browse button [...] to the right of the Shortcut Target
box.

3. In the Axiom Explorer dialog, select the desired command from the Command Library, then click
Open.

This returns you to the Shortcut Properties dialog. The selected command is now listed in the
Shortcut Target box, and the Shortcut Parameters section displays the parameters for the
command.

4. Complete the Shortcut Parameters for the command as needed. The available parameters
depend on the selected command.

You can later edit the shortcut parameters or select a different command by clicking Edit Command.

� Supported commands
Only certain commands are available for execution in this context. The following commands are available:

l File Group Rollover
l Create File Group Scenario

l File Group Rollover
l Create File Group Scenario

Systems with installed products may have Scheduler jobs that use the following additional commands:
l Create File Group From Prototype
l Upgrade File Group To Prototype Version
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These commands can only be configured by product developers. Clients looking for more information on
how to use a particular product-delivered Scheduler job should consult their product documentation.
Syntellis employees should consult internal resources for more information on this feature as needed.

Execute SQL Command task

This task runs a SQL statement on an Axiom database. If needed, you can also use this task in a user-
defined job to run any valid SQL statement on an Axiom database.

NOTE: The SQL statement in this task will be run as the Axiom database user, regardless of which
user executes the job.

This task has the following settings:

Item Description

Source Axiom
Database

Select the database on which to run the SQL statement:
l Current system database: The database for the current system.
l Current audit database: The corresponding audit database for the current

system.

SQL Command
Text

Enter any valid SQL statement to be run against the specified database.

To validate the syntax of the SQL statement, click the Check SQL syntax button
. Axiom Budgeting and Performance Reporting sends the statement to your

database server to see if the statement can be parsed, resulting in either a
success message or an error message.

Job variables can be used in the SQL statement. The Check SQL syntax button is
not available if the statement uses variables.

Export ETL Package task

This task exports data from Axiom Budgeting and Performance Reporting to an external database (same
as executing an export from the Exports Library).

This task has one setting, Select ETL Export Package. This is the name of the export package to process.
You can select any export that is defined in the current system.

File Processing task

This task performs file processing on a specified report file or file group utility. The file must already be
enabled for file processing. You can use the file processing settings that are already in the file, or you can
override any setting.

The following settings must be completed for the task:
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Item Description

File to Process The report to process for the task. Click the Browse button to open the Axiom
Explorer dialog, and then select a report to process. You can select any report
that you have access to within the Reports Library or a file group Utilities folder.

Only one report can be selected for each File Processing task. If you want to
process multiple reports, you can add multiple File Processing tasks to the
Scheduler job.

TIP: Once the file is selected, only the file name displays in the task. If you want
to know the folder location of the selected file, hover your cursor over the field.
The folder location is listed in the tooltip.

If this Scheduler job is stored in a file group Utilities folder, then you can
optionally navigate to the report through the Current File Group node at the
top of the file groups list. When you do this, the path to the file is stored relative
to the current file group, which means that it will automatically update when
the file group is cloned. This is the recommended method of referencing the
report to process when both the Scheduler job and the report belong to the file
group.
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Item Description

Override file to
process

Optional. Specifies a Scheduler job variable to override the file to process. The
override file will then be used for processing instead of the original file. This
feature allows you to pass in an alternate file to process, when using Run Event
or Raise Event to trigger the Scheduler job for processing.

To use a job variable, enter the variable name in curly brackets, such as
{MyFile}. When the job is executed, this variable must resolve to a valid file
path in the Axiom Budgeting and Performance Reporting file repository. Note
that it is not valid to leave the variable value blank (the task will not use the
original file to process).

NOTES:
l The override feature is only exposed to product developers. It is only

visible in client systems if the job is delivered as part of a product package
and an override variable is specified in that job.

l The File to Process field must point to a valid file for file processing when
the override feature is used, even though that file will never actually be
processed by the task. If the file to process is missing or invalid, then the
task validation will fail.

Process
Multipass

Specifies whether the report will be run using multipass processing.
l If this option is selected, multipass processing is performed. This is

equivalent to selecting File Output > File Processing > Process File
Multipass.

l Otherwise, multipass processing is not performed and multipass settings do
not display in the task. This is equivalent to selecting File Output > File
Processing > Process File.

NOTE: If you select Process Multipass, but the file does not have any defined
multipass settings, then you must override the blank multipass settings for the
file and define them in the equivalent of "advanced mode." If you want to use
"basic mode" settings (specify only a source column and Axiom Budgeting and
Performance Reporting automatically completes the rest of the settings for
you), then you should edit the file to define the basic modemultipass settings
so that they can be inherited by the task.

Enable iterative
calculation while
processing

Specifies whether iterative calculations are enabled for the file during
processing. In most cases you will leave this option disabled.

If this option is selected, then iterative calculations are enabled for the file
during the Axiom query refresh process. The iterative calculation settings are
fixed at a maximum of 100 iterations and a maximum change value of .001.

For more information on iterative calculations, see theMicrosoft Excel Help.
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� Advanced options
This section only displays if multipass processing is enabled for the task, and the task uses settings that
are eligible for parallel processing. Click on the down arrow next to the title to expand the section and
view the options.

Parallel processing for file processing tasks is performed based on multipass passes. With certain task
settings, multiple passes can be separated into sub-jobs, which can then be processed at the same time
(in parallel). This can improve the performance of the task.

For example, imagine that you aremultipass processing a file by department. If the task is processed
sequentially, then the task would process Dept 100 and finish it, then move to Dept 110 and finish it, etc.
When parallel processing is used instead, Depts 100-199 can be separated into one sub-job, Depts 200-
299 into another sub-job, etc. Because the sub-jobs are processed in parallel, multiple departments are
processed at the same time, so the overall task can completemore quickly.

Item Description

Maximum
Parallel Jobs

Themaximum number of subordinate jobs to run in parallel. The default
number is 4.

This is the total number of sub-jobs that can be run at the same time for this
task. Ultimately the number of sub-jobs that are run in parallel depends on the
number of Scheduler threads that have been configured for use at your
organization, and the number of Scheduler threads that are currently available
(threads that are not processing other higher-priority jobs).

Processing Batch
Size

The number ofmultipass passes to include in each sub-job at a time. The
default number is 10 for eligible snapshot and export processes, and 7000 for
eligible save-to-database processes (save once at end).

Passes are determined based on themultipass list of items. For example, if you
are processing by department (DEPT.DEPT), then each department is a separate
pass. If the batch size is set to 10, then each sub-job would process 10
departments at a time.

In most cases, the default settings are sufficient. If you are experiencing lengthy
processing times and want to optimize performance, you can adjust this setting
as follows: divide the number of passes by the number of available Scheduler
threads. For example, if there will be 100 passes and there are 4 Scheduler
threads, set the batch size to 25.
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NOTES:
l For save processes, only "save once at end" processes are eligible for parallel processing. In

this case, the records to be saved to the database are extracted after each pass to a central
temporary table. Once all passes are complete, then all records are saved to the database
from the temporary table. Save processes where data is saved directly after each pass are not
eligible, because these processes may depend on sequential processing.

l There is no way to disable parallel processing if the task is eligible; however, you can adjust the
parallel processing settings if desired.

� File processing settings
Once you have selected a file to process, the file processing settings from that file display within the task
as read-only. You can leave the settings as they are, or you can override any setting.

l To override a setting, select theOverride check box to the right of the setting. The setting
becomes editable, and you can change it. The change only applies to the file processing task—the
setting remains unchanged within the file.

l If you override a setting, make sure that any related settings make sense in the context of the
change. For example, if File Generation is set toMultiple Output Files, and you override it to be
Single Output File, then you should also check the Sheet Names setting to make sure that you
will end up with unique sheet names within the file.

NOTE: If the target file for the task uses File Collect or Batch processing, then it is not possible to
override the settings on the File Collect Configuration Sheet or the Batch Control Sheet.

For more details on file processing settings, see the Axiom File Setup Guide.

Note the following requirements when running file processing using Scheduler:
l TheOutput Folder location must be accessible by the Scheduler service user account. If you

specify a network folder location using the Browse button, the location is automatically entered as
a UNC path. If you specify a C: drive location, that location will be evaluated as the C: drive of the
Scheduler server.

l If the file processing type is Print, the Scheduler server(s) must be configured to access the
specified printer. This may require the assistance of your IT department.

Job variables can be used in any file processing setting that accepts a typed user input.

� Batch variables
If the file has defined batch variables, you can specify variable values to be used for the file processing
task. When the task is executed, any specified variable values are temporarily placed within the file,
within the designated cell for that variable value. The file can be set up to use the variable value in some
way during processing.
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Item Description

Variable Names The names of the variables, as defined in the File Processing Control Sheet for
the source file. If no names are listed, then no variables are defined in the file.

Variable Values The variable values to be placed within the file when the file processing task is
executed.

Job variables can be used in the batch variable settings. For example, a job variable can be used as the
value for a batch variable.

Import ETL Package task

This task imports data into Axiom Budgeting and Performance Reporting (same as executing an import
from the Importsmenu).

NOTE: If the import package is configured to Ignore lookup and key errors, then if errors are found
the execution status of the job will be Partial Success. This will trigger an email notification if the job is
configured to notify only on error.

Item Description

Select ETL
Import Package

The import package to process. You can select any import that is defined in the
current system.

Source Filename The path and name of the source file. This option only applies in the following
situations:

l The import is configured to pull data from a source file (instead of a database
table).

l The import is configured to prompt the user for the source file during
execution.

If the import is configured to always use the same source file, then that file
displays for reference in the Source Filename box, but it is grayed out and
cannot be changed.

Job variables can be used in this setting.

Package
Variables

Specifies values for any variables used in the import package.

Variables are listed in the right-hand side of the grid. Use the drop-down list next
to the variable name to select from the defined set of choices, or type in a value.

Job variables can be used in this setting.

Process Plan Files task

This task processes plan files in a file group. It performs the same actions as the Process Plan Files utility
available from the file group menu.
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The Process Plan Files task uses several tabs to define different options. The available tabs and the
options on those tabs depend on the selected Processing Mode on theOptions tab.

l Options: Defines the overall processing mode and processing options
l Plan Files: Specifies the plan files to process
l Axiom Queries: Specifies which Axiom queries to run in plan files (only applies to Normal

Processing)
l Utilities: Specifies which data source to use for utility processing (only applies to Process with

Utilities)
l Processing Variables: Defines variables to pass into plan files from Scheduler, and to Scheduler

from plan files

� Options tab
The following options are available on the Options tab:

Item Description

Processing Mode Select the type of processing to perform:
l Normal Processing: Plan files are opened, refreshed, and saved. You

can configure which actions occur.
l Process with Utilities: A list of utilities is iteratively processed per plan

file. Utilities are opened, refreshed with data for each plan code, and
saved. This is primarily intended for processing form-enabled plan files
with embedded forms.

l Update Persistent Plan Files: Update existing plan files for text,
formatting, or formula fixes. This is an advanced feature.

l Process with Custom Utility: Plan files are processed using a custom
utility provided by Axiom Support. This is an advanced feature.

The default processing mode is Normal Processing. However, if the file
group has been configured so that utility processing is the default
processing mode for that file group, then Process with Utilities is selected
by default.
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Item Description

Select File Group The file group for which plan files will be processed. You can select any file
group or file group alias, including file group scenarios (click Show
Scenarios in the Choose File Group dialog to show scenarios in the file
group list).

If the Scheduler job is stored in a file group Utilities folder, then you can
select Use Current File Group to automatically use the file group that the
Scheduler job belongs to. This is the recommended approach when the
Scheduler job belongs to a file group, so that it will automatically update to
point to the current file group when the file group is cloned.

NOTE: If the task uses an alias, then you cannot select individual plan files
on the Plan Files tab. Only theUse Filter and All options are available.

Advanced Options:
Worker Batch Size

Optional. Specifies the number of plan files to be processed in each batch.
The batch size must be a number between 10 and 100.

By default this is left blank, which means that the batch size is
automatically calculated based on the number of plan files to be processed
divided by the total number of threads on all enabled Scheduler servers.
Generally speaking, you should not customize this setting unless you are
advised to by Axiom Budgeting and Performance Reporting Support.

NOTE: Each batch of plan files is processed by a subordinate job. These
subordinate jobs are automatically created for the Process Plan Files task
and are processed in parallel, dependent on the number of Scheduler
threads that are available at any one time.

Options for Normal Processing mode
If Normal Processing is the selected processing mode, the following additional options are available on
the Options tab:
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Option Description

Save document
after processing

Specifies whether plan files are saved during processing. This option is selected
by default.

This option does not cause a save-to-database to be performed—that option
must be selected separately.

NOTES:
l If this option is not selected, then the utility will open the file as read-only

and will not attempt to acquire the document lock before processing.
l If the file group uses virtual plan files, this option does not apply because the

plan files cannot be saved. However, if the option is enabled, Axiom
Budgeting and Performance Reporting will attempt to acquire the document
lock before processing, which is not necessary. This option should not be
enabled when processing virtual plan files.

Run Save To
Database on
plan files after
processing

Specifies whether a save-to-database is performed in plan files during
processing. This option is selected by default.

This option does not cause the file itself to be saved—that option must be
selected separately. It is not required to save the file in order to perform a save-
to-database.

Create a plan file
restore point
before
processing

If selected, then a plan file restore point will be created before processing
begins. This option is not selected by default.

Restore points can be used to restore plan files to the state they were in before
changes weremade.

NOTE: If the file group uses virtual plan files, this option does not apply. Plan
files are not saved and therefore restore points are irrelevant.

Options for Process with Utilities
If Process with Utilities is the selected processing mode, there are no additional options on the Options
tab.

Plan files are not saved when using Process with Utilities, and plan file restore points are not created.
When using this mode, the processing is being performed in the utility files, not in the plan files, so it is
not necessary to save the plan files. Additionally, in most cases the plan files used with this mode are
virtual form-enabled plan files, so the save and restore options are irrelevant.

Options for Update Persistent Plan Files
IfUpdate Persistent Plan Files is the selected processing mode, the following additional option is
available on the Options tab:

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1119



Option Description

Report File Click the Browse button to select the report file that is configured with the
PlanFileReconfig_ControlSheet. This file must be saved in the Reports Library.

This control sheet contains the settings that will be applied to plan files during
processing.

Plan files are always saved when using this processing option, and plan file restore points are always
created before processing. A save-to-database is not performed in this mode, so if you need to save
data, you should process plan files using Normal Processing after you have verified the results of the plan
file update.

Options for Process with Custom Utility
If Process with Custom Utility is the selected processing mode, the following additional options are
available on the Options tab:

Item Description

Report File Click the Browse button to select theMicrosoft Excel spreadsheet file that
contains the VBA custom utility. The file must be saved in the Reports Library.

VBAModule Select the VBA module to run as part of this utility. The drop-down list shows
the VBA modules available in the selected file.

VBA Function Select the VBA function to run as part of this utility. The drop-down list shows
the VBA functions available in the selected module.

Plan files are always saved when using this processing option, and plan file restore points are always
created before processing. A save-to-database is not performed in this mode, so if you need to save
data, you should process plan files using Normal Processing after you have verified the results of the
custom utility processing.

� Plan Files tab
On the Plan Files tab, specify the plan files that you want to process. There are three different options
that you can use to specify the plan files: Choose from list, Use filter, and All. You should use the option
that corresponds to howmany plan files you want to process—all plan files, or a subset of plan files. If
you want to process a subset of plan files, you can select individual files to process or you can use a filter
to define the subset.
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NOTES:
l If a plan file is locked by another user when the task is executed, then processing for that file

will fail. Failures are noted in the result history for the job.

l If a plan file has not yet been created for a particular plan code, then that plan code will not
display in this list and will be ignored when processing. Scheduler does not support creating
plan files as part of the Process Plan Files task (you must use the separate Create Plan Files
task for this purpose).

l If the file group uses a Show on List column, then any plan code that is set to Falsewill not
display in the plan file list and will be ignored when processing.

Process all plan files
To process all plan files, select All. The list of all plan files is generated each time the Scheduler task is
executed, so that if new plan files have been added then those new plan files will be included in the
processing (the reverse is also true if any plan files have been removed).

Alternatively, you can select Choose from list and then select the check box in the column header,
causing all current plan codes to be selected. However, in this case the list of selected plan codes is fixed
and therefore will not automatically adjust for any future changes.

Process selected plan files
To process certain plan files, select Choose from list, and then select the check boxes for the plan files
that you want to process. When the Scheduler task is executed, Axiom Budgeting and Performance
Reporting will process only the selected plan files.

To find the plan files you are looking for, you can sort, filter, and group the list using standard Axiom grid
features. You can show additional columns and hide columns by right-clicking in the column header. If
you have filtered the list, you can select the check box in the header to select only the plan files that
currently display in the dialog.

NOTE: This option is not available if the file group for the task is an alias. This is because the list of
plan files could change when the alias target changes.

Process a filtered set of plan files
To use a filter to process a subset of plan files, select Use Filter. When the Scheduler task is executed,
Axiom Budgeting and Performance Reporting will process only the plan files that meet the filter.

You can use the Filter Wizard to create the filter, or you can manually type a filter criteria statement into
the filter box. The filter must use the plan code table or a lookup table. For example: DEPT.Region='US
West'where Dept is the plan code table.
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Once you have entered a filter, you can click Refresh plan file list to show the plan files that currently
match the filter. The refresh feature is intended to help you determine whether you have defined the
filter correctly.

You can also use a job variable for the filter. For example, you can define a job variable named "filter" and
then place the text {filter} in the filter box. This is intended for use when running Scheduler jobs via
RunEvent. If a variable value is specified when the event is triggered, such as the value
dept.region='west', then that filter statement will replace the {filter} variable and will be used to
determine the list of plan files to be processed.

NOTE: If you use a variable, and you leave the default value for that variable blank within the Job
Variables tab, then all plan codes will be processed if no value is passed by the RunEvent function.
You may want to define a default filter that results in no values (such as 1=0), so that plan files are
only processed if a valid filter value is passed.

� Axiom Queries
On the Axiom Queries tab, select the queries that you want to run in the plan files. By default, all listed
queries are selected. This tab only applies when using Normal Processingmode.

If you do not want to run a particular query, you can clear the check box. You can select or clear
individual check boxes, or you can use the check box in the header to select or clear all queries currently
displayed in the list. You can sort, filter, and group the list using standard Axiom grid functionality.

Example Axiom Queries tab

The list of Axiom queries is based on the source templates that were used to create the plan files. Only
Axiom queries that meet the following criteria are eligible for selection:

l Active is set to On, or the setting uses a formula.
l Refresh during document processing is set to On.
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If a query uses a formula for the Active setting, this means the query is dynamic and may or may not be
run, depending on how the formula resolves in each plan file to be processed. When a particular plan file
is processed, each selected query will be evaluated based on the current settings in that plan file. If both
Active and Refresh during document processing areOn for that plan file, then the query will be run. If
either or both settings areOff for that plan file, the query will not be run. You can tell whether a query is
dynamic or not by looking at theDynamic column in the query list.

If a query is not selected on this tab, then that query will not be run in any plan files during processing,
regardless of whether Active or Refresh during document processing are enabled in the plan file.

The plan file selection on the Plan Files tab affects the Axiom query list as follows:
l If you have selected individual plan files, then only the eligible queries for the source templates of

the selected plan files are shown.
l If you have selected All or Use Filter, then all eligible queries for all used templates are shown. If

the file group has templates that have not been used to create any plan files, then those
templates are not included in the list.

The listed queries are identified by template, worksheet, and query name. The following additional
properties are also listed for each query:

l Refresh On Open: Indicates whether the Axiom query is configured to refresh automatically when
the file is opened. This is for information purposes only, to help you determine whether the query
needs to be included in the processing. The Refresh on Open status is ignored by Process Plan
Files—if the query is selected it will be run along with the other selected queries, and if it is not
selected it will not be run.

l Dynamic: Indicates whether the query is dynamically enabled. Truemeans that the query uses a
formula for the Active setting.

NOTE: If a query is listed on this tab but it is grayed out and unavailable for selection, that means
that although the query is active (either directly or dynamically), the query is not eligible to be run
using Process Plan Files (because the setting Refresh during document processing is set to Off). This
query is listed for your information only, so that you understand the query cannot be run as part of
the process.

� Utilities tab
On theUtilities tab, select the ProcessPlanFileUtilities data source to use during processing. This data
source determines which utility files are processed and the processing order. This tab only applies when
using Process with Utilitiesmode.
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Example Utilities tab

For each template listed, use theUtilities Data Source field to select the data source to use for plan files
created from that template.

l If the template only has one data source, that data source is selected.
l If the template has multiple data sources, then the data sourcemarked as the default data source

is selected by default. If desired, you can use the drop-down list to select a different data source.

When plan files are processed, Axiom Budgeting and Performance Reporting reads the specified data
source in each plan file to determine the utilities to be processed for that plan file.

The plan file selection on the Plan Files tab affects the Utilities list as follows:
l If you have selected individual plan files, then only the templates used to create the selected plan

files are shown.
l If you have selected All or Use Filter, then all used templates are shown. If the file group has

templates that have not been used to create any plan files, then those templates are not included
in the list.

� Processing Variables
This tab can be used to define variables to pass into plan files before processing begins, and to pass
variables back to the Scheduler job after processing has been performed. This tab is optional and is only
used in special situations.

Pre-Processing Document Variables
This section can be used to pass document variables into plan files before processing. This can impact the
processing of plan files if the files are configured to use the variable values in someway.

For each pre-processing document variable, you can specify a variable name and a variable value. The
plan files must be set up with GetDocumentInfo functions that return the values for the specified
variables.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

Pre-Processing Workbook Variables
This section can be used to pass values into plan files before processing. This can impact the processing
of plan files if the files are configured to use the values in someway.

For each pre-processing variable, you can specify a workbook location to place the value, and the value
to be placed.

Item Description

Workbook
Location

The location in the workbook for the value to be placed. Any existing value in
this location will be overwritten for the duration of the processing. If the file is
saved as part of the processing, then the value will be saved in the file.

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Formula The value to be placed in the specified workbook location. The value can be a
"hard-coded" value, or a formula, or a job variable that will be resolved at time
of processing.

If the value is a formula, the formula is placed into the target cell and calculated
in the plan file. The formula can be any formula that would be valid within a
spreadsheet in the Axiom client. This includes using Excel functions and Axiom
functions. The formula can also use job variables, which will be resolved before
placing the formula in the target cell.
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The specified location and value will apply to all plan files being processed by the task. If you are going to
use pre-processing variables, the location should be predefined in the template and therefore available
to all plan files built using that template. If the plan files will be built using multiple templates, then all
templates should be set up with the same designated location, or you should set up separate processing
tasks based on template type.

Post-Processing Workbook Variables
This section can be used to pass a value from plan files back to the Scheduler job after processing has
been performed. This can impact the processing of subsequent tasks in the job if those tasks are
configured to use the value in someway.

For each post-processing variable, you can specify the location in the workbook to find the value, and
the job variable to use that value.

NOTE: If this task processes multiple plan files, the resulting variable value will be from the last file
that was processed.

Item Description

Workbook
Location

The location in the workbook to find the value to be passed to Scheduler. This
value will become the value for the assigned job variable for the duration of
executing the current job (unless a later process within the same job overwrites
the value for the same job variable).

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Job Variable The job variable that you want to use the value in the specified workbook
location. Do not enclose the variable name in curly brackets (you are not using
the variable here, you are simply referencing the variable name).

If the job variable does not already exist in the job (on the Job Variables tab),
then it will be created. However, in most cases you will want the variable to be
already set up with a default value, so that the job does not have validation
errors that prevent saving.

The specified location and job variable will apply to all plan files being processed by the task. If you are
going to use post-processing variables, the location should be predefined in the template and therefore
available to all plan files built using that template. If the plan files will be built using multiple templates,
then all templates should be set up with the same designated location, or you should set up separate
processing tasks based on template type.

Even though the task may process many plan files, only the job variable value from the last-processed
plan file will be used. The plan files must be set up so that all plan files result in the same value after
processing, or else your results will vary depending on which plan file was the last file to be processed.
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Process Document List task

This task processes a user-defined set of documents. The process operation always calculates the files. In
addition, you can opt to run Axiom queries in the files, process alerts in the files, and then perform a
save-to-database and/or save the files.

You can process any Axiom-managed Excel files by using this task. The primary intent of the task is to
process files such as driver files or report utilities. For example, you may be using Axiom queries and
GetData functions in your driver files that need to be updated regularly. Rather than opening, refreshing,
and saving each driver file, you can use this task to define the set of files and schedule processing.

NOTES:
l Generally speaking, plan files should not be processed using this task. Instead, the Process

Plan Files task should be used.

l This task does not perform file processing actions on the file. File processing can be set up for
report files and driver files, and can be used to perform actions such as file delivery, using
standard or multipass processing. If you want to perform file processing using Scheduler, use
the File Processing task.

� Documents to process
Specify the documents to be processed when the task is run. Documents are processed sequentially in
the order listed.

To add a document, click the Add button. In the Axiom Explorer dialog,
select the file or files that you want to add, and then click Open.

To remove a document, select the document in the list and then click the
Remove button. Only one document can be selected at a time.

To change the order of documents, select the file in the list and then click
the arrow buttons to move the file up or down.

Only Axiom-managed Excel files are valid to be processed in the task.

Selecting a document using a file group alias
You may want to specify the document to process using a file group alias, so that the task does not have
to bemanually updated after rolling over to a new file group for a new year of planning. When you are
selecting a document in the Axiom Explorer dialog, you can expand the file group alias to see all of the
files in the current target of the alias.

For example, in the following screenshot, the file group alias Current Budget is expanded. Because the
alias currently points to the file group Budget 2018, the folders and files under the alias are from Budget
2018. When you select a file or folder, you can see the real file path in the top of Axiom Explorer.
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Selecting a document to process using a file group alias

When you select a document underneath an alias, the file path is written using alias syntax, so that the
Scheduler task will look for the document within the current target of the alias. This path is visible in the
tooltip that displays when you hover your cursor over a selected document.

File path using file group alias syntax

When the file group alias is updated to point to a new file group, the Scheduler task will use the file in the
new file group automatically. If the file does not exist in the new file group, the task will fail with an error.

� Processing Options
By default, both options are selected. Axiom queries are refreshed before the save-to-database occurs.

If neither option is selected, then the files are calculated and then saved.
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Item Description

Perform all enabled
Axiom Queries in
selected workbooks

If this option is selected, then all eligible Axiom queries in all selected files
will be refreshed when the task is run. This option is selected by default.

Axiom queries are eligible for processing if they are active and use either of
the following refresh behaviors: Refresh on File Open and Refresh During
Document Processing.

Enable iterative
calculation while
processing

Specifies whether iterative calculations are enabled for the file during
processing. In most cases you will leave this option disabled.

If this option is selected, then iterative calculations are enabled for the file
during the Axiom query refresh process. The iterative calculation settings
are fixed at a maximum of 100 iterations and a maximum change value of
.001.

For more information on iterative calculations, see theMicrosoft Excel
Help.

Save document after
processing

If selected, then files will be saved after processing. This option is selected
by default. The user executing the task must have Read/Write access to
the files.

This option does not cause a save-to-database to be performed—that
option must be selected separately.

NOTE: If this option is not selected, then the utility will open the file as
read-only and will not attempt to acquire the document lock before
processing.

Run Save To Database
on plan files after
processing

If selected, then a save-to-database will be performed after processing.
This option is selected by default. The user executing the task must have
the Allow Save Data permission to the files.

This option does not cause the file itself to be saved—that option must be
selected separately. It is not required to save the file in order to perform a
save-to-database.

Process alerts in
selected workbooks

If selected, then alerts in the file will be processed. The file must contain an
Alert Control Sheet and one or more alerts must be defined in the file.

If Axiom queries are enabled for processing as well, the queries will be run
before alerts are processed.

� Pre-Processing Document Variables
This section can be used to pass document variables into the target files before processing. This can
impact processing if the files are configured to use the variable values in someway, such as to filter an
Axiom query.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1129



For each pre-processing document variable, you can specify a variable name and a variable value. The
target file must be set up with GetDocumentInfo functions that return the values for the specified
variables.

To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

The following example screenshot defines the value for the document variable Dept. The value is defined
using the value of a Scheduler job variable {Dept}. A value for Dept can be passed into the Scheduler
job when the job is started, and then passed into the target file using the document variable.

� Pre-Processing Workbook Variables
This section can be used to pass values into the file before processing. This can impact processing if the
files are configured to use the values in someway. For each pre-processing variable, you can specify a
workbook location to place the value, and the value to be placed.

NOTE: The specified value will be placed in all files listed to process. Therefore, unless all files are set
up to use the same location and the sameway of deriving the value, you will need to create a
separate Process Document List task for each file. If you are not using pre-processing variables, then
this does not matter.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To change the order of variables, select the variable in the list and then click the
arrow buttons to move the variable up or down.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Workbook
Location

The location in the workbook for the value to be placed. Any existing value in
this location will be overwritten for the duration of the processing. If the file is
saved as part of the processing, the value will be saved in the file.

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Formula The value to be placed in the specified workbook location. The value can be a
"hard-coded" value, or a formula, or a job variable that will be resolved at time
of processing.

If the value is a formula, the formula is placed into the target cell and calculated
in the target file. The formula can be any formula that would be valid within a
spreadsheet in the Axiom client. This includes using Excel functions and Axiom
functions. The formula can also use job variables, which will be resolved before
placing the formula in the target cell.

� Post-Processing Workbook Variables
This section can be used to pass a value from the file back to Scheduler after processing has been
performed. This can impact the processing of subsequent tasks in the job if those tasks are configured to
use the value in someway. For each post-processing variable, you can specify the location in the
workbook to find the value, and the job variable to use that value.

NOTES:
l If this task processes multiple documents, the resulting variable value will be from the last

document processed.

l If the task is run as a sub-job, then the post-processing variable is not passed back to the
"parent" job. The task must be executed as a regular task within the job in order to pass the
variable value back to the job.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To change the order of variables, select the variable in the list and then click the
arrow buttons to move the variable up or down.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Workbook
Location

The location in the workbook to find the value to be passed to Scheduler. This
value will become the value for the assigned job variable for the duration of
executing the current job (unless a later process within the same job overwrites
the value for the same job variable).

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Job Variable The job variable that you want to use the value in the specified workbook
location. Do not enclose the variable name in curly brackets (you are not using
the variable here, you are simply referencing the variable name).

If the job variable does not already exist in the job (on the Job Variables tab),
then it will be created when the job is executed. However, in most cases you will
want the variable to be already set up with a default value, so that the job does
not have validation errors that prevent saving.

Process Template List task

This task processes a user-defined list of file group templates. During processing, any Axiom queries with
Refresh during template processing enabled are executed and time-stamped, and then the template
files are saved.

The primary purpose of this task is to enable use of time-stamped Axiom queries with virtual plan files.
Because virtual plan files are re-created from template each time they are accessed, Axiom queries
cannot be time-stamped within the plan files. Virtual plan files can use the time stamp from the template,
but under normal circumstances, Axiom queries are not time-stamped when they are run in templates.
However, when Axiom queries are run during template processing, the Last refresh time for the query is
updated, which means that the queries can be configured to only run if the primary table has changed.

To use this task to enable time-stamped Axiom queries for virtual plan files, do the following:
l In the template, enable Refresh only if primary table changed since last refresh and Refresh

during template processing for the Axiom queries that you want to be time-stamped.
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l In Scheduler, create a job with a Process Template List task and add the template to the task.
Define a scheduling rule for the job as appropriate. For example, you might want the template to
be processed nightly.

When the template is processed, the designated Axiom queries will be run if the primary table has
changed, and the time stamps are updated. When a virtual plan file that uses this template is opened,
the queries will not be run again if the primary table has not changed.

This task should only be used to process Axiom queries that meet the requirements of time-stamped
queries.

� Templates to process
Specify the templates to be processed when the task is run. Templates are processed sequentially in the
order listed. If you havemultiple templates to process (in the same or different file groups), you can run
them all in the same task.

To add a template, click the Add button. In the Axiom Explorer dialog,
select the file or files that you want to add, and then click Open.

To remove a template, select the file in the list and then click the Remove
button. Only one file can be selected at a time.

To change the order of templates, select the file in the list and then click the
arrow buttons to move the file up or down.

Normal template behavior rules apply during processing. For example, save-to-database and action
codes are not run in templates. The only exception to normal template behavior during this task is that
any executed Axiom queries will be time stamped.

Selecting a template using a file group alias
You may want to specify the template to process using a file group alias, so that the task does not have
to bemanually updated after rolling over to a new file group for a new year of planning. When you are
selecting a template in the Axiom Explorer dialog, you can expand the file group alias node to see all of
the files in the current target of the alias.

For example, in the following screenshot, the file group alias Current Budget is expanded. Because the
alias currently points to the file group Budget 2018, the folders and files under the alias are from Budget
2018. When you select a file or folder, you can see the real file path in the top of Axiom Explorer.
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Selecting a template to process using a file group alias

When you select a template underneath an alias, the file path is written using alias syntax, so that the
Scheduler task will look for the template within the current target of the alias. This path is visible in the
tooltip that displays when you hover your cursor over a selected template.

File path using file group alias syntax

When the file group alias is updated to point to a new file group, the Scheduler task will use the file in the
new file group automatically. If the file does not exist in the new file group, the task will fail with an error.

Purge System Data task

The Purge System Data task is intended to clean up old data in your system, to help keep your system
running efficiently.

NOTE: Scheduler automatically creates a system job for this task (System.SystemDataPurge), which
administrators can edit as needed.
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This task purges the following data when it is run:
l Scheduler job result history
l Scheduler and system email notifications
l System temp table data
l Audit history
l Alerts

For each category of data, you can specify a number of days of data to keep when the task is run. All
results older than the specified number of days will be deleted. Note that 0 days means that no data is
purged for that category.

Section Item Description

Scheduler
Results

Number of days to keep
result history

The number of days of job result history to keep
when the task is run. By default, this is set to 15
days.

SMTP Messages Number of days to keep
delivered messages and
attachment data

The number of days of delivered message data
to keep when the task is run. By default, this is
set to 15 days.

Temporary
Tables

Number of days to keep
temp table data

The number of days of temp table data to keep
when the task is run. By default, this is set to 15
days.

Audit History Number of days to keep
system history

The number of days of system audit history to
keep when the task is run. By default, this is set
to 15 days.

"System history" encompasses all audit data—
including prior document versions and deleted
documents—except table audit data.

Table History Number of days to keep
table history

The number of days of table audit history to
keep when the task is run. By default, this is set
to 15 days.

Table audit data is tracked for tables where
Audited is set to True.

Alerts Number of days to keep
alerts

The number of days of alerts to keep when the
task is run. By default, this is set to 60 days.

Job variables can be used in all of these settings.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1135



Each purge routine in the task is limited to purging a specific number of rows at a time (50000). If the
number of rows to be purged exceeds this limit, then the excess data is retained until the next time the
task is run. If you notice data in the database that you expected to be purged, most likely the amount of
data to be purged exceeded the limit, and the data will be purged next time the task is run.

� Other purged data
This task also cleans up the following items in your system:

l Deleted columns. When a column is deleted from a table in Axiom Budgeting and Performance
Reporting, the column is immediately deleted from the associated view (which prevents it from
being accessed in the system), but it remains in the base table. This task finishes the process of
removing obsolete columns from the base tables.

l Orphaned user folders. If the system contains any user folders that do not match up with existing
users, these folders are deleted. Although user folders are deleted when a user is deleted from
security, orphaned user folders can result from other processes, such as migrating a system
between different management databases.

These items are not associated with any specific task settings; the delete process is performed whenever
the task is executed.

Raise Event task

The Raise Event task can be used to trigger other Scheduler jobs for execution, using a named event
handler. This task has one required setting:

Item Description

Event Name Enter the name of the event that you want to raise for execution. This name
must match a defined event handler name in one or more other Scheduler jobs.

When this task is run, it looks for any jobs that contain the specified event
handler name. These jobs are added to the schedule and are eligible to be
processed immediately, depending on Scheduler thread availability and any
other higher-priority jobs already in the queue.

NOTE: It is not possible to specify a file group context for the event handler
when using Raise Event. Axiom Budgeting and Performance Reporting will run
all jobs that contain the specified event handler name, regardless of whether
the event handler is associated with a file group.

Event Variables
This section can be used to pass variables into the jobs triggered by the event handler. If the jobs are
configured to use the variables, these values can impact how the jobs are processed.
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To add a variable, click the Add button to add a row to the list. Complete
the settings for the variable as described below.

To remove a variable, select the variable in the list and then click the
Remove button. Only one variable can be selected at a time.

For each variable, you can specify a variable name and a variable value. To edit the variable settings,
double-click the applicable cell to make the cell contents editable. When you are finished editing, you can
press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

Run Excel Macro task

This task runs an Excel macro on an Axiom file.

NOTE: This task is no longer supported because it requires Excel processing on the Scheduler server.
It is still available on the task list, but cannot be executed.

Please contact Axiom Budgeting and Performance Reporting support if you need assistance with this
task.

Item Description

Workbook Path The path and name of the file to run themacro on.

You can click the Browse button to navigate to the file.

Macro Name The name of themacro to run.

Macro
Arguments

If themacro takes arguments, you can enter the argument values here.

Click Add to add an argument, Remove to delete the selected argument, or
Clear to clear all arguments.

Job variables can be used in all of these settings.
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Run Scheduler Job task

This task runs a specified Scheduler job as a subordinate job within the current job. The job containing
the Run Scheduler job task is the parent job, and the target job for the task is the child job.

By default, the parent job waits until the child job is complete before continuing to the next task in the
parent job. This means that tasks after the Run Scheduler Job task can be reference the results of the
child job. For example, the child job may perform a save-to-database. The subsequent tasks in the
parent job can access the data saved by the child job.

� Task Control options
When you create the Run Scheduler Job task, the options in the Task Control section are pre-set as
follows:

l The option Create a Subordinate Job for this Task is grayed out. This is because the target job is
always run as a subordinate job.

l The optionWait for all Subordinate Jobs to complete before proceeding to the next Task is
enabled by default. This means that tasks after the Run Scheduler Job task can be dependent on
the target job and reference the results of that job. If you disable this option, then the parent job
will continue to the next task in the job immediately after creating the subordinate job—it will not
wait for the subordinate job to complete.

Keep in mind that it is not possible to stop processing tasks in the parent job based on the success or
failure of the child job. Although Scheduler jobs automatically stop processing if a task fails, the task in
this case is just the Run Scheduler Job task. As long as the child job can be successfully added to the
Scheduler queue for processing, the Run Scheduler Job task will report success. The ultimate success or
failure of that child job is not reported back to the parent job—the parent job only knows when the child
job is started and then stopped.

If needed, you can use the option Process task only if the value of this expression is true to detect
whether a subsequent task in the parent job should be processed. For example, if you know that the
child job saves a particular value to the database, you can check for the existence of that value to
determine whether to process the task. For more information on using this option, see Conditionally
processing tasks in a job.

� Target Scheduler job
In the Task Details section, use the Browse button to select the target Scheduler Job. You can select any
job that you have access to in the Scheduled Jobs Library.

When the Run Scheduler Job task is executed, it creates one or more subordinate jobs as needed to
execute the tasks in the target Scheduler job. As long asWait for all Subordinate Jobs to complete
before proceeding to the next Task remains enabled in the Task Control options, the parent job waits
for all subordinate jobs to be completed beforemoving on to the next task in the parent job.
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NOTE: The user executing the job does not need to have security access to the target Scheduler job
for Run Scheduler Job. It is assumed that if the user can execute the parent job, the user should be
able to execute the target job.

� Child Job Values
If the target job for the Run Scheduler Job task has defined job variables, those variables and their
default values are listed in this section. The default values are determined as follows:

l If the parent job and the child job have a variable with the same name, the default value is the
value defined in the parent job. This value will be passed to the child job and used when the child
job is run.

l Otherwise, the default value is the value defined in the child job.

To override a variable value, select theOverride check box and then click inside theOverride Value field
to enter a value. You can enter a hard-coded value or use a job variable from the parent job. Enter the
variable name in curly brackets to use that variable's value as the override value.

For example, imagine that both the parent job and the child job have a variable of {Dept}. In the parent
job, the value of {Dept} is set to 20000, and in the child job the value is set to 40000. The Run Scheduler
Job task will display the parent value of 20000 as the default value, and that value will be used when the
child job is executed.

Now imagine that the parent job has a variable of {StartDept} set to 20000, and the child job has a
variable of {Dept} set to 40000. In this case, the Run Scheduler Job task will display the value of {Dept}
as defined in the child job (40000). If you want to use the parent job value for {StartDept} instead,
then you must select the Override check box and enter {StartDept} as the Override Value. Now the
value of {Dept} in the child job will be overridden and set to 20000.

SMTP Message Delivery task

This task delivers email notifications for Scheduler jobs.

NOTE: Scheduler automatically creates a system job for this task (System.SMTPMessageDelivery),
which administrators can edit as needed.

Item Description

Server name The server name of the SMTP email server.

Port number The port number for the SMTP email server. By default, the port is 587, but you
can specify a different port number if needed.

Server requires
authentication

Select this check box if the SMTP email server requires authentication.

If selected, type a Username and Password.
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Item Description

Test Mode Specifies whether the task is run in test mode. If this check box is selected, the
task verifies that it can successfully connect to the SMTP server to send email
notifications, but no emails are actually sent.

For the System.SMTPMessageDelivery job, new systems are automatically set
to test mode. If you restore a database, the restore process also sets the
system job to test mode. You must disable test mode before any emails will be
sent.

Start Process task

This task starts a process for Process Management. You can use this task to automatically start a process
at a specific point in time, including recurring schedules (such as to automatically start a monthly
process).

This task can be used to start a generic process definition or a plan file process definition.

Item Description

Process to start The process definition to start. Click the Browse button to select the process
definition file. You can select any process definition that you have access to
within the Process Definition Library or within a file group Process Definitions
folder.

If the Scheduler job is stored in a file group Utilities folder, then you can
optionally navigate to the process definition file through the Current File Group
node at the top of the file groups list. When you do this, the path to the file is
stored relative to the current file group, which means that it will automatically
update when the file group is cloned. This is the recommended method of
referencing the process definition file when the Scheduler job belongs to a file
group.
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Item Description

Restart process if
it is already
running

Specifies whether the Scheduler task will restart the process if it is already
running, or if the process will be left as is.
l Select this option if you want to start the target process regardless of

whether it is already running. The current process instance will be aborted
and a new process instance will start over at step 1. This option is selected by
default.

l Clear this option if you want to leave the existing process instance running.
In this case, the Scheduler task will take no action if the target process is
already running.

Scheduler tasks for database maintenance

Scheduler provides several built-in tasks that are intended for databasemaintenance. By default, these
tasks are included in the System.IndexMaintenance job, which runs regularly to maintain your database.
However, these tasks can also be added manually to jobs as needed to perform additional database
maintenance.

The following databasemaintenance tasks are available:
l Rebuild Database Indexes task
l Update Database Statistics task
l Update Indexes and Constraints task

All of these tasks are predefined versions of the Execute SQL Command task. You can use the Source
Axiom Database field to specify whether the task is executed against the system database or the audit
database.

For the SQL Command Text, the actual SQL code used by each task is generated automatically by Axiom
Budgeting and Performance Reporting when the task is executed. This ensures that the tasks always use
themost current SQL code for each task as defined by Axiom Budgeting and Performance Reporting.

Web Scheduler
Although most Scheduler setup activities can only be performed in the Desktop Client, some job
management can be performed in theWeb Client. Using the "Web Scheduler", you can monitor and
manage the job schedule, review job results, and process existing jobs on demand.

To access Scheduler in the Web Client:

1. In theWeb Client, click themenu icon in the Global Navigation Bar. From the Area menu,
select System Administration.
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2. From the Navigation panel, select Tools > Scheduler.

Alternatively, you can go directly to the Scheduler page as follows:

Example Cloud
URL

https://ClientName.axiom.cloud/Jobs

Where ClientName is the name of your Axiom Cloud system.

Example On-
Premise URL

http://ServerName/Axiom/Jobs

Where ServerName is the name of the Axiom Application Server, and Axiom is
the default name of the virtual directory.
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When you access the Scheduler area, a Scheduler panel becomes available in the left side of the Task Bar.
You can use this panel to change the current Scheduler view.

Example Scheduler area in Web Client

Managing the job schedule in the Web Client

In the Scheduler area of theWeb Client, you can view the status of all jobs that are currently on the
schedule. If necessary, you can view the job details, remove the job from the schedule, or run the job
now.

To view the current job schedule:
l On the Scheduler page, from the Scheduler panel, select Scheduled Jobs.

The Scheduled Jobs grid displays all jobs that are scheduled to be processed, or are currently in process.
This includes scheduled jobs, jobs executed manually via Run Now, and jobs that were triggered for
execution via an event handler.
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Example Scheduled Jobs grid

You can use the Actions column in the right side of the grid to perform any of the following actions on a
job:

View the job properties and results.

Remove the job from the schedule.

IMPORTANT: If the job is on the schedule due to a scheduling rule, this
action disables the scheduling rule and removes all future executions from
the schedule as well. If you want future scheduled instances of the job to
proceed, you must edit the job to re-enable the scheduling rule.

Run the job now.

This action places the job on the schedule for immediate execution (if
another manual instance of the job is not already pending). The future
scheduled instance of the job remains on the schedule.

To refresh the list, click the Refresh icon in the Task Bar.

For each job on the schedule, you can view the following information:

Item Description

Job The name of the job.

User The user identity that the job will be run as. If the job is a system job, the user is
System.

This is typically the name of the user who placed the job on the schedule, but not
always (for example, when using an event handler that is set to run as the job owner
instead of as the requester).
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Item Description

Status Job status is either Pending (waiting to be executed) orWorking (currently being
executed).

Server If a job is currentlyWorking, then the server executing the job is listed here.
Otherwise, this column is blank.

Priority The priority category for the job:

1. Manual: The job was executed manually.

2. Event Handler: The job was executed by a Scheduler event handler.

3. Scheduled Job: The scheduled instance of the job results from an active
scheduling rule.

4. Subordinate Job: The job was generated as a subordinate job, from a
currently executing job.

The priority category determines how jobs are evaluated for processing order, in
conjunction with the job's Priority Elevation setting. Manual jobs are highest
priority, and subordinate jobs are lowest priority. For more information, see
Processing priority for scheduled jobs.

Start Time The start time of the job. The job is eligible for immediate execution if the start time is
now or passed. Jobs may not be executed right at the start time if no Scheduler
threads are currently available to execute the job, or if other eligible jobs have higher
priority.

If the job is on the schedule due to a scheduling rule, the start time is based on the
scheduling rule. If the job was manually executed via Run Now or triggered by an
event handler, the start time is the time the execution was initiated.

Due In The length of time until the job is due to be processed. For example, if the job is
scheduled to run at noon and it is currently 11:50 AM, then the job is due to be run in
10minutes.

This column is intended to make it easy to see when a job will be run, without
needing to calculate it based on the start time.

NOTE: If a job has a scheduling rule with a recurring schedule, only the first scheduled execution
appears in the Scheduled Jobs list. For example, if you have a job that is scheduled to run once a
month for a year, you will not see all twelve scheduled executions in the list—you will only see the
first scheduled execution. Once that instance has been run, the scheduling rule is re-evaluated and
the next scheduled execution appears in the list.
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Viewing job results in the Web Client

In the Scheduler area of theWeb Client, you can view the results of jobs that have been executed. For
each job, you can see when it was run, and whether it completed successfully or had errors.

To view job results:
l On the Scheduler page, from the Scheduler panel, select Job Results.

The Job Results grid shows a list of jobs that have been recently executed. The grid shows the following
summary information:

l The name of the job, and the ID of the particular execution of that job
l The user identity the job was run as
l The status of the job, such as Success or Failure
l The Scheduler server that ran the job
l The start time and duration of the job

To refresh the list, click the Refresh icon in the Task Bar.
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Example Job Results grid

To view detailed results for a particular job execution, hover your cursor over the job and then click the
View icon in the far right column. This opens the job properties to the Job Results section, with the
corresponding execution ID expanded. You can further expand the job results to see the specific tasks
that were executed.

Example Job Results detail showing tasks executed

To view the detailed task results, hover your cursor over the task and then click the View icon in the
far right column. This opens a dialog to display the results for that task. For example, for a file processing
task, the detailed results would contain information such as the processing type and the number of
passes, and the output that was created at the end of the process.
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Once you are viewing the Job Results section of the job properties, you can review all of the available job
history as needed. Expand any execution ID to view the details for that particular execution.

TIP: You can also view job results by opening a job and viewing the job properties, which include the
job results. In some cases it may be easier to open the job and review all of its results rather than
trying to find the job within the overall job results. For more information, see Viewing jobs and event
handlers in theWeb Client.

NOTE: Users with the Scheduled Jobs User security permission can only see job results for jobs that
they executed. Administrators can see job results for all jobs.

� System job results
By default, system job results are hidden in the Job Results grid. System jobs such as the SMTP message
delivery job may run frequently, and can easily fill up the result history, making it difficult to find results
for user-initiated jobs.

If you want to view results for system jobs, you can do one of the following:
l Clear theHide system jobs check box above the Job Results grid. The list immediately updates to

include system jobs.
l Open the system job directly, and view its job results within the job. For example, you can go to

the Scheduled Jobs page and double-click the System.SystemDataPurge job to view all results for
that job.

� Job result availability
Job results are purged periodically to help optimize system performance. The availability of job results in
your system depends on the configuration of the system job System.PurgeSystemData. This system job
runs periodically to purge old data in your system, including old job results. By default, when this job is
run, it purges job history older than 15 days.

The configuration of this system job can only be viewed and edited in the Desktop Client, and only by
administrators. For more information, see Configuring Scheduler system jobs.

Additionally, individual jobs can be configured to purge old results when the job is run. In theWeb
Client, you can view the job properties to see if this option is enabled, but you cannot edit the job
properties. The option is displayed in theGeneral section of the job, under Job Results Cleanup. For
more information on viewing job properties, see Viewing jobs and event handlers in theWeb Client.

Running a job manually in the Web Client

In the Scheduler area of theWeb Client, you can run a job manually as needed.
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When using this approach, the job is run now. It is not possible to run a job manually and specify a
future execution time. If you want to schedule a job for future execution, you must define a scheduling
rule on the job, which can only be done in the Desktop Client. For more information, see Defining
scheduling rules for a job.

To run a Scheduler job manually:
1. On the Scheduler page, from the Scheduler panel, select Job Explorer.

2. In the Job Explorer page, locate the job that you want to run. This page lists all jobs in the
Scheduler Jobs Library that you have permission to access.

3. Hover your cursor over the job, then click the Run Once icon in the far right column.

The job is added to the schedule with a start time of now, and is eligible for immediate execution
(pending available Scheduler threads and any higher-priority jobs already in the queue). You are
automatically taken to the Scheduled Jobs area of Scheduler, so that you can see the job on the
schedule.

Running a job manually does not impact any scheduled executions of the job as determined by
scheduling rules. For example, if a job is scheduled to be run at 10:00 PM tonight, and you run the job
manually at 2:00 PM, the job will still be run as scheduled at 10:00 PM.

Viewing jobs and event handlers in the Web Client

In the Scheduler area of theWeb Client, you can view Scheduler jobs and event handlers.

� Viewing jobs
You can view any job in the Scheduler Jobs Library that you have permission to access.
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Scheduler jobs are read-only in theWeb Client. You can view the job properties to better understand the
purpose of a particular job and the tasks that it performs. TheWeb Client does not support creating new
jobs, editing existing jobs, or deleting jobs. If you need to perform any of those actions, you must use
the Desktop Client. For more information, see Scheduler Overview.

To view a Scheduler job:
1. On the Scheduler page, from the Scheduler panel, select Job Explorer.

2. In the Job Explorer page, locate the job that you want to view. This page lists all jobs in the
Scheduler Jobs Library that you have permission to access.

3. Hover your cursor over the job, then click the View icon in the far right column.

The job opens, and the Scheduler panel updates to show the viewable sections of the job. You can
switch between sections by selecting section names in the Scheduler panel. By default, theGeneral
section is shown.
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Example job properties

All job properties are defined in the Desktop Client. The following is a brief overview of the job properties
shown in theWeb Client.

Section Description More Information

General General job properties that impact the job's
processing priority and processing behavior.

Job properties

Variables Variables used by the job.
l If the job has defined variables, those variables

display in the Job Variables section at the top of
the page. Most likely, the tasks in the job are
configured to use these variables. This typically
means that the job is designed to be run using an
event handler, and the necessary variable values
will be passed to the job when it is triggered.

l The System Variables section displays the job's
values for various system-defined variables. This
section can help you understand who the owner
of the job is, and how other system variables will
resolve for the job.

Using job variables
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Section Description More Information

Scheduling Rules Scheduling rules to schedule jobs for future
execution. If the job has an active scheduling rule, the
job will be executed according to the rule (one time or
recurring, depending on how the rule is configured).
l Day of Week, Hours, andMinutes specify when

the job will be executed within the start / end
range of the rule. An asterisk in any of these fields
means "all"—for example, if Hours is set to * then
the job is run every hour.

l Starting On and Ending On determine the start /
end range of the rule. If they are blank, then the
rule has no start or end date.

Defining scheduling
rules for a job

Event Handlers If the job is designed to be run using an event
handler, the event handler name is listed here. The
Execute As property determines whether the job is
run as the requester or the job owner when it is
triggered for execution.

Viewing event
handlers

Notifications Notification settings for the job. The job can be
configured to send email notifications when the job
completes, or only when the job has errors. Variables
can be used to determine the notification recipients.

Setting up email
notification for jobs

Tasks Tasks to be executed by the job, listed by name and
task type. No other task properties are available in
theWeb Client. If you want to seemore information
about the task, you must view the job in the Desktop
Client.

Scheduler Task
Reference

Results Detailed results of the previous job executions.
Results are organized by execution ID and displayed
in execution order (themost recent listed first).

Viewing job results in
theWeb Client

� Viewing event handlers
You can view the event handlers that are defined in the system. Event handlers are used to trigger
Scheduler jobs based on an event.

For example, an Axiom form can have a Button component that is configured with the RunEvent
command. When a user clicks the button, the specified event name is passed to Scheduler, and any jobs
associated with that event are triggered to run. Variable values can also be passed from the form to the
Scheduler job as part of this process.
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Event handlers are read-only in theWeb Client. If you need to create, edit, or delete an event handler,
this can only be done in the Desktop Client. For more information, seeManaging event handlers.

To view Scheduler event handlers:
l On the Scheduler page, from the Scheduler panel, select Event Handlers.

The Event Handlers grid lists all of the event handlers as follows:
l Event Name: Name of the event handler. This is the name used in features such as RunEvent to

trigger execution of a Scheduler job.

l Job: Name of the job where the event name is used. When the event is raised by a feature such as
RunEvent, this job will be executed.

l User: The user identity that will be used to execute jobs triggered by the event handler. If the
event handler is configured to run as the requester, then Requester is listed here. If the event
handler is configured to run as the owner, then the owner name is listed here (either a specific
user name, or System).

Security
All users of Axiom Budgeting and Performance Reporting must be defined within Security. Within
Security, you can:

l Manage users and roles
l Control user access by file group
l Control user access to data in the database
l Control user access to specific features
l Control user access to data imports
l Control user access to files and folders
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l Specify files to open on system startup

Security Overview
Using Axiom Budgeting and Performance Reporting Security, you can create users and roles, and assign
access rights. This section explains how security is applied in Axiom Budgeting and Performance
Reporting.

Users can be created manually within Axiom Budgeting and Performance Reporting, or you can import
them from Active Directory. Once a user account is created, you must define the permissions for that
user, at the user level or at the role level (or both). The security permissions determine which files,
features, and data that the user can access within the Axiom Budgeting and Performance Reporting
system.

The following users can access and manage security:
l Users designated as a system Administrator. Administrator users have full rights to all areas of the

system, including security.

l Users who are granted the Administer Security permission. Administer Security users have full
rights to security, except for a few features which are limited to administrators-only.

l Users who are assigned as a Subsystem Admin for a subsystem. Subsystem administrators can
manage users and roles within the subsystem.

� Users and roles
To streamline security settings, you can define a number of roles, and then assign users to those roles.
Users inherit the security settings defined for their assigned roles. Additionally, Axiom Budgeting and
Performance Reporting provides a built-in Everyone role, for security settings that apply to all users.

Systems with installed products may also have roles that are designed for use with the product. These
roles are product-controlled and delivered with the product. For example, a system with the Capital
Planning product may have roles for Capital Planning Admin and Capital Planning User. You can assign
users to these roles based on the level of permissions they need to the product.

The specific way that security settings are inherited depends on the type of setting. Generally, roles grant
permissions, they do not deny permissions. For more information, see How role settings are applied to
users.

� Authentication behavior
There are several options to authenticate users into Axiom Budgeting and Performance Reporting. The
basic authentication type is Axiom Prompt authentication, which means that users will be prompted for
an Axiom user name and password each time they want to access Axiom Budgeting and Performance
Reporting.
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If desired you can use an integrated authentication option instead, which means that users are
authenticated based on certain supported external credentials—such as the user's Windows domain
credentials or LDAP credentials. These options are typically enabled and configured during the
installation of Axiom Budgeting and Performance Reporting. For more information, see Axiom Budgeting
and Performance Reporting can integrate with your organization's existing network security. You can:.

� Security subsystems
If desired, you can create security subsystems and assign users to subsystems. Subsystems allow you to:

l Define a maximum level of permissions for a subset of users. Any user that is assigned to the
subsystem cannot be granted rights that exceed the subsystem rights.

l Assign a user as a subsystem administrator, so that the user can manage security permissions for
the users and roles that belong to the subsystem.

In systems with installed products, subsystems are used to control access to specific products. These
subsystems are product-controlled and delivered with the product. For example, you may have
subsystems for Capital Planning and Budget Planning. You can assign users to subsystems based on the
specific products they should be able to access.

For more information, see Security Subsystems.

The Security Management dialog
All security settings for Axiom Budgeting and Performance Reporting are controlled in the Security
Management dialog. To access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

Only users with the following permissions can access the Security Management dialog:
l System administrators
l Users with the Administer Security permission
l Users assigned as a subsystem administrator

� Viewing users, roles, and subsystems
Users, roles, and subsystems are listed in the left-hand side of the dialog. To switch between items, select
one of the radio buttons at the top of the dialog. By default, users are displayed.
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l You can sort the user list by last name, first name, and login name. To change the sort, select the
desired option from the Sort By list. By default, the list is sorted by last name.

l To search for a particular user, role, or subsystem, type the name into the search box at the top of
the list. To clear the search, click the Clear filter icon to the right of the search box. Note that
this will search the user's login name as well as first and last name.

l To show or hide users by their enabled status, use the Enabled and Disabled check boxes. By
default, both check boxes are selected which means that all users are shown (enabled and
disabled).

When a user, role, or subsystem is selected in the list, the settings for that item display in the right-hand
side of the dialog, organized by tabs.

TIP: You can double-click on any user, role, or subsystem name listed in the Assigned Users /
Assigned Roles / Assigned Subsystems sections to open that record.

NOTE: Subsystems are optional in systems without installed products. Subsystem features are only
available if you have enabled them using the system configuration settings.
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� Editing security
Changes made in the Security Management dialog are reflected in "real-time" within the dialog. If a
required setting is missing, a validation message appears in the bottom left of the dialog. You can click on
themessage to be taken to the applicable setting. This issuemust be resolved before you can save any
changes.

At any time you can save changes by clicking Apply (to leave the dialog open) orOK (to close the dialog).
In most cases, changed security permissions will be effective within seconds of being saved; the user
does not need to log out and log back in before changes are applied.

� Effective permissions
Several tabs of the Security Management dialog, such as the File Groups tab and the Tables tab, display
the effective permissions for the user. This is the permission that the user has after applying all of the
relevant security settings, including inherited role permissions, subsystem restrictions, and
administrator permissions. This allows you to understand exactly what permission the user has.

For example, if you select a table type or a table in the Tables tab, the Configured Permissions section
displays what permissions have been granted at the user level, and the Effective Permissions section
displays the actual access rights of the user. In the following example screenshot, although the user
herself has no configured access to the table type, her effective permission is full access. This means that
either the user is assigned to a role with full access to the table type, or the user has been granted
administrator rights. You can see exactly which rights contribute to the effective permissions by clicking
the Show Details link.
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Example effective permissions

As edits aremade in the dialog, those changes are reflected in the effective permissions immediately. For
example, if you grant a user permission to Administer Imports, and then switch to the Files tab, the
effective permissions for the Imports Library will reflect that the user has full permissions to all imports,
even though the change has not yet been saved.

Managing Users and Roles
All users of Axiom Budgeting and Performance Reporting must be defined within security. Users can be
assigned access rights on an individual basis, and/or they can be assigned to specific roles and inherit the
rights of the role.

The total number of active users that can be defined for your implementation depends on your license
agreement with Syntellis. If you have any questions, please contact Axiom Support for assistance.

The total number of available licenses and currently active users are displayed in the upper right-hand
corner of the Security Management dialog. This area also displays the total number of users who have
been granted administrator rights. For example: 20 of 25 licenses in use, 3 admins.
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NOTE: In addition to the Security Management dialog, you can also manage users and roles in bulk
via a spreadsheet interface. For more information, see Bulk edit of security.

Managing users

Using the Security Management dialog, you can create new users, edit existing users, and delete users.
To access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

To work with users, make sure that Users is selected in the top left-hand corner of the dialog. To save
changes, click Apply (orOK if you are finished editing security settings).

NOTE: Subsystem administrators can only work with users that belong to their assigned subsystem.
The user list is filtered to only show these users.

� Creating users
You can create a new blank user, or you can clone the settings of an existing user. If you clone a user, all
of that user's settings are copied to the new user, except for unique personal information (name, email,
login, password).

To create a user, click one of the following buttons located underneath the user list:
l To create a new blank user, click Create user .
l To clone an existing user, select that user in the list and then click Clone user .

The new user is added to the list. You can define the security settings for the new user as desired,
including assigning the user to one or more roles.

If you are a subsystem administrator, then all users that you createmust belong to a subsystem. If you
are an administrator for only one subsystem, then any new users are automatically added to that
subsystem. If you are an administrator for multiple subsystems, then the user is automatically assigned
to one of the subsystems—you can later change the assignment as needed.

� Editing user properties
To edit user properties, select a user from theUsers list, then make any changes to that user. Changes to
user settings are applied to that user when the changes are saved.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1159



� Deleting users

IMPORTANT: If a user has made any changes to the system or data, deleting the user will have
implications on auditing. In order to comply with SOX, HIPAA, and other protocols for standard
security practices, it is strongly recommended to disable existing user records instead of deleting
them. Generally speaking, a user record should only be deleted if it is newly created and has not been
used.

To delete a user, select a user from theUsers list, then click Delete user . You are prompted to confirm
that you want to delete the user.

If you delete a user, that user is removed from Axiom Budgeting and Performance Reporting security
entirely. Alternatively, you can disable a user if you want to keep the user record, but prevent the user
from accessing Axiom Budgeting and Performance Reporting. On theGeneral tab, clear the Enabled
check box.

When a user is deleted, the user's associated user folders in \Axiom\Axiom System\User Folders
are also deleted (such as My Favorites and My Documents) .

NOTE: Only Axiom Support users can delete other Axiom Support users.

Managing roles

Using the Security Management dialog, you can create new roles, edit existing roles, and delete roles. To
access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

To work with roles, select Roles in the top left-hand corner of the dialog. To save changes, click Apply (or
OK if you are finished editing security settings).

NOTE: Subsystem administrators can only work with roles that belong to their assigned subsystem.
The role list is filtered to only show those roles.

� Creating roles
You can create a new blank role, or you can clone the settings of an existing role. If you clone a role, all of
that role's settings are copied to the new role, including assigned users.

To create a role, click one of the following buttons located underneath the role list:
l To create a new blank role, click Create role .
l To clone an existing role, select that role in the list and then click Clone role .
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The new role is added to the list. You can define the security settings for the new role as desired, and you
can assign users to the role.

If you are a subsystem administrator, then all roles that you createmust belong to a subsystem. If you
are an administrator for only one subsystem, then any new roles are automatically added to that
subsystem. If you are an administrator for multiple subsystems, then the role is automatically assigned
to one of the subsystems—you can later change the assignment as needed.

� Editing roles
To edit a role, select a role from the Roles list, then make any changes to that role. Changes to role
settings are applied to users who are assigned to that role when the changes are saved.

� Deleting roles
To delete a role, select a role from the Roles list, then click Delete role . You are prompted to confirm
that you want to delete the role.

A role cannot be deleted if users are assigned to it.

TIP: If you have a role that you want to delete and many users are assigned to it, you can delete it
using the Open Security in Spreadsheet feature. The users will be automatically updated to remove
the role assignment. For more information, see Bulk edit of security.

Assigning users to roles

Each user in security can be assigned to one or more roles to define the user's security permissions.
Generally speaking, the permissions of each assigned role are combined with any user permissions to
result in themost permissive set of rights available to the user. There are some exceptions; for more
information see How role settings are applied to users.

Users can be assigned to roles from the user record or from the role record. Users have an Assigned
Roles section that lists their assigned roles. Roles have an Assigned Users section that list their assigned
users.

NOTE: Alternatively, you can use the Security Manager page in theWeb Client to assign users to
roles. For more information, seeWeb Security Manager.

To assign roles to a user from the user record:
1. In the Security Management dialog, select the user.

2. On theGeneral tab, in the Assigned Roles section, click the Add button .

3. Use the Assign Roles dialog to assign one or more roles to the user:

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1161



l Use the Add and Remove buttons to move role names between Available Roles and
Assigned Roles. All roles listed in the Assigned Roles box will be assigned to the user.

l You can also double-click role names to move them between the boxes.

4. When you have finished assigning roles, click OK to close the Assign Roles dialog, and then Apply
orOK to save the changes to the user record.

To assign users to a role from the role record:
1. In the Security Management dialog, select the role.

2. On theGeneral tab, in the Assigned Users section, click the Add button .

3. Use the Assign Users dialog to assign one or more users to the role:
l Use the Add and Remove buttons to move user names between Available Users and

Assigned Users. All users listed in the Assigned Users box will be assigned to the role.

l You can also double-click user names to move them between the boxes.

4. When you have finished assigning users, click OK to close the Assign Users dialog, and then Apply
orOK to save the changes to the role record.

How role settings are applied to users

Axiom Budgeting and Performance Reporting supports role-based security. Each user can be assigned to
one or more roles, and that user inherits the security settings defined for those roles. This topic explains
how role-level rights are inherited by individual users.

In general, role rights are additive. Users are granted themost permissive set of rights among their own
personal security settings and any roles that they are assigned to. Roles are intended to grant
permissions, not deny permissions.

Role inheritance works slightly differently for different areas of security, as detailed in the following
sections. When configuring security settings for a user, be sure to review the Effective Permissions
section that is available in most areas of the dialog. This section displays the user's effective permissions
after taking into account all applicable factors, including role inheritance, subsystem restrictions, and
administrator status.

NOTE: If subsystems are being used, then role inheritance works in the sameway, but users'
effective permissions are limited by the subsystem's maximum permissions. For more information,
see Security Subsystems.

� Permissions
The Permissions tab of security defines access rights for specific Axiom Budgeting and Performance
Reporting features. By default, users inherit security permissions from any roles that they are assigned
to. However, you can override role inheritance for a user on a per permission basis.
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If a permission is set to inherited, then the user is granted themost permissive set of rights among any
roles the user is assigned to. For example, imagine the following settings for the Browse Audit History
permission:

User Inherited

Role1 Unchecked

Role2 Checked

If the user is assigned to both Role1 and Role2, then the user inherits the permission and can access the
audit history for the system.

If instead you select to Override a permission for a user, then that permission is no longer inherited from
roles. The user is granted or denied the permission based on whether the Permission box is checked for
the user.

The following screenshot shows what the Permissions tab looks like in all possible states:

Example Permissions tab

In this screenshot, the example permissions are treated as follows:
l Administer Announcements: Inherited from role. The Budget Process role grants this permission

to the user, so the Permission check box shows as checked, and the role name is listed in the
details to the right.

l Administer Axiom Explorer: Inherited from role. None of the roles that the user belongs to
currently grant this permission, so the Permissions check box shows as unchecked.

l Administer Exports: The Override check box is checked, so the user does not inherit this
permission from any roles. The Permission check box is not checked, so the user does not have
this permission.

l Administer File Groups: The Override check box is checked, so the user does not inherit this
permission from any roles. The Permission check box is also checked, so the user has this
permission.
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� Startup documents
The Startup tab of security specifies files to open when a user starts Axiom Budgeting and Performance
Reporting, such as the home page, task panes, and ribbon tabs. Users inherit startup files from roles in
addition to their own individually assigned startup files.

Each user can have only one home page. If a user has an individually assigned home page, that file will be
used and any role settings are ignored. Otherwise, the user will inherit the home page from a role. If no
home page is assigned, the default home page is used.

For more information about startup file inheritance, see Assigning startup files (Startup tab), and review
the section for the applicable type of startup file.

� File groups
The File Groups tab of security defines access rights for plan files in file groups. For file groups, you can
configure role inheritance to be handled in a variety of ways. You can specify that role settings are
combined with user settings, or that role settings are inherited independently from user settings, or that
role settings are ignored entirely and not inherited.

For more information and examples of how role file group permissions apply to users, see Understanding
role inheritance options for file group permissions.

� All other areas
For all other areas of Security, the user inherits themost permissive set of rights among their own
personal security settings and any roles that they are assigned to. This applies to the Tables tab and the
Files tab.

For example, imagine the following access level settings for a report folder:

User Read-Only

Role1 None

Role2 Read/Write

If the user is assigned to both Role1 and Role2, then the user has Read/Write access to that report folder,
because that is themost permissive set of rights available to the user.

Each tab has an Effective Permissions section where you can view the rights that the user will be granted
after taking into account role inheritance, administrator status, and folder inheritance (where applicable).
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NOTES:
l For table access, if both the user and a role have filtered access, the filters are concatenated

using OR. So if a user has a table filter of DEPT.Region='North' and a role the user is
assigned to has a table filter of DEPT.Region='South', then that user's full filter is:

DEPT.Region='North' OR DEPT.Region='South'

That user has access to data for either the North or South regions.

l For table access, you can choose to ignore role inheritance. If this option is enabled for a user,
then any applicable role access settings for the table are not inherited (including the Full
Access setting) and the only filter applied is the user's filter.

Granting administrator-level permissions

In Security, users can be designated as a system administrator, by enabling the Administrator option on
theGeneral tab.

System administrators have full rights to all features and all data for the system. Although you can
configure security settings for administrators, such as to define file access or table filters, these settings
will be overridden as long as the Administrator check box is enabled for the user. The Effective
Permissions will reflect the user's full access.

� Administrator-only features
Administrators have access to all features and files in the current Axiom Budgeting and Performance
Reporting system. While non-admin users can be granted access to many features and files, some
features are only available to administrators:

l The ability to make another user a system administrator
l The ability to lock non-admin users out of the system, and the ability to log into a locked system
l The ability to restore a deleted file
l The ability to modify system configuration settings using Save Type 4, or using the System

Configuration page in the AxiomWeb Client
l Access to Scheduler administration features in the Scheduler dialog (such as viewing all job

history, managing system jobs and event handlers, managing Scheduler servers, and managing
remote data connections)

l Access to system folders in Axiom Explorer (therefore, any file management for system files that
cannot be done using system utilities can only be done by administrators)

l Access to certain underlying file group folders such as the Plan Files folder, Plan File Attachments
folder, and the Calc Method Libraries folder

l Access to theDeveloper > Toolsmenu on the Axiom Designer ribbon (though some of the
features on this menu are available elsewhere without the administrator restriction)

l Access to the technical administration features in the AxiomWeb Client, such as: Reset Services,
Rebuild Table Views, System Logs, and Update License
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l Ability to create and edit imports that use the current Axiom database as the source data

� Security access for non-administrators
If you want a user to be able to access and edit security settings, but you do not want to make the user
an administrator, there are two options:

l You can give the user the Administer Security permission. Users with this permission can add,
edit, and delete users, roles, and subsystems, and can access security tools such as System Access
and Logged in Users.

l If you are using subsystems, you can assign a user as a subsystem administrator. Users with this
permission can edit the security settings for users that belong to the subsystem, and can also
create and delete users within the subsystem. For more information, see About subsystems.

These users do not have access to the Administrator check box in Security. They cannot make
themselves or any other user an administrator.

The Everyone role

The Everyone role is a built-in role for each Axiom Budgeting and Performance Reporting system. The
purpose of this role is to define security settings that apply to every user in the system. All users
automatically belong to the Everyone role.

The Everyone role has the following default settings:
l Document reference tables.When a new document reference table is created, the Everyone role

is automatically granted full read access to that table. This permission grants all users the right to
query the data in document reference tables. In most cases, this is the desired level of rights. If
you have some particular document reference tables that you do not want every user to have
access to, then you can do one of the following:

o Modify the Everyone role to remove access to those tables, and instead grant access
directly to specific users and roles.

OR

o Leave the Everyone role at the default of full access, and instead modify certain users to
ignore role inheritance for that table.

l On-demand file groups.When a new on-demand file group is created, the Everyone role is
automatically granted the Create New Records permission for that file group. Effectively, this
means that any user who also has access to plan files in the file group will also have permission to
create new plan files. If you do not want this behavior—meaning that you want some users to be
able to access plan files in the file group without being able to create new plan files—then you can
remove the permission from the Everyone role and instead grant it to individual users and roles as
needed.
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l Startup task panes. By default, the Everyone role is configured to open the Explorer and Process
task panes on startup, as non-closeable task panes. You can modify the Everyone role to remove
any of these task panes, and instead grant access directly to specific users and roles (or do not
grant access to anybody, if you do not want to use these task panes at all). Only the Explorer task
pane will open automatically for all users; the Process task pane only displays when it is relevant
to the user.

NOTE: In systems with installed products, your Everyone role may have been modified to not
open these task panes on startup, and instead open different task panes.

l Startup ribbon tabs. By default, the Everyone role is configured to open the Axiom and Axiom
Designer ribbon tabs on startup.

o The Axiom ribbon tab shows for all users and provides the default menu for the Desktop
Client. You should not remove this tab from the Everyone role unless you have created one
or more custom ribbon tabs that you plan to assign to the necessary users and/or roles
instead.

o The Axiom Designer ribbon tab is limited to administrators only. You can modify the
configuration of the startup file so that it displays to other users, or you can remove it from
the Everyone role and instead grant access directly to specific users and roles (or do not
grant access to anybody, if you do not want to use the ribbon tab at all).

NOTE: In systems with installed products, your Everyone role may have been modified to not
open these task panes on startup, and instead open different task panes.

If desired, you can modify the Everyone role to grant additional rights to every user. Any right granted at
the Everyone level will be inherited by every user, except for rights that have been overridden at the user
level. Subsystem restrictions, if applicable to the user, still apply.

Note the following about the Everyone role:
l The Everyone role cannot be renamed or deleted. The security settings for the role can be

modified in either the Security Management dialog or by using Open Security in Spreadsheet.

l Users cannot be explicitly assigned to the role, nor can they be removed from the role. All users
permanently belong to this role.

l The Everyone role is not recognized by GetSecurityInfo("InRole") or when querying security tables
via Axiom query. It is assumed that all users belong to the role; therefore it is not listed as a role
assignment.

Configuring Security Settings
Security settings for users, roles, and subsystems are organized by tabs in the Security Management
dialog. The following tabs are available:
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Tab Description

General Define general settings such as name and email, as well as role assignments and
system access.

Permissions Set permissions for individual features.

File Groups Set access rights for file groups.

Tables Set access rights for tables.

Files Set access rights for files in the Axiom Budgeting and Performance Reporting file
system. This includes reports, imports, task panes, and Scheduler jobs.

Startup Specify certain files to open automatically on system startup.

Defining user properties (General tab)

The following settings are available for users on theGeneral tab.

� User Details
Each user has the following general properties:

Item Description

First Name

Last Name

The user's first and last name.

This information can be referenced by using the function GetUserInfo.

Email The user's email address. This address is used to send user notifications, such as
for process management.

This information can be referenced by using the function GetUserInfo.
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Item Description

License Type The user's license type. By default, users are Standard users unless a different
user type is selected. Standard users have the potential to access any feature or
file in Axiom Budgeting and Performance Reporting, limited by their security
permissions.

In addition to standard users, the following user types are available:
l Axiom Support users are intended to allow Axiom Budgeting and

Performance Reporting support representatives to log into your system as
part of requested support activities. Any user accounts assigned to this
license typemust acknowledge that they are Axiom representatives when
they log into the system.
Once a user has been assigned an Axiom Support license, that license can
only be removed by another Axiom Support user. Support users must use
either Axiom Prompt authentication or Internal AD authentication (Axiom
Cloud systems only).
NOTE: The Axiom Support license type is primarily intended for use in on-
premise systems. For Axiom Cloud systems, active Axiom support
representatives can access your system to troubleshoot reported issues
without requiring a support user to be created in the system.

l Consultant users are intended to allow Axiom Budgeting and Performance
Reporting consultants to log into your system as part of contracted
consulting engagements. Any user accounts assigned to this license type
must acknowledge that they are Axiom representatives when they log into
the system.
Only Axiom support users can create a consultant user. Consultant users
must use Internal AD authentication for Axiom Cloud systems, and Axiom
Prompt authentication for on-premise systems.

l Viewer users allow for view-only access to Axiom Budgeting and
Performance Reporting. Viewer users can access files as read-only, but they
cannot save files or data, and they cannot otherwise perform "change
actions" on the files (such as submitting a plan file for process management).
Viewer users also cannot perform any administration functions.
Security permissions for viewer users can be set as normal, but any settings
above read-only access to files will be ignored. The Effective Permissions will
note that the user is being limited due to the Viewer license. However, if you
switch the user to a Standard license, the settings will be honored.

The number of users that can be created and assigned to each license type
depends on your Axiom Budgeting and Performance Reporting license.
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Item Description

Authentication Themethod used to authenticate the user for access to Axiom Budgeting and
Performance Reporting. By default, new users will be assigned to your
installation's configured authentication mode; however, this can be changed on
a per user basis as needed.
l Axiom Prompt: Select this option if you want the user to be authenticated

by using their Axiom Budgeting and Performance Reporting user name and
password. You would use this option if your installation is not configured to
enable an external authentication method, or if you are using an external
authentication method but you want to create a user who can log in directly.

l Windows User: Select this option if you want the user to be authenticated
based on their Windows credentials. This option is only valid if your
installation is configured to enableWindows Authentication. For more
information, see Using Windows Authentication.

l LDAP Prompt: Select this option if you want the user to be authenticated via
your LDAP directory. This option is only valid if your installation is configured
to enable LDAP Authentication. For more information, see Using LDAP
Authentication.

l OpenID: Select this option if you want the user to be authenticated using an
OpenID provider. This option is only valid if your installation is configured to
enable OpenID Authentication. For more information, see Using OpenID
Authentication.

l SAML: Select this option if you want the user to be authenticated using a
SAML identity provider. This option is only valid if your installation is
configured to enable SAML Authentication. For more information, see Using
SAML Authentication.

l Internal AD: This option can only be used with Consultant and Support
license types, and only for Axiom Cloud systems. It allows the consultant or
support user to be authenticated using Syntellis' internal Active Directory.
The login namemust match the email address for the user within Active
Directory. For example, if the user's email address is jdoe@syntellis.com,
then the user's Axiom login namemust be jdoe@syntellis.com.
In order to log in using Internal AD authentication, the user must go to the
following page for the system:
https://ClientName.axiom.cloud/internal.

An additional option ofUnspecified exists to support backwards-compatibility
for systems upgraded from older versions. Upgraded users may be assigned to
it, but it cannot be selected otherwise. If you have users assigned to this option,
we recommend changing their assignment to the appropriate authentication
type.
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Item Description

Login The user's login name.

If the user's authentication type is anything other than Axiom Prompt, then the
user's login namemust match the user's login name for the designated
authentication source (for example, it must match the user's Windows login
namewhen using Windows Authentication). See the information on the
appropriate authentication type for login name requirements.

For Windows Authentication only, you can validate that the login name
matches a user name in one of the allowed domains by clicking the Validate
icon to the right of the box. Amessage box will let you knowwhether the
namewas found or not. This feature is only available ifWindows Authentication
is enabled and at least one valid domain name has been specified as an allowed
domain.

This information can be referenced by using the function GetUserInfo.

Password The user's Axiom Budgeting and Performance Reporting password. Click the ...
button to the right of the box to set or change the user's password. All users
must have a non-blank password.

Users can change their own password later from within the application.

NOTES:
l By default, Axiom Budgeting and Performance Reporting enforces a basic set

password rules. If desired, you can disable these rules and allow any
password. See Enabling password rules.

l The Password setting only displays for Axiom Prompt users. For all other
authentication types, a randomly generated password will be created for the
user and cannot be changed. Users cannot log in with this randomly
generated password; they can only log in using their specified authentication
type.

If you are an administrator and you need to log into Axiom Budgeting and
Performance Reporting as another user in order to test that user's security
settings, you do not need to know that user's password. For more information,
see Testing user security.

Enabled Specifies whether the user can access Axiom Budgeting and Performance
Reporting. If this check box is not selected, the user cannot log into any Axiom
Budgeting and Performance Reporting system.

NOTE: System administrators cannot disable other system administrators. The
Administrator permission must be removed before the user can be disabled.
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Item Description

Locked Out If a user has become locked out of the system due to exceeding the configured
number of failed login attempts, then the system will automatically select this
check box. You can clear the lockout by clearing this check box.

This setting only displays if you havemanually configured a lockout threshold.
For more information, please contact Axiom Support.

If an administrator becomes locked out, and no other administrator accounts
are available to clear the lockout, the Axiom SoftwareManager can be used to
reset the administrator's password and clear the lockout.

Administrator Specifies whether the user has administrator-level permissions. If this check box
is selected, then the user has access to all features and data in the current
system. For more information, see Granting administrator-level permissions.

NOTE: This check box only displays to users who have the Administrator
permission. In other words, a user cannot make themselves an administrator,
they have to be granted the right by a user who is already an administrator.

Directory Sync
Enabled

Specifies whether the user will be synched with Active Directory the next time an
Active Directory import is performed. This is enabled by default.
l If enabled, then the user will be synchronized with Active Directory according

to the settings in the Scheduler task for the import. For more information
about how this import and synchronization occurs, see HowActive Directory
user synchronization works.

l If disabled, then the user will not be affected by the Active Directory import,
even if the user namematches a user name in the import.

NOTE: This check box only displays if Active Directory import has been enabled
for your system.

� Assigned Roles
Users can be assigned to one or more roles. If the user is already assigned to roles, those roles are listed
here.

l To add a user to a role, click Add . In the Assign Roles dialog, you can select roles for the user.
l To remove a user from a role, select the role in the list and then click Remove .

Role assignments can bemadewhen editing either the user or the role. Any changes made in one area
are automatically applied to the other area.

NOTE: The Everyone role is not listed in the Assigned Roles box. All users belong to the Everyone role
and cannot be removed; therefore it is not listed as a role assignment.

For more information, see How role settings are applied to users.
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� Assigned Subsystems
This section only displays if subsystems are enabled for your system. See Security Subsystems.

If you are using subsystems, you can optionally assign the user to one or more subsystems. If the user is
already assigned to subsystems, those subsystems are listed here.

l To add a user to a subsystem, click Add . In the Assign Subsystems dialog, you can select
subsystems for the user.

l To remove a user from a subsystem, select the subsystem in the list and then click Remove .

IMPORTANT: If you remove a user from a subsystem, that subsystem's maximum permission limit
will no longer apply to that user.

Subsystem assignments can bemadewhen editing either the user or the subsystem. Any changes made
in one area are automatically applied to the other area.

NOTE: If you are a subsystem administrator, then all users that you have access to must belong to a
subsystem. If you are an administrator for only one subsystem, then any new users you create are
automatically added to that subsystem. If you are an administrator for multiple subsystems, then
the user is automatically assigned to one of the subsystems; you can change the assignment as
needed.

Configuring role properties (General tab)

The following settings are available for roles on theGeneral tab.

� Role Details
Each role has the following general properties:

Field Description

Name The name of the role.

NOTE: The name of the built-in Everyone role cannot be changed.

Description A description of the role. The description is for the administrator's use only, to
help explain the purpose of the role.

� Assigned Users
Multiple users can be assigned to a role. If the role already has assigned users, those users are displayed
here.

l To add a user to the role, click Add . In the Assign Users dialog, you can select users to add to
the role.

l To remove a user from the role, select the user in the list and then click Remove .
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Role assignments can bemadewhen editing either the user or the role. Any changes made in one area
are automatically applied to the other area.

NOTE: This section is not available when editing the built-in Everyone role. All users belong to the
Everyone role and cannot be removed.

For more information, see How role settings are applied to users.

Configuring feature permissions (Permissions tab)

On the Permissions tab of the Security Management dialog, you can specify which features a user or role
has access to. The Permissions tab works slightly differently depending on whether you are defining
rights for a user or a role.

NOTE: If you are defining permissions for a subsystem, see Defining maximum permissions for
subsystems.

� Setting permissions for users
For users, each permission has three available settings:

l Inherited: The permission is not set for the user. The permission is grayed out and the text
"inherited from role" appears to the right of the permission name. If the user is assigned to a role,
this permission can be inherited from the role.

l Denied: If theOverride check box is selected, but the Permission check box is not selected, this
means that the user explicitly does not have access to the feature. The user will not inherit the
permission from any roles.

l Allowed: If theOverride check box and the Permission check box are selected, this means that
the user explicitly has access to the feature, regardless of any role settings.

By default, all user permissions are left unset and are inherited from any role assignments. If you want to
override role inheritance and explicitly set a permission for the user, then you must select theOverride
check box and then leave the permission unchecked (to deny the permission) or checked (to allow the
permission).
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NOTES:
l When a permission is inherited from a role, it displays the effective permission for the user.

For example, if a user is assigned to a role that has the Administer Imports permission, and
that permission is eligible for inheritance, then the check box for that permission displays as
grayed out and selected. The name of the role from which the permission is inherited is also
listed. For example:

l If a user has administrator rights to the system, that user has all permissions. In this case, the
permissions list is grayed out and cannot be edited, and all permissions display as selected.
The text "user is an admin" displays next to the permission names.

l If the user belongs to a subsystem, and the subsystem settings do not allow a particular
permission to be granted to users in the subsystem, then the permission is grayed out and
cannot be edited. The text "disallowed by subsystem" (including the subsystem name)
displays next to the permission name.

� Setting permissions for roles
For roles, the Permission box for each permission is either checked or unchecked. If a permission is
checked for a role, then users who have that permission set to "inherited" will inherit rights to that
permission when they are assigned to that role.

� Permissions
The following permissions are available:

Permission Description

Administer
Announcements

The user can create, edit, and delete announcements and announcement
categories. The user must have access to a form-enabled file with an
Announcements component in order to use this permission.
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Permission Description

Administer
Axiom Explorer

The user can access the Axiom Explorer dialog. The user's other security
permissions determine what folders they can viewwithin this dialog and what
actions they can perform on them.

NOTE: This permission has no impact on the availability of the Explorer task
pane. Any user can use the Explorer task pane.

Administer
Exports

The user can create exports in the Exports Library.

The user must also have read/write permissions to at least one folder within the
Exports Library (as configured on the Files tab), or else they will have no place to
save their created exports. Execute permissions are also managed on the Files
tab.

Administer File
Groups

The user has general administrative permissions to all file groups. The user can:
l Create and delete file groups
l Edit file group settings
l Clone file groups
l Manage scenarios for file groups
l Manage restore points for file groups
l Manage categories for file groups
l Manage file group aliases
l Use the Delete Plan Files command to delete any plan file from an on-

demand file group

NOTE: Generally speaking, this permission does not grant access to any files
within the file groups, such as plan files, templates, and drivers. The user must
be granted access to these files separately if the user is expected to manage or
use these files. There are two exceptions: the user can delete any on-demand
plan file using Delete Plan Files, and the user can restore any plan file when
using restore points.

Administer
Imports

The user can create import utilities.

The user must also have read/write permissions to at least one folder within the
Imports Library (as configured on the Files tab), or else they will have no place
to save their created imports. Execute permissions are also managed on the
Files tab.

Administer
Locked Items

The user can remove file locks on documents and tables, and can remove save
locks on Axiom forms.

The list of locked items is limited to the files and tables that the user has some
level of access to. The user cannot see or unlock items that the user does not
have access to.
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Permission Description

Administer
Picklists

The user can administer picklist tables using theWeb Client TableManager. The
user can create new picklist tables. For existing picklist tables, the user can edit
table properties and delete tables (as long as the user has at least read-only
permission to the table, otherwise the table does not display in the table
manager).

Administer Picklist users do not gain access to the table administration features
in the Desktop Client.

Administer
Security

The user can access and edit security settings for the current system. The user
can also access security-related tools such as System Access and Logged in
Users.

The Administrator check box is not available to users with this permission.

Administer
Tables

The user has general table administration permissions. The user can:
l Create and delete tables
l Edit table structure
l Open tables using Open Table in Spreadsheet
l Use other table utilities available on the table administration menu

(Administration > Tables > Table Administration

The user's read and write filters (as set on the Tables tab) are honored for
purposes of viewing and saving table data.

Administer Task
Panes

The user can create and edit task panes and ribbon tabs, as allowed by the
user's folder / file access rights defined for the Task Panes Library and the
Ribbon Tabs Library (as set on the Files tab).

Administer
Updates

The user can apply product updates to the Axiom Budgeting and Performance
Reporting installation.

Browse Audit
History

The user can view audit history for the system.

NOTE: Users with this permission can see audit records for all changes, including
changes made to tables that the user does not otherwise have access to. Use
caution in granting this permission.

Remove
Protection

The user can remove workbook and worksheet protections, for any Axiom file
that the user can access.

NOTE: Alternatively, you can grant unprotect rights for individual report files
and folders on the Files tab, or for plan files on the File Groups tab.
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Permission Description

Scheduled Jobs
User

The user can access the Scheduler dialog for the purposes of working with
scheduled jobs.

The user can create jobs, edit jobs, run jobs, and delete jobs, as allowed by the
user's folder and file access rights defined for the Scheduled Jobs Library (as
configured on the Files tab of Security). For example, you might create a sub-
folder for each user and only grant the user rights to that folder.

The user can view the results of jobs that the user has executed. Other job
history is not available to the user.

The user cannot manage Scheduler servers, edit system jobs, or use other
Scheduler administration features.

NOTE: Generally speaking, task-level security is not applied to users with this
permission, within the context of Scheduler. However, file-level rights are
enforced. For example, the user can create and/or run a Process Plan Files task
within a Scheduler job, even if the user does not have the Process Plan Files
permission. But within that task, the user can only process file groups and plan
files that the user otherwise has access to.

User Documents
Folder Access

The user can access a My Documents folder in their My Files section.

The user can save files to My Documents. The user has read/write access over
any file saved to this area. Typically this permission is only granted to power
users who may need a place to save their own "personal" reports or an area to
temporarily save "in progress" files.

Administrators can access any user's My Documents folder. Other users cannot
access it.

NOTE: If a user has this permission and then later it is removed, the user's
existing My Documents folder is not deleted; it is simply hidden from the user in
Explorer dialogs. If desired, an administrator can delete the folder in
\Axiom\Axiom System\User Folders.

NOTE: Generally speaking, if a user does not have rights to a feature, themenu item associated with
that feature does not show on that user's ribbon tabs or other applicable areas.

Configuring file group permissions (File Groups tab)

On the File Groups tab of the Security Management dialog, you can manage user access to plan files and
to file group features. On this tab, you can specify the following:

l Which plan files a user can access
l The level of access to those plan files (read-only or read/write)
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l What features are available in those plan files (such as saving data or inserting calc methods)
l Which file group administration features the user can access (such as Create Plan Files or Process

Plan Files)

NOTES:
l The settings on this tab do not apply to administrators. Administrators have access to all plan

files and all file group features.
l If you are defining permissions for a subsystem, see Defining maximum permissions for

subsystems.

IMPORTANT: This tab does not control access to other files in a file group, such as templates, drivers
and utilities. To give users access to these files, use the Files tab.

File group permissions

The settings on the File Group tab define permissions for each file group. The left-hand side lists the
available file groups for the system. When you select a file group in the list, you can define the security
settings for the user or role using the two sub-tabs on the right-hand side.

l File Group: Manage access to file group administration features such as Create Plan Files and
Process Plan Files. This tab can be ignored for most end users.

l Plan Files: Manage access to plan files. It is necessary to configure access on this tab if you want
the user to have any access to plan files in the file group.

Example File Groups tab, configuring permissions to plan files
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File groups are listed by display name, followed by the file group code in parentheses. If the name of the
file group is different than the display name, that name is also displayed in the parentheses.

The Effective Permissions section displays the full permissions of the user, taking into account any
inherited role rights and other settings such as administrator rights.

NOTE: If a non-admin user has no effective permissions for a file group (either on the File Groups tab
or on the Files tab), then that user cannot see the file group in Axiom Explorer, the Axiom ribbon tab,
and other lists of file groups.

� File Group tab
Use the File Group tab to configure user access to administration features for the file group. This tab is
optional and can be ignored for most end users.

To grant a user access to one of these features, select the check box. By default, all check boxes on this
tab are not selected, which means the user does not have access to any of these features.

Item Description

Modify File
Group

This permission grants general administrative rights to the file group. The user
can:
l Edit the file group settings
l Clone the file group
l Manage scenarios for the file group
l Manage restore points for the file group

Create Plan Files The user can create plan files for the file group, using the Create Plan Files
feature. This permission is limited to those plan files where the user has
read/write access, as defined in the File Groups tab of Security.

This permission also grants access to the Copy Plan Files feature for standard
file groups, which can be used in certain specialized configurations to copy plan
files from one file group to another. In this case the user must have read/write
access and Create Plan Files permission to the target file group.

NOTE: If the file group is an on-demand file group, then users do not need this
permission in order to create new plan files "on demand." Instead, users need
the Create New Records permission.
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Item Description

Create New
Records

The user can create new plan files for the on-demand file group. This process
includes creating a new identity record in the plan code table and then creating
a plan file for that record using either its assigned template or by copying an
existing plan file (when using the Clone selected item feature). This permission
only applies to on-demand file groups.

By default, this permission is automatically enabled on the Everyone role when
a new on-demand file group is created. This means that any user with at least
Read-Only access to plan files in this file group will also have the ability to create
new plan files. (This includes plan file permission sets with the potential to be
elevated to read-only access or higher, due to the Interacts with Process
Management permission.) If you do not want all users with access to the file
group to be able to create new plan files, then you can remove the permission
from the Everyone role and instead grant it to individual users and roles.

Process Plan
Files

The user can process plan files for the file group, using the Process Plan Files
feature. This permission is limited to plan files where the user has at least read-
only access, as defined in the File Groups tab of Security.

The user can run Axiom queries and save data as part of the process, but the
user can only save the file if they have read/write access to it.

Run Axiom
Queries

The user can refresh Axiom queries in plan files, using the Refresh feature.

By default, non-admin users cannot use the Refresh feature in plan files. If you
have a plan file design where users should be able to refresh the queries in the
file as needed, then you should enable this permission.

NOTES:
l This permission does not apply to "refresh on open" Axiom queries, or to

queries run using the RunAxiomQueryBlock function. These queries will
always run, regardless of whether the user has this permission.

l This permission does not apply to form-enabled plan files (when viewed as
an Axiom form). Axiom queries in form-enabled plan files will refresh
according to the standard form refresh behavior, regardless of whether the
user has this permission.

Manage Calc
Methods

The user can perform all management activities for calc method libraries in the
file group, including adding new calc methods, editing calc methods, deleting
calc methods, as well as use any other calc method features available on the CM
Librarymenu. The user can also insert or change calc methods in any file group
files that the user has access to, and can override any calc method controls.
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� Plan Files tab
Use the Plan Files tab to configure user access to plan files for the file group. Each plan file permission set
defines the following: 

l The plan files that the permission set applies to (all plan files or a filtered subset)
l The permissions to be applied to those plan files (such as: access level, ability to save data, and

calc method permissions)
l The role inheritance to be applied to the permission set (none, combine, or independent)

Users can havemultiple permission sets per file group—for example, to define read/write access to one
set of plan files and read-only access to another set of plan files. These permission sets can be configured
for the user directly or inherited from one or more roles. Roles can only have one defined permission set
per file group.

You can add, edit, and delete permission sets as follows:
l To add the first permission set for a user or a role, click Add a Permission.
l To add an additional permission set for a user, click the plus icon .
l To edit a permission set, double-click it. You can also select it and then click the edit icon .
l To delete a permission set, select it and then click the delete icon .

NOTES:
l If a user has no configured permission sets, the user will inherit role permissions using

independent inheritance. Each role's permissions will be inherited as a separate unit. For more
information on role inheritance behavior for file groups, see Understanding role inheritance
options for file group permissions.

l If a user has multiple configured permission sets, only the first permission set displays in Open
Security in Spreadsheet.

When creating or editing a permission set, the Plan File Permission dialog opens. Within this dialog, you
can configure all permissions relating to this permission set.
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Item Description

File access level The level of access that the user or role has to the plan files covered by this
permission set. Select from one of the following:
l No Access: The user or role has no access to plan files.

The No Access option is intended to be used in conjunction with Interacts
with Process Management and/or with Combine role inheritance. You can
define other permissions for the plan files, and those permissions will apply
when the user's access level is elevated due to a plan file process, or
combined with another permission set to result in a higher level of access.

l Read Only: The user or role has read-only access to plan files.
l Read/Write: The user or role has read/write access to plan files in the file

group.

NOTES:
l The ability to save data to the database from within a file is controlled

separately, using the Allow Save Data permission.
l If you are using a plan file process with this file group, select the level of

access that you want the user to have when they are NOT the current step
owner. For example, you may want the user to have no access if they are not
the step owner, or read-only access.

l If the file group uses virtual spreadsheet plan files, and you want file locking
behavior to apply to the plan files, then users must have Read/Write access
to the files instead of Read-Only access (even though the virtual files cannot
be saved).
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Item Description

Allow Save Data Select this check box if you want the user or role to be able to save data to the
database from the plan files covered by this permission set.

NOTES:
l If you are using a plan file process to manage access to plan files, you do not

need to select this option. When the user is a step owner of a plan file, the
user's permissions will be "elevated" as needed, including the ability to save
data to the database. Generally you would only enable Allow Save Data for
a user if you want the user to be able to save the data at all times, regardless
of process step ownership.

l If a user has Read Only access and Allow Save Data, then the user will be
able to save data to the database but not save changes to the file. Generally
this configuration would only be used with form-enabled plan files. Users
with this combination of rights can save data from the file at any time,
regardless of whether the file is locked to another user.

l In most cases, this option is only selected if the user also has Read/Write
access to the file group, so that file changes and data changes can be saved
in sync.

Allow Calc
Method Insert

Select this check box if you want the user or role to be able to insert calc
methods into plan files.

This option enables or disables the user's overall ability to insert calc methods.
Within individual templates/plan files, calc method controls can be used to
further control which calc methods can be inserted and where they can be
inserted.

It is valid to select this option even if the user has No Access or Read Only
access to plan files, if the user's access will be elevated by a plan file process or
combined with another permission set. It is also valid to insert calc methods in
read-only plan files when using form-enabled plan files.

NOTE: This setting does not apply if the user has been granted theManage Calc
Methods permission. Users with this permission can perform any calc method
action in any plan file that they have access to within the file group.
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Item Description

Allow Calc
Method Change

Select this check box if you want the user or role to be able to change
methodologies in the plan file by overwriting one calc method with another.

This option enables or disables the user's overall ability to change calc methods.
Within individual templates/plan files, calc method controls can be used to
further control which calc methods can be used to overwrite and where
overwrite is allowed.

It is valid to select this option even if the user has No Access or Read Only
access to plan files, if the user's access will be elevated by a plan file process or
combined with another permission set.

NOTE: This setting does not apply if the user has been granted theManage Calc
Methods permission. Users with this permission can perform any calc method
action in any plan file that they have access to within the file group.

AllowUnprotect Select this check box if you want the user or role to be able to unprotect the
worksheet and workbook within plan files. If enabled, the user will have access
to the Protect toggles in the Advanced group on the Axiom ribbon.

This option should only be granted in special situations. Normally, end users are
not allowed to unprotect plan files.

Allow Sheet
Assistant

Select this check box if you want the user or role to see the Sheet Assistant.
Generally, you should only expose the Sheet Assistant if the user is expected to
edit file settings, including Axiom query settings.

Enabling this permission also has the following impacts:
l The user has access to the Control Sheet. The Control Sheet is hidden by

default in plan files but the user can unhide it via the Sheet Assistant.
l The Drilling Control Sheet will not be hidden if the user has the Sheet

Assistant permission.
l If the user has read/write permission and the Sheet Assistant permission,

then the user can enable forms for the file and can see the Form Assistant
and Form Control Sheet.

l The Data Source Assistant is also available if the Sheet Assistant is available.

If this check box is not selected, then the user cannot see the Sheet Assistant or
the other related items as described above.

This option should only be granted in special situations. Normally, end users are
not allowed to edit settings in plan files.
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Item Description

Allow File
Processing

Select this check box if you want the user or role to be able to perform file
processing on the file. If selected, then the user has access to file processing
features, including the File Processing button on themenu and the File
Processing task pane. The related control sheets will also be visible to the user.

If this check box is not selected, then the user cannot perform file processing
actions and cannot see the related menu items, task panes, or control sheets.

This option should only be granted in special situations. Normally, end users do
not perform file processing in plan files.

Apply settings to Select one of the following to determine the plan files that this permission set
applies to:
l All Plan Files: The configured permissions apply to all plan files in the file

group.
l Filtered Plan Files: The configured permissions apply to a subset of plan files

in the file group, as defined using a filter. For more information on defining a
plan file filter, see Defining plan file filters.

Interacts with
Process
Management

This option specifies whether this permission set interacts with plan file
processes. It is enabled by default for users, and disabled by default for roles.

Enabling this option has the following effects, for plan files covered by this
permission set:
l If the access level of the permission set is No Access, the permission set will

still be considered for step ownership when the user is directly assigned as
the step owner. If "interacts" is disabled, then the permission set is only
considered if the access level is at least Read Only.

l If the ownership assignment is through a role, enabling this option tells the
process to consider this permission set when evaluating which role members
should be step owners. If this option is not enabled, then this permission set
will be ignored by the plan file process when evaluating the role permission.

Settings for users only
The following settings apply only to users, not to roles. These settings specify how the user will inherit file
group rights from any roles that the user is assigned to. For more information, see Understanding role
inheritance options for file group permissions.
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Item Description

Role Inheritance Specify how the user will inherit file group permissions from roles:
l None: The user will not inherit file group permissions from roles. Only the

user's configured permissions will be applied. Role permissions will be
ignored.

l Combine: The user's permissions and any role permissions will be combined,
so that the user will be granted themost permissive set of rights among all
the plan file access settings. Using the Role(s) setting, you can specify
whether this applies to all roles that the user belongs to, or only a specific
role.

l Independent (default): The user will inherit permissions from roles, but the
user's configured permissions and the role's inherited permissions will be
applied separately. Using the Role(s) setting, you can specify whether this
applies to all roles that the user belongs to, or only a specific role.

Role(s) Select which roles the role inheritance settings apply to. This setting only applies
if the role inheritance is set to Combine or Independent.
l If you select (all roles), then the specified inheritance settings apply to all

roles that the user belongs to. This is the default setting.
l If you select a particular role, then the specified inheritance settings apply to

only that particular role. If the user belongs to other roles, and those other
roles are not selected in additional file group permission sets for the user,
then those role permissions are ignored.

� Defining plan file filters
To define a filter to control access to plan files, select the Filtered Plan Files option and then use the
Filter Wizard to construct the filter. (You can also type a filter directly into the filter box.) The filter
must be based on the plan code table for the file group, or on a reference table that the plan code table
links to. When using the Filter Wizard, the wizard only displays the eligible tables.

After defining a filter, you can validate it by clicking the Validate filter button . This check is to ensure
that the filter syntax is valid. You can test to make sure that a file group filter is operating as you expect
by logging in as the user (or as a user assigned to the role) and checking to see which plan files display in
theOpen Plan Files dialog for the file group.

Filter variables can be used in plan file filters, to set a filter that is based on a user's login name (see
example below) or on another related user property. This is useful to be able to set a filter at the role
level, yet resolve the filter dynamically for each user in the role. For more information, see Filter
variables.
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NOTE: You can leave the filter blank only if you are using Combine role inheritance. This assumes
that either the user or the role has a filter that will apply after the permissions are combined. If the
filter remains blank after inheritance, then the user will have no access to plan files.

Example filters
DEPT.Dept IN (200,400)

This example limits the user to accessing plan files for departments 200 and 400.

DEPT.Region='North'

This example limits the user to accessing plan files for departments assigned to the North region.

DEPT.Owner='{CurrentUser.LoginName}'

This example limits the user to accessing plan files for departments that are assigned to that user (by the
presence of the user's login name in the Owner column). This type of filter would most likely be set on a
role, so that the filter could be set once yet resolve dynamically for each user in the role. For example, for
user JDoe, this filter would resolve as DEPT.Owner='JDoe'.

Configuring plan file security for use with plan file processes

This section provides basic guidelines for setting user permissions when you intend to use a plan file
process with the file group. There aremany nuances to file group security settings and how they can
interact with plan file processes, especially if you are using advanced security configurations such as
multiple permission sets for plan files or the combine option for role inheritance.

Generally speaking, you should configure security permissions for plan files to reflect the "baseline"
permissions that you want the users to have when they are not process step owners. When the users
are step owners, their permissions will be temporarily "elevated" as needed so that they can complete
the process task. For example, a user may have Read-Only access to a plan file configured in security, so
this is their baseline permission. But when the user is the step owner of an edit step, their permission will
be elevated to Read/Write and Allow Save Data so that they can edit and save the plan file.

Additionally, the Interacts with Process Management setting for plan file permissions can be used as
follows:

l If you want a user to only have access to the plan file when they are the step owner, you can
configure a permission set to the plan file with No Access and Interacts with Process
Management enabled. This causes the permission set to be considered for step ownership of a
plan file even though the access level is No Access. The user must still have a plan file filter that
includes the plan file.

l If the ownership assignment is through a role, enabling Interacts with Process Management tells
the process to consider this permission set when evaluating which role members should be step
owners. If "interacts" is not enabled when using a role assignment, then this permission set will be
ignored by the process.
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� Example user permissions for use with a plan file process
The first step in configuring plan file permissions for use with a plan file process is deciding what level of
permissions that you want the user to have when the user is not a process step owner. This is the user's
baseline level of security permissions that they will always have.

NOTE: All of the example permission sets below assume that the user's plan file filter includes the
plan file where the user is assigned as a step owner. The user must have a configured or inherited
permission set that includes this plan file. The plan file process cannot not grant permissions to plan
files, they can only elevate existing permissions to those files.

No Access If you want a user to have no access to the plan file when the user is not a
process step owner, then set the permissions as follows:
l File Access Level: No Access
l Allow Save Data: Unchecked
l Interacts with Process Management: Checked

When the user is a step owner, the process will elevate the user's permissions as
appropriate.

Read-Only Access If you want a user to have read-only access to the plan file when the user is not a
process step owner, then set the permissions as follows:
l File Access Level: Read-Only
l Allow Save Data: Unchecked
l Interacts with Process Management: Checked if the ownership assignment

comes through a role (can be left unchecked if the user will be assigned
directly)

When the user is a step owner, the process will elevate the user's permissions as
appropriate.

Full Access If you want a user to have full edit rights to the plan file when the user is not a
process step owner, then set the permissions as follows:
l File Access Level: Read/Write
l Allow Save Data: Checked
l Interacts with Process Management: Checked if the ownership assignment

comes through a role (can be left unchecked if the user will be assigned
directly)

These permissions can be set at the user level, or at a role level, or at some combination of the two (if
using Combine role inheritance). All other plan file permissions can be enabled or not as appropriate for
the user. In some cases, the other permissions will only be relevant when the user's access level has been
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elevated by the process. For example, if the user has No Access plus Allow Calc Method Insert, then the
ability to insert calc methods is only relevant when the user is a step owner (because otherwise they will
be unable to see or open the plan file).

� Enabling Interacts with Process Management
When creating new permission sets for users, Interacts with Process Management is enabled by default.
You can disable this permission for the user if:

l The permission set grants Read-Only access or higher.

AND

l The permission set does not need to be considered when using role ownership assignments.

When creating new permission sets for roles, Interacts with Process Management is disabled by default.
You should consider whether to enable the option or leave it disabled, based on how you are granting
permissions to users and how you are assigning step owners. Keep in mind the following:

l If ownership assignments aremade through a role, then users who belong to the role must have
permission to the plan file and Interacts with Process Management enabled in order to be a step
owner.

l If the role assignment is configured to consider All permissions, then it is not necessary to enable
Interacts with Process Management on the role that will be used as the assignment. In this case,
the role simply defines the pool of eligible users. If a user has any permission set with access to the
plan file and "interacts" enabled, then they will be a step owner.

l If the role assignment is configured to considerOnly permissions associated with the assigned
role, then either Interacts with Process Managementmust be enabled on the role so that users
in the role inherit it, or the users must have an individual permission set with the "interacts"
permission that is also configured to combine with the role.

Understanding role inheritance options for file group permissions

Role inheritance for file group permissions is handled differently than in other areas of Security. For each
set of permissions defined for a user on the File Groups tab, you can specify whether role permissions
are inherited and how they are inherited.

File group permissions have three different role inheritance options:
l None
l Combine
l Independent

By default, if no file group permissions are configured for a user, the role inheritance is set to
independent. This means that users will inherit file group settings from all roles that they are assigned to,
but those inherited settings will be applied independently instead ofmerged.

The following sections explain how each role inheritance option works.
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� No inheritance
TheNone option means that no role inheritance applies. Role settings are ignored for this particular
permission set. If the user only has one permission set, then role settings are ignored entirely (for
settings on the File Groups tab).

The following is an example of how file group settings are treated with no inheritance, assuming that the
user belongs to the role:

File Group Settings User Configured
Settings

Role Configured
Settings

User Effective
Permissions

File Access Level Read Only Read/Write Read Only

Allow Save Data Unchecked Checked Unchecked

Allow Calc Method Insert Checked Checked Checked

Allow Calc Method Change Unchecked Checked Unchecked

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

DEPT.Region='South'

Filtered Plan Files:

DEPT.Region='North'

In this example, the role settings are ignored, and the user has only his or her configured permissions.

� Combine inheritance
The Combine option means that the user's permissions are combined with role permissions. The user is
granted themost permissive rights as defined for either the user or the role, on a per permission basis.

The following is an example of how file group settings are treated with combine inheritance, assuming
that the user belongs to the role:

File Group Settings User Configured
Settings

Role Configured
Settings

User Effective
Permissions

File Access Level Read Only Read/Write Read/Write

Allow Save Data Unchecked Checked Checked

Allow Calc Method Insert Checked Checked Checked

Allow Calc Method Change Unchecked Checked Checked

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

DEPT.Region='South'

Filtered Plan Files:

(DEPT.Region='North')
OR
(DEPT.Region='South')
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In this example, the user and role permissions are combined, and the user is granted themost
permissive set of rights available for each individual setting.

When you select combine inheritance, you can choose to combine with all roles that the user is assigned
to, or to combine with a specific role. For example, imagine that the user belongs to role A and role B,
and the permissions are as follows:

File Group Settings User Configured
Settings

Role A Configured
Settings

Role B Configured
Settings

File Access Level Read Only Read/Write Read Only

Allow Save Data Unchecked Checked Unchecked

Allow Calc Method Insert Checked Checked Unchecked

Allow Calc Method Change Unchecked Checked Unchecked

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

DEPT.Region='South'

Filtered Plan Files:

DEPT.Country='France'

In this case, the effective permissions of the user depend on whether the combine inheritance is set to all
roles, or to a specific role:

File Group
Settings

Combine: All Roles Combine: Role A Combine: Role B

File Access Level Read/Write Read/Write Read Only

Allow Save Data Checked Checked Unchecked

Allow Calc Method
Insert

Checked Checked Checked

Allow Calc Method
Change

Checked Checked Unchecked

Apply settings to Filtered Plan Files:

(DEPT.Region='North') OR
(DEPT.Region='South')
OR
(DEPT.Country='France')

Filtered Plan Files:

(DEPT.Region='North')
OR
(DEPT.Region='South')

Filtered Plan Files:

(DEPT.Region='North') OR
(DEPT.Country='France')

When combined with all roles, the user is granted themost permissive set of rights across all of the roles.
When combined with only one of the roles, the second role is effectively ignored. Unless the user has
another set of permissions that allows inheritance from the second role, the user will not inherit any file
group settings from the second role.
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� Independent inheritance
The Independent option means that the user inherits permissions from roles, but the role permissions
are applied independently from the user's configured permissions. The user and role permissions are not
merged, as they are when using the combine option. The user effectively has two sets of permissions:
one set based on the user's configured permissions, and one set based on the role's inherited
permission. Additionally, if the user belongs to multiple roles, each role's permissions are inherited
independently from each other (assuming that the independent inheritance is set to apply to "all roles").

The following is an example of how file group settings are treated with independent inheritance,
assuming that the user belongs to the role:

File Group Settings User Configured
Settings

Role Configured
Settings

File Access Level Read Only Read/Write

Allow Save Data Unchecked Checked

Allow Calc Method Insert Checked Checked

Allow Calc Method Change Unchecked Checked

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

DEPT.Region='South'

In this example, the user's effective permissions are the same as the user configured permissions and the
role configured permission, except applied separately. When the user accesses a plan file that belongs to
the North region, it will be read only, and the user will not be able to change calc methods. When the
user accesses a plan file that belongs to the South region, it will be read/write, and the user has all of the
other plan file permissions as defined for the role.

If there is any overlap between the two independent permissions, then the user will be granted themost
permissive set of rights for the area of overlap only. In the above example the filters cannot overlap, but
imagine that the user and role filters were instead something like the following:

User Filter: DEPT >= 5000 and DEPT < 6000

Role Filters: DEPT >= 4000 and DEPT < 6000

In this case, the role permissions alone would apply to any departments from 4000 up to 4999. Where
the permissions overlap, for departments 5000 to 5999, the user and role permissions would be
combined.

NOTE: If you use independent inheritance with a specific role instead of all roles, that configuration
blocks inheritance from all other roles unless the user has another permission set that allows the
inheritance from the other roles.
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� Multiple permission sets
For each file group, a user can havemultiple sets of permissions that apply to the plan files in that file
group. This allows you to define different permissions for different subsets of files. For example, you
might want to give a user full read/write access to plan files belonging to the North region, but only read
access to plan files belonging to the South region. In this case, you can create two sets of permissions for
the user.

If a user has multiple permission sets, each permission set has its own role inheritance settings. For
example, you may want to define filters at the user level, but define other access rights at the role level,
as shown in the following example:

File Group Settings User Configured
Settings (Set 1)

Role A Configured
Settings

User Effective
Permissions
(Combine: Role A)

File Access Level None Read/Write Read/Write

Allow Save Data Unchecked Checked Checked

Allow Calc Method Insert Unchecked Checked Checked

Allow Calc Method Change Unchecked Checked Checked

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

<Blank Filter>

Filtered Plan Files:

DEPT.Region='North'

User Permission Set 1, Combine: Role A

File Group Settings User Configured
Settings (Set 2)

Role B Configured
Settings

User Effective
Permissions
(Combine: Role B)

File Access Level None Read Only Read Only

Allow Save Data Unchecked Unchecked Unchecked

Allow Calc Method Insert Unchecked Checked Checked

Allow Calc Method Change Unchecked Unchecked Unchecked

Apply settings to Filtered Plan Files:

DEPT.Region='South'

Filtered Plan Files:

<Blank Filter>

Filtered Plan Files:

DEPT.Region='South'

User Permission Set 2, Combine: Role B

The ability to definemultiple permission sets with separate inheritance settings is a very flexible feature,
able to meet a wide variety of security needs. When using multiple permission sets, keep in mind that it
is possible to configure settings that cancel out or contradict the settings of another set.
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For example, if you configure one permission set with no role inheritance, and then you configure a
second permission set with independent inheritance, then the no inheritance setting on the first set is
pointless (since you are already independently inheriting all role settings from the second set). On the
other hand, it can bemeaningful to have no inheritance on the first permission set, and then combine
inheritance on the second permission set (for either all roles or a specific role). Make sure that you
understand the purpose of each permission set, and check the effective permissions section for the user
to ensure that permissions are being inherited as intended.

Configuring table permissions (Tables tab)

On the Tables tab of the Security Management dialog, you can manage user access to tables. You can
control what data a user can query from a table (read access), and what data a user can save to a table
(write access).

Table access can bemanaged at the table level and at the table type level. By default, users have the
following permissions:

l All table types, and stand-alone data tables and reference tables, start at "no access" for both read
and write. You must configure access to these table types and tables on a per user or role basis. If
access is defined for a table type, then any tables added to the table type will automatically inherit
that access.

l All document reference tables are automatically set to full read access, via the Everyone role.

NOTES:
l If a user is an administrator, the settings on this tab are ignored. Administrators can access

data in all tables.
l If you are defining permissions for a subsystem, see Defining maximum permissions for

subsystems.

Understanding table permissions

This section explains how the table access settings in Security work.

� Read access and write access
Each table and table type can have read access permissions and write access permissions.

l Read access defines what data a user can query from a table—for example, via a GetData function
or by running an Axiom query. For each table or table type, a user can have no read access, full
read access, or filtered read access.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1195



l Write access defines what data a user can save to a table. For most users this means via a Save
Type 1 process set up in a plan file or a report, but it also applies to Open Table in Spreadsheet (if
the user has access to it). For each table or table type, a user can have no write access, full write
access, or filtered write access.

NOTE: Table write access does not apply to document reference tables (Save Type 3).
Document reference tables can only be created and edited via a source document; therefore
the ability to write data to the table is controlled by the user's access rights to the source
document. Also, write access is ignored for import packages—if the user has execute rights to
an import, then they can save the imported data to the specified destination table, regardless
of their write access to that table.

By default, the write access for a table or table type is set to the same level as the read access. If that is
the desired level of access, then you only need to configure the read access; the write access will be
automatically set. You can see this inheritance for the write access in the Effective Permissions box after
you set the read access.

However, if you want differing levels of read and write access for a table or table type, then you must
select the Specify custom write access check box, and then configure the specific write access.

For example, imagine the following settings for the table GL2020:

If the read access is set to... And the write access is set to... The user's permission is...

Full Access (Default) Read: Full Access

Write: Full Access

Filter: DEPT.Region='North' (Default) Read: DEPT.Region='North'

Write: DEPT.Region='North'

Full Access Specify custom write access:

Filter: DEPT.Region='North'

Read: Full Access

Write: DEPT.Region='North'

Full Access Specify custom write access:

Filter: <Blank Filter>

Read: Full Access

Write: No Access

No Access Specify custom write access:

Full Access

Read: No Access

Write: Full Access
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NOTES:
l For reference tables, the read access settings are only applied when the reference table is

queried directly—for example, when viewing the reference table using Open Table in
Spreadsheet, or when the reference table is the primary table of an Axiom query. The read
access settings defined on a reference table are not applied when queries aremade against a
data table that joins to the reference table.

Therefore if you want to restrict access to data, the filter must be defined on the data table or
its table type. For example, if you want to restrict a user to only viewing planning data for the
North region, then you must define that filter on the data table or the table type, not on the
DEPT reference table.

l Read filters are not applied to data that already exists in a spreadsheet. For example, when the
administrator runs the Process Plan Files utility to process Axiom queries in plan files, the plan
files are populated with data according to the administrator's data rights. When individual
users open these plan files, they see all of the data that was populated into the spreadsheet.
The read filters of the individual users would only be applied if the users processed Axiom
queries by using the Refresh feature. If you would like to limit data access in plan files, you can
consider dynamically hiding sheets that you do not want particular users to access.

l Keep in mind that just because a user has write access to a table, it does not mean that the
user actually has themeans to save any data. For example, in order for a user to save data to a
table from a plan file, the user must have access rights to the plan file, and the permission to
save data from the file, and the file must be configured to save data to the table. If a user does
not have access to files and/or features that facilitate saving data to the database, then the
user cannot save any data, regardless of his or her write access permissions.

� How table type access and table access combine
Tables inherit any rights set at the table type level, and then combine that access with any rights set at
the table level, resulting in themost permissive set of rights for the table.

l If a table type is set to full or filtered access, then all tables in that table type inherit the full or
filtered access. You cannot "override" the table type setting at the table level to deny access to a
specific table in the table type. You can set individual tables to havemore permissive access than
the table type, but not less permissive.

l If desired, you can leave the table type access unset, and instead configure access at the table
level. The user will be granted whatever access is set at the table level.

l If access filters are set at both the table type level and the table level, the filters are concatenated
using OR (meaning the filters are combined to result in themost permissive set of rights for the
table).

For example, imagine a table type of GL, which contains a table named GL2020:

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1197



If the table type GL is
set to...

And the table GL2020 is
set to...

The user's permission is...

Full Access No Access (nothing is
configured)

Full Access

Full Access DEPT.Region='North' Full Access

No Access (nothing is
configured)

DEPT.Region='North' DEPT.Region='North'

DEPT.Region='South' Full Access Full Access

DEPT.Region='South' DEPT.Region='North' (DEPT.Region='South') OR
(DEPT.Region='North')

Tables that do not belong to a table type only have their individual table access rights.

� Table visibility to users
If a user does not have any read access to a table, then that table will not display in lists of tables
throughout the system, such as in the Sheet Assistant, or the Filter Wizard. Table Library folders and
table types will only display if the user has read access to at least one table within the folder or the table
type. (Exception: if the user has the Administer Tables permission, then that user will see all Table Library
folders and table types for the purposes of creating new tables.)

Table permissions

The settings on the Tables tab define access for each table or table type. The left-hand side of the tab lists
the available tables in the system, organized by table type. Tables that do not belong to a table type are
listed under (No Type). When you select a table or a table type in the list, you can configure the security
settings for the user or role within the Configured Permissions section in the right-hand side of the tab.
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Example Tables tab

The Effective Permissions section displays the full permissions of the user for the selected item, taking
into account any rights inherited from the table type or a role, and other settings such as administrator
rights or subsystem restrictions. Make sure to check this section to ensure that users are being granted
rights as you expect.

Because table permissions can be set at any point in the treeview, it can be difficult to later tell which
items have been configured. To change the view to only show items with configured permissions, select
the check box for Show configured items only. If the treeview is blank after selecting this check box, this
means that the user or role has no configured permissions.

NOTE: By default, the Everyone role grants all users full read access to document reference tables.
Any changes made to document reference tables in the Tables tab will not apply to users unless you
modify the Everyone role to remove full access (or unless you configure the user to ignore role
inheritance for that table).

� Read access settings
The following settings apply to all tables and table types, to define read access to data. By default, the
write access is automatically set to the same level as the read access. If that is the desired level of access,
then you do not need to do anything further to configure write access for a table or table type.
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Item Description

Full access

(Full read access)

Select this check box if you want the user or role to have full access to the table
or table type.

By default, this check box grants full read and write access. If you want to
configure write access separately, then you must enable the separate option to
Specify custom write access. Selecting that option exposes additional settings
for write access, and renames this check box to Full read access.

NOTE: If you are defining access for a table that belongs to a table type, and full
access has already been granted at the table type level, then this check box is
effectively ignored. However, the setting will be stored at the table level and
could apply in the future if the table type access is ever changed, or if the table is
removed from the table type. Be sure to check the Effective Permissions
section of the dialog to see what level of access is being granted due to
inheritance.

Filter

(Read filter)

If you want the user or role to have filtered access to the table or table type,
specify the filter. For example:

l ACCT.Acct>10000 restricts the user to only accessing data for accounts
over 10000.

l DEPT.Dept=100 restricts the user to only accessing data for department
100.

l DEPT.Region='North' restricts the user to only accessing data for
departments assigned to the North region.

By default, the filter applies to both read and write access. If you want to
configure write access separately, then you must enable the separate option to
Specify custom write access. Selecting that option exposes additional settings
for write access, and renames this option to Read filter.

NOTE: If you are defining a filter for a table that belongs to a table type, the filter
will be concatenated to the table type filter using OR. If full access has been
granted at the table type level, then the table level filter is effectively ignored.
However, the filter will be stored for the table and could apply in the future if the
table type access is ever changed, or if the table is removed from the table type.
Be sure to check the Effective Permissions section of the dialog to see what
level of access is being granted due to inheritance.
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To define a filter for a table or table type, type the filter into the Filter box, or use the Filter Wizard .
Note the following:

l If the filter is for a table type, the filter should be based on key columns that are common to all
tables in the table type (using either the key column itself, or a column in the lookup table that the
key column links to). For example, if the GL table type has two required key columns, ACCT and
DEPT, then you can create a table type filter that uses one or both of these columns, or one that
uses grouping columns in the associated reference tables. Filters using any other columns may be
invalid.

l If the table type has required columns, then any filter defined must be based on those required
columns. If the required columns do not have lookups, then no valid filters can be defined.

l When selecting key columns in the Filter Wizard, the Filter Wizard automatically uses the lookup
column in the reference table instead of the column in the data table. For example, if you select
the column Acct in the GL2020 data table, the filter wizard automatically uses ACCT.ACCT in the
filter (instead of GL2020.ACCT).

After defining a filter, you can validate the filter syntax by clicking the Validate filter button .

IMPORTANT: If you define a write filter on a reference table, then any columns used in the filter must
also be included in the save definition when saving to that table using Save Type 1. For example, if
the table is DEPT and the filter uses DEPT.Region, then the Region column must be included in the
save definition in order for the user to save data.

� Write access settings
The following settings only apply if you want to configure write access at a different level than the read
access.

NOTE: Write access settings do not apply to document reference tables. Document reference tables
are only created and edited via a source document; therefore the ability to write data to the table is
controlled by the user's access rights to the document.

Item Description

Specify custom
write access

Select this check box if you want to configure write access at a different level
than the read access.

When this check box is selected, two additional settings become available in the
dialog to set the write access: Full write access andWrite filter.

If you want the user to have no write access to the table, then select this check
box and ignore the other write access settings. If Full write access is unchecked
andWrite filter is blank, then the user has no write access.
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Item Description

Full write access Select this check box if you want the user or role to have full write access to the
table or table type.

NOTE: If you are defining access for a table that belongs to a table type, and full
access has already been granted at the table type level, then this check box is
effectively ignored. However, the setting will be stored at the table level and
could apply in the future if the table type access is ever changed, or if the table is
removed from the table type. Be sure to check the Effective Permissions
section of the dialog to see what level of access is being granted due to
inheritance.

Write filter If you want the user or role to have filtered write access to the table or table
type, specify the filter. For example:

l ACCT.Acct>10000 restricts the user to only saving data for accounts over
10000.

l DEPT.Dept=100 restricts the user to only saving data for department 100.
l DEPT.Region='North' restricts the user to only saving data for

departments assigned to the North region.

NOTE: If you are defining a filter for a table that belongs to a table type, the filter
will be concatenated to the table type filter using OR. If full access has been
granted at the table type level, then the table level filter is effectively ignored.
However, the filter will be stored for the table and could apply in the future if the
table type access is ever changed, or if the table is removed from the table type.
Be sure to check the Effective Permissions section of the dialog to see what
level of access is being granted due to inheritance.

To define a filter for a table or table type, type the filter into the Filter box, or use the Filter Wizard .
Note the following:

l If the filter is for a table type, the filter should be based on key columns that are common to all
tables in the table type (using either the key column itself, or a column in the lookup table that the
key column links to). For example, if the GL table type has two required key columns, ACCT and
DEPT, then you can create a table type filter that uses one or both of these columns, or one that
uses grouping columns in the associated reference tables. Filters using any other columns may be
invalid.

l If the table type has required columns, then any filter defined must be based on those required
columns. If the required columns do not have lookups, then no valid filters can be defined.

l When selecting key columns in the Filter Wizard, the Filter Wizard automatically uses the lookup
column in the reference table instead of the column in the data table. For example, if you select
the column Acct in the GL2020 data table, the filter wizard automatically uses ACCT.ACCT in the
filter (instead of GL2020.ACCT).
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After defining a filter, you can validate the filter syntax by clicking the Validate filter button .

IMPORTANT: If you define a write filter on a reference table, then any columns used in the filter must
also be included in the save definition when saving to that table using Save Type 1. For example, if
the table is DEPT and the filter uses DEPT.Region, then the Region column must be included in the
save definition in order for the user to save data.

� Other table permissions
The following permissions can also be defined for tables and table types:

Item Description

Open Table in
Spreadsheet

This option specifies whether the user can view the table in Open Table in
Spreadsheet, and at what level of access. Select one of the following:
l None (default): The user cannot view the table in Open Table in Spreadsheet.
l Read-Only: The user can view the table as read-only in Open Table in

Spreadsheet.
l Read/Write: The user can view the table as read/write in Open Table in

Spreadsheet.

Granting this permission gives the user access to the Table Library, so that the
user can launch Open Table in Spreadsheet for the table.

This permission does not apply to document reference tables. Document
reference tables cannot be opened via Open Table in Spreadsheet.

This permission can only be assigned if the user has read or read/write
permission to the table data (either configured on the user or inherited from a
role). If the user inherits Open Table in Spreadsheet permission from a role but
does not have any corresponding access to table data, then the permission will
be ignored. If the user is granted read/write access to Open Table in
Spreadsheet but only has read access to the table, then the spreadsheet access
will be limited to read-only.
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Item Description

Allow changing
table structure

Select this check box if you want the user to be able to edit the table structure
and table properties. If selected, then the user can open the Edit Table dialog
for the table. The user can add, modify, and delete table columns, as well as
modify other table properties.
Granting this permission gives the user access to the Table Library, so that the
user can launch Edit table structure for the table.

By default this option is not selected, which means the user cannot edit the
table structure or table properties.

This permission does not apply to document reference tables. The table
structure of document reference tables is controlled via the source file.

This permission can be granted regardless of whether the user has access to the
table data.

Ignore role
inheritance

Select this check box if you do not want the user to inherit table access settings
from a role (including the Everyone role).
l If selected, then only the user's individual settings will be used to determine

access to data in the table or table type.
l If this check box is not selected, then the user will be granted themost

permissive set of rights among the user's configured settings and any roles
that the user belongs to. If both the user and a role have filtered access,
then the filters are concatenated using OR.

� Restricting access to document reference tables
By default, all users have full read access to document reference tables, via the Everyone role. In most
cases this is the desirable level of access. However, in some cases you may need to restrict access to a
subset of users. To restrict access to a document reference table, you must do the following:

l In the Everyone role, clear the Full Access check box for the table. Now no non-admin users have
access to the table.

l For each individual user or role that you want to grant full or filtered access to the table, modify
the table access settings as desired.

TIP: Alternatively, you could leave the Everyone role at full access, and then modify specific users to
Ignore role inheritance for the table. Those users would then have no access to the table.

Write access settings do not apply to document reference tables. Document reference tables are only
created and edited via a source document; therefore the ability to write data to the table is controlled by
the user's access rights to the document.
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NOTE: If you have restricted access to a document reference table created by a driver file, keep in
mind that your security changes will not be cloned when the file group is cloned. This is because the
table itself is not cloned; the driver file is. If you want to apply the same changes to the new table
created by the new driver file, then you will need to manually configure access to this table after
processing the drivers for the new file group.

Configuring file access (Files tab)

On the Files tab of the Security Management dialog, you can control access to files in the Axiom
Budgeting and Performance Reporting file system. The following areas can be controlled:

l The Reports Library
l The Data Diagrams Library
l The Filter Library
l The Imports Library and the Exports Library
l The Process Definitions Library
l The Scheduler Jobs Library
l The Task Panes Library
l The Ribbon Tabs Library
l Certain supporting files for file groups: Templates, Drivers, Utilities, and Process Definitions

NOTES:
l File permissions do not apply to users with administrator rights. Administrators always have

full access to all files.
l File permissions must be defined within the Security Management dialog. The bulk editing tool

Open Security in Spreadsheet does not support configuring file and folder permissions.
l If you are defining file permissions for a subsystem, see Defining maximum permissions for

subsystems.

� Configuring file permissions
The left-hand side of the Files tab displays the available folders and files. When you select a folder or a file
in the list, you can define the security settings for the user or role within the Configured Permissions
section in the right-hand side of the tab.
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Example Files tab

File permissions can be set at the folder level and at the file level. By default, all sub-folders and files
underneath a parent folder inherit the rights of the parent folder, unless rights are explicitly set for the
sub-folder or file.

You can set permissions at the library level and then override those permissions for specific sub-folders
and files as needed, or you can set permissions for specific sub-folders and files only.

By default, each user or role has no access to any files or folders on this tab. You must define file
permissions for each user or role.

To configure permissions to a file or folder:
1. Select the file or folder in the treeview, and then select Configured Permissions.

If this check box is selected for a sub-folder or a specific file, the sub-folder or file will no longer
inherit any permissions set for the parent folder. You can clear the check box, and the sub-folder
or file will once again inherit permissions from the parent folder.

2. Select the applicable permission options as desired.

Each type of file (reports, import, etc.) has slightly different security settings that can be defined
on this tab. For more information on the file-specific options, see the detailed sections.
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If a new folder or file is added to any library, a user will have access to it if the folder or file is placed
underneath an existing parent folder that the user has rights to. For example, if a user has rights to the
entire Reports Library, that user will have access to any new folders and files added to the Reports
Library. If a user only has rights to a specific sub-folder in the Reports Library, that user will have access to
new folders and files added to that sub-folder.

The Effective Permissions section displays the full permissions of the user, taking into account any
inherited role rights, and other settings such as administrator rights. This section also takes into account
rights that are inherited from a parent folder.

NOTE: Because file permissions can be set at any point in the treeview, it can be difficult to later tell
which items have been configured. To change the view to only show items with configured
permissions, select the check box for Show configured items only. If the treeview is blank after
selecting this check box, this means that the user or role has no configured permissions.

� Reports Library
The following permissions can be set for files in the Reports Library:

Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to reports can open and refresh reports, but
cannot save changes. If read access is set at the folder level, users cannot
save new reports to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box for the target report of a custom
drill. The user only needs to be able to access this report when performing a
custom drill on the source file. Displaying the file in the Reports Library would
just clutter the list of files because the user never needs to open the file from
that location.

NOTE: The Reports Library dialog (accessible from Reports > All Reports) does
not honor this permission. If a user has at least read-only access to a report, it
will show in this dialog, regardless of the Show in Explorer permission.

Allow Save Data Select this check box if you want the user or role to be able to save data to the
database for the folder or file. If a report is set up to use Save Type 1, 3, or 4, the
user will be able to save data to the database.

If this check box is not selected, then the user cannot save data to the database
from the report.

NOTE: If a user has Read Only access and Allow Save Data, then the user will be
able to save data to the database but not save changes to the file. Note that
users with this combination of rights can save data from the file at any time,
regardless of whether the file is locked to another user.
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Option Description

AllowUnprotect Select this check box if you want the user or role to be able to remove workbook
and/or worksheet protection for this folder or file.

Users with this permission can use the Advanced > Protect options on the
ribbon to remove workbook or worksheet protection from Axiom files.

IMPORTANT: If you enable this permission at the folder level, then the user will
be able to unprotect any file that they save to the folder (assuming that the user
has read/write access to the folder).

NOTE: This setting is ignored for users with the Remove Protection permission
on the Permissions tab; those users can remove protection for any file.

Allow Sheet
Assistant

Select this check box if you want the user or role to see the Sheet Assistant.
Generally, you should only expose the Sheet Assistant if the user is expected to
edit file settings, including Axiom query settings.

Enabling this permission also has the following impacts:
l The user has access to the Control Sheet. If the Control Sheet is hidden in

the document, the user can make it visible by double-clicking any field name
in the Sheet Assistant.

l If the user has read / write permission and the Sheet Assistant permission,
then the user can enable forms for the file and can see the Form Assistant
and Form Control Sheet.

l The Drilling Control Sheet, if present in the file, is not hidden if the user has
the Sheet Assistant permission.

l The Data Source Assistant is also available if the Sheet Assistant is available.

If this check box is not selected, then the user cannot see the Sheet Assistant or
the other related items as described above.

Allow File
Processing

Select this check box if you want the user or role to be able to perform file
processing on the file. If selected, then the user has access to file processing
features, including the File Processing button on themenu and the File
Processing task pane. The related control sheets will also be visible to the user.

If this check box is not selected, then the user cannot perform file processing
actions and cannot see the related menu items, task panes, or control sheets.

NOTE: If a user does not have access to any report files or folders, then the Reports menu item does
not display on themenu, and the user cannot create reports.

� Filter Library
The following permissions can be set for files in the Filter Library:

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1209



Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or filter.
l Read Only: The user or role has read-only access to the folder or filter.

Users with read-only access to saved filters can load those filters into the
Filter Wizard for use. If read access is set at the folder level, users cannot
save new filters to that folder.

l Read/Write: The user or role has read/write access to the folder or filter.
If the item is a filter, the user can save changes to the filter. If the item is a
folder, the user can also save new filters to the folder, create sub-folders,
and delete and rename filters and folders.

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

� Scheduler Jobs Library

NOTE: Users must also have the Scheduled Jobs User permission (on the Permissions tab) in order
to access any files in the Scheduler Jobs Library.

IMPORTANT: Users do not have to have any file permissions to a Scheduler job in order to execute
that job via an event handler (such as when using Run Event or Raise Event).

The following permissions can be set for files in the Scheduler Jobs Library:
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Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to Scheduler jobs can open jobs and can
manually execute jobs, but cannot save changes. If read access is set at the
folder level, users cannot save new jobs to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open a
Scheduler job from a shortcut in a task pane, but otherwise the user does not
need to be able to browse to it in the Scheduler Jobs Library.

� Exports Library
The following permissions can be set for files in the Exports Library:
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Option Description

Access Select one of the following:
l No Access: The user or role cannot open the folder or file (however, they can

execute the export, if they have the separate Execute permission).
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to exports can open export files to view the
settings, but they cannot edit the settings.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
NOTE: Read/write access to the Exports Library does not allow the user to
create exports. Export creation is controlled by the Administer Exports
permission on the Permissions tab.

Execute Select this check box to give the user execute permissions to the folder or file.
Users with execute permissions can run the export.

NOTE: Table read permissions are honored for export packages. When the user
executes the export, the user's permission to the table will determine the
eligible data to export. If the user does not have access to the table at all, then
no data will be exported.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

For example, you might clear this check box if a user needs to be able to execute
an export from a shortcut in a task pane, but otherwise the user does not need
to be able to browse to it in the Exports Library.

NOTE: If a user has Execute permissions but No Access to the export file, then
you should select this check box if you want the export to display in the Export
Library. When using this configuration, the user can double-click the file to open
the Execute dialog only. If, however, the user will only execute the export from
links in a task pane or other predefined links, then you can leave this option
cleared.

NOTE: The export access permission and the execute permission are independent. A user can have
no access to an export file but still be given execute permissions. Similarly, a user can have read/write
access to the export settings, but not be able to execute it.

� Imports Library
The following permissions can be set for files in the Imports Library:
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Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file (however, they

can execute the import, if they have the separate Execute permission).
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to imports can open import files to view the
settings, but they cannot edit the settings.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
NOTE: Read/write access to the Imports Library alone does not allow the
user to create new imports. The user must also have the Administer
Imports permission on the Permissions tab.

Execute Select this check box to give the user execute permissions to the folder or file.
Users with execute permissions can run the import.

NOTE: Table write permissions are ignored for import packages. If a user has
execute rights to an import, then the imported data will be saved to the
configured destination table, regardless of the user's write access to that table.

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

NOTE: If a user has Execute permissions but No Access to the import file, then
you should select this check box if you want the import to display in the Import
Library. When using this configuration, the user can double-click the file to open
the Execute dialog only. If, however, the user will only execute the import from
links in a task pane or other predefined links, then you can leave this option
cleared.
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NOTES:
l The import access permission and the execute permission are independent. A user can have

no access to an import file but still be given execute permissions. Similarly, a user can have
read/write access to the import settings, but not be able to execute it.

l The Import Errors folder is system-maintained and therefore does not display in this dialog.
You cannot manually grant or deny access to this folder or the error files within it; access is
automatically granted based on access to the import that generated the error.

l If an import uses an Axiom database as its source, then non-administrators cannot view or
edit that import regardless of their access rights granted here. However, non-administrators
can execute the import if they have that permission.

� Task Panes Library
The following permissions can be set for files in the Task Panes Library:

Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to task panes can view and use task panes but
cannot save changes. If read access is set at the folder level, users cannot
save new task panes to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
NOTE: Users must also have the Administer Task Panes permission (on the
Permissions tab) in order to create or edit task panes.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open
an associated task pane for a file, but otherwise the user does not need to be
able to open the task pane from the Task Panes Library.

NOTES:
l Task panes can contain shortcuts to various files and system features. The ability of a user to

open a file or use a feature from the task pane depends on the user's permission for that file or
feature.

l Users do not need to have access permission to a task pane in order to open it at startup. If a
user is assigned a task pane on the Startup tab of security, it will always open as read-only at
startup, regardless of the user's access permission.

l By default, the Axiom ribbon tab does not contain any command to open task panes. If a user
has rights to a file in the Task Panes Library, then in order to see and open this file manually
the user must have access to either the Explorer task pane or the Axiom Explorer dialog, or
you must include access to the task pane within another custom task pane or ribbon tab file
that is assigned as a startup file to the user. For example, you might create a custom task pane
that includes a link to the Task Panes Library, and if a user has file access rights to any task
panes they could be launched from this location. Users only gain access to theManage > Task
Panesmenu item if they have the Administer Task Panes security permission.

� Ribbon Tabs Library
The following permissions can be set for files in the Ribbon Tabs Library:
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Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to task panes can view ribbon tab files but
cannot save changes. If read access is set at the folder level, users cannot
save new ribbon tab files to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
NOTE: Users must also have the Administer Task Panes permission (on the
Permissions tab) in order to create or edit task panes.

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

This setting does not havemuch use for ribbon tab files because ribbon tabs are
typically configured as startup files for end users, and end users do not need
access permission to be able to open the file at startup.
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NOTES:
l Users do not need to have access permission to a ribbon tab in order to open it at startup. If a

user is assigned a ribbon tab on the Startup tab of security, it will always open as read-only at
startup, regardless of the user's access permission.

l In general, there is no need to grant end users access to the Ribbon Tabs Library unless the
user needs to be able to create and edit ribbon tabs. If a user opens a ribbon tab file directly
from the Ribbon Tabs Library, it will always open in the editor, not in the application ribbon.
There is no way to open a ribbon tab file on demand and have it display in the application
ribbon.

� Process Definition Library
The following permissions can be set for files in the Process Definition Library:

Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to the file can open the process definition from
the Explorer task pane and view the settings.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
Users with read/write access cannot start or stop the process, they can only
edit the process definition settings.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open a
process definition from a shortcut in a task pane, but otherwise the user does
not need to be able to browse to it in the Process Definition Library.

� Data Diagrams Library
The following permissions can be set for files in the Data Diagrams Library:

Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.
l Read/Write: The user or role has read/write access to the folder or file.

If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open a
data diagram from a shortcut in a task pane, but otherwise the user does not
need to be able to browse to it in the Data Diagrams Library.

� File Groups
The following permissions can be set for certain files and folders in file groups. Each file group is listed
separately in this section, with sub-folders for Templates, Drivers, Utilities, and Process Definitions.

NOTE: Permissions cannot be set at the file group level and inherited by the folders. Each folder must
be configured separately.

Option Description

Access Select one of the following:
l Hidden: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to files can open and refresh those files, but
cannot save changes. If read access is set at the folder level, users cannot
save new files to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open
the file from a shortcut in a task pane, but otherwise the user does not need to
be able to browse to it in the Explorer task pane.

Allow Save Data Select this check box if you want the user or role to be able to save data to the
database for the folder or file. If a file is set up to use Save Type 1, 3, or 4, the
user will be able to save data to the database.

If this check box is not selected, then the user cannot save data to the database
from the report.

NOTES:
l If a user has Read Only access and Allow Save Data, then the user will be

able to save data to the database but not save changes to the file. Note that
users with this combination of rights can save data from the file at any time,
regardless of whether the file is locked to another user.

l This permission is ignored for template files and does not apply to process
definitions. Save-to-database processes do not run within file group
templates.
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Option Description

AllowUnprotect Select this check box if you want the user or role to be able to remove workbook
and/or worksheet protection for this folder or file.

Users with this permission can use the Advanced > Protect options on the
ribbon to remove workbook or worksheet protection from Axiom files.

IMPORTANT: If you enable this permission at the folder level, then the user will
be able to unprotect any file that they save to the folder (assuming that the user
has read/write access to the folder).

NOTES:
l This setting is ignored for users with the Remove Protection permission on

the Permissions tab; those users can remove protection for any file.
l This setting does not apply to process definitions.

Allow Sheet
Assistant

Select this check box if you want the user or role to see the Sheet Assistant.
Generally, you should only expose the Sheet Assistant if the user is expected to
edit file settings, including Axiom query settings.

Enabling this permission also has the following impacts:
l The user has access to the Control Sheet. If the Control Sheet is hidden in

the document, the user can make it visible by double-clicking any field name
in the Sheet Assistant.

l If the user has read / write permission and the Sheet Assistant permission,
then the user can enable forms for the file and can see the Form Assistant
and Form Control Sheet.

l The Drilling Control Sheet, if present in the file, is not hidden if the user has
the Sheet Assistant permission.

l The Data Source Assistant is also available if the Sheet Assistant is available.

If this check box is not selected, then the user cannot see the Sheet Assistant or
the other related items as described above.

NOTE: This setting does not apply to process definitions. Also, control sheets
are not hidden in template files.

Allow File
Processing

Select this check box if you want the user or role to be able to perform file
processing on the file. If selected, then the user has access to file processing
features, including the File Processing button on themenu and the File
Processing task pane. The related control sheets will also be visible to the user.

If this check box is not selected, then the user cannot perform file processing
actions and cannot see the related menu items, task panes, or control sheets.

NOTE: This setting does not apply to process definitions.
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� File permission examples
The following examples use the Reports Library, but the concept of folder inheritance applies to all files
on the Files tab.

If a user has read/write access to the Reports Library, that user can access and save files anywhere in the
library, unless a different level of access is explicitly set for a sub-folder or a file. For example:

Sub-folders and files inherit the rights defined for the parent folder, unless permissions are explicitly set
for the sub-folder or file. When you select a sub-folder or file in the folder tree, you can tell if it is
inheriting permissions by whether the Configured permission check box is selected. If this check box is
not selected, then the folder or file is inheriting permissions, and you can view the inherited permissions
in the Effective Permissions section.
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NOTE: The effective permissions also take into account role inheritance and administrator rights (if
applicable). Therefore, the sub-folder or file might show a different level of permissions than its
parent folder, if it is inheriting from a role.

If rights are set at the library level, but you want to set a different level of rights for a specific folder or file,
select Configured permission for that folder or file and define the desired level of rights. In the following
example, the user has read/write access to the Reports Library, but no access to theUtilities sub-folder.
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Note that if the user was assigned to a role that had access to the Utilities folder, then the user would be
granted that level of access even though the folder is explicitly hidden for the user. Users are granted the
highest level of file permissions allowed by their user rights and assigned roles. You cannot override role
inheritance for report file access.

It is also possible to grant a user access to a file or folder, but hide that file/folder in the user's Explorer
task pane and other "Explorer views." In the following example, theDrilling sub-folder contains drill
target files. The user needs read-only access to the files in order to perform the drill, but otherwise the
user never needs to open the files directly or see the files in their Reports Library. By clearing the Show in
Explorer option, this folder and its files will not display to the user.
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Assigning startup files (Startup tab)

On the Startup tab of the Security Management dialog, you can specify which files to open automatically
when a user logs into the system. You can also configure certain startup options.

Startup files are assigned using the following categories:
l Home Page: You can assign an alternate home page for a user or role.
l Task Panes: You can assign custom task panes to open on startup.
l Ribbon Tabs: You can assign custom ribbon tabs to open on startup.
l Other Documents: You can assign additional reports (regular or form-enabled) to open on

startup.

NOTE: Startup files are stored by document ID. If you subsequently change the name of a startup file
or move it to a different location, the startup configuration will still work. If the file is deleted, the
startup item will simply be ignored; it will not cause an error on startup.

Startup files only apply when using the Excel Client or theWindows Client, with one exception: if the
assigned home page is an Axiom form, that page will also display as the user's home page when accessing
forms in theWeb Client.
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Example Startup tab

Assigning home pages

You can optionally assign home pages on a user or role basis. If a home page is specified in Security, this
file will be used instead of the default files in the Startup folders. You can use any Axiom report (including
web reports and Axiom forms), or any normal Excel file stored in the Reports Library.

You can assign each user or role a "global" home page to be used in all clients. You can also override this
assignment to show a different home page in the Desktop Client (Excel Client or Windows Client).

The home page is always opened as read-only. The user does not need to be granted permissions to the
file in order to open it on startup.

To assign a home page to a user or role:
1. On the Startup tab of the Security Management dialog, click the [...] button to the right of either

of the following fields:
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Item Description

Home Page This "global" home page is used in all clients, unless a Desktop Client Home
Page is also specified.

If you want this home page to display in theWeb Client, the selected file
must be web-enabled (either an Axiom form or a web report). If the file is
not web-enabled, then the assignment will be ignored for purposes of the
Web Client.

Desktop Client
Home Page

This home page is used in the Desktop Client only (Windows Client or Excel
Client), overriding the Home Page assignment.

The Shortcut Properties dialog opens so that you can select a file.

2. To specify the file, click the [...] button to the right of the Shortcut Target box. In the Choose
Document dialog, select the desired file from the Reports Library, then click OK.

3. Once the file has been selected, specify any of the following optional Shortcut Parameters:

Item Description

Axiom Tab
Name

An alternate name to display on the file tab. By default, the tab name is
"Home".

Quick Filter AQuick Filter to apply to the file. The Quick Filter must be a valid filter
criteria statement. Once the file is opened, users can clear the filter using
the Quick Filter option on the ribbon.

NOTE: Queries in the target file must be configured to refresh on open, in
order for the filter to be applied to the data when the file is opened.

This option does not apply to web reports.

Non-closeable Specifies whether the user can close the file once it has been opened.

By default, this is not enabled, which means the file is closeable. If a user
closes the home page, they can reopen it using the Show Home button on
the default Axiom ribbon tab.

You might enable this option if you have defined a custom ribbon tab for
end users that does not contain the ShowHome button. This ensures that
users will always have access to the home page by preventing them from
closing it.

View As Form Select this option to open the report as an Axiom form. This option only
applies if the report is form-enabled.

4. Click OK.

The selected file displays in theHome Page box.
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You can change the home page assignment at any time, or remove the assignment by clicking the delete
button.

� Home page priority order
When a user logs into an Axiom Budgeting and Performance Reporting client, their home page is
determined using the following priority order. If the first item on the list is defined, then that file is used,
otherwise the next item on the list is used, and so on.

Desktop Client (Excel and Windows)
1. Security-assigned home page at the user level

2. Security-assigned home page for a role the user belongs to (excluding the Everyone role)

NOTE: If a user belongs to multiple roles, and more than one role has an assigned home page,
the home page of the "first" role is used (determined alphabetically by role name).

3. Security-assigned home page for the Everyone role

Axiom Budgeting and Performance Reporting first cycles through items 1-3 looking for a Desktop
Client Home Page assignment. If no assignment is found, Axiom Budgeting and Performance
Reporting cycles through items 1-3 again, this time looking for a Home Page assignment. If no
security home page is found, Axiom Budgeting and Performance Reporting continues to the next
item.

4. Default home page in the Axiom System directory
l In theWindows Client, Axiom Budgeting and Performance Reporting checks
\Startup\Home\Windows Client first, then moves on to \Startup\Home.

l In the Desktop Client, Axiom Budgeting and Performance Reporting checks
\Startup\Home\Excel Client first, then moves on to \Startup\Home.

If no valid home pages are found for the Desktop Client, a blank spreadsheet is used.

Web Client
1. Product-assigned home page

This item only applies in systems with installed products. If a product area in theWeb Client has a
designated home page, that home page takes precedence over all other home page assignments.
When the user logs into theWeb Client, they see the home page for their default product area.

2. Security-assigned home page at the user level

3. Security-assigned home page for a role the user belongs to (excluding the Everyone role)
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NOTE: If a user belongs to multiple roles, and more than one role has an assigned home page,
the home page of the "first" role is used (determined alphabetically by role name).

4. Security-assigned home page for the Everyone role

For theWeb Client, only theHome Page assignment is considered for items 1-3. TheDesktop
Client Home Page is ignored. The Home Page assignment must be a web-enabled file in order to
be used as theWeb Client home page. If no valid assignment is present in Security, Axiom
Budgeting and Performance Reporting continues to the next item.

5. Default home page in the Axiom System directory

In theWeb Client, Axiom Budgeting and Performance Reporting checks \Startup\Home\Web
Client for a web-enabled file, and uses that file as the home page if present. The
\Startup\Home directory is ignored in this case, even if the file in that directory is web-enabled.
If no valid home page is present in the Axiom System directory, Axiom Budgeting and Performance
Reporting continues to the next item.

6. Default Web Client home page provided by Axiom Budgeting and Performance Reporting

This page displays the user's notifications and web favorites. This built-in page is only used as the
home page if no other home page assignment is found.

Assigning startup task panes

You can assign one or more custom task panes to display automatically when a user logs into the
system. Typically, these settings are defined at the role level rather than at the user level—either on the
Everyone role to display for all users, or on your organization's defined roles.

Users do not need to have file permissions to access the task panes that are designated to open on
startup. Because of this, in most cases you should use theNon-Closeable option to specify that the task
pane cannot be closed. This will ensure that the task pane is always available to the user. Otherwise, the
user could close the task pane and then have no way to open it again, because they do not have access
to the file itself.

Users inherit any task panes defined for roles that they are assigned to, in addition to their own assigned
task panes. Task panes are opened in the following order:

l Task panes defined for the Everyone role, in the order specified on the Everyone role
l Task panes defined for roles (multiple roles sorted in alphabetical order), in the order specified for

the role
l Task panes defined for the user, in the order specified for the user

If a single task pane is listed in more than one place, it is only opened once, the first time it is listed.
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NOTES:
l The startup task pane settings do not control the display of system-controlled task panes such

as the Sheet Assistant or File Processing. These task panes display dynamically when they are
relevant to the current context, if the user has the appropriate rights.

l By default, the Everyone role is configured to open the following built-in task panes on
startup: Explorer and Process. These task panes are not system-controlled; if desired you can
change their security settings or remove the task panes entirely.

To assign startup task panes to a user or role:
1. On the Startup tab of the Security Management dialog, click the plus button at the top of the

Task Panes box.

The Shortcut Properties dialog opens.

2. To specify the task pane, click the ... button to the right of the Shortcut Target box. In the Choose
Document dialog, select the desired task pane from the Task Panes Library and then click OK.

3. Once the task pane has been selected, specify any of the following optional Shortcut Parameters:

Item Description

Axiom Tab
Name

Define an alternate tab name for the task pane (by default, the tab name is
the file name).

Non-closeable Select this option to prevent the user from closing the task pane.

This option should be selected for startup task panes if users do not
otherwise have access to the task pane. Most end users are not granted
access to the Task Panes Library and therefore they only see task panes
that are configured to open on startup. In this case, if the user closes the
task pane, they will have no way to reopen it (other than to exit the
system and then log in again). Preventing users from closing the task pane
ensures that it will always be available.

4. Click OK. The selected file displays in the Task Panes box.

You can repeat this process for as many custom task panes that you want to assign to the user or role.

Once one or more task panes have been assigned, you can modify the assignments as follows:
l To adjust the order ofmultiple assigned task panes, select the task pane that you want to move

and then use the arrow buttons to move it up or down.
l To delete an assigned task pane, select the task pane in the list and then click theDelete

button.
l To edit the shortcut parameters of an assigned task pane, double-click the task pane in the list to

reopen the Shortcut Properties dialog.
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Assigning startup ribbon tabs

You can assign one or more custom ribbon tabs to display automatically when a user logs into the
system. Typically, these settings are defined at the role level rather than at the user level—either on the
Everyone role to display for all users, or on your organization's defined roles.

Keep in mind that just because a ribbon tab is opened at startup does not necessarily mean it will display
to the user. You can configure certain ribbon tab options that further control the display. For example,
you can specify that a particular ribbon tab only displays if the user is an administrator, or if the current
file is a plan file. These options make it easier to configure a ribbon tab for the Everyone role, yet still
dynamically control the display so that only the users who need the ribbon tab can see it.

Users do not need to have file permissions to access the ribbon tabs that are designated to open on
startup. Startup is the only time that ribbon tabs can be opened in the ribbon, so in general there is no
reason to give end users file permissions to these files except for the small handful of users who need to
create and edit the ribbon tabs.

Users inherit any ribbon tabs defined for roles that they are assigned to, in addition to their own
assigned ribbon tabs. Ribbon tabs are opened in the following order:

l Ribbon tabs defined for the Everyone role, in the order specified on the Everyone role
l Ribbon tabs defined for roles (multiple roles sorted in alphabetical order), in the order specified for

the role
l Ribbon tabs defined for the user, in the order specified for the user

Custom ribbon tabs display before (to the left of) any Excel ribbon tabs. In the case of theWindows
Client, custom ribbon tabs display before the Home tab.

If a single ribbon tab is listed multiple times, it is only opened once, the first time it is listed.

NOTE: By default, the Everyone role is configured to display two built-in ribbon tabs: Axiom and
Axiom Designer. These ribbon tabs are not system-controlled; if desired you can change the security
settings for these tabs, customize the tab contents, or remove the tabs entirely.

To assign startup ribbon tabs to a user or role:
1. On the Startup tab of the Security Management dialog, click the plus button at the top of the

Ribbon Tabs box.

The Shortcut Properties dialog opens.

2. To specify the ribbon tab, click the ... button to the right of the Shortcut Target box. In the Choose
Document dialog, select the desired ribbon tab from the Ribbon Tabs Library and then click OK.

3. Once the ribbon tab has been selected, specify any of the following optional Shortcut Parameters:
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Item Description

Axiom Tab
Name

Optional. Define an alternate tab name for the ribbon tab (by default, the
tab name is the file name).

Requires Admin Select this check box if the ribbon tab should only be visible if the user is an
administrator.

In general, this option is only used if you are assigning a ribbon tab for the
Everyone role, but you want to limit the display to administrators.

Requires Sheet
Assistant

Select this check box if the ribbon tab should only be visible if the user has
Sheet Assistant permission to the current file.

This option can be used to dynamically display a ribbon tab that contains
tools appropriate for file designers. Keep in mind that the ribbon tab will
dynamically show and hide as the user changes the current file (assuming
the user only has Sheet Assistant permission to certain files).

Visible for doc
type

Optional. Select a document type if the ribbon tab should only be visible
when the current file is a certain type of file. You can specify Plan File,
Template, or Report. By default, this option is set to All, which means the
ribbon tab displays for all file types (assuming it is otherwise eligible to
display).

If you specify a document type, keep in mind that the ribbon tab will
dynamically show and hide as the user switches between different
documents. This may be confusing to the user if the ribbon tab is not very
obviously designed for a particular document type.

4. Click OK. The selected file displays in the Ribbon Tabs box.

You can repeat this process for as many custom ribbon tabs that you want to assign to the user or role.

Once one or more ribbon tabs have been assigned, you can modify the assignments as follows:
l To adjust the order ofmultiple assigned ribbon tabs, select the ribbon tab that you want to move

and then use the arrow buttons to move it up or down.
l To delete an assigned ribbon tab, select the ribbon tab in the list and then click theDelete

button.
l To edit the shortcut parameters of an assigned ribbon tab, double-click the ribbon tab in the list to

reopen the Shortcut Properties dialog.

Assigning other startup documents

You can assign other documents to open automatically when a user logs into the Axiom Budgeting and
Performance Reporting Desktop Client. These documents are opened in addition to the home file. You
can select any Axiom report (including web reports and Axiom forms) or any normal Excel file stored in
the Reports Library.
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There is no limit on the number of files that can be opened at startup, however, many files or large files
may slow performance and cause delays starting Axiom Budgeting and Performance Reporting.

If a document is assigned to open on startup, then it will always open on startup as read-only, regardless
of the user's file permissions for that document. The user does not need to have permission to access
the file otherwise.

Users inherit any documents defined for roles that they are assigned to, in addition to their own assigned
documents. Documents are opened in the following order:

l Documents defined for the Everyone role, in the order specified on the Everyone role
l Documents defined for roles (multiple roles sorted in alphabetical order), in the order specified for

the role
l Documents defined for the user, in the order specified for the user

If a single document is listed in more than one place, it is only opened once, the first time it is listed. Note
that the home page is always the first document opened.

To assign other startup documents to a user or role:
1. On the Startup tab of the Security Management dialog, click the plus button at the top of the

Other Documents box.

The Shortcut Properties dialog opens.

2. To specify the document, click the ... button to the right of the Shortcut Target box. In the Choose
Document dialog, select the desired file from the Task Panes Library and then click OK.

3. Once the document has been selected, specify any of the following optional Shortcut Parameters:

Item Description

Axiom Tab
Name

An alternate name to display on the file tab. By default, the tab name is
the file name.

If the file is an Axiom form or a web report, then this tab name is only used
when launching theWindows Client, and causes the file to open within the
application instead of the browser.
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Item Description

Quick Filter AQuick Filter to apply to the file. The Quick Filter must be a valid filter
criteria statement. Once the file is opened, users can clear the filter using
the Quick Filter option on the ribbon.

NOTE: The target file must be refreshed in order for the filter to be applied
to the data. One or both of the following settings should be enabled in the
file:

l Refresh all Axiom functions on open (if the file uses functions to
return data instead of an Axiom query)

l Refresh data on file open (for the applicable Axiom queries)
This option only applies to Axiom spreadsheet reports and Axiom forms.

Non-closeable Specifies whether the user can close the file once it has been opened.

By default, this is not enabled, which means the file is closeable. You may
want to enable this option if users do not otherwise have access to the file.
In this case, if the user closes the file, they will have no way to reopen it
(other than to exit the system and then log in again). Preventing users
from closing the file ensures that it will always be available.

You would only do this if the file is something that users need to see
throughout their session. If the file is simply informational and users don't
need to see it again once they have viewed it, then you probably want to
let users close the file.

View As Form Select this option to open the report as an Axiom form. This option only
applies if the report is form-enabled.

4. Click OK. The selected file displays in theOther Documents box.

You can repeat this process for as many additional documents that you want to assign to the user or
role.

Once one or more documents have been assigned, you can modify the assignments as follows:
l To adjust the order ofmultiple assigned documents, select the document that you want to move

and then use the arrow buttons to move it up or down.
l To delete an assigned document, select the document in the list and then click theDelete

button.
l To edit the shortcut parameters of an assigned document, double-click the document in the list to

reopen the Shortcut Properties dialog.
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NOTE: When a user launches the Excel Client, any web-enabled startup documents other than the
Home file will be opened in the browser instead of within the Excel Client. In theWindows Client, if
you define an Axiom Tab Name for the web-enabled document, it will open within the application
instead within the browser.

Assigning startup options

You can configure startup options that impact howAxiom Budgeting and Performance Reporting
displays when a user logs in. These options are listed at the bottom of the Startup tab of the Security
Management dialog, underneath the assigned startup files. You can set these startup options at the user
level or at the role level.

Currently there is only one startup option that can be set:
l Show Formula Bar At Start

If this option is enabled, then the formula bar automatically shows when a user logs into the Axiom
Budgeting and Performance Reporting Excel Client or theWindows Client. If this option is disabled, then
the formula bar is hidden.

Users can still toggle the formula bar shown or hidden using the Formula Bar check box on the Axiom
ribbon tab. This startup option simply determines the initial state of the formula bar when the user logs
in; it does not prevent the user from changing that state later.

By default, all users are set to show the formula bar at start, via the Everyone role. If you want to change
this behavior, you have several options:

l You can override the behavior for specific users by clicking theOverride check box and then
clearing the check box for Show Formula Bar At Start. This means that the formula bar will be
hidden at start for this user.

l You can clear the Show Formula Bar At Start check box for the Everyone role, and then set the
option as desired for specific users and roles.

NOTE: It is not possible to leave the option enabled for the Everyone role and then override it by
role. If you want some roles to show the formula bar and others to hide it, then you must disable the
option on the Everyone role and then enable or disable it as appropriate for your other roles.

This setting is always enabled for admin users and cannot be disabled. However, for admin users only,
Axiom Budgeting and Performance Reporting will remember the last state of the formula bar and apply
that on startup, disregarding this setting.
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Security Subsystems
Security subsystems allow you to define groups of users to bemanaged as a distinct "subset" of users
within the system. Using subsystems, you can:

l Define a group of users to belong to the subsystem and be limited to a certain maximum level of
permissions. When you create a subsystem, you are essentially drawing a permissions boundary
that users who belong to the subsystem cannot cross.

l Assign one or more subsystem administrators who can manage security for the users that belong
to the subsystem. This allows you to give certain users the right to manage other users'
permissions, without needing to grant them full administrator rights or even full security
administration rights.

Subsystems are not an alternative to roles. Roles grant permissions as a group; roles cannot be used to
deny permissions or to grant user management rights. Subsystems are intended for situations where
you need to create independently-managed user groups that work within the same system but only
need access to specific defined areas of that system. Roles can then be used to grant permissions within
the limits of the subsystem.

NOTE: Subsystems are optional in systems without installed products. Subsystem features are only
available if you have enabled them using the system configuration settings.

About subsystems

Subsystems are used to create distinct groups of users who need to be restricted to a certain maximum
level of access. When you create a subsystem, you define:

l Themaximum permissions for the subsystem. Using the standard security permission settings,
you specify themaximum level of permissions that any user who belongs to this subsystem can
have.

l The users who belong to the subsystem. The permissions for these users cannot exceed the
subsystem maximum permissions. Roles can also optionally belong to a subsystem, and will be
limited to the subsystem maximum permissions.

l The subsystem administrators. Subsystem administrators can access Axiom Budgeting and
Performance Reporting security for purposes ofmanaging users and roles that belong to the
subsystem.

For example, imagine that your organization has three different facilities, and you budget for all of these
facilities within the same Axiom Budgeting and Performance Reporting system. Each facility has a set of
users, and you want to limit those users to a specific set of plan files and reports. You also want to allow
the financemanager of each facility to control the user rights for their facility, but you do not want to
make them full system administrators.
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Example system with subsystems

You could use subsystems for this configuration as follows:
l Create a subsystem for each of the facilities. You can assign existing users to the subsystem,

and/or the subsystem administrator can create users for the subsystem.

l Within each subsystem, specify themaximum level of user rights for that facility. This would
include plan file access filters to restrict the set of plan files in a file group, and folder permissions
for the Reports Library (for example, each facility might have their own folder in the Reports
Library, and you would grant each subsystem permission to only the appropriate folder).

l Within each subsystem, assign the facility's financemanager as the subsystem administrator. That
user could then manage the rights for each user in the subsystem, including granting the users
rights to the necessary plan files and reports (either individually or by using roles). The users can
have a lower level of rights than what is allowed by the subsystem, but they cannot have a higher
level.

Each user can belong to one or more subsystems. If a user belongs to multiple subsystems, the limits for
each subsystem will be applied independently (in other words, using OR to concatenate the restrictions
where applicable instead of AND).

In systems with installed products, subsystems are used to control access to specific products. These
subsystems are product-controlled and delivered with the product. For example, you may have
subsystems for Capital Planning and Budget Planning. You can assign users to subsystems based on the
specific products they should be able to access.

About subsystem administrators

When a user is assigned as a subsystem administrator, that user can access security for the purposes of
managing users and roles that belong to the subsystem.
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Subsystem administrators are not administrator-level users. The behavior is similar to being granted the
Administer Security permission, except that the subsystem administrator can only work with users and
roles within the subsystem.

Subsystem administrators can do the following:
l Create, edit, and delete users and roles within the subsystem.

l Assign roles to users in the subsystem. The users can be assigned to subsystem-specific roles or to
"global" roles (roles that do not belong to any subsystem).

l Remove locks held by users in the subsystem. This applies to document and table locks, and save
data locks, where the subsystem administrator has some level of access to the locked item.

l Use Log in as selected user to test the permissions of any user in the subsystem by logging in as
that user. (Note that if a system administrator is assigned to the subsystem, the subsystem
administrator cannot log in as that user.)

Subsystem administrators cannot edit the subsystem settings, except to assign users and roles to the
subsystem. It is assumed that the subsystem is created by a system administrator (or delivered as part
of an installed product), and then the subsystem administrator simply manages the users and roles
within that predefined framework.

The subsystem administrator can be any user. The subsystem administrator may belong to the
subsystem as a user if desired, but that is not a requirement. If the subsystem administrator is also a
member of the subsystem, then the subsystem administrator can edit his or her own user permissions,
but overall those permissions are restricted by the limits of the subsystem.
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Example Security dialog for a subsystem administrator

About subsystems and roles

Subsystems can be used in conjunction with roles. You can assign a user to a subsystem, and then assign
the user to one or more roles to grant security permissions. These permissions are then limited by the
subsystem boundaries.

There are two ways that you can use roles with subsystems:
l You can assign subsystem users to "global" roles, meaning standard roles that don't belong to a

subsystem. These roles can contain users that belong to any subsystem. The role permissions are
inherited "as is" by the user and then the user's effective permissions are restricted by their
assigned subsystem.

l You can assign a role to a subsystem, and then assign users in the subsystem to the role. In this
case, only users who also belong to the subsystem can belong to the role. Also, the role
permissions are restricted by the assigned subsystem before the user inherits the permissions.
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Subsystem-specific roles are recommended if users may belong to multiple subsystems, due to the small
but crucial difference in how role inheritance and subsystem restrictions interact. Also, subsystem
administrators can create and edit subsystem-specific roles, which provides the subsystem administrator
with greater control over the use of roles with their subsystem users. When using global roles,
subsystem administrators can only assign users to the role, they cannot edit the role or see the role's
permissions.

� Role inheritance and subsystems
If each user only belongs to one subsystem, then there is no difference in the effective permissions when
users inherit permissions from global roles or from subsystem-specific roles. However, if a user can
belong to multiple subsystems, then the effective permissions can vary depending on which type of role
is used.

To illustrate this difference, consider the following plan file filter settings for a file group:

User configured permission: No Access

Role configured permission: All Plan Files

Subsystem maximum permission: DEPT.Facility=5

In this configuration, it doesn't matter whether the role is global or whether it belongs to the subsystem.
In both cases, the user will ultimately be restricted to plan files that are assigned to Facility 5. If the role is
global, then the subsystem restriction of Facility 5 will be applied to the user after the role inheritance. If
the role belongs to a subsystem, then the Facility 5 restriction will be applied to the role before the
permissions are inherited. Either way, the end result of the effective permission is the same.

Now consider what can happen if the role is global and the user belongs to two subsystems instead of
just one:

User configured permission: No Access

Role configured permission: All Plan Files

Subsystem 1maximum permission: DEPT.Facility=5

Subsystem 2maximum permission: All Plan Files

In this configuration, the user inherits the permission from the global role before the subsystem
restrictions are applied to the user. So the user's starting permission is All Plan Files. Because the user's
multiple subsystem restrictions are combined using OR, the ultimate subsystem restriction is
Dept.Facility=5 OR All Plan Files (which effectively means no restriction—the combined subsystem
maximum permission allows access to all plan files). Together with the inherited role permission, this
means the user has access to all plan files.
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The organization may have intended the user to have access to all plan files. The user belongs to
Subsystem 2 and that subsystem allows access to all plan files, so it is a valid result if the user is assigned
to a role that grants access to all plan files. However, a potential issuemay arise if the role assignment
was made by the Subsystem 1 administrator. This subsystem administrator may not know that the user
also belongs to Subsystem 2 and/or may not know that Subsystem 2 has a maximum permission of All
Plan Files. The Subsystem 1 administrator can only consider the impact of his or her subsystem's
restrictions, which would limit the user to plan files from Facility 5. The granting of all plan files via the
Subsystem 2maximum permission may be unintentional.

So if subsystem administrators aremanaging role assignments and users can belong to multiple
subsystems, the only way to ensure that permissions are limited by each respective subsystem is to use
subsystem-specific roles instead of global roles. For example, consider the following configuration where
the user belongs to multiple subsystems and is assigned to subsystem-specific roles:

User configured permission: No Access

Role configured permission (Subsystem 1): All Plan Files

Role configured permission (Subsystem 2): No Access

Subsystem 1maximum permission: DEPT.Facility=5

Subsystem 2maximum permission: All Plan Files

Now the role filters are limited by the subsystem restrictions before the user inherits permissions from
the roles. This gets resolved as follows:

l Subsystem 1 role permission of All Plan Files is restricted by the Subsystem 1maximum
permission of Dept.Facility=5. The user can access only those plan files that belong to Facility 5.

l Subsystem 2 role permission of No Access needs no further resolution—the user is not granted
access to any plan files via this subsystem.

l So even though the user's combined subsystem restriction is the same as in the previous
example, this is no longer an issue because the role permissions are restricted by their respective
subsystems before being inherited by the user. In this case this means the user is only granted the
plan file access from the Subsystem 1 role, meaning the user only has access to plan files for
Facility 5.

Now imagine the same permissions except that the role configured permission for Subsystem 2 is
Dept.VP='Smith' instead of No Access. Now the user's effective permission is as follows:

(DEPT.VP='Smith') OR (DEPT.Facility=5)

This means the user can access any plan files from Facility 5, and any plan files where the assigned
VP is Smith.
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Managing subsystems

Using the Security Management dialog, you can create new subsystems, edit existing subsystems, and
delete subsystems. To access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

To work with subsystems, select Subsystems in the top left-hand corner of the dialog.

NOTE: Only administrators and users with the Administer Security permission can create, edit, and
delete subsystems. Subsystem administrators are limited to viewing theGeneral tab of the
subsystem only, for purposes of assigning existing users to the subsystem.

Security dialog with subsystems enabled

To save changes, click Apply (orOK if you are finished editing security settings).
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� Creating subsystems
You can create a new blank subsystem, or you can clone the settings of an existing subsystem. If you
clone a subsystem, all of that subsystem's settings are copied to the new subsystem, except for assigned
users.

To create a subsystem, click one of the following buttons located underneath the subsystem list:
l To create a new blank subsystem, click Create subsystem .
l To clone an existing subsystem, select that subsystem in the list and then click Clone subsystem

.

The new subsystem is added to the list. You can define the settings for the new subsystem as desired,
and you can assign users and roles to the subsystem. You can also assign a user as a subsystem
administrator, to manage the users within the subsystem.

For more information on completing subsystem settings, see:
l Defining subsystem properties (General tab)
l Defining maximum permissions for subsystems

� Editing subsystems
To edit a subsystem, select a subsystem from the Subsystems list, then make any changes to that
subsystem. Changes to subsystem settings take effect when the changes are saved.

� Deleting subsystems
To delete a subsystem, select a subsystem from the Subsystems list, then click Delete subsystem .
You are prompted to confirm that you want to delete the subsystem.

A subsystem cannot be deleted if users are assigned to it.

Defining subsystem properties (General tab)

The following settings are available for subsystems on theGeneral tab.

� Subsystem Details
Each subsystem has the following general properties:

Item Description

Name The name of the subsystem.

Description A description of the subsystem.
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� Subsystem-Specific Roles
Multiple roles can be assigned to a subsystem. If the subsystem already has assigned roles, those roles
are displayed here.

It is not possible to assign roles from the subsystem record. Roles can be assigned to subsystems from
the role record, using the Subsystem box. SeeManaging subsystem roles.

� Assigned Users
Multiple users can be assigned to a subsystem. If the subsystem already has assigned users, those users
are displayed here.

Subsystem assignments can bemadewhen editing either the user or the subsystem. SeeManaging
subsystem users.

� Subsystem Admins
One or more users can be assigned as a subsystem administrator. Only administrators and users with
the Administer Security permission can assign or remove a subsystem administrator. Subsystem
administrators do not see this section when they view the subsystem record.

l To assign a user as a subsystem administrator, click Add . In the Assign Users dialog, you can
select one or more users to add as a subsystem administrator.

Assigning a user as a subsystem administrator does not automatically add the user to the
subsystem. Subsystem administrators are not required to belong to the subsystem. However, if
you want the user to also belong to the subsystem, then you must separately assign the user to
the subsystem.

l To remove a user as a subsystem administrator, select the user in the list and then click Remove
. You can select and removemultiple users at once.

Subsystem administrators can access the Security Management dialog for the purposes ofmanaging
users for the subsystem. Subsystem administrators do not otherwise have administrator-level
permissions. For more information on subsystem administration rights, see About subsystem
administrators.

Defining maximum permissions for subsystems

When defining security settings for a subsystem, you are defining themaximum permission that any
user who belongs to the subsystem can have. Users are not granted these permissions by the
subsystem; they are restricted to having this level of permission or less. Generally this means that you
must define themaximum desired settings on each tab of the dialog, or else no users in the subsystem
can have access to the features controlled by that tab.
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You can imagine the subsystem permissions as defining an outer boundary of user rights. Users that
belong to the subsystem can be assigned to roles and can be granted individual permissions as normal.
Any user permissions that fall within the subsystem boundary will be given to the user. Any user
permissions that fall outside of the subsystem boundary will be ignored.

At minimum, you must define settings on the following tabs:
l File Groups tab, to specify which file groups the subsystem can access and themaximum allowed

access.
l Tables tab, to specify which tables the subsystem can access and themaximum allowed access.
l Files tab, to specify which folders and files the subsystem can access and themaximum allowed

access. In most cases this will include defining access permissions to reports. Optionally, you can
grant access to scheduler jobs, task panes, and imports.

If users in the subsystem will not need any special permissions, then you can ignore the Permissions tab.
Otherwise, you must define themaximum allowed access on that tab.

NOTES:
l If a user belongs to more than one subsystem, then the allowed permissions in one

subsystem may exceed the permissions allowed in another subsystem. In this case the
permissions "boundary" is the combination of the subsystems, where the user is granted the
more permissive boundary (not restricted to the less permissive boundary). In this
circumstance, you may find it useful to use subsystem-specific roles to grant permissions to
users instead of "global" roles.

l If a system administrator is assigned to a subsystem, the administrator permission takes
precedence over the subsystem limitation. Subsystem limitations do not apply to system
administrators.

� Permissions tab
Select the check boxes for the permissions that you want to be available to users in the subsystem.

For example, if you know that some users in the subsystem need to have access to Scheduler, then you
must select the Scheduled Jobs User permission for the subsystem. The users' individual permissions
and role inheritance will determine which users in the subsystem actually have the Scheduled Jobs User
permission.

If no users in the subsystem need to have any of these permissions, then you can leave the entire tab
unchecked.

NOTE: In most cases, you should not select the Administer Security permission for a subsystem. If a
subsystem user is granted this permission, they will be able to manage all users and roles in the
system, not just the subsystem users and roles. Subsystem administrators do not need to be
granted this separate permission in order to manage the users in the subsystem.
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� File Groups tab
For subsystems, you can define a single permission set for each file group. This maximum permission set
will be applied against all permission sets defined for the user and inherited from the user's roles. If no
permission set is defined for a file group, then the subsystem does not allow access to that file group.

If you want the users in the subsystem to be able to access plan files in a particular file group, then you
must create a permission set and configure it as follows:

l Set the file access level to the highest level that you need to make available to users in the
subsystem. Typically this means setting the access to at least Read-Only. You must also specify
whether the subsystem has access to Allow Save Data, Allow Calc Method Insert, and Allow
Calc Method Change. Remember that if you are using process management to manage access to
plan files, then you do not need to select Allow Save Data because the plan file process will
automatically elevate user permissions as necessary.

NOTE: The setting Interacts with Process Management is not available to subsystem
permissions. There is no way to disable process interaction at the subsystem level.

l Apply the permission settings to themaximum group of plan files that you need to make available
to users in the subsystem.

You must either select All plan files or specify a plan file filter. For example, if you specify a filter
such as DEPT.Facility=5, then users in this subsystem can only access plan files for facility 5.
Any user or role permission that falls outside of that filter is ignored.

If the subsystem has a plan file filter, and a user in the subsystem is assigned a plan file filter (either
individually or via a role), then the subsystem filter and the user filter are concatenated using AND.
This restricts the user to only accessing files that match both the user filter and the subsystem
filter. For example, if the subsystem filter is DEPT.Facility=5 and the user filter is
DEPT.VP='Jones', then the user can only access plan files that are assigned to VP Jones AND
which belong to facility 5.

NOTE: The Create New Recordsmaximum permission is enabled by default for on-demand file
groups. This is set automatically on the subsystem whenever a new on-demand file group is created.
Also, when you create a new subsystem, this permission is automatically set for any existing on-
demand file groups. This behavior is to enable the default permissions for on-demand file groups,
which are automatically set to allow creating new records via the Everyone role.

� Tables tab
If you want the users in the subsystem to be able to access data in particular tables, then you must
define access for the table (at either the table or table type level).
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When granting access, you must define themaximum level of access needed for the subsystem. For
example, if some users in the subsystem need full access to the GL table type, but other users need
filtered access, then you must set the GL table type to full access. The users' individual rights and role
inheritance will determine their actual level of rights within this boundary.

If a subsystem has a table filter, and a user in the subsystem is assigned a table filter (either individually
or via a role), then the subsystem filter and the user filter are concatenated using AND. This restricts the
user to only accessing data that matches both the user filter and the subsystem filter. For example, if the
subsystem filter is DEPT.Facility=5 and the user filter is DEPT.VP='Jones', then the user can only
access data for VP Jones within facility 5.

NOTE: The default maximum permission for document reference tables is full access. This is set
automatically in the subsystem whenever a new document reference table is created. Also, when you
create a new subsystem, themaximum permission is automatically set for any existing document
reference tables. This behavior is to enable the default permissions for document reference tables,
which are automatically set to full access via the Everyone role.

� Files tab
If you want users in the subsystem to be able to access a particular folder or file, then you must define
access to those folders / files.

NOTE: Remember that users do not need to be granted access to files that are configured as startup
files. If the user or role is assigned a file to open on startup, that file will be opened as a startup file,
regardless of whether the subsystem allows access to that file.

Remember that subfolders and files will inherit any permission set at a "parent" folder level (unless
permission is explicitly set for the lower level). For this reason, the effective permissions section displays
for the subsystem, so that you can select a folder or file and see any inherited permissions for that item.

Where applicable, you should attempt to specify permissions at a level that accommodates ongoing
folder and file additions. For example, if each subsystem will have its own reports folder and that is the
maximum access required, then you can define access for just that folder. If the subsystem needs access
throughout the Reports Library, then you most likely want to define themaximum access at the Reports
Library level (perhaps also explicitly blocking access to certain subfolders and files). The users' individual
rights and role inheritance will determine their actual level of rights within this boundary.

� Example
This example illustrates how subsystem maximum permissions limit users who are assigned to the
subsystem.

The following screenshot shows file group maximum permissions for a subsystem named Facility 5. For
file group Budget 2020, the subsystem is limited by the following filter: DEPT.Facility=5. Users who
belong to this subsystem can only access plan files that are assigned to Facility 5.
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Subsystemmaximum permissions

Subsystem settings do not grant any permissions; they only define a maximum boundary of
permissions. Therefore users assigned to the subsystem must also be assigned to roles or be granted
their own individual security permissions. Imagine that some users belonging to the Facility 5 subsystem
are also assigned to the Facility 5Managers role. This role grants access to all plan files within file group
Budget 2020.

Role permissions

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1249



Although the role grants access to all plan files, the subsystem is limited to DEPT.Facility=5. The users in
the subsystem cannot have greater permission than what is allowed by the subsystem (assuming the
users only belong to one subsystem). Therefore the effective permission for this user is DEPT.Facility=5.

User effective permissions once roles and subsystems are applied

Managing subsystem roles

You can create new roles for a subsystem, and you can assign existing roles to a subsystem. When a role
belongs to a subsystem, the role permissions are restricted by the subsystem boundaries, and all users
in the role must also belong to the subsystem.
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When assigning subsystem users to roles, you can use the subsystem roles or you can use "global" roles
(that do not belong to the subsystem). For more information on the difference in behavior, see About
subsystems and roles.

The subsystem settings should be completed before assigning any roles (unless the roles do not contain
any users yet), to ensure that all desired subsystem restrictions are in place before any subsystem users
log in.

� Assigning a role to a subsystem
When you create or edit a role, you can assign it to a particular subsystem. Use the Subsystem drop-
down list on theGeneral tab to assign the role to a subsystem.

l This assignment can only bemade on the role record. The Subsystem-Specific Roles section on
the subsystem record is for information only; assignment changes cannot bemade there.

l Only administrators and users with the Administer Security permission can assign an existing role
to a subsystem. If the role already has assigned users who do not belong to the subsystem when
the role is assigned to the subsystem, then a validation error displays in the Security Management
dialog. All users in the role must belong to the subsystem in order to assign the role to the
subsystem.

l Subsystem administrators can create new roles for the subsystem. When a subsystem
administrator creates a new role, it is automatically assigned to the subsystem when it is created.
If the subsystem administrator manages multiple subsystems, then the role's subsystem
assignment can be changed to any of those subsystems.

l Only administrators and users with the Administer Security permission can remove a role from a
subsystem. Click the Remove button to clear the assigned subsystem.

Managing subsystem users

You can create new users for a subsystem, and you can assign existing users to a subsystem. When a
user belongs to a subsystem, the user's permissions are limited according to the subsystem boundaries.
Users can belong to multiple subsystems.

The subsystem settings should be completed before assigning any users, to ensure that all desired
subsystem restrictions are in place before any subsystem users log in.
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If the subsystem feature is enabled, then all non-administrator users must be assigned to a subsystem. If
a user does not belong to a subsystem, then that user will be blocked from logging in (unless the user is
an administrator, a subsystem administrator, or a user with theManage Security permission). This
requirement is intended to help ensure that all non-administrator users have a subsystem limit applied
to their security permissions.

NOTE: Alternatively, you can use the Security Manager page in theWeb Client to assign users to
subsystems. For more information, seeWeb Security Manager.

� Assigning existing users to a subsystem
Administrators and users with the Administer Security permission can assign existing users to a
subsystem from either the user record or the subsystem record. Any changes made in one area are
automatically applied to the other area.

l From the subsystem record, on theGeneral tab, click the Add button in the Assigned Users
section to add a user to the subsystem.

l From the user record, on theGeneral tab, click the Add button in the Assigned Subsystems
section to assign the user to a subsystem.

Subsystem administrators cannot assign existing users to a subsystem, because subsystem
administrators can only see user records for users that are already in the subsystem. It is assumed that a
general security administrator will add existing users to the subsystem as needed. (The exception is if a
user is the subsystem administrator for multiple subsystems. In that case, if an existing user belongs to
one of the subsystems but not the other, the subsystem administrator can assign that user to the other
subsystem.)

� Creating new users for a subsystem
Subsystem administrators can create new users for use in a subsystem. When the new user is created,
the user is automatically assigned to the subsystem.

If the subsystem administrator manages multiple subsystems then one of those subsystems will be
assigned at random when the user is created. Once the user has been saved, the subsystem
administrator can edit the user to change the subsystem assignment as needed.

When creating a new user, administrators and users with the Administer Security permission must save
the new user before they are able to assign the user to a subsystem. The Assigned Subsystems box is
not editable until the user has been saved.
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� Removing a user from a subsystem
Administrators, users with the Administer Security permission, and subsystem administrators can
remove a user from a subsystem. This can be done from either the user record or the subsystem record.

l From the subsystem record, on theGeneral tab, select one or more users in the Assigned Users
section and then click the Remove button.

l From the user record, on theGeneral tab, select one or more subsystems in the Assigned
Subsystems section and then click the Remove button.

If a non-admin user is removed from all subsystems, then that user will no longer be able to log into
Axiom Budgeting and Performance Reporting. The user must be assigned to a subsystem or granted
administrator-level permissions before they are able to log in again.

Bulk edit of security
You can manage users, roles, and subsystems in bulk by using theOpen Security in Spreadsheet
feature. You can edit, add, and deletemultiple users, roles, and subsystems simultaneously within a
spreadsheet interface.

Only users with access to security can use this feature: administrators, users with the Administer
Security permission, and subsystem administrators. The spreadsheet is limited as appropriate
depending on the user's rights.

The following items cannot be edited in the spreadsheet interface; you must use the Security
Management dialog for these items:

l File and folder access to any Axiom library (settings defined in the Files tab)
l Startup documents (settings defined in the Startup tab)

� Opening security in a spreadsheet
To manage security in a spreadsheet:

1. On the Axiom tab, in the Administration group, click Security > Open in Spreadsheet.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Open in Spreadsheet.

TheOpen Security in Spreadsheet dialog opens.

2. At the top of the dialog, specify how you want users and roles presented in the spreadsheet:
l Horizontally (default): Users, roles, and subsystems are displayed horizontally across

columns. The security settings are displayed in rows.
l Vertically: Users, roles, and subsystems are displayed vertically down rows. The security

settings are displayed in columns.
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3. Optional. If you want to limit the security settings that display in the spreadsheet, modify the
check boxes in the Select items to include section.

For example, you might only want to work with a particular file group or table type. General user
and role properties (such as name, email, etc.) are always included in the spreadsheet.

Clear the check boxes for any items that you do not want to display in the spreadsheet. You can
select or clear items by major category (File Groups, Tables, etc.), or you can expand themajor
categories to select or clear the individual items (such as individual file groups).

4. Optional. If you want to filter the users that display in the spreadsheet, select the Filter users
check box. By default, the spreadsheet displays all users, roles, and subsystems for the current
system.

If Filter users is checked, you can specify the following options to filter users:

Item Description

Include users
who are

Select the following options to include those users in the spreadsheet:

l Enabled users
l Disabled users
By default, both options are selected, which means that both enabled and
disabled users will be included in the spreadsheet.

If both options are cleared, then only roles (and subsystems, if applicable)
will be included in the spreadsheet.

Include users in
these roles

If you want to only view users that belong to specific roles, select the check
boxes for those roles. You can also choose to view users who do not
belong to any roles. You can use the Select All and Clear All links to select
or clear all roles.

This selection also limits the role records that will be included in the
spreadsheet.

Include users
from these
subsystems

If you want to only view users that belong to specific subsystems, select
the check boxes for those subsystems. You can also choose to view users
who do not belong to any subsystems. You can use the Select All and
Clear All links to select or clear all roles.

This also limits the subsystem records that will be included in the
spreadsheet.

This option only displays if subsystems are enabled for your system.

Selections from multiple categories will be combined. For example, if you select role Finance and
subsystem 5, then the spreadsheet will contain all users that are in either the Finance role or
subsystem 5 (not users who only belong to subsystem 5 and the Finance role).

5. Click OK.
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The spreadsheet opens with the selected security options.

Example security spreadsheet (horizontal orientation)

� Editing existing records
To edit the settings for a user, role, or subsystem, make changes directly in the spreadsheet. See the
following section Security settings in the spreadsheet interface for more information on editing settings
within the spreadsheet interface.

NOTE: You cannot edit user login names or role and subsystem names within the spreadsheet
interface. If the name is changed, it will be saved as a new record, and the existing record will be
unchanged.

For subsystem administrators, only users and roles that belong to their assigned subsystems are
brought into the spreadsheet. Subsystem settings are not brought into the spreadsheet.

� Adding new records
You can add new users, roles, and subsystems within the spreadsheet interface.

To add a new user, type the new user's login name in an empty cell in row 1 or column A (depending on
the spreadsheet orientation), and then complete the desired security settings for that user. Note the
following:

l Last name, first name, and email address are required for new users. If these items are blank, a
save error will result. Other user properties such as license type and authentication type will use
the same default values as when adding a new user in the Security Management dialog.

l You can type a password or leave the password blank. If left blank, the user will be assigned a
randomly generated password.

To add a new role, type the role name in an empty cell in row 1 or column A (depending on the
spreadsheet orientation), prefixed by "role:". For example, type role:MyRole. If the name is not
prefixed by "role:", then it will be interpreted as a user login name. Note the following:

l No other settings are required to save a role.
l To assign users to the new role within the spreadsheet interface, you must add the role name to

each individual user. There is no option to add users directly to the role record, like you can within
the Security Management dialog.

NOTE: Adding subsystems works the sameway as adding roles, except the subsystem namemust be
prefixed by "subsystem:". For example, subsystem:MySubsystem.
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When adding new users, roles, or subsystems to the spreadsheet, all settings must be typed (or copied
and pasted from other records). Drop-down lists are only available when editing existing records. For
more information on the valid inputs for the settings, see the following section Security settings in the
spreadsheet interface.

Users who are subsystem administrators can only create new users and roles. The new users and roles
must be assigned to their subsystem.

� Deleting records
You can delete users, roles, and subsystems within the spreadsheet interface. To delete a user or role,
set Delete to Yes.

NOTE: When editing security in a spreadsheet, you can delete a role or a subsystem regardless of
whether any users are assigned to it. The users will be updated to remove the assignment.

Users who are subsystem administrators can only delete users and roles that belong to their subsystem.

� Saving changes
To save changes made in the spreadsheet:

l On the Axiom tab, in the File Options group, click Save.

A confirmation prompt lists the number of users, roles, and subsystems that you are about to update,
create, or delete.

Settings are validated before the save occurs. If errors are found, they are displayed in the Save Errors
pane. Any errors must be resolved before the save can occur.

After a successful save, you will be prompted to refresh the spreadsheet to bring in themost recent data.

� Security settings in the spreadsheet interface
The following is a reference for completing or editing security settings via the spreadsheet interface.

NOTES:
l If an item is not explicitly discussed here, its input is the same as in the Security Management

dialog. This section only discusses items that are completed differently than in the Security
Management dialog.

l Most check boxes in the Security Management dialog correspond to TRUE (checked) and
FALSE (unchecked) in the spreadsheet interface. Any deviations are noted in the following
table.
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For more information on the purpose of each security setting, see Security settings for users, roles, and
subsystems are organized by tabs in the Security Management dialog. The following tabs are available:.

Item Description

Login, role,
or
subsystem

The user's login name, the role's name, or the subsystem's name.

Role names must be prefixed by role:. Subsystem names must be prefixed by
subsystem:. For example, to create a role named Finance, type role:Finance.

If users have been imported from Active Directory, those user names are prefixed
with the Active Directory domain. For example: Corporate\JDoe.

NOTE: You cannot rename existing records using the spreadsheet interface. If a
name is changed, it is interpreted as a new record.

Delete Select Yes if you want to delete the record. Otherwise, leave the default ofNo.

General This section works the sameway as the Security Management dialog, with the
following exceptions:
l Role assignments: For users, you can view and edit the list of roles that the user

is assigned to. Each role name is separated by a semicolon. (The same thing
applies to subsystem assignments if subsystems are enabled.)

l User assignments: For roles, you cannot view or edit the list of assigned users in
this interface. If you want to view all users assigned to a role or edit this list from
the role perspective, then you must use the Security Management dialog.

NOTE: The password display is always blank. You can change a user’s password by
entering a new password. When you save and then refresh the spreadsheet, the
password field will return to blank.

Permissions For users, specify one of the following:
l Inherit: The user will inherit the permission from any role assignments.
l True: The user is explicitly granted this permission; role inheritance is ignored.
l False: The user is explicitly denied this permission; role inheritance is ignored.

For roles and subsystems, specify either True or False.

File Groups This section works the sameway as the Security Management dialog, with the
following exceptions:
l FGName [calc method permission]: This item combines the Allow Calc Method

Insert and Allow Calc Method Change options from the Security Management
dialog. Valid entries are Insert, Change, or Insert/Change.

l FGName [create new records]: This item is listed for all file groups, but only
applies to on-demand file groups. A save error will result if this item is set to TRUE
for a standard file group.

l If a user has multiple permission sets, only the first set can be edited within the
spreadsheet interface.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1257



Item Description

Tables and
Table Types

All table types are listed first, followed by all individual tables.

If [write filter enabled] is False for a table or table type, this means that the user or
role's write access permissions are the same as their read permissions. In this case,
the other write access permissions in the spreadsheet can be ignored, because they
do not apply.

For example, the following user has full read and write access to the GL table type,
because [full read access] is True and [write filter enabled] is False. Even though
[full write access] displays False, it does not matter because the setting does not
apply.

If [write filter enabled] is True, then the [full write access] permission and the
[write filter] permission determine the user's level of write permissions.

Security tools
Axiom Budgeting and Performance Reporting provides security tools to control and monitor user access
to Axiom Budgeting and Performance Reporting.

Viewing the list of logged in users

Administrators can view a list of users who are currently logged into the system. For example, you may
want to check to make sure that nobody is logged into the system before performing actions such as
system upgrades.

For each user that is currently logged in, the list displays information such as:
l Full name and user name (login name)
l Email address
l Computer where the user is logged in
l Date and time the user logged in
l Date and time of the user's last activity during the session

The list of logged in users is for information purposes only—you can see whether any users are logged in,
but you cannot manually log them off and end their sessions.
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NOTE: Axiom Budgeting and Performance Reporting maintains a log of all login attempts, including
failed logins. Currently there is no user interface to view this information, but it can be accessed
directly in the system database in the SystemAccess table. For assistance, please contact Axiom
Budgeting and Performance Reporting Support.

To view the list of logged in users:
l On the Axiom tab, in the Administration group, clickManage > Security > Logged in Users.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Logged in Users.

The Currently Logged In Users dialog opens, listing the users who are logged into this system. You can
sort and filter the list using standard Axiom grid functionality.

� Orphaned session records
When a user logs off normally, their session record is removed from the Logged in Users list. If a user's
session ends unexpectedly—for example, due to a software crash or shutting down the computer
without logging off—then the session record will be removed from the list after a fewminutes, once the
session no longer "reports back" to the Axiom Application Server.

NOTE: For Web Client sessions, closing the browser window does not automatically log out the user.
In this case, the orphaned Web Client sessions will be automatically removed from the list in a few
minutes as described above.

Axiom Budgeting and Performance Reporting does not automatically remove any session records based
solely on time logged in. As long as the session remains connected and continues to report back to the
application server, the session will continue to be listed indefinitely.

� Removing session records
If desired, you can manually remove any logged in records by selecting the record in the list and clicking
Remove. This simply removes the record from the list; it has no impact on any user's session. If a user is
actually logged on and you remove their session record, the user will remain logged on.

In most cases this action should not be necessary, because sessions that are truly invalid will be
automatically removed from the list in a fewminutes as described above.

Enabling password rules

By default, Axiom Budgeting and Performance Reporting enforces a basic set of password rules. These
rules apply to users assigned to Axiom Prompt authentication.

The built-in password rules are as follows:
l Must be at least 8 characters long
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l Must contain at least 1 upper-case letter and at least 1 lower-case letter
l Must contain at least 1 non-alphabetic character (a number or a symbol)

The password rules are only enforced when creating new passwords. If any existing passwords do not
meet these rules, those passwords will continue to be valid.

When the password rules are enabled, a Generate Password link is available on the Set Password dialog
so that you can generate a random password that meets these rules. (This feature is not available if the
password rules are changed from the built-in rules; see the note below.)

Password rules are enabled or disabled by using the system configuration property
EnablePasswordPolicy. This setting is True by default. If you do not want to apply these rules, you can
disable the setting by changing it to False, which means that any password is considered valid. You can
do this by using the SoftwareManager, or by using a Save Type 4 report that has been set up to modify
the system configuration table. Only administrators can modify system configuration settings.

NOTE: The system configuration settings contain two additional options related to
EnablePasswordPolicy. PasswordRegularExpression defines the password rules, and
InvalidPasswordMessage defines the error message displayed if a new password does not meet the
rules. Axiom Budgeting and Performance Reporting does not currently provide a methodology for
clients to change the password rules from the built-in rules, therefore, these two options should not
be changed from their default settings. If you have a need to use different password rules, please
contact Axiom Budgeting and Performance Reporting support for assistance.

Testing user security

Administrators and other users who manage security may need to log into Axiom Budgeting and
Performance Reporting as other users, in order to test security permissions. For example, you may
define a table access filter for a particular security role. In order to test that the filter is providing access to
table data as expected, you can log in as a non-admin user who belongs to that role.

Using the Security Management dialog, you can "log in as" another user, for the purposes of testing their
security settings.

To log in as a different user:
1. On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

2. In the Security Management dialog, select the user whom you want to log in as. The following
limitations apply:

l Subsystem administrators can only log in as users who belong to their subsystem.
l If a user is an administrator, subsystem administrators and users with the Administer
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Security permission cannot log in as that user.
l The "log in as" feature cannot be used with users who are Axiom Support users.

3. In the lower left-hand corner, click Log in as selected user.

A new instance of Axiom Budgeting and Performance Reporting is launched, and you are automatically
logged in as the selected user—you do not need to input a user name and password. The client version
for the instance is whichever client version you are currently using (Excel Client or Windows Client).

Creating a permission report

You can create a report that details the effective security permissions for each user, for a particular file
group or for all tables. This report may be useful for auditing purposes and for reviewing permissions to
make sure they are set as intended.

The report is created as an Excel file. Once it is created, you can print it, or save it locally or within the
Axiom file system as needed.

Only administrators and users with the Administer Security permission can create a permission report.
Subsystem administrators do not have access to this feature.

� File group permission report
The file group permission report is created on a per file group basis. When you create the report, you
specify which file group you want to report on.

Each user defined in the system has at least one row in the report:
l If the user is an administrator, then the user has one rowwith a notation of: (Admin-Full Access).
l If the user has no access to the file group, then the user has one rowwith a notation of: (No

Access).
l If the user has access to all plan files in the file group via a single permission, then the user has one

rowwith a notation of: All Plan Files.
l In all other cases, the user has multiple rows in the report—one row for each individual plan file

that they have access to. Each row details the user's permissions to that particular plan code,
including the access level, calc method permissions, ability to save data, etc.

For example, if a non-admin user with access to the file group has permission to 3 plan files, then there
will be 3 rows in the report for that user, one for each plan file.

The permissions displayed in the report are the full effective permissions of the user, taking into account
all factors such as admin status, role inheritance, multiple file group permission sets, and subsystem
restrictions.

NOTE: Permissions granted by process ownership are not reflected in this report. Users may be
temporarily "elevated" to read/write and save data status when they are the assigned owner of an
active process task for a particular plan file.
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To create a file group permission report:
1. On the Axiom tab, in the Administration group, clickManage > Security > File Group Permission

Report.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > File Group Permission Report.

2. In the Permission Report dialog, select the file group for which you want to create the report, and
then click OK.

The report opens as an Excel spreadsheet file. The file group it was generated for and the current
date/time are noted at the top of the report. Excel’s auto-filtering is automatically applied to the columns
to make it easier to sort and filter the data.

� Table permission report
The table permission report details user permissions per table. All tables are included in the report; it is
not possible to filter by a particular table or table type.

Each user defined in the system has at least one row in the report:
l If the user has full access to all tables, then the user has one rowwith a notation of: (Full access to

all tables).
l If the user has no access to any tables, then the user has one rowwith a notation of: (No access

to any tables).

NOTE: It would be a rare situation for a user to have no access to any tables, because by
default all users are granted access to document reference tables using the Everyone role.

l In all other cases, the user has multiple rows in the report—one row for each table that they have
access to. Each row details the user's read and write permissions to that particular table. If a table
is not listed, then the user does not have access to that table.

For example, if a user has access to 5 tables, then there will be 5 rows in the report for that user, one for
each table.

The permissions displayed in the report are the full effective permissions of the user, taking into account
all factors such as admin status, role inheritance, table type inheritance, and subsystem restrictions.

To create a table permission report:
l On the Axiom tab, in the Administration group, clickManage > Security > Table Permission

Report.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > File Group Permission Report.
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The report opens as an Excel spreadsheet file. The current date/time are noted at the top of the report.
Excel's auto-filtering is automatically applied to the columns to make it easier to sort and filter the data.

Web Security Manager

Using the Security Manager in theWeb Client, you can assign users to subsystems and roles. This feature
provides a browser-based, easy-to-use interface for managing role and subsystem assignments.

Example Security Manager in the Web Client

In Axiom Budgeting and Performance Reporting security, subsystems and roles are used as follows:
l Subsystems are used to organize a system into certain "areas" of access. Axiom Budgeting and

Performance Reporting product suites use subsystems to define security boundaries by product,
such as Capital Planning and Budgeting.

l Roles are used to assign permissions to users. You can define permissions on a role, and then all
users assigned to that role inherit the permissions. Roles can be associated with a particular
subsystem, or they can be "global" roles.

NOTE: The functionality of this page is limited to assigning users to subsystems and roles. This page
does not support creating or deleting users, roles, or subsystems, nor does it support editing
security permissions. For full security functionality, you must use the security features of the
Desktop Client.

To access the web Security Manager:

1. In theWeb Client, click themenu icon in the Global Navigation Bar. From the Area menu,
select System Administration.
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2. From the Navigation panel, select Tools > Security Manager.

Alternatively, you can go directly to the Security Manager page as follows:

Example Cloud
URL

https://ClientName.axiom.cloud/ax/SecurityManager

Where ClientName is the name of your Axiom Cloud system.

Example On-
Premise URL

http://ServerName/Axiom/ax/SecurityManager

Where ServerName is the name of the Axiom Application Server, and Axiom is
the default name of the virtual directory.

NOTE: The Security Manager is only available to administrators, subsystem administrators,
and users with the Administer Security permission.
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� Security Manager overview
The left-hand pane of the Security Manager displays the users in your system. Once you have selected a
user, that user's subsystem and role assignments display in the right-hand pane. You can use the right-
hand pane to add, edit, or remove assignments.

To find users for which you want to manage assignments, you can do the following:
l View only enabled users: Select Show Enabled Users Only to hide disabled user accounts. To

view all users again, clear this check box.

l View users in a specific subsystem: To filter the user list by subsystem, select a subsystem from
the Subsystem drop-down list. The page updates to only show users that are assigned to the
selected subsystem. To show all users again, select Show All from the Subsystem drop-down list.

NOTE: If your system does not use the subsystem feature, then this option is not present.
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l Find a specific user: Type into the search box and then press the Enter key to find a specific user.
The user's first name, last name, and email address are considered for the search. To show all
users again, clear the search text and press the Enter key.

The user list shows 100 users per page. You can use the page controls at the bottom of the list to move
to specific pages in the list.

IMPORTANT: If you make any changes in the Security Manager, you must click the Save button at
the top of the page in order to commit those changes. Any changes that are not explicitly saved will
be lost when you navigate away from the page or close the browser tab. Note that the page does not
prompt you about unsaved changes when you attempt to leave the page.

� Managing subsystem assignments for a user
Use the Subsystem Assignments section in the right-hand pane to assign the selected user to one or
more subsystems, or to remove a subsystem assignment. Once a user is assigned to a subsystem, you
can edit that assignment to add or remove roles in the subsystem.

NOTE: If your system does not use subsystems, then this section does not apply and is not present
on the page.

To assign a user to one or more subsystems and subsystem roles:
1. In the left-hand pane of the Security Manager, select the user. You can use the features described

in the previous section to find the user that you want to work with.

Once a user has been selected, that user's current role and subsystem assignments display in the
right-hand pane. In the following example, the user does not yet belong to any subsystems.
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2. In the Subsystem Assignments section, click Add User to Subsystems.

3. In the Add To Subsystem dialog, select the toggle switch next to the subsystems that you want
the user to be assigned to, then click OK. If the toggle switch shows green, the user will be
assigned to that subsystem.

If the user already belongs to one or more subsystems, those subsystems showwith a gray check
mark next to the subsystem name. You can only add the user to subsystems that they do not
already belong to. This dialog cannot be used to remove subsystem assignments.

After you click OK, the selected subsystems now display in the Subsystem Assignments section.
You can now edit these assignments as needed to add subsystem roles.
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4. Click the pencil icon for the subsystem where you want to add role assignments.

5. In theManage Subsystem Roles dialog, select the toggle switches next to the roles that you want
the user to be assigned to, then click OK. If the toggle switch shows green, the user will be
assigned to that subsystem.

This dialog displays all roles that are associated with the selected subsystem.

After you click OK, the subsystem assignment updates to show the assigned subsystem roles for
the user.
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6. Click Save to commit the subsystem and role assignments. Changes to this page are not
committed until they are saved.

Once a user has been assigned to a subsystem and subsystem roles, you can later modify the role
assignments, or you can remove the user from the subsystem as needed.

l To modify subsystem role assignments: Click the pencil icon on the subsystem to open the
Manage Subsystem Roles dialog, then use the toggle switches to add or remove role assignments
as needed.

l To remove a user from a subsystem: Click the trash can icon on the subsystem to remove the
user from the subsystem. The user will also be automatically removed from all of the subsystem's
roles.

Remember to click the Save button after making any modifications to subsystem and subsystem role
assignments.
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� Managing global role assignments for a user
Use the Global Role Assignments section in the right-hand pane to assign the selected user to one or
more global roles, or to remove a role assignment. Global roles are roles that are not associated with a
subsystem.

NOTE: If your system does not use subsystems, then the word "global" does not display on this
section, because there is no need to differentiate between global roles and subsystem roles.

To assign a user to one or more global roles:
1. In the left-hand pane of the Security Manager, select the user. You can use the features described

previously to find the user that you want to work with.

Once a user has been selected, that user's current role and subsystem assignments display in the
right-hand pane. In the following example, the user does not belong to any global roles.

2. In theGlobal Role Assignments section, click Add User to Global Role.

If your system does not use subsystems, then the section is titled Role Assignments and the
action is Add User to Role.

3. In the Add Global Role dialog, select the toggle switch next to the roles that you want the user to
be assigned to, then click OK. If the toggle switch shows green, the user will be assigned to that
role.

If your system does not use subsystems, then this dialog is titled Add Role.
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If the user already belongs to one or more roles, those roles showwith a gray check mark next to
the role name. You can only add the user to roles that they do not already belong to. This dialog
cannot be used to remove role assignments.

After you click OK, the selected roles now display in the Global Role Assignments section.

4. Click Save to commit the role assignments. Changes to this page are not committed until they are
saved.

To remove a user from a global role:
l Click the trash can icon on the role assignment. Remember to click Save after making any changes.

� Limitations for subsystem administrators
If you are a subsystem administrator, the Security Manager page has some limitations. These limitations
are consistent with the behavior of the Security Management dialog in the Desktop Client.

l The user list is limited to only showing users that belong to one of the subsystems that you
administer.

l The subsystem list is limited to only showing subsystems that you administer. This applies to the
Subsystem filter and the Add To Subsystem dialog.
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This means that as a subsystem administrator, you are limited to managing users that already belong to
one of the subsystems that you administer. If a user does not belong to any subsystems, or if a user
belongs to a subsystem that you do not administer, then that user will not display in the web Security
Manager. In this case, if the user needs to be assigned to your subsystem, a system administrator or a
user with the Administer Security permission must make this assignment.

Security Integration
Axiom Budgeting and Performance Reporting can integrate with your organization's existing network
security. You can:

l EnableWindows Authentication for user authentication against your Windows domain, including
the option to import users from Active Directory.

l Enable LDAP Authentication for user authentication against your LDAP server.
l Enable SAML Authentication for user authentication against a SAML identity provider.
l Enable OpenID Authentication for user authentication against an OpenID provider.

NOTE: This guide discusses how to set up and use security integration features once they have been
enabled for your system. For information on enabling the associated system configuration settings,
see the System Administration Guide.

Using Windows Authentication

You can enableWindows Authentication for a system, to authenticate users based on their Windows
domain credentials.

� Windows Authentication behavior
When the Axiom Budgeting and Performance Reporting login screen displays, users must enter their
Windows user name, domain, and password. If the domain is an allowed domain and theWindows user
namematches a user name in Axiom Budgeting and Performance Reporting, then the credentials are
passed to Windows for authentication into Axiom Budgeting and Performance Reporting.

If theWindows Authentication configuration for Axiom Budgeting and Performance Reporting only
allows one domain, then that domain is assumed for authentication and users do not need to specify it
when logging in. If multiple domains are allowed, then the domain must be specified in one of the
following ways:

l The user must include the domain with their user name, such as: DomainName\UserName.
l The user must specify the appropriate domain using theDomain selection list on the login screen.

This is an optional setting that can be enabled for your installation. For more information, see
Domain selection list.

Users must enter their credentials each time they log in, unless they select Remember me to store their
credentials for future use. For more information, see Remember me.
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� Setting up Windows Authentication
The following summarizes the setup process for Windows Authentication.

1. Windows Authentication must be enabled for the system.

For on-premise systems, Windows Authentication can be enabled during the Axiom Application
Server installation. If it was not enabled during the installation, you can configure it later using
either of the following options:

l Use the Configure Authentication Methods page of the Axiom SoftwareManager. For
more information, see the Installation Guide.

l Use a Save Type 4 report to modify the applicable system configuration settings
(WindowsAuthEnabled andWindowsAuthAllowedDomains).

When you enableWindows Authentication, you must specify the valid domains for
authentication. You can specify multiple domains, separated by commas. You can also choose to
enable Active Directory Synchronization if you want to import and synchronize users from Active
Directory (for more information, see Synchronizing users with Active Directory).

For Axiom Cloud systems, Axiom Support will enableWindows Authentication for you as part of
the system setup, if that is your chosen authentication method.

2. In security, Axiom Budgeting and Performance Reporting users must be set up as follows to
support Windows Authentication:

l The user's Axiom Budgeting and Performance Reporting login namemust match their
Windows login name.

l The user's Authenticationmethod must be set toWindows User. This is the default setting
for new users ifWindows Authentication is enabled for your installation.

If users are imported from Active Directory, then they will automatically be created with the
appropriate login name and authentication type.

3. Axiom Cloud systems have the following additional requirements:
l Installation of the Cloud Integration Service is required to enable the Axiom Cloud system

to communicate with your localWindows domain, to validate user credentials. For
information on installing the Cloud Integration Service, see the Axiom Cloud Technical
Guide and contact Axiom Support as needed.

l A remote data connection must be created in Scheduler, with the option Use for
authentication service enabled.

All users who are assigned to theWindows Authentication method will be authenticated based on their
Windows credentials. This is the only way that these users can log in—they cannot log in using an
internal Axiom Budgeting and Performance Reporting password.

If you need to test the security settings of a Windows Authentication user, you can use the Log in as
selected user feature to log in to Axiom Budgeting and Performance Reporting as that user. For more
information, see Testing user security.
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� Adding or removing domains for Windows Authentication
If theWindows domain names used by your organization for authentication have changed, you must
update the list of allowed domains in Axiom Budgeting and Performance Reporting. Users can only log
into Axiom Budgeting and Performance Reporting using Windows Authentication if their domain name
matches one of the allowed domain names in this list. The list of allowed domains is stored in the system
configuration settings (WindowsAuthAllowedDomains).

For example, when Windows Authentication was originally configured, you may have been using a
domain named CompanyA. After a merger or reorganization, some or all of your users may now be using
a domain named CompanyB. If those users need to log in to Axiom Budgeting and Performance
Reporting, you must add CompanyB to the list of allowed domains. You might leave CompanyA on the
domain list if your organization is actively using both domains, or you might remove it if your
organization has completely switched to using the CompanyB domain.

The list of allowed domain names for Windows Authentication can bemanaged in the AxiomWeb Client,
on the System Configuration page.

To add or remove a domain name for Windows Authentication:

1. In theWeb Client, click themenu icon in the Global Navigation Bar. From the Area menu,
select System Administration.

2. From the Navigation panel, select System Status > System Configuration.
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Alternatively, you can go directly to the System Configuration page as follows:

Example Cloud
URL

https://ClientName.axiom.cloud/Admin/SystemConfiguration

Where ClientName is the name of your Axiom Cloud system.

Example On-
Premise URL

http://ServerName/Axiom/Admin/SystemConfiguration

Where ServerName is the name of the Axiom Application Server, and Axiom is
the default name of the virtual directory.

3. On the System Configuration page, locate the row forWINDOWSAUTHALLOWEDDOMAINS, and
then click Edit.
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When you click the Edit button, the Value field on the row becomes editable.

4. Modify the list of domains as needed to add or remove domain names. Multiple domain names
must be separated with commas.

For example, if the list is currently CompanyA, and you need to keep CompanyA but add new
CompanyB, edit the domain names as follows:

5. Click Update to save and apply your changes. The Value field now shows your edited list.

The changed list of domain names takes effect immediately after saving. If you removed a domain name,
users in that domain can no longer log in using Windows Authentication. If you added a domain name,
users in that domain can now log in using Windows Authentication.

Synchronizing users with Active Directory

You can import users from Active Directory, to automatically create users within Axiom Budgeting and
Performance Reporting and assign them to the appropriate roles. Subsequent imports can be used to
create new users and synchronize previously imported users.

Active Directory synchronization can only be used in conjunction with Windows Authentication. For
more information, see Using Windows Authentication.

To set up Active Directory synchronization:
1. Enable Active Directory synchronization for your system.
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For on-premise systems, Active Directory synchronization can be enabled during the Axiom
Application Server installation. If it was not enabled during the installation, you can configure it
later using either of the following options:

l Use the Configure Authentication Methods page of the Axiom SoftwareManager. For
more information, see the Installation Guide.

l Use a Save Type 4 report to modify the applicable system configuration setting
(WindowsAuthUserSyncEnabled).

For Axiom Cloud systems, Axiom Support can enable Active Directory synchronization for your
system.

2. Create a job in Scheduler with an Active Directory Import task, and schedule the job to run
periodically as needed for your environment.

Each import task can import users from a single Active Directory domain into the current Axiom
Budgeting and Performance Reporting system. The import task specifies the Active Directory
domain and groups to import, role mappings, and notification settings. If you need to import
from multiple Active Directory domains, then you must create an import task for each domain.

For more information, see Creating a Scheduler job to import users from Active Directory.

When the Scheduler job is run, new users are created as needed and existing users are synchronized with
Active Directory. For more information, see HowActive Directory user synchronization works.

Creating a Scheduler job to import users from Active Directory

Once Active Directory synchronization has been enabled for your system, you must create a Scheduler
job in order to import users from Active Directory into Axiom Budgeting and Performance Reporting.

The Scheduler job must contain an Active Directory Import task. Each import task can import users from
a single Active Directory domain into the current Axiom Budgeting and Performance Reporting system.
The import task specifies the Active Directory domain and groups to import, and role mappings for those
groups. When setting up the job, you can configure a scheduling rule so that it runs nightly, weekly, or
whatever frequency is appropriate for your organization.

If you need to import users from multiple Active Directory domains, then you must create an import task
for each domain. You can create a single Scheduler job with multiple import tasks, or you can separate
the import tasks into multiple Scheduler jobs. If all of the import tasks can use the same schedule, then it
is easiest to create a single job with multiple tasks.

For Axiom Cloud systems, the Active Directory Import task can import users from your local Active
Directory by use of the Axiom Cloud Integration Service. If you have a remote data connection that is
enabled for user authentication, this task will use that connection when the job is executed by Scheduler.
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� Before you begin
Before creating the job, you should make sure you are prepared with the following information:

l The name of your Active Directory domain, or the server name that hosts Active Directory. You
will need to specify one of these to identify the source domain for the import.

l The user credentials to use to access Active Directory. You can specify a user name and
password, or you can use the credentials of the Axiom service that is performing the process.

l The groups to import from Active Directory. You must know the names of the groups that you
want to import from Active Directory. All users in the selected groups will be imported into Axiom
Budgeting and Performance Reporting. If you do not have groups that exactly correspond with
the users that you want to create in Axiom Budgeting and Performance Reporting, you may need
to work with your Information Technology department to create new groups or refine existing
groups.

l The Axiom Budgeting and Performance Reporting roles, subsystems, user license types, and
authentication types for each imported group.When users are imported, they can be
automatically assigned to one or more roles and subsystems in Axiom Budgeting and
Performance Reporting, and assigned a user license type and an authentication type. Make sure
you knowwhich options to use.

� Creating the job
In order to create a Scheduler job, you must be an administrator or have the Scheduled Jobs User
security permission. Non-admin users must also have read/write access to at least one folder in the
Scheduler Jobs Library.

Scheduler jobs can only be created in the Desktop Client. Although you can view the status of existing
jobs in theWeb Client, you cannot create new jobs in that environment.

IMPORTANT: The Active Directory Import task can only be executed by a user who has permission to
create users in security—an administrator, a subsystem administrator, or a user with the Administer
Security permission. If you plan to schedule the job for automated execution, the job owner must
have the required permissions to execute the task. The job owner is the user who last saved the job.
Effectively, this means that the job must be created by a user with the required permissions. If the
job is created by a user who does not have the required permissions, then the job must be saved by
a user with the required permissions in order to re-set the job owner. You can see the current job
owner for the job in the Job Variables section of the job properties.

To create an Active Directory Import job in Scheduler:
1. On the Axiom tab, in the Administration group, clickManage > Scheduler.
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Scheduler on default Axiom ribbon tab

In systems with installed products, this featuremay be located on the Admin tab. In the System
Management group, click Scheduler.

Scheduler on Admin tab (example product ribbon)

2. In the Scheduler dialog, click New.
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A new job is opened in the dialog, with a tab name ofNew Job.

3. Click Add > Active Directory Import to add the task to the new job.

The task is added to the job, and you can now configure the task properties. In the Task Details
section, the task has three tabs: Source Directory, Notification, and Preview Import.
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4. On the Source Directory tab of the Task Details, select either Domain or Server to specify the
source domain for the import.

l If you select Domain, enter the name of the domain.
l If you select Server, enter the name of the domain controller server.

The server option is available in case you are not currently logged into the source domain, and
your current domain does not have access to the source domain. In this case, you must use
domain credentials in order to access the source domain.

Only one domain can be selected per import task. If you want to import users from multiple
domains into an Axiom Budgeting and Performance Reporting system, then you must create
multiple import tasks.

5. For Credentials, specify the user credentials to use when accessing Active Directory for the import.
Select one of the following:

l Use process credentials: (Default) Use the credentials of the network service account for
Axiom Scheduler Server (on-premise installations) or Axiom Cloud Integration Service
(Axiom Cloud systems).

l Specify domain credentials: Enter the credentials of a specified domain User and
Password. This option is required if you identified the source domain using the server name
instead of the domain name.
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6. If you do not want new and synchronized users to be automatically enabled by the import, select
Never Enable Users. This option works as follows:

l If unchecked (default), then newly imported users are enabled as part of the import.
Additionally, any existing imported users who have been changed to disabled are re-
enabled.

l If checked, then newly imported users are not enabled as part of the import. A security
administrator must modify the security settings after the import is complete to enable the
new users. Existing imported users retain their current enabled status.

We recommend enabling this option because in most cases it is necessary for a security
administrator to make further changes to security settings before the user account is fully ready
for use. Additionally, if your system uses subsystems, any newly imported users will not be able to
log in anyway, since the import does not assign users to a subsystem.

7. In theGroups to import section, click Add to select one or more groups to import.
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The Select Groups dialog opens, displaying a list of groups from the source domain.

l Select the group or groups that you want to add, and then click OK. You can use the search
box at the top of the dialog to find a group by name. You can use the SHIFT or CTRL keys to
select multiple groups in the list.

l The selected group(s) display in theGroups to import box. If you have added a group by
mistake, you can select it and click Remove.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1283



8. In theGroups to import section, click Role Mapping to define the role mappings for each selected
group:

l In the Role Mapping dialog, click the Add mapping icon in the top right to add a
mapping row to the dialog.
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l In themapping row, select a Directory Group to map, then select the following:
o The Axiom Role that you want the users to belong to. You can select None if you do

not want the users to be assigned to a role.
o The Subsystem that you want the users to belong to. This option is only present if

subsystems are enabled for your system.
o TheUser Type for the users. This means license type, such as a Standard license or a

Viewer license.
o The Authentication Type for the users,Windows User or SAML. If you want to use a

different authentication type, then you must update the users after importing to
assign them to the desired authentication type. You may be able to create a Save
Type 4 report to Axiom.Principals to update the users, and process that report
within the same Scheduler job, after the Active Directory import task is performed.
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l Repeat these steps for each group to be imported. If you want the users in a group to
belong to more than one role and/or subsystem, you can createmultiple mapping rows for
that group. If you need to remove a mapping row, select it and then click the Remove
mapping icon in the top right of the dialog.

l When you are finished defining mappings, click OK to return to the Scheduler task
properties.

The defined role mappings do not display in theGroups to import box. If you want to review or
edit the role mappings, click Role Mapping.

NOTES:
l If a group has multiple mapping rows to assign the users to multiple roles and/or

subsystems, then the specified user type and authentication type should be the same
on each row. If the user type or authentication type is different, then the entry on the
last processed mapping will be used.

l If a group has no defined role mappings, then the users will not be assigned to any roles
or subsystems. If the import creates new users without role mappings, the assigned
user type is Standard and the assigned authentication type is Windows User.

9. On theNotification tab of the Task Details, enter one or more email addresses to send a
notification when users have been added or synchronized due to running the Active Directory
Import task. Separatemultiple addresses with a semi-colon.
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When the import task is run, if any users are created or modified in the Axiom Budgeting and
Performance Reporting system, an email notification will be sent to the addresses specified here.
The email summarizes the changes made. This email notification is independent of any job-level
notification settings (which notify based on overall job completion or failure).

We recommend setting up this task-level notification to send emails to the security administrator
(s) responsible for maintaining the security settings in Axiom Budgeting and Performance
Reporting, so that he or she can define security settings for newly added users, validate changes
made to existing users, and perform any other follow-up tasks.

10. On the Preview Import tab of the Task Details, click Preview to see the changes that will bemade
to Axiom Budgeting and Performance Reporting Security when the Active Directory Import task is
run.

The preview feature is intended to help you verify that you have set up the task correctly. If the
reported changes are not as you expect, then you can review and adjust the task settings as
needed. No changes aremade to security when preview is run.

This completes the settings for the Active Directory Import task. However, there are a few general
job properties that should also be reviewed and completed as needed.
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11. In the left-hand pane, click Scheduling Rules. Using this section, you can define a scheduling rule
so that the job runs automatically as needed. Typically, organizations want the Active Directory
Import task to run regularly so that users are kept in sync.

Click Add to add a scheduling rule to the job, and then complete the rule as needed based on your
desired schedule. In the following example, this job will run Monday through Friday at 11:00PM.

12. In the left-hand pane, click Notification. Using this section, you can configure the notification
settings for the overall Scheduler job. The job-level notifications are intended to inform interested
parties when the job completes successfully or has errors. These notifications do not contain any
information about user changes to Axiom Budgeting and Performance Reporting Security—to
inform someone about specific user changes, you must use the task-level notification settings as
described in step 9.

By default, jobs are configured to send a notification whenever the job is run (Send all email
notifications). You can change the Job Notification Level as needed, and you can modify the
recipients, subject, and message. In the following example, a notification is only sent when the job
has errors.
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13. Complete any other job or task properties as needed. In most cases, the default settings are
sufficient.

14. Click Save. You can define a name for the job and save it to the desired location in the Scheduler
Jobs Library.

Once you save the job with an active scheduling rule, the job is immediately added to the schedule to
await the first scheduled execution time. You can see this scheduled instance on the Scheduled Jobs tab.

You can also run the job manually as needed by opening the job and clicking Run Once. Note that when
using Run Once, the job runs as the current user instead of the job owner, so you must have the
required permissions to perform the import.

For more information on what happens when the Active Directory Import task is run, see HowActive
Directory user synchronization works.

How Active Directory user synchronization works

This topic describes how newusers are created and how existing users are updated when an Active
Directory Import job runs in Scheduler.
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NOTE: The Active Directory domain name is always used to determinematching users for purposes
of the Active Directory import. If a user namematches but the domain does not, that user is not
considered to be a matching user.

� Creating new users via Active Directory import
For each unique user name in the import, Axiom Budgeting and Performance Reporting looks for a
matching user name in Axiom Budgeting and Performance Reporting Security. If no match is found, then
a new user is created. If a match is found, then the user synchronization behavior applies as detailed in
the following section.

New users are created with the following user properties:
l Login (from Active Directory)
l Domain (from Active Directory)
l First name (from Active Directory)
l Last name (from Active Directory)
l Email address (from Active Directory)
l License Type (from Scheduler task settings)
l Authentication (from Scheduler task settings)
l Enabled (from Scheduler task settings)
l Assigned Roles (from Scheduler task settings)
l Assigned Subsystems (from Scheduler task settings)
l Directory Sync Enabled (assumed as enabled)

NOTE: The imported user's domain does not display in the Security dialog, but it is stored in the
database and can be reported upon by use of an Axiom query to the Axiom.Principals table. The
relevant domain also displays before each user namewhen using Open Security in Spreadsheet. The
domain is stored in case of a situation where two users with the same user name are imported from
different domains.

� Synchronizing users via Active Directory import
If a user name in the Active Directory import matches an existing user name in Axiom Budgeting and
Performance Reporting security, then that user will be updated ONLY if theDirectory Sync Enabled check
box remains selected for thematching user. Matching users are updated as follows:

l User Properties: If the first name, last name, or email address has changed in Active Directory, it is
updated in Axiom Budgeting and Performance Reporting.

l User License Type: If the assigned user license type for the Active Directory group has changed,
then the license type is updated in Axiom Budgeting and Performance Reporting.
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l Authentication Type: If the assigned authentication type for the Active Directory group has
changed, then the authentication type is updated in Axiom Budgeting and Performance
Reporting.

l Role and Subsystem Assignments: The user's role and subsystem assignments are updated as
follows:

o If a role or subsystem assignment has been added for the Active Directory group, the user
is assigned to that role or subsystem.

o If a role or subsystem assignment has been removed from the Active Directory group, the
user is only removed from the role or subsystem if another group is mapped to that same
role or subsystem (and the user does not also belong to that other group). If the previously
assigned role or subsystem is not present in themappings at all, then the user is not
removed from the role or subsystem.

o If the user no longer belongs to the Active Directory group, and that group's role or
subsystem mappings still exist, then the user is removed from those roles and subsystems
(unless the user belongs to another Active Directory group in the import that is mapped to
the same roles and subsystems).

l Disabled Users: If the user is disabled in Active Directory, then the user is disabled in Axiom
Budgeting and Performance Reporting. If the user is disabled in Axiom Budgeting and
Performance Reporting but enabled in Active Directory, then the user will either be re-enabled or
left as disabled depending on whetherNever Enable Users is checked in the Scheduler task
settings.

If theDirectory Sync Enabled check box is cleared for thematching user, then that user will be ignored
by the Active Directory synchronization process and left as is.

If theDirectory Sync Enabled check box is selected for a user and that user does NOTmatch a user name
in the Active Directory import, then the user is disabled. If you still need the user account, you can re-
enable the user and clear the Directory Sync Enabled check box so that the user will be ignored by future
imports.

NOTES:
l Rolemappings are processed in role ID order. If a group has multiple mappings, and the user

license type or authentication type does not match on all of themappings, then users in the
group will be assigned to the license type and authentication type associated with the last-
processed role.

l If a role mapping uses a subsystem-specific role, users will be assigned to that role regardless
of whether they also belong to the associated subsystem. This creates an invalid security
configuration that must be corrected after the import.

� Editing imported users
Once an imported user has been created in Axiom Budgeting and Performance Reporting, you can edit
the user's permissions in Security as appropriate.
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You can assign the user to additional roles and/or subsystems, and those additional assignments will
persist through subsequent imports. However, if the user is part of an import that contains a mapping
with those roles or subsystems, and the user is not in the group affected by that mapping, then the user
will be removed from those roles or subsystems.

You can edit user properties such as name, email, and authentication type, however, these changes will
be overwritten the next time the Active Directory import task is run, assuming that Directory Sync
Enabled is still checked for the user.

If you do not want the user to be synchronized with Active Directory anymore, but you still want the user
to be active in Axiom Budgeting and Performance Reporting, then you should clear theDirectory Sync
Enabled check box for the user. Once this option is disabled, the user will be ignored by the import and
will be treated like a manually created user.

� Treatment of manually created users
If Active Directory Import is enabled for your system, you can still manually create users and exclude
them from the Active Directory import and synchronization process by clearing theDirectory Sync
Enabled check box for the user. The user will be ignored by any future Active Directory Import jobs.

If you manually create a user and leave theDirectory Sync Enabled check box selected, then the user will
be treated as follows the next time an Active Directory Import job is run:

l If the user matches a user name in the Active Directory import, then the user will remain active
and will be synchronized with Active Directory.

l If the user does not match a user name in the Active Directory import, then the user will be
disabled.

Using LDAP Authentication

You can enable LDAP Authentication for Axiom Budgeting and Performance Reporting, so that users are
authenticated against your LDAP server when launching Axiom Budgeting and Performance Reporting.

NOTE: LDAP Authentication is not supported for use with Axiom Cloud systems.

� LDAP Authentication behavior
When the Axiom Budgeting and Performance Reporting login screen displays, users must enter their
LDAP user name (with or without the suffix) and their LDAP password. If the LDAP user namematches a
user name in Axiom Budgeting and Performance Reporting, then the credentials are passed to LDAP for
authentication into Axiom Budgeting and Performance Reporting.
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If the LDAP Authentication configuration for Axiom Budgeting and Performance Reporting only allows
one LDAP suffix, then that suffix will be used for all LDAP authentication. The user can include the suffix or
not when logging in, and the Axiom user name can contain the suffix or not. Axiom will automatically
append the suffix as needed when sending the credentials to LDAP for authentication. However, if
multiple suffixes are allowed, then the suffix must be specified using any of the following approaches:

l The user must specify the appropriate suffix using theDomain selection list. This is an optional
login setting that can be enabled for your installation. For more information, see Domain selection
list.

l The user must include the suffix as part of their user namewhen logging in.
l The user names in Axiom Budgeting and Performance Reporting must include the appropriate

suffix for each user.

Users must enter their credentials each time they log in, unless they select Remember me to store their
credentials for future use. For more information, see Remember me.

� Setting up LDAP Authentication
The following summarizes the setup process for LDAP Authentication.

To set up LDAP Authentication:
1. LDAP Authentication must be enabled for the system.

LDAP Authentication can be enabled during the Axiom Application Server installation. If it was not
enabled during the installation, you can configure it later using the Configure Authentication
Methods page of the Axiom SoftwareManager. For more information, see the Installation Guide.

When you enable LDAP Authentication, you must specify the connection string to the LDAP
server, as well as a user name and password for the connection. You must also specify the allowed
suffix(es) for user names.

2. In security, Axiom Budgeting and Performance Reporting users must be set up as follows to
support LDAP Authentication:

l The user's Axiom Budgeting and Performance Reporting login namemust match their LDAP
login name.

The user name can contain the LDAP suffix or not as desired. Note that the user namemust
include the suffix if there is a naming conflict with another user who is configured with a
different authentication type (or with a different LDAP suffix). For example, if you have an
Axiom Prompt user jdoe, and you have an LDAP user jdoe, then the LDAP user must
include the suffix on their user name to differentiate the two users.

l The user's Authenticationmethod must be set to LDAP Prompt. This is the default setting
for new users if your installation is enabled for LDAP Authentication.

All users who are assigned to the LDAP authentication type will be authenticated by your designated
LDAP directory. This is the only way that these users can log in—they cannot log in using an internal
Axiom Budgeting and Performance Reporting password.
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If you need to test the security settings of an LDAP authentication user, you can use the Log in as
selected user feature to log in to Axiom Budgeting and Performance Reporting as that user. For more
information, see Testing user security.

Using SAML Authentication

You can enable SAML Authentication for Axiom Budgeting and Performance Reporting, so that users are
authenticated based on a designated identity provider (such as Shibboleth or Windows Active Directory
Federation Services). This option is only supported for use with Axiom Cloud systems.

� SAML Authentication behavior
SAML Authentication (Security Assertion Markup Language) is a web-based authentication method.
Users access Axiom Budgeting and Performance Reporting by going to the AxiomWeb Client in a
browser. Users must enter their user name and password for their identity provider. Once they are
authenticated, if the user namematches a user name in Axiom Budgeting and Performance Reporting,
then the user can access the AxiomWeb Client or install / launch the Axiom Excel Client or Windows
Client from the web page.

Users assigned to SAML Authentication can only access Axiom Budgeting and Performance Reporting
from the web. The Excel Client and Windows Client cannot subsequently be launched using a shortcut on
the user's computer; the user must continue to log into the AxiomWeb Client in order to start the
Desktop Client. When using SAML Authentication, you may want to configure the Axiom Application
Server installation so that no shortcuts are placed on user computers during the client installation, since
users will not be able to use these shortcuts.

� Setting up SAML Authentication
The following summarizes the setup process for SAML Authentication.

1. SAML Authentication must be enabled for the system.

For Axiom Cloud systems, Axiom Support will enable SAML Authentication for you as part of the
system setup, if that is your chosen authentication method.

2. Complete any additional configuration requirements to enable SAML Authentication.

SAML Authentication requires additional setup steps. These steps differ depending on the
designated identity provider. Please contact Axiom Support for assistance in completing the SAML
Authentication setup.

3. In security, Axiom Budgeting and Performance Reporting users must be set up as follows to
support SAML Authentication:

l The user's Axiom Budgeting and Performance Reporting login namemust match their login
name for the SAML identity provider (with or without an @suffix as appropriate).

l The user's Authenticationmethod must be set to SAML.
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If you need to test the security settings of a SAML Authentication user, you can use the Log in as
selected user feature to log in to Axiom Budgeting and Performance Reporting as that user. For more
information, see Testing user security.

� Logging in as an Axiom Prompt user when SAML Authentication is enabled
You can also set up Axiom Prompt users when SAML Authentication is enabled, such as to allow Axiom
Support to access the system without giving them credentials for the SAML identity provider. These
users must go a special area of the web site in order to log in:

https://ServerName/Axiom/Home/Login

Where ServerName is the name of your Axiom Application Server and Axiom is the name of the
virtual directory.

Using OpenID Authentication

You can enable OpenID Authentication for Axiom Budgeting and Performance Reporting, so that users
are authenticated based on a designated OpenID provider (such as Google OpenID Connect).

� OpenID Authentication behavior
OpenID Authentication is a web-based authentication method. Users access Axiom Budgeting and
Performance Reporting by going to the AxiomWeb Client in a browser. Users must enter their user name
and password for their OpenID provider. Once they are authenticated, if the user namematches a user
name in Axiom Budgeting and Performance Reporting, then the user can access the AxiomWeb Client or
install / launch the Axiom Excel Client or Windows Client from the web page.

Users assigned to OpenID Authentication can only access Axiom Budgeting and Performance Reporting
from the web. The Excel Client and Windows Client cannot subsequently be launched using a shortcut on
the user's computer; the user must continue to log into the AxiomWeb Client in order to start the
Desktop Client. When using OpenID Authentication, you may want to configure the Axiom Application
Server installation so that no shortcuts are placed on user computers during the client installation, since
users will not be able to use these shortcuts.

� Setting up OpenID Authentication
The following summarizes the setup process for OpenID Authentication.

1. OpenID Authentication must be enabled for the system.

For on-premise systems, OpenID Authentication can be enabled during the Axiom Application
Server installation. If you did not enable it during the original installation, you can use Repair to
change the installation to enable it. For more information, see the Installation Guide.

When you enable OpenID Authentication for Axiom Budgeting and Performance Reporting, you
must specify the Client ID and Client Secret for your OpenID provider.
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For Axiom Cloud systems, Axiom Support will enable OpenID Authentication for you as part of the
system setup, if that is your chosen authentication method.

2. Complete any additional configuration requirements to enable OpenID Authentication.

At minimum, you must configure the OpenID provider with the redirect URI to the Axiom
Budgeting and Performance Reporting login page (such as <URLtoAxiom>/openid/login).
Other setup steps may be necessary, depending on your particular configuration. Please contact
Axiom Support as needed for assistance in completing the OpenID Authentication setup.

3. In security, Axiom Budgeting and Performance Reporting users must be set up as follows to
support OpenID Authentication:

l The user's Axiom Budgeting and Performance Reporting login namemust match their login
name for the OpenID provider, including the@suffix.

l The user's Authenticationmethod must be set to OpenID.

If you are an administrator and you need to test the security settings of an OpenID Authentication user,
you can use the Log in as selected user feature to log in to Axiom Budgeting and Performance Reporting
as that user. For more information, see Testing user security.

� Logging in as an Axiom Prompt user when OpenID Authentication is enabled
You can also set up Axiom Prompt users when OpenID Authentication is enabled, such as to allow Axiom
Support to access the system without giving them credentials for the OpenID identity provider. These
users must go a special area of the web site in order to log in:

https://ServerName/Axiom/Home/Login

Where ServerName is the name of your Axiom Application Server and Axiom is the name of the
virtual directory.

Login behavior options

The following options apply to all authentication types except SAML and OpenID Authentication.

� Domain selection list
When a user logs in, Axiom Budgeting and Performance Reporting looks for a matching user namewithin
Axiom security and applies the specified authentication type for that user. For LDAP Authentication and
Windows Authentication, if only one allowed domain or suffix is specified, that information can be
assumed and the user does not need to include it when logging in. If multiple domains or suffixes are
specified, then the user must include that information as part of their user name. For example:
DomainName\UserName for Windows Authentication.

Alternatively, you can configure your system so that all users must specify their authentication type /
domain when logging into Axiom Budgeting and Performance Reporting, using theDomain selection list.
The Domain selection list displays the following:

l Axiom Named User (for Axiom Prompt login)
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l Each allowed Windows Authentication domain (ifWindows Authentication is enabled for the
installation)

l Each allowed LDAP suffix (if LDAP Authentication is enabled for the installation)

When the Domain selection list is enabled, the user must make the appropriate selection in order to log
in. For example, a Windows Authentication user must select their Windows domain name. Because it is
specified separately, the domain or suffix does not need to be added to the user name, even when there
aremultiple allowed domains or suffixes.

The following screenshot shows an example of the Domain selection list. In this example, the installation
has enabled Windows Authentication with two allowed domains. The two domain names display on the
selection list as well as the choice to log in as an Axiom Named User.

The Domain selection list can be enabled or disabled using the
AuthenticationDomainSelectionListRequired system configuration setting. By default this is set to False,
which means the Domain selection list only displays if your system contains duplicate user names that
require the domain to be specified to differentiate those users. If you set this to True, then the Domain
selection list displays at all times.

If the Domain selection list is enabled, and ifWindows Authentication is enabled for the installation, then
by default the user's current domain will be selected in the list (if that domain is one of the allowed
domains). Otherwise, the first option in the list is selected by default. Options are ordered as follows:
LDAP suffixes, Windows domains, Axiom Named User.
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� Remember me
Users can optionally select Remember me at the login screen to store their Axiom Budgeting and
Performance Reporting authentication for future use. This information is encrypted and only applies to
the current user for the current machine. The next time the user starts Axiom Budgeting and
Performance Reporting on the current machine, they will not be prompted to log in.

Although all Axiom Budgeting and Performance Reporting clients have a Remember Me check box on the
login screen, note that the remembered status is stored separately for access to theWeb Client versus
the Desktop Client. For example, a user can choose Remember Mewhen logging into the Excel Client,
and then that user will not be prompted when subsequently accessing either the Excel Client or the
Windows Client. However, if the user attempts to access theWeb Client, they will be prompted for
credentials (and can then choose to be separately remembered for theWeb Client).

NOTE: Logging out of a client will clear the remembered status for that client type. Although the Excel
Client and Windows Client do not have an explicit log out feature, logging out of theWord or
PowerPoint add-in will clear the remembered status for the Desktop Client (but only if you are not
also currently logged into another instance of the Desktop Client).

If you do not want users to have access to the Remember Me option, so that they must log in each time,
then you can disable the feature by setting the system configuration setting ShowRememberMe to
False. This will hide the option from the various login screens. Keep in mind that if a user has already
used the Remember Me option, hiding the setting will not clear the user's stored credentials. The user
will continue to be remembered until they log out and cause their credentials to be cleared.

Filters
This section contains reference information for creating filter criteria statements. Security settings for file
groups and tables can use filters to determine access.

Filter criteria syntax

Several areas of Axiom Budgeting and Performance Reporting use criteria statements to define a set of
data. The syntax for these criteria statement is as follows:

Table.Column='Value'

l Table is the name of the database table.
l Column is the name of the column in the database table.
l Value is the value in the column.

If the column is String, Date, or DateTime, the valuemust be placed in single quotation marks as shown
above. If the column is Numeric, Integer (all types), Identity, or Boolean, then the quotation marks are
omitted.
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For example:
l To filter data by regions, the filter criteria statement might be: DEPT.Region='North'. This

would limit data to only those departments that are assigned to region North in the Region
column.

l To filter data by a single department, the filter criteria statement might be: DEPT.Dept=100. This
would limit data to only department 100.

If the table portion of the syntax is omitted, then the table is assumed based on the current context. For
example, if the filter is used in an Axiom query, then the primary table for the Axiom query is assumed. If
the current context supports column-only syntax, and the specified column is a validated key column,
then the lookup table is assumed.

� Operators
The criteria statement operator can be one of the following: =, >,<,<>,<=,>=. Greater than or less than
statements can only be used with numeric values. For example:

ACCT.Acct>1000

SQL IN and LIKE syntax can also be used. For example:
DEPT.Region IN ('North','South')

� Compound criteria statements
You can use AND and OR to combinemultiple criteria statements. If you are creating long compound
criteria statements with multiple ANDs or ORs, you can use parentheses to group statements and
eliminate ambiguity. For example:

(DEPT.Region='North' OR DEPT.Region='South') AND (ACCT.Acct=100 OR
ACCT.Acct=200)

NOTES:
l When filtering on multiple values in the same column, you must use OR to join the

statements, not AND. In the example above, if the statement was instead
DEPT.Region='North' AND DEPT.Region='South', that statement would return no
data because no single department belongs to both the North and South regions. When you
use OR, the statement will return departments that belong to either the North or the South
regions.

l Alternatively, you can use the SQL IN syntax to create a compound statement for values in the
same column. For example, the statement DEPT.Region='North' OR
DEPT.Region='South' can also be written as DEPT.Region IN ('North','South').
The Filter Wizard uses IN syntax by default.
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� Using criteria statements in functions
If you are using a criteria statement in a function, such as GetData, you must place the entire criteria
statement in double quotation marks. For example:

=GetData("Bud1","DEPT.Region='North'","GL1")

You can also place the criteria statement in a cell and then use a cell reference in the function. In this
case, you do not need to use double quotation marks in the function, unless you are concatenating text
and cell reference contents within the function.

� Referencing blank values in filters
If a string column contains a blank value, you may want to create a filter that includes or excludes records
with these blank values. For SQL Server, the blank value is stored as an empty string. This empty string is
indicated with empty quotation marks in the filter. For example: ACCT.CMAssign='' or
ACCT.CMAssign<>''

If you use the Filter Wizard to construct the filter, it will automatically use the appropriate syntax.

� Referencing values with apostrophes in filters
If a string column contains a value with an apostrophe (such as O'Connor), then that apostrophemust
be escaped with another apostrophe so that it is not read as the closing apostrophe for the filter criteria
statement. For example:

Dept.VP='O'Connor'

Invalid. This construction does not work because Axiom Budgeting and Performance Reporting
reads it as Dept.VP='O' and then does not knowwhat to do with the rest of the text.

Dept.VP='O''Connor'

Valid. The extra apostrophe tells Axiom Budgeting and Performance Reporting that the
apostrophe is part of the string value and is not the closing apostrophe.

NOTE: This syntaxmust use two apostrophe characters in sequence and not a double
quotation mark. If you create the filter using the Filter Wizard, Axiom Budgeting and
Performance Reporting will construct the appropriate syntax for you.

� Referencing Date or DateTime values in filters
If your locale uses a date format where the first value is the day, filters using that date or date-time value
will not process correctly. Instead, the date or date-time valuemust be in standard format. Standard
format is YYYY-MM-DDTHH:MM:SS for DateTime and YYYY-MM-DD for Date.

If you use the Filter Wizard to construct the filter, it will automatically convert the date or date-time value
to the appropriate syntax.
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Filter variables

Axiom Budgeting and Performance Reporting provides a set of filter variables that can be used in filter
criteria statements throughout the software. Currently, these variables allow filtering based on the
current user.

For example, you may have a column on a plan code table such as Dept.Owner, which contains user
login names. When setting up plan file filters in security, you want each user to have a filter such as
Dept.Owner='UserName'. Without using variables, you would need to set up each user with a user-
level filter such as Dept.Owner='JDoe', Dept.Owner='RSandstone', and so on. With variables, you
can instead set up a single role-level filter such as Dept.Owner='{CurrentUser.LoginName}'. For
each user in the role, this filter will be resolved using that user's login name.

Filter variables can be used in any place that takes a filter criteria statement. For example, you can use
the variables to impact data queries in places such as Sheet Filters, Axiom query filters, Web Report data
source filters, Quick Filter, and GetData functions. You can also use the variables in utilities such as
Process Plan Files and Create Plan Files.

To use a filter variable, place the variable in curly brackets within the filter criteria statement. All other
filter rules still apply—for example, if the variable will resolve to a string value such as a user name, the
variable must be placed in single quotation marks. The filter must result in a valid filter criteria statement
once the variable is resolved to its current value.

Variable Resolved Value

{CurrentUser.EmailAddress} The email address of the current user.

{CurrentUser.FirstName} The first name of the current user.

{CurrentUser.LastName} The last name of the current user.

{CurrentUser.LoginName} The login name of the current user.

{CurrentUser.PrincipalID} The database ID of the current user.

{CurrentUser.QualifiedLoginName} The qualified login name of the current user
(domain\username). If the user does not have a defined
domain, the regular login name is used.

File Management
This section contains information about file management features in Axiom Budgeting and Performance
Reporting. All files are stored in the Axiom Budgeting and Performance Reporting database.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1301



Managing files using Axiom Explorer
Using Axiom Explorer, administrators can view and manage the files in the Axiom Budgeting and
Performance Reporting file system. You can access files, import and export files, delete files, view file
history, and manage folder structures for various Axiom libraries. All Axiom files are stored in the Axiom
Budgeting and Performance Reporting database.

In addition to basic file management, other administration features such as file group administration and
table administration are performed in Axiom Explorer. For more information on performing these
activities, see the documentation for each particular feature. This topic discusses general file
management features only.

To open Axiom Explorer:
l On the Axiom tab, in the Administration group, clickManage > Axiom Explorer.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click System Browser.

� Access to Axiom Explorer
By default, only administrators have access to Axiom Explorer. Non-administrators can be granted access
by enabling the Administer Axiom Explorer permission.

If a non-administrator has access to Axiom Explorer, what they can see in the dialog and what actions
they can perform are controlled by their other relevant security permissions. For example, if a user does
not have any access to imports, then they will not see the Imports Library. If a user has read-only access
to a folder in the Reports Library, then they will see that folder and can open reports, but they will not
have access to commands such as creating new folders and deleting files.

NOTE: The Axiom System section of Axiom Explorer contains system files for Axiom Budgeting and
Performance Reporting. Only administrators can access this section.

The Explorer task pane is a streamlined version of the Axiom Explorer dialog. Essentially, the Explorer task
pane displays the treeview from the left-hand pane of Axiom Explorer, which allows users to open files
and perform actions available on the right-click menu. The same rules apply to the Explorer task pane in
determining what files and features a user has rights to access within the treeview. However, the
Administer Axiom Explorer permission is not required for non-administrator users to see the Explorer
task pane—any user can view the task pane.

By default, the built-in Explorer task pane is available to all users, via Startup settings defined on the
Everyone role. This default access can be changed if desired. If your system has installed products, those
products may havemodified the default access to provide a different way for users to access the task
pane.
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� Axiom Explorer overview
In the Axiom Explorer dialog, the virtual folder directory is displayed in the left-hand pane, and the sub-
folders and files within a selected folder are listed in the right-hand pane.

Example Axiom Explorer

When you select a folder or file, information about that item displays in the bottom of the dialog, such as
the file type and size, the date the file was last modified, and the file or folder description. If the file is
currently in use, the user who has locked the file is also listed.

As you navigate through the directory, the current location is displayed in a box at the top of the
window. You can also type a location into the box to jump directly to that location.

To refresh the file list, click the Refresh button in the toolbar.

� Managed and non-managed files
By default, all files used by Axiom Budgeting and Performance Reporting are stored in the Axiom
Budgeting and Performance Reporting database and accessible via Axiom Explorer. These files are also
known asmanaged files, because access to the files is managed by Axiom Budgeting and Performance
Reporting.

It is also possible to save an Axiom file outside of the Axiom Budgeting and Performance Reporting
database, such as by using Save As > Local or Export. Axiom files saved locally are known as non-
managed files. Axiom Budgeting and Performance Reporting does not control access to non-managed
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files. Although some features—such as basic Axiom queries and some Axiom functions—still work in non-
managed files when they are opened within Axiom Budgeting and Performance Reporting, most
functionality is not available. It is not recommended to use non-managed files, except as a method to
move a file from one Axiom Budgeting and Performance Reporting system to another.

� File groups and Axiom Explorer
File groups have special treatment in Axiom Explorer. Only administrators can access all of the underlying
folders and files for a file group.

If a non-administrator has access to Axiom Explorer, that user will not see the Plan Files folder or any plan
files, even if the user otherwise has access to the plan files. Non-administrators must use Open Plan Files
(or similar related software features) to open their plan files. The Plan File Attachments folder is also
hidden.

Non-administrator users can see the following folders only if they have been granted access to the
folders (or files within them) on the Files tab of the Security Management dialog: Drivers, Templates,
Utilities, Process Definitions.

File group folders are not listed in the Explorer task pane for any user. Instead, the Explorer task pane
displays a version of the file group menu, so that users can open plan files and perform other file group
tasks using the task pane (dependent on their file group permissions).

� Managing folders
You can perform the following actions in Axiom Explorer by right-clicking a folder. You must have
read/write permissions to the folder (as defined in Security) in order to perform any of these actions.

Folder Action Description

New > Folder Create a new sub-folder in the selected folder. Once the folder has been created,
use Rename to name it. You can also define a description for the folder.

You must have read/write access to the parent folder in order to create a sub-
folder.

NOTES:
l The Reports Library on the Reports menu only displays folder structures up

to four levels deep. Folder structures greater than four levels can only be
accessed using Reports > All Reports (or Axiom Explorer).

l Not all folders in the Axiom file system support creating sub-folders.
Generally speaking, if access to the folder is controlled using the Files tab in
Security, then users with read/write access can create a sub-folder there.
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Folder Action Description

Rename Rename the selected folder. You can also press the F2 key to rename a selected
folder.

You must have read/write access to the folder in order to rename it.

NOTE: Not all folders in the Axiom file system support being renamed. If the
folder is system-controlled, then this option will not be available.

Import Files Import files into the selected folder. The imported files will be saved in the
Axiom Budgeting and Performance Reporting database. You must have
read/write access to the folder in order to import files.

NOTE: If you import a file with the same name as an existing file in the folder,
that file will replace the existing file and retain its document ID.

Certain folders have additional file type and user permission requirements. For
example:
l Folders that are dedicated to specialty Axiom file types (such as AXL for task

pane files) can only accept imported files of that type.
l Report folders can accept imported files of virtually any file type.
l Plan file folders can only accept imported XLSX or XLSM files that have the

same name as an existing plan file in the folder.

Delete Delete the selected folder. This option is only available for user-created folders.

A folder cannot be deleted if it contains any files or sub-folders. You must first
delete or move the files within the folder before theDelete command becomes
available on themenu.

You must have read/write access to the folder in order to delete it.

You can move user-created folders by dragging and dropping. Only one folder can bemoved at a time—
drag and drop does not support multiple selections. System-controlled folders cannot bemoved.

� Managing files
You can perform the following actions by right-clicking a file:

File Action Description

Open Open the selected file. You can select multiple files and open them
simultaneously.

Open Read Only Open the selected file as read-only.
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File Action Description

Open Without
Refresh

Open the selected file without running any Axiom queries that are set to refresh
on open. This option also ignores theDowngrade to read-only on open setting.
This option is only available to administrators.

Open in Browser Open the selected file in a browser. This is only available for form-enabled files.

Open in Browser
(as other user)

Open the selected file in a browser, using the security permissions of a different
user. This option is only available to administrators and only for form-enabled
files, so that administrators can test the file setup. A dialog box allows you to
select the user to view the file as.

Break Selected
Locks

Break the file lock for the selected file or files, if the file is locked by another user.
For more information, seeManaging locked items.

Document
history

View the history for the selected document. For more information, see Viewing
document history.

Cut

Copy

Cut or copy the selected file, to be pasted to another location in Axiom Explorer.
After cutting or copying, navigate to the location where you want to paste the
file. Right-click in the blank area of the file list (the right-hand pane) and then
click Paste.

You can select multiple files and copy them simultaneously.

You must have read/write access to the file's folder in order to use cut.

Rename Rename the selected file. You must have read/write access to the file's folder in
order to rename a file.

Delete Delete the selected file. You must have read/write access to the file's folder in
order to delete a file.

Export Exports a copy of the selected file to your local computer or a network file
location. You can select multiple files and export them simultaneously.

When the export copy is created, workbook and worksheet protections are
applied and "refresh on open" Axiom queries are run. The behavior is as if you
had opened the document in Axiom Budgeting and Performance Reporting and
then used Save As (Local).

If you are an administrator and you want to save a local copy of a file without
these protections and data, then you must use Export Without Refresh.

Export Without
Refresh

Exports a copy of the document as it exists in the database. This option is only
available to administrators.

When using this option, Axiom Budgeting and Performance Reporting exports
the file without performing the various "open document" protocols such as
applying protection and running "refresh on open" Axiom queries.
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File Action Description

Copy shortcut to
clipboard

Creates a hyperlink to the selected file and copies it to the clipboard. You can
then paste the hyperlink into a file or an email (or otherwise provide it to a
user).

Copy document
path to
clipboard

Copies the full path of the document to the clipboard. You can then paste the
path somewhere—for example, for use with alert setup, or within certain Axiom
functions that use a document path.

Add to Favorites Add the selected file to your favorites list.

Package Details View the product package details for the file, including the feature the file
belongs to, the package version, and the date the feature was installed.

This action is only available in the Axiom Explorer dialog, and only applies if the
file belongs to an installed product. If the file was not installed by a product
package, then no package details will be found.

You can move files by dragging and dropping. Only one file can bemoved at a time—drag and drop does
not support multiple selections.

� Defining file and folder descriptions
Each file and folder can have a description. Descriptions are displayed in the bottom of the Axiom
Explorer windowwhen a file or folder is selected. In some cases the description displays elsewhere in the
system, such as when selecting a report to open.

To create or edit a file or folder description:
1. Select the file or folder in Axiom Explorer.

2. At the bottom of the dialog, in the file/folder properties section, click on the space to the right of
theDescription label. (When you hover your cursor over this area, the description box becomes
outlined.)

3. Type the description into the box. If you want to clear a description, highlight the existing text and
then press the Delete key.

Importing and exporting files
You can import external files into the Axiom Budgeting and Performance Reporting file system, and you
can export Axiom files from the file system to a local folder or network share. This can be done using the
Axiom Explorer dialog or the Explorer task pane.

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1307



� Importing files
To import an external file into a folder in the Axiom Budgeting and Performance Reporting file system,
you must be an administrator or have read/write access to the folder. This is the same level of
permissions required to save a new file within a folder.

Most folders in Axiom Budgeting and Performance Reporting are limited to holding files of a certain type.
For example, the Scheduler Jobs Library can only hold Scheduler jobs, and the Imports Library can only
hold import utilities. If you attempt to import a file into a folder and that file type is not allowed in that
folder, the import will be prevented.

A few folders do not have file type restrictions. For example, the Reports Library can contain files such as
Word files, PowerPoint files, and image files in addition to Axiom reports. These files can be referenced
throughout the system—such as a logo file that is referenced by various reports and forms.

NOTES:
l If you import a file that has the same name as a file that is already in the folder, then the

imported file will replace the current file and retain the current document ID. This is important
for cases where you want the imported file to be recognized as the "same" file, so that
shortcuts and other references to the file remain intact.

If you have read/write access to a particular Axiom file but not its folder, then you cannot use
import to overwrite the file. Instead, you can open the external file within Axiom Budgeting
and Performance Reporting, and then use Save As (Repository) to overwrite the existing file.

l When you import a spreadsheet file into the Axiom Budgeting and Performance Reporting file
system, any passwords relating to workbook/worksheet protection will be removed from the
file. This is to put the imported file in a state where it can be opened by Axiom Budgeting and
Performance Reporting. If the file is an Axiom file with protection enabled on the Control
Sheet, that protection will be reapplied when the file is opened (using the system-applied
password as appropriate).

If Axiom Budgeting and Performance Reporting is unable to remove the protection-related
passwords from the file (for example, if there is a file-level password on the file), then the file
cannot be imported.

To import a file into the Axiom Budgeting and Performance Reporting file system:
1. On the Axiom tab, in the Administration group, clickManage > Axiom Explorer.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click System Browser.

You can also import files using the Explorer task pane.

2. Navigate to the folder where you want to import the file, then right-click and select Import Files.

3. In the Select File to Import dialog, select the file to import from your local drive or a network file
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share, and then click Open. You can also select multiple files to import.

4. If a file with the same name already exists in the folder, you are prompted to confirm that you
want to overwrite the existing file. Click Yes if you want to overwrite the existing file, retaining the
same document ID.

NOTE: When overwriting an existing file, you must also have read/write access to that file.

The selected file is imported to the folder.

� Exporting files
If a file is visible to you in Axiom Explorer or the Explorer task pane, you can export it. Themost common
reason to export an Axiom file is to import it into another Axiom Budgeting and Performance Reporting
system.

Any file in the Axiom Budgeting and Performance Reporting file system can be exported using the Export
command. For Axiom spreadsheet files (such as reports), there are two export options:

l Non-administrator users can use Export, which exports the file in the same state that it would
appear to the user in Axiom Budgeting and Performance Reporting. This means that
workbook/worksheet protection is applied to the exported file (if enabled on the Control Sheet),
and "refresh on open" Axiom queries are run. Effectively, this is the same behavior as if the user
had opened the file in Axiom Budgeting and Performance Reporting, then used Save As (Local) to
save a copy of the file outside of Axiom Budgeting and Performance Reporting.

l Administrator users have access to a second option called Export Without Refresh. This can be
used to export the file as it exists in the database—without applying protection, and without
running "refresh on open" queries.

To export a file from the Axiom Budgeting and Performance Reporting file system:
1. On the Axiom tab, in the Administration group, clickManage > Axiom Explorer.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click System Browser.

You can also export files using the Explorer task pane.

2. Navigate to the file that you want to export, then right-click and select Export or Export Without
Refresh.

In the Axiom Explorer dialog only, you can select multiple items to export. Multiple selection is not
available in the Explorer task pane.

3. In the Export Repository File dialog, navigate to the local folder or network file share where you
want to save the exported copy, and then click Save.

The exported copy is saved to the designated location.
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Viewing document history
Axiom Budgeting and Performance Reporting automatically creates document versions when a file is
modified, and stores those versions in the database for a configured amount of time. These historical
versions can be viewed using Axiom Explorer, and can be restored as the current version if needed.

New document versions are automatically created when a document is modified within a user's lockout
session, once per lockout. For example, if a user opens a plan file as read/write and then saves that
document, the new version becomes the current version of the document, and the prior version is
"archived" in the audit database. Whether the user saves the document once or multiple times within
the lockout session, only one version is created. However, if the user closes the document and then re-
opens it, creating a new lockout session, another version will be created if the user saves the document.

Administrators have access to an additional means of creating and restoring document versions of Axiom
spreadsheet files, using the Axiom Designer tab. Using this feature saves the file and creates a new
document version, within the same lockout session.

The available document history at any particular time depends on how your System.SystemDataPurge
job is configured in Scheduler. This task purges audit history as of a specified number of days. For
example, if the task is configured to purge audit data older than 15 days (the default value), then you
cannot view or restore any document versions older than 15 days. Only administrators can see and edit
system jobs in Scheduler.

NOTE: If you need to restore plan files, you can use the Restore Plan Files feature instead. This
feature can be used to restore any number of plan files as of a specified point in time.

� Viewing available document versions
You can view the list of available document versions using Axiom Explorer, and export older versions as
needed. Once the older version is exported, you can import it into Axiom Budgeting and Performance
Reporting as a new copy of the document, or you can overwrite the current version of the document.
For spreadsheet-based files, you can also open the older versions directly.

To view the history for a document:
1. On the Axiom tab, in the Administration group, clickManage > Axiom Explorer.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click System Browser.

You can also view document history using the Explorer task pane.

2. Navigate to the desired document, then right-click it and select Document History.

TheDocument History dialog opens, listing all of the available versions of the selected document
(including the current version). The version numbering starts at 1 and increments by +1 for each
subsequent version, so that the version with the greatest number is themost recent version.
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Example Document History dialog

If you want to view a prior document version, select the version and then do either of the following:
l Click Open to open the version in Axiom Budgeting and Performance Reporting. This option is only

available for spreadsheet Axiom files, and opens the selected version as an non-managed copy of
the document. The name of the non-managed file is Filename - version #.

NOTE: If you open the current version of the document from the Document History dialog,
then the document opens normally, just as if you had opened it from Axiom Budgeting and
Performance Reporting menus. The version behavior only applies when opening a historical
version.

If you want to save a copy of this version, you must use Save As to save the file. You can save it
locally, or you can save it to the Axiom Budgeting and Performance Reporting file system as a new
name. If you just click Save, then the file is saved within the Axiom temporary folder and will not
be retained.

l Click Export to export a copy of the selected version. This option is available to administrators for
all documents, and to users with read/write permission for non-spreadsheet-based documents.
The exported copy can be saved to your local computer or to a network file share.

If the document is a spreadsheet Axiom file, then export performs the same action as Export
Without Refresh—meaning, protection will not be applied, and "refresh on open" Axiom queries
will not be run.

� Restoring document versions
The easiest way to restore a document version is by using the Restore Prior Version button on the
Axiom Designer tab. By default this feature is only available to administrators, but it can be used by any
user with read/write access to the document, if the feature is included on a custom ribbon tab that the
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user has access to. This feature is only available to Axiom spreadsheet files.
To restore a prior document version (spreadsheet Axiom files):

1. Open the document, then go to the Axiom Designer tab.

2. Click Restore Prior Version to view a drop-down list of available versions, then click the prior
version that you want to restore.

3. Axiom Budgeting and Performance Reporting prompts you to confirm that you want to open the
selected prior version in place of the current version. Click Yes to continue.

4. If the currently open version of the file has unsaved changes, then Axiom Budgeting and
Performance Reporting prompts you to save those changes before the prior version is opened.
Click Yes orNo depending on whether those changes need to be saved.

The current document is closed and the prior version of the document is opened as the current
file.

5. To save this prior version as the current version, click Save.

To restore a prior document version (any file type):
If it is not possible to use Restore Prior Version, then you can do either of the following:

l Open the prior version using the Document History dialog, then use Save As to save the file over
the current version.

OR

l Export the prior version using the Document History dialog, then use Import Files in Axiom
Explorer (or the Explorer task pane) to import the file over the current version. The exported file
must have the same name as the file in the Axiom Budgeting and Performance Reporting file
system in order to overwrite the current version.

See the previous section for more information on how to open or export a prior document version.

Managing locked items
When users open files and tables in Axiom Budgeting and Performance Reporting with read/write
permissions, the item becomes "locked" to that user. Administrators can useManage Locked Items to
view a list of locked files and tables, and to remove locks if necessary.

� How items become locked
When a user opens a file with read/write permissions, the file in the database is locked to prevent other
users from making changes to the file. If a different, non-admin user attempts to open the file with
read/write permissions, that user is informed that the file is locked and can open the file as read-only.
The lock is removed when the locking user closes the file.
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Tables become locked when a user opens the table with read/write permissions using Open Table in
Spreadsheet. The table remains locked until the user closes the spreadsheet. All other operations that
modify tables lock the table immediately prior to the save, and release the lock immediately afterward,
so the tables do not become listed as locked items.

Situations may occur where a file or a table remains locked to a user unintentionally. For example, the
user may have exited Axiom Budgeting and Performance Reporting improperly or experienced a system
crash, therefore preventing the lock from being removed as part of the normal application closing
processes. In these situations, administrators can remove the lock so that the file or table can be edited
again by other users.

NOTES:
l If a file remains locked to a user who is not currently accessing the document, that user can re-

acquire the lock by opening the file again. If the user exits the file normally, the lock is then
released. It is only necessary for an administrator to break a lock if a different user needs to
gain access to the file.

l Files and tables are not locked if a user opens them as read-only. This includes Axiom forms,
which are always opened as read-only. Alternatively, Axiom forms can use the data context
feature in order to lock the ability to save data from the read-only file. These "save locks" are
managed separately from regular locked items and do not display in theManage Locked Items
dialog. If you need to view or break a save lock, use the Save Lock Administration page in the
System Administration section of theWeb Client.

� Viewing locked items and removing locks
Only administrators, subsystem administrators, and users with the Administer Locked Items security
permission can remove locks on items. Users with the Administer Locked Items security permission are
limited to managing locks on items that they have some level of access to. Subsystem administrators
also have this limitation, plus they are limited to managing locks held by users in their subsystem.

To view locked items:
l On the Axiom tab, in the Administration group, clickManage > Locked Items.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Locked Items.

The Axiom Explorer: Locked Items dialog opens. This dialog lists all currently locked files and tables. The
following information is provided:

l The name of the item
l Whether the item is a document or a table
l The user who locked the item
l The date the item was locked
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If necessary, you can remove the lock on a file or table. To do so:
l Select one or more items in the list, and then click Break Selected Locks.

You are prompted to confirm that you want to remove the lock. If you click Yes, the lock is removed from
the item, and any user with the appropriate rights can open the item as read/write.

IMPORTANT: If the user is actually in the document when you break the lock, then that user may not
be able to save their changes. If the document does not become locked to any other user in the
meantime, then when the original user clicks Save they will re-acquire the lock and can save their
changes. However, if another user has locked the file, then the original user will be unable to save.

TIP: You can also break locks as you are browsing in Axiom Explorer, by using the right-click context
menu on a locked item.

Administering save data locks for Axiom forms
Using the Save Lock Administration page in theWeb Client, you can view all active sessions relating to
data contexts in Axiom forms, and break save locks if necessary.

Save locking is an optional feature for Axiom forms, so that you can prevent concurrent data saves within
the form. By default, multiple users can access an Axiom form concurrently and save data. If you want to
prevent concurrent saves, you can define a data context for the form. Once a data context is defined,
only one user at a time can have the "save lock" for that data context and save data from the form. If
necessary, a user's save lock can be broken so that a different user can acquire the lock.
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Only administrators, subsystem administrators, and users with the Administer Locked Items security
permission can access this dialog and remove save data locks. Users with the Administer Locked Items
security permission are limited to managing locks relating to documents that they have some level of
access to. Subsystem administrators also have this limitation, plus they are limited to managing locks
held by users in their subsystem.

To access the Save Lock Administration page:

1. In theWeb Client, click themenu icon in the Global Navigation Bar. From the Area menu,
select System Administration.

2. From the Navigation panel, select Tools > Save Lock Administration.
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Alternatively, you can go to directly to the Save Lock Administration page as follows:

Example Cloud
URL

https://ClientName.axiom.cloud/SaveLocks

Where ClientName is the name of your Axiom Cloud system.

Example On-
Premise URL

http://ServerName/Axiom/SaveLocks

Where ServerName is the name of the Axiom Application Server, and Axiom is the
default name of the virtual directory.

The Save Lock Administration page displays a list of all data contexts that are currently active in at least
one session.
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Example active data contexts

To view the active sessions for a data context and see the users, click View Sessions. Then, if you need to
break a save lock, click Break Lock.

Example active sessions for a data context

IMPORTANT: If the user is actually in the form when you break the lock, then that user may not be
able to save their changes. If the form does not become locked to any other user in themeantime,
then the user can reacquire the lock. However, if another user has acquired the save lock, then the
original user will be unable to save.

If a lock is broken, the user's form session is immediately converted to a view-only session, and the Break
Lock button is converted to a Clear button. It is not necessary to clear the view-only session if the user is
still viewing the form—the view-only session will be cleared automatically when the user stops viewing
the form.

� Clearing orphaned view sessions
When a user without a save lock is viewing the form, that user's session shows in the Save Lock
Administration page with an eye icon instead of a lock. "View-only" sessions are tracked for information
only, and do not affect the availability of the save lock. An example view-only session is shown in the
previous screenshot.
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Occasionally, a view-only session may be "orphaned"—meaning, the user is no longer viewing the form,
but the save lock dialog and administration page still show the user's view-only session. If this occurs,
you can clear the view-only session using the Save Lock Administration page, by clicking the Clear button
on the session record. The sole purpose of the "clear" action is to remove orphaned records—the action
has no effect on the availability of the save lock or on any user's ability to view the form.

Refreshing the file system
The Axiom Budgeting and Performance Reporting file system is the virtual folder directory that is used to
enable easy navigation of files stored in the Axiom Budgeting and Performance Reporting database.

If files are added by a user, other users who are currently logged into the softwaremay not immediately
see these files in Axiom Budgeting and Performance Reporting menus. You can manually refresh the file
system for your current session to update any stale lists of files.

To refresh the file system:
l On the Axiom tab, in the Reports group, click Reports > Refresh File System.

NOTE: In systems with installed products, this featuremay be located on theMain tab. In the
Help group, click Help > Support Tools > Refresh File System.

This action is for rare cases when the file system was not refreshed naturally. Most areas that list files
from the file system include a built-in refresh to get the latest information, such as when opening Axiom
Explorer.

User access to My Documents
Axiom Budgeting and Performance Reporting provides a My Documents folder which administrators can
use to store their own personal reports, or as a temporary holding area for reports that are "in
progress." This folder displays in theMy Files area of Axiom Explorer, along with favorites and recent
items.

By default, only administrators have access to this folder. In most cases, end users do not need an area
like this because they are not creating new files, and exposing the folder to them may cause confusion.

However, if you want to give certain power users access to this folder, you can grant them theUser
Documents Folder Access permission in Security. If a user has this permission, then a My Documents
folder is created for them, within their user folder. These user folders are located in the Axiom Budgeting
and Performance Reporting file system at: \Axiom\Axiom System\User Folders. Each user has a
folder that contains their favorites, recent items, and My Documents (if applicable). The folders are
named using the user's database ID, but they display in Axiom Explorer with the user name as follows:
~username. These folders are what display to each individual user as their My Files area.
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If a user has access to a My Documents folder, and then later the permission is removed, the existing
folder will be hidden from the user in Explorer screens but the folder will remain in the file system. You
can delete this folder in Axiom Explorer if desired.

NOTE: Non-administrator users will not be able to access the Sheet Assistant or use other file-level
permissions (such as the ability to unprotect) on files saved to My Documents. Currently there is no
way to grant file-level permissions to this area, so only administrators have full access to file features.

Axiom Budgeting and Performance Reporting file system
The Axiom Budgeting and Performance Reporting file system is a virtual folder directory that is provided
to logically organize the documents in the Axiom Budgeting and Performance Reporting database, and
make it easier to locate and manage these documents.

� Axiom folders
The following table details each folder in the file system (using the folder display names in Axiom
Explorer), with a brief description of its contents and how it is used. The system folder name is an internal
name that should be used when referencing Axiom file paths in non-English systems (such when listing
file paths in the GetDocument function).

Folders are listed in the order they are displayed in Axiom Explorer. Subfolders are indicated with "\" in
front of the folder name.

Folder Name Description System Folder Name

File Groups Contains all of the files in your file groups. This
folder contains a sub-folder for each file group.

SystemFolderName_
FileGroups

\FileGroupName Contains the files for a specific, user-defined file
group. Each file group defined in the system has its
own folder.

N/A

\\Calc Method
Libraries

Contains the calc method libraries for the file
group.

SystemFolderName_
CalcMethodLibraries

\\Drivers Contains the driver files for a file group. SystemFolderName_
Drivers

\\Plan File
Attachments

Contains the supporting file attachments for plan
files in a file group.

SystemFolderName_
PlanFileAttachments

\\Plan Files Contains the individual plan files for a file group. SystemFolderName_
Plans

\\Process
Definitions

Contains the process definitions for a file group SystemFolderName_
Process

\\Templates Contains the plan file templates for a file group. SystemFolderName_
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Folder Name Description System Folder Name

Templates

\\Utilities Contains the utilities for a file group. SystemFolderName_
Utilities

Libraries Contains the file libraries for Axiom Budgeting and
Performance Reporting.

This is not a literal folder; it displays for
organizational purposes in Axiom Explorer.

N/A

Reports Library Contains the reports created in your system. You
can createmultiple sub-folders as needed to
organize your reports, and control access to these
files and folders in Security.

SystemFolderName_
ReportsLibrary

Any user-defined subfolders
can be referenced by the
name as it appears in Axiom
Explorer.

Table Library Contains the user-defined tables created in your
system. You can createmultiple sub-folders as
needed to organize your tables.

SystemFolderName_
AxiomTables

Tables cannot be opened
using GetDocument.

Data Diagrams
Library

Contains the data diagrams created in your system.
You can createmultiple sub-folders as needed to
organize your diagrams, and control access to
these files and folders in Security.

SystemFolderName_
DiagramsLibrary 

Any user-defined subfolders
can be referenced by the
name as it appears in Axiom
Explorer.

Filter Library Contains the filter criteria statements created in
your system. You can createmultiple sub-folders as
needed to organize your diagrams, and control
access to these files and folders in Security.

SystemFolderName_
FilterLibrary 

Any user-defined subfolders
can be referenced by the
name as it appears in Axiom
Explorer.

Task Panes Library Contains the task panes created in your system.
You can createmultiple sub-folders as needed to
organize your task panes, and control access to
these files and folders in Security.

SystemFolderName_
ShortcutListLibrary 

Any user-defined subfolders
can be referenced by the
name as it appears in Axiom
Explorer.

Ribbon Tabs Contains the ribbon tabs created in your system. SystemFolderName_
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Folder Name Description System Folder Name

Library You can createmultiple sub-folders as needed to
organize your ribbon tabs, and control access to
these files and folders in Security.

RibbonListLibrary 

Any user-defined subfolders
can be referenced by the
name as it appears in Axiom
Explorer.

Process Definition
Library

Contains process definitions created in your
system. You can createmultiple sub-folders as
needed to organize your definitions, and control
access to these files and folders in Security.

SystemFolderName_
ProcessDefinitionLibrary 

Any user-defined subfolders
can be referenced by the
name as it appears in Axiom
Explorer.

Scheduler Jobs
Library

Contains the scheduler jobs created in your
system. You can createmultiple sub-folders as
needed to organize your jobs, and control access
to these files and folders in Security.

SystemFolderName_
JobsLibraryFolder

Any user-defined subfolders
can be referenced by the
name as it appears in Axiom
Explorer.

Imports Library Contains the imports created in your system. You
can createmultiple sub-folders as needed to
organize your imports, and control access to these
files and folders in Security.

SystemFolderName_
ImportsLibrary

Any user-defined subfolders
can be referenced by the
name as it appears in Axiom
Explorer.

Exports Library Contains the exports created in your system. You
can createmultiple sub-folders as needed to
organize your exports, and control access to these
files and folders in Security.

SystemFolderName_
ExportsLibrary

Any user-defined subfolders
can be referenced by the
name as it appears in Axiom
Explorer.

Axiom System Contains system files for Axiom Budgeting and
Performance Reporting. Only administrators can
see and access this area.

SystemFolderName_
AxiomSystem

\Axiom
Intelligence
Models

Contains supporting files for Axiom Intelligence
reporting. This folder is only present if your system
has licensed this feature.

SystemFolderName_
AxiomIntelligenceModels

\Diagnostics Can be used to hold supporting files for custom
diagnostics tests.

SystemFolderName_
Diagnostics
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Folder Name Description System Folder Name

\Document
Templates

Contains default files used throughout the system.
When a new file is created in Axiom Budgeting and
Performance Reporting, the appropriate document
template is used to create the new file.

SystemFolderName_
DocumentTemplates

\\Calc Method
Library

Contains the default file for calc method libraries. SystemFolderName_
CalcMethodLibraryTemplate

\\Control
Sheet

Contains the default Control Sheets. SystemFolderName_
ControlSheetTemplate

\\\Alert Contains the default Alert Control Sheet. SystemFolderName_
AlertControlSheet

\\\Batch Contains the default Batch Control Sheet. SystemFolderName_
BatchControlSheet

\\\Default Contains the default Control Sheet. This is the base
Control Sheet that defines a spreadsheet file as an
Axiom file.

SystemFolderName_
DefaultControlSheet

\\\Drilling Contains the default Drilling Control Sheet. SystemFolderName_
DrillingControlSheet

\\\File Collect Contains the default File Collect Control Sheet. SystemFolderName_
FileCollectControlSheet

\\\File
Processing

Contains the default File Processing Control Sheet. SystemFolderName_
FileProcessingControlSheet

\\Drivers Contains the default file for driver files.

This folder can contain multiple files.
Administrators can save additional driver templates
to this folder, and users will be able to select which
template to use when they create a new driver.

SystemFolderName_
DriversTemplate

\\Empty
Workbooks

Contains blank workbooks used by Axiom
Budgeting and Performance Reporting processes
that create spreadsheet files.

SystemFolderName_
EmptyWorkbooks

\\Forms Administrators can optionally save form-enabled
report templates to this folder. If one file exists in
this folder, it is used as the default form template. If
multiple files exist in this folder, users will be able to
select which template to use when they create a
new form-enabled report.

SystemFolderName_
FormsTemplate

\\File Group
Templates

Contains the default file for plan file templates. SystemFolderName_
TemplatesTemplate
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Folder Name Description System Folder Name

\\Report
Designer

Contains templates for use in theWeb Client
Report Designer.

SystemFolderName_
WebReportTemplate

\\Reports Contains the default file for report files.

This folder can contain multiple files.
Administrators can save additional report
templates to this folder, and users will be able to
select which template to use when they create a
new report.

SystemFolderName_
ReportsTemplate

\\Sample
Ribbon Tabs

Contains the built-in ribbon tabs delivered with
Axiom Budgeting and Performance Reporting.

If you want to use one of these ribbon tabs, copy it
over to your Ribbon Tabs Library and then modify
it as needed. The ribbon tabs in this folder are
system controlled and may be overwritten on
future upgrades.

SystemFolderName_
RibbonListSamples

\\Sample Task
Panes

Contains the built-in task panes delivered with
Axiom Budgeting and Performance Reporting.

If you want to use one of these task panes, copy it
over to your Task Panes Library and then modify it
as needed. The task panes in this folder are system
controlled and may be overwritten on future
upgrades.

SystemFolderName_
SampleLists

\\Support
Utilities

Contains templates for support utilities, such as a
Save Type 4 report to change the system
configuration settings.

SystemFolderName_
SupportUtilities

\\Utilities Contains the default file for file group utilities.

This folder can contain multiple files.
Administrators can save additional utility templates
to this folder, and users will be able to select which
template to use when they create a new utility.

SystemFolderName_
UtilitiesTemplate

\Forms Runtime Contains files to support display of Axiom forms. SystemFolderName_
FormsRuntime

\GEO Feature
Files

Contains example GeoJSON files that can be used
with Map View components in Axiom forms.

SystemFolderName_
GeoJsonData

\Package
Manager

Contains supporting files relating to licensed
product packages.

SystemFolderName_
PackageManager
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Folder Name Description System Folder Name

\\Post Package
Processing

Contains any files to be used after installing a
product package. Only applies to installations with
licensed product packages.

SystemFolderName_
PostPackageProcessing

\Process History Contains historical process definitions to support
viewing process history. These files are system-
managed. They are automatically created when a
process instance is aborted or completed, and they
are automatically deleted when the corresponding
process history instance is deleted.

SystemFolderName_
ProcessHistory

\Scheduler
Working Folder

Contains system files used by Scheduler, such as
system event handlers and system-managed jobs.

SystemFolderName_
SchedulerWorkingFolder

\Startup Contains files that are launched at system startup.
Separate folders aremaintained for the Excel Client
and theWindows Client.

SystemFolderName_
Startup

\\Excel Startup Any files placed in this folder are opened when the
Excel Client is started.

SystemFolderName_
ExcelStartup

\\Hidden Any files placed in this folder are opened and
hidden at system startup. Separate sub-folders are
maintained for the Excel Client and theWindows
Client.

The Hidden folder is primarily used to support
custom solutions. Please contact Axiom Budgeting
and Performance Reporting support if you have
any questions about files in this folder.

SystemFolderName_
Hidden

\\\Excel
Client

Any files placed in this folder are opened and
hidden when the Excel Client is started.

SystemFolderName_
ExcelHidden

\\\Windows
Client

Any files placed in this folder are opened and
hidden when theWindows Client is started.

SystemFolderName_
SpreadsheetGearHidden

\\Home Contains the default Home file. This file can be
customized for a system.

You can also create separate versions for the
various Axiom Clients by copying the Home file (or a
different report file) into the sub-folders.

SystemFolderName_
Home

\\\Web
Client

If a form-enabled file is placed here, this file will be
used as the default Home Page file for theWeb
Client.

SystemFolderName_
WebClient

\\\Excel If a file is placed here, this file will be used as the SystemFolderName_
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Folder Name Description System Folder Name

Client default Home Page file for the Excel Client. ExcelClient

\\\Windows
Client

If a file is placed here, this file will be used as the
default Home Page file for theWindows Client.

SystemFolderName_
SpreadsheetGearHome

\\Windows
Startup

Any files placed in this folder are opened when the
Windows Client is started.

SystemFolderName_
SpreadsheetGearStartup

\User Folders Contains the Favorites and My Documents for each
user in the system.

This folder only displays when using the Axiom
Explorer dialog; it does not display in the Explorer
task pane.

SystemFolderName_
UserFoldersRoot

The folder name of each
subfolder is the user ID of
the relevant user.

� Updating document templates
The following document templates are always updated when a database is upgraded: control sheets,
sample task panes and ribbon tabs, and support utilities. All other document templates are not updated
by a database upgrade, however, they may be updated by a product installation.

If you want to update a document template to the latest version provided by Axiom Budgeting and
Performance Reporting, you can use the SoftwareManager to do so. Using the Reload System
Documents utility, you can specify which templates you want to update. The latest templates in the
selected template categories will be placed in your Axiom Budgeting and Performance Reporting
database, overwriting the current templates.

The SoftwareManager is the tool used to install and configure your Axiom Budgeting and Performance
Reporting database and server components. For more information, see the Installation Guide.

� Using system folder names
When using folder paths in Axiom features such as the GetDocument function, you can use the folder
path as you see it in your system, or you can use the underlying system folder name as defined in the
software code. You should use the system folder name if your system is deployed in an environment
where users are working in different system languages.

For example, imagine that some of your users work in English, while others work in French. In English
systems, the path to a particular folder looks like the following:

\Axiom\Reports Library\Budget Reports\Acct Subtotals.xlsm

If this folder path is used in a GetDocument function, it will not work in French systems because the
French system does not have a folder named "Reports Library." Instead, users in French systems see a
French language version of this folder name.
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To work around this issue, you can use the system folder name instead of the localized folder name. For
example, the following path would work in both English and French systems:

\Axiom\SystemFolderName_ReportsLibrary\Budget Reports\Acct Subtotals.xlsm

Only system-controlled folders such as "Reports Library" are localized and require the system folder
name syntax. The parent folder "Axiom" is the same in all system languages. Any subfolders and file
names created by the client—such as the "Budget Reports" subfolder in the example above—are always
displayed as they were defined, regardless of the system language.

Axiom file format specifications
This section outlines the file format requirements for importing data for the following products:

l Budgeting
l Performance Reporting
l Productivity
l Provider
l Rolling Forecasting

Data imports are built based on the provided file type and structure (i.e. column layout).

IMPORTANT: Neither the file type nor the file structure should change after they are provided to
your implementation team unless requested by the implementation team.

� Delimited Files
Delimited files are an acceptable format with the following parameters:

l Pipe-delimited preferred, comma delimited acceptable.
l If comma delimited, denote text fields by beginning with a quotation mark (“) and ending with a

quotation mark.
l Row 1may include headers (optional).

� Excel Files
Excel files are acceptable following the parameters below. Please be aware of file size. For very large files
such as Revenue and Usage, a delimited file is the recommended format.

l Row 1may include headers.
l Only row 1may include headers. Data records should begin on row 1 (no headers) or row 2 (if

using headers).
l The file should not include subtotals or totals.
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� Numeric Data Format
The values (e.g., dollar amounts, statistic amounts) in numeric (value) fields should NOT include commas
or dollar signs ($). These fields may include decimals to the second or third place if desired. If values are
negative (e.g., credits), we would prefer the negative sign be just in front of the value with no spaces
between the negative sign and the first character (number) of the value.

� Additional Columns
The file layouts on the proceeding pages define required and optional columns. If your standard extract
contains additional columns, then you do not need to remove them because they are ignored during the
Axiom import process.

Requested dimension (key field) data
Provide Excel files with the following data:

Table Data to Provide

Department l Department code
l Department descriptions by cost center
l Entity/Company code assignment

Account l GL account number
l Account description by account

number
l Primary financial statement category

(e.g. salaries, medical supplies,
purchased services, etc.)

Job Code l Job code
l Job code description
l Job class (if available)

Pay Type l Pay type code (also referred to as
earnings code in some payroll systems)

l Pay type descriptions by pay code
l Identifier for FTE-related hours

Charge Description Master
(CDM)

l Charge code
l Charge descriptions
l UBRev code
l CPT_HCPCS

� Provide module data
If licensed for the Provider module, provide Excel files with the following data:
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Table Data to Provide

Provider l Provider number (billing database ID)
l Provider name
l Employee payroll ID

CPT code l CPT code (only those used in your
billing history)

l CPT descriptions

Financial class l Financial class codes (e.g. codes for
Medicare, Medicaid, etc.)

l Financial class descriptions

Location l Location codes
l Location descriptions

Requested data files
To implement the Budget system in themost expeditious manner, as well as to familiarize ourselves with
your specific needs and processes, we request that you send us the requested information and files
within two weeks of receipt of this packet.

IMPORTANT: A delay in receiving thesematerials may lead to a delay in the implementation of the
software.

To view file layouts for the following requested files, click the provided links.

� Data file extracts

Type File Layout

l Current Fiscal Year Actual General
Ledger (monthly)

l Current Fiscal Year Budget General
Ledger (monthly)

l Prior Fiscal Year Actual General Ledger
(monthly)

General Ledger

EmployeeMaster (monthly or annually) Employeemaster

Labor Distribution Labor distribution

Accounts Payable Accounts payable

Materials Management Materials/stores issues

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1328



Type File Layout

Accrued Receipts Accrued receipts/received
not invoiced

Revenue and Usage Revenue and usage

Provider Billing Data (if licensed) Provider billing data

Bi-weekly Productivity (if implementing) l Biweekly productivity –
CDM volumes

l Biweekly Productivity –
Input Statistics
(Optional)

� Statistical data
If not included in the General Ledger extract and if not to be calculated from Rev Usage data, please
supply a file with the following statistical data:

l Monthly Departmental Statistics (volumes) – Inpatient and Outpatient for current fiscal year-to-
date (YTD), see Statistics

� Report examples
l Income Statement Representing the Same Period of Data Supplied
l Balance Sheet Statement Representing the Same Period of Data Supplied

NOTE: With the requested data extract files, please send your organization’s financial reports for the
period(s) included in the extract file. This will allow us to reconcile the data and ensure accuracy.
Please send related financial statements for all files sent.

Standard database file layouts
The following section includes the layout descriptions for the Standard Database Files.

General Ledger

� File layout
l Recommend the file name begin with “GL_”

o Examples: GL_CYActual, GL_CYBudget, GL_LYActual, GL_L2Actual

l Same file name can be used each month

This file will load your general ledger data into the Budget system. This ensures that data can reconcile to
the General Ledger System. The GL file should have the following layout:
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� Balance sheet accounts
We prefer that each period value contain themonthly activity. It is required that you include a period 0
within this file layout to contain the beginning FY balance.

� Audit adjustments
Depending on your accounting practice, you may include year-end audit adjustments in period 12 or add
them as period 13 to the extract file. If you add them as a period 13 to the extract file, these will be
summed with month 12 and loaded to month 12 during import into Axiom.

� Statistic and hour accounts
Please include statistical and/or manhour values in your file extract if tracked within your GL on a
monthly basis. This data can also be extracted in a separate file (see Statistics or calculated from Revenue
and Usage data).

This file will load your general ledger data into the Axiom system. The GL file should have the following
layout:

Field Description Field Type Length

Entity Entity or Hospital Code Numeric 5

GL Department Department or Cost Center
Number

Numeric 50

GL Account GL Account\SubAccount
Number

Numeric 50

Type Asset, Liability, Revenue,
Deduction, Expense, Statistic,
Hours

Text 50

Period 0 Value Beginning Balance Decimal 11.3

Period 1 Value Fiscal month amount Decimal 11.3

Period 2 Value Fiscal month amount Decimal 11.3

Period 3 Value Fiscal month amount Decimal 11.3

Period 4 Value Fiscal month amount Decimal 11.3

Period 5 Value Fiscal month amount Decimal 11.3

Period 6 Value Fiscal month amount Decimal 11.3

Period 7 Value Fiscal month amount Decimal 11.3

Period 8 Value Fiscal month amount Decimal 11.3

Period 9 Value Fiscal month amount Decimal 11.3
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Field Description Field Type Length

Period 10 Value Fiscal month amount Decimal 11.3

Period 11 Value Fiscal month amount Decimal 11.3

Period 12 Value Fiscal month amount Decimal 11.3

� Sample file layout

Statistics

NOTE: You organization must provide statistics if volume statistics are not included in GL and are not
calculated by Revenue and Usage data.

� File layout
l Recommended file name to begin with “ST_”

o Examples: ST_CYActual, ST_CYBudget, ST_LYActual, ST_L2Actual

l You can use the same file name each month.

The following are the preferred methods of loading statistics into the Axiom system.

l Via the General Ledger import file as defined previously.
l A file in the following requested layout.
l Statistic data entry worksheet. If some of your statistics are unavailable from a database and a

current statistic Excel worksheet exists, please e-mail a current copy of this. Wewill enable this
worksheet to post entries to your database.

l Calculated from the Revenue and Usage data.

Field Description Field Type Length

Entity Entity or Hospital Identification Code Numeric 5

GL Dept Department Number Numeric 10

GL Acct Statistic Account Number Numeric 10

Acct Desc Statistic Description Text 50

Period 1 Value Fiscal month amount Decimal 11.3

Period 2 Value Fiscal month amount Decimal 11.3
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Field Description Field Type Length

Period 3 Value Fiscal month amount Decimal 11.3

Period 4 Value Fiscal month amount Decimal 11.3

Period 5 Value Fiscal month amount Decimal 11.3

Period 6 Value Fiscal month amount Decimal 11.3

Period 7 Value Fiscal month amount Decimal 11.3

Period 8 Value Fiscal month amount Decimal 11.3

Period 9 Value Fiscal month amount Decimal 11.3

Period 10 Value Fiscal month amount Decimal 11.3

Period 11 Value Fiscal month amount Decimal 11.3

Period 12 Value Fiscal month amount Decimal 11.3

� Sample file layout

Labor distribution

� File layout
l Recommend file name to begin with “LD_”

o Example: LD_MMDDYY_PP where PP is the pay period number and MMDDYY is the pay
period end date.

l Each file should have a unique filename.

Note the following:

l When loading historical data, provide a file with all pay periods for the current fiscal year-to-date.
l For ongoing Axiom system maintenance, a file per pay period (in the same layout, the Pay Period

Number column will only reflect one Pay Period).

Field Description Opt/Required Field
Type

Length

Entity Entity or Hospital Identification
Code

R Numeric 5
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Field Description Opt/Required Field
Type

Length

Dept Department or Cost Center
Number

R Numeric 10

JobCode Job Position Code R Text 25

PayType Pay Category Code R Text 25

EmpID

IMPORTANT: Not SSN

Unique to Each Employee R Numeric 10

Employee Name Employee Last Name, First Name R Text 100

Hours Number of Hours Worked for this
Pay Type

R Decimal 9.3

Dollars Total Gross Dollars Paid for this
Pay Type

R Decimal 9.3

PayPeriod# Number of Pay Period or Pay Cycle R Numeric 2

Off Cycle Payrolls -Many payroll systems have the ability to run off-cycle payrolls for adjustments,
bonuses, and manual checks. Pleasemake sure to include off-cycle payroll information with the next
payroll period data.

� Sample file layout

Employee master

� File layout
l Recommend the file name begin with “EM_”

o Example: EM_CYActual

l You can use the same file name each pay period.
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The EmployeeMaster file is used for salary modeling purposes during the budget process. Normally this
file is provided either annually prior to the start of the budget process or biweekly along with the labor
distribution file.

The source system for this data is usually the HR information system.

l Employee Status – This term means different things to different organizations. It can define
whether the employee is exempt or non-exempt from overtime pay, full time or part time, etc.
You may have several fields of this nature.

l Scheduled Hours – This field is often provided as “number of hours worked per 80 hour pay
period.”

l Hire Date – The hire date is often used for vacation and other benefit computations based on
longevity. Many times, there is a separate field in your HR\payroll system for adjusted hire date
which accounts for gaps in employment that need to be considered for benefit calculations.

l Next Review – The date should correspond to the next salary increase date for the current “job /
position” of a particular employee. Include this field for all employees to represent the date of the
next review or anniversary date of an employee used for merit increases.

Each line (record) of the file should represent one employee. Include only records for active employees.

The EmployeeMaster file is used for salary modeling purposes during the budget process. Normally this
file is provided either annually prior to the start of the budget process or biweekly along with the labor
distribution file.

Field Description Opt/Required Field Type Length

Entity Entity or Hospital
Code

R Numeric 5

Dept Home Department
or Cost Center
Number

R Numeric 10

JobCode Job Position Code R Text 25

EmpID

IMPORTANT: Not
SSN. See Caution
note below.

Unique to Each
Employee

R Numeric 10

Employee Name Employee Name R Text 100

Status Employee Status R Text 5

Sch Hours Number of Hours
Scheduled

R Decimal 10.5

Hourly Rate Current Hourly
Rate

R Decimal 9.3
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Field Description Opt/Required Field Type Length

Hire Date Employee's Date of
Hire

R MM/DD/YYYY 25

Next Review Employee’s Next
Increase Date

R MM/DD/YYYY 25

PTO Balance Paid Time Off or
Vacation Accrual
Balance

R Decimal 11.2

PTO Rate Paid Time Off or
Vacation Accrual
Rate

R Decimal 11.2

Grade Labor Category R Text 5

� Sample file layout

NOTE: Kaufman Hall will not accept any file that includes a Social Security Number ("SSN"). Please
mask any SSN data.

Add-on database file layouts
The addition of these optional databases to your Budget system must be specified in your contract or
can be added at a later date. Please contact your sales executive or project manager for details. The
following section includes the layout descriptions for the optional add-on database files.

GL transaction detail /journal entry detail

� File layout
l Recommend the file name begin with “JE_”

o Example: JE_Actual2020_JAN

l Each month should have a file, and each file should have a unique file name.

Field Description Field Type Length

Entity Entity or Hospital Identification Code Numeric 5
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Field Description Field Type Length

Dept Department or Cost Center Number Numeric 10

Acct GL Account Number Numeric 10

JENum Journal Entry Number Text 50

JESource Journal Entry Source

(AP, MM, PO, Payroll, Reversing, etc.)

Text 10

JEDate Date of Journal Entry (MM/DD/YYYY) Text 10

JEDesc Description of Journal Entry Text 50

Amount Dollar Amount of Journal Entry Decimal 12.2

� Sample file layout

Accounts payable

� File layout
l Recommend the file name begin with “AP_”

o Example: AP_Actual2020_JAN

l Each month should have a file, and each file should have a unique file name.

Field Description Field Type Length

Entity Entity or Hospital
Identification Code

Numeric 5

Dept Department or Cost
Center Number

Numeric 10

Acct GL Account Number Numeric 10

Vendor Number Vendor Number Text 25

Vendor Name Vendor Name Text 50

PONum Purchase Order
Number

Text 25

ItemNoDesc Item\Line Number
Description

Text 100

Administrator's Guide Axiom Budgeting and Performance Reporting │ 1336



Field Description Field Type Length

InvoiceNum Invoice Number Text 50

Amount Dollar Amount Decimal 11.2

CheckNo Check Number Text 25

VendorImageLink URL to vendor image
location

Text 1000

� Sample file layout

Materials/stores issues

� File layout
l Recommend the file name begin with “MM_”

o Example: MM_Actual2020_JAN

l Each month should have a file, and each file should have a unique file name.

Field Description Field Type Length

Entity Entity or Hospital
Identification Code

Numeric 5

Dept Department or Cost
Center Number

Numeric 50

Acct GL Account Number Numeric 50

ItemNum Item or Stock Number Text 25

ItemNumDescr Item or Stock
Description

Text 100

Qty Net Quantity Issued in
Month

Decimal 11.2

Amount Net Amount Charged in
Month

Decimal 11.2

Location Location Issued From Text 25
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Field Description Field Type Length

Unit Price Can be Calculated from
Cost and Quantity

Decimal 11.2

UOM Unit of Issue (Boxes,
Cases, Each, etc.)

Text 25

� Sample file layout

Accrued receipts/received not invoiced

� File layout
l Recommend the file name begin with “AR_”

o Example: AR_Actual2020_JAN

l Each month should have a file, and each file should have a unique file name.

Field Description Field Type Length

Entity Entity or Hospital
Identification Code

Numeric 5

Dept Department or Cost
Center Number

Numeric 50

Acct GL Account Number Numeric 50

VendorNum Vendor Number Text 25

Vendor Name Vendor Name Text 50

PO Number PO Number Text 25

PO Description Item\Line Number
Description

Text 50

Qty Quantity Received Numeric 11

Amt Dollar Amount Decimal 11.2

VendorImageLink URL to vendor image
location

Text 1000
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� Sample file layout

Revenue and usage

� File layout
l Recommend the file name begin with “RU_”

o Example: RU_MMMYYYY

l Each month should have a file, and each file should have a unique file name.

Field Description Opt/Req Field
Type

Length

Entity Entity or Hospital Identification Code R Numeric 5

Dept Department or Cost Center Number R Numeric 10

CDM Code Charge Code Number R Text 25

CDM Code Desc Description of CDM Code O Text 100

Current Month IP
Vol

Inpatient Volume for Current Month R Decimal 11.2

Current Month IP
Rev

Inpatient Gross Revenue for Current
Month

R Decimal 11.2

Current Month OP
Vol

Outpatient Volume for Current Month R Decimal 11.2

Current Month OP
Rev

Outpatient Gross Revenue for Current
Month

R Decimal 11.2

UBRev Universal Billing Code R Text 25

CPT_HCPCS Health Care Procedure Coding
System/Current Procedural Terminology
Codes

R Text 25

CDM Code description can be provided in a separate file.
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� Sample file layout

Provider billing data

NOTE: There are two file layout options presented below. One provides one row per unique
combination of Dimension elements (Entity, Dept, CPTCode, Provider, FinClass, Location) with
multiple value columns (RVU, WRVU, Gross Charges, etc.) The other provides a row per unique
combination of Dimension elements and DataType (separate row for Gross Charges vs. WRVUs, etc.).
Please select which one best fits the extract capabilities of the billing system your organization uses.

� File layout
l Recommend the file name begin with “PB_”

o Example: PB_MMMYYYY

l Each month should have a file, and each file should have a unique file name.

Field Description Opt/Req Field
Type

Length

Entity Entity or Hospital Identification Code R Numeric 5

GL Dept Department or Cost Center Number R Numeric 10

CPT Code CPT Summary Code or CPT CodeWithout
Modifier1

R Text 25

Provider Provider Number R Text 50

FinClass Summary Financial Class2 R Text 50

Location Location of Encounter O Text 25

Current Month
CPT Volume

Volume for Current Month R Decimal 11.2

Current Month
WRVU

Worked RVU (Relative Value Unit) for
Current Month

R Decimal 11.2

Current Month
RVU

Gross Revenue for Current Month R Decimal 11.2

Month Revenue Total RVU (Relative Value Unit) for Current
Month

O Decimal 11.2
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Field Description Opt/Req Field
Type

Length

Current Month
Visits (or
Encounters)

Visits/Encounters for Current Month R Decimal 11.2

Current Month
Payment

Payment for Current Month O Decimal 11.2

Current Month
Allowance

Allowance for Current Month O Decimal 11.2

l Financial Class – Examples: Medicare, Medicaid, FFS, and Cap (Capitation). Examples include
Medicare, Medicaid, BCBS, etc.

l Data Type - Valid codes for Data Type are Encounter, Visit, Volume, WRVU, RVU and Revenue.
l Visits or Encounters

o If this data is not available from your billing system, the visit count can be summarized
during the import process by flagging the Visit CPT codes in the CPT dimension, Type
column.

o Alternatively, you can provide visits in a separate file using the file layout below.

l You may also provide data for Payments or Allowances. This data may be needed to calculate
Percent of Net and Percent of Cash Collections Provider Compensation in the budget workbooks.

Biweekly productivity – CDM volumes

NOTE: Use if implementing Axiom Productivity Management.

The two options for capturing Biweekly volumes in the Axiom system are:

l Calculating the volumes from the Rev Usage (CDM Volume) data (the following first option).
l Loading already calculated volumes by department (the following second option).
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Option 1 - CDM volumes

� File layout
l Recommend the file name begin with “LV_”

o Example: LV_MMMYYYY

l Each month should have a file, and each file should have a unique file name.

Field Description Opt/Req Field
Type

Length

Entity Entity or Hospital Identification Code R Numeric 5

Dept Department or Cost Center Number R Numeric 10

CDM Code Charge Code Number R Text 25

Current Month IP Inpatient Volume R Decimal 11.2

Current Month
IP Vol

Outpatient Volume R Decimal 11.2

� Sample file layout

Option 2

� File layout
l Recommend the file name begin with “LS_”

o Example: LS_MMMYYYY

l Each month should have a file, and each file should have a unique file name.

File for each month should have a unique file. This file will load your biweekly statistics into the Budget
system. Normally this file is provided on a biweekly basis.

Field Description Opt/Req Field
Type

Length

Entity Entity or Hospital Identification Code R Numeric 5
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Field Description Opt/Req Field
Type

Length

Dept Department or Cost Center Number R Numeric 10

Volume Biweekly Statistic R Decimal 11.2

CDM Code description is usually provided in a separate file.

� Sample file layout

Daily productivity

Worked hours

� File layout
l Recommend file name begin with “DP_”

o Example DP_MMDDYY

l Each month should have a file, and each file should have a unique file name.

The data source for this file is the Time and Attendance system. Typically this file is provided on a daily
basis.

Field Description Opt/Reqd Field
Type

Length

Entity Entity or Hospital Identification
Code

R Numeric 5

GLDept Department or Cost Center
Number

R Numeric 10

JobCode Job Position Code R Text 25

PayType Pay Category Code R Text 25

EmpID

IMPORTANT: Not SSN

Unique to Each Employee R Numeric 10
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Field Description Opt/Reqd Field
Type

Length

Hours Number of Hours Worked for this
Pay Type

R Decimal 9.3

EmpName Employee Last Name, First Name R Text 50

WorkDate DateWorked O Text 10

� Sample file layout

CDM volumes

� File Layout
l Recommend the file name begin with “DV_”

o Example: DV_MMMYYYY

l Each month should have a file, and each file should have a unique file name.

The recommended date parameter for this data is Date of Service. As such a time lag of a specified
amount of days is recommended to capture the bulk of the volume data. The finance and IT resource(s)
should discuss to determine the appropriate date criteria.

Field Description Opt/Reqd Field
Type

Length

Entity Entity or Hospital Identification
Code

R Numeric 5

Dept Department or Cost Center
Number

R Numeric 10

CDMCode Charge Code Number R Text 25

IP Volume Inpatient Volume R Decimal 11.2

OP Volume Outpatient Volume R Decimal 11.2

Service Date Date of Service R Text 10
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� Sample file layout

Input statistics

� File layout
l Recommend the file name begin with “DS_”

o Example: DS_MMMYYYY

l Each month should have a file, and each file should have a unique file name.

Field Description Opt/Reqd Field Type Length

Entity Code Entity or Hospital Identification Code R Numeric 5

GLDepartment Department or Cost Center Number R Numeric 10

Statistics Daily Statistic R Decimal 11.2

� Sample file layout
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